Oracle® Public Sector Purchasing User’s Guide Release 11i

The part number for this book is A80980–02. To reorder this book, use part number A75084–02.

Copyright © 1996, 2001, Oracle Corporation. All rights reserved.

Primary Authors: Vic Mitchell
Contributors: Carol Borison, Shannon Burnett, John Chan, Gary Cosentino, Rachel Haas, Shilpa Kotwal, Vijay Pawar

The Programs (which include both the software and documentation) contain proprietary information of Oracle Corporation; they are provided under a license agreement containing restrictions on use and disclosure and are also protected by copyright, patent and other intellectual property law. Reverse engineering of the Programs is prohibited.

Program Documentation is licensed for use solely to support the deployment of the Programs and not for any other purpose.

The information contained in this document is subject to change without notice. If you find any problems in the documentation, please report them to us in writing. Oracle Corporation does not warrant that this document is error free. Except as may be expressly permitted in your license agreement for these Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without the express written permission of Oracle Corporation.

If the Programs are delivered to the US Government or anyone licensing or using the Programs on behalf of the US Government, the following notice is applicable:

RESTRICTED RIGHTS LEGEND
Programs delivered subject to the DOD FAR Supplement are ‘commercial computer software’ and use, duplication and disclosure of the Programs including documentation, shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement. Otherwise, Programs delivered subject to the Federal Acquisition Regulations are ‘restricted computer software’ and use, duplication and disclosure of the Programs shall be subject to the restrictions in FAR 52.227–19, Commercial Computer Software – Restricted Rights (June, 1987). Oracle Corporation, 500 Oracle Parkway, Redwood City, CA 94065.”

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently dangerous applications. It shall be licensee’s responsibility to take all appropriate fail–safe, back up, redundancy and other measures to ensure the safe use of such applications if the Programs are used for such purposes, and Oracle disclaims liability for any damages caused by such use of the Programs.

Oracle is a registered trademark and ConText, Enabling the Information Age, Oracle7, Oracle8, Oracle8i, Oracle Access, Oracle Application Object Library, Oracle Financials, Oracle Discoverer, Oracle Quality, Oracle Web Customers, Oracle Web Employees, Oracle Work in Process, PL/SQL, Pro*C, SmartClient, SQL*, SQL*Forms, SQL*Loader, SQL*Menu, SQL*Net, SQL*Plus, and SQL*Report are trademarks or registered trademarks of Oracle Corporation. Other names may be trademarks of their respective owners.
Contents

Volume 1

Preface ................................................................. xi

Chapter 1

Setting Up ............................................................. 1 – 1
Overview of Setting Up .............................................. 1 – 2
Defining Locations ..................................................... 1 – 24
Defining Buyers ...................................................... 1 – 27
Defining Approval Groups ......................................... 1 – 29
Assigning Approval Groups ....................................... 1 – 33
Annotating Purchasing Documents .............................. 1 – 36
Defining Purchasing Options ..................................... 1 – 45
Defining Receiving Options ...................................... 1 – 58
Defining Requisition Templates ................................. 1 – 62
Purchasing Hazardous Materials ............................... 1 – 67
Defining Lookup Codes ........................................... 1 – 74
Purchasing Services ................................................. 1 – 79
Defining Document Types ........................................ 1 – 87
Controlling Purchasing Periods ................................. 1 – 93
Choosing Workflow Options .................................... 1 – 95
iProcurement Setup Windows .................................. 1 – 102
Profile Options and Security Functions ....................... 1 – 103
### Chapter 2 Approval, Security, and Control 2–1
- Setting Up Document Approval and Security 2–2
- Position Hierarchies 2–8
- Document Security and Access 2–10
- Approval Routing 2–13
- Approval Authorization Control 2–16
- Assigning Employees 2–23
- The Document Approval Process 2–24
- Document Control Overview 2–44
- MassCancel 2–60

### Chapter 3 Requisitions 3–1
- Overview of Requisitions 3–2
- Overview of Internal Requisitions 3–15
- Finding Requisitions 3–42
- Entering Requisition Preferences 3–52
- Entering Requisition Headers 3–57
- Entering Requisition Lines 3–60
- Entering Requisition Distributions 3–68
- Using Requisition Templates 3–73

### Chapter 4 Purchase Orders 4–1
- Overview of Purchase Orders 4–3
- Purchase Order Defaulting Rules 4–12
- Finding Purchase Orders 4–19
- Entering Purchase Order Preferences 4–34
- Entering Purchase Order Headers 4–39
- Entering Purchase Order Lines 4–45
- Entering Purchase Order Price Reference Information 4–49
- Entering Purchase Order Reference Document Information 4–51
- Entering Purchase Order Miscellaneous Information 4–53
- Entering Purchase Agreement Information 4–55
- Entering Currency Information 4–58
- Entering Purchase Order Details Information 4–60
- Entering Purchase Order Shipments 4–63
- Entering Purchase Order Receiving Controls 4–69
- Entering Purchase Agreement Price Break Information 4–72
- Entering Purchase Order Distributions 4–74
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advance Shipment Notices (ASNs)</td>
<td>7–17</td>
</tr>
<tr>
<td>Managing Receipts</td>
<td>7–23</td>
</tr>
<tr>
<td>Unordered Receipts</td>
<td>7–39</td>
</tr>
<tr>
<td>Receiving Transactions</td>
<td>7–45</td>
</tr>
<tr>
<td>Inspections</td>
<td>7–72</td>
</tr>
<tr>
<td>Returns</td>
<td>7–76</td>
</tr>
<tr>
<td>Corrections</td>
<td>7–84</td>
</tr>
<tr>
<td>Finding Intransit Shipments</td>
<td>7–92</td>
</tr>
<tr>
<td>Control Numbers</td>
<td>7–96</td>
</tr>
<tr>
<td>Receiving Reports</td>
<td>7–99</td>
</tr>
<tr>
<td>Overview of Receipt Accounting</td>
<td>7–101</td>
</tr>
<tr>
<td>Fund Accounting in Oracle Public Sector Purchasing</td>
<td>7–130</td>
</tr>
</tbody>
</table>

Index

**Volume 2**

**Chapter 8**

<table>
<thead>
<tr>
<th>Inquiries</th>
<th>8–1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewing Action History</td>
<td>8–2</td>
</tr>
<tr>
<td>Viewing Purchase Order Changes</td>
<td>8–4</td>
</tr>
</tbody>
</table>

**Chapter 9**

<table>
<thead>
<tr>
<th>Reports and Processes</th>
<th>9–1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accrual Reconciliation Report</td>
<td>9–5</td>
</tr>
<tr>
<td>Accrual Write–Off Report</td>
<td>9–13</td>
</tr>
<tr>
<td>Advanced Shipment Notice Discrepant Receipts Report</td>
<td>9–16</td>
</tr>
<tr>
<td>ASL Upgrade Process</td>
<td>9–17</td>
</tr>
<tr>
<td>Backordered Internal Requisitions Report</td>
<td>9–18</td>
</tr>
<tr>
<td>Blanket and Planned PO Status Report</td>
<td>9–19</td>
</tr>
<tr>
<td>Buyer Listing</td>
<td>9–21</td>
</tr>
<tr>
<td>Buyer’s Requisition Action Required Report</td>
<td>9–23</td>
</tr>
<tr>
<td>Cancelled Purchase Orders Report</td>
<td>9–25</td>
</tr>
<tr>
<td>Cancelled Requisitions Report</td>
<td>9–26</td>
</tr>
<tr>
<td>Confirm Receipts Workflow Select Orders Process</td>
<td>9–28</td>
</tr>
<tr>
<td>Contract Status Report</td>
<td>9–30</td>
</tr>
<tr>
<td>Country of Origin Report (by Item)</td>
<td>9–31</td>
</tr>
<tr>
<td>Country of Origin Report (by Supplier)</td>
<td>9–33</td>
</tr>
<tr>
<td>Create Internal Sales Orders Process</td>
<td>9–35</td>
</tr>
<tr>
<td>Appendix A</td>
<td>Windows and Navigator Paths ........................................... A – 1</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Windows and Navigator Paths ......................................... A – 2</td>
</tr>
<tr>
<td>Appendix B</td>
<td>Oracle Public Sector Purchasing Alerts ............................. B – 1</td>
</tr>
<tr>
<td></td>
<td>Using Oracle Alert in Oracle Public Sector Purchasing .......... B – 2</td>
</tr>
<tr>
<td>Appendix C</td>
<td>Using the Account Generator in Oracle Public Sector Purchasing ......................................................... C – 1</td>
</tr>
<tr>
<td></td>
<td>Overview of Procurement Workflows .................................. C – 3</td>
</tr>
<tr>
<td></td>
<td>Customization Guidelines ................................................ C – 5</td>
</tr>
<tr>
<td></td>
<td>Using the Account Generator in Oracle Public Sector Purchasing .......................................................... C – 10</td>
</tr>
<tr>
<td></td>
<td>Requisition Approval Workflow ........................................ C – 57</td>
</tr>
<tr>
<td></td>
<td>Purchase Order Approval Workflow ..................................... C – 114</td>
</tr>
<tr>
<td></td>
<td>Workflow Processes for Approving Change Orders .................. C – 171</td>
</tr>
<tr>
<td></td>
<td>Workflow for Creating Purchase Orders and Releases ............... C – 209</td>
</tr>
<tr>
<td></td>
<td>Confirm Receipts Workflow ............................................... C – 240</td>
</tr>
<tr>
<td></td>
<td>Send Notifications Workflow ............................................ C – 254</td>
</tr>
<tr>
<td></td>
<td>Price/Sales Catalog Notification Workflow .......................... C – 267</td>
</tr>
<tr>
<td></td>
<td>Process Navigator Workflows ............................................ C – 276</td>
</tr>
<tr>
<td></td>
<td>Debit Memo Notification Workflow ..................................... C – 278</td>
</tr>
<tr>
<td>Appendix D</td>
<td>Character Mode Forms and Corresponding GUI Windows ................ D – 1</td>
</tr>
<tr>
<td></td>
<td>Oracle Public Sector Purchasing Character Mode Forms and Corresponding GUI Windows .................................. D – 2</td>
</tr>
<tr>
<td></td>
<td>GLOSSARY ........................................................................ 1</td>
</tr>
</tbody>
</table>

Glossary

Index

This user guide includes the information you need to work with Oracle Public Sector Purchasing effectively. It contains detailed information about the following:

- Overview and reference information
- Oracle Public Sector Purchasing implementation suggestions
- Specific tasks you can accomplish using Oracle Public Sector Purchasing
- How to use Oracle Public Sector Purchasing windows
- Oracle Public Sector Purchasing programs, reports, and listings
- Oracle Public Sector Purchasing functions and features
- Oracle Public Sector Purchasing system setup

This preface explains how this user guide is organized and introduces other sources of information that can help you.
Audience for This Guide


This guide assumes you have a working knowledge of the following:

- The principles and customary practices of your business area.
- Oracle Public Sector Purchasing
  If you have never used Oracle Public Sector Purchasing, we suggest you attend one or more of the Oracle Public Sector Purchasing training classes available through Oracle University.
- The Oracle Applications graphical user interface.
  To learn more about the Oracle Applications graphical user interface, read the Oracle Applications User Guide.

See Other Information Sources for more information about Oracle Applications product information.

How To Use This Guide

This guide contains the information you need to understand and use Oracle Public Sector Purchasing.

This preface explains how this user guide is organized and introduces other sources of information that can help you. This guide contains the following chapters:

- Chapter 1 provides an overview of all the setup steps for Oracle Public Sector Purchasing and describes how Oracle Public Sector Purchasing can be tailored to your needs.
  
  **Note:** Implementation information and procedures are contained in this chapter.

- Chapter 2 contains information on the document approval process, security, and document control. It also describes how Oracle Public Sector Purchasing uses Oracle Workflow technology to route documents for approval.

- Chapter 3 contains information about requisitions, including internal requisitions, and explains how to create requisitions.

- Chapter 4 fully explains the creation and details pertaining to purchase orders. It also describes how Oracle Public Sector
Purchasing uses Oracle Workflow technology to create purchase orders and releases from approved requisitions.

- Chapter 5 describes how to manage your supply base through agreements, sourcing rules, and approved supplier lists. It also describes how to create requests for quotation (RFQs) and quotations, and manage buyer workload.

- Chapter 6 describes the AutoCreate process for purchasing documents.

- Chapter 7 contains full information about receiving, including inspections, returns, and corrections.

- Chapter 8 describes how to view the action history for specific purchasing documents or document lines.

- Chapter 9 describes Oracle Public Sector Purchasing reports and processes.

- Appendices A through D include information on navigating to windows in Purchasing, using Oracle Alert, and customizing procurement workflows.

**Documentation Accessibility**

Oracle’s goal is to make our products, services, and supporting documentation accessible to the disabled community with good usability. To that end, our documentation includes features that make information available to users of assistive technology. This documentation is available in HTML format, and contains markup to facilitate access by the disabled community. Standards will continue to evolve over time, and Oracle is actively engaged with other market-leader technology vendors to address technical obstacles so that our documentation can be accessible to all of our customers. For additional information, visit the Oracle Accessibility Program web site at http://www.oracle.com/accessibility/.

**Finding Out What’s New**

From the HTML help window for Oracle Public Sector Purchasing, choose the section that describes new features or what’s new from the expandable menu. This section describes:
• New features in 11i. This information is updated for each new release of Oracle Public Sector Purchasing.

• Information about any features that were not yet available when this user guide was printed. For example, if your system administrator has installed software from a mini pack as an upgrade, this document describes the new features.

Other Information Sources

You can choose from many sources of information, including online documentation, training, and support services, to increase your knowledge and understanding of Oracle Public Sector Purchasing.

If this guide refers you to other Oracle Applications documentation, use only the Release 11i versions of those guides unless we specify otherwise.

Online Documentation

All Oracle Applications documentation is available online (HTML and PDF). The technical reference guides are available in paper format only. Note that the HTML documentation is translated into over twenty languages.

The HTML version of this guide is optimized for onscreen reading, and you can use it to follow hypertext links for easy access to other HTML guides in the library. When you have an HTML window open, you can use the features on the left side of the window to navigate freely throughout all Oracle Applications documentation.

• You can use the Search feature to search by words or phrases.

• You can use the expandable menu to search for topics in the menu structure we provide. The Library option on the menu expands to show all Oracle Applications HTML documentation.

You can view HTML help in the following ways:

• From an application window, use the help icon or the help menu to open a new Web browser and display help about that window.

• Use the documentation CD.

• Use a URL provided by your system administrator.
Your HTML help may contain information that was not available when this guide was printed.

Related User Guides

Oracle Public Sector Purchasing shares business and setup information with other Oracle Applications products. Therefore, you may want to refer to other user guides when you set up and use Oracle Public Sector Purchasing.

You can read the guides online by choosing Library from the expandable menu on your HTML help window, by reading from the Oracle Applications Document Library CD included in your media pack, or by using a Web browser with a URL that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle store at http://oraclestore.oracle.com.

User Guides Related to All Products

Oracle Applications User Guide

This guide explains how to navigate the system, enter data, and query information, and introduces other basic features of the GUI available with this release of Oracle Public Sector Purchasing (and any other Oracle Applications product).

You can also access this user guide online by choosing “Getting Started and Using Oracle Applications” from the Oracle Applications help system.

Oracle Alert User Guide

Use this guide to define periodic and event alerts that monitor the status of your Oracle Applications data.

Oracle Applications Implementation Wizard User Guide

If you are implementing more than one Oracle product, you can use the Oracle Applications Implementation Wizard to coordinate your setup activities. This guide describes how to use the wizard.
Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications development staff. It describes the Oracle Application Object Library components needed to implement the Oracle Applications user interface described in the Oracle Applications User Interface Standards. It also provides information to help you build your custom Oracle Developer forms so that they integrate with Oracle Applications.

Oracle Applications User Interface Standards
This guide contains the user interface (UI) standards followed by the Oracle Applications development staff. It describes the UI for the Oracle Applications products and how to apply this UI to the design of an application built by using Oracle Forms.

User Guides Related to This Product

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup, and reference information for the Oracle Public Sector Purchasing implementation team, as well as for users responsible for the ongoing maintenance of Oracle Applications product data. This guide also provides information on creating custom reports on flexfields data.

Oracle Bills of Material User’s Guide
This guide describes how to create various bills of materials to maximize efficiency, improve quality and lower cost for the most sophisticated manufacturing environments. By detailing integrated product structures and processes, flexible product and process definition, and configuration management, this guide enables you to manage product details within and across multiple manufacturing sites.

Oracle Business Intelligence System Implementation Guide
This guide provides information about implementing Oracle Business Intelligence (BIS) in your environment.
BIS 11i User Guide Online Help
This guide is provided as online help only from the BIS application and includes information about intelligence reports, Discoverer workbooks, and the Performance Management Framework.

Oracle e–Commerce Gateway User’s Guide
This guide describes how Oracle e–Commerce Gateway provides a means to conduct business with trading partners via Electronic Data Interchange (EDI). Data files are exchanged in a standard format to minimize manual effort, speed data processing and ensure accuracy.

Oracle Public Sector General Ledger User’s Guide
This guide explains how to plan and define your chart of accounts, accounting period types and accounting calendar, functional currency, and set of books. It also describes how to define journal entry sources and categories so you can create journal entries for your general ledger. If you use multiple currencies, use this manual when you define additional rate types, and enter daily rates. This manual also includes complete information on implementing Budgetary Control.

Oracle HRMS Documentation Set
This documentation set includes the following volumes:

- Using Oracle HRMS – The Fundamentals, which explains how to set up organizations and site locations.
- Managing People Using Oracle HRMS, which explains how to enter employees and track employee data.
- Running Your Payroll Using Oracle HRMS, which explains how to set up payroll, do withholding, run statutory reports, and pay employees.
- Managing Compensation and Benefits Using Oracle HRMS, which explains how to set up Total Compensation, including 401(k), health, and insurance plans.
- Customizing, Reporting, and System Administration in Oracle HRMS, which explains how to customize the system and design reports.
Oracle Inventory User’s Guide
This guide describes how to define items and item information, perform receiving and inventory transactions, maintain cost control, plan items, perform cycle counting and physical inventories, and set up Oracle Inventory.

Oracle Order Management User’s Guide
This guide describes how to enter sales orders and returns, copy existing sales orders, schedule orders, release orders, create price lists and discounts for orders, run processes, and create reports.

Oracle Public Sector Payables User’s Guide
This guide describes how accounts payable transactions are created and entered in Oracle Public Sector Payables. This guide also contains detailed setup information for Oracle Public Sector Payables.

Oracle Quality User’s Guide
This guide describes how Oracle Quality can be used to meet your quality data collection and analysis needs. This guide also explains how Oracle Quality interfaces with other Oracle Manufacturing applications to provide a closed loop quality control system.

Oracle Public Sector Receivables User’s Guide
Use this manual to learn how to implement flexible address formats for different countries. You can use flexible address formats in the suppliers, banks, invoices, and payments windows.

Oracle Supplier Scheduling User’s Guide
This guide describes how you can use Oracle Supplier Scheduling to calculate and maintain planning and shipping schedules and communicate them to your suppliers.

Oracle Work in Process User’s Guide
This guide describes how Oracle Work in Process provides a complete production management system. Specifically this guide describes how discrete, repetitive, assemble-to-order, project, flow, and mixed manufacturing environments are supported.
Oracle Applications Concepts

This guide provides an introduction to the concepts, features, technology stack, architecture, and terminology for Oracle Applications Release 11i. It provides a useful first book to read before an installation of Oracle Applications. This guide also introduces the concepts behind, and major issues, for Applications-wide features such as Business Intelligence (BIS), languages and character sets, and self-service applications.

Installing Oracle Applications

This guide provides instructions for managing the installation of Oracle Applications products. In Release 11i, much of the installation process is handled using Oracle One-Hour Install, which minimizes the time it takes to install Oracle Applications and the Oracle 8i Server technology stack by automating many of the required steps. This guide contains instructions for using Oracle One-Hour Install and lists the tasks you need to perform to finish your installation. You should use this guide in conjunction with individual product user guides and implementation guides.

Upgrading Oracle Applications

Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or Release 11.0 products to Release 11i. This guide describes the upgrade process in general and lists database upgrade and product-specific upgrade tasks. You must be at either Release 10.7 (NCA, SmartClient, or character mode) or Release 11.0 to upgrade to Release 11i. You cannot upgrade to Release 11i directly from releases prior to 10.7.

Using the AD Utilities

Use this guide to help you run the various AD utilities, such as AutoInstall, AutoPatch, AD Administration, AD Controller, Relink, and others. It contains how-to steps, screenshots, and other information that you need to run the AD utilities.

Oracle Applications Product Update Notes

Use this guide as a reference if you are responsible for upgrading an installation of Oracle Applications. It provides a history of the changes.
to individual Oracle Applications products between Release 11.0 and Release 11i. It includes new features and enhancements and changes made to database objects, profile options, and seed data for this interval.

**Oracle Applications System Administrator’s Guide**

This guide provides planning and reference information for the Oracle Applications System Administrator. It contains information on how to define security, customize menus and online help, and manage processing.

**Oracle Purchasing Applications Technical Reference Manual**

This reference manual contains database diagrams and a detailed description of database tables, forms, reports, and programs for Oracle Public Sector Purchasing and related applications. This information helps you convert data from your existing applications, integrate Oracle Public Sector Purchasing with non-Oracle applications, and write custom reports for Oracle Public Sector Purchasing.

You can order a technical reference manual for any product you have licensed. Technical reference manuals are available in paper format only.

**Oracle Self Service Purchasing Implementation Manual**

This manual describes how to set up Oracle Self Service Purchasing. Self-Service Purchasing enables employees to requisition items through a self-service, Web interface.

**Oracle Workflow Guide**

This guide explains how to define new workflow business processes as well as customize existing Oracle Applications-embedded workflow processes. You also use this guide to complete the setup steps necessary for any Oracle Applications product that includes workflow-enabled processes.

**Training and Support**

**Training**

We offer a complete set of training courses to help you and your staff master Oracle Applications. We can help you develop a training plan
that provides thorough training for both your project team and your end users. We will work with you to organize courses appropriate to your job or area of responsibility.

Training professionals can show you how to plan your training throughout the implementation process so that the right amount of information is delivered to key people when they need it the most. You can attend courses at any one of our many Educational Centers, or you can arrange for our trainers to teach at your facility. We also offer Net classes, where training is delivered over the Internet, and many multimedia–based courses on CD. In addition, we can tailor standard courses or develop custom courses to meet your needs.

**Support**

From on–site support to central support, our team of experienced professionals provides the help and information you need to keep Oracle Public Sector Purchasing working for you. This team includes your Technical Representative, Account Manager, and Oracle’s large staff of consultants and support specialists with expertise in your business area, managing an Oracle server, and your hardware and software environment.

---

**Do Not Use Database Tools to Modify Oracle Applications Data**

*We STRONGLY RECOMMEND that you never use SQL*Plus, Oracle Data Browser, database triggers, or any other tool to modify Oracle Applications tables, unless we tell you to do so in our guides.*

Oracle provides powerful tools you can use to create, store, change, retrieve, and maintain information in an Oracle database. But if you use Oracle tools such as SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using an Oracle Applications form can update many tables at once. But when you modify Oracle Applications data using anything other than Oracle Applications forms, you might change a row in one table without making corresponding changes in related tables. If your tables get out of synchronization with each other, you risk retrieving erroneous information and you risk unpredictable results throughout Oracle Applications.
When you use Oracle Applications forms to modify your data, Oracle Applications automatically checks that your changes are valid. Oracle Applications also keeps track of who changes information. But, if you enter information into database tables using database tools, you may store invalid information. You also lose the ability to track who has changed your information because SQL*Plus and other database tools do not keep a record of changes.

About Oracle

Oracle Corporation develops and markets an integrated line of software products for database management, applications development, decision support and office automation, as well as Oracle Applications. Oracle Applications provides the E–business Suite, a fully integrated suite of more than 70 software modules for financial management, Internet procurement, business intelligence, supply chain management, manufacturing, project systems, human resources and sales and service management.

Oracle products are available for mainframes, minicomputers, personal computers, network computers, and personal digital assistants, enabling organizations to integrate different computers, different operating systems, different networks, and even different database management systems, into a single, unified computing and information resource.

Oracle is the world’s leading supplier of software for information management, and the world’s second largest software company. Oracle offers its database, tools, and application products, along with related consulting, education and support services, in over 145 countries around the world.

Your Feedback

Thank you for using Oracle Public Sector Purchasing and this user guide.

We value your comments and feedback. This guide contains a Reader’s Comment Form you can use to explain what you like or dislike about Oracle Public Sector Purchasing or this user guide. Mail
your comments to the following address or call us directly at (650) 506–7000.

Oracle Public Sector Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway, MS 3op7
Redwood Shores, CA  94065
U.S.A.

Or, send electronic mail to gepddoc_us@oracle.com.
This chapter tells you everything you need to know about setting up, including:

- Overview: page 1 – 2
- Defining Locations: page 1 – 24
- Defining Buyers: page 1 – 27
- Defining Approval Groups: page 1 – 29
- Assigning Approval Groups: page 1 – 33
- Annotating Purchasing Documents: page 1 – 36
- Defining Purchasing Options: page 1 – 45
- Defining Receiving Options: page 1 – 58
- Defining Requisition Templates: page 1 – 62
- Purchasing Hazardous Materials: page 1 – 67
- Defining Lookup Codes: page 1 – 74
- Purchasing Services: page 1 – 79
- Defining Document Types: page 1 – 87
- Controlling Purchasing Periods: page 1 – 93
- Choosing Workflow Options: page 1 – 95
- Self-Service Purchasing Setup Windows: page 1 – 102
- Profile Options in Purchasing: page 1 – 103
Overview of Setting Up

This section contains an overview of each step you need to complete to set up Oracle Public Sector Purchasing. For instructions on how to complete each task, see the setup sections indicated in each step.

Oracle Applications Implementation Wizard

If you are implementing more than one Oracle Applications product, it is recommended that you use the Oracle Applications Implementation Wizard (AIW) to coordinate your setup activities. The Wizard guides you through the setup steps for the applications you have installed, suggesting a logical sequence that satisfies cross-product implementation dependencies and reduces redundant setup steps.

You can use the Wizard to see a graphical overview of setup steps, read online help for a setup activity, and open the appropriate setup window. You can also document your implementation, for further reference and review, by using the Wizard to record comments for each step.

Multiple Reporting Currencies

If you plan to use Multiple Reporting Currencies (MRC) with Oracle Public Sector Purchasing, additional setup steps are required. See: Multiple Reporting Currencies in Oracle Applications.

See Also

Oracle Applications Implementation Wizard User’s Guide
Some of the steps outlined in this flowchart and setup checklist are Required, and some are Optional. Required Step With Defaults means that the setup functionality comes with pre-seeded, default values in the database; however, you should review those defaults and decide whether to change them to suit your public sector needs. If you want or need to change them, you should perform that setup step. You need to perform Optional steps only if you plan to use the related feature or complete certain business functions.

Some of the setup steps you may not need to perform if you’ve already performed a common-application setup (setting up multiple Oracle Applications products).
Setup Checklist

The following table lists setup steps and a reference to their location within the Wizard. For a detailed description of AIW reference levels, see the Oracle Applications Implementation Wizard User’s Guide. After you log on to Oracle Applications, complete these steps to implement Purchasing:

<table>
<thead>
<tr>
<th>Step No.</th>
<th>Required</th>
<th>Step</th>
<th>AIW Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Required</td>
<td>Set Up System Administrator</td>
<td>Common Applications</td>
</tr>
<tr>
<td>Step 2</td>
<td>Required</td>
<td>Define Accounting Key Flexfields</td>
<td>Common Applications</td>
</tr>
<tr>
<td>Step 3</td>
<td>Required</td>
<td>Set Up Calendars, Currencies, and Set of Books</td>
<td>Common Applications</td>
</tr>
<tr>
<td>Step 4</td>
<td>Required</td>
<td>Define Human Resources Key Flexfields</td>
<td>Common Applications</td>
</tr>
<tr>
<td>Step 5</td>
<td>Required</td>
<td>Define Locations</td>
<td>Common Distribution</td>
</tr>
<tr>
<td>Step 6</td>
<td>Required</td>
<td>Define Organizations and Organization Relationships</td>
<td>Common Applications</td>
</tr>
<tr>
<td>Step 7</td>
<td>Optional</td>
<td>Convert to a Multi-Org Architecture</td>
<td>Common Applications</td>
</tr>
<tr>
<td>Step 8</td>
<td>Required</td>
<td>Define Inventory Key Flexfields</td>
<td>Common Applications</td>
</tr>
<tr>
<td>Step 9</td>
<td>Required</td>
<td>Define Units of Measure</td>
<td>Common Applications</td>
</tr>
<tr>
<td>Step 10</td>
<td>Optional</td>
<td>Define Freight Carriers</td>
<td>Common Applications</td>
</tr>
<tr>
<td>Step 11</td>
<td>Required</td>
<td>Define Item Attributes, Codes, and Templates</td>
<td>Common Applications</td>
</tr>
<tr>
<td>Step 12</td>
<td>Required</td>
<td>Define Categories</td>
<td>Common Applications</td>
</tr>
<tr>
<td>Step 13</td>
<td>Optional</td>
<td>Define Catalog Groups</td>
<td>Common Applications</td>
</tr>
<tr>
<td>Step 14</td>
<td>Required</td>
<td>Set Up Personnel</td>
<td>Common Applications</td>
</tr>
<tr>
<td>Step No.</td>
<td>Required</td>
<td>Step</td>
<td>AIW Reference</td>
</tr>
<tr>
<td>---------</td>
<td>----------</td>
<td>-------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Step 15</td>
<td>Required</td>
<td>Set Up Oracle Workflow</td>
<td>Common Applications</td>
</tr>
<tr>
<td>Step 16</td>
<td>Required</td>
<td>Decide How to Use the Account Generator</td>
<td>Oracle Purchasing</td>
</tr>
<tr>
<td>Step 17</td>
<td>Required</td>
<td>Open Inventory and Purchasing Accounting Periods</td>
<td>Common Distribution</td>
</tr>
<tr>
<td>Step 18</td>
<td>Optional</td>
<td>Define Subinventory Locations</td>
<td>Common Distribution</td>
</tr>
<tr>
<td>Step 19</td>
<td>Optional</td>
<td>Define Cross-Reference Types</td>
<td>Oracle Purchasing</td>
</tr>
<tr>
<td>Step 20</td>
<td>Optional</td>
<td>Define Tax Codes</td>
<td>Common Financial</td>
</tr>
<tr>
<td>Step 21</td>
<td>Optional</td>
<td>Define Payment Terms</td>
<td>Common Financial</td>
</tr>
<tr>
<td>Step 22</td>
<td>Required</td>
<td>Set Up Approval Information</td>
<td>Oracle Purchasing</td>
</tr>
<tr>
<td>Step 23</td>
<td>Required</td>
<td>Define Lookups and Classes</td>
<td>Oracle Purchasing</td>
</tr>
<tr>
<td>Step 24</td>
<td>Optional</td>
<td>Define Standard Attachments</td>
<td>Oracle Purchasing</td>
</tr>
<tr>
<td>Step 25</td>
<td>Required</td>
<td>Define Purchasing Options</td>
<td>Oracle Purchasing</td>
</tr>
<tr>
<td>Step 26</td>
<td>Required</td>
<td>Define Buyers</td>
<td>Oracle Purchasing</td>
</tr>
<tr>
<td>Step 27</td>
<td>Optional</td>
<td>Define Items</td>
<td>Oracle Purchasing</td>
</tr>
<tr>
<td>Step 28</td>
<td>Required</td>
<td>Define Line Types</td>
<td>Oracle Purchasing</td>
</tr>
<tr>
<td>Step 29</td>
<td>Required</td>
<td>Start the Purchasing Database Administrator</td>
<td>Oracle Purchasing</td>
</tr>
<tr>
<td>Step 30</td>
<td>Required</td>
<td>Define Financial Options</td>
<td>Common Financial</td>
</tr>
<tr>
<td>Step 31</td>
<td>Optional</td>
<td>Define Transaction Reasons</td>
<td>Oracle Purchasing</td>
</tr>
</tbody>
</table>

Table 1 – 1  (Page 2 of 3)
<table>
<thead>
<tr>
<th>Step No.</th>
<th>Required</th>
<th>Step</th>
<th>AIW Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 32</td>
<td>Required</td>
<td>Define Receiving Options</td>
<td>Oracle Purchasing</td>
</tr>
<tr>
<td>Step 33</td>
<td>Required</td>
<td>Set Up Transaction Managers and Resubmission Intervals</td>
<td>Oracle Purchasing</td>
</tr>
<tr>
<td>Step 34</td>
<td>Required</td>
<td>Define Suppliers</td>
<td>Common Financial</td>
</tr>
<tr>
<td>Step 35</td>
<td>Required</td>
<td>Set Up Workflow Options</td>
<td>Oracle Purchasing</td>
</tr>
<tr>
<td>Step 36</td>
<td>Required</td>
<td>Submit Workflow–related Processes</td>
<td>Oracle Purchasing</td>
</tr>
<tr>
<td>Step 37</td>
<td>Optional</td>
<td>Define Descriptive Flexfields</td>
<td>Common Applications</td>
</tr>
<tr>
<td>Step 38</td>
<td>Optional</td>
<td>Set Up Automatic Sourcing</td>
<td>Oracle Purchasing</td>
</tr>
<tr>
<td>Step 39</td>
<td>Required</td>
<td>Perform Additional System Administrator Setup</td>
<td>Common Applications</td>
</tr>
<tr>
<td>Step 40</td>
<td>Required</td>
<td>Define Manufacturing System and User Profiles</td>
<td>Oracle Purchasing</td>
</tr>
</tbody>
</table>

Table 1 – 1 (Page 3 of 3)
Setup Steps

For those steps that are affected, a Context section indicates whether you need to repeat the step for each set of books, set of tasks, inventory organization, HR organization, or other operating unit under Multiple Organizations.

Step 1  Set Up System Administrator

This step involves the following tasks:

- Create a super user to use as a logon name during setup and assign the super user the required setup responsibilities. Typically, the required responsibilities are as follows (Required):
  - Purchasing
  - System Administrator

- Set up printers. Although you do not have to set up all of your printers now, it may be useful to set up one printer if you wish to print anything during setup. See: Setting Up Your Printers, Oracle Applications System Administrator’s Guide. (Optional)

See: Oracle Applications System Administrator’s Guide.

Step 2  Define Accounting Key Flexfields (Required)

Define Accounting key flexfields and cross validation rules. You may not need to perform this step if you have already installed and set up Oracle Public Sector General Ledger or performed a common–applications setup. See: Oracle Public Sector General Ledger User’s Guide.

Attention: If you are, or will be, fully installing other Oracle applications, be sure to coordinate with those products’ flexfield setup before defining the key flexfields here, as it is not recommended to change flexfields after you acquire any flexfields data.

For instructions on how to set up key flexfields, see: Oracle Applications Flexfields Guide.

Step 3  Set Up Calendars, Currencies, and Set of Books (Required)

If you have defined your calendars, currencies, and set of books while setting up a different Oracle Applications product, proceed to the next step.
Context: If you are performing a Multi–Org implementation of Purchasing, you may optionally create more than one calendar, currency, or set of books. See: Multiple Organizations in Oracle Applications.

This step involves the following tasks:

- Set up calendars:
  - Define period types. See: Defining Period Types, Oracle Public Sector General Ledger User’s Guide.

Note: You can define the following three optional items if you install certain Oracle Manufacturing applications.

  - Define transaction calendar. See: Defining Transaction Calendars, Oracle Public Sector General Ledger User’s Guide. (Optional)
  - Define workday calendar. See: Overview of Workday Calendar, Oracle Bills of Material User’s Guide. (Optional)
  - Define exception templates. See: Creating a Workday Exception Template, Oracle Bills of Material User’s Guide. (Optional)

- Define currencies. See: Defining Currencies, Oracle Public Sector General Ledger User’s Guide.

- Define conversion rate types. See: Defining Conversion Rate Types, Oracle Public Sector General Ledger User’s Guide.

- Define your set of books. You must define at least one set of books for your organization. See: Oracle Public Sector General Ledger User’s Guide.

- Assign your set of books to the current responsibility. See: Oracle Public Sector General Ledger User’s Guide.

- Define currency rates:
  - Define historical rates. See: Entering Historical Rates, Oracle Public Sector General Ledger User’s Guide.
• Set up accounting code combinations. You do not need to perform this task if you allow dynamic entry of code combinations for the chart of accounts corresponding to your Purchasing installation. See: Oracle Public Sector General Ledger User’s Guide.

• Open and close accounting periods. See: Opening and Closing Accounting Periods, Oracle Public Sector General Ledger User’s Guide.

Step 4 Define Human Resources Key Flexfields (Required)

You may not need to set up Human Resources key flexfields if you have already installed and set up Oracle Human Resource Management Systems or performed a common–applications setup. See also: Oracle Human Resources User’s Guide.

⚠️ Attention: If you are, or will be, fully installing other Oracle applications, be sure to coordinate with those products’ flexfield setup before defining the key flexfields here, as it is not recommended to change flexfields after you acquire any flexfield data.

For instructions on how to set up each of the key flexfields listed below, see: Oracle Applications Flexfields Guide.

Define Human Resources and Payroll key flexfields:

• Job flexfield
• Position flexfield
• Grade flexfield
• Cost allocation flexfield
• People Group flexfield
• Personal Analysis flexfield

Step 5 Define Locations (Required)

If you’re also setting up other Oracle applications, you may already have defined locations when you set up those applications.

You are required to set up at least one location for now. You can set up the remaining locations after you define inventory organizations and tax codes.
You may need to revisit this step after you set up organizations, if you want to link a location to an inventory organization.


**Step 6 Define Organizations and Organization Relationships (Required)**

You may not need to perform this step if you have already installed and set up Oracle Inventory or performed a common–applications setup.

For the following tasks relating to setting up organizations, see: *Oracle Human Resources User’s Guide*.


- Assign business groups to responsibilities. Within your responsibility, make sure that the profile option HR: Business Group is set to the business group you want to use for that responsibility. See: *Oracle Human Resources User’s Guide*.

  **Attention:** It is important that the HR: Business Group profile option be set to the business group you want to use before you define organizations as described below.

- Define legal entities organizations.

- Define operating–units and assign them to legal entities.

- Set up inventory organizations. For the following tasks relating to setting up inventory organizations, see: *Oracle Inventory User’s Guide*.
  - Classify the organizations as inventory organizations.
  - Define accounting information for inventory organizations.
  - Define inventory organization parameters.
  - Define receiving options for the inventory organizations. For this task, see: Defining Receiving Options: page 1 – 58.

- Define human resources organizations.

- Define organization hierarchies. See: *Oracle Human Resources User’s Guide*. (Optional)
Step 7  Convert to a Multi–Org Architecture (Optional)

Although optional, this setup step is recommended even if your business is composed of just one operating unit. Performing this step now gives you the flexibility to add operating units later.

This step includes the following tasks:

- Set the profile options **MO: Operating Unit** and **HR: User Type**.
- Run the utility to convert to a Multi–Org architecture. It is recommended to involve your system administrator with this task.

See: *Multiple Organizations in Oracle Applications*.

Step 8  Define Inventory Key Flexfields (Required)

You may not need to set up Inventory key flexfields if you have already installed and set up Oracle Inventory or performed a common–applications setup. See also: *Oracle Inventory User’s Guide*.

Attention: If you are, or will be, fully installing other Oracle applications, be sure to coordinate with those products’ flexfield setup before defining the key flexfields here, as it is not recommended to change flexfields after you acquire any flexfield data.

For instructions on how to set up each of the key flexfields listed below, see: *Oracle Applications Flexfields Guide*.

Define Inventory key flexfields:

- System Items flexfield. After you compile the System Items flexfields, the item flexfield view concurrent request is started.
- Item Category flexfield
- Item Catalog flexfield
- Stock Locator flexfield
- Account aliases flexfields
- Sales orders flexfield

Note: Even if you do not use any of the above flexfields, you must still enable at least one flexfield segment for each and compile them because Oracle Inventory transactions (such as
the Define Items window), inquiries, and reports require a frozen flexfield definition.

**Step 9 Define Units of Measure (Required)**

You may not need to perform this step if you have already installed and set up Oracle Inventory or performed a common-applications setup. See: *Oracle Inventory User’s Guide*.

This step involves the following tasks:

- Define units–of–measure classes.
- Define units of measure.
- Define units–of–measure conversions. You can define three different conversion types for your needs: Standard, Intra–class, or Inter–class.

**Step 10 Define Freight Carriers (Optional)**

If you’re also setting up Oracle Inventory, you may already have performed this step when you set up Inventory. Define freight carriers if you want to specify on a purchase order the freight carrier that a supplier should use.


**Context:** You must perform this step for each inventory organization.

**Step 11 Define Item Attributes, Codes, and Templates**

See: *Oracle Inventory User’s Guide*.

This step involves the following tasks:

- Define item attribute controls. *(Required with defaults)*

  **Default:** Most item attribute groups default to Item Master–level control. The rest default to the Item/Organization level.

- Define container type QuickCodes. These can be used to define physical attributes for items. *(Optional)*

- Define status codes. *(Required with defaults)*

  **Default:** Default status codes include basic statuses such as Active, Inactive, Obsolete, and Prototype.

- Define item type QuickCodes. *(Required with defaults)*
**Step 12 Define Categories**

If you’re also setting up Oracle Inventory, you may already have performed this step when you set up Inventory.

This step involves the following tasks:

- Define category sets. See: Defining Category Sets, *Oracle Inventory User’s Guide*. *(Required with defaults)*
  
  **Default:** Examples of category sets are Inventory and Purchasing.

- Define default category sets. See: Defining Default Category Sets, *Oracle Inventory User’s Guide*. *(Required with defaults)*
  
  **Default:** Each functional area comes with a default category set.

  **Note:** Purchasing requires you to enforce a list of valid categories. Therefore, in the List of Valid Categories in the Category Sets window, you must list all categories that are eligible for that category set. In particular, make sure that the Default Category in the Category Sets window also appears in the List of Valid Categories.

**Step 13 Define Catalog Groups (Optional)**

A catalog group consists of descriptive elements for items to which you assign sets of values such as type, size, or color. If you’re also setting up Oracle Inventory, you may already have performed this step when you set up Inventory.

See: Defining Item Catalog Groups, *Oracle Inventory User’s Guide*. 
Step 14 Set Up Personnel

You may not need to perform this step if you have already installed and set up Oracle Human Resource Management Systems or performed a common-applications setup. See: Oracle Human Resource Management Systems User’s Guide.

This step involves the following tasks:

- Define employee QuickCodes. (Required with defaults)
- Define position hierarchies. You can define one or more position hierarchies to meet your needs. See: Position Hierarchy Window, Oracle Human Resource Management Systems User’s Guide. (Optional)
  Default: If you skip this task, you cannot use position approval hierarchies, but must use the employee/supervisor approval method instead.
- Define the following financial options in the Financial Options window; see: Defining Financials Options, Oracle Public Sector Payables User’s Guide (Required):
  - Employee numbering
  - Position approval hierarchies option (whether to use position approval hierarchies)
  - Inventory organization
  - Business group (Make sure a business group is specified.)
  - Supplier numbering
- Define employees. If you use Purchasing without Oracle Human Resource Management Systems, use the setup window from within Purchasing for defining employees. See: the online help for the Enter Person window. If you use Purchasing with Oracle Human Resource Management Systems, use the setup window for defining employees from within the Human Resource Management Systems application. See: Entering a New Person, Managing People Using Oracle HRMS. (Required)
Note: Purchasing users must have user names, which is a later setup step. These Purchasing user names must be linked to an employee name.

Step 15  Set Up Oracle Workflow (Required)

Since Purchasing uses Oracle Workflow technology to perform document approvals, automatic document creation, and account generation via the Account Generator, you need to set up Oracle Workflow, if you haven’t done so already. See: Setting Up Oracle Workflow, Oracle Workflow Guide.

Step 16  Decide How to Use the Account Generator (Required)

The Account Generator process in Purchasing builds a charge, budget, accrual, and variance account for each purchase order, release, and requisition distribution based on the distribution’s Expense, Inventory, or Shop Floor destination type. You must review the default process that Purchasing uses to see if it meets your accounting requirements. You can optionally customize the Account Generator for each set of books that you have defined. See: Using the Account Generator in Oracle Public Sector Purchasing: page C – 10.

Context: This step needs to be performed for each operating unit.

Step 17  Open Inventory and Purchasing Accounting Periods (Required)

This step involves the following tasks.

• Open Inventory accounting period. See: Maintaining Accounting Periods, Oracle Inventory User’s Guide.

  Context: This task needs to be performed for each inventory organization.


  Context: This task needs to be performed for each set of books.

Step 18  Define Subinventory Locations (Optional)

You can define your own subinventory locations such as Inspection, Cold Storage, or Reject–Disposition. You may not need to perform this step if you have already installed and set up Oracle Inventory. See: Defining Subinventories, Oracle Inventory User’s Guide.
Context: This step needs to be performed for each inventory organization.

Step 19 Define Cross–Reference Types (Optional)

An example of a cross–reference type is one used to cross–reference an item number to the part number that the supplier uses. See: Defining Cross–Reference Types, Oracle Inventory User’s Guide.

Step 20 Define Tax Codes (Optional)

Define tax codes and assign them recovery rates or rules. You may not need to perform this step if you have already installed and set up Oracle Public Sector Payables or performed a common–applications setup. See: Tax Codes, Oracle Public Sector Payables User’s Guide. See: Partially Recoverable Tax, Oracle Public Sector Payables User’s Guide.

Default: If you skip this step, you will not be able to select a tax code when entering a requisition or purchase order.

Context: This step needs to be performed for each operating unit.

Step 21 Define Payment Terms (Optional)

If you’re also setting up Oracle Public Sector Payables, you may already have performed this step when you set up Payables. You can set up payment terms such as 1/10 Net 30, which indicates that you get a 1% discount if you pay within 10 days and the invoice is due in 30 days.

See: Payment Terms, Oracle Public Sector Payables User’s Guide.

Step 22 Set Up Approval Information

All approvers must be employees and must have a logon user name as described in Step 14 Set Up Personnel.

Note: Even offline approvers must have a user name. An offline approver is someone who approves Purchasing documents without logging on to Oracle Applications and using the Notifications Summary window. To set up offline approvers, see: Offline Approvers: page 2 – 40. You can set up offline approvers at any time, as long as user names have been assigned to all approvers and Workflow has been set up.

Once all approvers have been set up as employees and set up with user names, complete your approval setup as follows:

Context: This step needs to be performed for each operating unit.
• Define approval groups. See: Defining Approval Groups: page 1 – 29. (Required)

• Assign approval groups. See: Assigning Approval Groups: page 1 – 33. (Required)

• Fill employee hierarchy after defining position approval hierarchies. See: Fill Employee Hierarchy Process: page 9 – 41. If you are using position approval hierarchies, you must run the Fill Employee Hierarchy process. (Optional)

• Define document types. See: Defining Document Types: page 1 – 87. (Required with defaults)

Default: Each Purchasing document (such as a Standard Purchase Order, Blanket Purchase Agreement, Quotation, or Requisition) comes with standard defaults. Update these defaults to meet your security and approval needs.

Step 23 Define Lookups and Classes

This step involves the following tasks:

• Define Purchasing lookups. See: Defining Lookup Codes: page 1 – 74. (Required with defaults)

Default: An example of a default lookup code that Purchasing provides is a Price Type of Fixed. See the section referenced above for a list of the other defaults that Purchasing provides.

• Define inspection codes. See: Defining Quality Inspection Codes: page 1 – 77. (Optional)

Default: If you skip this task, you will not be able to assign inspection codes during receiving.

• Define hazard classes. See: Defining Hazard Classes: page 1 – 70. (Optional)

Default: If you skip this task, you will not be able to assign hazard classes to items or purchase order lines.

• Define United Nations (UN) numbers. See: Defining UN Numbers: page 1 – 71. (Optional)

Default: If you skip this task, you will not be able to assign UN numbers to items or purchase order lines.
Step 24  Define Standard Attachments (Optional)
If you do not want to define standard attachments now, you can do so at any time later. See: Annotating Purchasing Documents: page 1 – 36. See: Attaching Notes to Purchasing Documents: page 1 – 44.

Step 25  Define Purchasing Options (Required)
See: Defining Purchasing Options: page 1 – 45.

Context: This step needs to be performed for each operating unit.

Step 26  Define Buyers (Required)
Employees who will use Purchasing as buyers or managers must all be defined as buyers. See: Defining Buyers: page 1 – 27.

Step 27  Define Items (Optional)
Although you can define items at any point from this step onward, it is recommended that you set up at least one item to ensure that your flexfields are working properly.

Default: If you skip this step, when you create a requisition or purchase order, you will be able to enter only an item description, not an item number.

Context: This step needs to be performed for each inventory organization.

This step involves the following tasks.

• Define items at the master level. See: Master Level vs. Organization Level, Oracle Inventory User’s Guide. See: Defining Items, Oracle Inventory User’s Guide. Note that some Inventory fields in the Master Item window, such as the Serial number fields, are available only if Inventory is fully installed rather than shared.

• Update the default categories assigned to the items.

• Assign items at the organization level. See: Updating Organization Level Items, Oracle Inventory User’s Guide.

• Define item relationships. See: Defining Item Relationships, Oracle Inventory User’s Guide.
Step 28  Define Line Types (Required with defaults)

See: Defining Line Types: page 1 – 84.

Default: Default line types that Purchasing provides include Goods; Services; and Outside Processing, if Work in Process is installed.

Step 29  Start the Purchasing Database Administrator (Required)


Step 30  Define Financial Options (Required)

See: Defining Financials Options, Oracle Public Sector Payables User’s Guide.

Context: This step needs to be performed for each operating unit.

Step 31  Define Transaction Reasons (Optional)

Transaction reason codes allow you to provide predefined explanations for each receiving transaction. Examples of transaction reason codes you can define include No Packlist, Shortage, Recall, or Supplier Error. If you’re also setting up Oracle Inventory, you may already have performed this step when you set up Inventory.

See: Defining Transaction Reasons, Oracle Inventory User’s Guide.

Step 32  Define Receiving Options (Required)

You may not need to perform this step if you’ve already defined receiving options in Step 6 Define Organizations and Organization Relationships. See: Defining Receiving Options: page 1 – 58.

Context: This step needs to be performed for all inventory organizations. Use the Change Organization function in the Purchasing menu to perform this step for each inventory organization.

Step 33  Set Up Transaction Managers and Resubmission Intervals

This step involves the following tasks:

- Start the following transaction managers. See: Administer Concurrent Managers Window, Oracle Applications System Administrator’s Guide. (Required)
  - Receiving transaction manager
  - Document approval manager
- Define resubmission intervals for concurrent processes. Contact your system administrator if you need help with this task. See: Defining Managers and Their Work Shifts, Oracle Applications System Administrator’s Guide. (Optional)

### Step 34  Define Suppliers (Required)

You may not need to perform this step if you have already installed and set up Oracle Public Sector Payables or performed a common-applications setup. See: Entering Suppliers, Oracle Public Sector Payables User’s Guide.

### Step 35  Set Up Workflow Options (Required with defaults)

Purchasing uses Oracle Workflow technology to handle requisition and purchase order approvals, automatic creation of purchase orders and releases, purchase order changes (specifically, any additional approvals those changes require), and receipt confirmation. Workflow runs in the background. It automates these procurement activities whenever you submit a document for approval, create a requisition, or change a purchase order.

**Default:** Purchasing provides default functionality in these Workflow-automated processes. For example, one default functionality is for the automatic document creation workflow to create purchase orders automatically from approved requisition lines. If you do not want this default functionality, you can easily change it in the Oracle Workflow Builder.

For descriptions of the other defaults that Purchasing provides, see: Choosing Workflow Options: page 1 – 95.

### Step 36  Submit Workflow–Related Processes

Start the following Workflow-related processes, if you haven’t already done so in the previous step:

- Send Notifications for Purchasing Documents process. See: Send Notifications for Purchasing Documents: page 9 – 155. (Required)

- Workflow Background Engine. Whether you need to submit this process depends on the options you chose or the defaults you accepted as described in the section Choosing Workflow Options: page 1 – 95. For instructions on submitting the Workflow Background Engine, see: To Schedule Background Engines, Oracle Workflow Guide. (Required with defaults)
Step 37  **Define Descriptive Flexfields (Optional)**

If you do not want to define descriptive flexfields now, you can define them at any time. See: *Oracle Applications Flexfields Guide*.

Step 38  **Set Up Automatic Sourcing (Optional)**

You can set up Purchasing to automatically default source document information from a blanket purchase agreement or catalog quotation onto a requisition or purchase order line for a particular item and supplier. Or you can default just a supplier and optionally a supplier site. See: Setting Up Automatic Sourcing: page 5 – 33.

You can set up automatic sourcing now or at any time on an ongoing basis.

Step 39  **Perform Additional System Administrator Setup**

This step involves the following tasks:

- Define custom menus. *(Optional)*
- Define new responsibilities based on your business and security needs. See: *Oracle Applications System Administrator’s Guide*. *(Optional)*
- Define user names. Purchasing users must have user names, and the user names must be linked to an employee name. See: Users Window, *Oracle Applications System Administrator’s Guide*. *(Required)*

See: *Oracle Applications System Administrator’s Guide*. 
Step 40 Define Manufacturing System and User Profiles (Required)


Context: This step needs to be performed for each operating unit.
Defining Locations

Use the Locations window to define ship-to, receiving, and other location information for Purchasing documents.

To set up locations for Purchasing:

1. Navigate to the Locations window.
2. For information on the Name, Description, Inactive Date, Global, and Address Details fields, follow the instructions in Setting Up Locations, Oracle Human Resources User’s Guide or see the online help for the window.

3. Fill in information in the Shipping Details tabbed region.

Note: Selecting the check boxes means that you are making the location Name a valid location in the list of values on a Purchasing document. For example, selecting Ship-To Site makes the location
Name a valid choice in the list of values for the Ship–To field on a purchase order header. Note that if you define a default Ship–To or Bill–To Location in the Supplier–Purchasing region of the Financials Options window for your organization, that is the location that defaults onto your purchase orders. But if you wanted to change that default, the location Name that you define here and enable as a Ship–To or Bill–To site is available in the list of values for you to choose from in the Ship–To or Bill–To fields.

**Contact:** Optional contact name for the location Name.

**Ship–To Location:** Usually the same as the location Name. You could select a separate, previously defined Ship–To Location—for example, if you wanted to create a location Name, Office A, and specify Receiving Dock A as its Ship–To Location. Note, however, that once you specify a separate Ship–To Location, you can no longer enable the location Name as a Ship–To Site. In this example, Receiving Dock A is the ship–to site for Office A; therefore, Office A itself cannot also be the ship–to site.

**Ship–To Site:** Select this option to make the location Name a valid ship–to organization on a purchase order or requisition.

**Receiving Site:** Select this option to make the location a valid receiving Location when creating a receipt or receiving transaction.

**Office Site:** Select this option to indicate that this location Name is an office site, such as a field office.

**Bill–To Site:** Select this option to make the location Name a valid bill–to site. The Bill–To Site, which is used by Payables, is specified on a purchase order header.

**Internal Site:** Select this option to make the location a valid internal ship–to location when creating an internal requisition.

4. Optionally fill in information in the Other Details tabbed region.

**Inventory Organization:** Select an inventory organization within which this location will be available in the list of values on a Purchasing document. By selecting no inventory organization, this location becomes available on Purchasing documents in all organizations.

**Tax Name:** Select a tax code to associate with the ship–to location. If you check the Ship–To Location option in the Purchasing tax default hierarchy, this is the tax code that defaults onto your requisitions and purchase orders, depending on your hierarchy. See Defining Tax Defaults Options: page 1 – 55.
EDI Location: If you use Electronic Data Interchange (EDI) to receive Advance Shipment Notices (ASNs) or ASNs with billing information (ASBNs), enter a defined location. This location should match the ship–to location specified on an ASN or ASBN. See: Advance Shipment Notices (ASNs): page 7 – 17.

5. If you want to use the Extra Information button to enter additional information required by your business, see: Entering Extra Information, Oracle Human Resources User’s Guide or see the online help for the window.
Defining Buyers

Use the Buyers window to define and maintain your buyers. Buyers can review all requisitions using the Requisitions window, and only buyers can enter and autocreate purchasing documents. See the Document Types window for rules governing access to documents. See: Defining Document Types: page 1 – 87.

Prerequisites

❑ Define employees before performing this step. See: the online help for the Enter Person window.

❑ Define locations before performing this step. See: Defining Locations: page 1 – 24.

To define buyers:

1. Navigate to the Buyers window by selecting Buyers from the menu.
2. Enter the Name of an employee who you want to define as a buyer. If the name you want does not appear in the list of values, use the Enter Person window to enter that person as an employee. See: the online help for the Enter Person window.
3. Enter the default purchasing Category of the goods the buyer typically orders. Purchasing defaults this value in the Category field when you are autocreating documents. See: Defining Categories, *Oracle Inventory User’s Guide*.

4. Enter the name of the ship-to location for which the buyer typically creates purchase orders. Purchasing defaults this value when you are autocreating documents.

5. Enter the Start Date that you want to initiate the responsibilities for a buyer. The default is the current date.

6. Enter the End Date after which the employee is no longer a buyer.

7. Save your work.
Defining Approval Groups

Use the Approval Groups window to define and update approval groups. Once you have defined an approval group here, you can then use it to assign approval functions to jobs or positions in the Approval Assignments window. You cannot delete an approval group that is used in an active assignment. You can enable or disable the entire approval group, or you can enter inactive dates for individual approval rules.

Prerequisites

❑ Define employees before performing this step. See: See: the online help for the Enter Person window.

❑ Review how your choices in this window affect your approval routing. See: Defining Approval Authorization Rules: page 2 – 16.

To define approval groups:

1. Navigate to the Approval Groups window by selecting Approval Groups from the menu.
2. Enter the Name of the approval group. You can change existing approval group names, but names must be unique.

3. Select Enabled to permit the approval group to be assigned to a position/job in the Approval Assignments window.

4. Choose one of the following Objects:

   * **Account Range** – (Required) For this option, you enter the accounting flexfields for the Low and High Values. Include Type rules identify accounts that you want to be included on the document. Exclude Type rules identify accounts that you do not want on the document. If you do not enter a rule for an account, the default is to exclude the account. If you enter only an Exclude Type rule, Purchasing does not automatically include everything else.

For example, entering only the following account includes account 01.000.0451 and excludes all else:

<table>
<thead>
<tr>
<th>Object</th>
<th>Type</th>
<th>Amount Limit</th>
<th>Low Value</th>
<th>High Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Range</td>
<td>Include</td>
<td>50,000.00</td>
<td>01.000.000000000.000000</td>
<td>02.999999999999</td>
</tr>
<tr>
<td>Account Range</td>
<td>Include</td>
<td>01.000.0451</td>
<td>01.000.0451</td>
<td></td>
</tr>
</tbody>
</table>
Entering only the following account excludes all accounts:

<table>
<thead>
<tr>
<th>Account Range</th>
<th>Exclude</th>
<th>01.000.0451</th>
<th>01.000.0451</th>
</tr>
</thead>
</table>

Entering only the following two accounts includes all accounts except 01.000.0451:

<table>
<thead>
<tr>
<th>Account Range</th>
<th>Include</th>
<th>00.000.0000</th>
<th>ZZ.ZZZ.ZZZZ</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Exclude</td>
<td>01.000.0451</td>
<td>01.000.0451</td>
</tr>
</tbody>
</table>

The Inactive Date is optional, but you must enter an Amount Limit for Include Type rules.

*Document Total* – (Required) The document total refers to the monetary limit on an individual document. For this option, the Type defaults to Include, and you can enter only the Amount Limit (required) and the Inactive Date (optional).

*Item Category Range* – For this option, you enter the purchasing category flexfields for the Low and High Values. Include Type rules identify manufacturing categories that you want to be included on the document. Exclude Type rules identify categories that you do not want on the document. If you do not define a rule for a category, the default is Include. The Inactive Date is optional, but you must enter an Amount Limit for Include Type rules.

*Item Range* – For this option, you enter the item flexfields for the Low and High Values. Include Type rules identify items that you want to be included on the document. Exclude Type rules identify items that you do not want on the document. If you do not define a rule for an item, the default is Include. The Inactive Date is optional, but you must enter an Amount Limit for Include Type rules.

*Location* – The location refers to the deliver-to location on a requisition as well as the ship-to location on purchase orders and releases. Include Type rules identify locations that you want to be included on the document. Exclude Type rules identify locations that you do not want on the document. For this option, you enter the location in the Low Value field. If you do not define a rule for a location, the default is Include. The Inactive Date is optional, but you must enter an Amount Limit for Include Type rules.

5. Select the rule Type: Include or Exclude indicates whether to allow objects that fall within the selected range.
6. Enter the Amount Limit. This is the maximum amount that a control group can authorize for a particular object range. This field is required only for Include type rules.

7. Enter the Low Value. This is the lowest flexfield (accounting, purchasing category, or item) in the range pertinent to this rule. When the object is Location, enter the location. You cannot enter this field when the object is Document Total.

8. Enter the High Value. This is the highest flexfield (accounting, purchasing category, or item) in the range pertinent to this rule. You cannot enter this field when the object is Location or Document Total.

9. Enter the Inactive Date on which Purchasing will no longer use this rule in formulating the group.

10. Save your work.

**See Also**

- Defining Approval Assignments: page 1 – 33
- Approval Authorization Rules: page 2 – 16
- Defining Approval Authorization Rules: page 2 – 16
- Using Approval Assignments: page 2 – 19
Assigning Approval Groups

Use the Assign Approval Groups window to assign approval groups and approval functions to positions or jobs. If you are using approval hierarchies (the Use Approval Hierarchies option in the Financials Options window is enabled), you must first use the Approval Groups window to establish rules for your approval groups. Then you can assign approval groups to positions in this window. When you are not using approval hierarchies, you can use this window to assign approval groups and approval functions to jobs within your organization.

Prerequisites

- Define approval groups before performing this step. See: Defining Approval Groups: page 1 – 29.
- Review how your choices in this window affect your approval routing. See: Using Approval Assignments: page 2 – 19.

To assign approval groups:

1. Navigate to the Assign Approval Groups window by selecting Assignments from the menu.
2. Enter the Position for which you want to assign approval groups and approval functions. If the Use Approval Hierarchies option in the Financial Options window is not enabled, this field is not applicable.

3. If you are not using approval hierarchies, enter the Job.

4. Select the approval function you want to assign to this position or job.

5. Enter the approval group that you want to assign to the selected position or job. The list of values includes only enabled approval groups with at least one approval rule. See: Defining Approval Groups: page 1 – 29.

6. Enter the Start Date and End Date for the assignment.

**Attention:** The start and end dates that you assign here are the effectivity dates of the assignment. When the system date reaches the end date of the assignment, the rule no longer applies. There is no explicit warning that the rule is no longer in effect.

7. Save your work.
See Also

Defining Financials Options, Oracle Public Sector Payables User's Guide


Defining Approval Groups: page 1 – 29

Approval Authorization Rules: page 2 – 16

Defining Approval Authorization Rules: page 2 – 16

Using Approval Assignments: page 2 – 19
Annotating Purchasing Documents

Purchasing provides you with powerful features to create attachments for your purchasing documents. You can provide unlimited text, specify who can review the attachments, and print text attachments onto your purchase orders. You can even modify existing attachments to personalize your messages for different suppliers. You can easily provide all the information you need when you create your purchasing documents. You should be able to:

- Provide unlimited text attachments on your purchasing documents
- Designate the appropriate people who can review the attachments
- Print text attachments on your purchase orders and RFQs for the supplier to review
- Reuse attachments on different documents
- Copy and modify existing attachments to speed up data entry
- Copy attachments from your requisitions to your RFQs and purchase orders
- Provide standard attachments for an item that you can reference whenever you create a purchasing document for that item

Major Features

Copy

You can copy an existing long attachment so that you can customize it without having to retype the entire attachment. This feature is particularly useful if you have a lengthy document that you want to modify for different suppliers.

Usage

You can indicate who has access to your long attachments. You indicate whether the attachment is for an approver, receiver, buyer, or supplier. Or you can indicate that you want the attachment for internal use only. You can also enter attachments that will be displayed during invoice matching in Accounts Payable. To understand how to enter and review attachments for different usages, see: Managing Attachments: page 1 – 38.
Using Brief Notes

You can provide brief notes on most of your documents. Unlike attachments, you cannot copy notes from one document to the next. You should provide notes when the attachment contains no more than 240 characters, you do not want to reuse the note on other documents, or you do not want to format the note. Otherwise, you should use attachments to provide additional text for your documents.

Using Attachments

You can provide as much text as you want for your documents. You can provide attachments at the header and line level for the following documents:

- Requisitions
- Standard and Planned Purchase Orders (also shipment level)
- Blanket Purchase Agreements
- Releases (header and shipment levels)
- Contract Purchase Agreements (header level only)
- RFQs
- Quotations
- Receipts (line level only)
- Receiving Transactions (line level only)

You can also provide attachments for your items. When you create an attachment, you designate whether you want the attachment to be available to the supplier, receiver, approver, or buyer. Or, you can designate that you want the attachment to appear to anyone who has access to that particular document on-line. To understand how to create attachments for different usages, see: Managing Attachments: page 1 – 38.

See Also

Attaching Notes to Purchasing Documents: page 1 – 44

Managing Attachments: page 1 – 38
Managing Attachments

Item Attachments

You can provide attachments for your items. When you reference an item on a purchasing document, Purchasing makes the corresponding item attachments available for you to review. Purchasing also prints text attachments on your purchase orders and RFQs if you choose Supplier as the usage when you create the item attachment.

Requisition and Standard Purchase Order Attachments

You can create attachments for your requisition headers and lines. When you AutoCreate a requisition line onto a purchase order, Purchasing copies the attachments from the requisition header and line to the corresponding purchase order line. As a buyer, you can provide additional attachments to a purchase order even after you AutoCreated it from a requisition.

If the purchase order line references more than one requisition line, Purchasing copies only the header and line attachments from the requisition line that is the basis for the purchase order line. For example, if you place multiple requisition lines onto a single purchase order line, Purchasing copies only the requisition header and line attachments from the line where you use the Copy option.

For each requisition line copied, the corresponding header level attachment is copied. For example, you have a requisition with 3 lines and they have 3 line level attachments and a header level attachment. You then AutoCreate this requisition to a purchase order with 3 lines, each of the 3 lines in the purchase order would have the specific line attachment and the common header attachment.
Blanket Purchase Agreement and Release Notes

You can create long attachments for your blanket purchase agreements at the header and line level. You can review the blanket purchase agreement header attachment on the corresponding release header, and you can enter new attachments on the release header. You can also review the blanket agreement line attachment on the corresponding release shipment, and you can enter new attachments for the shipments. Purchasing does not copy requisition attachments to a blanket agreement or release when you AutoCreate a release.
Requisition, RFQ, and Quotation Notes

Similar to standard purchase orders, Purchasing copies requisition header and line attachments to the corresponding RFQ line. Purchasing copies all RFQ header and line attachments to the corresponding quotation header and line when you copy a quotation using the Entire RFQ or RFQ Header and Lines options in the Copy Document window. Purchasing copies only the attachments from the RFQ header to the quotation header when you copy a quotation using RFQ Header Only. If you choose the Selective option when copying a quotation, Purchasing copies the RFQ header attachments to the quotation header and lets you decide which line attachments you want to copy to the quotation line.
Printing Attachments

You can print text attachments on your purchase orders and RFQs. To print an attachment on a purchase order or an RFQ, simply designate Supplier as the usage for the attachment. Purchasing prints these attachments on the corresponding purchase order or RFQ. Purchasing prints as much as possible on each page and continues printing on the next page where applicable.

Purchasing also prints item attachments and attachments with usage Receiver on the Receipt Traveler.

Usages in Attachments

You can enter unlimited attachments on any requisition, purchase order, quotation, or request for quotation (RFQ). You decide which standard attachments to print on your documents and reports. You can easily combine the one–time attachments you enter for a specific document with predefined standard attachments. You can even create a new attachment directly from an existing attachment or use attachments to enter long descriptions for the items you purchase.
Understanding Usages

Purchasing provides you with a list of predefined usages you can use depending on the type of document you create. The following list shows the usages available for each document you can create.

**Supplier**
You can use this usage on purchase orders, RFQs, quotations, requisitions, and for items. Purchasing prints all Supplier text attachments on your documents.

**Receiver**
You can use this usage on purchase orders, quotations, RFQs, receipts, requisitions, and for items. Purchasing displays these attachments to the receiver in the receiving windows and prints text attachments on the Receipt Traveler.

**Approver**
You can use this usage on requisitions. Purchasing displays these attachments to the approvers when they approve your requisitions.

**Buyer**
You can use this usage on requisitions. Purchasing displays these attachments to the buyers when they create purchase orders from your requisitions.

**[Document]**
You can enter these attachments only on a specific [Document]. Reference this usage when you want to enter information specific to a purchase order, quotation, RFQ, receipt, requisition, or item. Purchasing does not print or display these attachments outside the window you use to enter the document. RCV Internal attachments, however, are printed on the Receipt Traveler.

**Payables**
You can use this usage on purchase orders. Purchasing displays these attachments during invoice matching in Accounts Payable.

Defining a Standard Attachment

To define a standard attachment, you simply provide the usage for this attachment, a meaningful and unique name, and the attachment itself. You can also provide a start date and end date to control the availability of this attachment. Purchasing defaults today’s date as the start date for standard attachments. You can easily inactivate an attachment by entering an end date for it. You cannot use a standard attachment on a document after the end date has expired. You define standard attachments in the Documents window. See: Defining Product Specific Documents, Oracle Applications User’s Guide.
Referencing a Standard Attachment

After you define your standard attachments, you can reference them on your documents. You can reference as many standard attachments to your documents as you want.

See Also

Attaching Notes to Purchasing Documents: page 1 – 44
Attaching Notes to Purchasing Documents

You can attach files, such as notes, comments, spreadsheets, and graphics to your application data.

For example, in Purchasing, you can attach files to purchasing documents.

An attached file may include comments, for example if the buyer would like to be notified when an item fails inspection.

To attach notes to purchasing documents:
- Choose the Attachments icon.

See Also

About Attachments, Oracle Applications User’s Guide
Working With Attachments, Oracle Applications User’s Guide
Annotating Documents: page 1 – 36
Managing Attachments: page 1 – 38
Defining Purchasing Options

Use the Purchasing Options window to define default values and controls for functions throughout Purchasing. You can often override purchasing options when you are creating documents.

You can define specific categories of options when you select one of the following:

**Accrual Options**
Define accrual options, such as whether you accrue expense items at period end or upon receipt. See: Defining Accrual Options: page 1 – 48.

**Control Options**
Define control options, such as the receipt close point. See: Defining Control Options: page 1 – 49.

**Default Options**
Define default options, such as the minimum release amount. See: Defining Default Options: page 1 – 45.

**Internal Requisition Options**
Define the required order type and order source for internal requisitions. You can navigate to this window only when Purchasing, Order Management, and Inventory are installed. See: Defining Internal Requisition Options: page 1 – 52.

**Numbering Options**
Define the numbering method, numbering type, and next number for each of your documents. See: Defining Numbering Options: page 1 – 53.

**Tax Defaults Options**
Define the sources from which purchasing documents default tax information. See Defining Tax Defaults Options: page 1 – 55.

---

Defining Default Options

- To define default options:
2. Select one of the following ReqImport Group By options for requisitions imported through the requisition open interface: All (not grouped), Buyer, Category, Item, Location, or Supplier. See: Requisition Import Process: page 9 – 144.

3. Select the currency Rate Type that defaults on requisitions, purchase orders, RFQs, and quotations. If the Rate Type is User, you can override this default for each document line. If either your functional currency (defined in your set of books) or your transaction currency (the currency you enter in a purchasing document window) is Euro (the European Monetary Unit currency), and the other is another European currency, Purchasing defaults in the appropriate conversion Rate Type, Rate, and Rate Date. See: Defining Conversion Rate Types, Oracle Public Sector General Ledger User’s Guide.

4. Enter the Minimum Release Amount that defaults on blanket, contract, and planned purchase orders. This amount is in your functional currency. See: Overview of Multi–Currency Accounting, Oracle Public Sector General Ledger User’s Guide.

5. Select the Price Break Type that defaults on blanket purchase orders:

   **Cumulative:** Price breaks apply to the cumulative quantity on all release shipments for the item.

   **Non–cumulative:** Price breaks apply to quantities on individual release shipments for the item.
6. Select the Price Type that defaults on purchase orders. Use the Lookup Codes window to define price types. See: Defining Lookup Codes: page 1–74.

7. Enter the Quote Warning Delay. This is the number of days before a quotation expires that you want to receive an expiration warning. When a quotation is due to expire within the number of days you provide here, you receive the following message in the Notifications Summary window: Quotations active or approaching expiration: [number]. See: Viewing and Responding to Notifications: page 2–31.

8. Select RFQ Required to require an RFQ for an item before you can autocreate the corresponding requisition line onto a purchase order. You can override this value for each item or requisition line.

9. Enter the Receipt Close tolerance percentage for your shipments. Purchasing automatically closes a shipment for receiving if it is within the receiving close tolerance at the receiving close point. Set the receiving close point in the Control Options window. You can override this option for specific items and orders. See: Defining Control Options: page 1–49.

10. Enter the Invoice Close tolerance percentage for shipments. Purchasing automatically closes a shipment for invoicing if it is within the invoicing close tolerance at billing, when Payables matches invoices to purchase orders or receipts. You can override this option for specific items and orders. See: Defining Control Options: page 1–49.

11. Select a default Line Type for requisition, RFQ, quotation, and purchase order lines. When you create any of these documents, the line type is part of your item information. You can override the line type for each document line. See: Defining Line Types: page 1–84.

Attention: This field is enterable only when the form is accessed from the Purchasing menu.

12. Select one of the following options for Match Approval Level:

   Two-Way: Purchase order and invoice quantities must match within tolerance before the corresponding invoice can be paid.

   Three-Way: Purchase order, receipt, and invoice quantities must match within tolerance before the corresponding invoice can be paid.
Four-Way: Purchase order, receipt, inspection, and invoice quantities must match within tolerance before the corresponding invoice can be paid.

See: Receiving Controls, Options, and Profiles: page 7 – 9.

Note: The Invoice Match Option in the purchase order Shipments window and the Match Approval Level here are independent options. The Invoice Match Option determines whether Payables performs invoice matching to the purchase order or the receipt. You can perform whichever Invoice Match Option you want on a shipment regardless of the Match Approval Level you choose here.

13. Save your work.

Defining Accrual Options

To define accrual options:

1. Navigate to the Accrual tabbed region in the Purchasing Options window.

2. Choose one of the following Accrue Expense Items options:

Accrue Expense Items: At Receipt
Accrue Inventory Items: At Receipt
Expense AP Accrual Account: 01.000.2220.0000.000
Accrual Account Description: Operations.Balance Sheet.Accounts 1
Setting Up

At Receipt: Accrue expense items upon receipt. You can override this flag in the Shipment Details window when you are entering purchase orders and releases.

Period End: Accrue expense items at period end.

**Attention:** When using Cash Basis Accounting, you should set this option to Period End, but you will not normally run the Receipt Accrual – Period End process.

3. For Accrue Inventory Items, you currently have only one choice: On Receipt.

4. Enter the default Expense AP Accrual Account.

5. Save your work.

---

### Defining Control Options

To define document control options:

1. Navigate to the Control tabbed region in the Purchasing Options window.

![Purchasing Options (Vision Operations)](image)

- **Price Tolerance**
  - Enter the Price Tolerance Percent. This is the percentage by which the autocreated purchase order line price cannot exceed the requisition line price. If you select Enforce Price Tolerance, you can

2. **Enforce Full Lot Quantity**

3. **Receipt Close Point**

4. **Cancel Requisitions**

5. **Enforce Buyer Name**

6. **Enforce Vendor Hold**
create, but not approve, purchase orders for which this tolerance is exceeded. There is no restriction on how much a price can decrease.

3. Select Enforce Price Tolerance if you want Purchasing to enforce the price tolerance percentage.

4. Select one of the following values for the Enforce Full Lot Quantity option:

   * **None**: The requisition quantity is not rounded to the lot quantity.
   * **Automatic**: The requisition quantity is forced to the rounded quantity.
   * **Advisory**: An advisory message suggesting rounding and a suggested rounding quantity are displayed, but you can override.

Enforce Full Lot Quantity is used for rounding quantities on Internal Requisitions, for example:

System Options Enforce Full Lot Quantities = Yes
Items Rounding Factor = 75%
Items Unit of Issue = DZ
Unit of Measure on Internal Requisition = Each

If the user enters 6 Each on the Internal Requisition, the quantity will be rounding to 0. If the user enters 11 Each on the Internal Requisition, the quantity will be rounded to 12 Each.


5. Select Display Disposition Messages if you want to see any disposition messages defined against inventory items when they are placed on requisitions.

6. Select the Receipt Close Point, which is when the shipment is closed for receiving: Accepted (passed inspection), Delivered, or Received. Note that you need to set the receipt close tolerance percentage in the Default Options window. See: Defining Default Options: page 1 – 45.

7. Select Notify If Blanket PO Exists if you want to be notified of existing blanket purchase agreements when you create a requisition, purchase order, or blanket purchase agreement line for the item. If you sourced the item, you see the following message: Blanket purchase order [number] already exists for this item. Your requestors can directly create a release for the blanket purchase agreements instead of creating a requisition or purchase order if you allow your requestor to enter releases. See: Viewing and Responding to Notifications: page 2 – 31.
8. The Cancel Requisitions options apply only to requisitions from which purchase orders were autocreated. Select one of the following:

*Always:* When canceling the purchase order, Purchasing also cancels the requisition.

*Never:* When canceling the purchase order, Purchasing does not cancel the requisition, so it is again available for inclusion on a purchase order.

*Optional:* When canceling the purchase order, you are given the option to cancel the requisition. See: Controlling Documents: page 2 – 55.

9. You can define for each item whether you allow updating of the item description during the creation of requisition, RFQ, quotation, or purchase order lines. This update affects *only* the line you are creating. Select Allow Item Description Update if you want Yes to be the initial default of the Allow Description Update attribute when you are defining a new item.

10. Select a Security Hierarchy, which is a position hierarchy from the Position Hierarchy window. When the Security Level is set to Hierarchy for a document in the Document Controls window, this position hierarchy governs access security for the document.

   **Attention:** This field is enterable only when the form is accessed from the Purchasing menu.

11. Select Enforce Buyer Name to enforce entry of only your name as the buyer on purchase orders. Otherwise, you can enter the name of any active buyer. See: Defining Buyers: page 1 – 27.

12. Select Enforce Supplier Hold if you do not want to be able to approve purchase orders created with suppliers that are on hold. Use the Suppliers window to place suppliers on hold. See: About Suppliers, Oracle Public Sector Payables User’s Guide.

   **Note:** Even if you put a supplier on hold in the Suppliers window, you can still approve a purchase order to that supplier if Enforce Supplier Hold is not checked here.

13. Save your work.
Defining Internal Requisition Options

To define internal requisition options:

1. Navigate to the Internal Requisition tabbed region in the Purchasing Options window.

Attention: The following two fields are enterable only when the form is accessed from the Purchasing menu.

2. Select the default Order Type for internal requisitions.

Attention: The Order Type field is visible only if the application Oracle Order Management is installed.

Order types are defined in Order Management. The order type you choose here is the type that Purchasing uses to create sales orders from internal requisitions.

3. Select the default Order Source for internal requisitions.

Purchasing defaults and only uses Internal. This is the source OrderImport uses to transfer internal requisitions from Purchasing to Order Management.

4. Save your work.
Defining Numbering Options

Purchasing numbers requisitions, purchase orders, quotations, and RFQs within operating units in a Multi-Org setup. So, for example, Purchasing allows the same requisition number to be used by different operating units.

Purchasing also numbers receipts within inventory organizations rather than across inventory organizations. So, for example, the same receipt number could be used by different inventory organizations. To define receipt numbering options, see: Defining Receiving Options: page 1 – 58.

To define numbering options for your documents:

1. Navigate to the Numbering tabbed region in the Purchasing Options window.

2. Select the [Document] Number Entry method for RFQ, quotation, purchase order, and requisition numbers:

   * **Automatic**: Purchasing automatically assigns a unique sequential number to each document when you create the document.
   * **Manual**: You provide a document number manually when you enter the document.
Attention: You can change the method of entering document numbers at any time. If you originally allow manual entry and switch to automatic entry, make sure to enter a Next Number that is higher than the highest number you assigned manually.

3. Select the [Document] Number Type you want Purchasing to use for RFQ, quotation, purchase order, and requisition numbers: Numeric or Alphanumeric.

Attention: If you choose Automatic document number entry, you can generate only numeric document numbers, but you can still import either numeric or alphanumeric values from another purchasing system.

Attention: If you import purchasing documents from a foreign system that references alphanumeric numbers, you must choose Alphanumeric as your number type, regardless of your numbering method.

If you choose Manual document number entry, you can choose numeric or alphanumeric numbers. You can change the document number type from Numeric to Alphanumeric whenever you want. You can change the document number type from Alphanumeric to Numeric only if all your current document numbers are numeric.

Attention: The ordering of numeric values in lists of values can appear random when you use the Alphanumeric number type. If you are using Alphanumeric numbering, consider entering all numeric values with the same number of digits. For example, if you can assume all numeric values contain six digits, you should enter the first value as 000001.

4. Enter the Next Number. This is the starting value you want Purchasing to use for generating unique sequential document numbers if you choose Automatic document number entry. Purchasing displays the next document number that will be used for a new document when you create the new document. You cannot enter this field if you choose Manual document number entry.

If you use Master Scheduling/MRP, Inventory, Work in Process, or any non-Oracle system to create requisitions automatically, you must also let Purchasing number the corresponding requisitions automatically.

5. Save your work.
Defining Tax Defaults Options

The tax defaults you select in this window are used in the following windows and processes in Purchasing:

- Shipments window for standard and planned purchase orders
- Requisition lines in the Requisitions window
- Purchase order line shipments created by the AutoCreate Documents window
- Shipments tabbed region in the Releases window (for blanket releases)
- Release shipments created by the Create Releases process
- RFQ Shipments window (for Bid or Standard RFQs) or RFQ Price Breaks window (for Catalog RFQs)
- Quotation shipments window (for Bid or Standard quotations) or Quotation Price Breaks window (for Catalog quotations)


Each source you choose below corresponds to a tax code. For more information on defining tax codes, see: Defining Tax Codes, Oracle Public Sector Payables User’s Guide. See also: Defining Locations: page 1 – 24.

2. Check one or more of the tax defaults sources from which your purchasing documents default tax codes.

*Ship-To Location* – The tax code defaults from the Tax Code you entered in the Location window.

*Item* – The tax code defaults from the Tax Code value you entered in the Purchasing region of the Master Item or Organization Item windows. The tax code defaults first from the item and the ship-to organization, if available; if not, it defaults from the item and inventory organization.

*Supplier Site* – The tax code defaults from the Invoice Tax Code in the Invoice Tax region of the Supplier Sites window (accessible from within the Suppliers window).

*Supplier* – The tax code defaults from the Invoice Tax Code value in the Invoice Tax region of the Suppliers window.


3. In the Hierarchy column, enter a ranking number (starting with 1) for each of the tax defaults sources you checked (even if you checked only one).

For example, you may check Item, Supplier Site, and Supplier and rank them 3, 2, and 1 respectively. This means that when your purchasing documents default tax information, they look first for tax information from the supplier; if that tax information is not
found, they look next for tax information from the supplier site; if that’s not found, they look for tax information corresponding to the item.

4. Save your work.

See Also

Tax Control Methods, *Oracle Public Sector Payables User’s Guide*
Defining Receiving Options

Use the Receiving Options window to define options that govern receipts in your system. Most of the options that you set here can be overridden for specific suppliers, items, and purchase orders. See: Receiving Controls, Options, and Profiles: page 7 – 9.

To define receiving options:

1. Navigate to the Receiving Options window from the menu.

2. Enter the maximum acceptable number of Days Early and Days Late for receipts.

3. Enter the Action for Receipt Date Control. This field determines how Purchasing handles receipts that are earlier or later than the allowed number of days selected above. Choose one of the following options:
   
   None – Receipts may exceed the allowed days early or late.
   
   Reject – Purchasing does not permit receipts outside the selected number of days early or late.
Warning – Purchasing displays a warning message but permits receipts outside the selected number of days early or late.

4. Enter the maximum acceptable over-receipt Tolerance percentage.

5. Enter the Action for Overreceipt Quantity Control. This field determines how Purchasing handles receipts that exceed the quantity received tolerance. Choose one of the following options:

None – Receipts may exceed the selected tolerance.

Reject – Purchasing does not permit receipts that exceed the selected tolerance.

Warning – Purchasing displays a warning message but permits receipts that exceed the selected tolerance.

6. Choose an action for ASN Control. This field determines how Purchasing handles receiving against purchase order shipments for which an Advance Shipment Notice (ASN) exists. Choose one of the following options.

None – Purchasing does not prevent or warn you when you try to receive against a purchase order shipment for which an ASN exists.

Reject – Purchasing gives you a message and prevents you from receiving against a purchase order shipment for which an ASN exists.

Warning – Purchasing gives you a message informing you that an ASN exists for the purchase order shipment and lets you decide whether to receive against the purchase order shipment or its ASN.

7. Check Allow Substitute Receipts if you want to receive substitute items in place of ordered items. You must define substitute items in the Item Relationships window before you can receive them. You can override this option for specific suppliers, items, and orders. See: Defining Item Relationships, Oracle Inventory User’s Guide.

8. Check Allow Unordered Receipts if you want to receive unordered items. You can later match the unordered receipts to a purchase order. If you enable this option, you can override it for specific suppliers and items.


11. Select Allow Blind Receiving if you want blind receiving at your site. Blind receiving helps you ensure that receivers record the exact amount they receive. With blind receiving, you cannot see the quantity due or the quantity ordered for shipments when you receive items. Purchasing ignores all quantity receipt tolerances to help ensure that you can receive the exact amount the supplier shipped.

12. Enter the default Receipt Routing that you assign goods: Direct Delivery, Standard Receipt, or Inspection Required. You can override this option at receipt time by changing the destination type for specific suppliers, items, and orders if the RCV: Allow Routing Override user profile is set to Yes. See: Profile Options in Purchasing; page 1 – 103.

13. Enter the Enforce Ship To location option to determine whether the receiving location must be the same as the ship-to location. Choose one of the following options:

   None – The receiving location may differ from the ship-to location.

   Reject – Purchasing does not permit receipts when the receiving location differs from the ship-to location.

   Warning – Purchasing displays a warning message but permits receipts when the receiving location differs from the ship-to location.


   Automatic: Purchasing automatically assigns a unique sequential number to each receipt when you create the receipt.

   Manual: You provide a receipt number manually when you enter the receipt.

   Purchasing numbers receipts within inventory organizations rather than across inventory organizations. So, for example, the same receipt number could be used by different inventory organizations.

   **Attention:** You can change the method of entering receipt numbers at any time. If you originally allow manual entry and switch to automatic entry, make sure to enter a Next Number that is higher than the highest number you assigned manually.

15. Choose the receipt number Type you want Purchasing to use for receipt numbers: Numeric or Alphanumeric.

   **Attention:** If you choose Automatic receipt number entry, you can generate only numeric receipt numbers, but you can still import
either numeric or alphanumeric values from another purchasing system.

Attention: If you have any alphanumeric documents in your system, you must choose Alphanumeric as your number type, regardless of your numbering method.

If you choose Manual receipt number entry, you can choose numeric or alphanumeric numbers. You can change the receipt number type from Numeric to Alphanumeric whenever you want. You can change the receipt number type from Alphanumeric to Numeric only if all your current receipt numbers are numeric.

Attention: The ordering of numeric values in lists of values can appear random when you use the Alphanumeric number type. If you are using Alphanumeric numbering, consider entering all numeric values with the same number of digits. For example, if you can assume all numeric values contain six digits, you should enter the first value as 000001.

16. Enter the Next Receipt Number. This is the starting value you want Purchasing to use for generating unique sequential receipt numbers if you choose Automatic receipt number entry. Purchasing displays the next receipt number that will be used for a new receipt when you create the new receipt. You cannot enter this field if you choose Manual receipt number entry.

17. Enter the accounting flexfield for the default Receiving Accrual Account.

See Also

Defining Purchasing Options: page 1 – 45
Defining Requisition Templates

Use the Requisition Templates window to define requisition templates. These templates automate requisitioning of commonly ordered items like office supplies. To create a requisition for office supplies, requestors in your organization simply use your template and enter the quantity of each item they want to order.

To create a template, you can specify the items individually or you can reference an existing requisition or purchase order. If you reference an existing document, Purchasing adds all lines on the document to the template. You can reference multiple documents to add all their lines to the same template.

After you define a template, you can reference the template in the Supplier Item Catalog. When you do so, Purchasing displays all template lines that are valid for the destination organization, and you can use any of these lines on your requisition. You can create requisitions with this template as long as the requisition creation date is before the template inactive date.

To define requisition templates:

1. Navigate to the Requisition Templates window by selecting Requisition Templates from the menu.
2. Enter the requisition Template name.

3. Enter a Description of the template.

4. Enter the Inactive Date after which you do not want any requestor to create a requisition from this template.

5. Enter the requisition Type: Internal or Purchase. In either case, you can enter individual requisition lines of either type.

**To copy lines to a template:**

1. Select the Copy button to open the Base Document window.
2. Enter the Base Document Type: Purchase Order or Requisition.
3. Enter the base document Number from which you want to copy lines to the template.
4. Choose the OK button to copy all lines of the base document onto
the template. You can choose the Cancel button to return to the
Requisition Templates window without copying.

You can place lines from multiple documents onto the same
requisition template.

► To manually add lines to a template:

1. Use the Lines region to manually add new lines to the template.
You can also remove lines that you have copied from a base
document, and you can change certain information in these lines.

2. Enter a Number in this field to identify the sequence of the line on
your requisition. Purchasing provides default sequence numbers in
increments of one.

3. Enter the line Type. You can enter or change information in this
field only for new lines. The default is from the Purchasing
Options window. See: Defining Default Options: page 1 – 45.

4. Enter the Item number. You can enter or change information in this
field only for new lines.

5. For new lines only, you can enter the item Revision number.

6. If you entered an item, Purchasing displays the purchasing
Category, and you cannot change it. Otherwise, you must enter a
purchasing category.

7. Purchasing displays the item Description from the document you
selected in the Base Document Number field. If you are entering a
new line, the description is from the item master. You can change
the description only if this attribute is active for the item.

8. The Source type determines the source of the requisitioned items.
The choice you have in this field is dependent on your user profile
options and the system profile options. At either level, you may be
restricted to one of the following options: Inventory or Supplier.

Note that if you have both options, you can source requisition lines
independently of the requisition type. You can even mix inventory
and supplier sourced requisition lines in the same requisition.
Purchasing creates one internal sales order for each inventory
source type requisition line on this requisition. The supplier source
type requisition lines go onto purchase orders, either automatically
with AutoCreate Documents or manually with the Purchase Orders
window.

9. Enter the default unit of measure.
10. For supplier sourced lines, you can enter the unit price, and this price is used in the Requisitions window. For inventory sourced lines, the cursor does not enter this field, and the price in the Requisitions window is the actual cost from inventory.

11. Save your work.

**To enter sourcing information:**

You can enter sourcing information for the current line in the lower part of the screen.

1. For supplier source type lines, you can enter the name of the Buyer to whom you want to assign the requisition line. The buyers can query requisition lines that you assign to them when they AutoCreate purchase orders.

2. For supplier source type lines, you can select RFQ Required to indicate that you want to require an RFQ before the buyer can create a purchase order for the requisition. Purchasing displays a warning message if you try to create a purchase order without a required RFQ.

3. For supplier source type lines, you can enter a suggested Supplier for your requisition items. You can choose a supplier from the list of available suppliers. Alternatively, you can suggest a new supplier by entering the name of the supplier directly.

4. For supplier source type lines, you can enter the supplier Site. You can enter this field only if you provide a suggested supplier name. You can choose a supplier site from the list of values. Alternatively, you can enter a new site directly.

5. For supplier source type lines, you can enter the name of your Contact at the supplier site.

6. For supplier source type lines, you can enter the Supplier Item number.

7. For inventory source type lines, you can specify the source Organization.

8. For inventory source type lines, you can optionally specify the Subinventor source. If you do so, Oracle Order Management reserves the goods and uses only the specified subinventory for allocation. If the goods do not exist at the specified subinventory, Order Management backorders them, even if they do exist in another subinventory.
See Also

Overview of the Supplier Item Catalog: page 5 – 8
Purchasing Hazardous Materials

Purchasing provides you with flexible features to handle all your hazardous materials purchasing and receiving requirements. You can clearly identify and classify hazardous materials and print information on your RFQs and purchase orders to ensure that your suppliers pack, label, and ship hazardous materials according to the regulations. You can also review hazardous materials information when receiving items and take the required safety precautions.

Use the Hazard Classes window (See: Defining Hazard Classes: page 1 – 70.) to define the hazard classes you need. Use the UN Numbers window (See: Defining UN Numbers: page 1 – 71.) to define the identification numbers you use and to assign them to hazard classes. Use the Item window to associate hazard classes and UN numbers with your items. See: Defining Items, Oracle Inventory User’s Guide

Regulation Background

Section 19 of the ISRS (International Safety Rating System) requires that you clearly identify and record all orders for hazardous materials. The US Department of Transportation provides similar regulations. These regulations provide an extensive classification system for hazardous materials. The purpose of this classification is to provide detailed requirements for shipping papers, package marking, labelling, and transport vehicle placarding applicable to the shipment and transportation of hazardous materials. For each hazardous material, the classification provides:

Shipping Name  
Describes the item ordered or shipped. Shipping names are regulated in some cases.  
Examples:  
Calcium hydrogen sulfite solution  
Epichlorohydrin  
Fuel oil  
Mercuric oleate, solid  
Petroleum Distillate  
Small arms ammunition
Hazard Class  Categorizes the hazardous material. Most hazardous materials belong to only one hazard class. Some materials belong to more than one hazard class and some materials do not belong to any. If a material belongs to more than one hazard class, you should list these classes in a specific order.

Examples:
- Corrosive Material
- Flammable liquid
- Forbidden
- Combustible liquid
- Poison A
- ORM–A
- Class A explosive

Identification Number  Identifies the hazardous material. Each identification number has a description. There are two types of identification numbers. Identification numbers preceded by "UN" (United Nations) have descriptions appropriate for international and US domestic shipments. Identification numbers preceded by "NA" (North American) apply only to US domestic shipments and shipments between the US and Canada. Identification numbers are not unique. For instance, the same UN Number may correspond to two closely related but different types of materials.

Examples:
- UN0001 Alarm Devices, Explosives
- UN0027 Black powder
- UN0180 Rockets
- NA1133 Cement
- NA2016 Grenade
- UN2016 Ammunition
- UN2769 Benzoic derivative pesticide, liquid
UN2769 Benzoic derivative pesticide, solid

Some hazardous materials do not have a corresponding identification number.
Examples:
Fuse, lighter
Propellant, explosive, liquid

In some cases, hazardous materials that you identify by the same identification number can belong to two different hazard classes.
Example:
Fuel, aviation, turbine engine has the ID Number UN1863, but it can be in either the Flammable Liquid or the Combustible Liquid hazard class.

<table>
<thead>
<tr>
<th>Labels Required</th>
<th>Specifies the labels required for each package of the hazardous material. The regulations provide detailed instruction concerning the format, size, colors, and printing of labels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Examples:</td>
</tr>
<tr>
<td></td>
<td>Flammable liquid</td>
</tr>
<tr>
<td></td>
<td>Explosive C</td>
</tr>
<tr>
<td></td>
<td>Poison B</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Packaging Requirements</th>
<th>Specify the packaging and placarding requirements and exceptions for the hazardous material. Packaging requirements depend mainly on the hazard class for the hazardous material, but there are many exceptions to this rule.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Shipping Requirements</th>
<th>Specify the maximum amount of hazardous material you can carry per package depending on the mode of transportation you use. Also provide additional shipping, handling, storing, or other information about the hazardous material.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Examples:</td>
</tr>
</tbody>
</table>
Defining Hazard Classes

Use this window to define codes for different classes of hazardous materials. You provide the class name, description, and the date after which the class is no longer active. You can assign a hazard class to multiple UN numbers to identify hazardous items.

Purchasing automatically copies hazardous material information onto your documents and prints this information on your purchase orders, RFQs, and Receipt Travelers. Purchasing automatically displays hazardous material information for your receivers.

If you use Multilingual Support (MLS), translations can be entered for the hazard classes from within each of your installed languages. To enter the translations for the hazard classes, select Translations from the View menu. For more information, see the Oracle Applications User’s Guide.

To define hazard classes:

1. Navigate to the Hazard Classes window.
2. Enter a unique name for each hazard class you want to define. For example, you might provide any of the following classes: Explosive, Poisonous, Toxic.

3. Enter a description for your hazard class. You can use this description to provide a more detailed explanation of the hazard class.

4. Enter the date your hazard class becomes inactive. You cannot use the hazard class after this date.

5. Save your work.

See Also

Purchasing Hazardous Materials: page 1 – 67
Defining UN Numbers: page 1 – 71
Defining Items, *Oracle Inventory User’s Guide*

**Defining UN Numbers**  
*POXSTDUN.un_num*

Use this window to define United Nations identification numbers for hazardous materials. You can associate a hazard class with multiple
identification numbers. You can also assign an identification number and a hazard class to each item you define.

Purchasing automatically copies hazardous material information onto your documents. Purchasing prints hazardous material information on your purchase orders, RFQs, and Receipt Travelers and displays this information for your receivers and inspectors.

If you use Multilingual Support (MLS), translations can be entered for the UN numbers from within each of your installed languages. To enter the translations for the UN numbers, select Translations from the View menu. For more information, see the Oracle Applications User’s Guide.

Prerequisites

❑ Define Hazard Classes before performing this step. See: Defining Hazard Classes: page 1 – 70.

To define UN numbers:

1. Navigate to the UN Numbers window.

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
<th>Hazard Class</th>
<th>Inactive Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>UN355</td>
<td>FLAMMABLE</td>
<td>FL1</td>
<td></td>
</tr>
</tbody>
</table>

2. Enter the UN identification number. You can define multiple instances of the same UN number as long as the descriptions are different.

3. Enter a Description for your identification number.
4. Enter the Hazard Class you want to associate with the identification number. This is optional.

5. Optionally enter the Inactive Date for the identification number.

6. Save your work.

See Also

Purchasing Hazardous Materials: page 1 – 67
Defining Hazard Classes: page 1 – 70
Defining Items, Oracle Inventory User’s Guide
Defining Lookup Codes

Use the Oracle Public Sector Purchasing Lookups window to define lookup codes in Purchasing.

Purchasing uses lookup codes to define lists of values throughout the system. A lookup category is called a lookup type, and the allowable values for the lookup type are called lookup codes. You can add your own codes to those initially provided for some of the lookup types, depending on your Access Level.

For example, Purchasing supplies the following Supplier Type codes: Employee and Supplier. You might want to define an additional code called Consultant to use for the purchase of consulting services.

Attention: You cannot change or delete codes once you have added and saved them, but you can change the code descriptions.

For detailed information on defining and updating lookups, see: Lookups, Oracle Applications Developer’s Guide, or see online help.

If you use Multilingual Support (MLS), translations can be entered for the lookups from within each of your installed languages. To enter the translations for the lookups, select Translations from the View menu. For more information, see the Oracle Applications User’s Guide.

To define lookup codes:

1. Navigate to the Oracle Public Sector Purchasing Lookups window from the menu.
2. Enter one of the following predefined lookup Types: 1099 Supplier Exception, Acceptance Type, FOB (free on board), Freight Terms, Minority Group, Pay Group, PO/Requisition Reason, Price Type, Quotation Approval Reason, Reply/Receive Via, and Supplier Type.

3. Enter up to 25 characters as a unique code you want to add to the lookup codes already provided. Purchasing provides the following codes for the listed lookup types:

   **1099 Supplier Exception:** Purchasing provides no 1099 Supplier Exception codes, but you can define your own. These codes are used only in the Payables reports: 1099 Invoice Exceptions Report and 1099 Supplier Exceptions Report.

   **Acceptance Type:** Purchasing provides Accepted Terms, On Schedule, and Unacceptable Changes.

   **FOB:** Purchasing provides no FOB codes, but you can define your own. This code is printed on your purchase orders.

   **Freight Terms:** Purchasing provides no Freight Terms codes, but you can define your own. This code is printed on your purchase orders.
**Minority Group:** Purchasing provides no Minority Group codes, but you can define your own. Minority Group codes are used to classify suppliers for reporting purposes.

**Pay Group:** Pay Groups can be assigned to Payables invoices. Then Payables payment batches can be limited to invoices assigned to a specified Pay Group. The system provides no Pay Group lookups, but you can define your own in this window.

**Price Type:** Purchasing provides Cost Plus Fee, Cost Plus Percentage, Fixed, Indexed, and Variable.

**Quotation Approval Reason:** Purchasing provides Best Delivery, Best Design, Lowest Price, Only Source, Quality, and Service.

**Reply/Receive Via:** Purchasing provides no Reply/Receive Via codes, but you can define your own.

**PO/Requisition Reason:** Purchasing provides no transaction reason/transaction nature codes for purchase orders, requisitions, RFQs, and quotations, but you can define your own.

**Vendor (Supplier) Type:** Purchasing provides Employee, Supplier, and Public Sector Organizations. These codes are used to classify suppliers for reporting purposes. You enter this value in the Type field of the Classification region of the Suppliers window. See: Classification Region of the Suppliers window, *Oracle Public Sector Payables User’s Guide*. It is also used to define tax recovery rules. See: Tax Recovery Rules, *Oracle Public Sector Payables User’s Guide*. The Tax Authority supplier type indicates suppliers to whom you remit withholding taxes. See: Setting Up Withholding Taxes, *Oracle Public Sector Payables User’s Guide*.

4. Enter an Inactive Date on which the code is no longer active.

5. Save your work.
Defining Quality Inspection Codes

Use the Quality Inspection Codes window to define and update your inspection codes. You can define as many codes for inspection as you want. Each code must have a corresponding numerical ranking, which provides an inspection scale. You use these inspection codes when you receive and inspect the items you ordered.

To define quality inspection codes:

1. Navigate to the Quality Inspection Codes window by selecting Quality Inspection Codes on the menu.

2. Enter a Ranking number that corresponds to a specific quality code. This value must be between 0 and 100, where 0 represents the lowest quality. For example, 10 might represent a quality ranking of Poor, while 90 might represent a quality ranking of Excellent. Purchasing lists these rankings when you inspect your receipts.

3. Enter a Quality Code to indicate a particular quality standard. For example, you might want to define Excellent Condition or Damaged as quality codes.
4. Enter a description for your quality code. You can use this description to provide a more detailed explanation of the quality code.

5. Enter the Inactive Date after which the quality code is no longer active.

6. Save your work.
Purchasing Services

Purchasing provides the line type feature so that you can clearly differentiate orders for goods from those for amount–based services or outside processing.

Background

Requestors and buyers generally order both goods and services by quantity. You order the number of items you need in a specific unit of measure and at a given price. For instance, a buyer could order 10 computer terminals at a price of $1500 each. Later, the receiving agent records the receipt of one crate of 5 terminals. The accounts payable department receives a bill for 5 terminals, and matches the invoice against the original purchase order. Sometimes, you also need to order services in the same way. For example, you purchase 40 hours of product training at a rate of $40 per hour. You simply record the hours of training ordered and the price per hour. Once you receive the training, you record the hours received.

However, you sometimes order services by amount rather than by quantity. For example, a project manager orders $10,000 of consulting services to install a local area network. In this case, the buyer only needs to record the total amount of the service.

When half of the work is complete, the project manager records a receipt of $5000. The consulting firm may send an invoice for the complete amount of the service, or it may send partial invoices. In either case, the accounts payable department must match the invoice to the original purchase order or receipt by amount.

Purchasing provides you with the features you need to order both goods and services. You should be able to:

- Create your own purchasing document line types. For each line type, you should be able to specify the value basis: amount or quantity. For both amount and quantity based line types, you can specify default values for category, unit of measure, and whether you require receipt. For quantity based line types, you can specify the unit price, but for amount based line types the unit price defaults to 1. For quantity based lines, you can specify whether the line type is used for outside processing.
- Create a purchasing document with any combination of line types you need.
• AutoCreate purchase order lines from your requisition lines, grouping requisition lines for the same line type and item onto the same purchase order lines.

• Create amount–based purchase order lines by selecting an amount–based line type, category, item description, and total amount for the line.

Major Features

Line Type
The line type governs the type of requisition, purchase order, RFQ, and quotation lines you create. Quantity–based line types let you order and receive and/or invoice based on the quantity of goods or services provided. Amount–based line types let you order and receive and/or invoice based on the value of the service provided.

Quantity–Based Purchasing
Use quantity–based line types when you want to specify the quantity, unit of measure, and unit price for the items you are ordering. Purchasing provides Goods as an initial quantity–based line type. You can modify this line type or create new quantity–based line types to satisfy your needs.

Amount–Based Purchasing
Use amount–based line types when you want to order services and other items by amount. You create an order for a service by selecting an amount–based line type, category, item description, and total amount of the service. You can also receive and match services by amount.

Outside Processing Line Types
You can use outside processing line types to enter purchasing documents to pay suppliers for outside processing operations. Purchasing provides Outside Processing as an initial outside processing line type, and you can create additional outside processing line types. You cannot use outside processing line types, unless Purchasing, Work in Process, and Bills of Material are installed. See: Overview of Outside Processing, Oracle Work in Process User’s Guide.
Line Types Step by Step

Defining Line Types

Purchasing provides one initial line type: Goods. If Work in Process is installed, Purchasing also provides the line type Outside Processing. You can modify these line types or create new line types in the Line Types window. To define a new line type, you simply provide a name and description for lines types with a value basis of quantity or amount. You can then optionally specify a default category, whether receipt is required, and unit of measure. The unit price defaults to 1 for amount–based line types but is otherwise optional. You cannot specify a line as outside processing unless the value basis is quantity. You must provide a default unit of measure for amount–based line types. You use the unit of measure for amount–based lines as reference information only. Purchasing does not perform any unit conversion for amount based lines. You can create a unit of measure such as AMOUNT for amount based line types to help you determine if you ordered by amount. See: Defining Line Types: page 1 – 84. See: Defining Units of Measure, Oracle Inventory User’s Guide.

Creating Purchasing Document Lines

Purchasing lets you specify whether you are creating a document line for quantity, amount, or outside processing. You simply choose the line type when you create your document line. You enter the item, item description, quantity, unit of measure, and unit price for quantity based document lines. For amount based document lines, you enter only the category, item description, and the amount (in the Quantity field). The Unit Price defaults to 1 and you cannot change it.

Setting Up a Default Line Type

Since you typically use one line type more than the others, Purchasing lets you define a system default line type in the Purchasing Options window. All new purchasing document lines default to this line type. You can override this value when you need to create document lines of another type. You do not have to set up a system default if you use many different line types. See: Defining Default Options: page 1 – 45.

AutoCreating Purchase Orders

You can use the AutoCreate Documents window to convert approved requisition lines for items and services into purchase orders and releases. You can gather requisition lines for the same line type and place them onto a single purchase order. You can also place requisitions for different line types onto the same purchase order.
Purchasing combines requisition lines for the same item, line type, unit of measure, and item revision onto a single purchase order line. See: Autocreate Documents Overview: page 6 – 2

Enhanced Document Printing
Purchasing prints your document lines according to their line types. For quantity based line types, Purchasing prints the quantity, unit price and total amount for purchase orders and RFQs. Purchasing prints only the amount for amount based document lines.

Enhanced Reporting
The line type feature includes enhanced reporting to differentiate between quantity and amount based orders. Purchasing prints the line type so you can easily determine whether the information is quantity or amount based. For amount based orders, Purchasing prints only the total amount of the order.

Purchasing Services Step by Step

Creating Requisitions for Services
Purchasing lets you create requisition lines for services and other amount based orders. When you choose an amount based line type, Purchasing automatically sets the unit price to 1 for your line and enters the default unit of measure for the line type. You cannot change the unit price or unit of measure for amount–based requisition lines. You enter the amount of the service in the Quantity field. Your total line amount is the same as the value displayed in the quantity field. You can use the quantity field in your distributions to allocate the order amount to multiple accounting flexfields.

Creating Purchase Orders for Services
You can use AutoCreate Purchase Orders to create purchase order lines and releases from approved requisitions. You can gather all requisition lines for services and review these lines before placing specific ones on purchase orders. You can also split a requisition line for a service into several requisition lines for goods and services. Purchasing creates a purchase order for all of the requisition lines you choose.

You can also enter purchase orders for services manually by entering a service line type, the amount (Quantity) of the service, the category, and the item description. Purchasing automatically enters the unit price and unit of measure.
Sourcing Services

When you request a quotation from a supplier for a particular service, you can provide a complete description of the service you are requesting. You must choose a quotation type of Catalog if you want to use it for sourcing.

If you provide a requested service amount on your RFQ, Purchasing prints “Amount Requested:” followed by the total amount you entered. For example, you request quotations for the installation of a local area network and you know that you would like to pay $10000. You simply create an amount-based RFQ line and one shipment for this line. Purchasing automatically sets the unit price to 1 and fills in your unit of measure. On the RFQ shipment, you enter the amount, 10000, in the quantity field. Purchasing automatically sets the shipment break price and unit of measure.

When you choose sourcing information for amount-based requisition and purchase order lines, Purchasing copies the total amount from your chosen quotation shipment into the Quantity field of your purchasing document. Since you are creating an amount-based line and the unit price is set to 1, the Quantity field displays the total amount for the line.

Receiving Services

You receive services the same way you receive goods. When you receive a service, your quantity fields reflect the amounts of your order. Simply specify the amount you receive, correct, or return in the Quantity fields. Purchasing displays your line type so you can determine whether you are receiving by amount or quantity. You must receive services and other amount-based purchases in the unit of measure specified on the purchase order.

Matching Service Purchase Orders

When matching Payables invoices to service purchase order or receipt lines, you enter the amount invoiced in the Quantity field. Payables defaults the unit price to 1 when matching to service purchase orders or receipts. You should not change the unit price. Payables warns you if the unit price is not 1 for service orders.
Defining Line Types

Use the Line Types window to define and update line types.

When you enter a line on a purchasing document and choose a line type, Purchasing automatically displays the default information that you define here for the line type.

Line types let you distinguish between quantity and amount based line items. You use quantity based line items when you know the quantity and price of the line you are ordering. For example, you might buy a dozen pens for $10. You use amount based line items when you are ordering a service. For example, you might order $5,000 of consulting services over the next year.

When you are entering amount based document lines in purchasing windows such as the Purchase Orders window, Purchasing skips the Item and Revision fields, and sets the price to 1. You simply provide the total amount of 5,000 as the quantity. Then, when you record your receipts, you can enter the amount you have received as a quantity. For example, if you have incurred $300 of a $500 charge, you record a quantity of 300.

You can create line types to reflect different characteristics for the items you purchase. For example, you may want to define one line type for items you order by quantity and unit price, another line type for services you order by hour, and yet another that indicates an outside processing operation used in Oracle Work In Process (WIP). You can create purchasing document lines and specify whether they are for goods, services, outside processing, or any other line type you define.

Outside processing line types are necessary when you are using WIP and want to enter purchasing documents for outside processing operations in WIP. When you choose an outside processing line type on a purchasing document line, you can enter only outside processing items and the destination type can be only Shop Floor.

Purchasing automatically provides you with a line type of Goods that is quantity based. If Work in Process is installed, Purchasing also provides you with an Outside Processing line type. You can set up your purchasing options to copy a default line type for lines you add to every requisition, purchase order, RFQ, or quotation document. You can override the default line type for each document line you create.

If you use Multilingual Support (MLS), translations can be entered for the line types from within each of your installed languages. To enter the translations for the line types, select Translations from the View menu. For more information, see the Oracle Applications User’s Guide.
Prerequisites

❑ Define categories. See: Defining Categories, Oracle Inventory User’s Guide.

❑ Define units of measure. See: Defining Units of Measure, Oracle Inventory User’s Guide.

▶ To define line types:

1. Navigate to the Line Types window from the menu.

2. Enter the Name and Description of the line type.

3. Enter the Value Basis for the line type. You cannot update this field after you save your work.

   Amount: Receive items by amount. You cannot change the unit of measure and unit price on purchasing document lines.

   Quantity: Receive items by quantity. Outside Processing line types must have this value basis.

4. Enter the default purchasing Category for items with this line type. You can override this purchasing category on purchasing document lines.
5. Select Receipt Required if you want this as the default on your purchasing document shipments with this line type. You can overrule the default when you enter the shipment.

6. Enter the default Unit of measure for items with this line type. You must enter a default unit when you use the Amount value basis for your line type. You can override this unit of measure on your purchasing document lines only when you use non–Outside Processing line types with Quantity value basis.

   If you use the Amount value basis, you may want to choose your functional currency as the unit of measure. For example, if your functional currency is US dollars, you may want to define a unit of measure USD that you can use for your line types with the Amount value basis.

7. Enter the default Unit Price for items with this line type. Purchasing automatically enters a unit price of 1 when you use the Amount value basis and prevents you from updating this price when you create your line type. You can override this unit price on your purchasing document lines only when you use line types with Quantity value basis.

8. Select Outside Processing to restrict this line type to purchasing outside processing. Also, when you use an outside processing line type on a purchasing document, your choices for the item are limited to outside processing items. You can select this check box only if the value basis is Quantity and if you are using Work in Process.

9. Enter the Inactive Date on which the line type is no longer usable.

10. Save your work.

See Also

Purchasing Services: page 1 – 79

Overview of Outside Processing, Oracle Work in Process User’s Guide
Defining Document Types

Use the Document Types window to define access, security, and control specifications for all Purchasing documents. You cannot enter new document types; you can enter new document subtypes only for RFQs and quotations.

If you use Multilingual Support (MLS), translations can be entered for the document types from within each of your installed languages. To enter the translations for the document types, select Translations from the View menu. For more information, see the Oracle Applications User’s Guide.

Prerequisites

Before you use this window to set up your document types, you should perform the following steps:

- If you want to be able to choose the document approval hierarchy in this form, you must enable Use Approval Hierarchies in the Financials Options window. See: Defining Financials Options, Oracle Public Sector Payables User’s Guide.

- You must use the Position Hierarchy window to create and update the position hierarchies, since Purchasing uses these hierarchies as document approval routings. See: Representing Jobs and Positions, Oracle Human Resource Management Systems User’s Guide.

To define document types:

1. Navigate to the Document Types window from the menu. The Find Document Types window appears.

Select one of the following Document Types: Purchase Agreement, Purchase Order, Quotation, Release, Request for Quotation, and Requisition.
2. You can enter user-defined Document Subtypes only for document types Quotation and Request for Quotation. You can delete Quotation and Request for Quotation document types you have created, but only if no actual document exists for the type. Purchasing provides the following document subtypes:

* **Purchase Agreement** – Blanket and Contract (For more information on these document types, see: Purchase Order Types: page 4 – 4.)

* **Purchase Order** – Planned and Standard (For more information on these document types, see: Purchase Order Types: page 4 – 4.)

* **Quotation** – Bid, Catalog, and Standard (For more information on these document types, see: Types of Quotations and RFQs: page 5 – 7.)

* **Release** – Blanket and Scheduled (For more information on these document types, see: Purchase Order Types: page 4 – 4.)
Request for Quotation – Bid, Catalog, and Standard  (For more information on these document types, see: Types of Quotations and RFQs: page 5 – 7.)

Requisition – Internal and Purchase  (For more information on these document types, see: Requisition Types: page 3 – 7.)

3. Enter your Document Name for the document. The description must be unique for the given document type. The name that you enter here appears as a list of values choice in the Type field in the appropriate document entry window. For example, the Name Bid Quotation appears, along with the Quotation Class Bid, as a list of values choice in the Quotation Type field in the Quotations window.

4. The Quotation Class is applicable only for document types Quotation and Request for Quotation. Choose one of the following options:

 Bid – The quotation or RFQ is for a specific fixed quantity, location, and date.

 Catalog – The quotation or RFQ includes price breaks at different quantity levels.

For more information about Bid and Catalog, see: Types of Quotations and RFQs: page 5 – 7. (Although there are three types of quotations—Bid, Standard, and Catalog—there are only two quotation classes—Bid and Catalog. Standard belongs to the Catalog class.)

5. Check Owner Can Approve to indicate that document preparers can approve their own documents. This field is not applicable when the Document Type is Quotation or RFQ.

Attention: If you are using budgetary control and enable this option, you should also enable the Reserve at Requisition Completion option in the Financials Options window. Likewise, if you disable this option, you should also disable the Reserve at Requisition Completion option.

6. Check Approver Can Modify to indicate that document approvers can modify documents. This field is not applicable when the Document Type is Quotation or RFQ.

7. Check Can Change Forward–To to indicate that users can change the person the document is forwarded to. This field is not applicable when the Document Type is Quotation or RFQ.

For more information on how this and the next two fields affect your approval routing, see: Approval Routing: page 2 – 13.
8. Check Can Change Forward–From to indicate that users can change the name of the document creator. This field is applicable only when the Document Type is Requisition.

9. Check Can Change Approval Hierarchy to indicate that approvers can change the approval hierarchy in the Approve Documents window. This field is not applicable when the Document Type is Quotation or RFQ.

10. Check Disable to disable a document type. This field is applicable only for user–defined quotations and RFQs.

11. For user–defined quotations and RFQs, Purchasing displays as a default the Security Level of the Standard Quotation or RFQ, and you cannot enter the field. Otherwise, choose one of the following options:

   Hierarchy – Only the document owner and users above the owner in the defined purchasing security hierarchy may access these documents.

   Private – Only the document owner may access these documents.

   Public – Any user may access these documents.

   Purchasing – Only the document owner and users listed as buyers in the Define Buyers window may access these documents.


12. For user–defined quotations and RFQs, the Access Level is that of the Standard Quotation or Standard RFQ, and you cannot enter the field. Otherwise, choose one of the following Access Level options:

   Full – Users can view, modify, cancel, and final close documents.

   Modify – Users can only view and modify documents.

   View Only – Users can only view documents.

13. The Forward Method field is not applicable when the Document Type is Quotation or RFQ. The following options apply regardless of whether you are using position hierarchies or the employee/supervisor relationship to determine your approval paths. Choose one of the following options:

   Direct – The default approver is the first person in the preparer’s approval path that has sufficient approval authority.

   Hierarchy – The default approver is the next person in the preparer’s approval path regardless of authority. (Each person in
the approval path must take approval action until the person with sufficient approval authority is reached.)

14. The Archive When field is applicable only when the Document Type is Purchase Agreement, Purchase Order, or Release. Choose one of the following options:

   *Approve* – The document is archived upon approval. This option is the default. The Change Order workflow begins only if this option is chosen. See: Workflow Processes for Approving Change Orders: page C – 171.

   *Transmission* – The document is archived upon transmission. A document transmission action would be printing, faxing, or e-mail.

15. The Default Hierarchy field is not applicable when the Document Type is Quotation or RFQ. Otherwise, when Use Approval Hierarchies is enabled in the Financial Options window, you can enter a position hierarchy from the Position Hierarchy window. This hierarchy then becomes the default in the Approve Documents window.

To associate certain workflows with specific document types:

In Purchasing, all approvals are handled in the background by Oracle Workflow technology. The default approval workflow processes in Purchasing use the approval controls and hierarchies you define according to the setup steps in Setting Up Document Approval and Security: page 2 – 2. If you created a workflow process of your own and wanted to associate it with a specific document type, you would choose that workflow process here.

1. Select the Approval Workflow you want to use for this particular document type, or use the default that is already provided.

   The PO Approval workflow is used for approving purchase orders. The PO Requisition Approval workflow is used for approving requisitions. If you’ve created a workflow of your own, you can select that for this document. See: Approval Workflows: page C – 114.

2. Select the Workflow Startup Process you want to use for this particular document type, or use the default that is already provided.

   Usually the Workflow Startup Process is the highest-level process in a workflow. The default startup process for the PO Approval workflow is the PO Approval Top Process. The default startup process for the PO Requisition Approval workflow is the Main
Requisition Approval Process. If you’ve created a startup process of your own, you can select that for this document.

3. For requisitions only, select the Autocreate Workflow you want to use for automatically creating purchase orders or releases from approved requisition lines, or use the default that is provided.

The default workflow that comes with Purchasing is the PO Create Documents workflow. If you’ve created a workflow of your own, you can select that for this document. See: Workflow for Creating Purchase Orders or Releases: page C – 209.

4. For requisitions only, select the Autocreate Workflow Startup Process you want to use, or use the default that is already provided.

The highest-level process for the PO Create Documents workflow is the Overall Document Creation / Launch Approval Process. If you’ve created a startup process of your own, you can select that for this document.

See Also

Defining Financials Options, Oracle Public Sector Payables User’s Guide


The online help for the Enter Person window

Budgetary Control and Online Funds Checking, Oracle Public Sector General Ledger User’s Guide

Submitting a Document for Approval: page 2 – 35

Entering Requisition Headers: page 3 – 57

Entering Purchase Order Headers: page 4 – 39

Entering RFQ Headers: page 5 – 57

Entering Quotation Headers: page 5 – 73
Controlling Purchasing Periods

Use the Control Purchasing Periods window to control the purchasing periods defined in the Accounting Calendar window. You use purchasing periods to create journal entries in your general ledger system. Purchasing lets you create journal entries only for transactions you enter in an open purchasing period. You create general ledger journal entries when encumbering requisitions, purchase orders or accruing receipts.

If you use encumbrance or budgetary control, Purchasing verifies that the GL Dates you provide on purchase order distributions and requisition distributions are within an open purchasing period. See: Budgetary Control and Online Funds Checking, Oracle Public Sector General Ledger User’s Guide.

Prerequisites

Before using this window you should define your purchasing periods in the Accounting Calendar window. See: Defining Calendars, Oracle Public Sector General Ledger User’s Guide.

To control purchasing periods:

1. Navigate to the Control Purchasing Periods window from the menu.

Purchasing displays the Period Status, Period Number, Fiscal Year, Period Name, Begin Date, and End Date for each existing period.
2. In the Period Status field, you have the following options:

Closed – Use this option to close this purchasing period. When you close a purchasing period, Purchasing does not allow further accruals during this period. Purchasing reverses the status of accrued purchase order lines so that you can accrue them in the next period if you want.

Future – Use this option if you want to open this purchase period in the future. This option is available only when the current status is Never Opened.

Never Opened – Purchasing displays this default status if you have not opened this period in the past.

Open – Use this option to open this purchasing period.

Permanently Closed – Use this option if you do not want to open this period in the future. This option is irreversible.

See Also

Defining Purchasing Options: page 1 – 45

Controlling the Status of AP Accounting Periods, Oracle Public Sector Payables User’s Guide
Choosing Workflow Options

Purchasing provides default functionality in its Workflow-automated processes. This default functionality is described in the sections below. If you do not want this default functionality, you can change it in the Oracle Workflow Builder.

Before you can use or modify any of the workflows in Purchasing, you need to set up Oracle Workflow if you haven’t done so already. See: Setting Up Oracle Workflow, Oracle Workflow Guide.

Although Workflow is installed with Purchasing automatically, you need to complete additional setup steps described in the Oracle Workflow Guide, if you did not already do this as part of your installation or upgrade. Additionally install the Workflow Builder only if you want to modify the default workflows that Purchasing provides or if you just want to see and understand the workflow processes as they are graphically displayed in the Builder.

Choosing Document Creation Options

Prerequisite

Before you can use or modify any of the workflows in Purchasing, you need to set up Oracle Workflow if you haven’t done so already. See: Setting Up Oracle Workflow, Oracle Workflow Guide.

Purchasing integrates with Oracle Workflow technology to create standard purchase orders or blanket releases automatically from approved requisition lines. The workflow for creating purchasing documents automatically is called PO Create Documents. PO Create Documents includes three attributes, the values of which you can change in the Oracle Workflow Builder:

- Is Automatic Creation Allowed? – The default value of this attribute is set to ‘Y,’ meaning that automatic document creation is allowed for approved requisition lines. You can prevent automatic document creation by setting the default value of this attribute in the Workflow Builder to ‘N’ for No.

- Should Workflow Create the Release? – The default value of this attribute is set to ‘Y,’ meaning that the workflow tries to create the release; if it cannot, or if the value of this attribute is set to ‘N’ for No, then the workflow will not create the release; you
must use the AutoCreate Documents window to create the release.

- Is Automatic Approval Allowed? – The default value of this attribute is set to ‘N’ for No, meaning that documents are not automatically approved after they are created. If you set it to ‘Y’ for Yes, then the PO Approval workflow is launched to route the documents for approval.

For each of these attributes you can change their values to ‘Y’ for Yes or ‘N’ for No. You make these changes in the Oracle Workflow Builder.

➤ **To modify automatic document creation defaults:**

1. Start the Workflow Builder and open the PO Create Documents workflow.
   
   See: Opening and Saving Item Types, *Oracle Workflow Guide*.

2. Expand the Attributes branch.

3. Select any of the three item attributes described above and, in the attributes’ Properties windows, change the Default Value to suit your public sector needs.

   See the *Oracle Workflow Guide*.

**See Also**

Workflow for Creating Purchase Orders and Releases: page C–209

---

**Choosing a Process Mode for Automatic Document Creation**

The item attribute Send PO Autocreation to Background is used by the Main Requisition Approval Process in the PO Requisition Approval workflow. Send PO Autocreation to Background determines whether the approval workflow should launch automatic document creation in *Background* mode. By default, this item attribute is set to Y for Yes. But you can change it to N for No if you’d rather process automatic document creation in *Online* mode.

Background and online modes affect your system performance in different ways. For more information on what *Background* and *Online* mean, see *PO: Workflow Processing Mode* in the section Profile Options in Purchasing: page 1–103.
Note: The profile option PO: Workflow Processing Mode sets the processing mode for the entire approval workflow in Purchasing, whereas the item attribute Send PO Autocreation to Background enables you to change the processing mode specifically for automatic document creation after requisition approval, regardless of how the profile option PO: Workflow Processing Mode is set.

If you want to keep the default mode of Background:

- Use the Submit Requests window in the System Administrator responsibility to start the Workflow Background Process, which must be running for Background mode.

Attention: Since the item attribute Send PO Autocreation to Background contains a default value of Y—which means automatic document creation occurs in Background mode—you must start the Workflow Background Process if you are going to keep the default.

You can submit the process for all workflows or just for a particular workflow, in this case the PO Requisition Approval workflow. See: To Schedule Background Engines, Oracle Workflow Guide.

If you want to change the default mode to Online:

1. Start the Oracle Workflow Builder and open the PO Requisition Approval workflow.
   See: Opening and Saving Item Types, Oracle Workflow Guide.
2. Select the item attribute Send PO Autocreation to Background and open its Properties window.
3. Change its Default value from Y to N.
   Automatic document creation, when launched from the requisition approval workflow process, will now perform in Online mode.

Deciding If You Want to Use the Timeout Feature

Prerequisite

Before you can use or modify any of the workflows in Purchasing, you need to set up Oracle Workflow if you haven’t done so already. See: Setting Up Oracle Workflow, Oracle Workflow Guide.
The Timeout feature in the approval workflow enables you to specify a period of time after which, if no response has yet come from an approver, a reminder is sent. You can send up to two reminders to an approver using the Timeout feature. You can also specify that after a certain period of time, the document is forwarded automatically to the next approver in the hierarchy. You can optionally set up this feature through the Oracle Workflow Builder.

If you don’t set up the Timeout feature, the approval workflow will not time out; it will simply wait to receive a response from each approver.

**To set up approval reminders using the Timeout feature:**

1. Start the Workflow Builder and open the PO Approval workflow for purchase orders or the PO Requisition Approval workflow for requisitions.

   See: Opening and Saving Item Types, *Oracle Workflow Guide*.

2. Open any of the following activities’ Properties windows and enter a Timeout period (for instructions, see the *Oracle Workflow Guide*):
   - To enable the Timeout feature in the PO Approval workflow, modify the following activities in the Notify Approver subprocess by entering a Timeout period in their Properties windows: Approve PO Notification, PO Approval Reminder 1, and PO Approval Reminder 2.
   - To enable the Timeout feature in the PO Requisition Approval workflow, modify the following activities in the Notify Approver subprocess by entering a Timeout period in their Properties windows: Approve Requisition Notification, Requisition Approval Reminder1, and Requisition Approval Reminder2.

For example, you enter the following Timeout days in all three purchase order approval notifications as follows:

- Approve PO Notification – 3 days
- PO Approval Reminder 1 – 2 days
- PO Approval Reminder 2 – 1 day

In this example, the first notification, Approve PO Notification, times out after 3 days if the approver does not take an action on the notification, and PO Approval Reminder 1 sends the reminder notification. PO Approval Reminder 1 times out after 2 days, and PO Approval Reminder 2 times out after 1 day. Then the workflow looks for the next approver.

3. Save your changes.
The Workflow Background Process must be running for the Timeout feature to take effect.

See: Using the Workflow Background Engine: page 1 – 100.

---

**Modifying Change Order Workflow Options**

**Prerequisite**

- Before you can use or modify any of the workflows in Purchasing, you need to set up Oracle Workflow if you haven’t done so already. See: Setting Up Oracle Workflow, Oracle Workflow Guide.

Purchasing integrates with Oracle Workflow technology to let you define what changes to purchase orders or releases—for example, to amounts, suppliers, or dates—require full reapproval. All of the workflow processes and functions relating to change orders can be found within the PO Approval workflow. The change order workflow process uses the same reapproval rules already defined in Purchasing to determine whether a document, depending on its document type, requires reapproval. If you want to change the reapproval rules that the change order workflow uses, you can change those reapproval rules that determine what percentage change to a unit price, quantity, or document total requires reapproval. You can optionally change these rules by modifying their attributes in the Oracle Workflow Builder. See the section **Customizing the Change Order Workflow** in: Workflow Processes for Approving Change Orders: page C – 171.

The change order workflow requires that Archive on Approve be chosen in the Document Types window. The Archive on Approve option copies the purchase order information into the archive tables in Purchasing every time you approve or reapprove a purchase order. The change order workflow needs to use this archive information to compare a document before and after you make a change.

---

**Starting the “Send Notifications for Purchasing Documents” Process**

The workflow process, Send Notifications for Purchasing Documents, looks for documents that are incomplete, rejected, or in need of reapproval and sends notifications to the appropriate people of the document’s status. For these notifications to be sent, you need to start the concurrent program process Send Notifications for Purchasing...
Using the Workflow Background Engine

Prerequisite

Before you can use or modify any of the workflows in Purchasing, you need to set up Oracle Workflow if you haven’t done so already. See: Setting Up Oracle Workflow, Oracle Workflow Guide.

The Workflow Background Engine must be running if you are using the following options:

- The **Background** mode for Purchasing approvals. By default the profile option PO: Workflow Processing Mode is set to **Background**. You must start the Workflow Background Engine in order for the **Background** mode to work. See: Profile Options in Purchasing: page 1 – 103.

- The Timeout feature in any workflow. The Timeout feature sends reminder notifications.

- The Background mode for the item attribute Send PO Autocreation to Background in the PO Requisition Approval workflow. See: Choosing a Process Mode for Automatic Document Creation: page 1 – 96.

- The Confirm Receipts Workflow Select Orders process. This is a process you submit through the Submit Request window. If you submit it, the Workflow Background Engine must also be running. See: Confirm Receipts Workflow Select Orders Process: page 9 – 28.

If you are using the Workflow Background Engine for the Timeout feature, it is reasonable to schedule the process to run once or twice a day. If you are using it for **Background** mode, you should schedule it to run much more frequently; a workflow activity that is set to **Background** mode doesn’t begin until the Workflow Background Engine picks it up for processing.

If you want to use the Workflow Background Engine for both requisitions and purchase orders, you need to submit it twice, once for PO Approval and once for PO Requisition Approval. Or, by not specifying an item type, you can submit it for all item types.
Report Submission

In the Submit Requests window, in the System Administrator responsibility, select Workflow Background Process in the Name field.

See: To Schedule Background Engines, Oracle Workflow Guide.
The following windows are part of the iProcurement setup. Located in the Setup menu in Purchasing, they are used only by iProcurement. iProcurement is used to create requisitions on the Web. These requisitions are turned into purchase orders in Purchasing. Use these windows only if you are setting up iProcurement:

- **Define Information Template** – enables you to create additional information templates.

  **Note:** Information templates are not the same as requisition templates in Purchasing. Requisition templates in Purchasing are a pre-filled listing of frequently ordered items. Information templates are additional information templates that a requester in iProcurement completes for certain items.

- **Item Source** – used to define internal or external catalog sources for items.

- **Define Catalog Server Loader Values** – enables you to define which catalog data to load into the system.

- **Define Catalog Server for External Suppliers** – enables communication with external suppliers outside the firewall.

- **Realms** – used to create user access privileges to internal or external catalogs.

For instructions on these windows, see the *Oracle iProcurement Implementation Manual*. 
Profile Options and Security Functions

During implementation, the system administrator sets up profile options and security functions.

Profile Options

During implementation, you set a value for each user profile option to specify how Purchasing controls access to and processes data.

Generally, the system administrator sets and updates profile values. See: Setting User Profile Options, Oracle Applications System Administrator’s Guide.

Profile Option Settings

The table below indicates whether you (the “User”) can view or update the profile option and at which System Administrator (SA) levels the profile options can be updated: at the user, responsibility, application, or site levels.

A ✓ mark in the table indicates that you can update the profile option. The – mark in the table indicates that you can view the profile value but you cannot change it. A 0 in the table means that you cannot view or change the profile option.

A “Required” profile option requires you to provide a value. An “Optional” profile option already provides a default value, so you only need to change it if you don’t want to accept the default.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>MRP: Default Sourcing Assignment Set</td>
<td>✓</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>✓</td>
<td>Required if using sourcing rules</td>
<td>No Default</td>
</tr>
<tr>
<td>MRP: Sourcing Rule Category Set</td>
<td>✓</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>✓</td>
<td>Required if using sourcing rules</td>
<td>No Default</td>
</tr>
<tr>
<td>PO: Allow Buyer Override in AutoCreate Find</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Table 1 – 2   (Page 1 of 3)
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PO: Allow Category Override in AutoCreate Find</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>Yes</td>
</tr>
<tr>
<td>PO: Allow Rate Override for User Rate Type</td>
<td>–</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>No</td>
</tr>
<tr>
<td>PO: Archive Catalog on Approval</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>No</td>
</tr>
<tr>
<td>PO: AutoCreate GL Date Option</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>AutoCreate Date</td>
</tr>
<tr>
<td>PO: Automatic Document Sourcing</td>
<td>–</td>
<td>0</td>
<td>0</td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>No</td>
</tr>
<tr>
<td>PO: Change Supplier Site</td>
<td>–</td>
<td>0</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>No Default</td>
</tr>
<tr>
<td>PO: Default Supplier Item Catalog Option</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>Negotiated Sources</td>
</tr>
<tr>
<td>PO: Display AutoCreated Quotation</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>Yes</td>
</tr>
<tr>
<td>PO: Display the Autocreated Document</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>Yes</td>
</tr>
<tr>
<td>PO: Enable Sql Trace for Receiving Processor</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>No</td>
</tr>
<tr>
<td>PO: ERS Aging Period</td>
<td>–</td>
<td>0</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>0</td>
</tr>
<tr>
<td>PO: ERS Invoice Number Prefix</td>
<td>–</td>
<td>0</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>ERS–</td>
</tr>
<tr>
<td>PO: Item Cross Reference Warning</td>
<td>–</td>
<td>0</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>Disposition</td>
</tr>
<tr>
<td>PO: Legal Requisition Type</td>
<td>–</td>
<td>0</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>Both</td>
</tr>
<tr>
<td>PO: Override Approved Supplier List Status</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>No longer used</td>
<td></td>
</tr>
<tr>
<td>PO: Price Tolerance (%) for Catalog Updates</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>No Default</td>
</tr>
<tr>
<td>PO: Release During ReqImport</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>No</td>
</tr>
<tr>
<td>PO: Set Debug Concurrent ON</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>See description below</td>
<td>No</td>
</tr>
<tr>
<td>PO: Set Debug Workflow ON</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>See description below</td>
<td>No</td>
</tr>
<tr>
<td>PO: Supplier Pricing Method</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>No longer used</td>
<td></td>
</tr>
</tbody>
</table>

Table 1 – 2  (Page 2 of 3)
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PO: Use P-Cards in Purchasing</td>
<td>–</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>No</td>
</tr>
<tr>
<td>PO: Warn if RFQ Required before AutoCreate</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>No</td>
</tr>
<tr>
<td>PO: Workflow Processing Mode</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>Background</td>
</tr>
<tr>
<td>PO: Write Server Output to File</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>No Default</td>
</tr>
<tr>
<td>RCV: Allow routing override</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>No</td>
</tr>
<tr>
<td>RCV: Fail All ASN Lines if One Line Fails</td>
<td>–</td>
<td>0</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>No</td>
</tr>
<tr>
<td>RCV: Print Receipt Traveler</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>No</td>
</tr>
<tr>
<td>RCV: Processing Mode</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>Optional</td>
<td>Online</td>
</tr>
</tbody>
</table>

Table 1 – 2  (Page 3 of 3)

Profile Options Descriptions

**MRP: Default Sourcing Assignment Set**

This profile option indicates which sourcing rules assignment set will be used in Purchasing and Supplier Scheduling. Planning allows you to use multiple Assignment Sets, but Purchasing looks at only a single Assignment Set—the one that is specified in this profile option. Therefore, the Assignment Set name you choose for this profile option is the Assignment Set name you should specify when you assign sourcing rules in the Sourcing Rule/Bill of Distribution Assignments window. This profile option must be set if you are using sourcing rules in Purchasing.

**MRP: Sourcing Rule Category Set**

If you are using sourcing rules in Purchasing, this profile needs to be set to the name of the default category set used by Purchasing as indicated in the Default Category Sets window. Otherwise, you will not be able to display Category and Category–Organization assignments in the Sourcing Rule / Bill of Distribution Assignments window.
PO: Allow Buyer Override in AutoCreate Find
Yes or No indicates whether the suggested buyer (from the Enter Person window) defaulted into the Find Requisition Lines window can be cleared or overridden. The default is Yes.

PO: Allow Category Override in AutoCreate Find
Yes or No indicates whether the category (from the Buyers window) defaulted into the Find Requisition Lines window can be cleared or overridden.

PO: Allow Rate Override for User Rate Type
Yes or No indicates whether the Rate in the Currency tabbed region of the Receipts window can be changed. Even if the Rate Type is User, you cannot change the Rate if this profile option is set to No. This profile option affects the Rate on the receipt only, not in the Currency window of a purchase order, RFQ, or quotation. (In the Currency window, you can modify the Rate if the Rate Type is User.)

PO: Archive Catalog on Approval
Yes or No indicates whether Purchasing archives blanket purchase agreements in a price/sales catalog submission upon approval. You need to consider this profile option only if you receive price/sales catalog submissions from your suppliers through the Purchasing Documents Open Interface. This profile option comes into effect only if Archive on Approval is chosen in the Document Types window in Purchasing and you import the documents with a status of Approved; if you then choose No for this profile option, Purchasing does not archive the price/sales catalog agreements.

Note: If a document update is pending review in the Exceeded Price Tolerances window, the revision of that document is not updated until you accept all line updates.

For more information, see the Oracle Manufacturing, Distribution, Sales and Service Open Interfaces Manual.

PO: AutoCreate GL Date Option
Indicates the date used on purchase orders generated by AutoCreate:

<table>
<thead>
<tr>
<th>AutoCreate Date</th>
<th>The autocreate date is used as the purchase order date.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requisition GL Date</td>
<td>The GL date on the requisition distribution is used as the purchase order date.</td>
</tr>
</tbody>
</table>
PO: Automatic Document Sourcing
Yes means that Purchasing automatically defaults source document and pricing information for an item from the most recently created blanket purchase agreement or quotation. No means that this source document information comes from the Approved Supplier List window, where you must specify which source documents to use. Note that if an item on a requisition is associated with both a blanket purchase agreement and a quotation, Purchasing uses the blanket purchase agreement even if the quotation was created more recently. See: Setting Up Automatic Sourcing: page 5 – 33.

PO: Change Supplier Site
Yes or No indicates whether users can change the supplier site on approved purchase orders.

PO: Default Supplier Item Catalog Option
Indicates the default source tabbed region in the supplier item catalog: Negotiated Sources, Prior Purchases, Sourcing Rules, or Requisition Templates.

PO: Display AutoCreated Quotation
Controls the viewing of an autocreated quotation.

PO: Display the Autocreated Document
Yes or No indicates whether Purchasing opens the appropriate transaction window (Purchase Orders window or RFQs window) and displays the created line(s) when you autocreate a document.

PO: Enable Sql Trace for Receiving Processor
Yes means that when you run the Receiving Transaction Processor to import data from another system using the Receiving Open Interface, the View Log screen displays the receiving transaction pre-processor’s actions, including errors, as it processed the receipt data from start to finish. (The profile option RCV: Processing Mode must also be set to Immediate or Batch for the Yes option to work.) Yes also generates a database trace file; if you need help with an error that occurs while the Receiving Transaction Processor runs, Oracle Support Services may ask you for this trace file. This profile option should be set to Yes only while debugging the Receiving Open Interface or for generating a trace file. The Receiving Open Interface validates receipt transactions from other systems and uses the Receiving Transaction Processor to import the
validated data into Purchasing. See the *Oracle Manufacturing, Distribution, Sales and Service Open Interfaces Manual, Release 11i.*

**PO: ERS Aging Period**

The value in this profile option indicates the number of days between the receipt date and the Payment on Receipt automatic invoice creation date. For example, a value of 2 means that Payment on Receipt creates invoices only for receipts that are 2 or more days old. Any corrections or returns you make against a receipt during that 2–day period are included on the Payment on Receipt invoice.

**PO: ERS Invoice Number Prefix**

‘ERS–’ is the prefix that appears before all invoices that you create automatically using Payment on Receipt. This profile option allows you to change this prefix. For example, shortening this prefix allows extra spaces for longer packing slip or receipt numbers.

**PO: Item Cross Reference Warning**

Indicates the Item Cross Reference Type that you want to use as a disposition warning message for requisitions.

**PO: Legal Requisition Type**

Indicates whether users can enter internal requisitions sourced from stock by means of an internal sales order, purchase requisitions sourced from a purchase order, or both types. Available values are Both, Internal, and Purchase.

**PO: Override Approved Supplier List Status**

If you have upgraded from a previous release, you will see this profile option in the application, but the profile option is no longer used.

**PO: Price Tolerance (%) for Catalog Updates**

A value in this profile option specifies the maximum percentage increase allowed to an item’s price when your supplier sends updated price/sales catalog information through the Purchasing Documents Open Interface. This profile option affects only blanket purchase agreements and catalog quotations imported through the Purchasing Documents Open Interface. If the tolerance is exceeded, the buyer receives a notification and can accept or reject the price increase in the Exceeded Price Tolerances window.
This profile option is used only if price tolerances are not already defined at lower levels, in the purchase agreement Terms and Conditions window or the Supplier–Item Attributes window.


**PO: Release During ReqImport**

Yes or No indicates whether Purchasing can automatically create releases during the Requisition Import process.

**PO: Set Debug Concurrent ON**

This profile option is used, *usually by technical support staff only*, for finding problems with Requisition Import. The default value is No. The user can view and update this profile option. It can also be updated at the user, responsibility, application, and site levels.

**Caution:** For performance reasons, it is very important that this profile option *always* be set to No, unless you are instructed otherwise by Oracle Corporation for debugging purposes.

**PO: Set Debug Workflow ON**

This profile option is used, *usually by technical support staff only*, for finding problems with Purchasing workflow processes. The default value is No. The user can view and update this profile option. It can also be updated at the user, responsibility, application, and site levels.

**Caution:** For performance reasons, it is very important that this profile option *always* be set to No, unless you are instructed otherwise by Oracle Corporation for debugging purposes.

**PO: Supplier Pricing Method**

If you have upgraded from a previous release, you will see this profile option in the application, but the profile option is no longer used.

**PO: Use P–Cards in Purchasing**

Set this profile option to Yes if you use procurement card—also known as P–Card or corporate credit card—numbers on requisitions in iProcurement. Set this profile option to Yes to display the procurement card number in the Purchase Orders, Releases, and Purchase Order Headers summary windows.

Set this profile option to No if you do not have iProcurement installed or do not want to display the procurement card field to buyers. Purchasing windows can physically display the procurement card field even if
iProcurement is not installed and procurement cards aren’t used. Therefore, set this profile option to No if you are not using procurement cards.

**PO: Warn if RFQ Required before AutoCreate**

Yes or No indicates whether you are given a warning message and an opportunity to cancel autocomplete if one or more of the requisition lines selected for inclusion requires an RFQ and has not been placed on an RFQ.

If you use the PO Create Documents workflow to create purchase orders automatically from approved requisition lines, note that setting this profile option to Yes can affect the workflow. If it is set to Yes and the requisition line is not on an RFQ (but RFQ Required is checked for the requisition line), the workflow stops automatic document creation because it is unable to issue the warning. (The requisition line will still be available in the AutoCreate Documents window.) Even if an RFQ is required for the requisition line, as long as this profile option is set to No, the workflow will continue creating the document.

**PO: Workflow Processing Mode**

Affects the performance of the Purchasing approval workflow processes:

- **Online**
  
  Completes an entire approval workflow process before letting you proceed to the next activity, but provides you with an updated Status (for purchase orders) as soon as it finishes.

- **Background**
  
  Enables you to proceed to the next activity while the approval process completes in the background.

Whichever option you choose, you can always view the current status of a requisition or purchase order through the Requisitions Summary or Purchase Orders Summary windows.

The default value is **Background**.

**Note:** When this profile option is set to **Background**, you must start the Workflow Background Engine, which you access through the System Administrator responsibility. It is recommended that you set this process to run frequently, if you are using it for Background mode approvals. See: To Schedule Background Engines, *Oracle Workflow Guide*. 

---

1 – 110  Oracle Public Sector Purchasing User’s Guide
PO: Write Server Output to File

Yes or No indicates whether log details are written to a flat file rather than to the standard concurrent manager details log viewable through the View Log button in the Submit Request window when running the Purchasing Documents Open Interface program.

Yes means log details are written to a flat file. No means log details are written to the concurrent manager log screen, which can cause overflow problems for large catalogs. Leaving this profile option blank means log details are not written at all, which improves performance.

You need to consider a value for this profile option only when debugging a price/sales catalog submission from your supplier through the Purchasing Documents Open Interface.

See the Oracle Manufacturing, Distribution, Sales and Service Open Interfaces Manual, Release 11i.

RCV: Allow routing override

Yes or No indicates whether the destination type assigned during requisition or purchase order entry can be overridden at receipt time.

RCV: Fail All ASN Lines if One Line Fails

If you choose Yes, you can reject an entire Advance Shipment Notice (ASN) if any ASN line fails validation or processing. If you choose No, then you can accept an ASN if at least one ASN line is successful.

RCV: Print Receipt Traveler

Yes or No indicates whether Purchasing automatically prints the receipt traveler when you perform a receipt or a receiving transaction, and when you match unordered receipts. You can always print receipt travelers from the Submit Requests window.

RCV: Processing Mode

Indicates the processing mode used after you save your work for receiving transactions:

**Batch**

The transaction goes to the interface table, where it will be picked up the next time the Receiving Transaction Processor runs.

**Immediate**

The transaction goes to the interface table, and the Receiving Transaction Processor is called for the group of transactions that you entered since you last saved your work.
On-line The Receiving Transaction Processor is called directly.

See Also

Overview of User Profiles, *Oracle Applications User’s Guide*

Setting User Profile Options, *Oracle Applications System Administrator’s Guide*

Setting Your Personal User Profile, *Oracle Applications User’s Guide*

Common User Profile Options, *Oracle Applications User’s Guide*

Profile Options in Oracle Application Object Library, *Oracle Applications User’s Guide*

Function Security for Purchasing

Function Security defines the specific access to individual forms and the business functions of each form. A form can have several business functions associated with it, however some forms and functions may not be appropriate for each user. Purchasing provides the following basic responsibilities: Requestor, Receiver, Buyer, and PO Superuser. You can create new responsibilities or modify the existing ones. A responsibility defines an application user’s current privileges while working with Oracle Applications.

You can use Function Security to control access to forms (windows) and functions within windows, thereby tailoring each responsibility to the needs of an individual user. However, if you grant a user access to a window, all the functions within that window are automatically included in the user’s access. If you want the user to have access to the window but not to all the window’s functions, you must exclude access to each function individually.

For example, if you want a user to be able to view the Purchase Orders Summary window but not have access to the functions associated with the New Release, New PO, and Open buttons within that window, you would grant access to the Purchase Orders Summary window but disable access to the New Release, New PO, and Open functions.

The following table shows the function security.
<table>
<thead>
<tr>
<th>Window</th>
<th>Function</th>
<th>Requestor</th>
<th>Receiver</th>
<th>Buyer</th>
<th>PO Superuser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requisition Summary Tools Menu</td>
<td>View Lines</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Distributions</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Purchase Orders</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sales Orders</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Action History</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Preferences</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Control</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Requisition Summary window</td>
<td>New</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Purchase Order Summary window</td>
<td>New Release</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>New PO</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Open</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Purchase Order Summary Tools Menu</td>
<td>View Lines</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Shipments</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Distributions</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Action History</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Invoices</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Receipts</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Acceptances</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Control</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Preferences</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supplier Summary window</td>
<td>Open</td>
<td></td>
<td></td>
<td></td>
<td>View Only</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Exceeded Price Tolerances window</td>
<td>Accept/Reject</td>
<td>View Only</td>
<td>View Only</td>
<td>View Only</td>
<td>View Only</td>
</tr>
</tbody>
</table>

Table 1 – 3  (Page 1 of 1)
See Also

Overview of Function Security, *Oracle Applications System Administrator’s Guide*

Forms and Subfunctions, *Oracle Applications System Administrator’s Guide*

CHAPTER 2

Approval, Security, and Control

This chapter tells you what you need to know about Approval, Security, and Control, including:

- Setting Up Document Approval and Security: page 2 – 2
- Position Hierarchies: page 2 – 8
- Approval Routing: page 2 – 13
- Approval Authorization Control: page 2 – 16
- Assigning Employees: page 2 – 23
- The Document Approval Process: page 2 – 24
- Document Control Overview: page 2 – 44
- MassCancel: page 2 – 60
Setting Up Document Approval and Security

**Human Resources with Purchasing**

Human Resources and Purchasing share job and position information if they are installed together. You should consider your requirements from both perspectives before deciding on an approval/security structure.

Human Resources uses jobs to classify categories of personnel in your organization, and associates information like the exempt/non–exempt code and EEO code with individual jobs. Examples of a typical job include Vice President, Buyer, and Manager. Positions represent specific functions within these job categories. Examples of typical positions associated with the Vice President job include Vice President of Manufacturing, Vice President of Engineering, and Vice President of Sales.

Human Resources uses position hierarchies to define management line reporting and control access to employee information.

Review your Personnel department’s system requirements before you decide how you want to use positions, jobs, and position hierarchies in Purchasing.

**Using Approval Hierarchies**

Approval hierarchies let you automatically route documents for approval. There are two kinds of approval hierarchies: position hierarchy and employee/supervisor relationships.

If you choose to use employee/supervisor relationships, you define your approval routing structures as you enter employees using the Enter Person window. In this case, Purchasing does not require that you set up positions.

If you choose to use position hierarchies, you must set up both jobs and positions. While positions and position hierarchies require more initial effort to set up, they are easy to maintain and allow you to define approval routing structures that remain stable regardless of how frequently individual employees leave your organization or relocate within it.

**Using Security Hierarchies**

Security hierarchies let you control who has access to certain documents. For example, you can create a security hierarchy in which only you and other buyers in that hierarchy can view each other’s purchase orders.
Security hierarchies are not an alternative to approval hierarchies, but something different altogether. Changes you make to a security hierarchy do not affect the approval hierarchy and vice versa.

If you want to specify a Security Level of Hierarchy for any of your document types, you must first define all positions which should have access to the documents you want to restrict in this manner. (Even if you are using jobs to route documents for approval, you must define positions before you can enable this Security Level). You then define a security position hierarchy, and specify it in the Purchasing Options window.

Approval Workflow

Purchasing uses Oracle Workflow technology to handle approvals. Workflow works in the background, using the approval controls and hierarchies you define in the setup steps below to route documents for approval. Because Workflow handles your approval process in the background, you can use Oracle Workflow Builder’s easy interface to modify your approval process. See: Purchase Order Approval Workflow: page C–114. See: Requisition Approval Workflow: page C–57.

Approval and Security Setup Steps

1. Use the Financials Options window to indicate whether you want to route documents for approval using position hierarchies or employee/supervisor relationships. This decision applies only to the Business Group you choose for your Purchasing installation in the Financials Options window. See: About Financials Options, Oracle Public Sector Payables User’s Guide.

If you choose to use position hierarchies, you must define positions in addition to jobs. You later build your hierarchies by referencing these positions.

2. Use the Job window to create each of the job titles in your organization (for example: Buyer, Supply Base Engineer). If you are not using positions, you assign one or more employees to each job. If you are using positions, you assign one or more positions to each job, and later assign one or more employees to each position.

Attention: You assign authorization rules to jobs or positions based on your decision in Step 1. It is important to ensure that your job/position infrastructure supports the different approval levels in your organization.

For example, if your purchasing staff includes a Junior Buyer, a Senior Buyer, a Supply Base Manager, and a Purchasing Manager,
all of whom have different authorization levels for different
document types, you should define a different job or position for
each role. If your purchasing department is comprised of five
employees with common authorization limits, then a single
approval group (see steps 7 and 8) could be given to those five jobs
or positions. See: Representing Jobs and Positions, Oracle Human

3. Use the Position window to create each of the positions in your
organization. This step is required if you plan to use either security
or position approval hierarchies. See: Representing Jobs and

4. Use the Position Hierarchy window to build and administer your
position hierarchies. There are two distinct uses for position
hierarchies in Purchasing: 1) document approval routing and 2)
document security control. You can use a single position hierarchy
for both purposes. See: Representing Jobs and Positions, Oracle
Human Resource Management Systems User’s Guide. See also:

5. Use the Purchasing Options window to choose a single security
hierarchy for your installation if you want to use the document
Security Level of Hierarchy for any or all of your document types.
See: Defining Control Options: page 1 – 49. For additional
overview information, see Document Security and Access: page

Attention: Note that a security hierarchy controls which positions
(and therefore which employees) have access to a particular
document type. It does not control whether an employee has the
authority to approve a document or perform other actions.
An Off–line approver is a valid employee with approval authority,
but without access to the relevant form. An On–line approver is an
active employee with approval authorization, and with access to
the relevant form.

6. Use the Document Types window to specify distinct security and
approval controls for each document type/subtype. See: Defining

7. Use the Approval Groups window to define approval

8. Use the Assign Approval Groups window to associate approval
rules with a specific job or position and a document type. See:
Assigning Approval Groups: page 1 – 33.
9. Use the Enter Person window to assign employees to jobs or positions. If you are not using position approval hierarchies for document routing, you must provide the employee’s supervisor. See: the online help for the Enter Person window.

10. Run the Fill Employee Hierarchy process. This process creates an employee–populated representation of your approvals hierarchy and should be run whenever you make a structural or personnel change to your hierarchies or assignments. You can set up this process to run automatically at predefined intervals. See: Fill Employee Hierarchy Process: page 9 – 41.

Changing the Approval Hierarchy

When you make a change to an approval hierarchy—for example, by adding or removing an approver—existing documents still use the previous hierarchy before you changed it. Future documents use your changed hierarchy. Remember that every time you change a hierarchy, you must run the Fill Employee Hierarchy process.

If you are using position hierarchy approvals, and you move an employee out of a position that’s in the approval hierarchy, assign another employee to the vacant position. You can remove a position altogether if it has no positions below it; you can also end–date the position or create a new version of the hierarchy. You can build a new version of a hierarchy by creating a new version of it or by copying an existing hierarchy.

If you are using employee/supervisor approvals, and you remove an employee or supervisor from an employee/supervisor chain, you must rebuild the employee/supervisor chain.

Approval and Security Setup Matrix

See Also


Create a Position Hierarchy, Oracle Human Resource Management Systems User’s Guide


Position Hierarchies

Use the Positions window to create each of the positions in your organization. This step is required if you plan to use either security or position approval hierarchies. See: Representing Jobs and Positions, Oracle Human Resource Management Systems User’s Guide.

All the positions you want to include in your hierarchies must be included in the Business Group you selected in the Financials Options window.

A position can be added to multiple hierarchies.

Use the Position Hierarchy window to build and administer your position hierarchies. There are two distinct uses for position hierarchies in Purchasing: 1) document approval routing and 2) document security control. You can use a single position hierarchy for both purposes. See: Representing Jobs and Positions, Oracle Human Resource Management Systems User’s Guide.

When you build your hierarchies, always begin with the most senior position and work down. Use your organization charts and predefined special approval paths to facilitate this process.

While you can include a position in many hierarchies, it can appear only once within a single hierarchy.

If you want to use the document Security Level of Hierarchy for any or all of your document types, the hierarchy you specify in the Purchasing Options window must include all the positions in your organization that should have access to these documents. See: Defining Control Options: page 1 – 49.

If you build multiple hierarchies for use in the approval process, it is useful to give them meaningful names. This helps employees quickly choose the appropriate approval path when moving documents from one approval hierarchy to another.

For example, you can define a special approval hierarchy including a Facilities Manager and Chief Financial Officer for all plant and property purchases. Name this hierarchy “Facilities.” Your default approval hierarchy for standard purchase orders (called “Purchasing”) includes only your procurement staff and a Vice President of Operations, none of whom have the authority to approve plant and property items. When a buyer attempts to approve a standard purchase order for these items, Purchasing will require a forward–to employee. Assuming your setup allows changes to the default approval hierarchy for standard purchase orders, instruct buyers to route these documents to the “Facilities” approval hierarchy.
Before you can reference your position hierarchies in Purchasing, you must assign employees to the referenced positions with the Enter Person window and then use the Submit Requests window to run the Fill Employee Hierarchy process. See: Fill Employee Hierarchy Process: page 9 – 41.

See Also

Setting Up Document Approval and Security: page 2 – 2
Document Security and Access

Purchasing lets you control which groups of employees have access to each document type, and what modification/control actions these individuals can take once they gain access. Use the Document Types window to specify your security options. See: Defining Document Types: page 1 – 87.

You can restrict document access based on the following Security Level options for each document type:

- **Public**: All system users can access the document
- **Private**: Only the document owner and subsequent approvers can access the document
- **Purchasing**: Only the document owner, subsequent approvers, and individuals defined as buyers can access the document
- **Hierarchy**: Only the document owner, subsequent approvers, and individuals included in the security hierarchy can access the document

Within the installation security hierarchy, you can access only those documents that you or your reporting employees own

**Attention:** You must define one position hierarchy including all positions that require access to the document types you want to control with a Security Level of Hierarchy. You need to specify this hierarchy in the Purchasing Options window before you can choose a Security Level of Hierarchy for a given document type. See: Defining Control Options: page 1 – 49.

In addition to the Security Level, you specify an Access Level to control what modification/control actions you can take on a particular document type once you gain access. Document owners always have **Full** access to their documents. The Access Level options include:

- **View Only**: Accessing employees can only view this document
- **Modify**: Accessing employees can view, modify, and freeze this document
- **Full**: Accessing employees can view, modify, freeze, close, cancel, and final-close this document

Both the Security Level and Access Level apply to existing documents. Anyone with menu access to the document entry windows can create a document. These individuals then become the document owners.
The Security Level and Access Level work together. For example, if you assign a Security Level of Public and an Access Level of Full to standard purchase orders, then all users can access all standard purchase orders from document entry, view, and control windows.

**Attention:** While any document is in the approval process (regardless of Access or Security Level), no one can access it using an entry window.

If you change the Access Level to View Only for a document type, then all users (except for the document owner whose Access Level is always Full, and approvers who can optionally modify the document when it is in their approval queue based on the document control Approver Can Modify) can access these documents in the view windows, but not in the document entry or control windows. If you change the Security Level for a document type to Private, then only the document owner and subsequent approvers can access these documents.

Finally, the Security Level and Access Level work with the Approver Can Modify option that you choose in the Document Types window. If this control is set to Yes for a particular document type (even if the Access Level is View Only), then all approvers can modify documents in their pending approval queue. Once you approve a document, you cannot make further modifications.

The following matrix describes the effects of all possible Security Level and Access Level combinations in which groups of employees can access documents using the view, entry, or control windows.
## The Security Level / Access Level Matrix

<table>
<thead>
<tr>
<th>Document Type</th>
<th>Access Level</th>
<th>View Windows</th>
<th>Entry Window: Doc NOT in Approval</th>
<th>Entry Window: Doc in Approval</th>
<th>Control Window: Freeze/Close</th>
<th>Control Window: Cancel/Final Close</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public</td>
<td>View Only</td>
<td>All</td>
<td>Owner</td>
<td>None</td>
<td>Owner</td>
<td>Owner</td>
</tr>
<tr>
<td></td>
<td>Modify</td>
<td>All</td>
<td>All</td>
<td>None</td>
<td>All</td>
<td>Owner</td>
</tr>
<tr>
<td></td>
<td>Full</td>
<td>All</td>
<td>All</td>
<td>None</td>
<td>All</td>
<td>All</td>
</tr>
<tr>
<td>Private</td>
<td>View Only</td>
<td>Owner Approver</td>
<td>Owner</td>
<td>None</td>
<td>Owner</td>
<td>Owner</td>
</tr>
<tr>
<td></td>
<td>Modify</td>
<td>Owner Approver</td>
<td>Owner</td>
<td>None</td>
<td>Owner</td>
<td>Owner</td>
</tr>
<tr>
<td></td>
<td>Full</td>
<td>Owner Approver</td>
<td>Owner</td>
<td>None</td>
<td>Owner</td>
<td>Owner</td>
</tr>
<tr>
<td>Purchasing</td>
<td>View Only</td>
<td>Owner ApproverBuyers</td>
<td>Owner</td>
<td>None</td>
<td>Owner</td>
<td>Owner</td>
</tr>
<tr>
<td></td>
<td>Modify</td>
<td>Owner ApproverBuyers</td>
<td>Owner ApproverBuyers</td>
<td>None</td>
<td>Owner Buyers</td>
<td>Owner Buyers</td>
</tr>
<tr>
<td></td>
<td>Full</td>
<td>Owner ApproverBuyers</td>
<td>Owner ApproverBuyers</td>
<td>None</td>
<td>Owner Buyers</td>
<td>Owner Buyers</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>View Only</td>
<td>Owner ApproverHierarchy</td>
<td>Owner</td>
<td>None</td>
<td>Owner</td>
<td>Owner</td>
</tr>
<tr>
<td></td>
<td>Modify</td>
<td>Owner ApproverHierarchy</td>
<td>Owner ApproverHierarchy</td>
<td>None</td>
<td>Owner Hierarchy</td>
<td>Owner</td>
</tr>
<tr>
<td></td>
<td>Full</td>
<td>Owner ApproverHierarchy</td>
<td>Owner ApproverHierarchy</td>
<td>None</td>
<td>Owner Hierarchy</td>
<td>Owner Hierarchy</td>
</tr>
</tbody>
</table>

Table 2 – 1 (Page 1 of 1)
Approval Routing

Purchasing lets you route documents for approval based on either position hierarchies or employee/supervisor relationships. In both cases, you control whether documents are routed to the first employee with enough authority to approve the document (Direct method), or if they must pass through each level of the associated hierarchy or reporting infrastructure regardless of authority (Hierarchy method). You can also control whether document owners are able to approve the documents they create.


| Owner Can Approve | Prevent or allow document owners to approve the documents they create. |
| Can Change to Forward–To | Prevent or allow changes to the default forward–to employee. |
| If you are using position approval hierarchies and there is more than one employee associated with a particular position, Purchasing defaults a Forward–To employee in the Approvals window based on alphabetic order. |
| If you are using position approval hierarchies and allow changes to the Forward–To employee, the list of values in the Approvals window includes all employees in the selected hierarchy. |
| If you are routing documents using employee/supervisor relationships and you allow changes to the Forward–To employee, the list of values in the Approvals window includes all employees defined in the Business Group you specify in the Financials Options window. |
| Can Change Forward–From | Prevent or allow changes to the default forward–from employee. This control applies only to requisitions. |
| If you allow changes to the forward–from employee, Purchasing restricts the Forward–From list of values in the Approvals window to requestors associated with the requisition you are trying to approve. |
This flexibility allows you to build an approval history including the original requestor rather than the preparer.

**Can Change Approval Hierarchy**

This control applies only if you are using position approval hierarchies. Prevent or allow changes to the default approval hierarchy.

If you allow changes to the default approval hierarchy, the list of values in the Approvals window includes all hierarchies defined in the Business Group you specify in the Financials Options window.

**Attention:** When you submit a document for approval, Purchasing verifies that you are included in the default position hierarchy for your document. If you are not included in this hierarchy, and Allow Change to Approval Hierarchy is set to No, you cannot approve the document or route it to another employee. If you have enough authority to approve the document, you can complete this action regardless of whether you are included in the default hierarchy.

**Forward Method**

Select Direct to route documents to the first employee with enough authority to approve them. Select Hierarchy to route documents to the next person in the approval hierarchy or reporting infrastructure regardless of authority.

Approval authority is determined by the approval rules you define in the Define Approval Groups and Assign Approval Groups windows. For example, a hierarchy of three approvers consists of one with a $1,000 approval limit, one with a $5,000 approval limit, and one with a $10,000 approval limit. In a Direct forward method, a document totalling $7,000 is routed directly to the approver with the $10,000 approval limit. In a Hierarchy forward method, the document routes to all three approvers, stopping at the $10,000 approver.

**Default Hierarchy**

This control applies only if you are using position approval hierarchies. You must specify a default approval hierarchy for each document type.

Combine these controls to build an approval routing policy that is as strict or as flexible as your needs warrant. For example, if you set Allow Change to Approval Hierarchy and Allow Change to Forward–To to No, Purchasing forces employees to route all documents
according to the approval hierarchy or employee / supervisor relationships that you define. If you set these controls to Yes, Employees can route documents for approval with a high degree of autonomy and flexibility within the structures you define.

See Also

About Financials Options, *Oracle Public Sector Payables User’s Guide*

Submitting a Document for Approval: page 2 – 35
Approval Authorization Control

You can define flexible groups of authorization rules (Approval Groups) which you assign to specific document types and jobs or positions (based on your implementation). These authorization rules are comprised of include/exclude and amount limit criteria that you specify for Document Total, Account Range, Item Range, Item Category Range, and Location. You can associate multiple approval groups (collections of authorization rules) with a single document/job or position combination to create unique approval structures in support of your organization’s signature policies. Finally, you link employees to authorization limits when you assign them to jobs or positions.

When you attempt to approve a document, Purchasing evaluates the authorization rules associated with your job or position and the document type to determine whether you have adequate authority. If you do not have enough authority to approve the document, Purchasing provides default routing information based on your approval setup. Depending on the level of routing flexibility you specify, approvers may or may not be able to change these defaults.

See Also

Defining Approval Groups: page 1 – 29
Assigning Approval Groups: page 1 – 33
Defining Approval Authorization Rules: page 2 – 16
Using Approval Assignments: page 2 – 19

Defining Approval Authorization Rules

An approval group is a set of authorization rules comprised of include/exclude and amount limit criteria for the following Object Types: Document Total, Account Range, Item Range, Item Category Range, and Location. For each position or job, you ultimately associate these approval groups with document types to implement your authorization rules.

To build an approval group, first assign a descriptive name that will make it easy to reference in the Assign Approval Groups window. You can then add multiple rules for the same Object Type to your approval group. When you associate two or more rules for the same Object Type
with a single job/position and document type combination, Purchasing uses the most restrictive criteria during the authorization check.

An Account Range rule defines the distribution accounting flexfield ranges and their amount limits that the approval group can approve, and an Include rule is required for at least one approval group associated with each document type in the Assign Approval Groups window. To include an account range, choose this Object Type with an Approval Type of Include, enter an Amount Limit, and specify the Value Low and Value High for your range.

**Attention:** The Amount Limit that you specify for an Account Range Include rule applies to the sum of all accounts included in the range. It does not apply to each individual account within the range.

To exclude an account range, choose this Object Type with an Approval Type of Exclude and specify the Value Low and Value High for your range. The approval group will be unable to approve documents including these accounting distributions, even if your enabling Include rule contains these accounts within its upper and lower bounds.

A Document Total rule defines the maximum document amount that the approval group can approve. This is not required to enable the approval group. If you want to specify a Document Total, choose this Object Type with an Approval Type of Include and enter an Amount Limit.

An Item Range rule defines the items and their amount limits that the approval group can approve. An Item Range rule is not required; approval groups can approve documents for all items by default.

To include an Item Range, choose this Object Type with an Approval Type of Include, enter an amount limit, and specify the Value Low and Value High for your range. An Item Range Include rule allows you to specify approval amount limits for individual items or item ranges, and the Amount Limit you enter applies to the sum of all items within the range. Also, an Item Range Include rule does not implicitly exclude items that are not referenced in the rule.

To exclude an Item Range, choose this Object Type with an Approval Type of Exclude and specify the Value Low and Value High for your range. The approval group will be unable to approve documents including these items.

An Item Category Range rule defines the item categories and their amount limits that the approval group can approve. An Item Category Range rule is not required; approval groups can approve documents for all item categories by default.
To include an Item Category Range, choose this Object Type with an Approval Type of Include, enter an Amount Limit, and specify the Value Low and Value High for your range. An Item Category Range include rule allows you to specify approval amount limits for individual item categories or item category ranges, and the Amount Limit you enter applies to the sum of all item categories within the range. Also, an Item Category Range include rule does not implicitly exclude item categories that are not referenced in the rule.

To exclude an Item Category Range, choose this Object Type with an Approval Type of Exclude and specify the Value Low and Value High for your range. The approval group will be unable to approve documents including these item categories.

A Location rule defines the ship–to and deliver–to locations and their amount limits that this approval group can approve. Purchasing verifies the ship to location for purchase orders and releases, and the deliver to location for requisitions. A Location rule is not required; approval groups can approve documents for all ship to and deliver to locations by default.

To include a Location rule, choose this Object Type with an Approval Type of Include, enter an Amount Limit, and specify the Location you want to control using the Value Low field. A Location Include rule allows you to specify approval amount limits for individual ship to and deliver to locations. It does not implicitly exclude locations not referenced in the rule.

To exclude a ship to or deliver to location, choose this Object Type with an Approval Type of Exclude and specify the location using the Value Low field. The approval group will be unable to approve purchase orders and releases that include this location as a ship to, or requisitions that include this location as a deliver to.

To illustrate approval group implementation, assume a Purchasing department is comprised of three kinds of purchasing professionals with a corresponding position defined for each in Purchasing: Senior Buyers (who purchase all manufacturing and MRO items/services with a $50,000 document limit), MRO Buyers (who purchase all non–manufacturing items and services with a $10,000 document limit), and Junior Buyers (who purchase all but one manufacturing item category with a $25,000 document limit).

This organization uses four two–segment item categories: MRO–SERVICE, MRO–SUPPLIES, MFG–GENERAL, and MFG–SPECIAL.
First, define one approval group called “Buyer Master” containing a single Account Range Include rule for all accounting distribution ranges with a $50,000 Amount Limit.

You can then define a supplementary approval group called “MRO Buyer” containing two rules: 1) a Document Total rule with an Amount Limit of $10,000 and 2) an Item Category Range rule excluding all item categories with MFG as the first segment.

Finally, you can define another supplementary approval group called ”Junior Buyer” containing three rules: 1) a Document Total rule with an Amount Limit of $25,000, 2) an Item Category Range rule excluding all item categories with MRO as the first segment, and 3) another Item Category Range rule excluding the MFG–SPECIAL category.

See Also

Defining Approval Groups: page 1 – 29
Defining Approval Assignments: page 1 – 33
Approval Authorization Rules: page 2 – 16
Using Approval Assignments: page 2 – 19

Using Approval Assignments

Use the Assign Approval Groups window to associate approval groups with a specific job or position and a document type including: Purchase Requisition, Internal Requisition, Standard Purchase Order, Planned Purchase Order, Blanket Purchase Agreement, Contract Purchase Agreement, Scheduled Release, and Blanket Release. You can associate multiple approval groups with a single document type/job or position combination. Whenever you associate two or more approval groups with a single document type/job or position combination, Purchasing uses the most restrictive rule to evaluate authorization limits.

Attention: While individual approval groups do not require an enabling Account Range Include rule, every document type for each job/position must be associated with at least one approval group with this characteristic. Otherwise, employees in the associated job or position will be unable to approve this document type.
If no approval groups are associated with a particular document type for a given job or position, then employees assigned to this job or position will be unable to approve documents of this type.

If you want to specify the approval assignments for the Purchasing department described in the Defining Approval Authorization Rules document (See: Defining Approval Authorization Rules: page 2–16), you can begin with the Senior Buyer position. Assuming Senior Buyers should be able to approve all document types, you can set up the control assignments as shown in the following table:

<table>
<thead>
<tr>
<th>Control Function</th>
<th>Approval Group</th>
<th>Start Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blanket Purchase Agreement</td>
<td>Buyer Master</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Blanket Release</td>
<td>Buyer Master</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Contract Purchase Agreement</td>
<td>Buyer Master</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Internal Requisition</td>
<td>Buyer Master</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Planned Purchase Order</td>
<td>Buyer Master</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Purchase Requisition</td>
<td>Buyer Master</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Scheduled Release</td>
<td>Buyer Master</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Standard Purchase Order</td>
<td>Buyer Master</td>
<td>dd–MON–yy</td>
</tr>
</tbody>
</table>

Table 2 – 2 (Page 1 of 1)

This plan allows Senior Buyers to approve all document types for all account ranges with a maximum amount limit of $50,000. The Senior Buyer position can approve all locations, items, and item categories by default.

If Junior Buyers can approve releases (and no other document types) based on the authorization criteria you specified in the Defining Approval Authorization Rules document, set up the Control Assignments as shown in the following table for this position:

<table>
<thead>
<tr>
<th>Control Function</th>
<th>Control Group</th>
<th>Start Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blanket Release</td>
<td>Buyer Master</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Blanket Release</td>
<td>Junior Buyer</td>
<td>dd–MON–yy</td>
</tr>
</tbody>
</table>

Table 2 – 3 (Page 1 of 2)
In this case, Junior Buyers can approve up to $25,000 for each Blanket and Scheduled Release including all but one category of manufacturing items. These employees cannot approve Standard Purchase Orders, Planned Purchase Orders, Purchase Requisitions, Internal Requisitions, Blanket Purchase Agreements, or Contract Purchase Agreements regardless of document total or content. Finally, Junior Buyers are unable to approve any document type that includes MRO item categories.

Attention: Note that we assigned two approval groups to each document type in this example. The Buyer Master approval group lets Junior Buyers approve releases by providing an enabling Account Range Include rule. The Junior Buyer approval group introduces the specific authorization restrictions for this position. Remember, the most restrictive rules prevail at approval time, so even though the Buyer Master Account Range Include rule allows for a $50,000 Amount Limit, the Junior Buyer Document Total rule with a $25,000 Amount Limit controls the approval ceiling.

MRO Buyers should be able to approve any document type for up to $10,000 of MRO item categories. Set up the approval assignments as shown in the following table:

<table>
<thead>
<tr>
<th>Control Function</th>
<th>Approval Group</th>
<th>Start Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blanket Purchase Agreement</td>
<td>Buyer Master</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Blanket Purchase Agreement</td>
<td>MRO Buyer</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Blanket Release</td>
<td>Buyer Master</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Blanket Release</td>
<td>MRO Buyer</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Contract Purchase Agreement</td>
<td>Buyer Master</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Contract Purchase Agreement</td>
<td>MRO Buyer</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Internal Requisition</td>
<td>Buyer Master</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Internal Requisition</td>
<td>MRO Buyer</td>
<td>dd–MON–yy</td>
</tr>
</tbody>
</table>

Table 2 – 4 (Page 1 of 2)
<table>
<thead>
<tr>
<th>Control Function</th>
<th>Approval Group</th>
<th>Start Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned Purchase Order</td>
<td>Buyer Master</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Planned Purchase Order</td>
<td>MRO Buyer</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Purchase Requisition</td>
<td>Buyer Master</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Purchase Requisition</td>
<td>MRO Buyer</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Scheduled Release</td>
<td>Buyer Master</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Scheduled Release</td>
<td>MRO Buyer</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Standard Purchase Order</td>
<td>Buyer Master</td>
<td>dd–MON–yy</td>
</tr>
<tr>
<td>Standard Purchase Order</td>
<td>MRO Buyer</td>
<td>dd–MON–yy</td>
</tr>
</tbody>
</table>

Table 2 – 4  (Page 2 of 2)

See Also

Defining Approval Groups: page 1 – 29
Defining Approval Assignments: page 1 – 33
Approval Authorization Rules: page 2 – 16
Defining Approval Authorization Rules: page 2 – 16
Assigning Employees

To assign employee to jobs or positions:

1. Use the Enter Person window to assign employees to jobs or positions. If you are not using position approval hierarchies for document routing, you must provide the employee’s supervisor. See: the online help for the Enter Person window.

   You can assign an employee to only one job or position.

   **Attention:** If Human Resources is installed, you must maintain employee information using the People window for Human Resources. See: Entering a New Person, *Managing People Using Oracle HRMS*.

2. Before you can reference your position hierarchies in Purchasing, you must run the Fill Employee Hierarchy process. This process creates an employee–populated representation of your approvals hierarchy and should be run whenever you make a structural or personnel change to your hierarchies or assignments. You can set up this process to run automatically at predefined intervals. See: Fill Employee Hierarchy Process: page 9 – 41.

   The process creates an error log which lists all positions to which no employee is assigned, but having such positions is a benign error that does not hamper system operation.
The Document Approval Process

Approve Document Window

Purchasing lets you approve requisitions, standard and planned purchase orders, blanket and contract purchase agreements, and releases using a common process. When you complete your documents and are ready to initiate the approval process, select the Approve button in the document entry window to open the Approve Document window.

In the Approve Document window, choosing Submit for Approval (and then choosing OK) approves the document if Owner Can Approve is enabled for the specific document type in the Document Types window and you have the authority to approve the document. See: Defining Document Types: page 1 – 87. If the document requires someone else’s approval, choosing Submit for Approval (and then choosing OK) automatically submits the document to that person (or routes it to multiple approvers) for approval, based on your approval hierarchy setup. See: Setting Up Document Approval and Security: page 2 – 2.

Purchasing offers the following document approval actions in the Approve Document window: Reserve or Unreserve (if using encumbrance / budgetary control), Submit for Approval, and Forward. You can also change the approval hierarchy from within the Approve Document window if Allow Change to Approval Hierarchy is selected for the document type in the Document Types window. You can also specify a Forward To person if you want the document to be approved by someone outside the approval hierarchy. You can also select the Print option, and the document will automatically be printed once it is approved. In addition, certain documents can be transmitted electronically by facsimile or e-mail.

When you select the Approve button in a document entry window, Purchasing performs submission checks to verify that the document is complete and in an appropriate state for the action you chose. Status checks are performed when you take an approval action. See: Document Submission Checks: page 2 – 27. See: Document Status Checks: page 2 – 26.

Notifications Web Page

You can also approve documents through the Notification Details Web page, accessible through the Notifications Summary menu in Purchasing. The Notifications Summary page lists all the documents awaiting your approval, so that you can manage your pending approval queue and take approval actions. After opening a
You can drill down to the document itself, and review it and its action history. You can also modify the document if Approver Can Modify is enabled for the document type. See: Defining Document Types: page 1 – 87. (After you modify a document, you need to return to the notification to take an approval action.)

You can also view and respond to notifications through e-mail. Oracle Applications uses Oracle Workflow technology to route notifications through e-mail. This way, an approver who has easier access to e-mail than to the Purchasing application can view notifications and take approval actions.

See: To View Notifications from the Worklist, Oracle Workflow Guide.

See: Reviewing Notifications via Electronic Mail, Oracle Workflow Guide.

Approval Workflow

Purchasing uses Oracle Workflow technology to handle the entire approval process. When you take an approval action in the Approve Document window or the notification, or through the Web or e-mail, you are “submitting” the approval action to Workflow. Workflow works in the background, using the approval controls and hierarchies you’ve defined to route documents for approval. Because Workflow handles your approval process in the background, you can use Oracle Workflow Builder’s easy interface to modify your approval process.

For more information about the approval workflows in Purchasing, see: Purchase Order Approval Workflow: page C – 114 and Requisition Approval Workflow: page C – 57.

See Also

Submitting a Document for Approval: page 2 – 35

Viewing and Responding to Notifications: page 2 – 31

Approved Documents and Supply

A Pre–Approved document does not show up as supply. A Pre–Approved document is one that meets the following conditions:
• A person with the final authority to approve the document approves it, but then forwards it to someone else for additional approval, thus changing its status to Pre–Approved.

• Your organization uses encumbrance (reserves funds for documents), and the document is authorized for approval but funds have not yet been reserved for it. Even if someone with sufficient approval authority approves the document, its status may still be Pre–Approved if funds were not able to be reserved at the time of approval. Once funds are reserved for the approved document, the document changes its status to Approved.

A Pre–Approved document does not show up as supply until its status changes to Approved.

When you make a change to an approved document that changes its status to Requires Reapproval, that change (for example, to quantity) does not show up as supply until the document has been approved again.

---

**Document Status Checks**

Purchasing performs a status check on all documents whenever you perform or attempt an approval action. This check verifies that the document is in a valid state to perform the selected approval action. If your document fails the status check, Purchasing provides an error message in the window in which you are working.

The following matrix describes the valid actions for each document state. Generally, lists of values in the document entry and approval windows restrict the list of available approval actions based on document status, so you should rarely encounter status check failures.

**Document Approval Status: Valid Action Rules**

<table>
<thead>
<tr>
<th>Current Document Status</th>
<th>Approve</th>
<th>Reserve</th>
<th>Forward</th>
<th>Reject</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incomplete</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>In Process</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

Table 2 – 5 (Page 1 of 2)
<table>
<thead>
<tr>
<th>Current Document Status</th>
<th>Approve</th>
<th>Reserve</th>
<th>Forward</th>
<th>Reject</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pre-Approved</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Rejected</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Returned</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Requires Reapproval</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Not on Hold</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Not Frozen</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Not Cancelled</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Not Reserved</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Open</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Closed</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

Table 2 – 5  (Page 2 of 2)

### Document Submission Checks

Purchasing performs a submission check on all documents that successfully complete a status check whenever you perform or attempt an approval action.

The submission check verifies that all mandatory fields have been entered and that various quantities, amounts, and dates are within prescribed ranges or limits. If your document fails any of the submission check rules, Purchasing automatically brings you to the Approval Errors window where you can review the cause(s) of failure. You can then return to the document entry window to make required corrections.

The following matrix describes the submission checks that are performed for each document type.
### Submission Check Rules

<table>
<thead>
<tr>
<th></th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
<th>Requisition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document must have a supplier</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Document must have a supplier site</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Supplier must not be on hold</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Supplier must be included in current Approved Supplier List entries for items requiring an approved supplier</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Document must have a currency</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Foreign currency must have a rate</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Foreign currency must have a rate type</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Foreign currency must have a rate date if rate type is not User</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Document must have a ship-to location</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Document must have a bill-to location</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amount limit must be greater than or equal to Amount Agreed</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Amount limit must be greater than or equal to Minimum Release Amount</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Amount limit must be greater than or equal to the total amount already released</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

Table 2 – 6  (Page 1 of 4)
<table>
<thead>
<tr>
<th>HEADER</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
<th>Requisition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount limit must be greater than or equal to the standard purchase order line total referencing this contract</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Related document cannot be on hold</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Release date must fall within related document effectivity dates</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Related purchase agreement cannot be on hold</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Related document supplier cannot be on hold</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Current release total must be greater than or equal to header minimum release amount specified on related agreement</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Current Release total plus all approved release totals must be greater than or equal to the related document amount limit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LINE</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
<th>Requisition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each document must have at least one line</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Line quantity must equal the sum of its shipment quantities</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If a line references a contract, the contract must be approved</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 2 – 6  (Page 2 of 4)
<table>
<thead>
<tr>
<th>LINE</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
<th>Requisition</th>
</tr>
</thead>
<tbody>
<tr>
<td>If a line references a contract, the supplier on the contract must be the supplier on the PO header</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PO line total related to a contract plus existing approved lines relating to the same contract cannot exceed contract amount limit</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Requisition line quantity must equal the sum of its distribution quantities</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SHIPMENT</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
<th>Requisition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each PO line must have at least one shipment</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shipment quantity must equal the sum of its distribution quantities</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Each release must have at least one shipment</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Current shipment total must be greater than or equal to line minimum release amount specified on related document</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Price must be within specified price tolerance if Enforce Price Tolerance is Yes and the release was AutoCreated from a requisition</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

Table 2 – 6  (Page 3 of 4)
### Table 2–6  (Page 4 of 4)

<table>
<thead>
<tr>
<th>DISTRIBUTION</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
<th>Requisition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each shipment must have at least one distribution</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Each requisition line must have at least one distribution</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Foreign currency distributions must have a rate</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Foreign currency distributions must have a rate type</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Foreign currency distributions must have a rate date if rate type is not User</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

### Viewing and Responding to Notifications

Use the Notification Details Web page, accessible through the Notifications Summary menu in Purchasing, to manage your pending approval queue and take approval actions. After opening a notification, you can also submit a document for approval from the notification if you didn’t yet do it through the Approve Document window.

Purchasing offers the following document approval actions in the notification: Approve, Approve and Forward, Forward, and Reject. You can also reassign a notification to somebody else.

The approval amount noted in the notification includes nonrecoverable tax if you use tax and recovery rates. See: Tax Defaults in Purchasing: page 4 – 135.

The Notifications Web page requires Oracle Workflow to be set up. See: Setting Up Oracle Workflow, Oracle Workflow Guide.
Reassign and Forward

A **Reassign** action is not recorded in the Action History window, but a **Forward** action is. See: Viewing Action History: page 8 – 2. To reassign a notification but still record you as the approver, choose Reassign, and then choose Delegate. To forward the notification so that the new approver is recorded in the action history instead of you, open the notification and select the Forward action. (Do not use the Reassign/Transfer option.)

Ignore

Some reminder notifications include a response of Ignore. Ignore means that you are ignoring the notification for now. Purchasing will not display that notification again until the concurrent program process **Send Notifications for Purchasing Documents** runs. (See: Send Notifications for Purchasing Documents: page 9 – 155.)

Close Button

When you click Close, Purchasing considers the notification closed. If you want to see the notification again, choose Search and select a status of All or Closed.

Opening a Document

From a notification that you have opened, you can also drill down to the document and modify it if Approver Can Modify is enabled for the document type. See: Defining Document Types: page 1 – 87. Depending on the function security assigned to your responsibility, you have varying levels of access to information. A responsibility defines an application user’s current privileges while working with Oracle Applications.

**Attention:** After you modify a document opened through the notification, you must return to the notification and choose Approve there, not in the document itself, so that Purchasing can record your approval action and continue with or complete the approval process.

Purchasing Notifications

In the Notifications Summary list, notifications for the following Purchasing documents appear. The Send Notifications for Purchasing Documents process must be running for some of these notifications to be sent:

- Purchase orders and requisitions that require approval action.
• Requisitions or purchase orders that are incomplete.

• Purchase orders and releases that require acceptance. (You indicate on your standard purchase orders, purchase agreements, and releases whether you require your suppliers to accept your orders by a specific date by selecting Acceptance Required in the Terms and Conditions window.) For purchase orders and releases that have not been entered as accepted in the Acceptances window, Purchasing notifies you that acceptance is required. If the Acceptance Require By date indicates that the acceptance is overdue, Purchasing sends a notification that acceptance is past due.

• RFQs and quotations with a Status of In Process. Purchasing sends a notification that the document requires completion.

• RFQs for which the Status is Active and the current date is between the Due Date and the Close Date on the RFQ. Purchasing sends a notification that the RFQ is approaching expiration.

• Quotations for which the Status is Active and the current date is between the Effectivity end date on the Quotation and the Quote Warning Delay end date in the Default region of the Purchasing Options window. Purchasing sends a notification that the quotation is approaching expiration.

• Blanket purchase agreements or catalog quotations sent by your supplier through the Purchasing Documents Open Interface when price increases on those documents exceed a price update tolerance that you define. You receive a notification for each affected document. See: Receiving Price/Sales Catalog Information Electronically: page 5 – 22.

• Reschedule notifications from Master Scheduling/MRP. Master Scheduling/MRP can automatically reschedule standard purchase orders and blanket and planned releases by changing the Need By date on the document if you respond to the reschedule notification with your approval. See: Summary of Exception Process 2, Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.

• Debit memos that failed to be created when you entered a Return to Supplier transaction, if automatic debit memo creation is enabled in both the Supplier Sites and the Returns windows. The buyer is notified. See: Debit Memos: page 7 – 15.

For notifications about purchase order acceptances, RFQ expiration, and quotation expiration, you can choose a response of Close. The
closed notification won’t reappear unless you change the expiration date on the document.

**If you receive a notification titled Document Manager Failed:**
Open the notification and read the detailed message. You or your system administrator may need to reactivate the PO Document Approval Manager. Once the PO Document Approval Manager is reactivated, respond to the notification by choosing Retry.

![Attention:](image) After the PO Document Approval Manager is reactivated, you must respond to the notification with Retry to restart the approval process where it left off.

**If you receive a notification titled Unable to Reserve Document:**
You have several options:

- Reserve the document again if, for example, more funds have been allocated.

  ![Attention:](image) To reserve funds for the document, first open the document from the notification. Choose the Approve button in the document, and then check Reserve and OK. Then respond with Retry in the notification.

- Send the document back to its preparer for modification; the preparer can then, for example, reduce the quantity on the document and submit it again for approval.

- Forward the document to somebody else with authority to reserve the funds.

**If you see Resubmit Requisition, Update Requisition, and Requisition Detail icons in a notification:**
These icons enable you to resubmit, update, or view requisitions only if iProcurement is installed.

**Additional Information**


You can also view and respond to notifications through e-mail. Oracle Applications uses Oracle Workflow technology to route notifications through e-mail. This way, an approver who has easier access to e-mail
than to the Purchasing application can view notifications and take approval actions. See: Reviewing Notifications via Electronic Mail, Oracle Workflow Guide.

See Also

Overview of Function Security, Oracle Applications System Administrator’s Guide

Function Security for Purchasing: page 1 – 112
Send Notifications for Purchasing Documents: page 9 – 155

Submitting a Document for Approval

Use the Approve Document window to take approval actions on documents that you create or modify. (You can also use this window to make changes to encumbered documents. See: Changing Encumbered Documents: page 4 – 132.)

To take approval actions:

Navigate to the Approve Document window by selecting the Approve button in a document entry window.
1. If you are using encumbrance/budgetary control, Reserve and Unreserve options are available.

*Reserve* – You can reserve funds for the document only if you are using encumbrance/budgetary control. Requisition preparers can choose this option only if Reserve at Completion in the Financials Options window is enabled and the document is currently unreserved. See: Defining Financials Options, *Oracle Public Sector Payables User’s Guide*. When you select Reserve (and then OK), Purchasing reserves the funds now. Purchasing also automatically approves the document if the document has been preapproved, you’re the appropriate approver, and no more approvals are required. If you get a message that you cannot reserve the funds, forward the document to an approver who has the authority to reserve them. If you don’t select Reserve, but just select Submit for Approval (and then OK), Purchasing reserves funds later, when the approver with the authority to reserve the funds approves the document.

*Unreserve* – You can unreserve funds for the document only if you are using encumbrance/budgetary control and funds are currently reserved for that document.
Unreserve Date – If you selected Unreserve, enter an Unreserve Date that falls within an open reserve period.

2. Select Submit for Approval.

3. Select Forward only if you want to forward the document to someone other than the next approver in the default Approval Path.

If you select Forward, you must enter a Forward To person. If you don’t select Forward, Purchasing will automatically route the document to the appropriate person in the Approval Path, if you’re not the appropriate approver.

If the Forward To person is higher up in the default (or selected) Approval Path, but still does not have enough approval authority, Purchasing will continue the approval process with the next person in that Approval Path. If the Forward To person is not in the default (or selected) Approval Path, and also does not have enough approval authority, you will receive an Approver Not Found notification.

4. If Allow Change to Approval Hierarchy is selected for the document type, you can select a new Approval Path. See: Defining Document Types: page 1 – 87.

5. Choose OK.

The document is submitted to the approval process, which routes the document to the appropriate approvers based on the approval hierarchies and controls you’ve defined. If Owner Can Approve is enabled for the specific document type in the Document Types window and you have the authority to approve the document, then choosing OK approves the document.

▶ To cancel your approval action:

■ Choose the Cancel button to cancel your approval action and return to your document entry window.

▶ To change the Forward From person:

■ For requisitions only, if you have selected Forward as the action and if Allow change to Forward–From is enabled for the document type in the Document Types window, you can change the Forward From person to the original preparer or to any requestor on a line of the requisition. See: Defining Document Types: page 1 – 87.
To change the Forward To person:

- If you have selected Forward as the action and if Allow change to Forward–To is enabled for the document type in the Document Types window, you can change the Forward To person. See: Defining Document Types: page 1 – 87.

The Forward To value is a default from the employee/supervisor relationship or from the approval hierarchy, depending on whether you are using approval hierarchies.

To enter notes:

- Enter notes in the Note field to record information about your approval action or provide instructions for the next approver if your document requires additional authorization. See also: Attaching Notes to Purchasing Documents: page 1 – 44.

To print the document:

- Select Print.

The document will automatically print once it is approved.

A purchase order will not print if the supplier site on the purchase order is already set up to receive purchase orders through Electronic Data Interchange (EDI).

To send a facsimile of the purchase order:

- Select Fax and enter a Fax Number. CommercePath, or any facsimile software that is compatible with the CommercePath Fax Command Language (FCL), must be installed to use this functionality.

If the Supplier Notification Method in the supplier site window (General tab) is set to Fax and you have entered a fax number for that supplier site then the number will default in. This is a default and you can change it. Once approved, the document will be faxed to the supplier by the purchase order approval workflow. See: Supplier and Supplier Sites Window Reference, Oracle Public Sector Payables User’s Guide.

Selecting Fax and entering a Fax Number automatically sends a facsimile of the document once it is approved.

Selecting Fax without entering a Fax Number sends the document to your facsimile server once it is approved. Depending on your
CommercePath setup, you can choose where or when to send the documents that are stored on your facsimile server.

If the supplier is already set up to receive purchase orders through Electronic Data Interchange (EDI), a facsimile of the purchase order will not be sent.

► To send an e-mail of the purchase order:
  - Select E-mail and enter an e-mail address to send this standard purchase order, blanket agreement, or blanket release by way of e-mail. Selecting E-mail and entering an e-mail address automatically sends the purchasing document by way of e-mail, once it is approved.

  If the Supplier Notification Method in the supplier site window (General tab) is set to E-mail and you have entered an e-mail address for that supplier site then the address will default in. Once approved, the document will be e-mailed to the supplier by the purchase order approval workflow. See: Supplier and Supplier Sites Window Reference, Oracle Public Sector Payables User’s Guide.

  Note that setting your supplier site notification method as described above simply provides a default on this form. The buyer is free to change or override these defaults.

  If the supplier is already set up to receive purchase orders through Electronic Data Interchange (EDI), an e-mail of the purchase order will not be sent.

See Also

Defining Document Types: page 1 – 87
The Document Approval Process: page 2 – 24
Viewing and Responding to Notifications: page 2 – 31
Setting Up Document Approval and Security: page 2 – 2
Purchase Order Approval Workflow: page C – 114
Requisition Approval Workflow: page C – 57
An offline approver is someone who does not log on to Oracle Applications, but uses someone else to approve on his or her behalf.

All approvers, including offline approvers, need to have a logon user name. Even if the approver is set up as an employee in the approval hierarchy, Purchasing cannot continue with approval without that employee’s also having a logon user name.

If in the Approve Document window you forward to an approver who does not have a logon user name, Purchasing alerts you right away. If an approver without a logon user name is already included in the approval hierarchy, the approval workflow will fail at that approver. (The document will remain In Process.)

To include the offline approver in document approvals, you need to:

- Assign the offline approver a logon user name.
- Use the notification handling feature to forward the offline approver’s documents to a proxy approver—someone who can log on to Oracle Applications and approve the document on the offline approver’s behalf.

You need to do both of these steps. The approval process needs to know the offline approver’s logon user name before it can route that person’s documents to the proxy approver. Both of these steps are described below.

When you designate a proxy approver to approve on the offline approver’s behalf, the offline approver, not the proxy approver, shows up as having approved the document in the Action History window.

To designate a proxy approver:

1. Assign the offline approver a logon user name if the approver does not already have one.
   
   For instructions, see: Users Window, Oracle Applications System Administrator’s Guide.

2. In the Purchasing or System Administrator responsibility, in the Workflow menu, navigate to Notification Rules, which opens a Web page.
   
   In the System Administrator responsibility, the Workflow Administrator > Notification Rules menu enables you to reassign anyone’s notifications. In the Purchasing responsibility, the
Workflow User > Notification Rules menu enables you to reassign only your notifications.

3. Designate a proxy approver for the offline approver by following the instructions in Defining Rules for Automatic Notification Handling, Oracle Workflow Guide.

The instructions for defining these rules refer to a role. For Purchasing, role means the user for whom you are designating a proxy approver.

When you reach the Find Notification Routing Rules Web page, enter the user name of the offline approver.

If you want to designate the proxy approver for both requisitions and purchase orders, when you reach the step about selecting the workflow (item type) for which you need to create the proxy approver, select the PO Requisition Approval workflow. Then repeat the steps for the PO Approval workflow, for purchase orders. (Recall that different document types are tied to their corresponding workflows—usually to either the PO Requisition Approval workflow or the PO Approval workflow—in the Document Types window during Purchasing setup. For example, the PO Approval workflow handles all purchase order types, unless you’ve set up the Document Types window to do differently.)

Once you have selected the workflow, you will be presented with a list of the notifications within the workflow. For offline approvers, you may want to select All notifications.

When you reach the step that asks you to enter a comment, it is advisable to enter a comment—for example, "This document requires your approval on Joan’s behalf.” This helps the proxy approver know whether it is just another document in his or her queue, or a document that needs to be approved for someone else.
Mass Forwarding Documents

Use the Forward Documents window to forward all or selected documents awaiting approval from one approver to a new approver. This lets you keep your documents moving when the original approver of a document is unavailable.

**To mass forward documents:**

1. Select Forward Documents from the menu. Purchasing displays the Enter Approver modal window, where you must provide the name of the original Approver and select OK to display the Forward Documents window.

   ![Forward Documents Window](image)

   For each document available for forwarding, Purchasing displays the Forward Date, document Type, document Number, Currency, Amount, Status, From person, Note, document Description, document Owner, and Creation Date.

2. Select the documents you want to forward.
3. Enter the New Approver to whom you want to forward the selected documents.

4. Save your work.

► **To change the original approver:**

- Select the Change Approver button to display the Enter Approver modal window, where you can change the original approver for whom the Forward Documents window displays documents available to be forwarded.

► **To view action history:**

- Select View Action History on the Tools menu. See: Viewing Action History: page 8 – 2.
Document Control Overview

Purchasing allows you to control the status of your requisitions, planned and standard purchase orders, blanket and contract purchase agreements, and releases during the document life cycle.

Purchasing provides you with the features you need to satisfy the following basic needs. You should be able to:

- Delete unapproved documents or unapproved lines, shipments, and distributions that you add to previously approved documents
- Terminate existing commitments to buy from suppliers by fully or partially cancelling your documents
- Indicate that no further internal activity is expected or allowed on completed orders by final closing them
- Freeze or unfreeze documents to control whether modifications are allowed
- Place documents on hold to prevent printing, receiving, invoicing, and approval until the hold is removed
- Firm purchase orders to prevent Oracle Master Scheduling/MRP and Supply Chain Planning from suggesting reschedules in, cancellations, or new planned purchase orders within the time fence created by your firm date
- Control how Purchasing automatically closes documents for receiving and invoicing activity


See Also

Controlling Documents: page 2 – 55

Document Control Options

Delete

Before documents are approved, you can delete them or their components from the document entry window.
Attention: If you are using automatic numbering, you cannot reuse document numbers that you delete with this option.

You can also use the appropriate entry window to delete unapproved lines, shipments, and distributions that you added to previously approved documents.

If you use online requisitions, Purchasing returns all requisitions associated with your delete action to the requisition pool. You can reassign these unfilled requisitions to other purchase orders or releases using the AutoCreate Documents window. See: Finding Requisition Lines for AutoCreate: page 6–12.

Cancel

Purchasing lets you terminate an existing commitment to buy from a supplier by cancelling document headers, lines, shipments, or releases.

When you cancel a purchase order entity, you are unable to receive or pay for cancelled items and services, however, you can pay for all previously received orders. You also cannot modify a cancelled entity or its components. For example, if you cancel a line you cannot modify the associated shipments and distributions. If you cancel a document header, you cannot access the document in the corresponding entry form. You can approve documents that include cancelled entities (lines and shipments), but you cannot approve documents that are cancelled at the header level. You can also print cancelled documents.

Purchasing marks these documents with a cancellation notice to highlight this action to the supplier. Finally, you can Purge documents that were cancelled at the header level before the Last Activity Date that you specify when you submit Purge. See: Printed Purchase Order Overview: page 4–109. See: About Purging Records, Oracle Public Sector Payables User’s Guide.

If you are using encumbrance and budgetary control, Purchasing automatically creates negative debit encumbrance journal entries in your general ledger system to reverse the encumbrance that corresponds to the document header, lines, or shipments you are cancelling.

If you are using online requisitions, Purchasing returns unfilled requisitions associated with cancelled purchase order entities to the requisition pool based on the Cancel Requisitions control you specify in the Purchasing Options window. See: Defining Control Options: page 1–49.

Example

You order 100 items from a supplier, and after receiving 30 of these items, you realize that you no longer have a need for the outstanding items.
balance. Cancel the remaining 70 items, print the purchase order, and send it to the supplier to indicate contractually that you do not want to take delivery of these items.

You should cancel documents or their components only if you are absolutely certain that all desired activities have been completed; you cannot undo a cancel action.

You can cancel an entire requisition or particular requisition lines. However, you cannot cancel a requisition line a buyer placed on a purchase order, modified during AutoCreate, or placed on a sales order.

If a buyer places a requisition line on a purchase order, you cannot cancel the requisition line or the corresponding requisition header until you cancel or final close all purchase order lines associated with the requisition.

Similarly, you cannot cancel a requisition if any of its lines are on an active internal sales order. However, if the related internal sales order is cancelled, you should cancel the originating requisition line.

When you cancel a requisition related to a cancelled sales order, the quantity cancelled on the requisition line is the same as the quantity cancelled on the sales order line, not the remainder of the requisition.

You cannot cancel a purchase order if there are batch receiving transactions in the receiving interface awaiting processing against the purchase order.

If you partially received a shipment corresponding to multiple distributions, Purchasing cannot always cancel the shipment. To make sure Purchasing can cancel a shipment, enter the delivery transactions for the receipts you entered against that shipment. You can use express delivery to facilitate this process.


**Final Close**

Prevent modifications to or actions against completed documents, lines, and shipments by final closing them. Final–closed documents are not accessible in the corresponding entry forms, and you cannot perform the following actions against final–closed entities: receive, transfer, inspect, deliver, correct receipt quantities, invoice, return to
supplier, or return to receiving. You can approve documents that include final–closed entities, but you cannot approve documents that are final closed at the header level. You can print final–closed documents; this is an internal control action that has no bearing on your contractual relationship with the supplier. Finally, you can Purge documents that were final closed at the header level before the Last Activity Date that you specify when you submit Purge. See: About Purging Records, Oracle Public Sector Payables User’s Guide.

You should final close documents or their components only if you are absolutely certain that all desired activities have been completed; you cannot undo a final–close action.

If you are using encumbrance and budgetary control, final close automatically creates credit encumbrance journal entries in your general ledger system to reverse the encumbrance that corresponds to the document header, lines, or shipments you are final closing.

If you are using online requisitions, Purchasing does not return unfilled requisitions associated with final–closed purchase order entities to the requisition pool. You must cancel or final close these requisitions using the Control Document window. See: Controlling Documents: page 2 – 55.

Payables can also final close documents during Payables Approval for purchase order matched invoices only, if you select Allow Final Matching in the Payables Options window. See: Payables Options, Oracle Public Sector Payables User’s Guide.

You can final close an entire requisition or particular requisition lines. However, you cannot final close a requisition line a buyer placed on a purchase order, modified during AutoCreate, or placed on a sales order.

If a buyer places a requisition line on a purchase order, you cannot final close the requisition line or the corresponding requisition header until you cancel or final close all purchase order lines associated with the requisition.

Similarly, you cannot final close a requisition if any of its lines are on an active internal sales order. If the related internal sales order is closed, you can final close the originating requisition line.

You cannot final close a purchase order if there are batch receiving transactions in the receiving interface awaiting processing against the purchase order.
Freeze

Freeze your purchase orders and releases to prevent changes or additions while maintaining the ability to receive and match invoices against received shipments. You cannot access frozen documents in the entry forms.

Use the Control Document window to freeze or unfreeze a document. See: Controlling Documents: page 2 – 55.

Hold

Place documents on hold to unapprove them while preventing printing, receiving, invoicing, and future approval until you remove the hold.

Example  
After sending a purchase order to a supplier and receiving some items, you discover a severe quality problem with one of the incoming lots. While you wait for corrective action from the supplier, place the document on hold until the problem is resolved.

Use the Control Document window to place a document on hold, or remove a hold. See: Controlling Documents: page 2 – 55.

Firm

When you firm an order, Master Scheduling/MRP uses the firm date to create a time fence within which it will not suggest new planned purchase orders, cancellations, or reschedule–in actions. It continues to suggest reschedule–out actions for orders within the time fence. If several shipments with different promised or need–by dates reference the same item, Master Scheduling/MRP sets the time fence at the latest of all scheduled dates.

You can firm orders at the document header or shipment level. If you firm at the header level, Purchasing applies this control to every shipment on the document.

Example  
When you negotiate delivery dates for an allocated commodity, the supplier warns that you will be unable to expedite or cancel this order. Firm the order to prevent Master Scheduling/MRP from assuming you have this flexibility in its planning logic.


You can also create firm time fences for specific items using the Item window. See: Defining Items, Oracle Inventory User’s Guide.
Close, Close for Receiving, Close for Invoicing

Purchasing automatically closes shipments for receiving and invoicing based on controls that you specify in the Purchasing Options window. Once all shipments for a given line are closed, Purchasing automatically closes the line. When all lines for a given header are closed, Purchasing automatically closes the document.

You can specify closing controls including: Receipt Close Tolerance, Receipt Close Point, and Invoice Close Tolerance. See: Defining Purchasing Options: page 1 – 45.

- The Receipt Close Tolerance lets you specify a quantity percentage within which Purchasing closes a partially received shipment. For example, if your Receipt Close Tolerance is 5% and you receive 96% of an expected shipment, Purchasing automatically closes this shipment for receiving.

- The Receipt Close Point lets you choose which receiving action (Received, Accepted, or Delivered) you want to use as the point when Purchasing closes a shipment for receiving based on the Receipt Close Tolerance. For example, if you set a Receipt Close Tolerance of 5% and choose Delivered as your Receipt Close Point, Purchasing closes shipments for receiving when you have delivered 95% or more of the ordered quantity.

- The Invoice Close Tolerance lets you specify a similar quantity percentage within which Purchasing automatically closes partially invoiced shipments for invoicing.

Purchasing does not include closed shipments in the Open Purchase Order reports, and you can purge documents that were closed at the header level before the Last Activity Date that you specify in the Submit Purge window. See: About Purging Records, Oracle Public Sector Payables User’s Guide.

You can close and reopen documents and their components for invoicing and receiving using the Control Document window. You can reopen a document at any time by modifying it or taking another action against it. See: Controlling Documents: page 2 – 55.

Note: The Close for Invoicing status does not prevent you from matching an invoice to a purchase order or to a receipt.
Purchase Order Control Matrices

The following matrices describes each of the purchase order control functions including information on where the control is specified, what purchase order activities can occur when a document is in a given state, the related MRP/ATP effects, related encumbrance effects, and finally, related requisition effects.

<table>
<thead>
<tr>
<th>Control Details</th>
<th>Close</th>
<th>Close for Invoicing</th>
<th>Close for Receiving</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document available to purge?</td>
<td>Yes, if header final closed before Last Activity Date</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Modify controlled entity?</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Action causes revision change?</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Print document?</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Receive against controlled entity?</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>RTV against controlled entity?</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Invoice against controlled entity?</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Does document maintain its approval status?</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>AutoCreate or Release against document?</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>MRP/ATP Effect</td>
<td>Closed quantity no longer available as supply; supply is recreated when reopened</td>
<td>No effect</td>
<td>Closed quantity no longer available as supply; supply is recreated when reopened</td>
</tr>
<tr>
<td>Encumbrance Effect</td>
<td>No effect</td>
<td>No effect</td>
<td>No effect</td>
</tr>
<tr>
<td>Associated Requisitions</td>
<td>No effect</td>
<td>No effect</td>
<td>No effect</td>
</tr>
</tbody>
</table>

Table 2 – 7  (Page 1 of 1)
<table>
<thead>
<tr>
<th>Control Details</th>
<th>Cancel</th>
<th>Finally Close</th>
<th>Freeze</th>
<th>Hold</th>
<th>Firm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document available to purge?</td>
<td>Yes, if header cancelled before Last Activity Date</td>
<td>Yes, if header final closed before Last Activity Date</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Modify controlled entity?</td>
<td>Cannot modify entity or below cancelled entity</td>
<td>Cannot modify entity or below final-closed entity</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Action causes revision change?</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Print document?</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Receive against controlled entity?</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>RTV against controlled entity?</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Invoice against controlled entity?</td>
<td>Yes, against received qty.</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Does document maintain its approval status?</td>
<td>Yes, if header, line, or shipment is cancelled; but if you cancel the header, the Cancelled check box is selected</td>
<td>Yes if header, line, or shipment is final closed; but if you final close the header, the Closure Status is updated correspondingly</td>
<td>Yes, but the Frozen check box is selected</td>
<td>No; documents on hold require reapproval</td>
<td>Yes</td>
</tr>
<tr>
<td>AutoCreate or Release against document?</td>
<td>Cannot add req to cancelled doc; cannot create release</td>
<td>Cannot add req to final-closed doc; cannot create release</td>
<td>Cannot create release against frozen purchase order</td>
<td>No effect</td>
<td>No effect</td>
</tr>
<tr>
<td>MRP/ATP Effect</td>
<td>Cancelled quantity no longer available as supply</td>
<td>Finally Closed quantity no longer available as supply</td>
<td>No effect</td>
<td>MRP will not reschedule in or cancel the order. (See Note)</td>
<td>No effect</td>
</tr>
</tbody>
</table>

Table 2 – 8 (Page 1 of 2)
<table>
<thead>
<tr>
<th>Control Details</th>
<th>Cancel</th>
<th>Finally Close</th>
<th>Freeze</th>
<th>Hold</th>
<th>Firm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encumbrance Effect</td>
<td>Outstanding encumbrance reversed as a negative DR</td>
<td>Outstanding encumbrance reversed as CR</td>
<td>No effect</td>
<td>No effect</td>
<td>No effect</td>
</tr>
<tr>
<td>Associated Requisitions</td>
<td>Determined by Purchasing Options: Never, Always, Optional</td>
<td>Not returned to req pool; must manually final close or cancel associated req</td>
<td>No effect</td>
<td>No effect</td>
<td>No effect</td>
</tr>
</tbody>
</table>

Note: Within the time fence created by a Firm order, MRP will not suggest new planned orders, cancellations, or reschedule–in actions; but it will suggest reschedule–out actions.

**Document Control Applicability Matrix**

The Document Control Applicability matrix describes which control actions are valid for each document type and entity.

<table>
<thead>
<tr>
<th>Current Document Type</th>
<th>Cancel</th>
<th>Finally Close</th>
<th>Close for Invoice</th>
<th>Close for Receipt</th>
<th>Freeze</th>
<th>Hold</th>
<th>Firm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned PO Header</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Planned PO Line</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Planned PO Shipment</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Standard PO Header</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Standard PO Line</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard PO Shipment</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Blanket Agreement Header</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Blanket Agreement Line</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contract Agreement Header</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Release Header</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Release Shipment</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

Table 2 – 9 (Page 1 of 2)
## Document Control Status Check Matrix

Purchasing performs a status check on all documents when you choose a control action. This check verifies that the document is in a valid state to perform the selected control action. If your document fails the status check, Purchasing provides an error message in the window in which you are working.

The following matrix describes the valid actions for each possible document state. Generally, Purchasing restricts the list of available actions based on document status, so you should rarely encounter problems in the status check.

<table>
<thead>
<tr>
<th>Current Document Type</th>
<th>Cancel</th>
<th>Finally Close</th>
<th>Close</th>
<th>Close for Invoice</th>
<th>Close for Receipt</th>
<th>Freeze</th>
<th>Hold</th>
<th>Firm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requisition Header</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Requisition Line</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 2 – 9  (Page 2 of 2)

<table>
<thead>
<tr>
<th>Current Document Status</th>
<th>Cancel</th>
<th>Finally Close</th>
<th>Close</th>
<th>Open</th>
<th>Close for Invoice</th>
<th>Close for Receipt</th>
<th>Freeze</th>
<th>Hold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incomplete</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>In Process</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Approved</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pre-Approved</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Rejected</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Requires Reapproval</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>On Hold</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frozen</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cancelled</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Finally Closed</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reserved</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

Table 2 – 10  (Page 1 of 2)
Table 2 – 10 (Page 2 of 2)

Document Control Submission Check Matrix

Purchasing performs a submission check on each document for which you choose a Cancel or Finally Close control action. The submission check verifies that the document satisfies specific conditions for these control actions. For example, if you try to cancel a blanket purchase agreement, the submission check verifies that all releases associated with this agreement have been cancelled or final closed. If your document fails any of the submission check rules, Purchasing opens the View Online Report window where you can review the cause(s) of failure.

The following matrix describes the submission checks that Purchasing performs for each document type.

<table>
<thead>
<tr>
<th>Current Document Status</th>
<th>Cancel</th>
<th>Finally Close</th>
<th>Close</th>
<th>Open</th>
<th>Close for Invoice</th>
<th>Close for Receipt</th>
<th>Freeze</th>
<th>Hold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Closed</td>
<td></td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Closed for Invoicing</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Closed for Receiving</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

Table 2 – 11 (Page 1 of 2)
Table 2 – 11    (Page 2 of 2)

**Controlling Documents**

Use the Control Documents window to control requisitions and requisition lines as well as purchase orders, purchase order lines, releases, and shipments. For requisitions, the only available actions are Cancel and Finally Close. Only control options appropriate for the selected requisition or purchase order are displayed in the Actions field. The following control actions are available in this window:

**Cancel** – If you use on-line requisitions, and you cancel a purchase order you did not receive or pay at all, Purchasing cancels the requisition lines associated with the purchase order if the Cancel
Requisitions check box is selected. If the Cancel Requisitions check box is not selected, the requisition lines are not cancelled and are returned to the pool of available requisitions. You can then assign these requisition lines to new purchase orders to fulfill your requestors’ needs. See: Defining Control Options: page 1 – 49.

If you use on-line requisitions, and you cancel a partially received purchase order line, Purchasing recreates requisition lines for the remainder of the maximum of the billed or received quantity you have not received. You can assign these requisition lines to a new purchase order line to fulfill the requestor’s needs. See: Autocreate Document Options: page 6 – 4.

If you are using encumbrance or budgetary control, Purchasing automatically creates negative debit entries in your general ledger system to cancel the encumbrane that corresponds to the purchase order header, lines, or shipments you are cancelling, using the action date you specify in Action Date. Purchasing recreates requisition encumbrances for the requisition lines you used to create the purchase order if the Cancel Requisitions check box is not selected. Purchasing uses the distributions from your cancelled purchase order to recreate the encumbrane for your requisition. See: Budgetary Control and Online Funds Checking, Oracle Public Sector General Ledger User’s Guide.

After you partially or completely cancel a purchase order, you need to inform your supplier of the cancellation. You can reprint purchase orders or releases you partially or completely cancelled. Purchasing automatically prints a cancellation message on the purchase order, purchase order line, purchase order shipment, or release you cancelled.

You can source a requisition line from a line in the Prior Purchases region of the Supplier Item Catalog window. (A line in the Prior Purchases region corresponds to a purchase order line.) However, Purchasing does not automatically update the corresponding sourcing information if you cancel a blanket agreement or agreement line with which you source requisition lines. If you cancel a blanket agreement or agreement line, be sure to update the corresponding information in the Requisition Templates or the Sourcing Rules window. See: Defining Requisition Templates: page 1 – 62. See: Automatic Sourcing: page 5 – 30.

Close – You can close at the header, release, line, and shipment levels.

Close for Invoicing – You can close for invoicing at the header, release, line, and shipment levels. Note that if you close for invoicing a purchase order header that is currently open, Purchasing sets the status of all purchase order shipments to Closed for Invoicing, but the purchase order lines and header remain open. This status will not
prevent you from matching an invoice to the purchase order or to the receipt.

*Close for Receiving* – You can close for receiving at the header, release, line, and shipment levels. Note that if you close for receiving a purchase order header that is currently open, Purchasing sets the status of all purchase order shipments to Closed for Receiving, but the purchase order lines and header remain open.

*Finally Close* – You can final close at the header, release, line, and shipment levels. Purchasing automatically closes fully billed and received purchase orders. However, to prevent further actions on the purchase order, you should use this window to final close purchase orders. Finally Close prevents modifications to the purchase order. Also, if you are using encumbrance or budgetary control, Finally Close automatically creates credit encumbrance journal entries in your general ledger system to reverse the encumbrance that corresponds to the purchase order header, lines, or shipments you are closing, using the action date you specify in Action Date. See: Budgetary Control and Online Funds Checking, Oracle Public Sector General Ledger User’s Guide.

*Freeze* – You can freeze only at the header and release level. You freeze a purchase order when you want to prevent any future modifications to the purchase order. When you freeze a purchase order, you can still receive and pay for goods you already ordered. If you want to prevent future receipt or matching invoices against this purchase order, cancel or final close the purchase order instead.

If you use a Requisition template or source requisition lines from a purchase order line, Purchasing does not automatically update the corresponding sourcing information when you freeze a purchase order with which you source requisition lines. If you freeze a purchase order, be sure to update the corresponding information in the Requisition Templates or the Sourcing Rules window. See: Defining Requisition Templates: page 1 – 62. See: Automatic Sourcing: page 5 – 30.

*On Hold* – You can place a purchase order on hold only at the header level. This unapproves the purchase order while preventing printing, receiving, invoicing, and future approval until you remove the hold.

*Open* – You can open at the header, line, and shipment levels.

*Open for Invoicing* – You can reopen for invoicing at the header, line, and shipment level.

*Open for Receiving* – You can reopen for receiving at the header, line, and shipment level.
Release Hold – You can release a hold only at the header level.

Unfreeze – You can unfreeze only at the header and release levels.

To control documents:

1. Navigate to the Control Document window by selecting Control from the Tools menu in the Requisition Headers Summary and Requisition Lines Summary windows. For purchase orders, you can navigate to the Control Document window from the summary windows titled Purchase Order Headers, Purchase Order Lines, and Purchase Order Shipments.

2. Select the control Action.

3. If you selected the Cancel action, you can update the Action Date.

   Note: If you are using encumbrance or budgetary control, make sure the action date you specify lies in an open period.

4. Optionally enter a Reason for the action.

5. If you are cancelling a purchase order, you can enter a Note to Supplier.

6. The Cancel Requisitions check box appears only when you have selected the Cancel action for a purchase order. The operation of
the check box is governed by the Cancel Requisitions flag in the Purchasing Options window. If this flag is set to Never, the check box does not appear. If this flag is set to Always, the check box appears checked when you select the Cancel action, but you cannot update the check box. If this flag is set to Optional, the check box appears unchecked when you select the Cancel action, and you can update it. If the check box is checked, requisition lines associated with the cancelled purchase order header, line, shipment, or release are cancelled. If the check box is unchecked, requisition lines associated with the cancelled purchase order header, line, shipment, or release are not cancelled and are returned to the requisition pool. See: Defining Control Options: page 1 – 49.

To cancel control actions:

- Select the Cancel button to cancel your actions and return to the previous window.

See Also

Document Control Options: page 2 – 44
MassCancel

Defining MassCancel

Use the Define MassCancel window to specify criteria for cancelling groups of requisitions or purchase orders that you no longer want to honor.

You can specify a range of Accounting Flexfields for which to cancel requisitions or purchase orders. You can use this zone to specify a range of accounts, programs, projects, or funds, or one account, program, project, or fund for which to cancel purchase orders or requisitions. Purchasing selects for cancellation all purchase orders or requisitions that meet your other selection criteria and have distributions falling completely or partially within these ranges.

You can define multiple ranges of Accounting Flexfields, each including both a low and high value for each key segment. Purchasing excludes all values outside the specified ranges.

When you enter the Include Low field, Purchasing displays a pop-up window that contains a prompt for each segment you have defined for your Accounting Flexfield. You enter both the low and high ends of each range in this pop-up window. After you finish entering each range, Purchasing displays your low segment values in concatenated form in the Low field and displays your high segment values, similarly, in the High field.

Note that Purchasing does not perform checking for incompatible ranges, so you must take care to insure that your High value is actually higher than your Low value. Otherwise, no documents will be selected for MassCancel.

After you specify your cancellation criteria, Purchasing selects all purchase orders or requisitions meeting your cancellation criteria and automatically prints the Define MassCancel Listing. This report lists requisitions and purchase orders that are not cancellable, that fall partially within your cancellation criteria, and that fully meet your cancellation criteria. You can cancel purchase orders or requisitions in the latter two categories using the Run MassCancel window.

To define cancellation criteria:

1. Navigate to the Define MassCancel window from the menu.
2. Enter the MassCancel Batch Name. Purchasing displays this name in the Run MassCancel window, where you can choose the batch for cancellation.

3. Choose one of the following Options:

   * Requisition – Use this option to submit MassCancel for Requisitions.

   * Purchase Order – Use this option to submit MassCancel for planned and standard purchase orders, and blanket purchase agreements.

4. Select Cancel Backing Requisition Lines to indicate that you want to cancel the backing requisition lines when you cancel a purchase order. The cursor enters this field only when you choose the Purchase Order option in this window and then only when the Cancel Requisitions option in the Purchasing Options window is set to Optional. In this case, the default is to disable the check box,
but you can change it. You cannot disable this option when the Cancel Requisitions option is Always or enable this option when the Cancel Requisitions option is Never. See: Defining Control Options: page 1 – 49.

If you set the Cancel Backing Requisition Lines option to Never, when you complete your MassCancel for purchase orders Purchasing recreates the requisition (and requisition encumbrance if you use requisition encumbrance or requisition budgetary control) from which you created your purchase order. Therefore, you should define and run MassCancel for all your purchase orders before you define and run MassCancel for your requisitions.

5. Enter the Start Date and End Date you want Purchasing to use to choose requisitions or purchase orders for cancellation. The creation date is the date you created your requisitions or purchase orders. Purchasing selects requisitions or purchase orders for cancellation that have creation dates between the start date and end date you specify here.

6. For requisitions only, enter the Requisition Type: Internal or Purchase.

7. Enter the Supplier Name for which you want Purchasing to choose purchase orders for MassCancel. If you specify a supplier name, Purchasing selects for cancellation all purchase orders for this supplier that also fit your other cancellation criteria. If you do not specify a supplier name, Purchasing selects all purchase orders that meet your other selection criteria. You cannot specify a supplier name if you are cancelling requisitions.

8. Enter the Low and High values of your MassCancel rule range. Neither value has to be a valid Accounting Flexfield value nor does it have to be made up of valid key segment values.

You must enter a Low and High value. If you want to cancel all documents in a specific range or for a specific supplier, regardless of the account, enter the lowest and highest possible account values. The lowest and highest possible values in a range are operating system dependent. The lowest possible value is either the number 0 or the character A. If the lowest value on your computer is the number 0, then the highest possible value is the character Z. If the lowest value on your computer is the character A, then the highest possible value is the number 0. You must determine which combination is correct for your computer. If you enter the incorrect combination of lowest to highest, Purchasing displays an error message so you know your computer accepts the other lowest to highest range combination. Note that ZZ is a
higher value than Z. If you want to specify a single value to include, enter the same value in both the Low and High fields.

**Example**

You want to cancel all purchase orders you charge to project 305. You define your Accounting Flexfield as Fund – Account – Organization – Project. Your computer uses 0 as the lowest value. You specify the Include Low value as 00–0000–000–305 and Include High as ZZ–ZZZZ–ZZZ–305. Note that if none of the Accounting Flexfield segments are required, you can have a range of all null (empty) segments, which in effect means that all accounts are included in the range.

**See Also**

Overview of Encumbrance Accounting, *Oracle Public Sector General Ledger User’s Guide*

Define MassCancel Listing: page 2 – 63

Running MassCancel: page 2 – 65

**Define MassCancel Listing**

Use the Define MassCancel Listing to review purchase orders and requisitions you have selected for cancellation using the Define MassCancel form. Purchasing prints this report automatically after you define your purchase order or requisition cancellation criteria in the Define MassCancel window and save your work. The report is in four sections: Unable to Cancel Requisitions, Unable to Cancel Purchase Orders, Partially in Range Documents, and Fully in Range Documents.

The Unable to Cancel Requisitions and Unable to Cancel Purchase Orders sections print documents which fit your selection criteria, but which are not cancellable by MassCancel for a reason that the report provides.

Purchasing displays one of the following reasons why you cannot cancel a requisition:

- **Included in PO**
  You have matched at least one line of your requisition to a purchase order. Therefore, you cannot cancel the entire requisition.

- **One or more POs are created based on this REQ**
  You have one or more purchase orders that have been created based on this requisition. Therefore, you cannot cancel the requisition.
REQ is either incomplete, cancelled, or final closed

The requisition is either incomplete, cancelled, or final closed. Therefore you cannot cancel the requisition.

Purchasing displays one of the following reasons why you cannot cancel a purchase order:

<table>
<thead>
<tr>
<th>Reason</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Line Overbilled**           | You have been billed for more goods or services than you ordered on at least one distribution of your purchase order.  
                                 | If you required receipt, you have been billed for more goods or services than you have recorded deliveries for at least one distribution of your purchase order. Therefore, you cannot cancel the purchase order in its entirety. |
| **Line Overdelivered**        | You have recorded deliveries in excess of goods or services ordered for at least one distribution of this purchase order. Therefore, you cannot cancel the purchase order in its entirety. |
| **Invalid Accounting Flexfield** | One of the Accounting Flexfields you use for a purchase order distribution has expired.  
                                 | Therefore, you cannot create a journal entry using this Accounting Flexfield. You need to reactivate the Accounting Flexfield if you wish to cancel this line.  
                                 | Purchasing prints this Cannot Cancel Reason only if you are using encumbrance or budgetary control for purchase orders. |
| **Shipment Fully Received**   | You have received all the goods or services you ordered for at least one shipment of your purchase order. Therefore, you cannot cancel this purchase order in its entirety. |
| **Shipment Fully Billed**     | You have been billed for all the goods or services for at least one of your shipments for this purchase order. Therefore, you cannot cancel this purchase order in its entirety.  
                                 | If you have been billed for goods or services in excess of the quantity ordered, Purchasing prints Line Overbilled as the Cannot Cancel Reason. |
| **Shipment Received But Not Delivered** | You have recorded receipts for some goods or services on at least one shipment for this purchase |
You have not recorded delivery of at least one of these items. Since you have received goods for this purchase order, you cannot cancel it in its entirety.

**Included in Invoice**

You have been billed for at least one item of your purchase order. Therefore, you cannot cancel the entire purchase order. Purchasing prints this Cannot Cancel Reason only if you are using encumbrance or budgetary control for purchase orders.

The Partially in Range Documents section prints purchase orders or requisitions having distributions which fall partially in the range of Accounting Flexfields you selected for cancellation. Column headings provide you with descriptions of the contents of each column.

The Fully in Range section prints purchase orders or requisitions which meet all your selection criteria, and whose distributions fall completely within the range of Accounting Flexfields you selected for cancellation. Column headings provide you with descriptions of the contents of each column.

After you review the Define MassCancel Listing, you can complete the MassCancel process using the Run MassCancel window. You can cancel only purchase orders or requisitions which are Fully in Range or Partially in Range.

### Report Submission

Since this report is automatically submitted, it is not available in the Submit Requests window.

### See Also

- Defining MassCancel: page 2 – 60
- Running MassCancel: page 2 – 65

### Running MassCancel

Use the Run MassCancel window to cancel a group of purchase orders or requisitions you have selected for cancellation, usually as part of
your year–end processing. When you cancel purchase orders or requisitions using this window, Purchasing reverses encumbrances associated with your requisitions or purchase orders. If you cancel a purchase order you created from a requisition, and you are using requisition encumbrance or requisition budgetary control, Purchasing allows you to recreate the requisition encumbrance using the distributions from your purchase order. Therefore, if you are cancelling both requisitions and purchase orders as part of your year–end processing, you need to cancel purchase orders before you cancel requisitions.

When you define your MassCancel criteria, you may select some purchase orders or requisitions for cancellation that Purchasing is unable to cancel for some reason. Purchasing does not display these purchase orders or requisitions in this window. However, you can review the Define MassCancel Listing for purchase orders or requisitions that are not cancellable, together with the reason why they are not cancellable. When the concurrent manager runs the MassCancel process, it checks all the purchase orders or requisitions for cancellability, using the same checks performed by the Define MassCancel window. The purchase orders or requisitions that cannot be cancelled are listed separately in the Run MassCancel Listing.

When you enter a batch name in this window, Purchasing displays the purchase orders or requisitions that can be cancelled. Cancel Backing Requisition Lines is checked if this option was selected for the batch in the Define MassCancel window. For each document, Purchasing displays the document Type (Requisition, Standard Purchase Order, Planned Purchase Order, or Blanket Purchase Agreement), document Number, Creation Date, and Supplier Name. Fully in Range is checked if all the distributions of this entry fall within all the Accounting Flexfield ranges you specify in the Define MassCancel window.

When you run MassCancel, Purchasing cancels all purchase orders or requisitions that are selected. If you are using encumbrance or budgetary control, Purchasing creates reversal entries for your commitments and obligations (pre–encumbrances and encumbrances) when you cancel requisitions and purchase orders, respectively.

### Prerequisites

- Defining MassCancel: page 2 – 60
- Define MassCancel Listing: page 2 – 63

**To run MassCancel:**

1. Navigate to the Run MassCancel window from the menu.
2. Enter the Batch Name of the MassCancel batch you want Purchasing to use for cancellation. See: Defining MassCancel: page 2 – 60.

3. If you are using budgetary control, enter the Cancel Date that you want Purchasing to use to create reversing encumbrance entries in your general ledger. Purchasing uses this date to reapply funds to a specific period. The date you enter must be in an open purchasing period.

4. Deselect each entry you do not want to cancel. If you save your work without running MassCancel, your selections are saved and are redisplayed the next time you query the batch.

5. Select the Run MassCancel button.

► To delete the MassCancel batch:

- Select the Delete MassCancel Batch button to delete the selected MassCancel batch.

See Also

Defining MassCancel: page 2 – 60
Define MassCancel Listing: page 2 – 63
Run MassCancel Listing: page 2 – 67
Overview of Encumbrance Accounting, Oracle Public Sector General Ledger User’s Guide

Run MassCancel Listing

Use the Run MassCancel Listing to review purchase orders and requisitions you have cancelled or were unable to cancel using MassCancel. Purchasing prints this report automatically after you complete your Run MassCancel process. The listing is in three sections: Unable to Cancel Requisitions, Unable to Cancel Purchase Orders, and Cancelled Documents. The Unable to Cancel Requisitions and Unable to Cancel Purchase Orders sections print documents which fit your selection criteria but which are not cancellable by MassCancel for another reason, which the report provides.

Purchasing prints one of the following reasons you cannot cancel a requisition:
<table>
<thead>
<tr>
<th>Included in Purchase Order</th>
<th>You have matched at least one line of your requisition to a purchase order. Therefore, you cannot cancel the entire requisition.</th>
</tr>
</thead>
<tbody>
<tr>
<td>One or more POs are created based on this REQ</td>
<td>You have one or more purchase orders that have been created based on this requisition. Therefore, you cannot cancel the requisition.</td>
</tr>
<tr>
<td>REQ is either incomplete, cancelled, or final closed</td>
<td>The requisition is either incomplete, cancelled, or final closed. Therefore you cannot cancel the requisition.</td>
</tr>
</tbody>
</table>

Purchasing prints one of the following reasons you cannot cancel a purchase order:

<table>
<thead>
<tr>
<th>Line Overbilled</th>
<th>You have been billed for more goods or services than you ordered on at least one distribution of your purchase order.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If you required receipt, you have been billed for more goods or services than you have recorded deliveries for at least one distribution of your purchase order. Therefore, you cannot cancel the purchase order in its entirety.</td>
</tr>
<tr>
<td>Line Overdelivered</td>
<td>You have recorded deliveries in excess of goods or services ordered for at least one distribution of this purchase order. Therefore, you cannot cancel the purchase order in its entirety.</td>
</tr>
<tr>
<td>Invalid Accounting Flexfield</td>
<td>One of the Accounting Flexfields you use for a purchase order distribution has expired. Therefore, you cannot create a journal entry using this Accounting Flexfield. You need to reactivate the Accounting Flexfield if you wish to cancel this line.</td>
</tr>
<tr>
<td></td>
<td>Purchasing prints this Cannot Cancel Reason only if you are using encumbrance or budgetary control.</td>
</tr>
<tr>
<td>Shipment Fully Received</td>
<td>You have received all the goods or services you ordered for at least one shipment of your purchase order. Therefore, you cannot cancel this purchase order in its entirety.</td>
</tr>
<tr>
<td>Shipment Fully Billed</td>
<td>You have been billed for all the goods or services for at least one of your shipments for this purchase</td>
</tr>
</tbody>
</table>
Therefore, you cannot cancel this purchase order in its entirety.

If you have been billed for goods or services in excess of the quantity ordered, Purchasing prints Line Overbilled as the Cannot Cancel Reason.

**Shipment Received But Not Delivered**

You have recorded receipts for some goods or services on at least one shipment for this purchase order. You have not recorded delivery of at least one of these items. Since you have received goods for this purchase order, you cannot cancel it in its entirety.

**Included in Invoice**

You have been billed for at least one item of your purchase order. Therefore, you cannot cancel the entire purchase order. Purchasing prints this Cannot Cancel Reason only if you are using encumbrance for purchase orders.

When you cancel purchase orders or requisitions and you are using encumbrance or budgetary control, Purchasing creates relieving encumbrance entries for your purchase orders or requisitions. See: Overview of Encumbrance Accounting, *Oracle Public Sector General Ledger User’s Guide*.

---

**Report Submission**

Since this report is automatically submitted, it is not available in the Submit Requests window.

**See Also**

- Defining MassCancel: page 2 – 60
- Running MassCancel: page 2 – 65
This chapter tells you everything you need to know about Requisitions, including:

- Overview of Requisitions: page 3 – 2
- Overview of Internal Requisitions: page 3 – 15
- Finding Requisitions: page 3 – 42
- Entering Requisition Preferences: page 3 – 52
- Entering Requisition Headers: page 3 – 57
- Entering Requisition Lines: page 3 – 60
- Entering Requisition Distributions: page 3 – 68
- Using Requisition Templates: page 3 – 73
Overview of Requisitions

With on-line requisitions, you can centralize your purchasing department, source your requisitions with the best suppliers, and ensure that you obtain the appropriate management approval before creating purchase orders from requisitions. You can use Master Scheduling/MRP to generate on-line requisitions automatically based on the planning requirements of your manufacturing organization. See: Overview of Implementing Planning Recommendations, Oracle Master Scheduling/MRP and Supply Chain Planning User’s Guide. You can use Inventory to generate on-line requisitions based on replenishment requirements. See: Overview of Inventory Planning and Replenishment, Oracle Inventory User’s Guide. You can use Work in Process to generate on-line requisitions for outside processing requirements. See: Overview of Outside Processing, Oracle Work in Process User’s Guide. Finally, you can use Purchasing to create internal requisitions, which are handled as internal sales orders and are sourced from your inventory rather than from outside suppliers like purchase requisitions. See: Overview of Internal Requisitions: page 3 – 15.

Purchasing helps you manage the items you order. With on-line requisitions, you can easily centralize your purchasing department, source requisitions with the best suppliers, and ensure that you obtain the appropriate management approval before creating purchase orders from requisitions. You can use Purchasing to create internal requisitions, which are handled as internal sales orders and are sourced from your inventory rather than from outside suppliers like purchase requisitions. See: Overview of Internal Requisitions: page 3 – 15.

Purchasing provides you with the features you need to satisfy the following basic requisition needs. You should be able to:

- Create, edit, and review requisition information on-line. You should also be able to enter suggested supplier information, delivery instructions, multiple accounting distributions, and notes to buyers, approvers, and receivers.

- Review the current status and action history of your requisitions. You should always know who approves requisitions and whether they are in the approval, purchasing, receiving, or delivery stage.

- Route requisitions according to your approval structure. You should also be able to set authorization limits by amount, charge account, item category, and location.
• Review and approve requisitions that need your approval. You should also be able to see the full requisition detail and review the action history before you approve a requisition.

• Print requisitions (with status Approved, Cancelled, Rejected, In Process, Pre–Approved, and Returned) for off–line review and approval. You should always be able to track the status of requisitions through the approval process.

• Import requisitions from other systems such as material or distributions requirement planning applications

• Perform on–line funds checking before creating requisitions. You should always know how your planned expenses compare to your budget.

• Automatically source requisitions from outstanding blanket purchase agreements or quotations you have received from suppliers

• Create requisitions quickly and easily for commonly purchased items

• Provide attachments as notes on requisition headers and lines

• Assign requisition lines to buyers and review buyer assignments for requisition lines

• Forward all requisitions awaiting approval from one approver to an alternate approver. Within your security and approval constraints, you should be able to reroute requisitions from one approver to another whenever you want.

• Record suggested foreign currency information for each requisition line

**Major Features**

**Eliminate Paper**

With Purchasing, your requestors submit requisitions on–line. You therefore eliminate the need for paper requisitions that you can misplace or lose during the approval process.

**Quick Online Entry**

With Purchasing, you can easily create requisitions on–line. Complete a requisition for any item by simply entering the requestor name, item description, delivery location, price, delivery quantity, and accounting
distribution. Purchasing uses the Account Generator to enter the distribution automatically whenever possible.

**Approval Status**

Purchasing automatically displays the approval status of your requisition and informs you whether it is Approved, Cancelled, In Process, Incomplete, Pre–Approved, Rejected, or Returned. You know where your requisition is at all times.

**Action History**

Purchasing lets you review the action history of requisitions as they move through the approval process. Purchasing uses your security and approval structure to help you forward requisitions. On–line notifications keep your requisitions moving. If someone rejects a requisition, you always know who and why.

**Easy Resubmission**

Purchasing lets you resubmit a rejected requisition for reconsideration. Depending on how you define system setup options, resubmitted requisitions return either to the original approver for reconsideration or to an alternate approver that you choose.

**Easy Cancellation / Final Close**

Purchasing lets you cancel or final close a requisition or requisition line before your manager approves it or before a buyer places it on a purchase order.

If you are using encumbrance or budgetary control, Purchasing automatically creates negative debit encumbrance entries for the cancelled requisitions. When you final close a purchase order, Purchasing creates credit entries which reverse the encumbrances.

**Easy Assignment**

Purchasing lets you assign requisitions to specific buyers and review which requisitions are Assigned and Unassigned.

**Accurate Accounting**

Purchasing uses the Account Generator to automatically supply accounting information as part of a requisition. You can allocate line item quantities to cost centers, organizations, projects, or departments. You can also create multiple distributions for a single item. For instance, you can allocate a computer system purchase across more than one cost center or organization.
Maximum Flexibility

Purchasing provides maximum flexibility by letting requestors create requisitions quickly and add details later. In the requisition header and on each line item, Purchasing provides space for descriptions and notes to approvers, buyers, and receivers.

Quick Customization

Purchasing lets you use Descriptive Flexfields to tailor the format of the requisition header and line blocks to your unique needs without additional programming.

Online Funds Availability Checking

Purchasing lets you verify whether you have enough funds available in your budget before you complete a requisition. You can check and reserve funds for a requisition at any level of a requisition.

Online Approvals

Purchasing lets you approve or reject requisitions on-line. You can access full requisition detail and prior action history to review the full detail before making an approval decision. Depending on your approval controls, you may be able to update a requisition before you approve it.

Requisition Templates

This feature, accessible through the Supplier Item Catalog, lets you quickly create requisitions for commonly purchased items. Buyers create templates that group commonly ordered items like office supplies into one place.

Quantity Rounding

If Quantity Rounding for inventory sourced lines is enabled in the Purchasing Options window, Purchasing either displays the rounded quantity you should have entered in a warning message or it updates the quantity to the appropriate rounded quantity. The rounding is based on the Unit of Issue (or primary unit of measure if the Unit of Issue is not defined) and the Rounding Factor defined for the item in Inventory. Rounding is up or down to the nearest whole Unit of Issue/primary unit of measure using the rounding factor.

Requisition Printing

Purchasing provides a requisition printing capability to provide hard copy requisitions. You can print requisitions after completing them, or
have somebody print and distribute all requisitions. Use the Printed Requisitions Report to print the requisitions which have the following status: Approved, Cancelled, Rejected, In Process, Pre–Approved, and Returned. The report does not include requisitions with status Incomplete.

**Quick Access to Particular Requisitions**

You can place requisitions that you reference frequently in the Oracle Applications Navigator. Placing documents in the Navigator is useful when you need to query large documents with multiple lines, shipments, or distributions. When the requisition is open, choose Place on Navigator from the Action menu. When you choose the Documents tabbed region in the Navigator, you can then access that document directly from within the Navigator. You can also do this with purchase orders. See: Using the Navigator’s Documents Region, Oracle Applications User’s Guide.

**Note:** Once you place a document in the Navigator, it is the first thing you see in the Navigator the next time you log into Purchasing. Choose Functions to return to the Purchasing menu.

**Requisition Import**

Using Requisition Import, you can import requisitions from other Oracle Applications or from non–Oracle systems. Requisition Import lets you integrate Purchasing with new or existing applications such as Material or Distribution Requirement Planning systems. You can import requisitions as often as you want. Then, you can review or place these requisitions on purchase orders. See: Requisition Import Process: page 9 – 144.

Master Scheduling/MRP, Work In Process, Order Management, and Inventory all provide requisition information to the requisition interface table from which Requisition Import creates requisitions. While requisitions can be imported with any approval status, they are most commonly approved since they correspond to specific production schedules, outside processing, or stock resupply. However, if you are using requisition encumbrance, Requisition Import changes the Approved status to Pre–Approved so that you can reserve funds for the requisition.
Requisition Types

Benefits of On-line Requisitions

You can save time, money, and paper by processing requisitions on-line. With a paper system, you must provide forms to the requestor, the requestor must send the form to someone else to be approved, and the buyer must manually consolidate requisitions to place on a purchase order. Throughout all of these transactions, you may generate a number of errors, waste time, and lose money. Some of the many problems you may incur with paper requisitions include:

- The requestor may not fill in the requisition completely or accurately.
- The requestor’s handwriting may be illegible.
- Someone without proper authority can potentially approve a requisition.
- The requestor might have to mail the requisition to an approver at a different location and wait a number of days to get it back.
- The approver or buyer may lose or damage the requisition.
- The buyer may translate the information from the requisition to the purchase order incorrectly.
- You may lose significant quantity discounts if the buyer cannot locate all the requisitions that reference a particular item.

Implementing On-line Requisitions

Many organizations want to provide on-line requisitions to everyone in the organization. Others want to limit the number of users who have access to the system. Purchasing is flexible enough to meet the needs of your organization. To give everyone access to the system, simply create a user name for each employee in the organization and assign the employee the appropriate responsibilities. You can easily designate a smaller group of individuals as requisition preparers if you want to limit the number of requestors on the system. These people can create requisitions for anyone in the organization by identifying the appropriate requestor directly on the requisition line. You might also want to limit some preparers to internal requisitions and others to purchase requisitions. You can also print requisitions to obtain signature approvals if some of the approvers do not have access to the system. You can then assign an individual to update the authorization status for these requisitions.
Purchase Requisitions

Use the Requisitions window to create requisitions. You must choose the requisition type (internal or purchase). You can also provide a description, unlimited notes, and defaults for requisition lines. For each requisition line, you choose the item you want to order along with the quantity and delivery location. You can get sourced pricing from catalog quotations or open blanket purchase agreements. You can also choose a price from a list of historical purchase order prices. In the Distributions window, you can charge the item to the appropriate accounts, or you can let the Account Generator create the accounts for you. Once you complete the requisition, you send it through the approval process. See: Entering Requisition Lines: page 3 – 60. See: Using the Account Generator in Oracle Public Sector Purchasing: page C – 10.

Internal Requisitions

Unlike purchase requisitions, which are supplied from purchase orders, internal requisitions are supplied from internal sales orders. Internal requisitions are not picked up when you AutoCreate RFQs or purchase orders, nor can they be assigned to a buyer in the Assign Requisitions window. See: Internal Requisitions Overview: page 3 – 15.

Requisition Templates

Use the Requisition Templates window to define requisition templates for items you purchase frequently. For example, if you frequently buy certain office supplies, you can set up an office supplies template for your requestors. This template consists of a list of all items, prices, and sourcing information you want available to the requestor. When you want to order items from this template, use the Supplier Item Catalog, choose the office supplies template, and indicate the quantity you want to order. Purchasing supplies default sourcing and delivery information. See: Defining Requisition Templates: page 1 – 62.

Imported Requisitions

Purchasing lets you import or reschedule requisitions from other Oracle or non–Oracle systems. See: Requisition Import Process: page 9 – 144. For example, Work in Process uses Requisition Import to create requisitions for outside processing. See: Overview of Outside Processing, Oracle Work in Process User’s Guide. Similarly, Master Scheduling/MRP automatically creates requisitions using Requisition Import when you mass load purchase requisitions. Master Scheduling/MRP also automatically reschedules existing requisitions by updating the need–by date during this process. See: Overview of
Implementing Planning Recommendations, Oracle Master Scheduling/MRP and Supply Chain Planning User’s Guide. If you are using Inventory, you can send a requisition requirement to Purchasing and then run Requisition Import in Purchasing to create the requisition. See: Overview of Inventory Planning and Replenishment, Oracle Inventory User’s Guide.

**Paper Requisitions**

You do not need to create a requisition on-line to purchase an item. Instead, you can reference a paper requisition number directly on the purchase order Distribution Details. See: Entering Purchase Order Distributions: page 4 – 74. Later, you can use the Purchase Orders window to review the status of the purchase orders referencing the paper requisitions.

---

**Reserving Funds for Requisitions**

Purchasing lets you reserve or encumber funds for requisitions. If you are using budgetary control, you can also check to see whether funds are available before you encumber the requisition. If you have problems reserving funds for a requisition, the Approval Errors window lets you review the reasons.

Purchasing automatically transfers the encumbrance from the requisition to the purchase order when you successfully approve the purchase order on which you placed the requisition. Purchasing also automatically transfers the encumbrance back to the requisition when you cancel the purchase order. See: Overview of Encumbrance Accounting, Oracle Public Sector General Ledger User’s Guide.

**Note:** Even if someone with sufficient approval authority approves a requisition, its status may still be Pre–Approved if funds were not able to be reserved at the time of approval. A Pre–Approved requisition does not show up as supply until its status changes to Approved. Once funds are reserved for the Pre–Approved requisition, the requisition’s status changes to Approved and shows up as supply.

**See Also**


The Document Approval Process: page 2 – 24

Requisition Import Process: page 9 – 144
Reviewing Requisitions

After you create a requisition, you can query the requisition at any time to review the status, action history, or problems with encumbering funds. Use the Requisition Summary windows to review requisitions. If a buyer has already placed the requisition line onto a purchase order, you can review the purchase order number. You can also review the changes that the buyer made to the requisition and the quantity receivers have delivered. See: Finding Requisitions: page 3 – 42.

Use the View Action History window to review the action history of requisitions. You can navigate to this window from the Tools menu in many entry windows. You can see who has approved or rejected the requisition and the corresponding notes the approvers provided. For Inventory sourced lines, you can review the status of the internal sales order. See: Viewing Action History: page 8 – 2.

Use the Approval Errors window to review reasons you could not completely reserve funds for requisitions.

Managing Requisitions

Purchasing lets you manage requisitions to help buyers save money and time when creating requisitions.

Sourcing Requisitions

You can suggest buyer and supplier information when creating a requisition. Simply provide the appropriate information in the Source Details tabbed region of the Requisitions window. A buyer can then query all requisition lines based on this information to help consolidate purchase orders. Alternatively, you can automatically source requisition line items by using the Sourcing Rule and Approved Supplier List windows. You use the Approved Supplier List window to list the primary blanket purchase agreement or catalog quotation for each item you want to order. When you create a requisition line for any item that you list in the Sourcing Rule and Approved Supplier List windows, Purchasing automatically provides suggested supplier, buyer, and source document information for you. (See: Automatic Sourcing: page 5 – 30. See: Approved Supplier List: page 5 – 42.) Purchasing also automatically provides the sourcing information if you use Requisition Import to import requisitions from an outside system. See: Requisition Import Process: page 9 – 144.
Assigning Requisitions to a Buyer

Purchasing lets you manage the buyers’ workload by reviewing how many requisition lines are assigned to a particular buyer and reassigning them to distribute the workload better. You can also review how many unassigned requisitions are urgent or are needed within a certain time limit so that you can assign them to the appropriate buyers for immediate ordering. See: Finding Requisition Lines for Review or Assignment: page 5 – 98.

Returning Requisitions

A buyer can return a requisition line to the original preparer instead of placing it onto a purchase order. Upon returning the requisition line, the buyer indicates the reason for the return. For example, the purchase price may exceed the requisition price, or the buyer may know that the requested item is no longer being purchased. When a buyer returns an individual requisition line, Purchasing automatically returns all other lines on the same requisition that are not currently on a purchase order. Purchasing returns the other lines to let the preparer decide whether it is still appropriate to order the rest of the requisition as is. See: Autocreate Purchase Order Options: page 6 – 4.

Referencing Requisition Reports

You can use the Buyer’s Requisition Action Required Report to review all current requisition lines that are not currently on a purchase order. You can choose from a number of report setup options to narrow the search to a particular list of approved requisition lines. You can also print reports to review requisition status, requisition distribution detail, and requisition import status. See: Buyer’s Requisition Action Required Report: page 9 – 23.

Managing Foreign Currency Information

For new requisitions, the initial default is the functional currency specified in the Financials Options window. You can specify a different suggested foreign currency for each requisition line.

If you source to a foreign currency blanket agreement or catalog quotation, Purchasing retrieves the foreign currency information for the document. Your user-defined preferences for currency are overridden by the currency information on the source document. This is also true even if the source document currency is blank (the same as the base currency).

Purchasing automatically updates the functional unit price if you enter the foreign currency unit price using the specified rate. Purchasing also
updates the foreign currency price if you update the functional unit price.

When you AutoCreate new purchase orders, Purchasing converts the requisition price into a purchase order price based on specified currency and rate information. (See: Entering Currency Information: page 4 – 58.) You cannot specify currency information in AutoCreate if you are adding requisition lines to an existing document. See: Entering Document Information and Completing AutoCreate: page 6 – 19.

Purchasing performs price tolerance verification for all currencies and uses the requisition total in functional currency to verify authorization limits.

Cancelling Requisitions

With Purchasing, you can submit a requisition for approval and then cancel the requisition or a requisition line if you no longer want to order the item. Use the Control Documents window to cancel the entire requisition or specific requisition lines. Once a buyer places a purchase requisition line onto a purchase order, you can no longer cancel the requisition line or the corresponding requisition header. Similarly, you cannot cancel a requisition line that has been modified with the AutoCreate Documents window, or a line that is currently on a sales order. See: Controlling Documents: page 2 – 55.

If you cancel an internal sales order or back order that was generated by an internal requisition, you get a warning message that the order line is related to a requisition line that is now awaiting cancellation. At this point, you can navigate to the Control Documents window and explicitly cancel the requisition line. Alternatively, you can continue processing sales orders and later use the MassCancel function to cancel any or all requisition lines awaiting cancellation. See: Defining MassCancel: page 2 – 60.

When you cancel an internal requisition related to a cancelled sales order, the quantity cancelled on the requisition is the same as the quantity cancelled on the sales order, not the remainder of the requisition. This is because a quantity of goods may have been shipped but not yet delivered against the requisition. See: Controlling Documents: page 2 – 55.

If you are using encumbrance or budgetary control, Purchasing automatically creates negative debit encumbrance journal entries in your general ledger system to cancel the encumbrance that corresponds to the requisition header or lines you are cancelling. See: Budgetary
Final Closing Requisitions

Use the Control Documents window to final close requisitions and requisition lines when you no longer need the items. You cannot final close a requisition line a buyer placed on a purchase order, a line that has been modified with the AutoCreate Documents window, or a line that is currently on a sales order. Purchasing automatically creates credit encumbrance journal entries to reverse the encumbrance that corresponds to the requisition header or lines you are final closing.

Updating Requisitions

Updating Incomplete Requisitions

As a requisition preparer, you can change the information on a requisition before you send it through the approval process. To update a requisition you created using the Requisitions window, simply navigate to the Find Requisitions window and query up the requisition. Once you send a requisition through the approval process, your access to it is determined by the security and approval structure.

Recreating Requisitions

When you cancel a purchase order line in the Control Documents window, you have the option to either have the referencing requisition lines cancelled or return them to the requisition pool for placement on another purchase order. If you have already partially received the item, Purchasing recreates the requisition line for the unreceived quantity. See: Controlling Documents: page 2 – 55.

Using Modify to Update Requisitions

A buyer may want to alter a requisition line before placing it onto a purchase order. The buyer can either return the requisition line to the preparer for changes or simply choose Modify from the Tools menu while in the AutoCreate Documents window to update the requisition line. You can split the requisition into multiple lines so that you can source the requisition across different suppliers. Or, you can change the requisition line if the preparer did not request the item correctly. For example, the preparer might order a computer, though you know you buy computers by ordering the peripherals and keyboards separately. The preparer can later review the requisition to see the
original requisition line and the changes the buyer made. See: Additional Autocreate Features: page 6 – 8. You cannot modify requisition lines if you are using requisition encumbrance or budgetary control. See: Autocreate Purchase Order Options: page 6 – 4.

**Updating Requisitions During Approval**

Instead of approving a requisition, the approver can reject the requisition and send a note to the preparer to make specific changes. Alternatively, the approver can make changes directly to the requisition without rejecting it. From the Notifications Summary window or any of the requisitions summary windows, the approver can navigate to the Requisitions window and make the appropriate changes, if Approver Can Modify is enabled for the document type in the Document Types window. See: Viewing and Responding to Notifications: page 2 – 31.
Overview of Internal Requisitions

Internal requisitions provide the mechanism for requesting and transferring material from inventory to other inventory or expense locations. When Purchasing, Order Management, Shipping Execution, and Inventory are installed, they combine to give you a flexible solution for your inter-organization and intra-organization requests. You should be able to:

- Set up your supply chain and automatically source your requirements from inventory or suppliers
- Define your inter-organization shipping network, and optionally require that you use internal orders for your inter-organization transfers
- Use intransit inventory when you want to track items as they move between organizations
- Reduce warehousing, shipping, and handling costs by requesting items in fixed lot sizes
- Use the same windows for data entry and inquiry that you use for purchase requisitions and sales orders
- Take advantage of standard requisition and sales order functionality to suit your individual business requirements
- Automatically generate inventory replenishment requisitions and fulfill them via internal or external suppliers
- Automatically source MRP generated requisitions to internal or external suppliers
- View the status of requests on-line
- Use internal requisitions to move inventory items from one inventory organization to another, even if that organization belongs to a different operating unit, legal entity, or set of books

Major Features

Complete Item Sourcing Definition

Purchasing and Inventory combine to provide the flexibility you need to define your item sourcing information. You can use the default sourcing options to automatically determine the correct source type and source for your requests. You can specify either Inventory or Supplier as the default source type, as well as the source organization and subinventory for internal requests.
Inter–Organization Shipping Network

Inventory provides the features you need to define your inter–organization shipping network. For transfers between two organizations, you can specify whether to use intransit or direct shipments. You can also require internal orders for transfers between specific organizations.

Flexible Processing

You can tailor internal requisition processing to fit your requirements. You can limit on–line interaction by setting up background processes to automatically perform specific actions such as creating inventory replenishment requests and creating internal sales orders in Order Management. Or, you can take advantage of other features such as on–line requisition approvals, internal sales order cycles, and on–line receipt and delivery of internally requested items.

Creating On–Line Requisitions

You can create on–line internal requisitions for both expense and inventory destinations using the same windows you use to create purchase requisitions. You can combine inventory and supplier sourced requisition lines on the same requisition. Also, Purchasing uses your item sourcing information to default the correct source type and supplier for the item and destination. You can define requisition templates for commonly requested internally sourced items.

Full Unit of Issue Enforcement

Purchasing offers the option of full unit of issue enforcement in which quantities entered on internal requisitions are automatically rounded to a full unit of issue defined for the item. You can also set this option to recommend a rounded quantity on requisitions, but leave the opportunity to change the recommended quantity. The quantity rounding is based on the specified unit of issue, if available, otherwise on the primary unit of measure.

Inventory Replenishment Requisitions

Inventory generates replenishment requisitions through min–max planning, reorder point planning, subinventory replenishment for replenishment counts, and Kanban replenishment. Purchasing uses your item sourcing information to create inter–organization or subinventory transfer requests. See: Overview of Inventory Planning and Replenishment, Oracle Inventory User’s Guide. See: Demand for Internal Requisitions: page 3 – 18.
MRP Generated Requisitions

MRP generated requisitions are sourced using the same item sourcing information that you define for inventory replenishment and on–line requisitions. For “buy” items, the Requisition Import process uses the item sourcing information to create either a purchase requisition or an inter–organization internal requisition for planned orders.

Approvals and Controls

You can control internal requisition approvals and document security just as you control purchase requisitions. Purchasing gives you the flexibility you need to set up approvals and limits for internal requests. You can use the same authorization rules, or you can relax or tighten controls for internal requisitions.

Creation of Internal Sales Orders

When you approve an internal requisition for a stocked item, Purchasing translates the requisition into an internal sales order, providing a link between the end user’s requirement and the physical demand against Inventory.

Order Management

Once you create an internal sales order from a requisition, you can manage internal requisitions just as you manage regular sales orders. You can use Order Management to define order cycles, approvals and holds to effectively process requisition orders. You can selectively pick release and otherwise process internal sales orders as easily as you do regular sales orders.

Complete Requisitions Status Visibility

You get complete visibility on the status of requests through inquiries and reports. You get on–line visibility to the internal sales order number, as well as the shipment and delivery status for requisitions. You can report on backordered items, internal requisition status, and delivery discrepancies.

Exception Processing

Internal requisitions help you manage exceptions to your normal business flow. Order Management automatically backorders your request when you have insufficient supply to fill the internal order by creating another shipment line for the unavailable quantity. You can reschedule orders when the shipment date changes, and the expected arrival date on the intransit shipment is updated automatically.
Cancellation of Requisitions

You can easily cancel a request if you have a change in requirements or if you cannot fulfill the entire order. Using Order Management, you can partially or fully cancel the line quantities on the internal sales order. You complete the cancellation process by cancelling the original requisition line in Purchasing.

Using Internal Requisitions

Internal requisitions provide a flexible solution to your inventory requisitioning needs. You can eliminate user intervention when you do not need it, such as when you are loading internal requisitions into Order Management or placing demand. The following sections describe the entire business and information flow for internal requisitions, and identifies opportunities for you to simplify processing.

Demand for Internal Requisitions

Demand for inventory requests can come from several sources. The primary sources are:

- On–line user’s request for stock items out of inventory
- Inventory Replenishment Requests
- Oracle Master Scheduling/MRP and Supply Chain Planning generated requisitions
- External system’s requests

On–Line Requests

On–line requisitions give you the choice of supplier or inventory sourced requisitions. Default sourcing information is determined by the requisition type, the item, and the destination of the request. When you enter a requisition, Purchasing automatically selects the correct source type and source information for the item and destination.

To restrict certain users to internal requisitions only, set their profile PO: Legal Requisition Type to Internal. Purchasing then requires that they source all internally orderable items from inventory. See: Entering Requisition Headers: page 3 – 57.
For frequently requested items, you can define requisition templates to create internal requisitions quickly. Requestors can pull up the template they need, fill in the need–by date and destination of the request, and specify the quantity for each desired item.

Internal requisitions also use the Account Generator, which automatically builds account distributions. You can specify only one accounting distribution per inventory sourced line. See: Using the Account Generator in Oracle Public Sector Purchasing: page C – 10.

Inventory Replenishment Requests

Inventory automatically generates requisitions to maintain an item’s stock level. The requisitions may request stock from an internal predefined source organization or from an outside supplier. See: Overview of Inventory Planning and Replenishment, Oracle Inventory User’s Guide.

Inventory generates replenishment requests automatically using the following methods:

- Min–Max Planning
- Reorder Point Planning
- Subinventory Replenishments for Replenishment Counts
- Kanban Replenishments

All inventory replenishment methods create requisitions via the Requisitions Open Interface.

**Attention:** If the destination subinventory uses locator control, you must specify a primary locator for direct inter–organization and subinventory transfers.

**Suggestion:** You can interface with third–party systems to enter count information and load it into Inventory using the Replenishment Interface. Inventory automatically creates replenishment requisitions using the source and planning method you define.

Kanban Replenishments

In a pull–based system, inventory items for a particular part or assembly area are replenished as soon as they are needed. When the items are needed, kanban cards in Oracle Inventory change their Supply Status to Empty, and Inventory generates the kanban replenishment request automatically. Then Requisition Import in Purchasing validates and imports replenishment requests as
requisitions. If the Source Type of the request is Supplier, Purchasing creates a blanket release (if a blanket agreement exists) or a standard purchase order (if a valid quotation exists) for the item. If the Source Type is Inter–Org, Requisition Import generates an internal requisition for the item. See: Overview of Kanban Replenishment, Oracle Inventory User’s Guide. See: Requisition Import Process: page 9 – 144.

Once Purchasing approves the standard purchase order, blanket release, or internal requisition, Inventory automatically receives a status for the kanban card of In Process.

In Purchasing, Kanban replenishment requests look like any other purchasing document, and you receive them like you do any other shipment. As soon as you receive the item for delivery through the Receipts or Receiving Transactions windows in Purchasing, Inventory automatically receives a status for the kanban request of Full, indicating that the inventory supply has been replenished.

MRP Generated Requisitions

Master Scheduling/MRP creates requisitions for “buy” items when you release them using the Planner Workbench. MRP generated requisitions are sourced using the same rules as on–line and inventory replenishment requisitions. However, since MRP is planning for the entire organization, inventory sourced requisitions for MRP planned orders must be inter–organization transfer requests. You cannot request subinventory transfers using internal requisitions for MRP planned orders, unless you specify a non–nettable source subinventory on the internal requisition. See: Viewing On–hand Quantities, Oracle Master Scheduling / MRP User’s Guide.

External Systems

You can automatically import internal requisitions from other Oracle Applications or existing non–Oracle systems using the Requisitions Open Interface. This interface lets you integrate the Purchasing application quickly with new or existing applications. Purchasing automatically validates your data and imports your requisitions. You can import requisitions as often as you want. Then, you can review these requisitions, approve or reserve funds for them if necessary, and place them on internal sales orders. See: Requisition Import Process: page 9 – 144.
Internal Requisition Approvals

After you create an internal requisition, you can optionally require approval. For on-line requests, you can set up approval rules that are specific for internal requisitions, or you can share the same rules you use for purchase requisitions. If you do not require additional approval steps, you can set up rules so that you can always complete and approve the document in the Requisitions window. See: Entering Requisition Headers: page 3 – 57.

Min–max planning, Reorder Point planning, and MRP generated requisitions are loaded as approved requisitions through the Requisitions Open Interface. If you set the Inventory Profile INV: RC Requisition Approval to Unapproved, you can optionally load Subinventory Replenishment requisitions as unapproved and use the document approval functionality in Purchasing. This profile option affects only Subinventory Replenishment requisitions. See: Submitting a Document for Approval: page 2 – 35. See: Oracle Inventory Profile Options, Oracle Inventory User’s Guide. An internal requisition corresponding to a kanban card in Oracle Inventory enters Purchasing through Requisition Import with a status of Approved. (If encumbrance/budgetary control is on, Purchasing sets the status to Pre–Approved.) As soon as the internal requisition is approved, Inventory automatically receives a status for the kanban card of In Process. See: Demand for Internal Requisitions: page 3 – 18. See: Requisition Import Process: page 9 – 144.

Requisition supply is created for the destination organization as soon as the requisition is approved. If you create approved requisitions through Requisition Import, supply is created at the time the requisition is created. Master Scheduling/MRP and Inventory planning get complete visibility to the incoming internal requisition supply so the planning processes do not create additional reorders for items that you have already requested.

Creation of Internal Sales Orders

Once you approve inventory sourced requisition lines, Purchasing translates the requisition into an internal sales order, providing the link between the requestor’s requirement and the physical demand against inventory. You run two separate batch processes to create the internal sales order from the approved requisition:


Purchasing uses location associations to create internal sales orders from internal requisitions for a given deliver-to location. When you associate a customer and customer site with a location and then enter an internal requisition with that location as the deliver-to point, Purchasing uses the associated customer and customer site on the internal sales order that it creates. The associated customer site becomes the ship-to site for Order Management’s ship confirmation. See: Defining Locations: page 1–24. See: Assigning a Business Purpose to a Customer Address, *Oracle Public Sector Receivables User’s Guide*.

Internal orders are automatically scheduled by setting the Schedule Ship Date on the sales order to the Need-by Date from the requisition. If you specify a subinventory on the internal requisition line, Order Management reserves the goods and uses only the specified subinventory for allocation. If the goods do not exist at the specified subinventory, Order Management backorders them, even if they do exist in another subinventory.

The Create Internal Sales Orders process loads the Order Management open interface, OrderImport, using the order type you define in the Purchasing Options window. See: Defining Internal Requisition Options: page 1–52. OrderImport creates internal sales orders from the records in the interface table, and determines the order cycle and defaults values based on the order type.

**Note:** You should not drop-ship internal sales orders. See: Drop Shipments: page 4–133.

**Multi–Org: Creation of Internal Sales Orders Across Operating Units**

A Multi–Org implementation of Purchasing enables separate operating units within an organization to operate independently of each other. However, you may still need to obtain goods from another operating unit, and Purchasing supports this. You can create an internal sales order for an item in another operating unit. When creating this internal sales order, you must create it in the destination organization’s operating unit, and all Order Management activity must take place within that destination operating unit. For example, the following table lists the generalized steps involved and indicate the organization in which they take place.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Operating Unit 1 Inventory Org A</th>
<th>Operating Unit 2 Inventory Org B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create and approve internal requisition.</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Run Create Internal Sales Orders.</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Run Order Import in Order Management</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>4</td>
<td>Perform pick release and ship confirm in Order Management.</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>5</td>
<td>Receive goods.</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

When you use internal sales orders to transfer goods from another operating unit, the items’ transfer cost is posted to the interfund payables and receivables accounts as defined in the shipping network; however, no interfund invoice is generated.

**Management of Internal Sales Orders**

You manage internal sales orders using some of the same windows as customer sales orders. Once you import an internal requisition using OrderImport, you can use the Sales Orders window to change the reserved quantity, schedule date, ship-to contact, and shipment priority. The destination organization has complete visibility to any changes in incoming supply based on schedule date changes or partial shipments.

The price on the internal sales order line comes directly from the price on the requisition line. OrderImport does not use the price list to recalculate the line price. However, the price that is used when posting the interfund payables and receivables information is the item cost plus any markup defined in the shipping network. See: Inter–Organization Shipping Network, *Oracle Inventory User’s Guide*.

Once an internal sales order is scheduled, it is visible as demand. You can reserve inventory for internal requisitions either to the organization, or the organization and subinventory levels.

Order Management *does not* process internal sales order lines for the Receivables Interface, even if the Receivables Interface is an action in the order cycle for the internal sales order.

**Note:** You should not drop–ship internal sales orders. See: Drop Shipments: page 4 – 133.
Pick Release for Internal Sales Orders

You can directly pick release from the Shipping Transactions window. Or you can selectively release one internal sales order at a time by entering the internal sales order number as a pick release criterion. Or, you can release a group of internal sales orders by specifying the internal sales order, order type, and a range of dates, or by using the shipment planning delivery, trip, and trip stop information. You can also release internal sales orders with customer orders by entering a range of dates.

When you enter an internal requisition, you must specify the source organization, and you can optionally specify the subinventory source. If you do not enter source subinventory information on an internal requisition, picking proceeds using the standard inventory picking rules.

Oracle Shipping Execution releases only order lines which meet the prerequisites of the order cycle specific to the internal sales order type.

See: Oracle Shipping Execution User’s Guide.

Ship Confirmation for Internal Sales Orders

Use the Shipping Transactions window to ship confirm entire or partial shipments. You can also backorder the internal sales order when you do not have enough on–hand quantity to fulfill the request.

Partial shipments are handled by splitting internal order lines into multiple shipment schedules with different delivery dates. You cannot change the warehouse or the subinventories on the delivery details.

When you ship confirm, Shipping Execution updates the Inventory Interface and generates a delivery ship notice outbound (DSNO) transaction. Inventory automatically updates on–hand quantities to reflect the internally ordered items that you shipped. If you are shipping using intransit inventory, the destination organization gets complete visibility of the incoming intransit supply. Internal requisition supply is reduced by the quantity of the shipment.

You can also enter the expected arrival date at ship confirmation to provide a more accurate supply picture to MRP and inventory planning.

See: Oracle Shipping Execution User’s Guide.
Management of Internal Requisitions

Update Intransit Information

For inter-organization transfers that use intransit, you can use the Manage Shipments window to update the expected arrival date. Master Scheduling/MRP and inventory planning get complete visibility to the change in expected arrival date. See: Managing Shipments: page 7 – 93.

Receive, Inspect, and Deliver Items

Use the Receipts and Receiving Transactions windows to process receipts of inter-organization requests that use intransit. Receiving personnel can simply enter the requisition number on the shipping documentation and process the entire shipment using express receiving transactions. For receipt of partial shipments, you can record the quantities for the individual items included in the shipment. You can receive items into receiving, or you can receive the goods directly to the final destination, either an inventory or expense location.

If you receive items into receiving/inspection, you process inspections, transfers, and deliveries for internal requisitions just as you would process supplier receipts or inventory transfers. See: Overview of Receiving: page 7 – 2.

View Internal Requisition Status

In Purchasing, you can view the internal sales order and any changes to it, by selecting View Sales Orders on the Tools menu in the Requisition Lines Summary window. Or, you can access the Sales Orders window directly in Order Management and query on the specific internal sales order number, or any other relevant criteria. The Sales Orders window provides information about the status of the internal sales order, quantities shipped, quantities cancelled, and dates of transactions.


Cancelling Internal Requisitions

If you cancel an internal sales order that was generated by an internal requisition, you get a warning message that the order line is related to a requisition line that is now awaiting cancellation. You can then use the Control Document window to cancel the requisition line. See: Controlling Documents: page 2 – 55.
Purchasing lets you cancel or final close an inventory sourced requisition line only after you cancel the internal sales order in Order Management. See: Cancelling Orders, Oracle Order Management User’s Guide.

Internal Requisitions Processing Summary

The following table summarizes key transactions and processes you use for Internal requisitions. If you are using inventory replenishment or MRP generated internal requisitions, Pick Release and Ship Confirmation are the only required on–line transactions. If you are creating on–line requests, you also use the Requisitions window. See: Online Processing Automation for Internal Requisitions: page 3 – 34 for suggestions on how to implement automated processing and reduce on–line interaction.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Required</th>
<th>Window/Process</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create Internal Requisition</td>
<td>On–line or Automatic</td>
<td>Requisitions window and Requisition Import process: Inventory replenishment, MRP Planned Orders, External Sources</td>
</tr>
<tr>
<td>2</td>
<td>Approve Requisition</td>
<td>Optional</td>
<td>Approve Documents window</td>
</tr>
<tr>
<td>3</td>
<td>Create Internal Sales Orders</td>
<td>Automatic</td>
<td>Create Internal Sales Orders process, OrderImport process</td>
</tr>
<tr>
<td>4</td>
<td>Modify Order Schedule</td>
<td>Optional</td>
<td>Sales Orders window</td>
</tr>
<tr>
<td>5</td>
<td>Pick Release Orders</td>
<td>On–line</td>
<td>Release Sales Orders for Picking window or Shipping Transactions window</td>
</tr>
<tr>
<td>6</td>
<td>Confirm Pick–Wave Move Order</td>
<td>Optional</td>
<td>Transact Move Order window (if not auto–pick confirming from Pick Release window)</td>
</tr>
<tr>
<td>7</td>
<td>Ship Confirmation</td>
<td>On–line</td>
<td>Shipping Transactions window, Order Management Interface, Inventory Interface</td>
</tr>
<tr>
<td>8</td>
<td>Receive Items</td>
<td>Optional</td>
<td>Receipts window, Receiving Transaction Processor</td>
</tr>
</tbody>
</table>

Table 3 – 1   (Page 1 of 2)
### Internal Requisitions Setup Overview

Internal requisitions provide a solution to a variety of inventory requisitioning needs. When you implement this feature, you need to carefully review the options and configure the applications to support your business processes.

For example, if you are using internal requisitions to generate inventory replenishment requisitions and fulfill them via subinventory transfers within a plant, you may want to limit your on-line interaction to pick release and ship confirmation. You do not have to record separate ship, receive, and deliver transactions when the same employee actually picks the items out of the source subinventory and places them at the destination in one step.

The following table describes internal requisition setup functions.

<table>
<thead>
<tr>
<th>Product</th>
<th>Internal Requisition Setup Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order Management</td>
<td>Update profile options, Define transaction types, Define order number sources, Update/define default value rules, Define price lists, Define Concurrent Program Resubmission interval for the OrderImport process</td>
</tr>
</tbody>
</table>

Table 3 – 2  (Page 1 of 2)
<table>
<thead>
<tr>
<th>Product</th>
<th>Internal Requisition Setup Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shipping Execution</td>
<td>Define release sequence rules, Define pick slip grouping rules, Define shipping parameters</td>
</tr>
<tr>
<td>Inventory</td>
<td>Define internally requested items, Define inter-organization shipping network, Define item sourcing, Define Concurrent Program Resubmission intervals in Inventory planning and replenishment windows</td>
</tr>
<tr>
<td>Purchasing</td>
<td>Define Internal Requisition Deliver-To Sites, Set Legal Requisition Type profile, Define Purchasing Options, Define Concurrent Program Resubmission intervals for the Requisition Import and Create Internal Sales Orders processes</td>
</tr>
</tbody>
</table>

**Table 3 – 2** (Page 2 of 2)

---

**Minimum Order Management Setup for Internal Requisitions**

You use standard sales order functionality to define transaction types for internal sales orders. You also need to use the Purchasing Options window to specify the order type you use for internal requisitions. See: Defining Internal Requisition Options: page 1 – 52.

You must perform the following setups in Order Management to use the internal requisition features. You may choose to take advantage of other Order Management features which require additional setups. See: Oracle Order Management Recommended Setup, *Oracle Order Management User’s Guide*.

**Define Order Management Profile Options**

Set the profile option OM: Item Flexfield. This profile option defines which structure of the item flexfield to use. See: Order Management Profile Options, *Oracle Order Management User’s Guide*.

Note that Order Management uses the same set of books as defined in the System Options window in Oracle Public Sector Receivables. See: Accounting System Options, *Oracle Public Sector Receivables User’s Guide*.

Use the Parameters window in Order Management to define the Item Master organization for this installation.

**Suggestion:** Set the Item Validation Organization to the same Item Master organization as your purchasing reference.
Define Transaction Types

Use the Transaction Types window to define order and line types. Order Management provides default order cycle workflows that you must associate with each order and line type. See: Defining Transaction Types, Oracle Order Management User’s Guide.

Define an Order Management Number Source For Internal Requisitions

Define order number sources to automatically number internal sales orders as you import them. You can use a single order number source to assign unique numbers to all your orders, or you can use a different order number source within each order type. See: Defining Order Number Sources, Oracle Order Management User’s Guide.

Define a Price List For Internal Requisition

Although internal requisitions use the item’s cost as the price, Order Management requires price lists to process all sales orders. Define a price list for use with the internal requisition order type. You do not need to add any lines to the price list. See: Defining a Price List, Oracle Order Management User’s Guide.

Decide which Default Value Rules to Use

Default value rules define the defaulting that occurs as orders are entered or imported. Order Management provides default value rules that you can use for internal sales orders. Confirm that the default value rules that Order Management provides suit your public sector needs. If not, use the Defaulting Rules window to modify them. See: Defining Default Value Rules, Oracle Order Management User’s Guide.

Define Inventory Accounting (Account Generator)

Order Management can dynamically create the Cost of Goods Sold (COGS) Account for each shipped or returned item based on rules you define. Order Management provides a default Account Generator process to be used in determining the COGS Account during the Inventory Interface process.

You can either accept the default COGS Account Generator process or customize it to suit your public sector needs. For more information on
how to accept or customize this feature, see: Account Generator, Oracle Order Management User’s Guide.

**Internal Sales Orders Processing Constraints (Optional)**

Order Management processing constraints apply to all your sales orders, including internal sales orders imported from Purchasing. Processing constraints prevent users from adding, updating, deleting and cancelling order information beyond certain points in the order cycles. You can use the System rules Order Management provides, which prevent data integrity violations, or define your own, stricter, rules. See: Defining Processing Constraints, Oracle Order Management User’s Guide.

---

**Minimum Shipping Execution Setup for Internal Requisitions**

Perform the following steps:

- Define release sequence rules
- Define pick slip grouping rules
- Define shipping parameters

See: Oracle Shipping Execution User’s Guide.

---

**Minimum Purchasing Setup for Internal Requisitions**

**Define Internal Requisition Deliver-To Sites**

Purchasing uses locations to identify the final delivery location for both inventory and supplier sourced requisitions. As a requestor, you want to specify the same destination for both purchase and internal requisitions. As a shipping clerk, you are concerned with the final delivery location of the item, regardless whether it is for an internal or external customer. Purchasing and Order Management use location associations to minimize the decisions you need to make when you create internal requests.

Use the Location window to define a location for each site that receives either inventory or supplier sourced material. See: Defining Locations: page 1 – 24. For internal requisition deliver-to locations, you also need to associate the locations with a customer. Use the Customers window to define a Customer and Ship-To site for each deliver-to location. Use the Business Purposes region in the Customers window to associate
your internal locations to your customers. See: Assigning a Business Purpose to a Customer Address, Oracle Public Sector Receivables User’s Guide.

**Suggestion:** Create an internal customer for each destination organization, and customer ship–to site for each deliver–to location within the destination organization.

**Suggestion:** Define the same address for the customer ship–to site as the deliver–to location. Order Management prints the ship–to address on the shipping documentation.

**Suggestion:** Order Management requires both a ship–to and an invoice–to for each order, even though internal order lines are not invoiced. When you define a customer, either make the ship–to address both a ship–to and bill–to business purpose and set the Primary flag to Yes on the business purpose, or assign the ship–to to a bill–to location.

**Set Up Internal Requisition Approvals and Security**


**Define Purchasing Options for Internal Requisitions**

You need to set up these additional purchasing options to use internal requisitions:

- **Order Type**
  
  Pick the Order Type you defined in Order Management for internal sales orders. Purchasing uses this type to create sales orders from internal requisitions. See: Defining Internal Requisition Options: page 1 – 52.

- **Enforce Quantity Rounding**
  
  In the Purchasing Options window, specify whether you enforce lot quantity rounding or display advisory messages when you create on–line requisitions using the Requisitions window. See: Defining Control Options: page 1 – 49.
Minimum Inventory Setup for Internal Requisitions

Define Internally Orderable Items

When you define internally orderable items, there are a few attributes that require extra consideration. See: Defining Items, Oracle Inventory User’s Guide.

- **Inventory and Order Management regions**
  
  Items you use on internal requisitions must be Inventory enabled, internally orderable and stockable, shippable, and Order Management transactable for the source organizations. Under Inventory, you need to select the Inventory Item, Transactable, and Stockable options. Under Order Management, you need to select the Internal Ordered, Internal Orders Enabled, OE Transactable, and Shippable options.

- **Source Type – General Planning region**

  Specify a default source type of Inventory or Supplier.

  You cannot create intraorganization internal requisitions for MRP planned items. When you specify sourcing information for MRP planned items, you need to ensure that you do not define an intraorganization sourcing rule for these items.

- **List Price – Purchasing region**

  Inventory sourced requisitions use item costs for pricing. You may still want to specify a list price for items that are sourced both from suppliers or inventory.

- **Unit of Issue – Purchasing region**

  You use units of issue to round order quantities, minimizing shipping, warehousing, and handling costs.

  Enter the unit of measure you typically use to issue the item from inventory. Purchasing uses this unit of measure as the default for internal requisition lines sourced from inventory when you create them in the Requisitions window.

- **Rounding Factor – Purchasing region**

  Enter a number between 0 and 1. This factor determines how to round the quantity on an internal requisition that results from conversions between the requisition line unit of measure and the item’s Unit of Issue. This factor ensures that the unit of issue resolves to an integer, rather than a fractional amount.
Purchasing either performs rounding automatically or advises you of the suggested quantity, depending how you set up your purchasing options.

**Set Up Item Sourcing**

Internal requisitions use the sourcing information you specify in Inventory. All items, subinventories, and organizations may have item sourcing information specified for them. At each level (item, subinventory, or organization), you can choose whether items are replenished from inventory or purchased from a supplier.

- **Source Type**
  
  Specify Inventory as the default source type if you want to source requests from an internal stock location.

- **Source Organization and Subinventory**
  
  If you specify an item to be replenished from inventory, you must specify a source organization; a source subinventory is optional. When you place an order for this item, Inventory creates an internal requisition for the item from the source location.

In case of a conflict between the item, subinventory, and organization levels, internal requisitions use the following order of precedence to determine the default source type and source for the item and destination:

- Sourcing information specified in the item–subinventory relationship
- Sourcing information specified in the subinventory definition
- Sourcing information specified in the item definition
- Sourcing information specified in the organization setup options

**Define the Inter–Organization Shipping Network**

Use the Shipping Networks window to define your inter–organization network. You must enable the network between each source (shipping) and destination (receiving) organization.

- **Internal Order Required**
  
  Select Internal Order Required if you want all transfers between these two organizations to use internal orders.
• **Transfer Type**
  
  Specify whether you ship material directly, or use intransit inventory for shipments between these two organizations.

  **Attention:** If you use Lot, Serial, or Item Revision Control in both the source and destination organization, you must use intransit if you ship from an organization with less control (i.e. Lot Control), to an organization with more control (i.e. Lot and Serial Control).

• **Receipt Routing**

  For intransit transfers, you can choose from the following primary receipt routings: Standard receipt, Inspection required, or Direct delivery.

• **FOB Point**

  Specify whether the destination organization takes ownership of transferred items when they are issued to intransit (Shipment), or when they are received out of intransit (Receipt).

• **Transfer Charge Type**

  Specify how you want to apply transfer costs to the destination organization. Choose either a predefined or requested percentage of the transaction value or a fixed amount that represents an added value.

### Set Up a Customer Association

To define your organization as the destination for an internal requisition, Order Management has to recognize you as a customer. See: Defining Locations: page 1–24. See: Assigning a Business Purpose to a Customer Address, *Oracle Public Sector Receivables User’s Guide*.

### Online Processing Automation for Internal Requisitions

Internal requisitions provide a number of options to automate processing. You can set up the following processes to run automatically as often as you like to limit on–line interaction and streamline processing. See: Submitting a Request, *Oracle Applications System Administrator’s Guide*.

• Reorder Point Planning Report

• Min–Max Planning Report
• Requisition Import
• Create Internal Sales Orders
• OrderImport

**Suggestion:** Create a report group to run all requests back–to–back over specific time intervals when you are using internal requisitions for automatic subinventory transfers.

---

### Internal Requisitions Example

Purchasing provides flexible internal requisitions that you can tailor to meet your needs. Review the example in this section to better understand how you can use internal requisitions.

*You are not required to manage internal requisition activities exactly as described in the following example. Rather, the objective of these examples is to highlight the flexibility of internal requisitions across a variety of situations.*

*Oracle Manufacturing recommends that you experiment and review the results of different approaches to determine the best implementation of the internal requisition functionality for your unique needs. You should use this example as a starting point to better understand how you might use internal requisitions.*

---

### Example Overview

Global Computers, Incorporated is a computer manufacturer with organizations in Austin, TX and Sacramento, CA.

The Austin organization repetitively manufactures plastic components and uses the components, along with purchased items, to assemble base and cover assemblies in the Sacramento organization. Ownership of inter–organization transfers between Austin and Sacramento changes hands at the time of receipt (FOB Point: Receiving).

The Sacramento organization uses the Austin base and cover assemblies to assemble configurations of Sentinel computers. Sacramento also has a local sales offices for customer visits and demonstrations. The agents distribute sales brochures during customer visits.

Employees can request Sentinel Computers for their own use, as well as mouse pads and wrist pads for their offices.
The following tables describe the items and subinventories at Global Computers.

Define the following items at Global Computers:

<table>
<thead>
<tr>
<th>Item</th>
<th>Item Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A54888</td>
<td>Sentinel Base Assembly</td>
</tr>
<tr>
<td>S86662</td>
<td>Sentinel Cover Assembly</td>
</tr>
<tr>
<td>S56302</td>
<td>Sentinel Computer</td>
</tr>
<tr>
<td>C13139</td>
<td>Hard Drive</td>
</tr>
<tr>
<td>S85773</td>
<td>Sales Brochure</td>
</tr>
<tr>
<td>M1002</td>
<td>Mouse Pad</td>
</tr>
<tr>
<td>M1002</td>
<td>Wrist Pad</td>
</tr>
</tbody>
</table>
Define the following subinventories at Global Computers:

<table>
<thead>
<tr>
<th>Organization</th>
<th>Subinventory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Austin</td>
<td>AUS–Finished Goods: Contains completed Sentinel Base Assemblies, Contains completed Sentinel Cover Assemblies, Tracked – asset subinventory</td>
</tr>
<tr>
<td></td>
<td>Repetitive Assembly: Contains Hard Drives for final assembly in WIP, Uses Min/Max replenishment to signal replenishment, Request from AUS–Stores subinventory</td>
</tr>
<tr>
<td></td>
<td>AUS–Stores: Contains additional supply of Hard Drives, Tracked – asset subinventory</td>
</tr>
<tr>
<td>Sacramento</td>
<td>SAC–Finished Goods: Contains completed Sentinel Computers, Tracked – asset subinventory</td>
</tr>
<tr>
<td></td>
<td>SAC–Stores: Contains completed Sentinel Base Assemblies shipped from Austin, Contains completed Sentinel Cover Assemblies shipped from Austin, Tracked – asset subinventory</td>
</tr>
<tr>
<td></td>
<td>Office Supplies: Contains supply of Wrist Pads and Mouse Pads for internal use, Not tracked – expense subinventory</td>
</tr>
<tr>
<td></td>
<td>Storage: Central storage for excess Sales Brochures, Tracked – asset subinventory</td>
</tr>
<tr>
<td></td>
<td>Visit Center: Contains local supply of Sales Brochures for customer visits, Space for only 100 Sales Brochures, Not tracked – expense subinventory</td>
</tr>
</tbody>
</table>

Table 3–4 (Page 1 of 1)

**Inventory Replenishment Request (Manufacturing)**

You use one Hard Drive during the assembly of each Sentinel Base Assembly, and keep a limited supply of the Hard Drives in your Repetitive Assembly subinventory. As you consume Hard Drives from the Repetitive Assembly, you want to automatically send inventory replenishment requests to transfer additional Hard Drives from your Stores subinventory. The material handler needs to receive the inventory request and transfer the material before you run into a shortage situation. You create a report group that submits the Min–Max Planning, Requisition Import, Create Internal Sales Orders, and OrderImport processes every two hours.
As soon as the **Hard Drive** supply in the **Repetitive Assembly** subinventory drops below the minimum quantity, the next run of the Min–Max Planning process automatically creates a replenishment order for the reorder quantity. The reorder uses the item sourcing information to automatically create an intraorganization request in the Austin plant to move **Hard Drives** from **Stores** to the **Repetitive Assembly** subinventory. The request is automatically loaded as an internal requisition and an internal sales order, providing visibility of the request to the material handlers in the Austin plant.

The material handler also runs Pick Release every two hours to identify the pull requests from the shop floor subinventory. The next run of Pick Release creates a move order line for the subinventory transfer of **Hard Drives**. The material handler picks the **Hard Drives** out of the **Stores** subinventory, completes a ship confirmation and replenishes the **Repetitive Assembly** subinventory before a shortage occurs. At ship confirmation, the on–hand balances of the two subinventories are automatically updated.

### MRP Generated Inter–Organization Request (Manufacturing)

You use Oracle Master Scheduling/MRP and Supply Chain Planning in **Sacramento** to schedule production of the final assembly of the **Sentinel Computer**. The **Sentinel Base Assembly** and **Sentinel Cover Assembly** are provided by the **Austin** organization, so you define these items as “buy” items in **Sacramento**. You also specify the following sourcing information for the item:

- **Source Type** – **Inventory**
- **Source Organization** – **Austin**
- **Source Subinventory** – **AUS–Finished Goods**

Master Scheduling/MRP recommends that you produce 400 **Sentinel Computers** to fulfill demand over the next four weeks (100 each week), and you only have 100 **Sentinel Cover Assemblies** and 100 **Sentinel Base Assemblies** on hand in **Sacramento**. You need five days to ship material from **Austin** to **Sacramento**, so the planner implements planned orders for 100 **Sentinel Cover Assemblies** and 100 **Sentinel Base Assemblies** for the next three weeks using the Planner Workbench.

When the planner releases the planned orders for **Sacramento**, Master Scheduling/MRP automatically loads the Requisitions Open Interface and submits Requisition Import. Requisition Import uses the sourcing information that you set up to create a requisition line for each week sourced from the **Austin AUS–Finished Goods** subinventory. In the
background, the Create Internal Sales Orders and OrderImport processes automatically load the internal sales order against the Austin organization.

What if you have a three day production delay in Austin and you need to delay the third shipment of Sentinel Base Assemblies for a few days? Sacramento needs visibility to the delay to adjust the production schedules of the final assembly of the Sentinel Computers. In Austin, you can use the Sales Orders window to update the scheduled shipment date by three days, or choose a different freight carrier for faster delivery if you need to expedite the shipment to prevent a shortage in Sacramento. When you ship the third shipment from Austin, you can update the expected arrival date, giving the planner and MRP in Sacramento full visibility of supply changes.

Each ship confirmation of the Sentinel Base Assemblies creates an intransit shipment from Austin to Sacramento. You do not require inspection of your own inter–organization transfers, so the receiving clerk in Sacramento receives directly into the Final Assembly subinventory when the shipment arrives. The intransit inventory balance is automatically updated and the inter–organization accounting entries are created along with the receipt transaction.

**Inventory Replenishment Request (Office Stock Locations)**

In the Sacramento sales office, you use internal requisitions to replenish your stock of sales brochures in the Visit Center.

Agents use your brochures well, and most customers take brochures with them after the visit. You want easy access to brochures in the Visit Center, but only have room for 100 Sales Brochures. You typically use about 75 a week, but the number fluctuates with sales activity. Agents take what they need; you do a stock count on Monday and Wednesday of each week and replenish whenever the stock count falls below 25.

You need to define min–max information for the Sales Brochures that you stock in the Visit Center subinventory. Use the Item Subinventories window to specify a planning method of Min–max planning, a minimum quantity of 25, and a maximum quantity of 100.

An assistant counts the Sales Brochures in the Visit Center on Monday, enters the results (20 remaining) into the Enter Replenishment Counts form, chooses On–Hand Quantity as the replenishment method, and runs the replenishment processor. Inventory automatically creates one replenishment request in the Requisitions
Open Interface for 80 Sales Brochures to Visit Center from the Storage subinventory.

Requisition Import creates an approved internal requisition for subinventory transfers, and the sales order is automatically loaded.

The material handler reviews the picking slip, pulls the 80 Sales Brochures from Storage Subinventory and delivers them to the Visit Center. After delivering the material the handler records the shipment using the Confirm Shipments window. The shipment, receipt, and delivery information is recorded at once, and the on-hand balance of the Storage subinventory is updated automatically. Inventory automatically creates the necessary accounting entries to reduce the overall value of Sales Brochures in the Storage subinventory and charges the accounts associated with the Visit Center subinventory.

Online Request for Goods out of Inventory

In Sacramento, you stock low-cost office supplies on site to provide quick delivery to your employees. Employees can request items that are sourced from suppliers or inventory, but they do not know the source type at the time of the request. You also require internal requisitions to process requests for goods out of the stock locations. You have an organization policy to always request items from Office Supplies whenever possible. You do not require any additional approvals, and a material handler picks the items out of inventory and delivers them directly to your office. A one day turnaround time is required for all internal requests.

As a requestor, you want to order the following items to improve your comfort and productivity:

- Sentinel Computer
- Mouse Pad
- Wrist Pad
- Glare Screen (not stocked on site)

Use the Requisitions window to create your request. Since organization policy dictates that you request items from inventory whenever possible, the default requisition type is Internal Requisition and the default source type is Inventory. When you create the four requisition lines for your items, Purchasing automatically uses the item sourcing information to source the Mouse Pad and Wrist Pad from the Office Supplies subinventory, and the Sentinel Computer from the SAC-Finished Goods subinventory. Since the Glare Screen can only be purchased from suppliers, Purchasing sets the source type to

Material handlers need immediate visibility of your requests to be able to deliver in 24 hours. The system administrator sets the Create Internal Sales Orders and OrderImport processes to run every hour for internal sales orders.

The material handler in charge of the **Office Supplies** subinventory runs Pick Release twice a day to generate pick slips. The material handler reviews the picking slip, pulls the **Mouse Pad** and **Wrist Pad** from Storage and delivers them to your office. After getting your signature, the handler records the shipment using the Confirm Shipments window. The shipment, receipt, and delivery information is recorded at once, and the quantity delivered on the internal request is updated.

**Office Supplies** is an expense subinventory, and the correct accounts are charged when you receive the supplies into this subinventory. Since you are sourcing from an expense subinventory, ship confirmation does not generate any accounting entries for the issue of the items from the **Office Supplies** subinventory to your office location.

A separate material handler receives the **Sentinel Computer** request, and picks and ships it from the **SAC–Finished Goods** subinventory. When you complete the ship confirmation, Inventory automatically issues the Sentinel Computer out of the **SAC–Finished Goods** asset subinventory to the expense location listed on the requisition. Inventory and Purchasing also record the accounting transactions to credit the **SAC–Finished Goods** asset account and debits the appropriate charge account listed on the requisition.
Finding Requisitions

Use the Find Requisitions window to:

• Access the Requisitions window.
• Perform requisition inquiries at header, line, and distribution levels

Depending on the function security assigned to your responsibility, you have varying levels of access to information. A responsibility defines an application user’s current privileges while working with Oracle Applications. See: Function Security for Purchasing: page 1–112.

To enter search criteria:

1. Navigate to the Find Requisitions window by selecting Requisition Summary from the menu. Then enter as many as desired of the search criteria described in the following steps.

2. Enter the requisition number. If you enter a requisition number, you can also enter a Line number.
3. Select the requisition Type (Purchase or Internal).
4. Enter the Preparer.
5. Enter the Requestor.
6. Enter the Buyer.
7. Select Yes or No to restrict the search to Modified requisitions.
8. Enter the Reference Number.
9. Enter the Import Source.
10. Enter the Line Type.
11. Use the tabbed regions to further restrict the search:
   - In the Item region, you can enter the following search criteria: Item number, Revision number, Category, item Description, and Supplier Item number.
   - In the Status region, you can limit the search by Approval status (Approved, Incomplete, In Process, Pre–Approved, Rejected, or Returned), Control status (Open, Cancelled, or Finally Closed), or Reserved status (Yes or No).
   - In the Date Ranges region, you can enter date ranges for the following dates: Creation, Need By, and Closed.
   - In the Sourcing region, you can limit the search by Source (Supplier or Inventory). For Supplier sourced requisitions, you can further limit the search by Supplier, Site, and Currency. For Inventory sourced requisitions, you can further limit the search by Organization and Subinventory.
   - In the Deliver To region, you can limit the search by Destination Type (Expense, Inventory, or Shop Floor), Organization, Location, and (for Inventory destinations only) Subinventory.
   - In the Related Documents region, you can limit the search by Document Type, Document number and Line Number, Purchase Order number, and drop shipment Sales Order number.
   - In the Accounting region, you can limit the search by Period, GL Date, Charge Account, Budget Account, and whether there are Active Encumbrances (Yes or No).
   - In the Projects region, you can limit the search by Project or Task number.
12. Select the Results group (Headers, Lines, or Distributions) to determine which summary window to open. Depending on the search criteria you have specified, all summary windows may not
be available. For example, if you specify criteria in the Accounting region, only the Distributions summary window is available.

13. Select the Find button to initiate the search and open the appropriate Summary window.

► **To clear existing search criteria:**
  - Select the Clear button to clear any existing search criteria.

► **To enter a new requisition:**

See Also

Using the Requisition Headers Summary Window: page 3 – 44
Using the Requisition Lines Summary Window: page 3 – 47
Using the Requisition Distributions Summary Window: page 3 – 49
Overview of Function Security, *Oracle Applications System Administrator’s Guide*

---

**Using the Requisition Headers Summary Window**

Use the Requisition Headers Summary folder window to:

- View requisition header information.
- Drill down to view requisition line and distribution information.
- Access the Requisitions window for entry of new documents.
- Access the Requisitions, Requisition Preferences, and Control Document windows for maintenance of existing information.
- View information in the Action History window.

► **To navigate to the Requisition Headers Summary window:**

1. In the Find Requisitions window, select Headers in the Results region and select the Find button to open the Requisition Headers Summary folder window.
The following information is displayed: requisition Number, Preparer, Status, Description, Total amount, Currency, Creation Date, Type, Cancelled status, Finally Closed status, and Reserved status.

- To drill down to view requisition line information:
  - Select the Lines button to drill down to the Requisition Lines Summary folder window. You can also select View Lines on the Tools menu to open this window. See: Using the Requisition Lines Summary Window: page 3 – 47.

- To enter a new requisition:

- To open the Requisitions window for the current line:
  - Select the Open button to open the Requisitions window and query the requisition on the current line. Your options in this window depend on the status of the requisition and your approval and security options. For example, if a requisition has a status of In

► **To view requisition distributions information:**

► **To view action history:**
  - Select View Action History on the Tools menu to open the Action History window. See: Viewing Action History: page 8 – 2.

► **To view purchase orders:**
  - Choose the Lines button to open the Requisition Lines Summary window. Then select View Purchase Orders on the Tools menu to open the purchase order.

► **To view sales orders:**
  - Choose the Lines button to open the Requisition Lines Summary window. Then select View Sales Orders on the Tools menu to open the Sales Orders window.

► **To enter requisition control information:**
  - Select Control on the Tools menu to open the Control Document window for the document on the current line. See: Controlling Documents: page 2 – 55.

► **To enter requisition preferences:**
  - Select Preferences on the Tools menu to open the Requisition Preferences window. See: Entering Requisition Preferences: page 3 – 52.

**See Also**

Customizing the Presentation of Data in a Folder, *Oracle Applications User’s Guide*

Finding Purchase Orders: page 4 – 19
Using the Requisition Lines Summary Window

Use the Requisition Lines Summary folder window to:

- View requisition line information.
- Drill down to view requisition distribution information.
- Access the Requisitions window for entry of new documents.
- Access the Requisitions, Requisition Preferences, and Control Document windows for maintenance of existing information.
- View information in the Action History window.
- View purchase order and sales order information, if the requisition has been placed on a purchase or sales order.

To navigate to the Requisition Lines Summary window:

1. In the Find Requisitions window, select Lines in the Results region and select the Find button to open the Requisition Lines Summary folder window. You can also navigate to this window from the Requisition Headers Summary window by selecting the Lines button or View Lines on the Tools menu.

![Requisition Lines Summary Window](image)
The following information is displayed: requisition Number, Line, Item, item Revision, Category, item Description, quantity Ordered, quantity Delivered, Type, UOM, Price, Need By date, Requestor, Total amount, Currency, Modified status, Currency Price, Supplier, supplier Site, Supplier Item number, Source Document Type, PO Number, PO Line number, Reference Number, Source Type, Source Organization, Source Subinventory, Destination Type, Destination Organization, Deliver To, Destination Subinventory, Finally Closed status, Cancelled status, and Reserved status.

► To drill down to view requisition distribution information:
  ■ Select the Distributions button to drill down to the Requisition Distributions Summary folder window. You can also select View Distributions on the Tools menu to open this window. See: Using the Requisition Distributions Summary Window: page 3 – 49.

► To enter a new requisition:

► To open the Requisitions window for the current line:
  ■ Select the Open button to open the Requisitions window and query the requisition on the current line. Your options in this window depend on the status of the requisition and your approval and security options. For example, if a requisition has a status of In Process, you cannot open its line from this window. See: Entering Requisition Headers: page 3 – 57.

► To view purchase orders:
  ■ Select View Purchase Orders on the Tools menu to open the purchase order.

► To view sales orders:
  ■ Select View Sales Orders on the Tools menu to open the Sales Orders window.

See Also

Customizing the Presentation of Data in a Folder, Oracle Applications User’s Guide
Using the Requisition Distributions Summary Window

Use the Requisition Distributions Summary folder window to:

- View requisition distribution information.
- Access the Requisitions window for entry of new documents.
- Access the Requisitions, Requisition Preferences, and Control Document windows for maintenance of existing information.
- View information in the Action History window.

To navigate to the Requisition Distributions Summary window:

1. In the Find Requisitions window, select Distributions in the Results region and select the Find button to open the Requisition Distributions Summary folder window. You can also navigate to this window by selecting View Distributions on the Tools menu in the Requisition Headers Summary and Requisition Lines Summary windows.
The following information is displayed: requisition Number, Line number, Distribution number, Item, item Description, UOM, Price, Quantity, Amount, and Charge Account.

► To enter a new requisition:

► To open the Requisitions window for the current line:
  ■ Select the Open button to open the Requisitions window and query the requisition on the current line. Your options in this window depend on the status of the requisition and your approval and security options. See: Entering Requisition Headers: page 3 – 57.
See Also

Customizing the Presentation of Data in a Folder, *Oracle Applications User’s Guide*

Viewing Action History: page 8 – 2
Finding Purchase Orders: page 4 – 19
Entering Requisition Preferences: page 3 – 52
Entering Requisition Preferences

Use the Requisition Preferences window to enter requisition line defaults (including currency, destination, project, and sourcing default information). These defaults are applicable during this user session to all new requisition lines you create after you set the defaults until you exit Purchasing. You can override these defaults for specific lines.

To enter main preferences:

1. Navigate to the Requisitions Preferences window by selecting Preferences on the Tools menu in the Requisitions window or in the Requisitions Headers, Lines, and Distributions Summary windows. In the Main tabbed region, you can enter the defaults described in the following steps.

2. Enter the Need By date.

3. Enter the GL Date to be used when funds are reserved. You can enter a GL Date only if you set up your financials system options to
use encumbrance or budgetary control for requisitions. See: About Financials Options, Oracle Public Sector Payables User’s Guide. See: Budgetary Control and Online Funds Checking, Oracle Public Sector General Ledger User’s Guide.

4. Enter the Charge Account for the cost of the items on the requisition line. The account you enter here is used only for expense destinations, and it overrides any account built by the Account Generator.

5. Enter a Justification for your requisition line. Buyers and approvers can review this justification.

6. For Internal requisitions only, enter a Note To Receiver. For example, you could note that the receiver should unpack your requested items or that only you can accept delivery. For both internal and purchase requisitions, you can provide additional notes to the receiver by using attachments. See: Attaching Notes to Purchasing Documents: page 1 – 44.

7. Enter the default Reference Number for all requisition lines. You use the reference number to match your requisition line with a specific work, project, etc.


9. Check Urgent to indicate that your requisition should be expedited. Buyers have the option to process urgent requisitions faster when they AutoCreate purchase orders from requisitions.

10. Enter a default suggested Currency for the requisition lines. This must be an enabled code from the Currency window. See: Defining Currencies, Oracle Public Sector General Ledger User’s Guide.

11. Enter the default Rate Type. You can also set this default in the Purchasing Options window. Defining Default Options: page 1 – 45. Purchasing supplies you with one of two predefined currency rate types: User or EMU Fixed. A rate type of User means that you can enter a conversion rate between the foreign currency (or transaction currency in a document entry window) and the base currency (or functional currency, defined in your set of books). A rate type of EMU Fixed means that if either your transaction currency or your functional currency is Euro (the European Monetary Unit currency) and the other is another European currency, Purchasing automatically enters a conversion Rate Date and Rate for you that you cannot change.
You can define additional currency rate types in the Daily Conversion Rate Types window. See: Defining Conversion Rate Types, *Oracle Public Sector General Ledger User’s Guide*.

12. Enter the default currency Rate Date.

13. Enter the default currency conversion Rate. Purchasing overrides this default when you are entering requisition lines if the rate type is not User and if you have established a rate for the rate type and date. See: Entering Daily Rates, *Oracle Public Sector General Ledger User’s Guide*.

14. Enter the Destination Type to indicate the final destination of the purchased items:

   **Expense** – The goods are delivered to the requestor at an expense location.

   **Inventory** – The goods are received into inventory upon delivery. This option is appropriate only if the item is stock enabled in the deliver-to organization.

   **Shop Floor** – The goods are delivered to an outside processing operation defined by Work in Process. This option is appropriate only for outside processing items.

15. Enter the Requestor. This is the employee who requests the quantities on the requisition lines. Purchasing copies this name as the requestor for every requisition line.

16. Enter the Organization. The default is the requestor’s organization. The List of Values displays all valid receiving organizations.

17. Enter the delivery Location for all requisition lines. The default is the requestor’s location. You can pick any location that does not have an organization or any location whose organization matches the deliver-to organization. See: the online help for the Enter Person window. See: Defining Locations: page 1 – 24.

   If the Destination Type is Inventory, you can also enter the Subinventory. See: Defining Subinventories, *Oracle Inventory User’s Guide*.

18. Enter the Source type: Inventory or Supplier. If you have both options, you can source requisition lines independently of the document type. You can also mix inventory and supplier sourced requisition lines in the same requisition. Purchasing creates one internal sales order for all Inventory source type requisition lines on this requisition. You can use the Autocreate Documents window to place Supplier source type requisition lines onto purchase orders.
For Inventory source type lines, you can enter a default Organization and Subinventory. If you specify a subinventory for an internal requisition line, Order Management reserves the goods and uses only the specified subinventory for allocation. If the goods do not exist at the specified subinventory, Order Management backorders them, even if they do exist in another subinventory.

For Supplier source type lines, you can enter the following defaults: Buyer, Note to Buyer, Supplier, Site, Contact, and Phone. You can also check RFQ Required to indicate that you want to require an RFQ before the buyer creates a purchase order for the requisition. If RFQs are required and you AutoCreate a purchase order before creating an RFQ for the requisition line, Purchasing displays a warning message. You can also set this default in the Purchasing Options window. See: Defining Default Options: page 1 – 45.

To enter project information preferences:

You see a Project Information tabbed region if one of the following is true:

- Oracle Projects is installed, or
- Oracle Project Manufacturing is installed and Project Reference Enabled is selected in the Project Manufacturing Organization Parameters window

The project information you enter is used by Oracle Projects for Deliver To destination types of Expense, or by Oracle Project Manufacturing for Deliver To destination types of Inventory or Shop Floor. See: Oracle Projects User’s Guide. See: Oracle Project Manufacturing Implementation Manual.

1. Choose the Project Information tabbed region.
2. Select a Project Number.

   For a Deliver To destination type of Inventory or Shop Floor, you can optionally enter a Project Number if the Project Control Level is set to Project in the Project Information tabbed region of the Organization Parameters window.

   For a Deliver To destination type of Expense, you can always optionally enter a Project Number.

3. If you entered a Project number, select a Task number.

   You must enter a Task number for a Deliver To destination type of Inventory or Shop Floor, if the Project Control Level is set to Task in
the Organization Parameters window and if you have entered a
Project number.

4. Enter Expenditure information:

Expenditure information is required only if your Destination Type
is Expense.

• Select the Expenditure Type.

• If you chose an Expenditure Type, enter an Expenditure
Organization.

• If you chose an Expenditure Organization, select the Expenditure
Item Date.

► To apply your defaults:

■ Select the Apply button to apply your defaults. The preferences
entered here will affect new lines entered after you select Apply
until you exit the application.

See Also

Using the Account Generator in Oracle Public Sector Purchasing: page
C – 10
Entering Requisition Headers

Use the Requisitions window to:

- Enter internal and purchase requisitions. Your approval and security setup options determine which types of requisitions you can enter.
- Take approval actions on individual requisitions online.

To enter requisition header information:

1. Navigate to the Requisitions window from the menu, by selecting the New button in the Find Requisitions and requisitions summary windows, or by selecting the Requisitions button in the Order Pad of the Supplier Item Catalog.
The upper part of the Requisitions window has the following display-only fields:

*Preparer* – Your employee name from the Application User window.

*Status* – The requisition status:

*Incomplete* – The requisition is incomplete, or the preparer has not yet submitted the requisition to an approver.

*Rejected* – The approver rejected the requisition.

*Returned* – A buyer rejected the requisition. Purchasing returns to the preparer all requisition lines within the same requisition that are not on a purchase order.

*Total* – The currency code and the base currency total amount of all lines in this requisition.

2. Enter a unique Requisition number. If automatic requisition number generation is active, the cursor does not enter this field and the number is generated when you save your work. See: Defining Numbering Options: page 1 – 53.

3. Choose the Requisition Type:

*Purchase Requisition* – The requisition lines are usually satisfied from an outside supplier by means of a purchase order.

*Internal Requisition* – The requisition lines are usually satisfied from inventory by means of an internal sales order.

When you enter requisition lines you can source them independently of the document type. You can mix inventory and supplier sourced requisition lines in the same requisition of either document type. See: Profile Options in Purchasing: page 1 – 103.

► **To open the Supplier Item Catalog:**

- With the cursor in a requisition line row, select the Catalog button to open the Supplier Item Catalog. See: Overview of the Supplier Item Catalog: page 5 – 8.

► **To take approval actions:**

- After completing a requisition, select the Approval button to open the Approve Documents window. See: Submitting a Document for Approval: page 2 – 35
To check funds:
■ Select Check Funds on the Tools menu.

To enter requisition preferences:
■ Select Preferences on the Tools menu to open the Requisition Preferences window. See: Entering Requisition Preferences: page 3 – 52.

To reaccess a requisition quickly:
■ Choose Place on Navigator from the Action menu. Choose the Documents tabbed region in the Navigator to later access the requisition more quickly. See also: Using the Navigator’s Documents Region, Oracle Applications User’s Guide.

Note: Once you place a document in the Navigator, it is the first thing you see in the Navigator the next time you log into Purchasing. Choose Functions to return to the Purchasing menu.

See Also

Overview of Requisitions: page 3 – 2
Entering Requisition Lines: page 3 – 60
Changing Encumbered Documents: page 4 – 132
Entering Requisition Lines

Use the Items tabbed region in the Requisitions window to enter requisition line information.

You can choose a predefined item (See: Defining Items, Oracle Inventory User’s Guide.) or you can enter an item without an item number.

To enter requisition line information:


2. Enter a line Type for the requisition line. Line types help you define how you want to categorize your items. The default for this field is the Line Type from the Purchasing Options window. (See: Defining Default Options: page 1 – 45.) If you change this line type, defaults from the Line Types window appear in the Category, UOM and Price fields, and the cursor moves to the Category field. See: Defining Line Types: page 1 – 84.
For purposes of requisition line entry, line types are handled in three classes: amount–based, quantity–based, and outside processing. The defaults that appear when you enter a line type are cleared if you change the line type to a different class. Once you have committed a line, you can change the line type only to another line type of the same class.

3. For quantity–based line types and outside processing line types, enter the Item you want to request. Purchasing displays defaults for purchasing category, item description, unit of measure, and unit price for this item. See: Defining Items, Oracle Inventory User’s Guide.

4. Enter the Revision (if any) that corresponds to the item you want to order.

5. Enter the purchasing Category. You cannot change the category if you provide an item number in the Item field.

6. Enter the item Description to explain the item in further detail. When you enter an item number, Purchasing displays the item description from the Items window. You can change this description only if the Allow Description Update attribute for the item is enabled. See: Defining Items, Oracle Inventory User’s Guide.

7. Enter the Quantity you want to request for the item. You can enter decimal quantities, but you must enter a value greater than 0.

You can use the Catalog button to get price breaks for different quantities from catalog quotations or blanket purchase agreements.

If Quantity Rounding is enabled, Purchasing either displays the rounded quantity you should have entered in a warning message or it updates the quantity to the appropriate rounded quantity. The rounding is based on the Unit of Issue (or primary unit of measure if the Unit of Issue is not defined) and the Rounding Factor defined for the item in Inventory. Rounding is up or down to the nearest whole Unit of Issue/primary unit of measure using the rounding factor. See: Overview of Requisitions: page 3 – 2.

8. Enter the unit of measure you want to use for your requisition line. If you enter an item number, Purchasing defaults the unit of measure for this item. If you change this value, the quantity is rounded again if appropriate, and the price is recalculated. If you enter a line type that is amount based, Purchasing uses the unit of measure that you assigned to that line type in the Line Types window. You cannot change the unit of measure of amount based items.
9. Enter the unit Price for the item. You can enter the price in decimal format. You must enter a value greater than or equal to 0. If you enter an item number, Purchasing defaults the list price for this item, but you can change this value. If you create a requisition line for an amount based line type, Purchasing sets the price to 1, and you cannot change it. Unit prices are in the functional currency.

10. Enter the Need By date for the requested items. This is required only for planned items. You must enter a date greater than or equal to the requisition creation date.

The Charge Account is rolled up from a single distribution after the distribution is created. If more that one distribution is created for the line, Multiple is displayed.

The lower part of the screen below the Lines tabbed region consists of optional fields for which the default can be set in the Requisition Preferences window. See: Entering Requisition Preferences: page 3 – 52.

11. Enter or use the default Tax Code for taxable items.


Accept the default tax code or select another. You cannot override the tax code if the profile option Tax: Allow Override of Tax Code is set to No, or the shipment has been received.

If on the requisition you change a tax source, such as Supplier or Site, then Purchasing does not redefault a new Tax Code on the current line, but does default it on new lines. The same is true even after you override the Tax Code: Purchasing does not redefault it on current lines when you change a tax source.

**Note:** If you change the Tax Code after already creating distributions for the line, the associated Recovery Rate on those distributions is not redefaulted for the new Tax Code.

For an overview of tax in Purchasing, see: Tax Defaults in Purchasing: page 4 – 135.

12. Enter the Destination Type:

*Expense* – The goods are delivered to the requestor at an expense location. The destination subinventory is not applicable.

*Inventory* – The goods are received into inventory upon delivery.
Shop Floor – The goods are delivered to an outside processing operation defined by Work in Process. Purchasing uses this option for outside processing items.

13. Enter the name of the employee who is requesting the item. You must provide a Requestor before you can approve the requisition. The default is the requisition preparer.

14. Enter the Organization.

15. Enter the delivery Location for the requested items. Purchasing defaults the deliver-to location that you assign to the employee in the Enter Person window. You must provide a deliver-to location before you can approve the requisition. Before the source of the line can be Inventory, the deliver-to location must be linked to a customer address in the Customer Addresses window. See: Assigning a Business Purpose to a Customer Address, Oracle Public Sector Receivables User’s Guide.

16. Enter the Subinventory. This field applies only when the Destination Type is Inventory.

17. Enter the Source type. The source type determines the source of the requisitioned items. The choice you have in this field is dependent on the PO: Legal Requisition Type profile option. You may be able to use either the Inventory or the Supplier source type, or both types. See: Profile Options in Purchasing: page 1 – 103.

Note that if you have both options, you can source requisition lines independently of the document type. You can even mix inventory and supplier sourced requisition lines in the same requisition. Purchasing creates one internal sales order for all inventory source type requisition lines on this requisition. The supplier source type requisition lines are placed onto purchase orders with the AutoCreate Documents window.

Even if you are restricted to one type, Purchasing restricts the source type as appropriate for the item. If you are restricted to Inventory but you are requesting a Supplier item (Purchased Item attribute – Yes, Internal Ordered Item attribute – No), the source type can be only Supplier. Conversely, if you are restricted to Supplier requisitions and you ask for an Inventory item (Purchased Item attribute – No, Internal Ordered Item attribute – Yes), the source type can be only Inventory. This is allowed because a requestor may not know the item source type.

For Inventory source type lines, you can enter a default Organization and Subinventory. If you specify a subinventory for an internal requisition line, Order Management reserves the goods...
and uses only the specified subinventory for allocation. If the goods do not exist at the specified subinventory, Order Management backorders them, even if they do exist in another subinventory.

18. For the Supplier source type, enter the suggested Supplier, Supplier Site, Contact, and Phone. For the Inventory source type, enter the Organization and Subinventory.

19. Save your work. If you save a requisition line without entering a distribution, Purchasing tries to generate a distribution line for you, using the Account Generator based on the information you have entered. If you want your distribution account numbers to be generated based on project information, you must enter project information in the Requisition Preferences or Requisition Distributions windows before committing the distribution line. See To enter project information preferences in: Entering Requisition Preferences: page 3 – 52. See To enter project information in: Entering Requisition Distributions: page 3 – 68.

► To enter line source details for the Supplier source type:

- Navigate to the Source Details tabbed region. When the source type is Supplier, you can enter the Note to Buyer, Buyer, RFQ Required, Supplier Item number, source Document Type (Blanket or Quotation), source Document, and document Line Number.

If Oracle Project Contracts is installed you can enter Contract number and Rev (version number) in this region. Additional project contract information can be entered in the Distributions window. See To enter project information in: Entering Requisition Distributions: page 3 – 68.

► To enter line details:

- Navigate to the Details tabbed region. You can enter a Justification, Note to Receiver, Transaction Nature, Reference Number, UN Number, and Hazard class. See: Defining Lookup Codes: page 1 – 74.

► To enter line currency information

1. Navigate to the Currency tabbed region.

2. Enter a suggested currency for the requisition line. This must be an enabled code from the Currency window. The cursor enters the remaining currency fields only if you have entered a currency here.
3. Purchasing supplies you with one of two predefined currency rate types: User or EMU Fixed. A rate type of User means that you can enter a conversion rate between the foreign currency (or transaction currency in a document entry window) and the base currency (or functional currency, defined in your set of books). A rate type of EMU Fixed means that if either your transaction currency or your functional currency is Euro (the European Monetary Unit currency) and the other is another European currency, Purchasing automatically enters a conversion Rate Date and Rate for you that you cannot change.

You can define additional currency rate types in the Define Daily Conversion Rate Types form, and you can enter User or one of your additional types. See: Defining Conversion Rate Types, Oracle Public Sector General Ledger User’s Guide.

4. Enter the currency rate date.

5. Enter the currency conversion rate. Purchasing overrides this default when you are entering requisition lines if the rate type is not User and if you have established a rate for the rate type and date. See: Entering Daily Rates, Oracle Public Sector General Ledger User’s Guide.

➤ **To enter outside processing information:**

- Select the Outside Processing button to open the Outside Processing window for outside processing line types. See: Entering Outside Processing Information: page 4 – 80.

➤ **To open the Supplier Item Catalog:**

- With the cursor in a requisition line row, select the Catalog button to open the Supplier Item Catalog. See: Overview of the Supplier Item Catalog: page 5 – 8.

➤ **To enter requisition distributions:**

- Select the Distributions button to open the Distributions window. See: Entering Requisition Distributions: page 3 – 68.
To view tax information:

- After you have entered and saved all tax information, do either or both of the following:
  - Choose Tax Code Summary from the Tools menu to see the total recoverable and nonrecoverable tax for each tax code in your document. See: Viewing Tax Code Summary Information: page 4 – 138.
  - Choose Tax Details from the Tools menu to see recoverable and nonrecoverable tax details for each line and distribution. See: Viewing Tax Details: page 4 – 140.

To approve requisitions:

- Select the Approval button to open the Approve Documents window. See: Submitting a Document for Approval: page 2 – 35.

To check funds:

- Select Check Funds on the Tools menu.

To enter requisition preferences:

- Select Preferences on the Tools menu to open the Requisition Preferences window. See: Entering Requisition Preferences: page 3 – 52.

To reaccess a requisition quickly:

- Choose Place on Navigator from the Action menu. Choose the Documents tabbed region in the Navigator to later access the requisition more quickly. See also: Using the Navigator’s Documents Region, Oracle Applications User’s Guide.

Note: Once you place a document in the Navigator, it is the first thing you see in the Navigator the next time you log into Purchasing. Choose Functions to return to the Purchasing menu.

See Also

Overview of Requisitions: page 3 – 2
Using the Account Generator in Oracle Public Sector Purchasing, Oracle Applications User’s Guide
Entering Requisition Distributions

Use the Distributions window to enter requisition distributions or to view distributions that Purchasing has automatically created for you. You can charge the cost of this requisition line to multiple Accounting Flexfields or update the default values you provided in the Requisition Preferences window. Note that if the line source type is Inventory, you cannot approve the requisition if you enter more than one distribution line.

To enter requisition distributions:

1. Navigate to the Distributions window by selecting the Distributions button in the Requisitions window. You begin in the Accounts tabbed region.

2. Enter the Quantity you want to distribute. The quantity must be in decimal format. Purchasing displays the quantity you have not yet assigned to an Accounting Flexfield. Multiple distribution quantities must total to the requisition line quantity.

Using decimal quantities in this field, you can easily distribute costs across distributions using percentages. For instance, you can have a simple quantity of one (1) on your requisition line. If you want to charge one Accounting Flexfield for 30% of the cost of the
item and another Accounting Flexfield for 70% of the cost of the item, simply enter .3 and .7 as the respective quantities for the requisition distribution lines.

If you have a quantity different from one (1), you can use the Calculator to perform the arithmetic, as illustrated by the following example:

- Your requisition line quantity is 5000
- You want to charge 35% of the cost to a first Accounting Flexfield
- You want to charge 65% of the cost to a second Accounting Flexfield

Simply enter \( \frac{5000 \times 35}{100} = 1750 \) as the quantity for the first requisition distribution and \( \frac{5000 \times 65}{100} = 3250 \) as the quantity for the second requisition distribution.

3. When you enter a Charge Account, Purchasing uses the Account Generator to automatically create the following accounts for each distribution:

- Accrual: the AP accrual account
- Variance: the invoice price variance account

If you are using encumbrance control, Purchasing also creates the following account for each distribution:

- Budget: the encumbrance budget account

The Account Generator creates these accounts based on predefined rules. See: Using the Account Generator in Oracle Public Sector Purchasing: page C – 10.

With one exception, you cannot create or update these accounts manually. If the requisition line destination type is Expense, however, you can change the default charge account supplied by the Account Generator.

4. Change or accept the default Recovery Rate for taxable items.

The recovery rate is the percentage of tax that your business can reclaim for credit. The recovery rate defaults in based on the Tax Code on the line in the Requisitions window and the setup in the Financials Options window.

You can change the recovery rate if the profile option Tax: Allow Override of Recovery Rate is set to Yes, and the shipment has not been received. Depending on the setup in the Financials Options window and the type of tax, only certain recovery rates may be

If on the requisition you change a tax source, such as Supplier, Site, or Tax Code, then Purchasing does not redefault a new Recovery Rate on the current distribution, but does default it on new distributions you create.

You can choose to use a different recovery rate for different distributions, even if they use the same tax code.

For an overview of tax in Purchasing, see: Tax Defaults in Purchasing: page 4 – 135.

5. Enter the GL Date that you want to use when you reserve funds.
You can enter a GL Date only if you set up your financials options to use encumbrance for requisitions. The Reserved check box indicates whether funds have been reserved. The default is the current date. See: About Financials Options, *Oracle Public Sector Payables User’s Guide*.

If you enter a date that belongs to two separate accounting periods, Purchasing creates a journal entry in the first accounting period that contains this date. See: Controlling Purchasing Periods: page 1 – 93.

6. Save your work.

<table>
<thead>
<tr>
<th>To view tax information:</th>
</tr>
</thead>
<tbody>
<tr>
<td>After you have entered and saved all tax information, do either or both of the following:</td>
</tr>
<tr>
<td>• Choose Tax Code Summary from the Tools menu to see the total recoverable and nonrecoverable tax for each tax code in your document. See: Viewing Tax Code Summary Information: page 4 – 138.</td>
</tr>
<tr>
<td>• Choose Tax Details from the Tools menu to see recoverable and nonrecoverable tax details for each line and distribution. See: Viewing Tax Details: page 4 – 140.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To enter project information:</th>
</tr>
</thead>
<tbody>
<tr>
<td>You see a Project tabbed region if one of the following is true:</td>
</tr>
<tr>
<td>• Oracle Projects is installed, or</td>
</tr>
</tbody>
</table>
• Oracle Project Manufacturing is installed and Project Reference Enabled is selected in the Project Manufacturing Organization Parameters window.

The project information you enter is used by Oracle Projects for destination types of Expense, or by Oracle Project Manufacturing for destination types of Inventory or Shop Floor. See: Oracle Projects User’s Guide. See: Oracle Project Manufacturing Implementation Manual.

1. Choose the Project tabbed region.

2. Select a Project Number.

   For a requisition line Destination Type of Inventory or Shop Floor, you can optionally enter a Project Number if the Project Control Level is set to Project in the Project Information tabbed region of the Organization Parameters window.

   For a requisition line Destination Type of Expense, you can always optionally enter a Project Number.

3. If you entered a Project number, select a Task number.

   You must enter a Task number for a requisition line Destination Type of Inventory or Shop Floor, if the Project Control Level is set to Task in the Organization Parameters window and if you have entered a Project number.

4. If you entered a Project Contract number in the Source Details tabbed region for this line, enter the Contract Line number and the Deliverable number that corresponds to this distribution.

5. Enter Expenditure information.

   Expenditure information is required only if your Destination Type is Expense.

   • Select the Expenditure Type.

   • If you chose an Expenditure Type, enter an Expenditure Organization.

   • If you chose an Expenditure Organization, select the Expenditure Date.

6. Note that the distribution Quantity that will be charged to the project should already be entered for you.

   If you change the Quantity here, then the distribution Quantity on the requisition line changes as well.

7. Note that a Unit Number field is visible if Project Manufacturing is installed.
If the item is under model/unit effectivity control, you must select an end-item model Unit Number. This field is disabled if the item is not under model/unit effectivity control. See: Model/Unit Effectivity, Oracle Project Manufacturing Implementation Manual.

**Note:** You can also view the Unit Number as a hidden field in the Requisition Distributions Summary window.

8. Save your work.

The Charge, Budget, Accrual, and Variance accounts in the Account Description region are generated automatically. See: Using the Account Generator in Oracle Public Sector Purchasing: page C – 10.

**See Also**

Budgetary Control and Online Funds Checking, *Oracle Public Sector General Ledger User’s Guide*

Entering Requisition Lines: page 3 – 60

Changing Encumbered Documents: page 4 – 132
Using Requisition Templates

From the Requisitions window, use the Supplier Item Catalog window and Requisition Templates to create requisitions more easily.

► To use requisition templates to enter requisitions:

1. Navigate to the Requisitions window by selecting Requisitions from the menu.
4. Select Catalog to open the Search Supplier Item Catalog window. See: Finding Supplier Items: page 5 – 11.
5. Select the desired Requisition Template from the list of values. See: Defining Requisition Templates: page 1 – 62.
6. Choose the Find button to open the Supplier Item Catalog window and display the template lines.
7. Copy the desired lines to the Order Pad. See: Using the Supplier Item Catalog Tabbed Regions: page 5 – 15.
8. Choose the Select button to close the Supplier Item Catalog window and transfer the order pad lines to the requisition.
9. Save your work.

See Also

Overview of the Supplier Item Catalog: page 5 – 8
This chapter tells you everything you need to know about Purchase Orders, including:

- Overview of Purchase Orders: page 4 – 3
- Purchase Order Defaulting Rules: page 4 – 12
- Finding Purchase Orders: page 4 – 19
- Entering Purchase Order Preferences: page 4 – 34
- Entering Purchase Order Headers: page 4 – 39
- Entering Purchase Order Lines: page 4 – 45
- Entering Purchase Order Price Reference Information: page 4 – 49
- Entering Purchase Order Reference Document Information: page 4 – 51
- Entering Purchase Order Miscellaneous Information: page 4 – 53
- Entering Purchase Agreement Information: page 4 – 55
- Entering Currency Information: page 4 – 58
- Entering Purchase Order Details Information: page 4 – 60
- Entering Purchase Order Shipments: page 4 – 63
- Entering Purchase Order Receiving Controls: page 4 – 69
• Entering Purchase Agreement Price Break Information: page 4 – 72
• Entering Purchase Order Distributions: page 4 – 74
• Entering Outside Processing Information: page 4 – 80
• Entering Purchase Order Notification Controls: page 4 – 82
• Entering and Viewing Purchase Order Acceptances: page 4 – 84
• Entering Releases: page 4 – 87
• Automatic Release Generation: page 4 – 103
• Copying Purchase Orders: page 4 – 106
• Printed Purchase Order Overview: page 4 – 109
• Document Revision Numbering: page 4 – 123
• Changing Encumbered Documents: page 4 – 132
• Drop Shipments: page 4 – 133
• Tax Defaults in Purchasing: page 4 – 135
• Procurement Card Purchase Orders and Releases: page 4 – 143
Overview of Purchase Orders

Purchasing provides the Purchase Orders window that you can use to enter Standard and Planned purchase orders as well as Blanket and Contract purchase agreements. You must be defined as a buyer to use this window. See: Entering Purchase Order Headers: page 4 – 39. See: Defining Buyers: page 1 – 27.

To create purchasing documents more quickly, use the AutoCreate Documents window. See: Autocreate Documents Overview: page 6 – 2.

Purchasing provides you the features you need to satisfy the following purchasing needs. You should be able to:

- Review all of your purchases with your suppliers to negotiate better discounts
- Create purchase orders simply by entering a supplier and item details
- Create standard purchase orders and blanket releases from both on-line and paper requisitions
- Create accurate and detailed accounting information so that you charge purchases to the appropriate departments
- Check your funds availability while creating purchase orders
- Review the status and history of your purchase orders at any time for all the information you need
- Print purchase orders flexibly by using a number of print options
- Inform your suppliers of your shipment schedule requirements
- Record supplier acceptances of your purchase orders. You always know whether your suppliers have received and accepted your purchase order terms and conditions
- Create your purchase orders by providing a quantity and price for each item you are ordering. Alternatively, you should also be able to create your purchase order simply by providing an amount if you are ordering a service that you cannot break down by price and quantity
Purchase Order Types

Purchasing provides the following purchase order types: Standard Purchase Order, Planned Purchase Order, Blanket Purchase Agreement, and Contract Purchase Agreement. You can use the Document Name field in the Document Types window to change the names of these documents. For example, if you enter Regular Purchase Order in the Document Name field for the Standard Purchase Order type, your choices in the Type field in the Purchase Orders window will be Regular Purchase Order, Planned Purchase Order, Blanket Purchase Agreement, and Contract Purchase Agreement.

Standard Purchase Orders

You generally create standard purchase orders for one-time purchase of various items. You create standard purchase orders when you know the details of the goods or services you require, estimated costs, quantities, delivery schedules, and accounting distributions. If you use encumbrance accounting, the purchase order may be encumbered since the required information is known.

Blanket Purchase Agreements

You create blanket purchase agreements when you know the detail of the goods or services you plan to buy from a specific supplier in a period, but you do not yet know the detail of your delivery schedules. You can use blanket purchase agreements to specify negotiated prices for your items before actually purchasing them.

Blanket Releases

You can issue a blanket release against a blanket purchase agreement to place the actual order (as long as the release is within the blanket agreement effectivity dates). If you use encumbrance accounting, you can encumber each release.

Contract Purchase Agreements

You create contract purchase agreements with your suppliers to agree on specific terms and conditions without indicating the goods and services that you will be purchasing. You can later issue standard purchase orders referencing your contracts, and you can encumber these purchase orders if you use encumbrance accounting.
Planned Purchase Orders

A planned purchase order is a long-term agreement committing to buy items or services from a single source. You must specify tentative delivery schedules and all details for goods or services that you want to buy, including charge account, quantities, and estimated cost.

Scheduled Releases

You can issue scheduled releases against a planned purchase order to place the actual orders. If you use encumbrance accounting, you can use the planned purchase order to reserve funds for long term agreements. You can also change the accounting distributions on each release and the system will reverse the encumbrance for the planned purchase order and create a new encumbrance for the release.

Purchase Order Types Summary

The following table describes the purchase order types summary.

<table>
<thead>
<tr>
<th></th>
<th>Standard Purchase Order</th>
<th>Planned Purchase Order</th>
<th>Blanket Purchase Agreement</th>
<th>Contract Purchase Agreement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terms and Conditions Known</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Goods or Services Known</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Pricing Known</td>
<td>Yes</td>
<td>Yes</td>
<td>Maybe</td>
<td>No</td>
</tr>
<tr>
<td>Quantity Known</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Account Distributions Known</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Delivery Schedule Known</td>
<td>Yes</td>
<td>Maybe</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Can Be Encumbered</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Can Encumber Releases</td>
<td>N/A</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Table 4 – 1 (Page 1 of 1)
Purchase Order Features

AutoCreate

AutoCreate lets you compose a purchase order or a release from on–line requisitions in a few keystrokes. See: Autocreate Documents Overview: page 6 – 2.

Workflow for Automatic Purchase Order and Release Creation

Purchasing uses Oracle Workflow technology to create purchase orders and releases automatically from approved requisition lines. Purchase orders and releases are created automatically only if the approved requisition lines are valid (for example, they contain valid source document information) and if the “Is Automatic Creation Allowed?” attribute in the Oracle Workflow Builder is set to ’Y’ for Yes. (It is set to ’Y’ by default.) See: Workflow for Creating Purchase Orders or Releases: page C – 209. See: Choosing Workflow Options: page 1 – 95. See also: Automatic Release Generation: page 4 – 103.

Accurate Accounting

You supply accounting information as part of your purchase order. You can allocate order line quantities and costs to organizations, projects, or departments.

On–line Funds Availability Checking

You can determine whether you have enough funds available in your budget before you complete a purchase order. You can check funds at the purchase order header, lines, shipments, distributions, and release levels. You can also check whether funds are available before you approve your purchase order. You can even set up your system setup options to prevent a buyer from approving a purchase order until sufficient funds are available.

To use on–line funds checking, you need to implement budgetary controls. You can check funds at the detail or summary level. You can also choose to check your funds for each period, quarter, or year. See: Budgetary Control and Online Funds Checking, Oracle Public Sector General Ledger User’s Guide.
Revising Purchase Orders

To change a standard or planned purchase order, simply query this purchase order and enter your changes. You can provide additional paper requisition information to a standard purchase order. You can also revise blanket or contract purchase agreements. When you make changes to a purchase order or release, Purchasing’s change order workflow processes determine whether or not the changes require reapproval and, if so, route the document for the necessary reapprovals. See: Workflow Processes for Approving Change Orders: page C – 171.

To add on–line requisition lines to an existing standard purchase order or release, use AutoCreate. You can add requisition lines as a new purchase order line or add to an existing purchase order line. See: Autocreate Document Options: page 6 – 4.

When you change a purchase order, Purchasing automatically increments the revision number. See: Document Revision Rules: page 4 – 125.

Shipment Schedules

You can create purchase order lines that have an unlimited number of ship-to locations and delivery dates. Each shipment line has a Ship–To Organization and Location, Promise–By Date, Need–By Date, and Last Accept Date. You receive goods and services against each shipment line.

Acceptances

You can enter purchase order acceptances to verify that your suppliers have agreed to and accepted the details on the purchase orders you send to them. See: Entering Purchase Order Acceptances: page 4 – 84.

Line Types

Purchasing uses Line Types to distinguish between items you order by quantity and price, and services that you order by amount. Line Types also serve to identify outside processing services for which Work in Process creates requisitions. See: Defining Line Types: page 1 – 84.
Approving Purchase Orders

Purchasing checks purchase orders for accuracy and completeness before printing. You can submit purchase orders to the approval process from the Purchase Orders window before you print them. Also, you can use the Notifications Summary window to submit purchase orders for approval. See: Submitting a Document for Approval: page 2 – 35. See: Viewing and Responding to Notifications: page 2 – 31.

You can also assign an authorization limit to each buyer and decide whether you want to enforce this limit whenever any buyer approves a purchase order. See: Overview of Purchasing Options: page 1 – 45. See: Defining Buyers: page 1 – 27.

Printing Purchase Orders

You can print purchase orders at the time you approve them. (See: Submitting a Document for Approval: page 2 – 35.) You can reprint purchase orders as often as you want using the Submit Requests window (See: Submitting a Request, Oracle Applications System Administrator’s Guide). You can choose from the following options:

- Print all new and changed purchase orders
- Print all changed purchase orders
- Print all new purchase orders
- Print a particular purchase order or range of purchase orders
- Print a test purchase order
- Landscape or portrait format

You can also print purchase orders, change orders, and RFQs in other languages, if you use Multilingual Support (MLS). See: Printed Purchase Order Overview: page 4 – 109.

You can send facsimiles of printed purchase orders and change orders if CommercePath is installed. You can send the facsimiles at the time you approve the purchase orders, or when you submit the printed purchase order or change order reports. See: Submitting a Document for Approval: page 2 – 35. See: Printed Purchase Order Overview: page 4 – 109.
Copying Purchase Orders

You can copy one purchase order to another. For example, if you want to renew a blanket purchase agreement with hundreds of lines, you can copy the previous agreement to a new document and change the effectivity dates. You can copy the following purchase order types:

- Standard purchase orders
- Blanket purchase agreements
- Planned purchase orders


Cancelling Purchase Orders

Purchasing lets you cancel a purchase order or purchase order line after you have approved it. When you cancel a purchase order or purchase order line, you pay only for those goods you received before cancellation, and you can optionally reassign any unfilled requisitions to another purchase order. See: Controlling Documents: page 2 – 55.

If you are using encumbrance or budgetary control and if you choose to cancel referencing requisitions, Purchasing creates negative debit entries in your general ledger system to cancel the encumbrance associated with the purchase order. Purchasing recreates requisition encumbrances for the requisition lines you used to create the purchase order, using the distributions from your cancelled purchase order. See: Budgetary Control and Online Funds Checking, Oracle Public Sector General Ledger User’s Guide.

Closing and Final Closing Purchase Orders

Purchasing lets you automatically close a purchase order once you have received and paid for all items you ordered. This feature lets you concentrate on those purchase orders that are overdue or partially received. You can also manually close purchase orders at any time. Of course, you always have the option to review or reopen a purchase order by adding new lines or creating additional receipt transactions until the purchase order is final closed. See: Controlling Documents: page 2 – 55.

If you designate an invoice as the final match to a purchase order, Payables final closes the purchase order shipment during Approval. You cannot update the status of a final–closed purchase order. See: Approval, Oracle Public Sector Payables User’s Guide.
If you are using encumbrance or budgetary control and if you choose to cancel referencing requisitions, Purchasing automatically creates credit entries in your general ledger system to reverse the encumbrance that corresponds to the purchase order are final closing. See: Budgetary Control and Online Funds Checking, Oracle Public Sector General Ledger User’s Guide.

Close for Receiving and Close for Invoicing

Purchasing automatically closes shipments for receiving and invoicing based on controls that you specify in the Purchasing Options window. Once all shipments for a given line are closed, Purchasing automatically closes the line. When all lines for a given header are closed, Purchasing automatically closes the document.

You can specify closing controls including: Receipt Close Tolerance, Receipt Close Point, and Invoice Close Tolerance. See: Defining Purchasing Options: page 1 – 45.

Note: The Close for Invoicing status does not prevent you from matching an invoice to a purchase order or a receipt.

Holding and Freezing Purchase Orders

Purchasing lets you freeze a purchase order so that you can prevent changes or additions to it, but still receive and pay for goods already ordered. You can easily control your purchase order changes because you can freeze or unfreeze a purchase order when appropriate. Likewise, you can place a purchase order on hold to prevent all actions until you remove the order from hold. See: Controlling Documents: page 2 – 55.

Notification Controls (Using Oracle Alert)

For planned purchase orders, blanket purchase agreements, and contracts, you can establish expiration and release control notification conditions and specify the number of days before the condition is met that you want to be notified. In the Notification Controls window, accessible through the Purchase Orders window, you can specify the following notification conditions:

• Amount released by date
• Amount not released by date
• Amount not released

4 – 10 Oracle Public Sector Purchasing User’s Guide
• Amount released
• Expiration date

When the notification conditions are met, Purchasing sends you an Alert (or email) so that you can take appropriate action. See: Entering Purchase Order Notification Controls: page 4 – 82. See: Using Oracle Alert in Oracle Public Sector Purchasing: page B – 2.

**Quick Access to Particular Purchase Orders**

You can place purchase orders that you reference frequently in the Oracle Applications Navigator. Placing documents in the Navigator is useful when you need to query large documents with multiple lines, shipments, or distributions. When the purchase order is open, choose Place on Navigator from the Action menu. When you choose the Documents tabbed region in the Navigator, you can then access that document directly from within the Navigator. You can also do this with requisitions. See: Using the Navigator’s Documents Region, Oracle Applications User’s Guide.

**Note:** Once you place a document in the Navigator, it is the first thing you see in the Navigator the next time you log into Purchasing. Choose Functions to return to the Purchasing menu.

**Viewing Changes to Purchase Orders**

You can view at a glance all past revisions made to archived purchase orders through the PO Change History menu item in the Oracle Public Sector Purchasing Navigator. See: Viewing Purchase Order Changes: page 8 – 4.
Purchase Order Defaulting Rules

Purchasing uses a comprehensive defaulting mechanism to provide most required purchase order information and minimize document creation time. For example, when you are entering a standard purchase order and you want only one shipment and distribution for each purchase order line, you do not need to navigate beyond the Lines tabbed region unless you want to change the default information in the shipments and distributions that Purchasing automatically creates. If you are creating an outside processing line, you must go to the Distributions window to enter outside processing information. Finally, note that the Account Generator may be unable to build accounts for a number of reasons, for example, if you have entered a one-time item. In this case, you must enter distributions in the Distributions window.

Purchase Order Default Matrix Conventions

The Purchase Order Default Matrix uses the following conventions:

- "Default" in this context means that Purchasing provides this information for you. It does not mean that you can always change the defaulted information.

- When options are listed as 1–2–3, Purchasing looks first for the option specified as 3. If new information is provided, or if information is not available in this source, Purchasing uses the next source. For example, when defaulting the currency to a standard purchase order header, Purchasing first provides the currency specified in the Financials Options window. When you specify a supplier, Purchasing updates the currency based on the supplier’s default currency. Finally, when you specify a supplier site, Purchasing updates the currency accordingly.

- For Releases, “Source Agreement” refers to Blanket Purchase Agreements or Planned Purchase Orders, as appropriate.

- The Last Acceptance Date is calculated using the Promised Date if available. Otherwise, Purchasing uses the Need–By date.

- Purchasing provides a GL Date only if you are using encumbrance.

- The following abbreviations are used in the matrix:
  - OSP  Outside Processing
  - PO Opt  Purchasing Options
<table>
<thead>
<tr>
<th>Header</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purchase Order Type</strong></td>
<td>Value = “Standard”</td>
<td></td>
<td></td>
<td></td>
<td>Value = “Blanket”</td>
</tr>
<tr>
<td><strong>Buyer</strong></td>
<td>User name (must be buyer)</td>
<td>User name (must be buyer)</td>
<td>User name (must be buyer)</td>
<td>User name (must be buyer)</td>
<td>User name (must be buyer)</td>
</tr>
<tr>
<td><strong>Currency – 1</strong></td>
<td>Set of Books</td>
<td>Set of Books</td>
<td>Set of Books</td>
<td>Set of Books</td>
<td>Source Agreement (not changeable)</td>
</tr>
<tr>
<td><strong>Currency – 2</strong></td>
<td>Supplier</td>
<td>Supplier</td>
<td>Supplier</td>
<td>Supplier</td>
<td></td>
</tr>
<tr>
<td><strong>Currency – 3</strong></td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td></td>
</tr>
<tr>
<td><strong>Supplier</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Source Agreement (not changeable)</td>
</tr>
<tr>
<td><strong>Supplier Site</strong></td>
<td>From supplier if only 1 “Purchasing” site exists</td>
<td>From supplier if only 1 “Purchasing” site exists</td>
<td>From supplier if only 1 “Purchasing” site exists</td>
<td>From supplier if only 1 “Purchasing” site exists</td>
<td>Source Agreement (not changeable)</td>
</tr>
<tr>
<td><strong>Supplier Contact</strong></td>
<td>From site if only 1 contact exists</td>
<td>From site if only 1 contact exists</td>
<td>From site if only 1 contact exists</td>
<td>From site if only 1 contact exists</td>
<td>Source Agreement (not changeable)</td>
</tr>
<tr>
<td><strong>Confirm Order</strong></td>
<td>Value = “No”</td>
<td>Value = “No”</td>
<td>Value = “No”</td>
<td>Value = “No”</td>
<td></td>
</tr>
<tr>
<td><strong>Ship To Location – 1</strong></td>
<td>Financials Options</td>
<td>Financials Options</td>
<td>Financials Options</td>
<td>Financials Options</td>
<td>Source Agreement (not changeable)</td>
</tr>
<tr>
<td><strong>Ship To – 2</strong></td>
<td>Supplier</td>
<td>Supplier</td>
<td>Supplier</td>
<td>Supplier</td>
<td></td>
</tr>
<tr>
<td><strong>Ship To – 3</strong></td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td></td>
</tr>
<tr>
<td><strong>Bill To Location – 1</strong></td>
<td>Financials Options</td>
<td>Financials Options</td>
<td>Financials Options</td>
<td>Financials Options</td>
<td>Source Agreement (not changeable)</td>
</tr>
<tr>
<td><strong>Bill To – 2</strong></td>
<td>Supplier</td>
<td>Supplier</td>
<td>Supplier</td>
<td>Supplier</td>
<td></td>
</tr>
<tr>
<td><strong>Bill To – 3</strong></td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td></td>
</tr>
<tr>
<td><strong>Payment Terms – 1</strong></td>
<td>Financials Options</td>
<td>Financials Options</td>
<td>Financials Options</td>
<td>Financials Options</td>
<td>Source Agreement (not changeable)</td>
</tr>
<tr>
<td><strong>Pay Terms – 2</strong></td>
<td>Supplier</td>
<td>Supplier</td>
<td>Supplier</td>
<td>Supplier</td>
<td></td>
</tr>
<tr>
<td><strong>Pay Terms – 3</strong></td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td></td>
</tr>
<tr>
<td><strong>Freight Terms – 1</strong></td>
<td>Financials Options</td>
<td>Financials Options</td>
<td>Financials Options</td>
<td>Financials Options</td>
<td>Source Agreement (not changeable)</td>
</tr>
<tr>
<td><strong>Frt Terms – 2</strong></td>
<td>Supplier</td>
<td>Supplier</td>
<td>Supplier</td>
<td>Supplier</td>
<td></td>
</tr>
<tr>
<td><strong>Frt Terms – 3</strong></td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td></td>
</tr>
<tr>
<td><strong>Ship Via – 1</strong></td>
<td>Financials Options</td>
<td>Financials Options</td>
<td>Financials Options</td>
<td>Financials Options</td>
<td>Source Agreement (not changeable)</td>
</tr>
<tr>
<td><strong>Ship Via – 2</strong></td>
<td>Supplier</td>
<td>Supplier</td>
<td>Supplier</td>
<td>Supplier</td>
<td></td>
</tr>
<tr>
<td><strong>Ship Via – 3</strong></td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td></td>
</tr>
<tr>
<td><strong>FOB – 1</strong></td>
<td>Financials Options</td>
<td>Financials Options</td>
<td>Financials Options</td>
<td>Financials Options</td>
<td>Source Agreement (not changeable)</td>
</tr>
</tbody>
</table>

Table 4 – 2  (Page 1 of 2)
<table>
<thead>
<tr>
<th>Header</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>FOB – 2</td>
<td>Supplier</td>
<td>Supplier</td>
<td>Supplier</td>
<td>Supplier</td>
<td></td>
</tr>
<tr>
<td>FOB – 3</td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td></td>
</tr>
<tr>
<td>Rate Type</td>
<td>Purchasing Options</td>
<td>Purchasing Options</td>
<td>Purchasing Options</td>
<td>Purchasing Options</td>
<td>Source Agreement</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(not changeable)</td>
</tr>
<tr>
<td>Effective Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expiration Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Minimum Release Amount</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Notification Control</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expiration Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Acceptance Required</td>
<td>Value = “No”</td>
<td>Value = “No”</td>
<td>Value = “No”</td>
<td>Value = “No”</td>
<td>Source Agreement</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(not changeable)</td>
</tr>
<tr>
<td>Release Number</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Existing number + 1</td>
</tr>
<tr>
<td>Release Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Today’s date</td>
</tr>
</tbody>
</table>

Table 4 – 2 (Page 2 of 2)

<table>
<thead>
<tr>
<th>Line Type</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Type</td>
<td>Purchasing Options</td>
<td>Purchasing Options</td>
<td>Purchasing Options</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Category – 1</td>
<td>Line Type</td>
<td>Line Type</td>
<td>Line Type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Category – 2</td>
<td>Item</td>
<td>Item</td>
<td>Item</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UOM – 1</td>
<td>Line Type</td>
<td>Line Type</td>
<td>Line Type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UOM – 2</td>
<td>Item</td>
<td>Item</td>
<td>Item</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unit Price – 1</td>
<td>Line Type</td>
<td>Line Type</td>
<td>Line Type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unit Price – 2</td>
<td>List Price</td>
<td>List Price</td>
<td>List Price</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unit Price – 3</td>
<td>Source document specified in Supplier–Item Attributes window</td>
<td>Source document specified in Supplier–Item Attributes window</td>
<td>Source document specified in Supplier–Item Attributes window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UN Number</td>
<td>Item</td>
<td>Item</td>
<td>Item</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hazard Class</td>
<td>Item</td>
<td>Item</td>
<td>Item</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OSP UOM Type</td>
<td>Item</td>
<td>Item</td>
<td>Item</td>
<td></td>
<td></td>
</tr>
<tr>
<td>List Price</td>
<td>Item</td>
<td>Item</td>
<td>Item</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 4 – 3 (Page 1 of 2)
<table>
<thead>
<tr>
<th>Line</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Market Price</td>
<td>Item</td>
<td>Item</td>
<td>Item</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Price Type</td>
<td>PO Preferences</td>
<td>PO Preferences</td>
<td>PO Preferences</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allow Price Override</td>
<td>Value = “No”</td>
<td>Value = “No”</td>
<td></td>
<td></td>
<td>Source Agreement (not changeable)</td>
</tr>
<tr>
<td>Promised Date</td>
<td>PO Preferences</td>
<td>PO Preferences</td>
<td>PO Preferences</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Need–By Date</td>
<td>PO Preferences</td>
<td>PO Preferences</td>
<td>PO Preferences</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transaction Nature</td>
<td>PO Preferences</td>
<td>PO Preferences</td>
<td>PO Preferences</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Price Break Type</td>
<td></td>
<td></td>
<td></td>
<td>PO Preferences</td>
<td></td>
</tr>
</tbody>
</table>

Table 4 – 3  (Page 2 of 2)

<table>
<thead>
<tr>
<th>Shipment</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ship–To Organization – 1</td>
<td>Financial System Options</td>
<td>Financial System Options</td>
<td>Agreement Header’s Ship–To locations organization</td>
<td>Source Agreement (not changeable) (blanket releases only)</td>
<td></td>
</tr>
<tr>
<td>Ship–To Org – 2</td>
<td>PO Preferences – Validated against item</td>
<td>PO Preferences – Validated against item</td>
<td>Agreement Header’s Ship–To locations organization</td>
<td>PO Preferences – Validated against item (blanket releases only)</td>
<td></td>
</tr>
<tr>
<td>Ship–To Org – 3</td>
<td>PO Preferences – Validated against validated organization</td>
<td>PO Preferences – Validated against validated organization</td>
<td>Agreement Header</td>
<td>Source Agreement (not changeable)</td>
<td></td>
</tr>
<tr>
<td>Ship–To Location</td>
<td>PO Preferences – Validated against validated organization</td>
<td>PO Preferences – Validated against validated organization</td>
<td>Agreement Header</td>
<td>Source Agreement (not changeable)</td>
<td></td>
</tr>
<tr>
<td>Promised Date – 1</td>
<td>Lines</td>
<td>Lines</td>
<td>Lines</td>
<td>Lines</td>
<td></td>
</tr>
<tr>
<td>Promised Date – 2</td>
<td>PO Preferences</td>
<td>PO Preferences</td>
<td>PO Preferences</td>
<td>PO Preferences</td>
<td></td>
</tr>
<tr>
<td>Need–By Date – 1</td>
<td>Lines</td>
<td>Lines</td>
<td>Lines</td>
<td>Lines</td>
<td></td>
</tr>
<tr>
<td>Need–By Date – 2</td>
<td>PO Preferences</td>
<td>PO Preferences</td>
<td>PO Preferences</td>
<td>PO Preferences</td>
<td></td>
</tr>
<tr>
<td>Receipt Close Tolerance – 1</td>
<td>Purchasing Options</td>
<td>Purchasing Options</td>
<td>Purchasing Options</td>
<td>Purchasing Options</td>
<td></td>
</tr>
<tr>
<td>Receipt Close – 2</td>
<td>Line Type</td>
<td>Line Type</td>
<td>Line Type</td>
<td>Line Type</td>
<td></td>
</tr>
<tr>
<td>Receipt Close – 3</td>
<td>Item</td>
<td>Item</td>
<td>Item</td>
<td>Item</td>
<td></td>
</tr>
<tr>
<td>Invoice Close Tolerance – 1</td>
<td>Purchasing Options</td>
<td>Purchasing Options</td>
<td>Purchasing Options</td>
<td>Purchasing Options</td>
<td></td>
</tr>
<tr>
<td>Invoice Close – 2</td>
<td>Item</td>
<td>Item</td>
<td>Item</td>
<td>Item</td>
<td></td>
</tr>
</tbody>
</table>

Table 4 – 4  (Page 1 of 3)
<table>
<thead>
<tr>
<th>Shipment</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invoice Matching (2, 3, 4 Way) – 1</td>
<td>Purchasing Options</td>
<td>Purchasing Options</td>
<td></td>
<td></td>
<td>Purchasing Options</td>
</tr>
<tr>
<td>Invoice Match – 2</td>
<td>Line Type</td>
<td>Line Type</td>
<td></td>
<td>Line Type</td>
<td></td>
</tr>
<tr>
<td>Invoice Match – 3</td>
<td>Item</td>
<td>Item</td>
<td></td>
<td>Item</td>
<td></td>
</tr>
<tr>
<td>Accrue on Receipt – 1</td>
<td>Else = Receipt Required Value</td>
<td>Else = Receipt Required Value</td>
<td></td>
<td>Else = Receipt Required Value</td>
<td></td>
</tr>
<tr>
<td>Accrue on Rct – 2</td>
<td>No, if PO Opt expense accrual is “Period End”</td>
<td>No, if PO Opt expense accrual is “Period End”</td>
<td></td>
<td>No, if PO Opt expense accrual is “Period End”</td>
<td></td>
</tr>
<tr>
<td>Accrue on Rct – 3</td>
<td>Yes, if item is stockable in ship-to organization</td>
<td>Yes, if item is stockable in ship-to organization</td>
<td></td>
<td>Yes, if item is stockable in ship-to organization</td>
<td></td>
</tr>
<tr>
<td>Accrue on Rct – 4</td>
<td>Yes, if line type is OSP</td>
<td>Yes, if line type is OSP</td>
<td></td>
<td>Yes, if line type is OSP</td>
<td></td>
</tr>
<tr>
<td>Taxable</td>
<td>Taxable is selected if there is a Tax Code</td>
<td>Taxable is selected if there is a Tax Code</td>
<td></td>
<td>Taxable is selected if there is a Tax Code</td>
<td></td>
</tr>
<tr>
<td>Tax Code – 1</td>
<td>Tax Defaults in Purchasing Options window</td>
<td>Tax Defaults in Purchasing Options window</td>
<td></td>
<td>Tax Defaults in Purchasing Options window</td>
<td></td>
</tr>
<tr>
<td>Tax Code – 2</td>
<td></td>
<td></td>
<td></td>
<td>Tax Code from planned purchase order shipment</td>
<td></td>
</tr>
<tr>
<td>Tax Code – 3</td>
<td>Purchasing Order Preferences</td>
<td>Purchase Order Preferences</td>
<td></td>
<td>Purchase Order Preferences</td>
<td></td>
</tr>
<tr>
<td>Enforce Ship-To Location – 1</td>
<td>Receiving Options</td>
<td>Receiving Options</td>
<td></td>
<td>Receiving Options</td>
<td></td>
</tr>
<tr>
<td>Enforce Ship-To – 2</td>
<td>Supplier</td>
<td>Supplier</td>
<td></td>
<td>Supplier</td>
<td></td>
</tr>
<tr>
<td>Enforce Ship-To – 3</td>
<td>Item</td>
<td>Item</td>
<td></td>
<td>Item</td>
<td></td>
</tr>
<tr>
<td>Allow Substitute Receipts – 1</td>
<td>Receiving Options</td>
<td>Receiving Options</td>
<td></td>
<td>Receiving Options</td>
<td></td>
</tr>
<tr>
<td>Substitute Rct – 2</td>
<td>Supplier</td>
<td>Supplier</td>
<td></td>
<td>Supplier</td>
<td></td>
</tr>
<tr>
<td>Substitute Rct – 3</td>
<td>Item</td>
<td>Item</td>
<td></td>
<td>Item</td>
<td></td>
</tr>
<tr>
<td>Receipt Routing – 1</td>
<td>Receiving Options</td>
<td>Receiving Options</td>
<td></td>
<td>Receiving Options</td>
<td></td>
</tr>
<tr>
<td>Receipt Routing – 2</td>
<td>Supplier</td>
<td>Supplier</td>
<td></td>
<td>Supplier</td>
<td></td>
</tr>
<tr>
<td>Receipt Routing – 3</td>
<td>Item</td>
<td>Item</td>
<td></td>
<td>Item</td>
<td></td>
</tr>
<tr>
<td>Quantity Received Tolerance – 1</td>
<td>Receiving Options</td>
<td>Receiving Options</td>
<td></td>
<td>Receiving Options</td>
<td></td>
</tr>
<tr>
<td>Qty Received – 2</td>
<td>Supplier</td>
<td>Supplier</td>
<td></td>
<td>Supplier</td>
<td></td>
</tr>
<tr>
<td>Qty Received – 3</td>
<td>Item</td>
<td>Item</td>
<td></td>
<td>Item</td>
<td></td>
</tr>
<tr>
<td>Quantity Received Exception – 1</td>
<td>Receiving Options</td>
<td>Receiving Options</td>
<td></td>
<td>Receiving Options</td>
<td></td>
</tr>
</tbody>
</table>

Table 4 – 4  (Page 2 of 3)
<table>
<thead>
<tr>
<th>Shipment</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rcvd Exception – 2</td>
<td>Supplier</td>
<td>Supplier</td>
<td></td>
<td>Supplier</td>
<td>Supplier</td>
</tr>
<tr>
<td>Rcvd Exception – 3</td>
<td>Item</td>
<td>Item</td>
<td></td>
<td>Item</td>
<td>Item</td>
</tr>
<tr>
<td>Days Early Receipt Allowed – 1</td>
<td>Receiving Options</td>
<td>Receiving Options</td>
<td></td>
<td>Receiving Options</td>
<td></td>
</tr>
<tr>
<td>Days Early Rct – 2</td>
<td>Supplier</td>
<td>Supplier</td>
<td></td>
<td>Supplier</td>
<td>Supplier</td>
</tr>
<tr>
<td>Days Early Rct – 3</td>
<td>Item</td>
<td>Item</td>
<td></td>
<td>Item</td>
<td>Item</td>
</tr>
<tr>
<td>Days Late Receipt Allowed – 1</td>
<td>Receiving Options</td>
<td>Receiving Options</td>
<td></td>
<td>Receiving Options</td>
<td></td>
</tr>
<tr>
<td>Days Late Rct – 2</td>
<td>Supplier</td>
<td>Supplier</td>
<td></td>
<td>Supplier</td>
<td>Supplier</td>
</tr>
<tr>
<td>Days Late Rct – 3</td>
<td>Item</td>
<td>Item</td>
<td></td>
<td>Item</td>
<td>Item</td>
</tr>
<tr>
<td>Last Accept Date</td>
<td>Promised Date or Need By Date + Late Receipt Tolerance</td>
<td>Promised Date or Need By Date + Late Receipt Tolerance</td>
<td></td>
<td>Promised Date or Need By Date + Late Receipt Tolerance</td>
<td></td>
</tr>
<tr>
<td>Receipt Date Exception – 1</td>
<td>Receiving Options</td>
<td>Receiving Options</td>
<td></td>
<td>Receiving Options</td>
<td></td>
</tr>
<tr>
<td>Receipt Dte Exc – 2</td>
<td>Supplier</td>
<td>Supplier</td>
<td></td>
<td>Supplier</td>
<td>Supplier</td>
</tr>
<tr>
<td>Receipt Dte Exc – 3</td>
<td>Item</td>
<td>Item</td>
<td></td>
<td>Item</td>
<td>Item</td>
</tr>
<tr>
<td>Shipment Price</td>
<td>Source Agreement (not changeable)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Country of Origin – 1</td>
<td>Supplier Site</td>
<td>Supplier Site</td>
<td></td>
<td>Supplier Site</td>
<td></td>
</tr>
<tr>
<td>Cntry of Origin – 2</td>
<td>Approved Supplier List</td>
<td>Approved Supplier List</td>
<td></td>
<td>Approved Supplier List (blanket releases only)</td>
<td></td>
</tr>
</tbody>
</table>

Table 4 – 4  (Page 3 of 3)

<table>
<thead>
<tr>
<th>Distribution</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination Type – 1</td>
<td>If line type is OSP = “Shop Floor”</td>
<td>If line type is OSP = “Shop Floor”</td>
<td></td>
<td>If line type is OSP = “Shop Floor”</td>
<td></td>
</tr>
<tr>
<td>Destination Type – 2</td>
<td>If item stockable in ship–to org, = “Inventory”</td>
<td>If item stockable in ship–to org, = “Inventory”</td>
<td></td>
<td>If item stockable in ship–to org, = “Inventory”</td>
<td></td>
</tr>
<tr>
<td>Destination Type – 3</td>
<td>If item stockable in ship–to org, and purchasable and Accrue on Receipt is No = “Expense”</td>
<td>If item stockable in ship–to org, and purchasable and Accrue on Receipt is No = “Expense”</td>
<td></td>
<td>If item stockable in ship–to org, and purchasable and Accrue on Receipt is No = “Expense”</td>
<td></td>
</tr>
<tr>
<td>Destination Type – 4</td>
<td>If item is NOT stockable = “Expense”</td>
<td>If item is NOT stockable = “Expense”</td>
<td></td>
<td>If item is NOT stockable = “Expense”</td>
<td></td>
</tr>
</tbody>
</table>

Table 4 – 5  (Page 1 of 2)
<table>
<thead>
<tr>
<th>Distribution</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requestor</td>
<td>PO Preferences</td>
<td>PO Preferences</td>
<td></td>
<td></td>
<td>Requestor’s location</td>
</tr>
<tr>
<td>Deliver–To Location</td>
<td>PO Preferences if valid for ship–to org and item</td>
<td>PO Preferences if valid for ship–to org and item</td>
<td></td>
<td></td>
<td>Requestor’s location</td>
</tr>
<tr>
<td>Location – 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Requestor’s location</td>
</tr>
<tr>
<td>Deliver–To Loc – 2</td>
<td>Requestor’s location</td>
<td>Requestor’s location</td>
<td></td>
<td></td>
<td>Requestor’s location</td>
</tr>
<tr>
<td>Project Details</td>
<td>PO Preferences</td>
<td>PO Preferences</td>
<td></td>
<td></td>
<td>PO Preferences</td>
</tr>
<tr>
<td>Rate Date</td>
<td>PO Header</td>
<td>PO Header</td>
<td></td>
<td></td>
<td>Source Agreement (not changeable)</td>
</tr>
<tr>
<td>GL Date</td>
<td>PO Preferences</td>
<td>PO Preferences</td>
<td></td>
<td></td>
<td>Today’s date if in valid period; else null</td>
</tr>
<tr>
<td>Accounts</td>
<td>Account Generator</td>
<td>Account Generator</td>
<td></td>
<td></td>
<td>Account Generator</td>
</tr>
<tr>
<td>Recovery Rate</td>
<td>Tax Code</td>
<td>Tax Code</td>
<td></td>
<td></td>
<td>Tax Code</td>
</tr>
<tr>
<td>Requisition Information – 1</td>
<td>PO Preferences</td>
<td>PO Preferences</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Requisition Information – 2</td>
<td>Source Requisition (Online)</td>
<td>Source Requisition (Online)</td>
<td></td>
<td></td>
<td>Source Requisition (Online)</td>
</tr>
</tbody>
</table>

Table 4 – 5  (Page 2 of 2)

See Also

Defining Financials Options, *Oracle Public Sector Payables User’s Guide*

About Suppliers, *Oracle Public Sector Payables User’s Guide*


Using the Account Generator in Oracle Public Sector Purchasing: page C – 10

Defining Purchasing Options: page 1 – 45

Defining Receiving Options: page 1 – 58

Profile Options in Purchasing: page 1 – 103

Entering Purchase Order Shipments: page 4 – 63

Entering Purchase Order Distributions: page 4 – 74
Finding Purchase Orders

Use the Find Purchase Orders window to:

- Access the Purchase Orders window.
- Access the Releases window.
- Perform purchase order inquiries at header, line, shipment, and distribution levels

Depending on the function security assigned to your responsibility, you have varying levels of access to information. A responsibility defines an application user’s current privileges while working with Oracle Applications.

See Also

Overview of Function Security, Oracle Applications System Administrator’s Guide

Function Security for Purchasing: page 1 – 112

- To enter search criteria:

  1. Navigate to the Find Purchase Orders window by selecting Purchase Order Summary from the menu. Enter desired search criteria as described in the following steps.
2. Enter the purchase order number. If you enter a purchase order number, you can also enter a Release, Line, and/or Shipment number for the purchase order.

3. Select the View Releases check box to include all associated releases for blanket purchase agreements and planned purchase orders. Purchasing automatically selects this check box if you specify selection criteria for which it would be required (for example, if you select Scheduled Releases as the purchase order Type). This check box is not available when inappropriate (for example, if you select Standard PO as the purchase order Type).

4. Select the purchase order Type (Standard purchase order, Blanket purchase agreement, Planned purchase order, Contract purchase agreement, Blanket Release, or Scheduled Release).

5. Enter the Currency.

6. Enter the Supplier. If you enter a supplier, you can also enter a supplier Site.
7. Enter the Ship To Organization.
8. Enter the Ship To location.
9. Enter the Bill To location.
10. Enter the Buyer.
11. Enter the Line Type.
12. Use the tabbed regions to further restrict the search:
   • In the Item region, you can enter the following search criteria: Item number, Revision number, Category, item Description, and Supplier Item Number.
   • In the Date Ranges region, you can enter date ranges for the following dates: Order, Approved, Promised, Need By, and Closed.
   • In the Status region, you can limit the search by:
     – Order Approval status (Approved, In Process, Incomplete, Pre–Approved, Rejected, or Requires Reapproval)
     – Control status (Open, Closed, Finally Closed, Closed for Invoicing, Closed for Receiving, or Cancelled)
     – Hold status (Yes or No)
     – Frozen status (Yes or No)
     – Firmed status (Yes or No)
   • In the Related Documents region, you can limit the search by Supplier Quote number, Quote number, Quote Line number, Requisition number, Receipt number, Contract number, Invoice number, and Paper Requisition number.
   • In the Deliver To region, you can limit the search by destination Type (Expense, Inventory, Shop Floor), Deliver To Person, Organization, Location, and Subinventory.
   • In the Accounting region, you can limit the search by Period, GL Date, Charge Account, Budget Account, and whether there are Active Encumbrances (Yes or No).
   • In the Projects region, you can limit the search by Project or Task number.
13. Select the Results summary window (Headers, Lines, Shipments, or Distributions). Depending on the search criteria you have specified, all summary windows may not be available. For
example, if you specify criteria in the Accounting region, only the Purchase Order Distributions summary window is available.

14. Select the Find button to initiate the search and open the appropriate summary window.

To clear existing search criteria:
- Select the Clear button to clear any existing search criteria.

To enter a new release:

To enter a new purchase order:
- Select the New PO button to open the Purchase Orders window. See: Entering Purchase Order Headers: page 4 – 39.
To enter purchase order preferences:

- Select Preferences on the Tools menu to open the Purchase Order Preferences window. See: Entering Purchase Order Preferences: page 4 – 34.

See Also

Overview of Purchase Orders: page 4 – 3
Using the Purchase Order Headers Summary Window: page 4 – 23
Using the Purchase Order Lines Summary Window: page 4 – 26
Using the Purchase Order Shipments Summary Window: page 4 – 29
Using the Purchase Order Distributions Summary Window: page 4 – 32

Using the Purchase Order Headers Summary Window

Use the Purchase Order Headers results folder window to:

- View purchase order header information.
- Drill down to view purchase order line, shipment, and distribution information.
- Access the Purchase Orders and Releases windows for entry and update of documents.
- Access other windows from the Tools menu.

To navigate to the Purchase Order Headers results window:

- In the Find Purchase Orders window, select Headers in the Results region and select the Find button to open the Purchase Order Headers folder window.

To drill down to view purchase order line information:

- Select the Lines button to drill down to the Purchase Order Lines results folder window. You can also select View Lines on the Tools menu to open this window. See: Using the Purchase Order Lines Summary Window: page 4 – 26.
To enter a new release:

- Select the New Release button to open the Releases window. If the current record is a blanket purchase agreement or a planned purchase order, then you can create a release against it.

Attention: Depending on how the Function Security is set for your user responsibility, you may not have access to the New Release button. (With Function Security, a system administrator can limit people’s access to this function.)

To enter a new purchase order:

- Select the New PO button to open the Purchase Orders window. See: Entering Purchase Order Headers: page 4–39.

Attention: Depending on how the Function Security is set for your user responsibility, you may not have access to the New PO button. (With Function Security, a system administrator can limit people’s access to this function.)

To open the Purchase Orders or Releases window for the current order:

- Select the Open button to open the Purchase Orders window and query the purchase order on the current line. If the current order is for a blanket or scheduled release, Purchasing opens the Releases window and queries the current order. Your options in this window depend on the status of the order and your approval and security options. See: Entering Purchase Order Headers: page 4–39.

Attention: Depending on how the Function Security is set for your user responsibility, you may not have access to the Open button. (With Function Security, a system administrator can limit people’s access to this function.)

To drill down to view purchase order shipment information:

To drill down to view purchase order distributions information:

- Select View Distributions on the Tools menu to open the Purchase Order Distributions results folder window. See: Using the Purchase Order Distributions Summary Window: page 4 – 32.

To view acceptances:


To enter acceptances:

- Select Enter Acceptances on the Tools menu to open the Enter Acceptances window. See: Entering and Viewing Purchase Order Acceptances: page 4 – 84.

To view action history:

- Select View Action History on the Tools menu to open the Action History window. See: Viewing Action History: page 8 – 2.

To view invoices:

- Select View Invoices on the Tools menu to view invoice information: See: Invoice Overview, Oracle Public Sector Payables User’s Guide.

To view receipts:

- Select View Receipts on the Tools menu to open the Find Receiving Transactions window. See: Finding Receiving Transactions (Summary): page 7 – 47.

To enter purchase order control information:

- Select Control on the Tools menu to open the Control Document window. See: Controlling Documents: page 2 – 55.

To enter purchase order preferences:

- Select Preferences on the Tools menu to open the Purchase Order Preferences window. See: Entering Purchase Order Preferences: page 4 – 34.
To view procurement card information:

- In the Purchase Order Headers summary window, which is a folder window, display the hidden field P–Card Number. See: Procurement Card Purchase Orders and Releases: page 4 – 143.

See Also

Customizing the Presentation of Data in a Folder, Oracle Applications User’s Guide

Overview of Purchase Orders: page 4 – 3
Finding Purchase Orders: page 4 – 19
Using the Purchase Order Lines Summary Window: page 4 – 26
Using the Purchase Order Shipments Summary Window: page 4 – 29
Using the Purchase Order Distributions Summary Window: page 4 – 32

Using the Purchase Order Lines Summary Window

Use the Purchase Order Lines results folder window to:

- View purchase order line information.
- Drill down to view purchase order shipment and distribution information.
- Access the Purchase Orders and Releases windows for entry and update of documents.
- Access other windows from the Tools menu.

To navigate to the Purchase Order Lines results window:

- In the Find Purchase Orders window, select Lines in the Results region and select the Find button to open the Purchase Order Lines folder window. You can also navigate to this window by selecting View Lines on the Tools menu in the Purchase Order Headers results folder window.

To drill down to view purchase order shipment information:

- Select the Shipments button to drill down to the Purchase Order Shipments results folder window. You can also select View
Shipments on the Tools menu to open this window. See: Using the Purchase Order Shipments Summary Window: page 4 – 29.

► To enter a new release:
  ▪ Select the New Release button to open the Releases window. If the current record is a blanket purchase agreement or a planned purchase order, then you can create a release against it.

► To enter a new purchase order:
  ▪ Select the New PO button to open the Purchase Orders window. See: Entering Purchase Order Headers: page 4 – 39.

► To open the Purchase Orders or Releases window for the current line:
  ▪ Select the Open button to open the Purchase Orders window and query the purchase order on the current line. If the current line is for a blanket or scheduled release, Purchasing opens the Releases window and queries the current line. Your options in this window depend on the status of the order and your approval and security options. See: Entering Purchase Order Headers: page 4 – 39.

► To drill down to view purchase order distributions information:
  ▪ Select View Distributions on the Tools menu to open the Purchase Order Distributions results folder window. See: Using the Purchase Order Distributions Summary Window: page 4 – 32.

► To view acceptances:

► To enter acceptances:
  ▪ Select Enter Acceptances on the Tools menu to open the Enter Acceptances window. See: Entering and Viewing Purchase Order Acceptances: page 4 – 84.

► To view action history:
  ▪ Select View Action History on the Tools menu to open the Action History window. See: Viewing Action History: page 8 – 2.
To view invoices:
- Select Invoices on the Tools menu to view invoice information. See: Invoice Overview, Oracle Public Sector Payables User’s Guide.

To view receipts:
- Select View Receipts on the Tools menu to open the Find Receiving Transactions window. See: Finding Receiving Transactions (Summary): page 7 – 47.

To enter purchase order control information:
- Select Control on the Tools menu to open the Control Document window. See: Controlling Documents: page 2 – 55.

To enter purchase order preferences:
- Select Preferences on the Tools menu to open the Purchase Order Preferences window. See: Entering Purchase Order Preferences: page 4 – 34.

See Also

Customizing the Presentation of Data in a Folder, Oracle Applications User’s Guide
Overview of Purchase Orders: page 4 – 3
Finding Purchase Orders: page 4 – 19
Using the Purchase Order Headers Summary Window: page 4 – 23
Using the Purchase Order Shipments Summary Window: page 4 – 29
Using the Purchase Order Distributions Summary Window: page 4 – 32
Using the Purchase Order Shipments Summary Window

Use the Purchase Order Shipments results folder window to:

- View purchase order shipment information.
- Drill down to view purchase order distribution information.
- Access the Purchase Orders and Releases windows for entry and update of documents.
- Access other windows from the Tools menu.

Note that this window does not display price breaks.

► To navigate to the Purchase Order Shipments results window:

1. In the Find Purchase Orders window, select Shipments in the Results region and select the Find button to open the Purchase Order Shipments folder window. You can also navigate to this window by selecting View Shipments on the Tools menu in the Purchase Order Headers and Purchase Order Lines results folder windows.

► To drill down to view purchase order distribution information:

- Select the Distributions button to drill down to the Purchase Order Distributions results folder window. You can also select View Distributions on the Tools menu to open this window. See: Using the Purchase Order Distributions Summary Window: page 4 – 32.

► To enter a new release:

- Select the New Release button to open the Releases window. If the current record is a blanket purchase agreement or a planned purchase order, then you can create a release against it.

► To enter a new purchase order:

- Select the New PO button to open the Purchase Orders window. See: Entering Purchase Order Headers: page 4 – 39.

► To open the Purchase Orders or Releases window for the current shipment:

- Select the Open button to open the Purchase Orders window and query the purchase order shipment on the current line. If the current shipment is for a blanket or scheduled release, Purchasing
opens the Releases window and queries the current shipment. Your options in this window depend on the status of the order and your approval and security options. See: Entering Purchase Order Headers: page 4 – 39.

► **To view acceptances:**

► **To enter acceptances:**
  - Select Enter Acceptances on the Tools menu to open the Enter Acceptances window. See: Entering and Viewing Purchase Order Acceptances: page 4 – 84.

► **To view action history:**
  - Select View Action History on the Tools menu to open the Action History window. See: Viewing Action History: page 8 – 2.

► **To view invoices:**

► **To view receipts:**
  - Select View Receipts on the Tools menu to open the Find Receiving Transactions window. See: Finding Receiving Transactions (Summary): page 7 – 47.

► **To enter purchase order control information:**
  - Select Control on the Tools menu to open the Control Document window. See: Controlling Documents: page 2 – 55.

► **To enter purchase order preferences:**
  - Select Preferences on the Tools menu to open the Purchase Order Preferences window. See: Entering Purchase Order Preferences: page 4 – 34.
See Also

Customizing the Presentation of Data in a Folder, Oracle Applications User’s Guide
Overview of Purchase Orders: page 4 – 3
Finding Purchase Orders: page 4 – 19
Using the Purchase Order Headers Summary Window: page 4 – 23
Using the Purchase Order Lines Summary Window: page 4 – 26
Using the Purchase Order Distributions Summary Window: page 4 – 32
Using the Purchase Order Distributions Summary Window

Use the Purchase Order Distributions results folder window to:

- View purchase order distribution information.
- Access the Purchase Orders and Releases windows for entry and update of documents.
- Access other windows from the Tools menu.

To navigate to the Purchase Order Distributions results window:

1. In the Find Purchase Orders window, select Distributions in the Results region and select the Find button to open the Purchase Order Distributions folder window. You can also navigate to this window by selecting View Distributions on the Tools menu in the Purchase Order Headers, Purchase Order Lines, and Purchase Order Shipments results folder windows.

To enter a new release:

- Select the New Release button to open the Releases window. If the current record is a blanket purchase agreement or a planned purchase order, then you can create a release against it.

To enter a new purchase order:

- Select the New PO button to open the Purchase Orders window. See: Entering Purchase Order Headers: page 4 – 39.

To open the Purchase Orders or Releases window for the current line:

- Select the Open button to open the Purchase Orders window and query the purchase order on the current line. If the current line is for a blanket or scheduled release, Purchasing opens the Releases window and queries the current line. Your options in this window depend on the status of the order and your approval and security options. See: Entering Purchase Order Headers: page 4 – 39.

To view acceptances:

To enter acceptances:
- Select Enter Acceptances on the Tools menu to open the Enter Acceptances window. See: Entering and Viewing Purchase Order Acceptances: page 4 – 84.

To view action history:
- Select View Action History on the Tools menu to open the Action History window. See: Viewing Action History: page 8 – 2.

To view invoices:
- Select Invoices on the Tools menu to view invoice information: See: Invoice Overview, Oracle Public Sector Payables User’s Guide.

To view receipts:
- Select View Receipts on the Tools menu to open the Find Receiving Transactions window. See: Finding Receiving Transactions (Summary): page 7 – 47.

To enter purchase order preferences:
- Select Preferences on the Tools menu to open the Purchase Order Preferences window. See: Entering Purchase Order Preferences: page 4 – 34.

See Also

Customizing the Presentation of Data in a Folder, Oracle Applications User’s Guide
Overview of Purchase Orders: page 4 – 3
Finding Purchase Orders: page 4 – 19
Using the Purchase Order Headers Summary Window: page 4 – 23
Using the Purchase Order Lines Summary Window: page 4 – 26
Using the Purchase Order Shipments Summary Window: page 4 – 29
Entering Purchase Order Preferences

Use the Purchase Order Preferences window to enter preference information for purchase order lines, shipments, distributions, and releases. You can save time and effort by entering valid default values here. When you save your work in the Lines tabbed region in the Purchase Orders window, Purchasing creates a shipment using the organization and ship-to location if you provided valid values in the defaults region. Then, if it is successful in creating a shipment, Purchasing creates a distribution using these values. Similarly, when you save your work in the Purchase Order Shipments window, Purchasing creates a distribution if it does not already exist and if you provided a valid organization here. You can update these shipments and distributions by navigating to the Purchase Order Shipments or Purchase Order Distributions windows.

Purchasing can create shipments only when it has default information that meets the following criteria:

- There must be an organization and a location.
- The location must belong to the organization or not be assigned to any organization.
- If the line contains an item (and optionally a revision), that item (and revision) must be valid in the default shipment organization.

Purchasing can create distributions only when it has default information that meets the following criteria:

- If the Destination Type is Inventory, the line must have an item that is stock enabled in the ship-to organization. Also, if a default subinventory has been entered, it must be defined in the ship-to organization.
- The Account Generator must be able to supply the accounts. If the Destination Type is Expense, you can enter a default charge account, which overrides any account supplied by the Account Generator.
- If you are using encumbrance accounting, you must enter a default GL date.

Purchasing uses the preferences you enter in this window for the current line and all subsequent purchase order lines that you enter during this user session. Thus, for existing purchase orders, the defaults apply only to new lines, shipments, and distributions that you add during this session. If you want to clear the default information,
either choose Delete Record in the Purchase Order Preferences window or exit the application. The default values are only valid for the session in which you are currently working. They are not saved to the database.

**To enter main preferences:**

1. Navigate to the Purchase Order Preferences window by selecting Preferences on the Tools menu in most of the purchase orders and releases windows.

In the Main tabbed region, you can enter the defaults described in the following steps.

2. Select Confirming Order to indicate that this order is confirming a previous informal order with the supplier.

3. Enter a Price Type from the Lookup Codes window. See: Defining Lookup Codes: page 1 – 74.

4. For planned purchase orders and blanket purchase agreements, enter the Minimum Release Amount for a line.
5. If you are referencing contract purchase agreement on a standard purchase order, enter the Contract number. The contract must be effective; that is, the current date has to be within the effective date and the expired date of the contract.

If you reference a contract purchase agreement on a standard purchase order line, Purchasing adds the total amount of the purchase order line to the total amount of the contract.


7. Enter the Need By date when the requestor needs the item. This date is printed on the purchase order if you do not provide a promised–by date. If you are using Purchasing with Master Scheduling/MRP, you must provide either a need–by date or a promised–by date for shipments that correspond to purchase order lines with Master Scheduling/MRP planned items. A need–by date is also required for Inventory planned items. See: Overview of Implementing Planning Recommendations, Oracle Master Scheduling/MRP and Supply Chain Planning User’s Guide.

8. Enter the Promised By date when the supplier promised delivery of the items. This date is printed on the purchase order.


10. Enter the paper Requisition Number for all distributions. Purchasing automatically copies this number to every distribution you create for this purchase order line. You can later review purchase orders based on paper requisitions using the Find Purchase Orders window. If you enter a requisition number, you can also enter a Requisition Line number. See: Finding Purchase Orders: page 4 – 19.

11. Enter the date you want to post expenses in your General Ledger for every distribution you create for this purchase order line. You can enter a GL Date only if you set up your financials system options to use encumbrance for purchase orders. See: About Financials Options, Oracle Public Sector Payables User’s Guide. See: Budgetary Control and Online Funds Checking, Oracle Public Sector General Ledger User’s Guide.

12. Enter the Accounting Flexfield that you want to charge for the expenses. Purchasing uses the account you enter here only for expense destinations and overrides any account built by the
13. Enter the organization. The List of Values displays all valid receiving organizations.

14. Enter the ship-to location for the shipment.

15. Enter the Destination type to indicate the final destination of the purchased items:

   Expense – The goods are delivered to the requestor at an expense location. The destination subinventory is not applicable.

   Inventory – The goods are received into inventory upon delivery.

16. Enter the Requestor. This is the employee who requests the quantities on the purchase order distribution lines. Purchasing copies this name as the requestor for every distribution you create for this purchase order line.

17. Enter the Deliver To location for all distributions. Purchasing copies this location to every distribution you create for this purchase order line. The default is the requestor’s location. You can pick any location that does not have an organization or any location whose organization matches the ship-to organization. See: the online help for the Enter Person window. See: Defining Locations: page 1 – 24.

18. If the destination type is Inventory, you can enter the Subinventory. See: Defining Subinventories, Oracle Inventory User’s Guide.

➢ To enter project information preferences:

You see a Project Information tabbed region if one of the following is true:

- Oracle Projects is installed, or
- Oracle Project Manufacturing is installed and Project Reference Enabled is selected in the Project Manufacturing Organization Parameters window

The project information you enter is used by Oracle Projects for destination types of Expense, or by Oracle Project Manufacturing for destination types of Inventory or Shop Floor. See: Oracle Projects User’s Guide. See: Oracle Project Manufacturing Implementation Manual.

1. Choose the Project Information tabbed region.

2. Select a Project Number.
For a Destination Type of Inventory or Shop Floor, you can optionally enter a Project Number if the Project Control Level is set to Project in the Project Information tabbed region of the Organization Parameters window.

For a Destination Type of Expense, you can always optionally enter a Project Number.

3. If you entered a Project number, select a Task number.

You must enter a Task number for a Destination Type of Inventory or Shop Floor, if the Project Control Level is set to Task in the Organization Parameters window and if you have entered a Project number.

4. Enter Expenditure information.

Expenditure information is required only if your Destination Type is Expense.

- Select the Expenditure Type.
- If you chose an Expenditure Type, enter an Expenditure Organization.
- If you chose an Expenditure Organization, select the Expenditure Item Date.

To apply your preference changes.

- Select the Apply button to apply your changes.

See Also

Entering Purchase Order Lines: page 4 – 45
Entering Purchase Order Shipments: page 4 – 63
Entering Purchase Order Distributions: page 4 – 74
Overview of Purchasing Options: page 1 – 45
Purchase Order Defaulting Rules: page 4 – 12
Entering Purchase Order Headers

Use the Purchase Orders window to:

- Enter standard and planned purchase orders as well as blanket and contract purchase agreements

  **Note:** You can also receive blanket purchase agreement lines electronically from your suppliers through the Purchasing Documents Open Interface. See: Receiving Price/Sales Catalog Information Electronically: page 5 – 22.

- Enter purchase orders from paper requisitions or without a requisition

- Take approval actions on individual purchase orders and agreements on-line

If you want to create a release against a planned purchase order or a blanket purchase agreement, use the Enter Releases window. See: Entering Release Headers: page 4 – 87.

If you want to place on-line requisitions onto a new or existing purchase order, use the AutoCreate Documents window. See: Autocreate Documents Overview: page 6 – 2.

**To enter purchase order headers:**

1. Navigate to the Purchase Orders window from the menu:

   - by selecting the New PO button in the Find Purchase Orders window or any of its results windows
   - by selecting the Open button in any of the Find Purchase Order results windows
   - by selecting the Open button and then double-clicking the Open Documents icon in the Notifications Summary window when the current line is a purchase order
   - if the PO: Display the AutoCreated Document profile option is set to Yes, Purchasing opens the Purchase Orders window when you have completed AutoCreation of a purchase order. See: Profile Options in Purchasing: page 1 – 103.
The upper part of the Purchase Orders window has the following display–only fields:

*Created* – The system date is displayed as the creation date.

*Status* – Possible order status values are: Incomplete – The order has not been approved. Approved – You have approved the order. You can print it and receive items against it. Requires Reapproval – You approved the order and then made changes that require you to reapprove it.

*Total* – For standard and planned purchase orders, Purchasing displays the current Total order amount.

*Amount Agreed* – For blanket and contract purchase agreements only, Purchasing displays the agreed–to amount for the agreement. The amount Released value should not exceed the Amount Agreed. (Note also that if you change the Amount Limit in the Terms and Conditions window, the Amount Agreed should be equal to or less than the Amount Limit.)
Released – For blanket and contract purchase agreements only, Purchasing displays the current total amount Released. The amount released is 0.00 until you create releases against the blanket purchase agreement or reference the contract on a standard purchase order.

Currency – Purchasing displays the functional currency. This is overridden by supplier currency information.

P–Card – Purchasing displays a procurement card number if the purchase order was created from a iProcurement requisition that used a corporate credit card for the purchase. This field displays if the profile option PO: Use P–Cards in Purchasing is set to Yes. Only the last four digits are displayed. Procurement cards can be used for items with a Destination Type of Expense, for documents that do not contain a Project number, and for standard purchase orders or releases only.

2. Enter a unique Purchase Order number. The Revision is displayed to the right of the number. If you chose automatic purchase order number generation in your Purchasing Options, the cursor does not enter this field and the number is generated when you save your work.


Attention: The names of the above purchase order types can be modified in the Document Types window. See: Defining Document Types: page 1 – 87.

4. Enter the name of the Supplier for this purchase order. To approve a purchase order, you must provide a supplier.

Attention: You cannot change the supplier once you approve the purchase order. The purchase order becomes a legal document when you approve it. To change the supplier after you approve a purchase order, you must cancel the existing purchase order and create a new one for the other supplier.

5. Enter the Site of the supplier you want to use for your purchase order. If the supplier you choose has only one site, it is defaulted into this field. Before you can approve a purchase order, you must provide a site. Once the purchase order is approved, you can change the supplier site only if the PO: Change Supplier Site profile option is set to Yes. And only sites with the same currency as the previous site can be used. If you change the supplier site, the
revision will be incremented, and will require reapproval. You cannot enter the supplier site until you have entered a supplier.

You can optionally enter the name of the Contact at the supplier site. If the supplier you choose has only one contact name, it is defaulted into this field. You cannot enter a contact until you have entered a supplier site.

6. Enter the Ship To and Bill To locations for the purchase order. If you entered a supplier and supplier site, the Ship To and Bill To defaults reflect the locations you assigned to the supplier or supplier site. You can accept these values or change them to other locations. See: Purchase Order Defaulting Rules: page 4 – 12

7. If the Enforce Buyer Name option in your Purchasing Options is set to Yes, your name is displayed as the Buyer, and you cannot change this value. Otherwise, you can enter the name of any buyer. See: Defining Control Options: page 1 – 49.

8. For blanket and contract purchase agreements only, enter the total Amount Agreed. This is the amount you have agreed to spend with the supplier.

9. Enter a Description of the purchase order. These comments are for internal use only and do not print on the purchase order. You can enter up to 240 characters. If you want to add unlimited notes, use the Attachments feature. See: Attaching Notes to Purchasing Documents: page 1 – 44.

10. For standard and planned purchase orders and blanket purchase agreements, enter line information for the header you have just created. See: Entering Purchase Order Line Information: page 4 – 45.

► **To open the Supplier Item Catalog:**

- Select the Catalog button to open the Supplier Item Catalog. See: Overview of the Supplier Item Catalog: page 5 – 8.

► **To enter currency information:**

- Select the Currency button to open the Purchase Order Currency window. See: Entering Currency Information: page 4 – 58.

► **To enter additional purchase order details information:**

- Select the Terms button to open the Terms and Conditions window. See: Entering Purchase Order Details Information: page 4 – 60.
To enter shipment information:
- Select the Shipments button to open the Purchase Order Shipments window. See: Entering Purchase Order Shipments: page 4 – 63.

To enter price break information:
- For blanket purchase agreements, you can select the Price Break button to open the Price Breaks window. See: Entering Purchase Agreement Price Break Information: page 4 – 72.

To take approval actions:
- Select the Approval button to open the Approve Documents window. See: Submitting a Document for Approval: page 2 – 35.

To check funds:
- Select Check Funds on the Tools menu.

To enter notification controls:
- Select Notification Control on the Tools menu (For planned purchase orders, contract purchase agreements, and blanket purchase agreements). See: Entering Purchase Order Notification Controls: page 4 – 82.

To enter or view acceptances:

To view action history:
- Select View Action History on the Tools menu to open the Action History window. See: Viewing Action History: page 8 – 2.

To enter purchase order preferences:
- Select Preferences on the Tools menu. See: Entering Purchase Order Preferences: page 4 – 34.
To disable Payment on Receipt for the purchase order:

- Select the Terms button. In the Pay On field, choose Null to disable Payment on Receipt for this document. Choose Receipt to enable Payment on Receipt. The Pay On field is disabled if the supplier site is not a Payment on Receipt site. See: Entering Purchase Order Details Information: page 4 – 60.

To reaccess a purchase order quickly:

- Choose Place on Navigator from the Action menu. Choose the Documents tabbed region in the Navigator to later access the purchase order more quickly. See also: Using the Navigator’s Documents Region, Oracle Applications User’s Guide.

Note: Once you place a document in the Navigator, it is the first thing you see in the Navigator the next time you log into Purchasing. Choose Functions to return to the Purchasing menu.

See Also

Overview of Purchase Orders: page 4 – 3
Entering Purchase Order Lines: page 4 – 45
Changing Encumbered Documents: page 4 – 132
Procurement Card Purchase Orders and Releases: page 4 – 143
Entering Purchase Order Lines

Use the Lines tabbed region in the Purchase Orders window to create purchase order lines.

When you save your work, Purchasing creates shipments and distributions if sufficient valid default information is available. Use the Purchase Order Shipments window to review, edit, and create multiple shipment lines for each purchase order line. See: Entering Purchase Order Shipments: page 4 – 63.

To enter a purchase order line:


2. Enter the purchase line Number for the purchase order line. If you start a new purchase order line, Purchasing displays the next sequential line number available. You can accept this number or
3. Enter the line Type for the item. When you create your purchase order line, you enter a line type as part of your item information. When you enter a line type, Purchasing automatically copies the corresponding defaults. You can change the line type after you have saved your work, if the change is in the same line type class, but Purchasing won’t automatically copy the new defaults. If you change the line type before you save your work, Purchasing automatically copies the new defaults if the new line type is in a different line type class.

You can enter predefined items for your purchase order line only when you specify a quantity based line type. If Bills of Material and Work in Process are installed and you have defined an outside processing line type, you can enter that type here to purchase outside processing. See: Defining Default Options: page 1 – 45. See: Defining Line Types: page 1 – 84.

4. Enter the Item you want to purchase. If you enter an item, Purchasing displays the purchasing category, item description, unit of measure, and unit price associated with the item. To create a purchase order line for a one–time item, simply skip the item number field and enter a purchasing category and an item description. If you are purchasing outside processing, you can enter only outside processing items. See: Defining Items, Oracle Inventory User’s Guide.

5. Enter the Revision number for the item on the purchase order line. The Revision number is required if the item is under revision control. See: Defining Item Revisions, Oracle Inventory User’s Guide. See: Inventory Attribute Group, Oracle Inventory User’s Guide.

6. Enter the purchasing Category of the item you want to purchase. If you choose an item, Purchasing displays the purchasing category for the item. You cannot change the purchasing category if you choose an item. See: Defining Categories, Oracle Inventory User’s Guide.

7. Enter the Description of the item. If you choose an item, Purchasing displays its description. You can change the item description only if you set up the item attributes to let you do so. The full item description for the current line is displayed beneath the Lines tabbed region.
8. Enter the total Quantity you are ordering on the purchase order line.

9. Enter the UOM of the item. The unit of measure qualifies the quantity you enter on the purchase order line. When you choose a line type, its default unit of measure appears here. When you choose an item number, its unit of measure overrides the line type default. You can change the UOM until the item has been received, billed, or encumbered.

10. Enter the unit Price for the item. If you choose an item, the default price is the list price for the item. Otherwise, the default price is from the line type. The Amount field displays the unit price multiplied by the quantity.

11. Enter the Promised date that the supplier promised delivery of the items. This promised–by date is printed on the purchase order.

12. Enter the Need By date when the requestor needs the item. This date is printed on the purchase order if you do not provide a promised–by date. If you are using Master Scheduling/MRP, you must provide either a need–by date or a promised–by date for shipments that correspond to purchase order lines with Master Scheduling/MRP planned items. A need–by date is also required for Inventory planned items. See: Overview of Implementing Planning Recommendations, Oracle Master Scheduling/MRP and Supply Chain Planning User’s Guide.

13. Optionally enter the Supplier’s Item number for this item.

Multiple distributions, Promised date, and Need–By date display as “multiple” at the line level.

14. Select Reserved to reserve funds for the line.

▶ To view tax information:

- After you have entered and saved all tax information, do either or both of the following:
  - Choose Tax Code Summary from the Tools menu to see the total recoverable and nonrecoverable tax for each tax code in your document. See: Viewing Tax Code Summary Information: page 4 – 138.
  - Choose Tax Details from the Tools menu to see recoverable and nonrecoverable tax details for each line, shipment, and distribution. See: Viewing Tax Details: page 4 – 140.
To reaccess a purchase order quickly:

- Choose Place on Navigator from the Action menu. Choose the Documents tabbed region in the Navigator to later access the purchase order more quickly. See also: Using the Navigator’s Documents Region, Oracle Applications User’s Guide.

Note: Once you place a document in the Navigator, it is the first thing you see in the Navigator the next time you log into Purchasing. Choose Functions to return to the Purchasing menu.

See Also

Overview of Purchase Orders: page 4 – 3
Entering Purchase Order Headers: page 4 – 39
Overview of the Supplier Item Catalog: page 5 – 8
Entering Currency Information: page 4 – 58
Entering Purchase Order Details Information: page 4 – 60
Entering Purchase Order Shipments: page 4 – 63
Entering Purchase Agreement Price Break Information: page 4 – 72
Submitting a Document for Approval: page 2 – 35.
Entering Purchase Order Notification Controls: page 4 – 82
Entering and Viewing Purchase Order Acceptances: page 4 – 84
Viewing Action History: page 8 – 2
Entering Purchase Order Preferences: page 4 – 34
Changing Encumbered Documents: page 4 – 132
Entering Purchase Order Price Reference Information

Use the Price Reference tabbed region in the Purchase Orders window to enter pricing information for purchase order lines.

To enter price reference information:


2. Enter the List Price for the item. If you have entered an item, Purchasing displays the list price for the item. (See: Defining Items, Oracle Inventory User’s Guide.) You can accept the default list price or change it. Use this field to help evaluate your buyers. Purchasing uses the list price you enter here in the savings analysis reports. See: Savings Analysis Report (By Buyer): page 9 – 151 and Savings Analysis Report (By Category): page 9 – 153.
3. Enter the latest Market Price for the item. If you enter an item, Purchasing displays the market price for the item. Use this field to help evaluate your buyers. Purchasing uses the price you enter here in the savings analysis reports if you do not provide a value in the List Price field.

4. Enter the Price Type from your lookup codes. See: Defining Lookup Codes: page 1 - 74.

5. For planned purchase orders and blanket purchase agreements only, check Allow Price Override to indicate that the release price can be greater than the price on the purchase agreement line. If you allow a price override, the release price cannot exceed the Price Limit specified on the line. If you do not allow a price override, Purchasing displays on the release the shipment price from the purchase agreement and prevents you from updating it. You cannot enter this field if the line type is amount based.

6. If you allow price override, enter the Price Limit. This is the maximum price per item you allow for the item on this agreement line.

7. Select Negotiated to indicate that the purchase price is negotiated. If the actual price is greater than or equal to the list price, then the field is unchecked as the default. If the actual price is less than the list price, then the field is checked as the default. You can accept the default value or change it.

8. Save your work.

See Also

Overview of the Supplier Item Catalog: page 5 – 8
Entering Currency Information: page 4 – 58
Entering Purchase Order Details Information: page 4 – 60
Entering Purchase Order Shipments: page 4 – 63
Entering Purchase Agreement Price Break Information: page 4 – 72
Submitting a Document for Approval: page 2 – 35.
Entering Purchase Order Notification Controls: page 4 – 82
Entering and Viewing Purchase Order Acceptances: page 4 – 84
Viewing Action History: page 8 – 2
Entering Purchase Order Preferences: page 4 – 34
Entering Purchase Order Reference Document Information

Use the Reference Documents tabbed region in the Purchase Orders window to enter reference document information for purchase order lines.

Purchasing lets you reference quotation information on your purchase orders.

To enter reference document information:


2. Enter the Contract purchase agreement number. You cannot enter a contract number until you have entered a supplier in the header, and the contract must be for this supplier. The contract you choose must be effective; that is, the current date has to be within the effective date and the expired date of the contract.
If you reference a contract purchase agreement on a standard purchase order line, Purchasing adds the total amount of the purchase order line to the total amount of the contract purchase agreement. Purchasing lists only those contracts with the same supplier as the one on your standard purchase order.

**Attention:** If you have not yet provided a supplier on your standard purchase order, you cannot choose any contracts for your purchase order lines. If you want to change the supplier on your standard purchase order after you reference a contract on your purchase order lines, you must remove the references to the contract purchase agreement, or you will not be able to approve the purchase order. Purchasing lets you change suppliers only on standard and planned purchase orders with the status Incomplete.

Purchasing displays the Quotation and Quotation Line numbers, Quotation Type, and Supplier Quotation Number if you select a quotation from the Supplier Item Catalog or Supplier–Item Attributes windows.

3. You can enter project contract information in this region. If you are using Oracle Project Contracts you can enter the project Contract number and Rev (version number). Once you have entered this information, you will then be able to enter additional project contract details at the distribution level.

4. Save your work.

**See Also**

Overview of the Supplier Item Catalog: page 5 – 8
Entering Currency Information: page 4 – 58
Entering Purchase Order Details Information: page 4 – 60
Entering Purchase Order Shipments: page 4 – 63
Entering Purchase Agreement Price Break Information: page 4 – 72
Submitting a Document for Approval: page 2 – 35.
Entering Purchase Order Notification Controls: page 4 – 82
Entering and Viewing Purchase Order Acceptances: page 4 – 84
Viewing Action History: page 8 – 2
Entering Purchase Order Preferences: page 4 – 34
Entering Purchase Order Miscellaneous Information

Use the More tabbed region in the Purchase Orders window to enter miscellaneous information for purchase order lines.

To enter miscellaneous information:


2. Enter a Note to the Supplier for the purchase order header. You can enter up to 240 characters. If you want to enter unlimited notes, use the Attachments feature. See: Attaching Notes to Purchasing Documents: page 1 – 44

3. Enter the UN identification Number for the item on the purchase order line. The default, if present, is from the item record. See: Defining UN Numbers: page 1 – 71.

4. Enter the Hazard Class for the item on the purchase order line. If you enter a UN number, Purchasing displays the corresponding
hazard class. The default, *if present*, is from the item record. See: Defining Hazard Classes: page 1 – 70.

5. Select Capital Expense to indicate that the purchase is a capital expenditure.


7. Save your work.

See Also

Overview of the Supplier Item Catalog: page 5 – 8
Entering Currency Information: page 4 – 58
Entering Purchase Order Details Information: page 4 – 60
Entering Purchase Order Shipments: page 4 – 63
Entering Purchase Agreement Price Break Information: page 4 – 72
Submitting a Document for Approval: page 2 – 35.
Entering Purchase Order Notification Controls: page 4 – 82
Entering and Viewing Purchase Order Acceptances: page 4 – 84
Viewing Action History: page 8 – 2
Entering Purchase Order Preferences: page 4 – 34
Entering Purchase Agreement Information

Use Terms in the Purchase Orders window to enter additional information for blanket purchase agreement lines and headers.

To enter additional agreement information on the header:

1. From the Purchase Orders window, select Terms.

2. Choose the Payment term. An example of a payment term is Net 30.

3. Choose a Freight term. An example of a freight term is Prepaid.

4. Choose a Carrier. An example of a carrier is Rail.

5. Choose an FOB point. An example of an FOB point is Origin.

6. In the Pay On field, select Receipt if you want an invoice to be created automatically for this document when you run Payment on Receipt, or Null if you do not. Receipt is defaulted in this field if the supplier site is set up as a Payment on Receipt site in the Supplier Sites window. If the supplier site is not set up as a Payment on Receipt site, this field is disabled, and you cannot change it. You can update the Pay On field again on a release (if...
the supplier is a Payment on Receipt site). See: Payment on Receipt: page 9–66.

7. Save your work.

► To enter additional agreement line information:

1. In the Agreement tabbed region of the Purchase Orders window (when you’ve selected a Type of Blanket Purchase Agreement), enter the Minimum Release Amount against this purchase agreement line.

2. Enter the Quantity Agreed. This is printed on your purchase orders. Purchasing does not automatically compute the quantity agreed from the amount agreed. Use the Amount Agreed field to provide agreed amounts.

3. Enter the Amount Agreed. Purchasing does not automatically compute the amount agreed from the quantity agreed.
4. Optionally enter an Expiration Date to prevent ordering of the item after that date.

If the item on the agreement has expired but already exists on an open release, you can still use the release. However, the expired line item will not be used for sourcing, and any future releases you create will not allow using the expired item. (If you use iProcurement, expired line items are also not available in the catalog.)

5. Select Cumulative Pricing if you want Purchasing to choose the price break by adding the current release shipment quantity to the total quantity already released against the purchase agreement line. Otherwise, Purchasing chooses the price break by using the individual release shipment quantity.

6. Save your work.

See Also

Overview of the Supplier Item Catalog: page 5 – 8
Entering Currency Information: page 4 – 58
Entering Purchase Order Details Information: page 4 – 60
Entering Purchase Order Shipments: page 4 – 63
Entering Purchase Agreement Price Break Information: page 4 – 72
Submitting a Document for Approval: page 2 – 35.
Entering Purchase Order Notification Controls: page 4 – 82
Entering and Viewing Purchase Order Acceptances: page 4 – 84
Viewing Action History: page 8 – 2
Entering Purchase Order Preferences: page 4 – 34
Entering Currency Information

Use the Currency window to enter and change currency information for purchase orders, RFQs, and quotations.

For purchase orders, you can change currency information until the purchase order is approved or encumbered. Note that changing the purchase order supplier to one that uses a different currency overrides any information you have entered in this region.

To enter currency information:

1. Navigate to the Currency window by selecting the Currency button in the Purchase Orders, RFQs, and Quotations windows.

2. Purchasing displays the functional Currency from your Set of Books, and you can accept or change the currency. If you change the currency, you must update the unit price on all lines to reflect what that price would be at the new currency.

3. You can enter a Rate Type only if the currency for this document is different from your functional or base currency. The default is the currency rate type from the Purchasing Options window.

Purchasing supplies you with one of two predefined currency rate types: User or EMU Fixed. A rate type of User means that you can enter a conversion rate between the foreign currency (or transaction currency in a document entry window) and the base currency (or functional currency, defined in your set of books). A
rate type of EMU Fixed means that if either your transaction currency or your functional currency is Euro (the European Monetary Unit currency) and the other is another European currency, Purchasing automatically enters a conversion Rate Date and Rate for you that you cannot change.

You can define additional currency rate types in the Daily Conversion Rate Types window, and you can enter User or one of your additional types as the default. Note that you cannot approve a purchase order without a rate type if you are not using your functional currency.

4. The default Rate Date is the current date. Purchasing uses this date to obtain the currency conversion rate from your conversion definitions and displays the rate if it finds one.

5. If the rate type is User, you can enter the conversion rate between the foreign currency and your functional currency. This rate corresponds to the value of your foreign currency in your functional currency. For example, if your functional currency is US Dollars, the foreign currency is British Pounds, and 1 British Pound equals 2 US Dollars, you should enter 2 in this field. For other rate types, when you enter a rate date for which a rate has been defined, Purchasing displays the rate.

► To cancel your entries and return:
  - Select the Cancel button to cancel your entries and return to the window from which you accessed the Currency window.

► To apply your entries:
  - Select the Done button to apply your entries.

See Also

Purchase Order Defaulting Rules: page 4 – 12
Defining Purchasing Options: page 1 – 45
Defining Currencies, Oracle Public Sector General Ledger User’s Guide
Defining Conversion Rate Types, Oracle Public Sector General Ledger User’s Guide
Entering Daily Rates, Oracle Public Sector General Ledger User’s Guide
Entering Purchase Order Details Information

Use the Terms and Conditions window to enter terms and conditions information for purchase orders.

► To enter purchase order terms information:

1. Navigate to the Terms and Conditions window by selecting the Terms button in the Purchase Orders window.

2. For planned purchase orders, blanket purchase agreements, and contract purchase agreements, enter the Effective start date for the purchase order. A starting date is necessary if you are using a warning delay on notification controls. You cannot associate a purchase order line with a contract that is not yet effective. You also cannot create a release with a date that is before the corresponding blanket purchase agreement or planned purchase order effective date.

3. For planned purchase orders, blanket purchase agreements, and contract purchase agreements, enter the Effective expiration date for the purchase order. This date must be later than the start date and later than any existing releases. You cannot associate a purchase order line with a contract that has expired. You also
cannot create a release with a date that is after the corresponding blanket purchase agreement or planned purchase order expiration date.

4. Enter the Payment terms for the purchase order. Purchasing displays default payment terms that you can accept or change. See: Defining Payment Terms, Oracle Public Sector Payables User’s Guide.

5. Enter the Freight terms for the purchase order. Purchasing displays default freight terms that you can accept or change. See: Defining Lookup Codes: page 1 – 74.

6. Enter the freight Carrier for shipment of the purchase order. Purchasing displays a default freight carrier that you can accept or change. See: Defining Freight Carriers, Oracle Inventory User’s Guide.

7. Enter the FOB point for the purchase order. Purchasing displays a default free on board (FOB) designation that you can accept or change. See: Defining Lookup Codes: page 1 – 74.

8. Optionally select a value in the Pay On field to enable or disable Payment on Receipt for this document.

Receipt is defaulted in this field if the supplier site is set up as a Payment on Receipt site in the Supplier Sites window. Receipt means that Payment on Receipt will automatically generate an invoice for this purchase order.

Select Null if you do not want Payment on Receipt to automatically create an invoice for this document. If the supplier site is not set up as a Payment on Receipt site, this field is disabled, and you cannot change it. See: Payment on Receipt: page 9 – 66.

You can update the Pay On field again on a release (if the supplier is a Payment on Receipt site).

9. Select Acceptance Required to indicate that the supplier must accept the purchase order. If you select this check box, you can enter the due By date, when you require the supplier to return an acceptance for your purchase order. See: Entering and Viewing Purchase Order Acceptances: page 4 – 84.

10. Select Confirming Order to indicate that the purchase order is a confirming order. A confirming order is an order that you are submitting formally to confirm a verbal order already placed with the supplier. For confirming orders, Purchasing prints the following on the purchase order header: This is a confirming order. Do not duplicate.
11. Select Firm to indicate that the purchase order is firm. Firm your purchase order when you want to indicate to Master Scheduling/MRP or your manufacturing application that it should not reschedule this purchase order shipment.

12. Select Supply Agreement if you want Oracle Supplier Scheduling to communicate releases against this blanket purchase agreement to suppliers.

Supplier Scheduling can communicate releases against a blanket purchase agreement only when this option is selected.

13. For planned purchase orders, blanket purchase agreements, and contract purchase agreements, enter the Amount Limit (for the total of all releases) and the Minimum Release Amount that can be released against this purchase order. For blanket and contract purchase agreements, the Amount Limit must be equal to or greater than the Amount Agreed. Enter Effective from and to dates to limit the agreement controls by time.

14. For blanket purchase agreements, enter a Price Update Tolerance only if you are importing price/sales catalog information through the Purchasing Documents Open Interface.

The Price Update Tolerance specifies the maximum percentage increase allowed to an item’s price on this blanket purchase agreement when your supplier sends updated price/sales catalog information through the Purchasing Documents Open Interface. This field affects only blanket purchase agreements imported through the Purchasing Documents Open Interface. See: Setting a Price Tolerance in a Price/Sales Catalog Update: page 5 – 25.

15. Enter a Supplier Note and a Receiver Note. You can enter up to 240 characters in these fields.

16. Save your work.

See Also

Purchase Order Defaulting Rules: page 4 – 12
Entering Purchase Order Shipments

Use the Shipments window to enter multiple shipments for standard and planned purchase order lines and to edit shipments that Purchasing automatically created for you. A purchase order shipment specifies the quantity, ship-to organization and location, date you want your supplier to deliver the items on a purchase order line, and country of origin for the items. When you save your work, Purchasing creates distributions if sufficient valid default information is available and if there are no existing distributions.

To enter purchase order shipment information:

1. For standard and planned purchase orders, you can navigate to the Shipments window by selecting the Shipments button in the Purchase Orders window.

![Shipments window](image)

The first tabbed region in the Shipments window is the Shipments tabbed region. In addition to the enterable fields discussed in the following steps, this region displays the UOM, the Original Promise date (if the Promised date has already been changed, the original promised date is displayed here), the Charge Account, the line Amount, and a check box to indicate whether funds have been
Reserved. See: Budgetary Control and Online Funds Checking, *Oracle Public Sector General Ledger User’s Guide*.

2. Enter the line Number for the shipment line. If you enter a new shipment line, Purchasing displays the next sequential line number available. You can enter any line number that does not already exist.

3. Enter the ship-to Organization. If you entered an item, you can pick only organizations in which the item is defined. If you entered a revision number on the purchase order line, then the item revision must also be defined in the organization. Note that you cannot update the organization once you have saved your work if the shipment has distributions. See: Purchase Order Defaulting Rules: page 4 – 12

4. Enter the Ship-To location for the shipment. You can pick any location that does not have an organization or any location whose organization matches the organization in the previous field. See: Purchase Order Defaulting Rules: page 4 – 12.

5. Enter the Quantity for the shipment. This value must be greater than 0. The default is the quantity from the corresponding Purchase Order Line. If you decrease this quantity, Purchasing automatically defaults the quantity ordered of the next line to the total quantity that you have not yet placed on a shipment line. The UOM is displayed to the right of the Quantity.

6. Enter the date that the supplier promised delivery of the items. This promised date is printed on the purchase order shipment. The default is from the Purchase Order Preferences window.

7. Enter the Need By date when the requestor needs the item. This date is printed on the purchase order if you do not enter a promised date. The default is from the Purchase Order Preferences window. If you use Purchasing with Master Scheduling/MRP, you must provide a need-by date for purchase order shipments with Master Scheduling/MRP planned items. You must also provide a need-by date for Inventory planned items. See: Overview of Implementing Planning Recommendations, *Oracle Master Scheduling/MRP and Supply Chain Planning User’s Guide*.

8. Optionally choose or change the Note for Receiver.

The Note for Receiver is a note which will be displayed at the time of receipt for this shipment.
The Note for Receiver displayed here defaults from the requisition line that this purchase order was created from. Otherwise, this field is blank.

9. Optionally choose or change the Country of Origin.

The Country of Origin is the country in which an item is manufactured.

The Country of Origin displayed here defaults from the Approved Supplier List, if it is defined there. If not, it defaults from the supplier site in the Supplier Sites window. Otherwise, this field is blank. You can leave it blank or select a country.

If you do not know the originating country, you can enter or change the Country of Origin later on the receipt.

10. Note that Taxable is selected if a Tax Code is associated with the item.

If there is no Tax Code for the item, Taxable is not selected. You cannot change the Taxable check box independently of the Tax Code.

11. Enter or use the default Tax Code for taxable items.

The tax code defaults from the following sources, in the following order:

- The Purchase Order Preferences window. If you have specified a preferred tax code in this window, Purchasing defaults this tax code onto the purchase order shipment.

- The Tax Defaults region in the Purchasing Options window. If you have specified a tax defaulting hierarchy in this window, Purchasing searches for and defaults the tax code based on that tax defaulting hierarchy. See: Defining Tax Defaults Options: page 1 – 55.

Accept the default tax code or select another. You cannot override the tax code if the profile option Tax: Allow Override of Tax Code is set to No, if the shipment has been received, or while funds for the document are reserved if you use encumbrance accounting.

If on the purchase order you change a tax source, such as Supplier or Site, then Purchasing does not redefault a new Tax Code on the current shipment, but does default it on new shipments. The same is true even after you override the Tax Code: Purchasing does not redefault it on existing shipments when you change a tax source.
Note: If you change the Tax Code after already creating distributions for the shipment, the associated Recovery Rate on those distributions is not redefaulted for the new Tax Code.

For an overview of tax in Purchasing, see: Tax Defaults in Purchasing: page 4 – 135.

12. Save your work.

► To display and enter more shipment information:


2. Enter the Receipt Close Tolerance percent for your shipments. Purchasing automatically closes a shipment for receiving if it is within the receiving closing tolerance at the receiving close point. You need to set the receiving close point in the Purchasing Options window. See: Defining Control Options: page 1 – 49.

3. Enter the Invoice Close Tolerance percent for your shipments. Purchasing automatically closes a shipment for invoicing if it is within the invoicing closing tolerance at billing, when Payables matches invoices to purchase orders or receipts. See: Defining Control Options: page 1 – 49.

4. Select one of the following options for Match Approval Level:

   Two–Way: Purchase order and invoice quantities must match within tolerance before the corresponding invoice can be paid.

   Three–Way: Purchase order, receipt, and invoice quantities must match within tolerance before the corresponding invoice can be paid.

   Four–Way: Purchase order, receipt, accepted, and invoice quantities must match within tolerance before the corresponding invoice can be paid.

   If you enter an item, the default value for this field comes from the item information at the organization level. If not defined there, the default comes from the item information at the master level. If you do not enter an item, the default is from your Purchasing Options. See: Receiving Controls, Options, and Profiles: page 7 – 9.

5. Select an Invoice Match Option:

   Purchase Order: Payables must match the invoice to the purchase order.

   Receipt: Payables must match the invoice to the receipt.
Choose Receipt if you want to update exchange rate information on the receipt or if you want your accounting to use exchange rate information based on the receipt date. (If you use Periodic Costing, you must match to the receipt to ensure accurate cost accounting.)

The Invoice Match Option defaults from the Supplier Sites window. You can change the Invoice Match Option on the shipment until you receive against the shipment.

**Note:** The Invoice Match Option and the Match Approval Level are independent options. You can perform whichever Invoice Match Option you want regardless of the Match Approval Level.


6. Select Accrue at Receipt to indicate that the items on this purchase order line accrue upon receipt. Inventory destined items always accrue upon receipt. For expense items, if the Accrue Expense Items flag in the Purchasing Options window is set to Period End, the items cannot accrue upon receipt, and you cannot change the shipment level default. If the Accrue Expense Items flag is set to At Receipt, the default is to accrue upon receipt, but you can change it to Period End. See: Defining Accrual Options: page 1 – 48.

**Attention:** If you are using Cash Basis Accounting, you should use the Purchasing Options window to set the Accrue Expense Items flag to Period End, and you should not select Accrue on Receipt in this window.

7. Select Firm to firm the purchase order shipment. Firm your purchase order when you want to indicate to Master Scheduling/MRP or your manufacturing application that it should not reschedule this shipment.

8. Save your work.

**To display status information:**

- Select the Status tabbed region in the Purchase Order Shipments window.

For each shipment, Purchasing displays the Status and the quantity Ordered, Received, Cancelled, and Billed.
To enter receiving control information:
- Select the Receiving Controls button to open the Receiving Controls window. See: Entering Purchase Order Receiving Controls: page 4 – 69.

To enter purchase order distribution information:
- Select the Distributions button to open the Distributions window. See: Entering Purchase Order Distributions: page 4 – 74.

To view tax information:
- After you have entered and saved all tax information, do either or both of the following:
  - Choose Tax Code Summary from the Tools menu to see the total recoverable and nonrecoverable tax for each tax code in your document. See: Viewing Tax Code Summary Information: page 4 – 138.
  - Choose Tax Details from the Tools menu to see recoverable and nonrecoverable tax details for each line, shipment, and distribution. See: Viewing Tax Details: page 4 – 140.

See Also

- Entering Purchase Order Preferences: page 4 – 34
- Changing Encumbered Documents: page 4 – 132
- Processing Periodic Acquisition Costs, *Oracle Cost Management User’s Guide*
Enter Purchase Order Receiving Controls

Use the Receiving Controls window to enter receiving control information for purchase orders and releases. Note that controls you enter here apply to specific purchase orders/releases and override the receiving controls you enter in the Receiving Options window. See: Receiving Controls, Options, and Profiles: page 7 – 9.

To enter purchase order receiving controls:

1. Navigate to the Receiving Controls window by selecting the Receiving Controls button in the Shipments window for purchase orders and in the Releases window for releases.
2. Enter the maximum acceptable number of Days Early and Days Late for receipts.

3. Enter the Action for receipt date control. This field determines how Purchasing handles receipts that are earlier or later than the allowed number of days selected above. Choose one of the following options:

   * **None** – Receipts may exceed the allowed days early or late.
   * **Reject** – Purchasing does not permit receipts outside the selected number of days early or late.
   * **Warning** – Purchasing displays a warning message but permits receipts outside the selected number of days early or late.

   Purchasing displays the Last Accept Date, which is the last date when the shipment can be received. This is the promised date plus the number of days late allowed.

4. Enter the maximum acceptable over-receipt Tolerance percent.

5. Enter the Action for Overreceipt Quantity control. This field determines how Purchasing handles receipts that exceed the quantity received tolerance. Choose one of the following options:

   * **None** – Receipts may exceed the selected tolerance.
   * **Reject** – Purchasing does not permit receipts that exceed the selected tolerance.
   * **Warning** – Purchasing displays a warning message but permits receipts that exceed the selected tolerance.

6. Select Allow Substitute Receipts to indicate that receivers can receive substitute items in place of ordered items. You must define substitute items before you can receive them. See: Defining Item Relationships, *Oracle Inventory User’s Guide*.

7. Enter the default Receipt Routing that you assign goods: Direct Delivery, Inspection Required, or Standard Receipt. You can override this routing during receipt by changing the destination type, if the RCV: Allow Routing Override user profile option is enabled. See: Profile Options in Purchasing: page 1 – 103.

8. Enter the Enforce Ship To location option to determine whether the receiving location must be the same as the ship-to location. Choose one of the following options:

   * **None** – The receiving location may differ from the ship-to location.
   * **Reject** – Purchasing does not permit receipts when the receiving location differs from the ship-to location.
Warning – Purchasing displays a warning message but permits receipts when the receiving location differs from the ship-to location.

▸ To cancel your entries:
  ■ Select the Cancel button to cancel your entries and return to the original window.

▸ To apply your entries:
  ■ Select the OK button to apply your entries and return to the original window.

See Also

Defining Receiving Options: page 1 – 58
Entering Purchase Agreement Price Break Information

Use the Price Break window to enter price break information for blanket purchase agreement lines.

To enter price break information:

1. Navigate to the Price Break window by selecting the Price Break button in the Purchase Orders window.

2. Enter a line Number for the shipment line. Purchasing displays the next available line number as the default.

3. Enter the ship to Organization. If you entered an item, you can select only organizations in which the item is defined. If you entered a revision number on the purchase order line, then the item revision must also be defined in the organization. See: Purchase Order Defaulting Rules: page 4 – 12.

4. Enter the Ship To location for the price break. You can select only locations for this organization or locations for which no organization is defined.
5. Enter the minimum Quantity that must to ordered to obtain this price break. The shipment quantity is displayed as the default.

6. Enter the Break Price at this quantity. Purchasing calculates the Discount % for you.

7. You can optionally enter a Discount % to have the Break Price calculated for you.

8. Save your work.

See Also

Entering Purchase Order Lines: page 4 – 45
Entering Purchase Order Distributions

Use the purchase order Distributions window to enter distribution information for purchase order shipments or to view distributions that Purchasing has automatically created for you. You can enter multiple distributions per shipment line. You can also enter information about paper requisitions in this window.

► To enter purchase order distribution information:

1. Navigate to the Distributions window by selecting the Distributions button in the Shipments window. The Shipments window is accessed from the Purchase Orders window. You begin in the Destination tabbed region.

2. Enter the line Number for the distribution line. If you enter a new distribution line, Purchasing displays the next sequential line number available. You can enter any line number that does not already exist.

3. The destination type determines the final destination of the purchased items. Choose one of the following options:

- Inventory
- Other
- Subinventory
- Other

4. The quantity and account description data are populated as per the accounting rules.
Expense – The goods are delivered to the requestor at an expense location. The destination subinventory is not applicable.

Inventory – The goods are received into inventory upon delivery. You can choose this option only if the item is stock enabled in the ship-to organization.

Shop Floor – The goods are delivered to an outside processing operation defined by Work in Process. You can choose this option only for outside processing items.

4. Enter the Requestor and Deliver To location for this distribution. If the destination type is Inventory, you can also enter the Subinventory.

5. Enter the Quantity of the purchase order shipment that you want to charge to the Accounting Flexfield. The default value comes from the quantity you enter in the Shipments window. If you decrease the default quantity, Purchasing automatically defaults on the next distribution line the total quantity you have not yet assigned to a distribution line.

6. Enter the Charge Account. When you save your changes in this window, Purchasing uses the Account Generator to automatically create the following three accounts for each distribution:
   - Charge: the account to charge for the cost of this item
   - Accrual: the AP accrual account
   - Variance: the invoice price variance account

   If you are using encumbrance control, Purchasing also creates the following account for each distribution:
   - Budget: the encumbrance budget account

   The Account Generator creates these accounts based on predefined rules. See: Using the Account Generator in Oracle Public Sector Purchasing: page C – 10.

   If the destination type is Expense, the default charge account you enter in the Purchases Order Preferences window overrides the charge account supplied by the Account Generator, and you can update the charge account here.

   For outside processing lines, the cursor does not enter this field during initial entry, since the Account Generator cannot build accounts until you have entered the Resource Sequence in the Outside Processing window.

7. Change or accept the default Recovery Rate for taxable items.
The recovery rate is the percentage of tax that your business can reclaim for credit. The recovery rate defaults in based on the Tax Code in the purchase order Shipments window and the setup in the Financials Options window.

You can change the recovery rate if the profile option Tax: Allow Override of Recovery Rate is set to Yes, if the shipment has not yet been received, or while funds for the document are not reserved (if you use encumbrance accounting). Depending on the setup in the Financials Options window and the type of tax, only certain recovery rates may be allowed. See: Recoverable Tax, *Oracle Public Sector Payables User’s Guide*.

If on a purchase order you change a tax source, such as Supplier, Site, or Tax Code, then Purchasing does not redefault a new Recovery Rate on the current distributions, but does default it on new distributions.

You can choose to use a different recovery rate for different distributions, even if they use the same tax code.

For an overview of tax in Purchasing, see: Tax Defaults in Purchasing: page 4 – 135.

8. Enter the GL Date you want to use when you reserve your funds. You can enter a GL Date only if you set up your financials system options to use encumbrance or budgetary control for purchase orders. The default is the current date. See: About Financials Options, *Oracle Public Sector Payables User’s Guide*. See: Budgetary Control and Online Funds Checking, *Oracle Public Sector General Ledger User’s Guide*.

If you enter a date that belongs to two separate accounting periods, Purchasing automatically creates a journal entry in the first accounting period that contains this date. See: Controlling Purchasing Periods: page 1 – 93.

To enter distribution detail information:

1. Select the More tabbed region.

   The Online check box indicates whether this distribution is part of an on-line requisition. If so, Purchasing displays the requisition number and line number.

2. If this distribution comes from an on-line requisition, Purchasing displays the Requisition Number and Line number, you cannot update this field. If this distribution does not come from an on-line requisition, enter the paper requisition number in this field. The default is the paper requisition number from the Purchase Order Preferences window.

   Purchasing displays the Budget Account, Accrual Account, and Variance Account numbers supplied by the Account Generator.

3. Enter the Rate Date for the currency. Purchasing uses this date to obtain the currency conversion rate from your conversion definitions. You cannot enter this field when you edit a purchase order created in your base currency. See: Defining Purchasing Options: page 1 – 45. See: Entering Daily Rates, Oracle Public Sector General Ledger User’s Guide.

   Note: The Rate Date is a required field for a foreign currency purchase order, to complete the approval process.

4. You can enter the conversion Rate between the foreign currency and the base currency only when the rate type is User. If you entered a rate date for which a conversion rate is defined, Purchasing displays that rate and you cannot change it.

To view tax information:

- After you have entered and saved all tax information, do either or both of the following:
  - Choose Tax Code Summary from the Tools menu to see the total recoverable and nonrecoverable tax for each tax code in your document. See: Viewing Tax Code Summary Information: page 4 – 138.
  - Choose Tax Details from the Tools menu to see recoverable and nonrecoverable tax details for each line, shipment, and distribution. See: Viewing Tax Details: page 4 – 140.
To enter project information:

You see a Project tabbed region if one of the following is true:

- Oracle Projects is installed, or
- Oracle Project Manufacturing is installed and Project Reference Enabled is selected in the Project Manufacturing Organization Parameters window

The project information you enter is used by Oracle Projects for destination types of Expense, or by Oracle Project Manufacturing for destination types of Inventory or Shop Floor. See: Oracle Projects User’s Guide. See: Oracle Project Manufacturing Implementation Manual.

1. Choose the Project tabbed region.

2. Select a Project Number.

   For a Destination Type of Inventory or Shop Floor, you can optionally enter a Project Number if the Project Control Level is set to Project in the Project Information tabbed region of the Organization Parameters window.

   For a Destination Type of Expense, you can always optionally enter a Project Number.

3. If you entered a Project number, select a Task number.

   You must enter a Task number for a Destination Type of Inventory or Shop Floor, if the Project Control Level is set to Task in the Organization Parameters window and if you have entered a Project number.

4. If you entered a Project Contract number in the Reference Documents tabbed region for the line that this distribution belongs to you can enter additional details here. The Contract Line number and the Deliverable Number for the project contract that correspond to this distribution should be entered.

5. Enter Expenditure information.

   Expenditure information is required only if your Destination Type is Expense.

   - Select the Expenditure Type.

   - If you chose an Expenditure Type, enter an Expenditure Organization.

   - If you chose an Expenditure Organization, select the Expenditure Date.
6. Note that the distribution Quantity that will be charged to the project should already be entered for you.
   If you change the Quantity here, then the distribution Quantity on the purchase order line changes as well.

7. Note that a Unit Number field is visible if Project Manufacturing is installed.
   If the item is under model/unit effectivity control, you must select an end-item model Unit Number. This field is disabled if the item is not under model/unit effectivity control. See: Model/Unit Effectivity, Oracle Project Manufacturing Implementation Manual.

   **Note:** You can also view the Unit Number as a hidden field in the Purchase Order Distributions summary window.

8. Save your work.

   The Charge, Budget, Accrual, and Variance accounts in the Account Description region are generated automatically. See: Using the Account Generator in Oracle Public Sector Purchasing: page C – 10.

   **To enter outside processing information:**
   - Select the Outside Processing button to open the Purchase Order Outside Processing window. See: Entering Outside Processing Information: page 4 – 80.

**See Also**

- Entering Purchase Order Shipments: page 4 – 63

- Changing Encumbered Documents: page 4 – 132
Entering Outside Processing Information

Use the Outside Processing window to review and enter outside processing information for document lines.

To enter outside processing information:


2. Enter the Job or repetitive Assembly that uses this outside processing operation. For an assembly, you can also enter the production Line. Use this to choose a schedule with the earliest first unit start date.

3. Enter the operation Sequence number of the outside processing operation. Purchasing displays the operation Code and the Department.

4. Enter the Sequence number of the resource the outside processing operation uses. Purchasing displays the resource UOM and Quantity. Purchasing also displays the Unit Type and Assembly Quantity.
To cancel your entries:

- Select the Cancel button to cancel your entries and return to the window from which you came.

To apply your entries:

- Select the Done button to apply your entries and return to the window from which you came.

See Also


Enter the Notification Controls window to enter notification controls for planned purchase orders, contract purchase agreements, and blanket purchase agreements. For these documents, you can establish expiration and release control notification conditions and specify the number of days before the condition is met that you want to be notified. When the notification conditions are met, Purchasing sends you an alert, using Oracle Alert (or e-mail).

To enter notification controls

1. Select Notification Controls on the Tools menu in the Purchase Orders window to open the Notification Controls window and display any existing controls. The Notification Controls option is active on the menu only when there is no unsaved information for the purchase order.

2. Enter one of the following notification Conditions:

   Amount Not Released – If you choose this condition, you can optionally specify effective and expiration dates, but you must specify the amount not released.
**Amount Released** – If you choose this condition, you can optionally specify the effective and expiration dates, but you must specify the amount released.

**Expiration** – Before you can use this condition, you must have specified an expiration date for the purchase order in the Details window. If you choose this condition, you must enter an effective date, and you can optionally enter an expiration date.

3. Enter the Warning Delay. This is the number of days before the expiration date that you want to be alerted. The warning delay is applicable only to the Expiration condition and helps you calculate the effective date.

4. Purchasing calculates the Effective Date based on your warning delay and the expiration date, but you can change this date. The effective date is required for the Expiration condition.

5. Purchasing displays the Expiration Date from the Terms and Conditions region as the default, but you can change this date.

**Attention:** If you do not enter an expiration date and your condition continues to be met, the alert will be issued forever. Therefore, we recommend entry of an expiration date.

6. The Percent field is applicable only when you have already entered an order line. For the Amount Released (or Not Released) conditions, you can enter a percentage of the order line total, and Purchasing calculates the amount.

7. When the amount released (or not released) reaches the Amount you enter here, Purchasing sends you an alert. If you have already entered an order line, Purchasing calculates the percentage and displays it in the Percent field.

8. Select the Done button to save your work and return to the Purchase Orders window.

**To cancel your entries:**

- Select the Cancel button to cancel your entries and return to the Purchase Orders window.

**See Also**

Using Oracle Alert in Oracle Public Sector Purchasing: page B – 2

Entering Purchase Order Headers: page 4 – 39
Entering and Viewing Purchase Order Acceptances

Use the Acceptances window to view and enter purchase order acceptances from your suppliers. The original copy of the purchase order you send to the supplier is a legal offer to buy. A binding purchase contract does not exist until the supplier accepts your offer either by performing the contract or formally accepting the offer by returning an acceptance document to you.

You indicate on your standard purchase orders, purchase agreements, and releases whether you require your suppliers to accept your orders by a specific date. Purchasing notifies you in the Notifications Summary window of the orders for which the suppliers have not responded by the acceptance due date.

► To view acceptances:
  - Navigate to the Acceptances window by selecting Acceptances from the Tools menu in the Purchase Orders and Releases windows when you do not have a purchase order open. Purchasing displays the Acceptances window with all previously accepted purchase orders for review.

► To enter acceptances:
  1. Navigate to the Acceptances window by selecting Acceptances from the Tools menu in the Purchase Orders and Releases windows.
You can accept only purchase orders and releases that you approved at least once and that are not closed.

2. In the Action field, enter the results of your supplier follow-up. You can easily record the type of follow-up you performed such as Follow-up telephone call, Follow-up letter, or Fax follow-up. You can also use this field to record the outcome of the follow-up such as Will call back, No answer, Schedule slippage, or Cannot fulfill order.

3. Enter the Revision number. The default is the current revision. Purchasing removes the notification from the Notifications Summary window only when you record the acceptance of the most recent revision.

4. Enter the Action Date for the acceptance transaction. Today’s date is the default, but you can enter any date.

5. Enter the Accepted By person. Your name is the default.
6. Select Accepted to indicate that the supplier accepted the purchase order. If you accept the most recent revision, Purchasing removes the acceptance requirement and the acceptance date from your purchase order or release. Purchasing also deletes the corresponding notification from the Notifications Summary window if any late acceptance notification exists for this order.

7. Enter an Acceptance Type for the acceptance. You can define your own acceptance types, or use one of the following that Purchasing provides. See: Defining Lookup Codes: page 1 – 74.

Accepted All Terms – The supplier accepted all the terms of the purchase order.

On Schedule – The supplier agreed to meet the delivery dates on the purchase order.

Unacceptable Changes – The supplier made modifications to the terms of the purchase order that you do not find acceptable.

See Also

Entering Purchase Order Headers: page 4 – 39
Entering Release Headers: page 4 – 87
Entering Releases

Entering Release Headers

Use the Releases window to enter, edit, and approve releases against blanket purchase agreements or planned purchase orders.

To enter release headers:

1. Navigate to the Releases window by selecting Releases from the menu or selecting the New Release button in the Find Purchase Orders window.

2. Enter the PO number for the release you want to create. The list of values displays all blanket and planned purchase order numbers that have been approved, the document type, status, supplier, buyer, and effectivity date range. When you select a purchase
order, Purchasing displays the Supplier, Site, and Currency for that order. Purchasing also displays the Status of the release and the current Total amount of the release.

**Note:** Purchasing displays a P–Card number if the purchase order used one. A procurement card purchase order is created from an iProcurement requisition that used a corporate credit card for the purchase. This field displays if the profile option *PO: Use P–Cards in Purchasing* is set to Yes. Only the last four digits of the procurement card are displayed. Procurement cards can be used for items with a Destination Type of Expense, for documents that do not contain a Project number, and for standard purchase orders or releases only.

3. Purchasing displays the next Release number available. You can change the release number to any number that does not already exist.

4. Enter the Created date. The default is the system date, but you can change this.

5. If the Enforce Buyer Name option in the Purchasing Options window is set to Yes, your name is displayed as the Buyer, and you cannot change this value. Otherwise, you can enter the name of any buyer. See: Defining Control Options: page 1 – 49.

6. Select Firmed to firm your release shipment when you want to indicate to Master Scheduling/MRP or your manufacturing application that it should not reschedule this release shipment automatically.

7. Select Acceptance Required to indicate that you want to require the supplier to accept your release.

8. If acceptance is required, enter the Due–By date when you require the supplier to return an acceptance for your purchase order.

9. Optionally select a value in the Pay On field to enable or disable Payment on Receipt for this document.

The value in this field defaults from the Pay On field in the Terms and Conditions window for the blanket purchase agreement. The agreement receives its default value from the Supplier Sites window. Unless this field was changed on the agreement, Receipt is defaulted in this field if the supplier site is set up as a Payment on Receipt site in the Supplier Sites window. Receipt means that Payment on Receipt will automatically generate an invoice for this release.
Select Null if you do not want Payment on Receipt to automatically create an invoice for this document. If the supplier site is not set up as a Payment on Receipt site, this field is disabled, and you cannot change it. See: Payment on Receipt: page 9 – 66.

10. Enter release shipment line information in the Shipments tabbed region. See: Entering Purchase Order Shipments: page 4 – 63

- To take approval actions:
  - Select the Approve button to open the Approve Documents window. See: Submitting a Document for Approval: page 2 – 35.

- To enter receiving control information:
  - Select the Receiving Controls button to open the Receiving Controls window. See: Entering Purchase Order Receiving Controls: page 4 – 69.

- To enter release distribution information:

- To view blanket purchase agreement information:
  - Select the Agreement button to view blanket agreement information for the release.

- To enter and view acceptances:
  - Select Acceptances on the Tools menu to open the Acceptances window. See: Entering and Viewing Purchase Order Acceptances: page 4 – 84

- To view action history:
  - Select View Action History on the Tools menu to open the Action History window. See: Viewing Action History: page 8 – 2.

- To enter purchase order preferences:
  - Select Preferences on the Tools menu. See: Entering Purchase Order Preferences: page 4 – 34
See Also

Entering Release Shipments: page 4 – 90
Entering Release Distributions: page 4 – 97
Procurement Card Purchase Orders and Releases: page 4 – 143

Entering Release Shipments

Use the Shipments tabbed region to enter shipment lines for planned and blanket releases and to edit shipments that Purchasing automatically generated for you. (See: Automatic Release Generation: page 4 – 103) A purchase order shipment specifies the quantity, ship-to location, date you want your supplier to deliver the items on a purchase order line, and country of origin for the items.

To enter release shipment information:


   The first tabbed region is the Shipments region. In addition to the enterable fields discussed in the following steps, this region displays the UOM, the Originally Promise date (if the Promised date has been changed, the original promised date is displayed here), the Charge Account, the shipment Amount, and a check box to indicate whether funds have been Reserved. See: Budgetary Control and Online Funds Checking, Oracle Public Sector General Ledger User’s Guide.
2. Enter the line Number for the shipment line. If you enter a new shipment line, Purchasing displays the next sequential line number available. You can enter any line number greater than zero that does not already exist.

3. Enter the source Line number. The list of values includes the item number, revision, and description.

4. For scheduled releases only, you can enter the source Shipment. This is the planned purchase order shipment against which you want to issue a release. The details from the shipment are used as defaults for the scheduled release shipment.

5. Enter the ship–to Organization. If you picked a line with an item, you can pick only organizations in which the item is defined. If you picked a revision number on the purchase order line, the item revision must also be defined in the organization. For scheduled releases (against planned purchase orders), you cannot change the default organization from the planned purchase order shipment.
Note that you cannot update the organization once you have saved your work.

6. Enter the Ship–To location for the shipment. You can pick any location that does not have an organization or any location whose organization matches the organization in the previous field. See: Purchase Order Defaulting Rules: page 4 – 12. For blanket releases, Purchasing defaults the ship–to location from the Release Header zone. For scheduled releases, Purchasing gets default information from the planned purchase order shipment.

7. Enter the Quantity for the shipment. This value must be greater than zero.

8. Enter the Price you want to use for this shipment. Purchasing displays the actual price for the shipment from the purchase order line price for the item. The actual price defaults from the purchase agreement line.

You can use list of values to choose purchase agreement price breaks. If your purchase agreement has price breaks, the quantity entered here determines what break price is defaulted into the Price field. The cursor does not enter this field when you are editing an existing line.

If you allow price override for this purchase order line in the Purchase Orders window, the release price cannot exceed the price limit specified for the line. If you allow price override but did not enter a price limit, Purchasing does not check the shipment price for the releases. If you do not allow price override, Purchasing displays the shipment price from the purchase agreement and prevents you from navigating to this field. This field can be defaulted from the purchase agreement price breaks if you have entered a sufficient quantity.

9. Enter the date that the supplier Promised delivery of the items. This promised date is printed on the release.

10. Enter the Need By date when the requestor needs the item. This date is printed on the release if you do not enter a promised date. The default is from the Purchase Order Preferences window. If you use Purchasing with Master Scheduling/MRP, you must provide a need–by date or promised date for shipments that correspond to purchase order lines with Master Scheduling/MRP planned items. You must also provide a need–by date or promised date for Inventory planned items. See: Overview of Implementing Planning Recommendations, Oracle Master Scheduling/MRP and Supply Chain Planning User’s Guide.
11. Optionally choose or change the Note for Receiver.

The Note for Receiver is a note which will be displayed at the time of receipt for this shipment.

The Note for Receiver displayed here defaults from the requisition line that this release was created from. Otherwise, this field is blank.

12. Optionally choose or change the Country of Origin.

The Country of Origin is the country in which an item is manufactured.

For a scheduled release, the Country of Origin defaults from the planned purchase order. For a blanket release, the Country of Origin defaults from the Approved Supplier List, if it is defined there. If not, it defaults from the supplier site in the Supplier Sites window. Otherwise, this field is blank. You can leave it blank or choose a country.

If you do not know the originating country, you can enter or change the Country of Origin later on the receipt.

13. Note that Taxable is selected if a Tax Code is associated with the item.

If there is no Tax Code for the item, Taxable is not selected. You cannot change the Taxable check box independently of the Tax Code.

14. Enter or use the default Tax Code for taxable items.

The tax code defaults from the following sources, in the following order:

- The Purchase Order Preferences window. If you have specified a preferred tax code in this window, Purchasing defaults this tax code onto the release shipment.

- The planned purchase order shipment. If you are creating a release shipment from a planned purchase order and a tax code exists on the planned purchase order shipment, Purchasing copies this tax code onto the release shipment.

- The Tax Defaults region in the Purchasing Options window. If you have specified a tax defaulting hierarchy in this window, Purchasing searches for and defaults the tax code based on that tax defaulting hierarchy. See: Defining Tax Defaults Options: page 1 – 55.
You can accept the default tax code or select another. If you need additional help with how tax defaulting works in Purchasing, see: Tax Defaults in Purchasing: page 4 – 135.

You cannot override the Tax Code if the profile option Tax: Allow Override of Tax Code is set to No, if the shipment has been received, or while funds for the document are reserved if you use encumbrance accounting.

**Note:** If you change the Tax Code after already creating distributions for the shipment, the associated Recovery Rate on those distributions is not redefaulted for the new Tax Code.

For an overview of tax in Purchasing, see: Tax Defaults in Purchasing: page 4 – 135.

15. Save your work.

► **To display item information:**

- Select the Item tabbed region in the Releases window.

  For each shipment, Purchasing displays the Item number, purchasing Category, item Description, and the Supplier Item number.

► **To display and enter more shipment information:**


2. Enter the Receipt Close Tolerance percent for your shipments. Purchasing automatically closes a shipment for receiving if it is within the receiving closing tolerance at the receiving close point. You need to set the receiving close point in the Purchasing Options window. See: Defining Control Options: page 1 – 49.

3. Enter the Invoice Close Tolerance percent for your shipments. Purchasing automatically closes a shipment for invoicing if it is within the invoicing closing tolerance at billing, when Payables matches invoices to purchase orders or receipts. See: Defining Control Options: page 1 – 49.

4. Select one of the following options for Match Approval Level:

  *Two-Way Matching*: Purchase order and invoice quantities must match within tolerance before the corresponding invoice can be paid.
Three-Way Matching: Purchase order, receipt, and invoice quantities must match within tolerance before the corresponding invoice can be paid.

Four-Way Matching: Purchase order, receipt, accepted, and invoice quantities must match within tolerance before the corresponding invoice can be paid.

If you enter an item, the default value for this field comes from the item information at the organization level. If not defined there, the default comes from the item information at the master level. If you do not enter an item, the default is from your Purchasing Options. See: Receiving Controls, Options, and Profiles: page 7 – 9.

5. Select an Invoice Match Option:

Purchase Order: Payables must match the invoice to the purchase order.

Receipt: Payables must match the invoice to the receipt.

Choose Receipt if you want to update exchange rate information on the receipt or if you want your accounting to use exchange rate information based on the receipt date. (If you use Periodic Costing, you must match to the receipt to ensure accurate cost accounting.)

The Invoice Match Option defaults from the Supplier Sites window. You can change the Invoice Match Option on the shipment until you receive against the shipment.

Note: The Invoice Match Option and the Match Approval Level are independent options. You can perform whichever Invoice Match Option you want regardless of the Match Approval Level.


6. Select Accrue at Receipt to indicate that the items on this purchase order line accrue upon receipt. Shop Floor and Inventory destined items always accrue upon receipt, and you cannot change this default. For expense items, if the Accrue Expense Items flag in the Purchasing Options window is set to Period End, the items cannot accrue upon receipt, and you cannot change the default. If the Accrue Expense Items flag is set to At Receipt, the default is to accrue upon receipt, but you can change it to not accrue upon receipt. See: Defining Accrual Options: page 1 – 48.

Attention: If you are using Cash Basis Accounting, you should use the Purchasing Options window to set the Accrue Expense Items flag to Period End, and you should not select Accrue on Receipt in this window.
7. Select Firm to firm the shipment to indicate to Master Scheduling/MRP or your manufacturing application that it should not reschedule this release shipment.

8. Save your work.

► **To display status information:**

- Select the Status tabbed region.

  For each shipment, Purchasing displays the Status and the quantity Ordered, Received, Cancelled, and Billed.

► **To view tax information:**

- After you have entered and saved all tax information, do either or both of the following:
  - Choose Tax Code Summary from the Tools menu to see the total recoverable and nonrecoverable tax for each tax code in your document. See: Viewing Tax Code Summary Information: page 4 – 138.
  - Choose Tax Details from the Tools menu to see recoverable and nonrecoverable tax details for each line, shipment, and distribution. See: Viewing Tax Details: page 4 – 140.

► **To take approval actions:**

- Select the Approve button to open the Approve Documents window. See: Submitting a Document for Approval: page 2 – 35.

► **To enter receiving control information:**

- Select the Receiving Controls button to open the Receiving Controls window. See: Entering Purchase Order Receiving Controls: page 4 – 69.

► **To enter distribution information:**


**See Also**

Entering Release Headers: page 4 – 87
Entering Release Distributions

Use the release Distributions window to enter distribution information for release shipments or to view distributions that Purchasing has automatically created for you. You can enter multiple distributions per shipment line. You can also enter information about paper requisitions in this window.

To enter release distribution information:

1. Navigate to the Distributions window by selecting the Distributions button in the Releases window.
2. Enter the line Number for the distribution line. If you enter a new distribution line, Purchasing displays the next sequential line number available. You can enter any line number greater than zero that does not already exist.

3. For scheduled releases only, enter the Source (the planned purchase order distribution you want to release).

4. The Destination Type determines the final destination of the purchased items. Choose one of the following options:

   - Expense – The goods are delivered to the requestor at an expense location. The destination subinventory is not applicable.

   - Inventory – The goods are received into inventory upon delivery. You can choose this option only if the item is stock enabled in the ship-to organization.

   - Shop Floor – The goods are delivered to an outside processing operation defined by Work in Process. You can choose this option only for outside processing items.

5. Enter the Requestor and Deliver To location for this distribution. If the destination type is Inventory, you can also enter the Subinventory.

6. Enter the Quantity of the purchase order shipment that you want to charge to the Accounting Flexfield. The default value comes from the quantity you enter in the Shipments region. If you decrease the default quantity, Purchasing automatically defaults on the next distribution line the total quantity you have not yet assigned to a distribution line. This quantity is printed on the release.

7. Enter the Charge Account. When you save your changes in this window, Purchasing uses the Account Generator to automatically create the following three accounts for each distribution:

   - Charge: the account to charge for the cost of this item
   - Accrual: the AP accrual account
   - Variance: the invoice price variance account

   If you are using encumbrance control, Purchasing also creates the following account for each distribution:

   - Budget: the encumbrance budget account

The Account Generator creates these accounts based on predefined rules. See: Using the Account Generator in Oracle Public Sector Purchasing: page C–10.
You cannot create or update these accounts manually unless the destination type is Expense. In this case, the default charge account you enter in the Purchases Order Preferences window overrides charge account supplied by the Account Generator, and you can update the charge account in this zone.

For outside processing lines, the cursor does not enter this field during initial entry, since the Account Generator cannot build accounts until you have entered the Resource Sequence in the Outside Processing window.

8. Enter or accept the default Recovery Rate for taxable items.

The recovery rate is the percentage of tax that your business can reclaim for credit. The recovery rate defaults in based on the Tax Code on the release shipment.

You can change the recovery rate if the profile option Tax: Allow Override of Recovery Rate is set to Yes, if the shipment has not yet been received, or while funds are not reserved for the document (if you use encumbrance accounting). Depending on the setup in the Financials Options window and the type of tax, only certain recovery rates may be allowed. See: Recoverable Tax, Oracle Public Sector Payables User’s Guide.

If you change the tax code on the document, Purchasing does not redefault a new recovery rate on the current distributions, but does default it on new distributions.

You can choose to use a different recovery rate for different distributions, even if they use the same tax code.

For an overview of tax in Purchasing, see: Tax Defaults in Purchasing: page 4 – 135.

9. Enter the GL Date you want to use when you reserve your funds.

You can enter a GL Date only if you set up your financials system options to use encumbrance or budgetary control for purchase orders. The default is the current date. See: About Financials Options, Oracle Public Sector Payables User’s Guide. See: Budgetary Control and Online Funds Checking, Oracle Public Sector General Ledger User’s Guide.

If you enter a date that belongs to two separate accounting periods, Purchasing automatically creates a journal entry in the first accounting period that contains this date. See: Controlling Purchasing Periods: page 1 – 93.

The Reserved check box indicates whether you successfully reserved funds for this purchase order distribution. You reserve
To enter distribution detail information:

1. Select the More tabbed region.
   The Online check box indicates whether this distribution is part of an on–line requisition. If so, Purchasing displays the requisition number and line number.

2. If this distribution comes from an on–line requisition, Purchasing displays the Requisition Number and Line number, and you cannot update this field. If this distribution does not come from an on–line requisition, enter the paper requisition number in this field. The default is the paper requisition number from the Purchase Order Preferences window.

   Purchasing displays the Budget Account, Accrual Account, and Variance Account numbers supplied by the Account Generator.

3. Enter the Rate Date for the currency. Purchasing uses this date to obtain the currency conversion rate from your conversion definitions. You cannot enter this field when you edit a purchase order created in your base currency. See: Defining Purchasing Options: page 1 – 45. See: Entering Daily Rates, Oracle Public Sector General Ledger User’s Guide.

4. You can enter the conversion Rate between the foreign currency and the base currency only when the rate type is User. If you entered a rate date for which a conversion rate is defined, Purchasing displays that rate and you cannot change it.

5. Save your work.

To view tax information:
- After you have entered and saved all tax information, do either or both of the following:
• Choose Tax Code Summary from the Tools menu to see the total recoverable and nonrecoverable tax for each tax code in your document. See: Viewing Tax Code Summary Information: page 4 – 138.

• Choose Tax Details from the Tools menu to see recoverable and nonrecoverable tax details for each line, shipment, and distribution. See: Viewing Tax Details: page 4 – 140.

To enter project information:

You see a Project tabbed region if one of the following is true:

• Oracle Projects is installed, or
• Oracle Project Manufacturing is installed and Project Reference Enabled is selected in the Project Manufacturing Organization Parameters window

The project information you enter is used by Oracle Projects for destination types of Expense, or by Oracle Project Manufacturing for destination types of Inventory or Shop Floor. See: Oracle Projects User’s Guide. See: Oracle Project Manufacturing Implementation Manual.

1. Choose the Project tabbed region.

2. Select a Project Number.

   For a Destination Type of Inventory or Shop Floor, you can optionally enter a Project Number if the Project Control Level is set to Project in the Project Information tabbed region of the Organization Parameters window.

   For a Destination Type of Expense, you can always optionally enter a Project Number.

3. If you entered a Project number, select a Task number.

   You must enter a Task number for a Destination Type of Inventory or Shop Floor, if the Project Control Level is set to Task in the Organization Parameters window and if you have entered a Project number.

4. If you entered a Project Contract number for the agreement line that you are releasing you may enter additional details about that contract here.

   Enter the project Contract Line number and Deliverable number for the contract that corresponds to this distribution.

5. Enter Expenditure information.
Expenditure information is required only if your Destination Type is Expense.

- Select the Expenditure Type.
- If you chose an Expenditure Type, enter an Expenditure Organization.
- If you chose an Expenditure Organization, select the Expenditure Date.

6. Note that the distribution Quantity that will be charged to the project should already be entered for you.

If you change the Quantity here, then the distribution Quantity on the release line changes as well.

7. Note that a Unit Number field is visible if Project Manufacturing is installed.

If the item is under model/unit effectivity control, you must select an end-item model Unit Number. This field is disabled if the item is not under model/unit effectivity control. See: Model/Unit Effectivity, Oracle Project Manufacturing Implementation Manual.

**Note:** You can also view the Unit Number as a hidden field in the Purchase Order Distributions summary window.

8. Save your work.

The Charge, Budget, Accrual, and Variance accounts in the Account Description region are generated automatically. See: Using the Account Generator in Oracle Public Sector Purchasing: page C – 10.

**See Also**

- Entering Release Headers: page 4 – 87
- Entering Release Shipments: page 4 – 90
- Viewing Action History: page 8 – 2
- Entering Purchase Order Preferences: page 4 – 34
Automatic Release Generation

You can minimize purchase order administrative costs by automatically creating releases for both manually entered and imported requisitions.

Purchasing provides you with the features you need to satisfy the following basic needs. You should be able to:

- Automatically create a release when you source your items from a single supplier using a single blanket purchase agreement.
- Specify for each blanket agreement whether you want to create approved releases automatically, create releases automatically but require manual approval, or require the use of the AutoCreate Documents window to create releases.
- Run the Create Release process automatically as part of the Requisition Import process.

Major Features

Flexible Sourcing Definitions

When you are defining your sourcing rules and Approved Supplier List entries, you can also define how you want your releases generated. Automatic Release automatically converts approved requisition lines to approved blanket purchase releases based on the sourcing rules and Approved Supplier List entries. Automatic Release/Review automatically converts approved requisition lines to blanket releases. Buyers can then review and modify these releases before approving them. Release Using Autocreate lets buyers use the AutoCreate Documents window to collect, review, and optionally modify requirements before creating and approving their releases. See: Autocreating Documents Overview: page 6 – 2.

You can define a different release generation method for each item and supplier. For frequently purchased items, you can set up Purchasing to automatically create and approve releases. For expensive or critical items, you can let Purchasing create the releases, while you review and approve them in a separate step. For infrequent purchases, your buyers can take more control by using the AutoCreate Documents window to combine requests.

You must set up a suggested blanket purchase agreement in the Approved Supplier List window so that Purchasing can use the price and ship–to information when it is generating releases against the agreement. See: Defining the Supplier/Item Attributes: page 5 – 51.
**Generate Releases Automatically**

The Create Releases process generates releases when the following criteria are met:

- The requisition is sourced to an approved blanket purchase agreement that is not on hold
- The Approved Supplier List entry for the item, supplier, and agreement must be active, and the Release Generation method must be Automatic Release or Automatic Release/Review in the Approved Supplier List window
- The source agreement is still active and the release will not put the agreement over the amount limit
- The release amount must be greater than the minimum line release amount
- The supplier on the source agreement is active and not on hold
- The requisition line is Approved (and Reserved, if requisition encumbrance is active)
- The requisition line is not cancelled, closed, or already on a purchase order
- The line type of the requisition line is quantity based

**Note:** If the release generation method in the Approved Supplier List window is Automatic Release or Automatic Release/Review, then the Create Releases process creates the release. If the release generation method is Release Using AutoCreate, then the PO Create Documents workflow tries to create the release; if it cannot, then you must use the AutoCreate Documents window to create the release.

If the release generation method is Automatic Release, the process sets the status to Approved and updates the action history. Otherwise, the process sets the status to Incomplete and updates the notifications.

Purchasing automatically creates releases for requirements entered by any source: Work in Process, Master Scheduling/MRP, Inventory Planning, purchase requisitions, or external systems.

For foreign currency blanket purchase agreements, the automatic release process uses the rate on the agreement as the default rate for the release and translates the functional unit price on the requisition into the foreign currency price. Automatically generated releases use the price retrieved by sourcing, which is price break sensitive but does not consider the quantity already released against the blanket purchase agreement.
The Create Releases process creates a release for each source blanket purchase agreement, with a release shipment for each requisition line and a release distribution for each requisition distribution. If release archiving is set to Approve, the process updates the archive table for the release, shipments, and distributions. See: Create Releases Process: page 9 – 36.

If you’ve set up a tax defaulting hierarchy in the Tax Defaults region of the Purchasing Options window, the appropriate tax codes automatically default onto the release shipments created by the Create Release process. See: Defining Tax Defaults Options: page 1 – 55.

**Variable Release Generation Frequency**

You can determine how often Purchasing creates releases by using the Submit Requests window to set the Create Releases process to run automatically at any frequency you desire. You can also use the Submit Requests window to run the process manually.

Optionally, you can set the profile PO: Release During ReqImport to create releases each time you run the Requisition Import process. For example, when you implement planned orders as requisitions in the MRP Planner Workbench, you can automatically create the releases at the same time you create the requisitions. As part of the Requisition Import process, Purchasing automatically creates (and optionally approves) releases for all blanket–sourced, approved requisitions, not just those created by the Requisition Import run.

**See Also**

AutoCreate Documents Overview: page 6 – 2
Workflow for Creating Purchase Orders or Releases: page C – 209
Profile Options in Purchasing: page 1 – 103
Automatic Sourcing: page 5 – 30
Create Releases Process: page 9 – 36
Requisition Import Process: page 9 – 144
Submitting a Request, *Oracle Applications System Administrator’s Guide*
Copying Purchase Orders

You can copy the following purchase order types from one document to the other as shown in the following table:

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard purchase order</td>
<td>Standard purchase order</td>
</tr>
<tr>
<td>Blanket purchase agreement</td>
<td>Blanket purchase agreement</td>
</tr>
<tr>
<td>Blanket purchase agreement</td>
<td>Request for quotation</td>
</tr>
<tr>
<td>Planned purchase order</td>
<td>Planned purchase order</td>
</tr>
<tr>
<td>Bid quotation (Bid quotation class)</td>
<td>Standard or planned purchase order</td>
</tr>
<tr>
<td>Self–defined Bid quotation (Bid quotation class)</td>
<td>Standard or planned purchase order</td>
</tr>
<tr>
<td>Catalog or Standard quotation (Catalog quotation class)</td>
<td>Blanket purchase agreement</td>
</tr>
<tr>
<td>Self–defined Catalog or Standard quotation (Catalog quotation class)</td>
<td>Blanket purchase agreement</td>
</tr>
</tbody>
</table>

For example, if you want to renew a blanket purchase agreement that contains hundreds of lines, you can copy the previous agreement to a new agreement and change the effectivity dates.

To copy documents:

1. Query the document you want to copy from the Purchase Orders, Purchase Order Summary, or Quotations windows.
2. With the document selected, choose Copy Document from the Tools menu.
3. Select an eligible To Document Type.
   You can change the To Document Type only if you’re copying from a Bid class quotation or a Blanket Purchase Agreement.

4. Select other options if needed.

   **Document Number**: Enter a document number only if you use manual numbering. If you use automatic numbering, a document number will be created for you after you choose OK. You cannot use the Copy Documents window to modify documents by copying from one document to another with the same document number.

   **Copy Attachments**: Check this box to copy an attachment from any level of the document.

   **Copy Blanket Price to RFQ**: Check this box to copy the purchase price to the target price when copying a blanket agreement to an RFQ (request for quotation).

5. Choose OK.

   Purchasing creates and displays the new document. The document is an exact copy of the original except for the Promised By and Need By dates; if these dates are past dates, they change to today’s date on the new document. Effectivity dates, if any, do not change.

   If you are copying a cancelled document, the Note to Supplier field will be blank. This is because a cancelled document changes the
Note to Supplier to an explanation that the document was cancelled. Therefore, when you copy the cancelled document, the Note to Supplier is left blank.

6. Modify the document if you need to.

When you copy a quotation to a purchase order, project and task information from the quotation, if any, is copied to the purchase order distribution when you create the distribution or save the purchase order. (This is because project information is associated with the quotation line, but must be associated with the distribution on the purchase order.)

Information from the copied document overrides any information in the purchase order preferences, if you are copying to a purchase order.

7. Save and approve the document.

If information in the document you have just copied is invalid or outdated—for example, if a supplier or account is inactive or invalid—a message window appears after you choose Approve. Use this window to help you identify and correct invalid or outdated fields in the new document you’re creating. You cannot approve the document until you update these fields appropriately.

See Also

Defining Document Types: page 1 – 87
Types of Quotations and RFQs: page 5 – 7
Copying Quotations from RFQs: page 5 – 88
Printed Purchase Order Overview

Purchasing formats your purchase orders to be printed on a standard purchase order form. This section explains how Purchasing prints the purchase order information. You can use the standard format or customize the report to meet your needs.

Multilingual Support

If you use Multilingual Support (MLS), you can print most of the fields on the following reports in another language:

- Printed Purchase Order Report (Landscape)
- Printed Purchase Order Report (Portrait)
- Printed RFQ Report (Landscape)
- Printed RFQ Report (Portrait)
- Printed Change Orders Report (Landscape)
- Printed Change Orders Report (Portrait)

See: Submitting a Request, Oracle Applications User’s Guide.

Note: You can print item descriptions in other languages only for inventory items for which translations have been entered. If you change the item description on the document, it does not print in the translated language.

Major Features

Portrait and Landscape Formats

Purchasing lets you print your purchase orders in portrait or landscape format. Use the Submit Requests window to choose either the Printed Purchase Order Report (Landscape) or the Printed Purchase Order Report (Portrait). The explanations that follow describe both portrait and landscape characteristics. See: Submitting a Request, Oracle Applications User’s Guide.

Printed Change Orders Report

In addition to the Printed Purchase Order Report, you can also use the Submit Requests window to choose the Printed Change Orders Report in portrait or landscape formats. This prints only the changes between revisions of purchase orders, but is otherwise identical to the Printed Purchase Order Report. When you have purchase orders with many
lines, you can print only pertinent change information to send to the supplier. If a modification to the purchase order shipment causes the purchase order revision to change, the Printed Change Orders Report prints the revised shipment, line, and header. If the modification is to the line, the report prints the revised line and header. If only the header is modified, the report prints only the header. Note that the report does not include purchase orders for which only the distribution is modified.

**Brief Notes**

Purchasing prints the brief notes to supplier that you attach to the purchase order header or line. These notes can contain up to 240 characters. Purchasing automatically wraps the notes after 103 characters per line for landscape orientation and 75 for portrait. These notes may wrap in the middle of a word to ensure the correct line count for each page.

**Attachments**

Purchasing prints all text attachments with a usage of Supplier on the purchase order. These notes contain up to 64K characters per note. You can attach as many notes as you want to the purchase order headers and lines. Purchasing also prints text attachments to the items. Purchasing prints 78 characters per line and automatically wraps to the next line. The note appears on the purchase order exactly as you enter it. See: Attaching Notes to Purchasing Documents: page 1 – 44.

**Facsimiles**


**Purchase Agreements**

Purchasing prints **Purchase Agreement** on all your blanket purchase agreements. Purchasing prints **Purchase Agreement Release** on all your releases.

Purchasing also prints the following messages on contract and blanket purchase agreements. If you provide effective dates on your contract or blanket purchase agreements, Purchasing prints **EFFECTIVE FROM**
[start effective date] TO [end effective date]. If you provide an effective start date without an effective end date, Purchasing prints only EFFECTIVE FROM [start effective date]. If you provide an effective end date without an effective start date, Purchasing prints only EFFECTIVE TO [end effective date].

**Cancelled Orders**

Purchasing automatically indicates whether you cancelled any part of your purchase order. If you cancel the purchase order header, Purchasing prints the following cancellation message at the top of the purchase order and does not print cancellation messages for lines or shipments:

- **This purchase order CANCELLED on:** [date]

If you cancel a purchase order release, Purchasing prints the following cancellation message:

- **This release CANCELLED on:** [date]

If you cancel a blanket purchase agreement line without cancelling the corresponding header, Purchasing prints the following cancellation messages:

- **This purchase order line CANCELLED on:** [date]
- **Original quantity ordered:** [quantity]
- **Quantity CANCELLED:** [quantity]

If you cancel a purchase order shipment without cancelling the corresponding purchase order line, Purchasing prints the following messages. Purchasing also prints these messages for each shipment if you cancel the corresponding purchase order line.

- **This shipment CANCELLED on:** [date]
- **Original shipment quantity:** [quantity]
- **Quantity CANCELLED:** [quantity]


**Confirming Orders**

You designate whether a purchase order is a confirming order when you enter the purchase order header information. If you select Confirming Order in the Purchase Order Details window, Purchasing automatically prints CONFIRMATION — DO NOT DUPLICATE.

Foreign Currency

If you designate that a purchase order is in a different currency than your base currency, Purchasing prints **All prices and amounts on this order are expressed in:** [foreign currency]. You designate the currency when you create the purchase order.

Acceptances

If you require an acceptance from your supplier, Purchasing prints the following message: **Please formally accept this order by:** [acceptance date]. You designate whether you require an acceptance when you create the purchase order. When you indicate that you require an acceptance, you also provide an acceptance date by which you expect your supplier to respond. See: Entering and Viewing Purchase Order Acceptances: page 4 – 84.

UN Number

If you associate a UN number with a purchase order line, Purchasing prints **UN Number:** [UN number and description]. The UN number and description can contain up to 240 characters. Purchasing prints 87 characters per line for landscape orientation (60 for portrait) and automatically wraps to the next line. See: Purchasing Hazardous Materials: page 1 – 67.

Hazard Class

If you associate a hazard class with a purchase order line, Purchasing prints **Hazard Class** [hazard class name]. Purchasing prints up to 87 characters per line for landscape orientation (60 for portrait). See: Purchasing Hazardous Materials: page 1 – 67.

Contract Purchase Agreement References

Purchasing prints the following message for each standard purchase order line that references a contract number: **This PO line references contract PO#** [contract number]. You associate a contract purchase agreement number with a standard purchase order line when you create the purchase order.

Quotation References

Purchasing prints the following message for each purchase order line that references a quotation number: **This PO line references Quotation #:** [supplier quotation number] **Line:** [line number] **Your Quotation #:** [purchase order quotation number]. You associate a
quotation number with a purchase order line when you create the purchase order.

**Automatic Table Update**

Purchasing automatically updates the item history table when you print your purchase order for each revision. Purchasing records the item, supplier, quantity, unit of measure, price, and purchase order number. This information is available when you view last price and history information. See: Overview of the Supplier Item Catalog: page 5 – 8.

**Printed Purchase Order Diagram Descriptions**

The following descriptions include both portrait and landscape explanations.

<table>
<thead>
<tr>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PO Number</strong></td>
<td>Purchasing prints the purchase order number. If the order is a release, Purchasing prints a dash (‘–’) after the purchase order number followed by the release number. (12 characters, portrait and landscape)</td>
</tr>
<tr>
<td><strong>Revision</strong></td>
<td>Purchasing prints the purchase order revision. (4 characters, portrait and landscape)</td>
</tr>
<tr>
<td><strong>Page</strong></td>
<td>Purchasing prints the page number. (3 characters, portrait and landscape)</td>
</tr>
<tr>
<td><strong>Ship To</strong></td>
<td>The ship to information contains up to 3 lines of address. After the address, Purchasing prints the city, state (or province), and zip code on the line 4. On line 5, Purchasing prints the country. Purchasing prints the ship to location even if it is the same as the bill to location. (portrait – 28 characters for line 1 through 4 lines, 25 characters for line 5; landscape – 30 characters for lines 1 through 4, 25 characters for line 5)</td>
</tr>
<tr>
<td><strong>Bill To</strong></td>
<td>The bill to information contains up to 3 lines of address. After the address, Purchasing prints the city, state (or province), and zip code on the line 4. On the line 5, Purchasing prints the country. (portrait – 28 characters for line 1 through 4 lines, 25 characters for line 5; landscape – 30 characters for lines 1 through 5)</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Supplier</td>
<td>Purchasing prints the supplier name on line 1. Purchasing then prints up to 3 lines of address. On line 5, Purchasing prints the city, state (or province), and zip code. Purchasing prints the country on line 6. (portrait – 40 characters for line 1, 35 characters for lines 2 through 4, 42 characters for line 5; landscape – 42 characters for line 1, 35 characters for lines 2 through 6)</td>
</tr>
<tr>
<td>Supplier No.</td>
<td>Purchasing prints the number for your supplier. (portrait – 13 characters; landscape – 9 characters)</td>
</tr>
<tr>
<td>Date Of Order/Buyer</td>
<td>Purchasing prints the original buyer and creation date. (portrait – first initial of first name and 10 characters of last name; landscape – first initial of first name and 11 characters of last name)</td>
</tr>
<tr>
<td>Revised Date/Buyer</td>
<td>If you revise the purchase order and do not change the name of the original buyer, Purchasing prints the original buyer’s name and the date of the revision. If you change the buyer’s name, the new name is printed. If you have not yet revised the purchase order, Purchasing leaves this field blank. (portrait – first initial of first name and 10 characters of last name; landscape – first initial of first name and 11 characters of last name)</td>
</tr>
<tr>
<td>Payment Terms</td>
<td>Purchasing prints the payment terms for your purchase order. (portrait – 27 characters; landscape – 21 characters)</td>
</tr>
<tr>
<td>Ship Via</td>
<td>Purchasing prints the mode of transportation for the items on the purchase order. (portrait – 22 characters; landscape 22 characters)</td>
</tr>
<tr>
<td>FOB</td>
<td>Purchasing prints the free on board terms. (portrait – 28 characters; landscape 20 characters)</td>
</tr>
<tr>
<td>Freight Terms</td>
<td>Purchasing prints the freight terms code that explains the condition of the freight charges and the party responsible for the freight. (portrait – 27 characters; landscape – 21 characters)</td>
</tr>
</tbody>
</table>

*Purchasing prints the first initial and last name rendered as follows:* portrait – first initial of first name and 10 characters of last name; landscape – first initial of first name and 11 characters of last name.*
Requestor/Deliver To
If the standard purchase order is for one requestor only, Purchasing prints the full first and last name of the requestor. For multiple requestors, Purchasing prints Many. (portrait – 22 characters; landscape – 52 characters)

Confirm/Telephone
Purchasing prints the contact name and contact phone number. (portrait – first initial of first name, up to 10 characters of last name, 15 characters for the phone number; landscape – 37 characters for first and last name combined, 16 characters for the phone number)

Standard/Planned Purchase Order Components
Purchasing prints the main text underneath the Item title on the purchase order. Purchasing first prints header information followed by line, shipment, and distribution information.

For single shipments with the same ship-to address as the header, Purchasing pulls all information up to the line level and blanks out the shipment level entirely, regardless of other factors. For multiple shipments or a single shipment with a different ship-to address from the header, Purchasing prints information at both shipment and line levels.

Standard and Planned Purchase Order Header
Standard and planned purchase orders print the following header information if it pertains to the purchase order:

• Brief Supplier Note
• Long Supplier Note
• This purchase order CANCELLED on: [date].
• CONFIRMATION — DO NOT DUPLICATE
• All prices and amounts on this order are expressed in [foreign currency].

Standard and Planned Purchase Order Lines
After printing the header information, Purchasing prints the following line information:

Line
Purchasing prints the purchase order line number.
**Item Number/Description** Purchasing prints your item number first. If you have an item revision number, Purchasing prints [revision number]. If you specify a supplier item number, Purchasing prints (Your #: [supplier item number]) on the next line. Purchasing then prints the item description on the following line. (portrait – wraps after 23 characters per line, landscape – wraps after 45 characters per line)

**Delivery Date** Purchasing prints dates only for single shipments. If you provided a promised date, Purchasing prints the promised date. If you do not provide a promised date or a last date, but you provide a need by date, Purchasing prints the need by date. Otherwise, this space is blank.

**Quantity** Purchasing prints the quantity of the item you are ordering if the line type is quantity–based (in number format 9999999999 with any existing decimal places, portrait and landscape)

**Unit** Purchasing prints the item unit of measure for quantity–based items (4 characters, portrait and landscape)

**Unit Price** Purchasing prints the item unit price if the line type is quantity–based (in number format 999999999999 with any existing decimal places in the precision associated with the currency, portrait and landscape)

**Extension** Purchasing prints the total amount of the line. This number is the product of the quantity and unit price. (in number format 999999999999 with any existing decimal places in the precision associated with the currency, portrait and landscape). For amount–based line types, Purchasing prints the price extension only for single shipments.

**Tax** For single shipments, Purchasing prints Y or N to indicate whether this is a taxable item.

After printing the first line of the purchase order, Purchasing prints the following if they pertain to the purchase order:

- **UN Number**: [UN number and description]
- **Hazard Class**: [hazard class name]
- **Brief Supplier Line Note**
• Long Supplier Line Notes
• This PO line references contract PO# [contract number]
• This PO line references your Quotation #: [quotation number]

Standard and Planned Purchase Order Shipments

After printing each line, Purchasing prints the following shipment information:

• o (This symbol indicates a distinct shipment)
• SHIP TO: [ship to address]. If the ship to address is the same as the one for the purchase order header, Purchasing prints Address at top of page directly below the SHIP TO: note without printing the address again. This address contains up to 3 lines of address. On line 4, Purchasing prints the city, state (or province), state, and zip code. On line 5, Purchasing prints the country. (35 characters for lines 1 through 5, portrait and landscape)

After printing the bullet and address to signify a new shipment, Purchasing prints the following information:

Delivery Date  If you provided a promised date, Purchasing prints the promised date. If you do not provide a promised date or a last date, but you provide a need by date, Purchasing prints the need by date. Otherwise, this space is blank.

Quantity  Purchasing prints the quantity of the item you are ordering for quantity–based items (in number format 999999999 with any existing decimal places, portrait and landscape)

Unit  Purchasing prints the item unit of measure for quantity–based items (4 characters, portrait and landscape)

Extension  For multiple shipments of amount–based line types, Purchasing prints the total amount of the line. This number is the product of the quantity and item price override. (in number format 9999999999999 with any existing decimal places in the precision associated with the currency, portrait and landscape)

Tax  Purchasing prints Y or N to indicate whether this is a taxable item. For amount–based line types,
Purchasing prints the tax flag only for multiple shipments.

If you cancelled a shipment, Purchasing prints the following information:

- **This shipment CANCELLED on:** [date]
- **Original shipment quantity:** [quantity]
- **Quantity CANCELLED:** [quantity]

**Standard and Planned Purchase Order Distributions**

After printing each shipment, Purchasing prints the following distribution information:

- **DELIVER TO:**
  - [Last Name], [First Name] [Middle Initial] ([quantity ordered]) if you provided a requestor name on your purchase order distribution and if there is more than one distribution. (54 characters, portrait and landscape)

**Agreement/Release Components**

**Blanket/Contract Purchase Agreement Header**

Purchasing prints the following header information if it pertains to the purchase order:

- Brief Supplier Note
- Long Supplier Notes
- **PURCHASE AGREEMENT**
- **EFFECTIVE FROM** [start effective date] **TO** [end effective date]
  - or
- **EFFECTIVE FROM** [start effective date], or
- **EFFECTIVE TO** [end effective date]
- **Total agreement amount:** [amount agreed].
- **This purchase order CANCELLED on:** [date]
- **CONFIRMATION — DO NOT DUPLICATE**
- **All prices and amounts on this order are expressed in** [foreign currency].
Blanket Purchase Agreement Lines

After printing the header information, Purchasing prints the following line information:

<table>
<thead>
<tr>
<th>Line</th>
<th>Purchasing prints the purchase agreement line number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Number/Description</td>
<td>Purchasing prints your item number first. If you have an item revision number, Purchasing prints [revision number]. If you specify a supplier item number, Purchasing prints (Your #: [supplier item number]) on the next line. Purchasing then prints the item description on the following line. (portrait – wraps after 23 characters per line, landscape – wraps after 45 characters per line)</td>
</tr>
<tr>
<td>Quantity</td>
<td>Purchasing prints the quantity committed of the item you are ordering for quantity–based items (in number format 9999999999 with any existing decimal places, portrait and landscape)</td>
</tr>
<tr>
<td>Unit</td>
<td>Purchasing prints the item unit of measure for quantity–based items (4 characters, portrait and landscape)</td>
</tr>
<tr>
<td>Unit Price</td>
<td>Purchasing prints the item unit price for quantity–based items (in number format 999999999999 with any existing decimal places in the precision associated with the currency, portrait and landscape)</td>
</tr>
<tr>
<td>Extension</td>
<td>Purchasing prints the total amount committed for the line. This number is the product of the quantity and unit price. (in number format 9999999999999 with any existing decimal places in the precision associated with the currency, portrait and landscape). For amount–based line types, Purchasing prints the price extension only for single shipments.</td>
</tr>
</tbody>
</table>

After printing the first line of the purchase order, Purchasing prints the following information if it pertains to the purchase order:

- **UN Number:** [UN number and description]
- **Hazard Class:** [hazard class name]
- **This purchase order line CANCELLED on:** [date]
- **Original quantity ordered:** [quantity]
- **Quantity CANCELLED** [quantity]
- Brief Supplier Line Note
- Long Supplier Line Notes
- **This PO line references your Quotation #:** [quotation number]

**Blanket Purchase Agreement Release Header**

Purchasing prints the following header information if it pertains to the release:

- Brief Supplier Note from Blanket Purchase Agreement
- Long Supplier Note from Blanket Purchase Agreement
- **BLANKET AGREEMENT RELEASE** (for blanket releases)
- **PLANNED PURCHASE ORDER RELEASE** (for scheduled releases)
- **This release CANCELLED on:** [date]
- **All prices and amounts on this order are expressed in** [foreign currency].

**Blanket Purchase Agreement Release Lines**

After printing the header information, Purchasing prints the following line information:

<table>
<thead>
<tr>
<th>Line</th>
<th>Purchasing prints the purchase order line number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Number/Description</td>
<td>Purchasing prints your item number first. If you have an item revision number, Purchasing prints [revision number]. If you specify a supplier item number, Purchasing prints <em>(Your #: [supplier item number]</em>) on the next line. Purchasing then prints the item description on the following line. <em>(portrait – wraps after 23 characters per line, landscape – wraps after 45 characters per line)</em></td>
</tr>
<tr>
<td>Unit Price</td>
<td>Purchasing prints the item unit price for quantity–based items <em>(in number format 999999999999 with any existing decimal places in the precision associated with the currency, portrait and landscape)</em></td>
</tr>
</tbody>
</table>

After printing the first line of the purchase order, Purchasing prints the following information if it pertains to the purchase order:

- **UN Number:** [UN number and description]
• **Hazard Class:** [hazard class name]
• **This purchase order line CANCELLED on:** [date]
• **Original quantity ordered:** [quantity]
• **Quantity CANCELLED** [quantity]
• Brief Supplier Line Note
• Long Supplier Line Notes
• **This PO line references your Quotation #:** [quotation number]

**Blanket Purchase Agreement Release Shipments**

After printing each line, Purchasing prints the following shipment information:

• o (This symbol indicates a distinct shipment)

• **SHIP TO:** [ship to address]. If the ship to address is the same as the purchase order header address, Purchasing prints **Address at top of page** directly below the **SHIP TO:** note without printing the address again. This address contains up to 3 lines of address. On line 4, Purchasing prints the city, state (or province), and zip code. On line 5, Purchasing prints the country. (35 characters for lines 1 through 3, 74 characters for line 4, and 25 characters for line 5, portrait and landscape)

After printing the bullet and address to signify a new shipment, Purchasing prints the following information:

**Delivery Date** If you provided a promised date, Purchasing prints the promised date. If you do not provide a promised date or a last date, but you provide a need by date, Purchasing prints the need by date. Otherwise, this space is blank.

**Quantity** Purchasing prints the quantity of the item you are ordering for quantity–based items (in number format 9999999999 with any existing decimal places, portrait and landscape)

**Unit** Purchasing prints the item unit of measure for quantity–based items (4 characters, portrait and landscape)

**Unit Price** Purchasing prints the item price override for quantity–based items (in number format 999999999999 with any existing decimal places in
the precision associated with the currency, portrait and landscape)

**Extension**

Purchasing prints the total amount of the line. This number is the product of the quantity and item price override. (in number format 9999999999999 with any existing decimal places in the precision associated with the currency, portrait and landscape)

**Tax**

Purchasing prints Y or N to indicate whether this is a taxable item.

If you cancelled a shipment, Purchasing prints the following information:

- **This shipment CANCELLED on:** [date]
- **Original shipment quantity:** [quantity]
- **Quantity CANCELLED:** [quantity]

**Blanket Purchase Agreement Release Distributions**

After printing each shipment, Purchasing prints the following distribution information:

- **DELIVER TO:**
  - [Last Name], [First Name] [Middle Initial] ([quantity ordered]) if you name the requestor. **Unspecified** ([quantity ordered]) otherwise. (45 characters, portrait and landscape)

**Total**

Purchasing prints **Continued** at the bottom of every page except for the last page of the purchase order. Purchasing prints the sum of the purchase order lines on the bottom of the last page.
Document Revision Numbering

You can create *multiple* revisions of your purchasing documents (planned and standard purchase orders and blanket and contract purchase agreements). Use the Document Types window to set whether each of these documents is archived upon approval or upon printing. All revisions begin at 0, and Purchasing increments this revision number by 1 when you make changes to controlled information and the current revision number is equal to the archived number. As a result, the first revision that you print might not be 0 if you are archiving on approval.


The following tables illustrate the difference between archiving on approval and on printing:

**Archiving On Approval**

<table>
<thead>
<tr>
<th>Action</th>
<th>Archive Rev</th>
<th>Current Rev</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1. Create purchase order</td>
<td>None</td>
<td>0</td>
</tr>
<tr>
<td>Step 2. Approve purchase order</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Step 3. Change controlled info</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Step 4. Approve purchase order</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Step 5. Print purchase order</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

Table 4 – 6 (Page 1 of 1)

**Archiving On Print**

<table>
<thead>
<tr>
<th>Action</th>
<th>Archive Rev</th>
<th>Current Rev</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1. Create purchase order</td>
<td>None</td>
<td>0</td>
</tr>
<tr>
<td>Step 2. Approve purchase order</td>
<td>None</td>
<td>0</td>
</tr>
<tr>
<td>Step 3. Change controlled info</td>
<td>None</td>
<td>0</td>
</tr>
<tr>
<td>Step 4. Approve purchase order</td>
<td>None</td>
<td>0</td>
</tr>
</tbody>
</table>

Table 4 – 7 (Page 1 of 2)
<table>
<thead>
<tr>
<th>Action</th>
<th>Archive Rev</th>
<th>Current Rev</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 5. Print purchase order</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Step 6. Change controlled information</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Step 7. Approve purchase order</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Step 8. Change controlled information</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Step 9. Print purchase order</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

Table 4 – 7  (Page 2 of 2)
The following tables describe the additions and changes that cause Purchasing to increment document revision numbers in each of the document components:

<table>
<thead>
<tr>
<th>Header Information</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buyer</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Contact</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Confirm</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Ship–To</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Bill–To</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Payment Terms</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Freight Carrier / Ship Via</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>FOB</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Freight Terms</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Brief Note to Supplier</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Acceptance Required</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Acceptance Due Date</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Amount Limit</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Effective Date</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Cancel Flag</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Amount Agreed</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Release Number</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Release Date</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Confirming Order</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

Table 4 – 8  (Page 1 of 1)
<table>
<thead>
<tr>
<th>Line Information</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit Price</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Line Number</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Item Revision</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Item Description</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Payment Terms</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quantity</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Source Quotation</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Header</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Source Quotation Line</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hazard Class</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UN Number</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contract Number</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supplier Item Number</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Brief Note to Supplier</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Price Type</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quantity Agreed</td>
<td></td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Amount Agreed</td>
<td></td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Closed Code</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Cancel Flag</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

Table 4 – 9  (Page 1 of 1)
<table>
<thead>
<tr>
<th><strong>Price Break Information</strong></th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ship–To Location</td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quantity</td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Break Price</td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Price Break Number</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 4 – 10  (Page 1 of 1)

<table>
<thead>
<tr>
<th><strong>Shipment Information</strong></th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shipment Number</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Ship–To</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Quantity</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Promise Date</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Need–By Date</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Last Acceptance Date</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Taxable</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Shipment Price</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Cancel Flag</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

Table 4 – 11  (Page 1 of 1)

<table>
<thead>
<tr>
<th><strong>Distribution Information</strong></th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantity</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Requestor</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Distribution Number</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
<td>✔️</td>
</tr>
</tbody>
</table>

Table 4 – 12  (Page 1 of 1)
Document Reapproval Rules

Documents are unapproved when you add or change specific information, regardless of whether the revision is incremented. Almost all changes that cause the revision to be incremented also unapprove the document, as does placing the document on hold. However, if you change the line level Brief Note to Supplier, cancel the document or its entities, or change the Firm Demand flag or receiver note, the document does not require reapproval.

Controlled changes unapprove either the document header alone, or both the header and its shipments. However, you can continue to receive against approved shipments even when the header is unapproved.

You can also control whether—or how much of—a revision (for example, to Quantity) requires the document to undergo the entire approval process or to be instantly approved. See: Workflow Processes for Approving Change Orders: page C – 171.

The following tables describe the additions and changes you can make that cause Purchasing to unapprove a document.

Header Changes Unapproves Header

<table>
<thead>
<tr>
<th>Header Information</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buyer</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Contact</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Confirm</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Ship–To</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Bill–To</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Payment Terms</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Ship via</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>FOB</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Freight Terms</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Brief Note to Supplier</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Acceptance Required</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Table 4 – 13  (Page 1 of 2)
### Header Information

<table>
<thead>
<tr>
<th></th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acceptance Due Date</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Amount Limit</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Effective Date</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Expiration Date</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Amount Agreed</td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Release Number</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Release Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔️</td>
</tr>
</tbody>
</table>

Table 4 – 13  (Page 2 of 2)

### Line Changes Unapproves Header

<table>
<thead>
<tr>
<th></th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit Price</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Line Number</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Item Revision</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Item Description</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Item Category</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quantity</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Source Quotation Header</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Source Quotation Line</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hazard Class</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contract Number</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supplier Item Number</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UN Number</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 4 – 14  (Page 1 of 2)
### Line Information

<table>
<thead>
<tr>
<th>Line Information</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Price Type</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Price Limit</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quantity Agreed</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amount Agreed</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Brief Note to Supplier</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Promised Date</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Need–By Date</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capital Expense</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 4 – 14  (Page 2 of 2)

### Price Break Changes Unapproves Header

<table>
<thead>
<tr>
<th>Price Break</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ship–To Location</td>
<td></td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quantity</td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Break Price</td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Discount</td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 4 – 15  (Page 1 of 1)
### Shipment Changes Unapproves Header and Shipment

<table>
<thead>
<tr>
<th>Shipment</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shipment Number</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Ship-To</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Quantity</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Promise Date</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Need–By Date</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Last Acceptance Date</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Taxable (Header only)</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Shipment Price</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
</tbody>
</table>

Table 4 – 16  (Page 1 of 1)

### Distribution Changes Unapproves Header and Shipment

<table>
<thead>
<tr>
<th>Distribution</th>
<th>Standard</th>
<th>Planned</th>
<th>Blanket</th>
<th>Contract</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distribution Number (Header Only)</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Quantity</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Requestor (Header Only)</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Charge Account</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Subinventory</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
</tr>
</tbody>
</table>

Table 4 – 17  (Page 1 of 1)
Changing Encumbered Documents

You can make changes to a purchase order for which funds have already been reserved (or encumbered). You do this by temporarily unreserving the document, making the desired changes, and reserving the document again. The Unreserve action takes place at the header level only; it affects all lines on a purchase order, and changes the document’s status to Requires Reapproval.

**Note:** If the appropriate approver modifies an encumbered requisition, Purchasing unreserves the requisition automatically.

**To make changes to an encumbered purchase order:**

1. Choose the Approve button.
   The Approve Document window appears.
2. Select Unreserve.
   The Unreserve option is available only if funds are currently reserved for at least one line in your document.
3. Enter an Unreserve Date that falls within an open reserve period.
4. Choose OK.
5. Make your changes to the document and choose Approve again.
6. In the Approve Document window that appears, select Reserve to reserve funds again for the document.
7. Select Submit for Approval and choose OK to resubmit the document for approval.

See Also

- Submitting a Document for Approval: page 2 – 35
- Document Reapproval Rules: page 4 – 128
- Overview of Encumbrance Accounting, *Oracle Public Sector General Ledger User’s Guide*
Drop Shipments

Oracle Order Management and Oracle Public Sector Purchasing integrate to provide drop shipments. Drop shipments are orders for items that your supplier ships directly to the customer either because you don’t stock or currently don’t have the items in inventory, or because it’s more cost–effective for the supplier to ship the item to the customer directly.

Drop shipments are created as sales orders in Order Management. The Purchase Release concurrent program or workflow in Order Management creates rows in the Requisition Import tables in Purchasing. Then Purchasing’s Requisition Import process creates the requisitions. Drop shipments are marked with the Source Type of External in Order Management and Supplier in Purchasing.

When the drop shipment has been sent to the customer, the supplier can confirm the shipment through a phone call, an invoice, or an Electronic Data Interchange (EDI) document, such as an Advance Shipment Notice (ASN).

When you receive confirmation of a drop shipment, create a receipt against the shipment, even though you have not received the item physically (because your customer has received it directly). Even if your supplier sends an invoice, create the receipt for it. This creates inbound and outbound material transactions in your system for accounting purposes.

Drop shipments support a Destination Type of Expense or Inventory only.

You can handle returns of drop shipments using standard Order Management or Purchasing functionality. There are different ways you may want to handle returns depending on whether the customer returned the item to you or directly to the supplier.

**Note:** You should not drop–ship internal sales orders.

See the section Drop Shipments and the section Drop–Ship Order Flow in the *Oracle Order Management User’s Guide*. 
See Also

Advanced Shipment Notices (ASNs): page 7 – 17
Returns: page 7 – 76
Entering Receipt Header Information: page 7 – 32
Entering Receipt Lines: page 7 – 34
Requisition Import Process: page 9 – 144
Tax Defaults in Purchasing

You enter tax information on your Purchasing documents, using the Tax Code and Recovery Rate fields. Each tax code has an associated tax rate in Payables that determines the tax amount for an item. You also associate a recovery rate with each tax code. The recovery rate is the percentage of tax that your business can reclaim for credit.

Tax information defaults onto requisitions, purchase orders, and blanket releases if you have set up tax codes and corresponding recovery rates. For example, you can associate a tax code for each item, supplier, or supplier site. Then you can use the Tax Defaults tabbed region of the Purchasing Options window in Purchasing to specify which source—such as item, supplier, and supplier site—from which to default the tax code onto your Purchasing documents.

You can override the tax code if the profile option Tax: Allow Override of Tax Code is set to Yes. You can override the recovery rate if the profile option Tax: Allow Override of Tax Recovery Rate is set to Yes.

If you use partially recoverable tax, you can view the recoverable and nonrecoverable tax for each tax code in your document by choosing Tax Code Summary from the Tools menu. You can view recoverable and nonrecoverable tax for each line, shipment, and distribution by choosing Tax Details from the Tools menu.

Duplicating Tax Functionality from Previous Releases

Purchasing preserves your tax defaults from previous releases. That is, Purchasing continues to default tax from the ship-to location if you don’t set a tax defaulting hierarchy in the Tax Defaults region of the Purchasing Options window. (Note that a Tax Code defined in the Purchase Order Preferences window overrides this tax defaulting hierarchy.)

Tax Codes

You can set up Purchasing to default tax codes based on your public sector needs. You set up the Tax Defaults hierarchy in the Tax Defaults tabbed region of the Purchasing Options window to determine the following:

- Which sources you use for tax codes
- The order in which Purchasing searches the sources to find a valid tax value

For instructions on defining the Tax Defaults hierarchy, see: Defining Tax Defaults Options: page 1 – 55.

**How Tax Code Defaults Affect Purchasing Documents**

The tax defaults you select in the Tax Defaults region of the Purchasing Options window default in the Tax Code field of the following windows and processes in Purchasing:

- Shipments window for standard and planned purchase orders
- Requisition lines in the Requisitions window
- Purchase order line shipments created by the AutoCreate Documents window
- Shipments tabbed region in the Releases window (for blanket releases)
- Release shipments created by the Create Releases process
- RFQ Shipments window (for Bid or Standard RFQs) or RFQ Price Breaks window (for Catalog RFQs)
- Quotation shipments window (for Bid or Standard quotations) or Quotation Price Breaks window (for Catalog quotations)

If you change the tax code of a tax source (for example, the Tax Code in the Invoice Tax tabbed region of the Supplier Sites window), Purchasing does not update your existing documents with the new tax code; it updates only new documents you create.

If you’ve set up a tax defaulting hierarchy in the Tax Defaults region of the Purchasing Options window, the appropriate tax codes automatically default onto blanket release shipments created by the Create Releases process and onto documents you autocreate.

When creating a release from a planned purchase order, the tax code on the planned purchase order shipment overrides the tax defaults in the Purchasing Options window.
Recovery Rate

The tax recovery rate defaults on Purchasing documents based on the tax code and the setup in the Financials Options window. The Recovery Rate field is used in the following windows:

- Requisition Distributions (for purchase requisitions)
- Purchase order Distributions (for planned and standard purchase orders)
- Release Distributions

The recovery rate is the percentage of tax your business can reclaim for credit. The nonrecoverable portion of the tax is included in the following:

- Encumbrance accounting and receipt or period-end accrual accounting
- Approval limit amounts


Recovery rates can be used for sales, user-defined, and offset taxes. See: Recoverable Tax, Oracle Public Sector Payables User’s Guide.

See Also

Tax Control Methods, Oracle Public Sector Payables User’s Guide
Tax Recovery Rules, Oracle Public Sector Payables User’s Guide
Viewing Tax Summary Information: page 4 – 138
Viewing Tax Details: page 4 – 140
Entering Requisition Lines: page 3 – 60
Entering Requisition Distributions: page 3 – 68
Entering Purchase Order Shipments: page 4 – 63
Entering Purchase Order Distributions: page 4 – 74
Entering Release Shipments: page 4 – 90
Entering Release Distributions: page 4 – 97
Entering Taxes on Invoices, Oracle Public Sector Payables User’s Guide
Viewing Tax Code Summary Information

Use the Tax Code Summary window to view tax lines totaled and grouped by tax code. When you enter or change the Tax Code on a line or the Recovery Rate on a distribution, the tax information in the Tax Code Summary window is recalculated once you save the document.

Use this window to view, not change, tax information. To change tax information, change the Tax Code or the Recovery Rate fields in the document entry window if the profile options Tax: Allow Override of Tax Code and Tax: Allow Override of Tax Recovery Rate are set to Yes, if funds for the purchase order or release are not currently reserved (if you use encumbrance accounting), and if the shipment has not yet been received.

To view a summary of tax information in the document:

- Choose Tax Code Summary from the Tools menu, from the Requisitions, Purchase Orders, or Releases windows, or their corresponding Shipments or Distributions windows.

The top region displays the total tax amounts in the document:
**Nonrecoverable Tax**  Based on the recovery rate on the distribution, the total tax in the document that cannot be reclaimed for credit.

**Recoverable Tax**  Based on the recovery rate on the distribution, the total tax in the document that can be reclaimed for credit.

**Total Tax**  Nonrecoverable Tax + Recoverable Tax.

**Amount**  The total document amount, excluding tax.

**Approval Amount**  Amount + Nonrecoverable Tax.

The bottom region lists all of the tax codes used in your document and the tax information for each:

**Tax Code**  The Tax Code from the Requisitions, purchase order Shipments, or Releases window. The tax code defaults from the following sources, in this order: the Purchase Order Preferences window, if you are creating a standard or planned purchase order or blanket release; the planned purchase order shipment if you are creating a release from a planned purchase order; the Tax Defaults region in the Purchasing Options window.

**Taxed Amount**  The total net Amount, excluding tax, for all lines with this tax code.

**Nonrecoverable Tax**  Based on the recovery rate on the distribution, the total tax that is not recoverable, for all lines with this tax code.

**Recoverable Tax**  Based on the recovery rate on the distribution, the total tax that is recoverable, for all lines with this tax code.

**Total Tax**  Nonrecoverable Tax + Recoverable Tax for all lines with this tax code.

**See Also**

Tax Defaults in Purchasing: page 4 – 135
Tax Control Methods, *Oracle Public Sector Payables User’s Guide*
Viewing Tax Details

Use the Tax Details window to view all tax information for each line. When you enter or change the Tax Code on a line or change the Recovery Rate on a distribution, the tax information in the Tax Details window is recalculated once you save the document.

Use this window to view, not change, tax information. To change tax information, change the Tax Code or the Recovery Rate in the document entry window if the profile options Tax: Allow Override of Tax Code and Tax: Allow Override of Tax Recovery Rate are set to Yes, if funds for the purchase order or release are not currently reserved (if you use encumbrance accounting), and if the shipment has not yet been received.

To view tax details:

1. Choose Tax Details from the Tools menu, from the Requisitions, Purchase Orders, or Releases windows, or their corresponding Shipments or Distributions windows.

2. Choose to display all lines, shipments, or distributions in the document.

The top region displays the total tax amounts in the document:
<table>
<thead>
<tr>
<th><strong>Nonrecoverable Tax</strong></th>
<th>Based on the recovery rate on the distribution, the total tax in the document that cannot be reclaimed for credit.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Recoverable Tax</strong></td>
<td>Based on the recovery rate on the distribution, the total tax in the document that can be reclaimed for credit.</td>
</tr>
<tr>
<td><strong>Amount</strong></td>
<td>The total document amount, excluding tax.</td>
</tr>
<tr>
<td><strong>Approval Amount</strong></td>
<td>Amount + Nonrecoverable Tax.</td>
</tr>
</tbody>
</table>

The bottom region displays detailed tax information for each line, shipment, or distribution:

<table>
<thead>
<tr>
<th><strong>Tax Code</strong></th>
<th>(Displayed in the Shipments tabbed region for purchase orders and the Lines tabbed region for requisitions) The Tax Code from the Requisitions, purchase order Shipments, or Releases window. The tax code defaults from the following sources, in this order: the Purchase Order Preferences window, if you are creating a standard or planned purchase order or blanket release; the planned purchase order shipment if you are creating a release from a planned purchase order; the Tax Defaults region in the Purchasing Options window.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Amount</strong></td>
<td>The total line, shipment, or distribution amount, excluding tax.</td>
</tr>
<tr>
<td><strong>Nonrecoverable Tax</strong></td>
<td>Based on the recovery rate on the distribution, the total tax for this line, shipment, or distribution that is not recoverable.</td>
</tr>
<tr>
<td><strong>Recoverable Tax</strong></td>
<td>Based on the recovery rate on the distribution, the total tax for this line, shipment, or distribution that is recoverable.</td>
</tr>
<tr>
<td><strong>Approval Amount</strong></td>
<td>Amount + Nonrecoverable Tax for this line.</td>
</tr>
<tr>
<td><strong>Recovery Rate</strong></td>
<td>(Displayed in the Distributions tabbed region only) The percentage of tax that is recoverable for this distribution.</td>
</tr>
<tr>
<td><strong>Charge Account</strong></td>
<td>(Displayed in the Distributions tabbed region only) The account number from the distribution line.</td>
</tr>
</tbody>
</table>
See Also

Tax Defaults in Purchasing: page 4 – 135
Tax Control Methods, Oracle Public Sector Payables User’s Guide
Tax Recovery Rules, Oracle Public Sector Payables User’s Guide
Procurement Card Purchase Orders and Releases

A procurement card (or P–Card) is a corporate credit card issued to an employee so that the employee can purchase items directly from a supplier. Procurement card numbers are provided on iProcurement requisitions only. After the requisition is created in iProcurement, a purchase order or release is generated in Purchasing by either the PO Create Documents workflow or by you using AutoCreate, depending on how you’ve set up Purchasing.

Procurement card purchase orders are approved and transmitted to the supplier like any other purchase order. They are approved through the approval workflows in Purchasing, and you transmit them to the supplier through facsimile, Oracle e–Commerce Gateway, or other method as usual. (The procurement card information itself is transmitted to the supplier through e–Commerce Gateway, through the outbound purchase order transaction.) Upon receiving the purchase order, the supplier transmits the procurement card information to the procurement card issuer (for example, a bank). The credit card issuer then sends transaction files back to Oracle Public Sector Payables, which automatically generates accounting distributions and creates invoices to pay the issuer.

If a supplier rejects a procurement card order, the buyer can notify the requester of the rejection. The buyer can cancel the purchase order and ask the requester to resubmit the requisition, or re–send the purchase order using a different form of payment.

In Purchasing, you see a procurement card number on a procurement card requisition line in the AutoCreate Documents window (as a hidden field), and in the Purchase Orders, Releases, and Purchase Order Headers windows (if PO: Use P–Cards in Purchasing is set to Yes).

You cannot create a procurement card purchase order or release manually. Purchasing creates a procurement card purchase order or release through the PO Create Documents workflow or the AutoCreate Documents window, depending on your Purchasing setup. See: Workflow Setup Options: page 1 – 95.

Procurement card purchase orders and releases can be created only from requisition lines in iProcurement. To use procurement card purchase orders or releases in Purchasing, you must set up procurement card functionality in both iProcurement and Payables.

For information on setting up procurement card functionality, see the iProcurement Implementation Manual and the Oracle Public Sector Payables User’s Guide.
Procurement card purchase orders:

- Cannot be used with encumbrance accounting.
- Can be used for items with a Destination Type of Expense only.
- Cannot be used for documents that contain a Project number.
- Can be used for standard purchase orders or releases only.
- Are not available for invoice matching or invoice creation.
- Do not accrue on receipt. See: Receiving, below.
- Transmit the procurement card number to the supplier through e–Commerce Gateway, through the outbound purchase order transaction. See: Running the EDI Purchase Order Outbound Extract Program, Oracle e–Commerce Gateway User’s Guide.
Approval

Requisitions and purchase orders that contain procurement card items are routed through the same approval process as any other document, unless you modify the approval workflow to treat them differently.

After a procurement card purchase order or release is approved, it is automatically closed for invoicing if you use the Two-Way match approval level.

Receiving

You receive a procurement card order like any other. However, procurement card items do not accrue upon receipt. Payment and accounting for procurement card orders are already handled in Payables, which imports the credit card transaction files from the credit card issuer. If you accrue upon receipt, Purchasing accrues upon receipt all items except procurement card items. You cannot change the Accrue at Receipt check box in the Shipments window for procurement card purchase orders or releases.

Similarly, at period-end, Purchasing does not accrue or roll over procurement card orders to General Ledger.

Invoicing

Since invoices for procurement card purchase orders are created through credit card transaction files that are imported from the credit card issuer into Payables, note the following:

- Procurement card purchase orders are not available for invoice matching in Payables.
- Procurement card shipment lines are automatically closed after approval if you use the Two-Way match approval level. (If you use Three-Way or Four-Way match approval levels, you can still receive or inspect against the shipment.)
- Payment on Receipt does not generate invoices automatically for procurement card orders, even if the supplier is set up as a Pay on Receipt site in the Supplier Sites window. A supplier site can be both a Pay on Receipt site and a Procurement Card Site; however, if the supplier site is a Pay on Receipt site, invoices will be generated automatically for all orders received from that supplier site when you run Payment on Receipt, except those that include procurement card information.
• Advance Shipment Notices (ASNs) that contain billing information (sometimes known as Advance Shipment and Billing Notices, or ASBNs), if they also contain procurement card information, are not automatically converted into invoices as they normally would be upon receipt.

This chapter tells you everything you need to know about Supply Base Management, including:

- Overview of Sourcing, RFQs, and Quotations: page 5 – 2
- Overview of the Supplier Item Catalog: page 5 – 8
- Receiving Price/Sales Catalog Information Electronically: page 5 – 22
- Overview of Automatic Sourcing: page 5 – 30
- Approved Supplier List: page 5 – 42
- Entering RFQs: page 5 – 57
- Entering Quotations: page 5 – 73
- Copying Quotations from RFQs: page 5 – 88
- Approving Quotations: page 5 – 90
- Defining Supplier Lists: page 5 – 96
- Managing Buyer Workload: page 5 – 98
Overview of Sourcing, RFQs, and Quotations

Purchasing provides you with request for quotation (RFQ), and quotation features to handle your sourcing needs. You can create an RFQ from requisitions, match supplier quotations to your RFQ, and automatically copy quotation information to purchase orders. Purchasing provides complete reporting to control your requests for quotations and evaluate supplier responses.

- Identify requisitions that require supplier quotations and automatically create a request for quotation.
- Create a request for quotation with or without approved requisitions so that you can plan ahead for your future procurement requirements.
- Record supplier quotations from a catalog, telephone conversation, or response from your request for quotation. You can also receive quotations electronically.
- Review, analyze, and approve supplier quotations that you want available to reference on purchase orders and requisitions. You should be able to evaluate your suppliers based on quotation information.
- Receive automatic notification when a quotation or request for quotation approaches expiration.
- Review quotation information on-line when creating purchase orders or requisitions and copy specific quotation information to a purchase order or requisition.
- Identify a supplier that you want to use only for receiving RFQs and quotations. You can later be able to access purchase history to help you decide if the quotations are acceptable.
- Hold all purchasing activity on a supplier at any time. You can still match invoices to approved purchase orders or receipts for this supplier. You can release a supplier hold at any time.
- Create, change, and review supplier information on-line. You can enter supplier site information, supplier contacts, and supplier-specific delivery information.
- Review the purchase history for a specific item. You can identify the suppliers you used in the past, quantities you ordered, and pricing information. You can match this information to specific purchase orders.
• Simplify the sourcing of commonly purchased items. You can define requisition templates for your commonly purchased items. Requestors can use these requisitions templates to create simple, pre-sourced requisitions.

• Source the items for which you negotiated purchase agreements automatically. If you created sourcing rules and Approved Supplier List entries for the items, supplier information is entered automatically in the Requisitions window when you create requisitions. You can also place supplier information for items onto blanket purchase order releases.

• Specify planning constraints, such as lead time, minimum order quantity, or fixed lot multiples, for each supplier site for an item so that if a supplier cannot currently meet your demand, Supply Chain Planning automatically uses another supplier that you specify. See: Defining the Supplier/Item Attributes: page 5 – 51.

Major Features

Electronically Received Catalog Information
You can receive price/sales catalog information electronically from your supplier through the Purchasing Documents Open Interface. The information is imported directly as blanket purchase agreement lines or catalog quotations. See: Receiving Price/Sales Catalog Information Electronically: page 5 – 22.

Flexible Document Numbers
Purchasing identifies each RFQ or quotation with a unique document number. You decide whether you want to enter document numbers manually or have the numbers assigned automatically.

Sourcing Power
Purchasing lets you source your items so you can negotiate the best deals with your suppliers. You can create requests for quotations, record the results, and reference the corresponding quotation when creating your purchase order. You can also review historical purchase prices so that you can evaluate how to purchase your items more effectively.
Supplier Defaulting
For each supplier, you can define default preferred ship-to locations, freight terms and carriers, free-on-board information, tax names, and payment terms to be used when you enter purchase orders. You can always override any default.

Supplier Purchasing Hold
You can prevent purchasing activity on specific suppliers at any time by using the Suppliers window to provide a reason for holding the supplier. You cannot approve any purchase order for a supplier on hold; however, you can receive and match against approved purchase orders or receipts for a supplier on hold. You can release a hold at any time.

AutoCreating RFQ and Quotation Information
You can AutoCreate RFQs directly from requisitions. You can also Copy quotations directly from RFQs to facilitate recording responses from your suppliers. See: Copying Quotations from RFQs: page 5 – 88. (If you receive catalog information from your supplier electronically, that information is sent automatically in the form of a catalog quotation. See: Receiving Price/Sales Catalog Information Electronically: page 5 – 22.)

Request for Quotation Requirement
You can identify whether a request for quotation is necessary for a specific item or requisition line.

Supplier Lists
Purchasing lets you create supplier lists so that you can predefine groups of suppliers to whom you want to send RFQs. You can establish supplier lists according to criteria you define (item, manufacturing category, geographic location, or other) and you can combine supplier lists to produce many copies of your RFQ automatically.

Note: If the Oracle Public Sector Payables profile option AP:Enter Alternate Fields is enabled, alternate fields will appear on designated windows like Enter Suppliers.

See: Profile Options in Payables, See Oracle Public Sector Payables User’s Guide
Purchasing History
Purchasing lets you review your purchase price history information to help you source your items better. You can either review all historical prices for a particular item or the last prices you paid for a specific item by quantity. You can review the detailed information of the purchase order corresponding to this last price.

Flexible, Custom Notes
Purchasing lets you quickly add extended Notes and instructions to your RFQs and quotations. You can include standard notes or create your own custom notes. You can use as much descriptive text as you need.

Automatic Sourcing
Automatic sourcing automatically defaults sourcing information onto the requisitions, blanket purchase orders, or quotations you create. You can easily assign any item with an item number to a specific blanket purchase agreement or quotation you created. Purchasing automatically assigns the name of the supplier for the blanket purchase order and quotation to any requisition for this item. (If you receive catalog information from your supplier electronically—and you specified sourcing rules to be sent electronically also—then the sourcing rule and Approved Supplier List entry for this supplier is entered in your system automatically.) See: Automatic Sourcing: page 5 – 30. See: Approved Supplier List: page 5 – 42.

RFQs and Quotations
A request for quotation (RFQ) is sent to a supplier to request pricing and other information for an item or items. A quotation is the supplier’s response to that RFQ. Some examples of how you send an RFQ to a supplier include creating an RFQ in the RFQs window and sending it by facsimile, making a phone call, or using Oracle iSupplier Portal. One way a supplier can send a quotation, whether or not in response to an RFQ, is through the Purchasing Documents Open Interface. (See: Receiving Price/Sales Catalog Information Electronically: page 5 – 22.) If you don’t receive quotations electronically from your supplier, you can create the quotation manually using the Quotations window, or copy the quotation from an RFQ. (See: Copying Quotations from RFQs: page 5 – 88.)
Using Quotation Information on Your Documents

Purchasing lets you use your quotation information when you build purchase orders.

Using Quotation Information for a Purchase Order

When you create a purchase order (manually or from requisitions), you can use the Supplier Item Catalog window to retrieve quotation information. (The Supplier Item Catalog window can include quotations sent to you by your supplier through the Purchasing Documents Open Interface. See: Receiving Price/Sales Catalog Information Electronically: page 5 – 22.) Purchasing provides all your approved quotation shipment information for a specific item or manufacturing category. You can copy this quotation shipment to an existing blanket purchase agreement or standard purchase order when you add this item or purchasing category to a purchase order line. You can sort this quotation information according to your needs, using criteria such as price or quantity. You can easily evaluate the source that is best for an item.

After you select the quotation shipment you want to use, Purchasing copies the item unit price, quantity, unit of measure, supplier product number, inspection required status, receipt required status, quotation number, quotation type, and supplier quotation number on your purchase order. Purchasing also copies the quotation item description on your purchase order if you define your items to do so.

Purchasing automatically warns you when the terms and conditions of the quotation are different from the terms and conditions of your purchase order. The original purchase order terms and conditions remain unchanged.

Using Partial Quotation Information on a Requisition

When you enter an item or purchasing category on a requisition line, you can use the Supplier Item Catalog window to access quotation shipment information for the item or category. After you select the quotation shipment you want to use, Purchasing automatically copies the item unit price, quantity, unit of measure, supplier product number, supplier name, supplier site, and supplier contact to your requisition line. Purchasing also copies the quotation item description on your purchase order if you define your items to do so.
Types of Quotations and RFQs

There are three types of quotations and RFQs that come with Purchasing by default:

- **Catalog**: Used for high-volume items or items for which your supplier sends you information regularly. A Catalog quotation or RFQ also includes price breaks at different quantity levels.

- **Standard**: Used for items you’ll need only once or not very often, but not necessarily for a specific, fixed quantity, location, and date. For example, you could use a Catalog quotation or RFQ for office supplies, but use a Standard quotation or RFQ for a special type of pen you don’t order very often. A Standard quotation or RFQ also includes price breaks at different quantity levels.

- **Bid**: Used for a specific, fixed quantity, location, and date. For example, a Bid would be used for a large or expensive piece of equipment that you’ve never ordered before, or for an item that incurs transportation or other special costs. You cannot specify price breaks for a Bid quotation or RFQ.

For all three types, you can define effectivity dates at the header level. For Catalog and Standard quotations, you can also specify effectivity dates for individual price breaks. (For a Bid, you cannot specify effectivity dates at the shipment level.)

You can also define your own RFQ or quotation types using the Document Types window. See: Defining Document Types: page 1 – 87.
Overview of the Supplier Item Catalog

The Supplier Item Catalog provides a simple mechanism for locating items and their source information for the purpose of creating purchase order and requisition lines. You can open the catalog from an existing requisition or purchase order and add lines to that document. Alternatively, you can open the catalog from the Navigator and search for item information from there.

Search Supplier Item Catalog Window

Purchasing displays the Search Supplier Item Catalog window whether you invoke the Supplier Item Catalog from the menu or from a requisition or purchase order.

To invoke the Supplier Item Catalog from a requisition or purchase order, select the Catalog button when the cursor is in the Lines tabbed region.

The Supplier Item Catalog does not support Outside Processing. However, you can open the Catalog from an outside processing line in a requisition or a purchase order to find other items.

In the search window, lists of values show only valid values. For example, inactive suppliers are not displayed.

The “Item description contains the words” field is used for keyword searches. If you search for “desk executive mahogany”, you get any item whose description includes all three words. In this case you could widen the search by removing “mahogany” and/or “desk.” The words in the description do not have to occur in the order listed, so searches on “desk executive” and “executive desk” would get the same result: all items whose description included both of the words.

The Deliver To Organization and Location (when invoked from the menu or a requisition) are the Ship To Organization and Location when the window is invoked from a purchase order. Lists of values display deliver–to or ship–to values, as appropriate. For query purposes, the deliver–to actually uses the associated ship–to information.

Supplier Item Catalog Window

There are four tabbed regions in the upper screen of this folder window, but Function Security can be used to determine whether a user will be able to see all of them. A profile option (PO: Default Supplier Item Catalog Option) determines which of these tabbed regions is the default when the catalog opens from the menu and for the first time in a user
session that the catalog opens from a requisition or purchase order. If you close the catalog and reopen it from a purchase order or requisition during the same session, the default source region is the last one previously open. The regions are:

**Negotiated Sources**

Long term agreements with a supplier that support repetitive buys: Blanket purchase agreements, quotations, and planned purchase orders. This tabbed region is a folder.

**Prior Purchases**

Actual past buys: Standard purchase orders, scheduled releases, blanket releases. This tabbed region is a folder.

**Sourcing Rules**

Sourcing rules. There are + and – iconic buttons just below the region box. Select the + icon or Expand Sourcing Rules on the Tools menu to display source documents for the rule in a folder region. Use the – icon or Collapse Sourcing Rules on the Tools menu to collapse the region displaying the documents. You must be in the documents region to add to the Order Pad or to select a price.

**Requisition Templates**

Requisition Templates. The PO: Legal Requisition Type profile option governs whether templates for supplier and internally sourced lines are displayed. This tabbed region is a folder.

### Using the Order Pad

Open the Supplier Item Catalog window by choosing Catalog in the Requisitions window to view and use the Order Pad. (The Order Pad is not available when you open the Supplier Item Catalog from the Purchase Orders window.) Select a line and click the Add button or double click to highlight the selected line in a source region and add it to the Order Pad. Validation takes place at this point, and if there is a problem, Purchasing displays a message window with an explanation. Depending on the problem, you may or may not be permitted to add the line. Also, if Disposition messages are enabled for the Purchasing Inventory organization, they are displayed as lines and added to the Order Pad.

When you add to the Order Pad, you must specify the following information. Defaults for this information are defined in the Order Pad Options window.

- Deliver–To organization (if you opened the catalog from the menu or a requisition)
• Ship–To organization (if you opened the catalog from a purchase order)
• Deliver–To location (if you opened the catalog from the menu or a requisition)
• Ship–To location (if you opened the catalog from a purchase order)
• Destination Type (Expense or Inventory)
• Subinventory (if the Destination Type is Inventory)
• Need–By date (if the item is planned in the destination organization)
• Quantity. The quantity must be greater than zero. It defaults to 1 or the quantity on the requisition/purchase order line if a quantity was specified and if the first record was added to the Order Pad.

If you are adding to the Order Pad from Negotiated Sources or Sourcing Rules and enter a quantity less than an existing price break quantity, Purchasing opens a Decision window and asks whether you want to increase the order quantity to reduce the unit price.

Use the Remove button or Clear Record to remove selected lines from the Order Pad. When you remove a line from the Order Pad, Purchasing returns it to the source region and unhighlights the line. To support returning a line to its source tabbed region, Purchasing does not permit Clear Record in the source tabbed regions or Clear Block in the Order Pad.

**Order Pad Options**

You enter Order Pad defaults and options in the Order Pad Options window. Navigate to the Order Pad Options window by opening the Supplier Item Catalog from a requisition and choosing the Options button while you are on the Order Pad. (Note: The Order Pad is not available when you open the Supplier Item Catalog from the Purchase Orders window.) The Order Pad Options window includes the Copy Option tabbed region, where you can specify the Supplier, Supplier Site, Supplier Contact, FOB, Carrier, Payment Terms, and Freight Terms to be copied to the purchase order header.
Order Pad Total

For each line on the Order Pad, Purchasing displays the extended price in that line’s currency. To see the total Order Pad amount in your functional currency, open the Order Pad Total window by selecting the Order Total button.

Select Price Only Option

As a mutually exclusive alternative to the Order Pad, there is a Select Price Only check box at the top right of the screen when you have opened the Supplier Item Catalog from a requisition or a purchase order. If the requisition or purchase order line is saved, when you open the Catalog, you must use Select Price Only. This check box can be enabled only if nothing has been added to the Order Pad. If this check box is selected, the Add, Order Total, and Options buttons are disabled and the Select button is enabled. You can then select prices for inclusion on a requisition or purchase order.

See Also

Profile Options in Purchasing: page 1 – 103
Customizing the Presentation of Data in a Folder, Oracle Applications User’s Guide
Finding Supplier Items: page 5 – 11
Using the Supplier Item Catalog tabbed regions: page 5 – 15
Entering Order Pad Options (from Requisitions): page 5 – 19

Finding Supplier Items

Use the Search Supplier Item Catalog window to enter search criteria for supplier items.

Depending on the function security assigned to your responsibility, you have varying levels of access to information. A responsibility defines an application user’s current privileges while working with Oracle Applications. See: Function Security for Purchasing; page 1 – 112.
If you enter an item with **Purchasing Enabled = ‘N’** and with **Internal Orders Enabled = ‘Y’**, the item is valid for an internal order, but you cannot search for this item in the Supplier Item Catalog. If you want to be able to search the Supplier Item Catalog, the item must have **Purchasing Enabled = ‘Y’**.

> **To enter search criteria:**

1. Navigate to the Search Supplier Item Catalog window by selecting Supplier Item Catalog from the menu. Also, the Search Supplier Item Catalog window is displayed when you select the Catalog button in the Requisitions and Purchase Orders windows.

   ![Search Supplier Item Catalog](image)

Enter optional search criteria as described in the following steps:

2. Enter the Commodity. This is used to locate matching stored categories on Purchasing document lines.

3. Enter the Requisition Template. This is enabled only if the window is accessed from the menu or from the Requisitions window.
4. Enter the Category Set. This is used to find predefined items associated with a specific category set. If you access this window from the Requisitions or Purchase Orders windows, the default is the Purchasing category set. If you enter a category set, you can also further restrict the search by entering a Category.

5. Enter the Item number. If you access this window from the Requisitions or Purchase Orders window, the default is the item on the originating document line. If you enter an item, you can also further restrict the search by entering an item Revision number.

6. Enter the Item Description. If you access this window from the Requisitions or Purchase Orders window, the default is the description on the originating document line.

7. Enter key words separated by spaces in the Item description contains the words: field to find item descriptions containing all the specified words. The search is not case sensitive, nor does it consider the sequence of the words.

8. Enter the Supplier. If you access this window from the Requisitions or Purchase Orders window, the default is the supplier on the originating document line. If you enter a supplier, you can enter a supplier Site.

9. Enter the Supplier Item number. If you access this window from the Requisitions or Purchase Orders window, the default is the supplier item number on the originating document line.

10. Select Approved Suppliers Only to get only records where the supplier and the item exist in a current sourcing rule and Approved Supplier List entry.

11. Enter the Due Date to get documents that are current as of this date or future effective. If you access this window from the Requisitions or Purchase Orders window, the default is the due date on the originating document line.

12. Enter the Line Type. If you access this window from the Requisitions or Purchase Orders window, the default is the line type on the originating document line.

13. Enter the UOM. If you access this window from the Requisitions or Purchase Orders window, the default is the UOM on the originating document line.

**Attention:** Since catalog quotations in the Negotiated Sources and Sourcing Rules tabbed regions can have different units of measure on the line and the price break, Purchasing performs the following test on the UOM you enter in this field:
If a UOM exists on the shipment, Purchasing returns rows where this matches the search value. If no UOM exists on the shipment, Purchasing returns rows where the line UOM matches the search value. We do this because if you add to the Order Pad from a row with a different UOM on the price break, this is the UOM we copy to the Order Pad.

14. Enter the Organization. If you access this window from the menu or the Requisitions window, the field title is Deliver–To Organization. If you access this window from the Purchase Orders window, the field title is Ship–To Organization. The defaults are from the originating document line, deliver–to from the requisition and ship–to from the purchase order.

15. Enter the Location. If you access this window from the menu or the Requisitions window, the field title is Deliver–To Location. If you access this window from the Purchase Orders window, the field title is Ship–To Location. The query is based on the ship–to location associated with the deliver–to location. The defaults are from the originating document line, deliver–to location from the requisition and ship–to location from the purchase order.

16. Enter the Currency. If you access this window from the Purchase Orders window, the default is the currency from the purchase order line.

► **To clear existing search criteria:**
  - Select the Clear button to clear any existing search criteria.

► **To initiate the search:**
  - Select the Find button to initiate the search and open the Supplier Item Catalog window.

► **To close the Search Supplier Item Catalog window:**
  - Select the Close Catalog button to close the Search Supplier Item Catalog window. This button is available only when you have accessed this window from the Requisitions or Purchase Orders windows; when you close the catalog window, you return to your originating document window.

Note that you must select either Find or Close Catalog before you can return to the originating document. While the Search Supplier Item Catalog window is open, you cannot:
  - Exit to the menu
Using the Supplier Item Catalog Tabbed Regions

Use the Supplier Item Catalog window to:

- Review results of your search in the tabbed regions of the Search Supplier Item Catalog window.
- Select prices from the tabbed regions for placement onto requisition and purchase order lines.
- Place source lines from the tabbed regions onto the Order Pad, where you can modify them before placing them onto requisition and purchase order lines or onto new requisitions.

The Supplier Item Catalog window has four tabbed regions (Negotiated Sources, Prior Purchases, Sourcing Rules, and Requisition Templates), but Function Security controls which are present. A profile option (PO: Default Supplier Item Catalog Option) determines which of these tabbed regions is the default, but this applies only to regions permitted by Function Security.
The query based on your search criteria is executed in the currently displayed alternative results region in the Supplier Item Catalog window. As you change tabbed regions, a query is executed in each tabbed region using the original search criteria. Search criteria are considered only in tabbed regions in which they are relevant.

For example, if your original search criteria consisted of a requisition template and a key word, the query in the Negotiated Sources tabbed region would ignore the requisition template.

To review the tabbed regions:

- Navigate to the Supplier Item Catalog window by selecting the Find button in the Search Supplier Item Catalog window. You can also navigate to the Search Supplier Item Catalog window by selecting the Catalog button in the Requisitions and Purchase Orders windows.
The Negotiated Sources tabbed region is a folder. As installed, it displays the Supplier, Item, Commodity, Item Description, Supplier Item number, Line UOM, Line Price, Break Quantity, and Break Price.

The Prior Purchases tabbed region is a folder. As installed, it displays the Order Date, Supplier, Item number, Commodity, Item Description, UOM, Price, Supplier Item number, and Quantity.

The Sourcing Rules tabbed region displays the Item number, Rank, Supplier, Rule number, and the rule Effective date range. You can expand and collapse sourcing rule lines either by selecting the + and – icons or from options on the Tools menu. When you expand a sourcing rule line, Purchasing opens a folder window that, as installed, displays the Rank, Commodity, Supplier Item, Line UOM, Line Price, Break Quantity, and Break Price for documents referencing the rule.

The Requisition Templates tabbed region is a folder. As installed, it displays the Supplier, Item number, Commodity, UOM, Price, Source Type, Supplier Item number, Template name, Template Description, and Buyer.

➢ To select prices from the tabbed regions:

1. Select the Select Price Only check box, if you opened the Supplier Item Catalog from a requisition (the target document.). If you opened the Supplier Item Catalog from a purchase order, the Select Price Only check box is already selected, and you cannot deselect it. You cannot use the Order Pad if you have checked Select Price Only. You cannot use the Order Pad if you opened it from a Purchase Order window.

2. Move the cursor to the desired line in one of the tabbed regions.

3. Select the Select button to copy the price of the current line to your target document.

➢ To use the Order Pad:

1. Open the Supplier Item Catalog by choosing the Catalog button on a requisition or purchase order. You can access the Order Pad only when you open the Supplier Item Catalog from a requisition or purchase order.
2. Choose the Add button to place the current line in the open tabbed region onto the Order Pad. The cursor moves to the Order Pad, where you can select the Remove button to return the current line to its original tabbed region.

3. You can enter or edit the following fields for an Order Pad line: Quantity, Price, Need—By date, Organization, Location, Destination Type, and Subinventory.

4. Choose the Select button to add the order pad lines to the requisition or purchase order from which you accessed the catalog. This also closes the Supplier Item Catalog window.

- **To enter order pad options and defaults:**
  - Select the Options button to open the Order Pad Options window. See: Entering Order Pad Options (from Requisitions): page 5 – 19.

- **To view the current order pad total:**
  - Select the Order Total button to open the Order Pad Total window. This window displays the Functional Currency and the current total amount on the order pad.

- **To close the Supplier Item Catalog window:**
  - Select the Close Catalog button to close the Supplier Item Catalog windows. This button is available only when you have accessed this window from the Requisitions or Purchase Orders windows; when you close the Search Supplier Item Catalog and the Supplier Item Catalog windows, you return to your originating document window.

  Note that you must either Select information to copy back or Close Catalog before you can return to the originating document. While the Supplier Item Catalog window is open, you cannot:
  - Exit to the menu
  - Navigate to the originating document
  - Clear the window
  - Save your work
See Also

Overview of the Supplier Item Catalog: page 5 – 8
Using the Search Supplier Item Catalog Window: page 5 – 11
Entering Requisition Lines: page 3 – 60
Customizing the Presentation of Data in a Folder, Oracle Applications User’s Guide

Entering Order Pad Options (from Requisitions)

Use the Order Pad Options window to enter order pad defaults and options. You access this version of the window when you have opened the Supplier Item Catalog from a requisition.

► To enter order pad defaults and options:

1. Navigate to the Order Pad Options window by selecting the Options button in the Supplier Item Catalog window.
2. Select the default option:

Default From Previous Line – Defaults for Order Pad lines are from the previous line on the Order Pad. (The first line on the Order Pad uses defaults from this window.)

Default From Options – Defaults for Order Pad records come from this window.

3. Enter the default Need–By date.
4. Enter the default Destination Type: Expense or Inventory.
5. Enter the default Organization.
6. Enter the default Location.
7. Enter the default Requestor.
8. For the Destination Type of Inventory, enter the default Subinventory.
9. Enter the default Expense Charge Account.

► To apply the defaults:
  - Select the OK button to apply the defaults and return to the Supplier Item Catalog window.

See Also

Overview of the Supplier Item Catalog: page 5 – 8
Receiving Price/Sales Catalog Information Electronically

Your supplier can send you the latest price/sales catalog information and responses to requests for quotation through the Purchasing Documents Open Interface. The Purchasing Documents Open Interface processes catalog data in the Oracle Applications interface tables to ensure that it is valid before importing it into Purchasing. One way to import catalog data into the Purchasing Documents Open Interface, and finally into Purchasing, is through Electronic Data Interchange (EDI). EDI programs import the catalog information into Purchasing directly as blanket purchase agreement lines or catalog quotations, whichever you choose. You can also choose to have the programs automatically populate the item master and/or apply sourcing rules to the imported item information. If you import price/sales catalog information as blanket purchase agreement lines, you can also specify release generation methods. You can import new documents, replace existing documents entirely, or update existing documents.

The catalog information is sent by the supplier in the form of a “flat file.” Your supplier can send you flat files with any of three kinds of action codes: Original, Replace, or Update. An Original file is one in which all the catalog information is new to your system. A Replace file replaces already-created blanket purchase agreement lines or catalog quotations with new documents containing new price/sales catalog information. (The Purchasing Documents Open Interface program replaces the old documents by invalidating their effectivity dates; then it creates new documents with the new price/sales catalog information and the old effectivity dates.) An Update file updates existing blanket purchase agreement and catalog quotation lines without replacing the documents entirely. It updates the unit Price, item Description, unit of measure (UOM), Price Breaks, Expiration Date, and the supplier URL descriptive flexfield if you use one.

Note: An Update submission does not update the UOM on an agreement line for which an open release exists. Instead, it uses the Expiration Date field to expire the line on the agreement, and creates a new line with the updated UOM, which will be used on future releases.

The Purchasing Documents Open Interface also imports price breaks. In an updated price/sales catalog, if the supplier updates an item’s price, the Purchasing Documents Open Interface deletes the item’s price breaks since they are no longer current with the new price. If the supplier sends new price breaks for an existing line, the current price breaks are deleted and the new price breaks sent by the supplier are created.
The Purchasing Documents Open Interface supports the Oracle e–Commerce Gateway transmissions of the price/sales catalogs (ANSI X12 832 or EDIFACT PRICAT) and responses to RFQs (ANSI X12 843 or EDIFACT QUOTES).

For e–Commerce Gateway to distinguish between Original, Replace, and Update action codes, you need to set up code–conversion categories and values in e–Commerce Gateway. See: Defining Code Conversion Categories, Oracle e–Commerce Gateway User’s Guide. See: Defining Code Conversion Values, Oracle e–Commerce Gateway User’s Guide.

Other setup includes making sure that default category sets are set up appropriately for both Purchasing and Inventory, setting Purchasing profile options, and allowing updating of the item master if you want to update the item description in the item master as well as on the blanket purchase agreement or quotation. For complete instructions on setup requirements, see the Oracle Manufacturing, Distribution, Sales and Service Open Interfaces Manual.

You can also import standard purchase orders through the Purchasing Documents Open Interface, using your own import program. You cannot update or replace existing standard purchase orders through the Purchasing Documents Open Interface. You must use the Original action code.

How Sourcing Works

When you import blanket purchase agreements and catalog quotations into Purchasing, you have the option of choosing Yes or No in the Create Sourcing Rules field in the Parameters window to enable Purchasing to create sourcing rules out of the supplier, item, and document information that the supplier sends.

Original and Replacement Price/Sales Catalogs

If you choose Yes to create sourcing rules in an original or replacement price/sales catalog, Purchasing checks if a sourcing rule is assigned to the item at the item level and does the following:

• If no sourcing rules exist for the item, Purchasing generates a sourcing rule automatically, allocating 100 percent to the supplier importing the information.
• If a sourcing rule exists for the item, Purchasing compares the effectivity dates of the incoming document with those of the existing sourcing rule for the item. To ensure that only one sourcing rule is used for the item, Purchasing does the following:
  
  – If the effectivity dates of the incoming document are the same as the existing sourcing rule’s effectivity dates, Purchasing checks to see if the supplier is in the sourcing rule. If not, Purchasing adds the supplier to the existing sourcing rule with an allocation of 0 percent. Later, you can query the sourcing rule and define your own percentage splits between suppliers.
  
  – If the effectivity dates of the incoming document are different than the existing sourcing rule’s effectivity dates, but are within or overlap the existing effectivity dates, then a new sourcing rule is not created, so as not to conflict with the existing sourcing rule.
  
  – If the effectivity dates of the incoming document do not overlap the existing sourcing rule’s effectivity dates, Purchasing updates the item’s sourcing rule with the new effectivity dates, adding the supplier at an allocation of 100 percent.
  
• Purchasing checks for an Approved Supplier List entry for the item and supplier/site combination. If an entry exists, Purchasing adds the document to the entry. If an entry does not exist, Purchasing creates a new entry with the new source document.

**Updated Price/Sales Catalogs**

If you choose Yes to create sourcing rules in an Update submission, new sourcing information is created (as described above) only if the Update submission results in a new line being created.

**See Also**

Running the EDI Price/Sales Catalog Inbound Program, *Oracle e-Commerce Gateway User’s Guide*

Running the EDI Response to Request for Quote Inbound Program, *Oracle e-Commerce Gateway User’s Guide*

Purchasing Documents Open Interface: page 9 – 108
Setting a Price Tolerance in a Price/Sales Catalog Update

You can set a price update tolerance that specifies the maximum percentage increase allowed to an item’s price when your supplier sends updated price/sales catalog information through the Purchasing Documents Open Interface. This price update tolerance affects only blanket purchase agreements and catalog quotations imported through the Purchasing Documents Open Interface. If the tolerance is exceeded, you receive a notification for each affected document and can accept or reject the price increase through the Exceeded Price Tolerances window. You can also access this window through the notification.

Purchasing performs the price update tolerance check against the price on the current revision of the document. The price tolerance check is performed only on updated blanket purchase agreements and catalog quotations and only on line price increases (not price breaks).

To set the price tolerance:

Define a price update tolerance at any of the following levels; Purchasing uses the first tolerance it finds, in this order: on the agreement in the Terms and Conditions window, at the item–supplier level in the Supplier–Item Attributes window, at the commodity–supplier level in the Supplier–Item Attributes window, and at the system level in the PO: Price Tolerance (%) for Catalog Updates profile option.

Example   If you set the Price Update Tolerance to 20 at the item–supplier level in the Supplier–Item Attributes window (and you haven’t set the price tolerance on the agreement), a price increase of more than 20 percent for that item and supplier will send the buyer a notification. If you set the Price Update Tolerance to 20 on the agreement, a price increase of more than 20 percent on that document will issue a notification.

A price tolerance of 0 means you are alerted of every price increase. No tolerance means that you are not alerted of any price increase.
Monitoring Price Increases in a Price/Sales Catalog Update

Use the Exceeded Price Tolerances window to accept or reject price increases to blanket purchase agreements and catalog quotations sent by your supplier through the Purchasing Documents Open Interface.

This window displays price increases only to blanket purchase agreements and catalog quotations received through the Purchasing Documents Open Interface and only if you define a Price Update Tolerance at one of four levels. See: Setting a Price Tolerance in a Price/Sales Catalog Update: page 5 – 25.

Purchasing performs the price update tolerance check against the price on the current revision of the document. The price tolerance check is performed only on updated blanket purchase agreements and catalog quotations and only on line price increases (not price breaks).

To accept or reject price increases:

1. Navigate to the Exceeded Price Tolerances window.

   This window is available in the Purchasing menu. You can also navigate to this window from the notification. The price increase notification is titled Price tolerance exceeded during BLANKET update or Price tolerance exceeded during QUOTATION update. Select the notification, and then choose the document icon to open the Exceeded Price Tolerances window.

   You receive a notification for each affected document.
The updated document’s header information is displayed at the top of the Exceeded Price Tolerances window. Its lines whose price updates exceeded the price tolerance are displayed below. You cannot change the price here, but simply accept or reject it.

**Document Status:** Approval Status of Approved or Incomplete entered in the Parameters window when importing the price/sales catalog, for your reference. You cannot change this field.

**Rev** – Item revision number.

**Current Price:** The current price of the item in Purchasing, on the blanket purchase agreement or quotation.

**New Price:** The updated price in the price/sales catalog submission. This price has exceeded your price tolerance.

**Increase (%):** Percentage by which the price of the item was exceeded over the price on the current blanket purchase agreement or quotation in Purchasing.
Tolerance (%): The price tolerance that is set in Purchasing for this item.

Price Increase: The difference between the current price on the blanket purchase agreement or quotation in Purchasing and the updated price in the price/sales catalog submission.

2. Choose Price Breaks to view price break changes, if any.

The Price Breaks window is a view–only window.

3. In the Action column of the Exceeded Price Tolerances window, choose Accept or Reject to accept or reject each price update. Or choose Accept All or Reject All to accept or reject all price updates.

Accept: The price update to the document line is accepted.

Reject: The price is not updated on the document. Any other changes to the line—to the item Description, UOM, Expiration Date, or URL descriptive flexfield—have already been made. Only the price update is not made. If you’ve customized the price/sales catalog workflow, you can enable the Reject action to send the supplier a notification that the price update for this item has been rejected. See: Price/Sales Catalog Notification Workflow: page C–267.

Note: The revision of the document is not updated until you accept all line updates (if the profile option PO: Archive Catalog on Approval is set to Yes).

Attention: Depending on how the function security is set for your user responsibility, you may not have access to the Action field. (With function security, a system administrator can limit people’s access to this function to view–only.)

4. Save your work.
See Also

Receiving Price/Sales Catalog Information Electronically: page 5 – 22

*Oracle Manufacturing, Distribution, Sales and Service Open Interfaces Manual*
Overview of Automatic Sourcing

Purchasing lets you automatically source online requisitions with blanket purchase agreements or quotations you create. You can easily assign any item with an item number to a specific blanket purchase agreement or quotation. Purchasing automatically assigns the name of the supplier for the blanket purchase agreement and quotation to any requisition for this item.

To achieve automatic sourcing, use the Sourcing Rule and Sourcing Rule/Bill of Distribution Assignments windows to create sourcing rules. Optionally use the Approved Supplier List and Supplier–Item Attributes windows to specify source document information for a particular item, supplier, and site.

Defaulting Sourcing Information

For requisitions, if you define a blanket purchase agreement or quotation as the source document for your item, and define and assign sourcing rules, Purchasing provides the following sourcing information for your requisition line: Buyer, Supplier, Site, Contact, Phone, Supplier Item Number, Document Type (Blanket or Quotation) Source Document, Source Line Number, and RFQ Required (Yes or No). Once you save the requisition line, Purchasing also defaults the price from the source document. You can later review the sourcing information in the AutoCreate Documents window before placing the requisition line onto a purchase order.

For standard purchase orders, if you define a quotation as the source document for the item, and define and assign sourcing rules, Purchasing provides the following sourcing information for the purchase order line: Contract, Quotation, quotation Line, Quotation Type, and Supplier Quotation number. Purchasing also defaults the price from the source document.

A requisition with a quotation as a source document becomes a standard purchase order. A requisition with a blanket purchase agreement as a source document becomes a release.

Purchasing defaults sourcing information from the blanket purchase agreement or quotation except under the following conditions:

- The document is not approved.
- The blanket purchase agreement is frozen or cancelled, or the purchase agreement line is cancelled.
- The document is not active.
• You have copied sourcing information back to the requisition from the Supplier Item Catalog.

**Sourcing by Item or Item Category**

In the Approved Supplier List and Sourcing Rule windows, you source at an item or commodity level. That is, you provide sourcing information for a particular item at the item level, or for a category of items at the commodity level.

For both one–time and inventory items, if no sourcing rule is provided at the item level in the Sourcing Rule/Bill of Distribution Assignments window, Purchasing automatically defaults the supplier or supplier site from the category–level sourcing rule if there is one.

The same is true of supplier statuses. If you debar a supplier for a specific commodity (category) in an Approved Supplier List entry, the supplier is prevented from supplying all items within that commodity. (Note: If you approve a supplier for a commodity, the item–specific status for the supplier still takes precedence.)

**Sourcing Globally or Locally**

In the Approved Supplier List and Sourcing Rule windows, you also choose whether to exercise the sourcing information at a global or local level. A sourcing rule assigned at the global level in the Sourcing Rule/Bill of Distribution Assignments window is valid for all operating units. A global ASL entry in the Approved Supplier List window is valid for all inventory organizations in an operating unit. A local sourcing rule or ASL entry is valid only for the organization that you were in or that you chose when creating the sourcing rule or ASL entry.

Local entries take precedence over global ones. For example, if you have a global sourcing rule that says to use Supplier A for an item for all organizations in your agency, and a local sourcing rule for the same item that says to use the local Supplier Z only for your organization, Purchasing defaults Supplier Z on requisitions or purchase orders created in your organization. Local entries are the default in the Approved Supplier List window.

**Defining Allocation Percentages**

When creating sourcing rules in the Sourcing Rule window, you must define allocation percentages. Master Scheduling/MRP uses these allocation percentages when creating planned orders, which Purchasing imports as requisitions through Requisition Import. In a group of
requisitions imported from Master Scheduling/MRP, the requisitions show the percentage allocation you define. In other words, at the end of a planning period, a group of orders to those suppliers approximately equals the percentage split you defined. However, when you create an individual requisition in Purchasing, Purchasing sources to the supplier with the highest allocated percentage. The Approved Supplier List (ASL) entry for that supplier is then referenced in order to pick up source document information (from a blanket purchase agreement or quotation), if source documents exist. If a percentage allocation is the same for some suppliers, and you have ranked the suppliers in the Sourcing Rule window, Purchasing sources to the one with the highest rank.

**Specifying Planning Constraints**

The Supplier–Item Attributes window lets you optionally specify the capacity of individual supplier sites to supply specific items. Supply Chain Planning allocates planned orders taking these capacity constraints into account. For example, you define and assign a sourcing rule that says an item can come from either of two suppliers this year. In the sourcing rule, you also rank the suppliers so that Planning prefers Supplier 1 over Supplier 2. However, if the capacity of Supplier 1 in the Planning Constraints tabbed region of the Supplier–Item Attributes window includes a four-day lead time, but there is a need–by date of one day, Supply Chain Planning automatically defaults Supplier 2 onto planned orders if Supplier 2 has a lead time of less than one day. (If no suppliers can meet your demand, Supply Chain Planning uses the top–ranked supplier.)

In addition to lead time, you can define receiving schedules, minimum order quantities and fixed lot multiples, capacity per day, and tolerance fences. See: Defining the Supplier/Item Attributes: page 5 – 51.

These planning constraints apply to planned orders only.

**See Also**

Setting Up Automatic Sourcing: page 5 – 33
Setting Up Automatic Sourcing

Use the Sourcing Rules windows to default a supplier and optionally a supplier site on your requisition or purchase order line. Use the Approved Supplier List if you also want to default source document information from a blanket purchase agreement or quotation on your requisition or purchase order line for an item–supplier combination.

By defining and assigning sourcing rules, Purchasing actively defaults the appropriate supplier onto your document as soon as you enter an item or commodity.

To default the supplier, site, and source document information:

1. Set the profile option PO: Automatic Document Sourcing.

   Setting this profile option to Yes means that Purchasing automatically searches for the most current blanket purchase agreement or quotation for an item–supplier combination, and defaults the information from this document onto a newly created document line. This method is useful if you do not want to maintain the most current source documents in the Approved Supplier List, particularly if you receive these documents regularly from your suppliers through the Purchasing Documents Open Interface. If you set this profile option to Yes, you do not have to specify source documents in the Approved Supplier List.

   Note that if an item on a requisition is associated with both a blanket purchase agreement and a quotation, Purchasing uses the blanket purchase agreement even if the quotation was created more recently.

   Setting this profile option to No means that Purchasing defaults sourcing information onto a newly created requisition or purchase order line only from those documents you have specified in the Approved Supplier List. This method is useful if you prefer to maintain and update the Approved Supplier List with documents that you choose.

2. If you set the profile option in the previous step to No, create a source document (a blanket purchase agreement or quotation) and then tie the document to an Approved Supplier List entry.

   See: Defining the Supplier and Commodity/Item Combination: page 5 – 47. Then see: Defining the Supplier/Item Attributes: page 5 – 51.

   If you set the profile option in the previous step to Yes, you do not have to perform this step, although you can if you want to.
Purchasing still uses the source documents in the Approved Supplier List if they are the most current, and uses documents outside the Approved Supplier List if they are not.

**Note:** When Use Approved Supplier is checked for an item in the Master Items window, you cannot approve the source document until the supplier is in the Approved Supplier List. Therefore, if Use Approved Supplier is checked for an item, create the Approved Supplier List entry and source document in the following order:

- Create an Approved Supplier List entry (this is the approved supplier you are enforcing for the item).
- Create and save a source document.
- Return to the Approved Supplier List window and tie the source document to the supplier.

3. Define and assign sourcing rules as described in **To default just the supplier and the supplier site** below.

**To default just the supplier and the supplier site:**

1. Make sure you have satisfied the prerequisites for defining and assigning sourcing rules:

   - Define items. See: Defining Items, Oracle Inventory User’s Guide.
   - Create suppliers and supplier sites in the Suppliers window. See: About Suppliers, Oracle Public Sector Payables User’s Guide.
   - Set the profile options *MRP: Sourcing Rule Category Set* and *MRP: Default Sourcing Assignment Set*. See: Purchasing Profile Options: page 1 – 103.


   **Note:** Some of the fields in the Sourcing Rule window may already be completed for you if your supplier sends you catalog information electronically. See: Receiving Price/Sales Catalog Information Electronically: page 5 – 22.

3. Use the Sourcing Rule/Bill of Distribution Assignments window to assign your sourcing rules to particular items or organizations. See: Assigning Sourcing Rules and Bills of Distribution: page 5 – 39.

   **Attention:** When you enter an Assignment Set name in the Sourcing Rule/Bill of Distribution Assignments window, note that Purchasing can use only one assignment set—the one that...
Supply Base Management is specified in the profile option *MRP: Default Sourcing Assignment Set*. (Note that the User level for the profile option takes precedence.)

Although creating and assigning a sourcing rule in the Sourcing Rule windows is all you need to do to default a supplier and supplier site onto your documents, you can still also create approved suppliers in the Approved Supplier List window. For example, if you checked Use Approved Supplier in the Master Items window when defining an item, you must define the supplier in the Approved Supplier List window.

If you want to verify the sourcing rule, create a requisition for the item to verify that the Supplier and Site default. If the sourcing rule is local, make sure the Organization field on the requisition is the organization in which the sourcing rule was created.

**Troubleshooting**

If you encounter any problems with automatic sourcing after you set it up, the following solutions may help.

**Purchasing is not using the sourcing rules defined in the Sourcing Rule/Bill of Distribution window**

Make sure that you have done both of the following:

- Assigned the sourcing rules to an assignment set in the Sourcing Rule/Bill of Distribution Assignments window.

- Made sure that the Assignment Set name in this window matches the assignment set name in the profile option *MRP: Default Sourcing Assignment Set*.

  Purchasing can use only one assignment set at a time, so if Purchasing is not using your sourcing rules, they may belong to another assignment set. For the *MRP: Default Sourcing Assignment Set* profile option, choose the assignment set name to which your sourcing rules are assigned in the Sourcing Rule/Bill of Distribution Assignments window.

  Also make sure that the profile option *MRP: Default Sourcing Assignment Set* isn’t also set at the User level. The User value for profile options takes precedence over System Administrator level values. If you believe that Purchasing is not using the correct Assignment Set, check if the profile option is also set at the User level.
Source document information is not defaulting onto my requisition or purchase order

Assuming you have defined and assigned sourcing rules, the problem could be one of the following:

- Make sure you have followed the instructions in the following two sections: Defining the Supplier and Commodity/Item Combination: page 5 – 47 and Defining the Supplier/Item Attributes: page 5 – 51. Make sure that, for the item, the supplier and site in the Approved Supplier List matches the supplier and site in the sourcing rule.

- The Approved Supplier List entry may be local. In the Approved Supplier List window, choose the Record Details tabbed region and note the Global field. If the Global field is set to No, then the sourcing information specified for the item is used only locally, by your organization or the organization that originally created the Approved Supplier List entry, and other organizations will not receive the source document information. Likewise, if there are two Approved Supplier List entries for an item, and one is local and the other is global, the local entry takes precedence for your organization.

- Sometimes you may see just one, Global entry in the Approved Supplier List window, but local versions of that entry are visible only in the Supplier–Item Attributes window. Recall that a local entry takes precedence over a global one and is used only by the organization in which it was created. In the Approved Supplier List window, choose the Attributes button. If local entries exist, the Create Local button will be dimmed.

See Also

Setting Up and Implementing Sourcing Strategies, Oracle Master Scheduling/MRP and Supply Chain Planning User’s Guide

Sourcing Rules and Bills of Distribution, Oracle Master Scheduling/MRP and Supply Chain Planning User’s Guide

Overview of Automatic Sourcing: page 5 – 30
Defining Sourcing Rules

You can define sourcing rules that specify how to replenish items in an organization, such as purchased items in plants. Sourcing rules can also specify how to replenish all organizations, as when the entire enterprise gets a subassembly from a particular organization.

If there is a conflict between a sourcing rule and a bill of distribution, the sourcing rule takes precedence. For instance, if you assign a bill of distribution to AUS that tells it to source a part from NYC, AUS can still define a sourcing rule to source the part from SAC. In this case, the local sourcing rule overrides the bill of distribution.

To define a sourcing rule:

1. Navigate to the Sourcing Rule window.

2. Enter a unique sourcing rule name.
3. Indicate whether this sourcing rule is used for all organizations (global) or a single organization (local).

   If the sourcing rule is local, you must enter an organization name; otherwise, your current organization will be the receiving organization.

4. Choose Copy From to copy the effectivity dates and shipping organization from another sourcing rule into this one.

5. Enter effectivity dates. You must enter a start date, but entering an end date is optional.

6. For each range of effectivity dates, you can include multiple shipping organizations. For each shipping organization you want to include, select a sourcing type to specify whether you make, buy, or internally transfer the item. You can also copy a list of shipping organizations from an existing sourcing rule.

   If you enter a customer organization as the receiving organization, then you cannot select a supplier organization as the shipping organization.

   **Note:** Suppliers and supplier sites are predefined in Oracle Public Sector Payables. (See: About Suppliers, *Oracle Public Sector Payables User’s Guide*.)

7. Enter an allocation percentage for each shipping organization. Allocation percentage includes the number of planned orders issued to the part for the entire planning horizon. Your total allocation may not exceed 100.

   If the allocation percentage for all the shipping organizations included within a range of effectivity dates equals 100, Planning Active is checked. If the sourcing rule is not planning active, the planning process will not use the rule to assign planned orders.

   **Note:** You cannot set the allocation percentage to less than or greater than 100 for sourcing rules that are already assigned in assignment sets.

8. Enter a numeric rank value to prioritize each sourcing type.

   If you have two sources with the same allocation percentage, planned orders are sourced from the highest rank first.

9. Select a shipping method, such as FEDEX, UPS, or rail. (See: Defining Shipping Methods, *Oracle Inventory User’s Guide*.)

10. Save your work.
To copy shipping organizations from an existing sourcing rule:

This feature allows you to include long, previously defined lists of shipping organizations without manual entry.

1. Select a sourcing type to specify whether you make, buy, or internally transfer the item.
2. Choose Copy Shipping Orgs From.
3. In the Find window, select a sourcing rule that includes the shipping organizations you want to duplicate in this new sourcing rule.
4. Choose OK.

To purge a sourcing rule:

1. Select a sourcing rule name.
2. Choose Purge.

Assigning Sourcing Rules and Bills of Distribution

Once you have defined your sourcing rules and bills of distribution, you must assign them to particular items and/or organizations. These assignments are grouped together in assignment sets. This is where your various sourcing strategies define a particular supply chain network.

Each assignment set represents selection of organizations and/or items you want planned. To influence the planning process, you must include an assignment set in your plan options.

In an assignment set you can assign your sourcing rules and bills of distribution at different levels, as follows:

- an item across all organizations
- a single item in an inventory organization
- all items in an inventory organization
- categories of items
- categories of items in an inventory organization
- all organizations
These levels allow you to assign a replenishment rule to as many or as few items as possible. For example, a category of items could be defined as packaging material, and a sourcing rule that identifies the suppliers could be assigned.

To assign a sourcing rule or bill of distribution:

1. Navigate to the Sourcing Rule/Bill of Distribution Assignments window.

2. Enter an assignment set name and description.

   **Note:** The assignment set name specified in the profile option MRP: Default Sourcing Assignment Set is the only one that Purchasing uses. If you want this assignment set to be used by Purchasing, update the profile option with this assignment set name, or create an assignment set that matches the profile option.

Note: You can assign a sourcing rule or bill of distribution to a category only if the profile option MRP: Sourcing Rule Category Set is set. See: Profile Options in Purchasing: page 1 – 103.

4. Enter an organization name, if the Assigned To type requires one.
   
   Note: You cannot assign customers modelled as organizations to a global sourcing rule.

5. Enter an Item/Category if you selected Item or Item–Org as the Assign To type.

6. Enter the sourcing rule or bill of distribution as the Type.

7. Enter the name of the sourcing rule or bill of distribution.

8. Save your work.

To purge a sourcing rule or bill of distribution:

1. Select an assignment set name.

2. Choose Purge.
Approved Supplier List

All procurement organizations maintain lists that associate the items and services they buy with the companies who supply them, either formally or informally. Data stored in a controlled, global repository containing relevant details about each ship–from/ship–to/item relationship, is known as an Approved Supplier List (ASL). This repository includes information about all suppliers with business statuses including Approved, Debarred, or New.

Use the Approved Supplier List and Supplier–Item Attributes windows to specify blanket purchase agreements or quotations as source documents for a particular item and supplier or particular item category (commodity) and supplier. Purchasing automatically defaults this source document information, such as the Buyer, supplier Contact, and Supplier Item Number, for the item or commodity onto the requisition line. Standard purchase orders get source document information from quotations. Requisitions get source document information from blanket purchase agreements or quotations. See: Defining the Supplier and Commodity/Item Combination: page 5 – 47. See: Defining the Supplier/Item Attributes: page 5 – 51.

Note: Purchasing can also search for the most current source documents for you, without your setting up the Approved Supplier List, if you set the profile option PO: Automatic Document Sourcing to Yes. See: Setting Up Automatic Sourcing: page 5 – 33.

See Also

Overview of the Approved Supplier List, Oracle Supplier Scheduling User’s Guide

Supply Chain Planning, Oracle Master Scheduling/MRP and Supply Chain Planning User’s Guide

Overview of Automatic Sourcing: page 5 – 30

ASL Repository Maintenance

Through maintenance of the Approved Supplier List repository the following goals are realized:

• Supports Supplier Certification programs by providing a single store of information regarding a supplier’s current status.
• Helps design engineers achieve higher quality designs at a lower total cost through the re-use of preferred suppliers in new designs. Avoids supply base proliferation or unnecessary design dependence on ‘difficult’ suppliers.

• Eliminates redundant sourcing efforts within departments, and across organizations. Facilitates a more global approach to contract negotiation.

• Provides immediate procurement visibility when a supplier is assigned an unfavorable status. This ‘early warning’ can help prevent problem replication in multiple organizations.

• Complies with external Quality System process requirements like ISO 9001/9002.

• Provides storage for general data attributes that are unique to the supplier/item intersection.

• Maintains lists of supplier ‘candidates’ by commodity or item for future consideration.

### ASL Public Sector Needs

Using Oracle Public Sector Purchasing Approved Supplier List, you can:

• Set approval/certification status at the appropriate level for your business. For example, approve a supplier for a given commodity (e.g. ‘Office Supplies’) for expense purchases while approving a specific supplier/site for each production item.

• Approve suppliers (they perform their own manufacturing), distributors (they represent manufacturers), and manufacturers (they manufacture items marketed and sold by distributors).

• Define global or local ASL entries. All organizations should be able to specify their own attributes (information about the supplier/item relationship) even if the supplier/item status is defined as a global record. This enables individual ship-to-organizations to determine, for example, whether they are ready to perform supplier scheduling, their purchasing unit of measure, their default item price, etc.

• Link the primary supplier item number with your internal item number. This designated item will default to Purchase Order and Requisition lines.
• Specify a Review By date indicating a proactive, planned review of the business with a longstanding supplier partner.

• Review ASL information in a flexible inquiry format.

• Define your own approval statuses and associate them with specific business rules.

• Control procurement activity by preventing purchase order approval or supplier schedule confirmation for certain supplier/item combinations.

• Control whether Sourcing Rules must be comprised of approved suppliers.

• Define reference information, including planning constraints such as lead time, for the supplier/item combination.

• Disable ASL entries. See: Defining the Supplier and Item/Commodity Combination: page 5 – 47.

See Also

Setting Up Automatic Sourcing: page 5 – 33

Overview of Supplier Scheduling, Oracle Supplier Scheduling User’s Guide

Sourcing Rules and Bills of Distributions, Oracle Master Scheduling/MRP and Supply Chain Planning User’s Guide

Bucket Patterns, Oracle Supplier Scheduling User’s Guide

Defining Supplier Lists: page 5 – 96

Defining Ship–to Organization Level Defaults and Controls, Oracle Supplier Scheduling User’s Guide

Defining the Supplier/Item Attributes: page 5 – 51

Defining Approved Supplier Statuses: page 5 – 45

View Approved Suppliers: page 5 – 56

Defining the Supplier and Item/Commodity Combination: page 5 – 47

Defining Sourcing Rules: page 5 – 37

Defining Bills of Distributions, Oracle Master Scheduling/MRP and Supply Chain Planning User’s Guide
Defining Approved Supplier Statuses

You can create any number of Approved Supplier Statuses to describe the condition of the Approved Supplier, ranging from fully Approved (the supplier has demonstrated the ability to satisfy rigorous quality, cost, and delivery requirements over a sustained period) to Debarred (no business is allowed with this supplier for a particular item or commodity), or New if you have never placed a purchase order with the supplier.

Note: If you debar a supplier for a specific commodity (category) in the Approved Supplier List, the supplier is prevented from supplying all items within that commodity. However, if you approve a supplier for a commodity, the item-specific status for the supplier still takes precedence.

Each Approved Supplier Status can have business rules applied to manage the characteristics of the status. You can prevent or allow certain business rules for each status, change the name of a status, or create a status of your own. For example, the default status of Approved allows all the default business rules: PO Approval, Sourcing, Schedule Confirmation, and Manufacturer Linking. But you could change the Approved status to prevent one of the Business Rules. Likewise, you can create your own status with your own combination of Business Rules.

In the Status field in the Approved Supplier List window, Purchasing lets you choose among these supplier statuses. Defining your own supplier statuses in this window is optional.

► To define Approved Supplier Statuses:

1. Navigate to the Approved Supplier List Statuses window.
2. Enter a unique Status name.

3. Enter a status Description to convey the meaning of the status.

4. Optionally check Approved Supplier List Default to set this status as a default.

   This is the status that appears as the default for suppliers you add to the Approved Supplier List window. (You can change a supplier’s status from within the Approved Supplier List window.)

   **Note:** You can only have one Approved Supplier Status as a default.

5. Optionally choose a date for Inactive On to set the time when the status will no longer be active.

   Existing Approved Supplier List entries still use the status you inactivate today. New entries you create, however, will not.
6. If you choose to apply Business rules to the Approved Supplier Status, choose a Control. By choosing a Control, you either Allow or Prevent the Business Rule.

7. Select a Business Rule.
   - **PO Approval** – Enables you to allow or prevent purchase order approvals sourced to this supplier.
   - **Sourcing** – Enables you to allow or prevent sourcing to this supplier.
   - **Schedule Confirmation** – Enables you to allow or prevent schedule confirmation for this supplier in Supplier Scheduling.
   - **Manufacturer Link** – In the Approved Supplier List window, you choose a Business from one of the following: Direct (Supplier), Manufacturer, or Distributor. If you have a Distributor defined in the Approved Supplier List window, this Business Rule enables you to allow or prevent linking to the Manufacturer also defined in the Approved Supplier List window.

8. Save your work.

See Also

Defining Planners Oracle Master Scheduling/MRP and Supply Chain Planning User’s Guide

---

**Defining the Supplier and Item/Commodity Combination**

**Prerequisites**

- Define items. See: Defining Items, Oracle Inventory User’s Guide.
- Create suppliers and supplier sites in the Suppliers window. See: About Suppliers, Oracle Public Sector Payables User’s Guide.

**To define the supplier and item/commodity combination:**

1. Navigate to the Approved Supplier List window.
2. In the Organizations window that appears, choose the ship-to organization for which you want to define Approved Supplier List (ASL) entries.

3. Choose one of the following options to which you want to assign a supplier:
   - Item – Assigns a supplier to a particular item.
   - Commodity – Assigns a supplier to a group of items belonging to a category (or commodity).

4. Select an Item or Commodity.
5. Choose a Business from the following:

- **Direct** (Supplier): Company sells their products directly to you
  
  If you choose Direct, choose the supplier Name and optionally, the Site.

  **Attention:** The supplier Name and Site, if you specify one, must match the sourcing rule Supplier and Site to default the supplier information or source document information successfully. See: Defining Sourcing Rules: page 5 – 37.

- **Manufacturer:** Company manufactures and sells through distributors

  If you choose Manufacturer, choose the Manufacturer Name.

- **Distributor:** Company sells products made by manufacturers

  If you choose Distributor, choose the distributor Name and optionally, the Site. You must associate the Distributor with a Manufacturer, meaning you must define a Manufacturer before you define its Distributor.

6. Choose the supplier’s approval Status.

   Use one of the default Statuses provided, or choose a status of your own if you defined other statuses in the Approved Supplier List Statuses window. See: Defining Approved Supplier Statuses: page 5 – 45.

   If you debar a supplier for a specific commodity, the supplier is prevented from supplying all items within that commodity. However, if you approve a supplier for a commodity, the item-specific status for the supplier still takes precedence.

7. Optionally choose the supplier item number.

   For Suppliers and Distributors, this supplier item number defaults to your purchase order and requisition lines, and is used to validate the source documents.

8. Optionally choose a Review By date.

   You can use this date to determine when a proactive business review will be performed for the supplier.

9. Choose the Record Details tabbed region.
10. Choose one of the following in Global:
   - Yes – This ASL entry is valid for all inventory organizations in your operating unit.
   - No – This ASL entry is local—that is, valid only for the organization you chose in the Organizations window when you first navigated to the Approved Supplier List window.

   **Note:** If you have two ASL entries for the same item or commodity—one Global entry that applies to all organizations in your agency and one local entry that applies only to your organization—the local entry takes precedence.

11. Save your work.

12. Optionally specify additional information, such as Supplier Scheduling, source documents, and capacity details for the ASL entry.

   See: Defining the Supplier/Item Attributes: page 5 – 51.

   **To disable an ASL entry that you no longer want to use:**

   1. In the Approved Supplier List window, identify the line (ASL entry) you want to disable.
   2. In the Key Attributes tabbed region, select the Disabled check box for the line.

   The item–supplier combination in this ASL entry is inactive for new documents that you create. Note that disabling an ASL entry is not the same as debarring a supplier. Debarring a supplier prevents sourcing to that supplier for that item or for all items in that commodity. Disabling an ASL entry disables just that line. You will still be able to source to that supplier if a separate ASL entry for the supplier is enabled.

   If you disable a local ASL entry, Purchasing uses the Global entry instead, if there is one.

   **To re-enable a supplier and item/commodity combination:**

   - Deselect the Disabled check box.

   The item–supplier combination in this ASL entry is now active for new documents you create.
Defining the Supplier/Item Attributes

Use the Supplier–Item Attributes window to specify additional information for the Approved Supplier List entry, including source document, Supplier Scheduling, and planning constraint information.

To define the supplier and commodity/item attributes:

1. Navigate to the Supplier–Item Attributes window by choosing the Attributes button in the Approved Supplier List window.

   Additional Information: The Create Local button creates a copy of an existing global Approved Supplier List entry and makes it local to your organization. The Create Local button is not available if you are already creating a local entry or if a local entry for the item (in this or the Approved Supplier List window) already exists.
2. Choose the Purchasing UOM.

3. Choose the Release generation Method from the following options:
   - Automatic Release/Review: automatically generate releases, but require a separate step for approval.
   - Automatic Release: automatically generate approved releases. You cannot choose this option if purchase order encumbrance is on.
   - Release Using AutoCreate: use the AutoCreate window to create releases.

4. Enter a Price Update Tolerance only if you are importing price/sales catalog information through the Purchasing Documents Open Interface.
The Price Update Tolerance specifies the maximum percentage increase allowed to a price for this item/supplier combination when the supplier sends updated price/sales catalog information through the Purchasing Documents Open Interface. This field affects only blanket purchase agreements and catalog quotations imported through the Purchasing Documents Open Interface. See: Setting a Price Tolerance in a Price/Sales Catalog Update: page 5 – 25.

5. Optionally choose the Country of Origin.

The Country of Origin is the country in which an item is manufactured. You can choose a Country of Origin if you specified a supplier Site in the Approved Supplier List window.

The Country of Origin is defaulted onto purchase orders for this item/supplier combination. However, you can change or enter the Country of Origin on the purchase order or later on the receipt.

6. Choose one of the following attribute groupings from the tabbed region:

- **Source Documents**: lets you associate specific quotations or blanket purchase agreements with the supplier/item combination.

- **Supplier Scheduling**: lets you associate Supplier Scheduling information with the supplier/item combination. You can choose this option if you specified an item and a supplier site.

- **Capacity Constraints**: lets you specify capacity constraints for the supplier/item combination. You can choose this option if you specified an item and a supplier site.

**If you chose Source Documents:**

**Note**: Setting the profile option **PO: Automatic Document Sourcing** to Yes enables Purchasing to default source documents automatically if you prefer that rather than specifying source documents here. See: Setting Up Automatic Sourcing: page 5 – 33.

1. Enter a unique Seq (Sequence) Number.

The Sequence Number is used internally. It does not affect the order with which Purchasing uses the source documents. If you enter more than one source document, Purchasing uses a blanket purchase agreement over a quotation, even if the quotation was created more recently. If there are only blanket purchase agreements or only quotations, Purchasing uses the one that was created most recently.
2. Select a Document Type from the following:
   - Blanket
   - Quotation

   A requisition with a quotation as a source document becomes a standard purchase order. A requisition with a blanket purchase agreement as a source document becomes a release. Standard purchase orders get source document information only from quotations.

   If you are creating a Blanket as a source document for Oracle Supplier Scheduling, make sure the Supply Agreement option is selected for the blanket purchase agreement in the Terms and Conditions window. See: Entering Purchase Order Details Information: page 4 – 60. Supplier Scheduling can communicate releases against a blanket purchase agreement only when this option is selected.

3. Choose a Document Number.

   If Purchasing does not let you enter a particular document number, it may be because the document is frozen, canceled, or not approved, or the agreement line is canceled. A quotation must be active.

4. Choose a Line Number.

   The Status and Effective Dates, if any, are displayed.

5. Save your work.

   ► If you chose Supplier Scheduling:

   1. Optionally check Enable Planning Schedules and/or Enable Shipping Schedules if you want to build Planning and/or Shipping Schedules.

   If you check Enable Planning Schedules and/or Enable Shipping Schedules, you can choose an assigned Scheduler.

   2. Check Enable AutoSchedule if you want your schedule automatically built.

   3. If you check Enable Planning Schedules and Enable AutoSchedule, you must choose the following:
      - Plan Bucket Pattern
      - Plan Schedule Type
4. If you check Enable Shipping Schedules and Enable AutoSchedule, you must choose the following:

- Ship Bucket Pattern
- Ship Schedule Type

5. If you check Enable Planning Schedules and Enable Authorizations, you can optionally choose up to four Resource Authorizations with their associated timefences.

6. Save your work.

► If you chose Planning Constraints:

The information you enter here is used by Supply Chain Planning for planned orders. See: Overview of Supply Chain Planning Logic, Oracle
Master Scheduling/MRP and Supply Chain Planning User’s Guide.

1. In the Processing Lead Time field, enter the number of lead days it takes to receive this item after ordering it.

2. Choose a Delivery Calendar pattern to define the dates upon which the supplier delivers to this organization.

   This calendar is independent of your workday calendar.

3. Choose Order Modifier options to indicate ordering constraints, if any:

   Minimum Order quantity: The minimum quantity you can order.

   Fixed Lot Multiple: The incremental quantity you can order on top of the Minimum Order quantity. For example, if the Minimum Order quantity is 100 and the Fixed Lot Multiple is 10, you must order at least 100, and if you order more than that, you must order 110, 120, and so on.

4. Create one or more entries in the Capacity area to indicate what the capacity is during a certain period or periods:

   From Date: The date from which the capacity constraints take effect.

   To Date: The date (optional) until which the capacity constraints take effect.

   Capacity per Day: Quantity of units per day. This field is required if a From Date is entered.

5. Create one or more entries in the Tolerance Fences area to indicate how the capacity fluctuates depending on how many days in advance you order:
For example, if you enter 12 Days in Advance and a Tolerance % of 2, you can exceed the supplier’s capacity by 2 percent if you order 12 days in advance. You must specify a Tolerance % if you specify Days in Advance.

See Also

AutoScheduling, Oracle Supplier Scheduling User’s Guide
Resource Authorizations, Oracle Supplier Scheduling User’s Guide
Defining Sourcing Rules: page 5 – 37
Assigning Sourcing Rules and Bills of Distribution: page 5 – 39
Setting Up and Implementing Sourcing Strategies, Oracle Master Scheduling/MRP and Supply Chain Planning User’s Guide
Defining the Supplier and Commodity/Item Combination: page 5 – 47

View Approved Suppliers

Use the Approved Supplier List Summary window to view all the Approved Supplier List entries. When you select and open a line in the Approved Supplier List Summary window, the Approved Supplier List window for that supplier appears.

To view the Approved Supplier List:

1. Navigate to the Approved Supplier List Summary window from the menu. The Search Approved Supplier List window opens.

2. Optionally choose or enter data into the available fields to further define your search.

   **Note:** Check Include Global Entries to specify that Global Entries are to be included.

3. Choose Find to begin the search.

   **Note:** You can choose Clear to erase the data from the form to redefine your search, or choose New to navigate to the Approved Supplier List window to define new approved suppliers.

4. Choose a record to view then choose Open to view the Approved Supplier List window.
Entering RFQs

Entering RFQ Headers

Use the RFQs window to:

- Enter and edit a request for quotation (RFQ)
- Review and edit an RFQ you autocreated from on-line requisitions

Each RFQ consists of header, line, and shipment information. You can send the RFQ to as many suppliers you want and decide how much item information to provide to the suppliers.

There are two methods of creating an RFQ: manual entry and by copying a blanket purchase agreement. Manual entry is described in this section below and the copy blanket agreement to RFQ process is described in detail in the Purchase Orders section. See: Copying Purchase Orders: page 4 – 106.

For information on the difference between RFQs and quotations, and the different types of RFQs and quotations, see: RFQs and Quotations: page 5 – 5.

Note: Whether or not you send an RFQ, suppliers can send you catalog quotations electronically, through the Purchasing Documents Open Interface. See: Receiving Price/Sales Catalog Information Electronically: page 5 – 22.

Prerequisites

Before using this window you should perform the following:

- Define suppliers and supplier sites. See: About Suppliers, Oracle Public Sector Payables User’s Guide.
- Define buyers. See: Defining Buyers: page 1 – 27.
- Define unit of measure classes. See: Defining Unit of Measure Classes, Oracle Inventory User’s Guide.
- Define units of measure. See: Defining Units of Measure, Oracle Inventory User’s Guide.
• Define payment terms. See: Defining Payment Terms, Oracle Public Sector Payables User’s Guide.

To enter RFQ header information:

1. Navigate to the RFQs window by selecting RFQs from the menu. Purchasing displays today’s date as the Created date and the functional Currency from your set of books.

2. Enter a unique number for the RFQ. In the Purchasing Options window, you can choose whether RFQ numbers are numeric or alphanumeric and whether Purchasing automatically generates them when you save your changes. See: Defining Numbering Options: page 1 – 53.

3. In the Type field, enter one of the document names defined for RFQs. The list of values lists the Document Type (Document Name) and Quotation Class from the Document Types window. For existing RFQs, the list of values includes only RFQs with the
4. Enter the Ship-To and Bill-To locations for the items on the RFQ. See: Defining Locations: page 1–24.

5. Use the Status field to control the status of the RFQ:

   - **In Process** – The initial status when you create the RFQ.
   - **Active** – Choose this status when the RFQ is complete and you are ready to send it to your suppliers. Only Active RFQs are printed.
   - **Printed** – The status assigned to the RFQ when you have printed at least one copy of it. You must change the status to Active if you want to reprint the RFQ.
   - **Closed** – Choose this status to close the RFQ when all suppliers have responded or when you no longer want responses. When you close an RFQ, Purchasing deletes all follow up notifications associated with it.

6. Enter the Due Date when you want your suppliers to reply. Purchasing prints the reply due date on the RFQ. Purchasing notifies you if the current date is between the RFQ reply due date and the close date and if the RFQ is Active. Purchasing knows that a supplier replied to an RFQ if you enter a quotation for this supplier referencing the RFQ. See: Viewing and Responding to Notifications: page 2–31. See: Entering Quotation Headers: page 5–73.

7. Enter the Reply/Receive Via code for the method you want the supplier to use to send the quotation. For example, by mail, telephone, or FAX. See: Defining Lookup Codes: page 1–74.

8. Enter the Close Date for the RFQ. Purchasing prints the close date on the RFQ. Purchasing notifies you if the current date is between the RFQ reply due date and the close date and if the RFQ is Active. Purchasing warns you when you enter a quotation against this RFQ after the close date. See: Viewing and Responding to Notifications: page 2–31.

9. Select Require Quote Approval to enforce approval of any quotation referencing this RFQ before the quotation can be used for a purchase order.

10. Purchasing displays your name as the Buyer. You can forward the RFQ to another buyer by choosing the name of this buyer from the list of values. The buyer you enter receives all notifications regarding this RFQ.
11. Enter the beginning and ending Effectivity Dates for the supplier quotation.


► To enter supplier information:
  ■ Select the Suppliers button to open the RFQ Suppliers window. See: Entering RFQ Supplier Information: page 5 – 63

► To enter currency information:
  ■ Select the Currency button to open the Currency window. See: Entering Currency Information: page 4 – 58.

► To enter terms and conditions information:
  ■ Select the Terms button to open the RFQ Terms window. See: Entering RFQ Terms Information: page 5 – 65.

► To enter shipment information:
  ■ When the Quotation Class of the header Type is Bid, you can select the Shipments button to open the RFQ Shipments window. See: Entering RFQ Shipment Information: page 5 – 66.

► To enter price break information:
  ■ When the Quotation Class of the header Type is Catalog, you can select the Price Break button to open the Price Breaks window. See: Entering RFQ Price Break Information: page 5 – 69.

---

**Entering RFQ Lines**

Use the Lines tabbed region in the RFQs window to enter and edit RFQ lines.

► To enter an RFQ line:
  1. Select the Lines tabbed region in the RFQs window.
2. Enter a unique Number for the RFQ line.

3. Enter the line Type for the item. When you enter a line type, Purchasing automatically copies the corresponding purchasing category, unit, and unit price. You can enter predefined items only when you choose a quantity based line type. Purchasing defaults the value you define in the Purchasing Options window. See: Defining Default Options: page 1 – 45. See: Defining Line Types: page 1 – 84.

4. Enter the Item for your RFQ line. Purchasing retrieves the item description, purchasing category, and unit of measure. If you do not enter a predefined item, you must provide a purchasing category and item description for the RFQ line. For amount based line types, the cursor does not enter this field. See: Defining Items, Oracle Inventory User’s Guide.

5. Enter the Revision number for the item on the requisition line.

6. Enter the purchasing category for your RFQ line. If you enter a predefined item, Purchasing supplies the purchasing category.
7. Enter the item Description for your RFQ line. If you enter an item, Purchasing supplies the item description. You can set up the item definition so that you can override the item description for this particular RFQ. See: Defining Items, Oracle Inventory User’s Guide.

8. Enter the UOM for your RFQ line. If you enter an item number, Purchasing supplies the unit of measure. For amount based line types, the cursor does not enter this field.

9. Enter an optional Target Price for the RFQ line. You may want to provide a target price on the RFQ line for negotiation purposes. For amount based line types, Purchasing uses a target price of 1.

10. Enter the supplier’s number for the item.

11. Save your work.

To enter additional RFQ line information:

1. Select the More tabbed region in the RFQs window. You can enter optional information in the fields described in the following steps.

2. Enter a unique line number for your RFQ line. Purchasing defaults the next available line number.

3. Enter the UN Number for the item on the RFQ line. See: Defining UN Numbers: page 1 – 71.

4. Enter the Hazard class for the item on the RFQ line. If you enter a UN number, Purchasing displays the corresponding hazard class if one has been defined. See: Defining Hazard Classes: page 1 – 70.

5. Enter the Minimum Order Quantity for the item on the RFQ line.

6. Enter the Maximum Order Quantity for the item on the RFQ line.

7. Optionally enter a Project Number.

8. Optionally enter a Task Number.


10. Optionally enter a Revision for Oracle Project Contracts.

11. Enter a note to the supplier about this item. This note prints on the RFQ.

12. Save your work.
To copy RFQs to quotations:


See Also

- Entering RFQ Headers: page 5 – 57
- Entering RFQ Supplier Information: page 5 – 63
- Entering RFQ Terms Information: page 5 – 65
- Entering RFQ Shipment Information: page 5 – 66
- Entering RFQ Price Break Information: page 5 – 69
- Entering Currency Information: page 4 – 58

Oracle Projects User’s Guide

Oracle Project Manufacturing Implementation Manual

Entering RFQ Supplier Information

Use the RFQ Suppliers window to:

- Enter the suppliers to which this RFQ will be sent. You can also delete suppliers from the RFQ until you have printed the RFQ for them.

- Review the supplier activity.

To enter RFQ supplier information:

1. Navigate to the RFQ Suppliers window by selecting the Suppliers button in the RFQs window. For each supplier that you enter, Purchasing displays the Printed and Responded dates as well as the Count of the number of times the RFQ has been printed. The Responded date is the receipt date recorded for the quotation from the supplier.
The Include In Next RFQ Printing check box is checked when you add a supplier. You can postpone printing the RFQ for a supplier by deselecting the check box. After you print the RFQ for a supplier, Purchasing deselects this field. If you want to reprint the RFQ for a supplier, you must use this window to select the field again.

2. Enter a unique sequence number for the supplier on the RFQ Suppliers list. Purchasing uses this sequence number to print your RFQs for these suppliers.

3. Enter the name of the active Supplier you want to place on the RFQ Supplier list. The list of values displays the supplier name, number, Tax ID number, and VAT number.

4. Enter the Supplier Site you want to place on the RFQ Supplier list for this supplier. You can choose only sites that you defined as RFQ Only suppliers. You cannot enter the same supplier site twice.

5. Enter the name of the Contact for this site

6. If you want to postpone printing the RFQ for a supplier, you can deselect Select for Printing.

7. Save your work.
To add suppliers from supplier lists:

1. Select the Add From List button in the RFQ Suppliers window to open the Supplier Lists modal window. This window is a display–only version of the Supplier Lists window, but includes only the Supplier List name, Description, and a Count of the number of suppliers on the list. See: Defining Supplier Lists: page 5 – 96.

2. Select any supplier list for which you want to copy all suppliers to the RFQ. Suppliers already on the RFQ are omitted.

3. Select the Apply button to close the window and add these suppliers to the RFQ. Otherwise, you can select the Cancel button to return to the RFQ Suppliers window without adding suppliers from a list.

4. Save your work.

See Also

Entering Currency Information: page 4 – 58
Entering RFQ Headers: page 5 – 57
Entering RFQ Lines: page 5 – 60

Entering RFQ Terms Information

Use the RFQ Terms window to enter terms and conditions information for RFQs.

To enter RFQ terms and conditions information:

1. Navigate to the RFQ Terms window by selecting the Terms button in the RFQs window. All terms and conditions information is optional. The defaults are from the Financial Options window. See: Defining Financials Options, Oracle Public Sector Payables User’s Guide.
2. Enter the Payment terms for the RFQ. Purchasing displays default payment terms that you can accept or change. See: Defining Payment Terms, Oracle Public Sector Payables User’s Guide.

3. Enter the Freight terms for the RFQ. Purchasing displays default freight terms that you can accept or change. See: Defining Lookup Codes: page 1 – 74.

4. Enter the freight Carrier for shipment of the RFQ. Purchasing displays a default freight carrier that you can accept or change. See: Defining Freight Carriers, Oracle Inventory User’s Guide.

5. Enter the FOB point for the RFQ. Purchasing displays a default free on board (FOB) designation that you can accept or change. See: Defining Lookup Codes: page 1 – 74.

6. Enter a Note To Supplier. You can enter up to 240 characters in this field.

7. Save your work.

See Also

Entering RFQ Headers: page 5 – 57
Entering RFQ Lines: page 5 – 60

Entering RFQ Shipment Information

Use the RFQ Shipments window to enter and review shipment information for Bid RFQs.

**Attention:** Use this window to request as many shipment quotations as you want. You might want to provide multiple shipments if you want to receive quotations from your suppliers for different ship-to locations, quantities, or other criteria.
To enter RFQ shipment information:

1. Navigate to the RFQ Shipments window by selecting the Shipments button in the RFQs window. This button is available only when the RFQ header Type has a Quotation Class of Bid. See: Entering RFQ Headers: page 5 – 57.

2. In the Shipments tabbed region, enter the shipment Number. Purchasing supplies shipment numbers in increments of one.

3. Enter the Organization.

4. Enter the Ship–To location for the quotation shipment. Purchasing defaults the ship–to location from the RFQ header.

5. Enter the Quantity for which you want to receive a quotation from your supplier.

6. Enter the shipping UOM for the RFQ shipment line. You may want the supplier to ship the item in different units of measure depending on the quantity ordered. Purchasing defaults the unit of measure from the RFQ line. For amount based line types, the field is not applicable.
7. Enter the unit Price for the RFQ shipment line. Leave this field blank if you want the supplier to provide a price independent of the price you want. For amount based line types, the cursor does not enter this field, and the price is set to 1.

8. Enter the Last Accept Date.

9. Enter the Need–By date.

10. Select Firm to indicate that the bid is firmed.

   The Approved check box indicates that there is an approved quotation shipment referencing this line.

11. Save your work.

   ▶ To enter additional RFQ shipment information:

   1. Select the More tabbed region in the RFQ Shipments window.

   2. Enter the shipment number. Purchasing provides shipment numbers in increments of one.

   3. Note that Taxable is selected if a Tax Code is associated with the item.

      If there is no Tax Code for the item, Taxable is not selected. You cannot change the Taxable check box independently of the Tax Code.

   4. Enter or use the default Tax Code for taxable items.

      The tax code defaults from the following sources, in the following order:

      • The Purchase Order Preferences window. If you have specified a preferred tax code in this window, Purchasing defaults this tax code onto the RFQ shipment.

      • The Tax Defaults region in the Purchasing Options window. If you have specified a tax defaulting hierarchy in this window, Purchasing searches for and defaults the tax code based on that tax defaulting hierarchy. See: Defining Tax Defaults Options: page 1 – 55.

      You can accept the default tax code or select another. If you need additional help with how tax defaulting works in Purchasing, see: Tax Defaults in Purchasing: page 4 – 135.

   5. Choose the Match Approval Level. The default is from the Purchasing Options window. See: Defining Default Options: page 1 – 45.
Two-Way – Purchase order and invoice quantities must match within tolerance.

Three-Way – Purchase order, receipt, and invoice quantities must match within tolerance.

Four-Way – Purchase order, receipt, inspection, and invoice quantities must match within tolerance.

6. Enter the Quantity Received Tolerance. The default is from the Receiving Options window. See: Defining Receiving Options: page 1 – 58.

7. Enter the Quantity Received Exception option. See: Defining Receiving Options: page 1 – 58.

   None – Receipts may exceed the selected tolerance.

   Reject – Receipts cannot exceed the selected tolerance.

   Warning – The receiver gets a warning message, but receipts can exceed the tolerance.

8. Save your work.

See Also

Entering RFQ Headers: page 5 – 57
Entering RFQ Lines: page 5 – 60

Entering RFQ Price Break Information

Use the RFQ Price Breaks window to enter pricing information for RFQs.

**Attention:** Use this window to request as many price breaks as you want. You can provide multiple price breaks if you want to receive quotations from your suppliers for different terms, ship-to locations, or quantities.

► **To enter RFQ price break information:**

1. Navigate to the RFQ Price Breaks window by selecting the Price Breaks button in the RFQs window. This button is available only when the RFQ header Type has a Quotation Class of Catalog.
2. In the Price Break tabbed region, enter the line Number. Purchasing supplies line numbers in increments of one.

3. Enter the Quantity at this price.

4. Enter the shipping UOM for the RFQ price break line. You may want the supplier to ship the item in different units of measure depending on the quantity you order. Purchasing defaults the unit of measure from the RFQ line.

5. Enter the unit Price for the RFQ price break line. You might want to provide price discounts to indicate to the supplier the prices you would like to receive. Leave this field blank if you want the supplier to provide a price independent of the price you want

6. Enter the Organization.

7. Enter the Ship–To location for the quotation line shipment. Purchasing defaults the ship–to location from the RFQ header.

8. Enter the Discount percentage from the unit price for the RFQ line. If you enter a unit price and break price for this line, Purchasing does not automatically calculate the discount. You should provide either a break price or a discount, not both. If you enter both values for the RFQ, Purchasing prints only the break price on the RFQ. If you provide a discount without providing a break price, Purchasing prints the discount on the RFQ.
9. Enter the Effective Date when you want to be able to start using the quotation from your supplier. If you leave this field blank, Purchasing applies the quotation effective date from the RFQ Header window. You can also enter lead time information instead of date information.

10. Enter the Expiration Date when you no longer need the quotation from your supplier. If you leave this field blank, Purchasing applies the expiration date from the RFQ header.

11. Enter the Lead Time for this RFQ line.

12. Enter the UOM you want to use to define the lead time.

13. Enter the Payment Terms for the RFQ. Purchasing prints these terms on the RFQ only if they are different from the terms on the RFQ header. The default is the payment terms from the RFQ header.

14. Enter the Freight Terms for the RFQ. Purchasing prints these terms on the RFQ only if they are different from the freight terms on the RFQ header. The default is the freight terms from the RFQ header.

15. Enter the FOB point for your RFQ Line. Purchasing prints this FOB point on the RFQ only if it is different from the FOB point on the RFQ header. The default is the FOB name from the RFQ header.

16. Enter the freight carrier for your RFQ. Purchasing prints this carrier on the RFQ only if it is different from the carrier on the RFQ header.

   The Approved check box indicates that there is an approved quotation shipment referencing this line.

17. Save your work.

   ► **To enter additional RFQ price break information:**


   2. Enter the line number. Purchasing provides line numbers in increments of one.

   3. Note that Taxable is selected if a Tax Code is associated with the item.

      If there is no Tax Code for the item, Taxable is not selected. You cannot change the Taxable check box independently of the Tax Code.

   4. Enter or use the default Tax Code for taxable items.
The tax code defaults from the following sources, in the following order:

- The Purchase Order Preferences window. If you have specified a preferred tax code in this window, Purchasing defaults this tax code onto the RFQ shipment.
- The Tax Defaults region in the Purchasing Options window. If you have specified a tax defaulting hierarchy in this window, Purchasing searches for and defaults the tax code based on that tax defaulting hierarchy. See: Defining Tax Defaults Options: page 1 – 55.

You can accept the default tax code or select another. If you need additional help with how tax defaulting works in Purchasing, see: Tax Defaults in Purchasing: page 4 – 135.

5. Choose the Match Approval Level. The default is from the Purchasing Options window. See: Defining Default Options: page 1 – 45.

*Two–Way* – Purchase order and invoice quantities must match within tolerance.

*Three–Way* – Purchase order, receipt, and invoice quantities must match within tolerance.

*Four–Way* – Purchase order, receipt, inspection, and invoice quantities must match within tolerance.

6. Enter the Quantity Received Tolerance. The default is from the Receiving Options window. See: Defining Receiving Options: page 1 – 58.

7. Enter the Quantity Received Exception option. See: Defining Receiving Options: page 1 – 58.

*None* – Receipts may exceed the selected tolerance.

*Reject* – Receipts cannot exceed the selected tolerance.

*Warning* – The receiver gets a warning message, but receipts can exceed the tolerance.

8. Save your work.

**See Also**

Entering RFQ Headers: page 5 – 57

Entering RFQ Lines: page 5 – 60
Entering Quotations

Entering Quotation Headers

Use the Quotations window to:

- Enter and edit quotations
- Review and edit quotations you copied from RFQs

For information on the difference between RFQs and quotations, and the different types of RFQs and quotations, see: RFQs and Quotations: page 5 – 5.

Note: You can also receive catalog quotations electronically from your suppliers through the Purchasing Documents Open Interface. See: Receiving Price/Sales Catalog Information Electronically: page 5 – 22.

Prerequisites

- Before using this window you should perform the following:
  - Define suppliers and supplier sites. See: About Suppliers, Oracle Public Sector Payables User’s Guide.
  - Define buyers. See: Defining Buyers: page 1 – 27.
  - Define unit of measure classes. See: Defining Unit of Measure Classes, Oracle Inventory User’s Guide.
  - Define units of measure. See: Defining Units of Measure, Oracle Inventory User’s Guide.
  - Define payment terms. See: Defining Payment Terms, Oracle Public Sector Payables User’s Guide.

To enter quotation header information:

1. Navigate to the Quotations window by selecting Quotations from the menu. Purchasing displays the functional Currency from your set of books.
2. Enter a unique number for the quotation. In the Purchasing Options window, you can choose whether quotation numbers are numeric or alphanumeric and whether Purchasing automatically generates them when you save your changes. See: Defining Numbering Options: page 1 – 53.

3. In the Type field, enter one of the document names defined for quotations. The list of values lists the Document Type (Document Name) and Quotation Class from the Document Types window. For existing quotations, the list of values includes only quotations with the same Quotation Class. See: Defining Document Types: page 1 – 87. See also: Types of Quotations and RFQs: page 5 – 7.

4. If you copied this quotation from an existing RFQ, Purchasing displays the corresponding RFQ number, which you can override. You can also manually provide an RFQ number. Purchasing verifies the supplier and supplier site you provide and lets you choose from a corresponding list of RFQs. If you want to enter a quotation as a response to an RFQ for a supplier you did not
provide on the RFQ supplier list, you need to modify the RFQ supplier list first. If you change the supplier or supplier site information on this quotation after you enter an RFQ number, Purchasing removes the RFQ number, and you must re-enter it. See: Entering RFQ Supplier Information: page 5 – 63.

If you enter the number of an RFQ for which you already entered a response for this supplier and supplier site, Purchasing displays a warning message but permits your entry.

**Attention:** If you are entering a quotation that is a response to an RFQ you previously sent to the supplier, you need to provide this RFQ number to indicate to Purchasing that the supplier responded.

5. Enter the Supplier for this quotation. When you enter a supplier name, Purchasing uses the default terms, conditions, and currency information for this supplier in the Quotation Terms and Currency windows. The list of values displays the supplier name, number, Tax ID number, and VAT number.

6. Enter the supplier Site for this quotation. You do not need to provide a supplier site for a quotation. When you enter a supplier site, Purchasing uses the default terms, conditions, and currency information for this supplier site in the Quotation Terms and Currency windows.

7. Enter a supplier Contact for this quotation.

8. Enter the Ship–To and Bill–To locations for the items on the quotation. See: Defining Locations: page 1 – 24.

9. Use the Status field to control the status of the quotation:

   - **In Process** – The initial status when you create the quotation. Purchasing sends you notifications that the quotation is awaiting completion.

   - **Active** – Choose this status when the quotation is complete and you are ready to approve it. Only Active quotations can be approved.

   - **Closed** – When you enter a quotation, you provide an expiration date for it. Purchasing sends you a notification when the quotation approaches expiration using the warning delay you provided in the quotation header. You can manually close the quotation to acknowledge the notification. If you do not acknowledge the notification by closing the quotation, the status of your quotation is still Active. You cannot use Closed quotation information on purchase orders.

10. Enter the Supplier Quote number.
11. Select Approval Required to indicate that approval is required to purchase goods based on this quotation.

12. The Response Date is the date you actually received the quotation. Purchasing defaults today’s date as the response date, but you can change this date.

13. Enter the beginning and ending Effective Dates for the quotation.

14. Purchasing displays your name as the Buyer. You can forward the quotation to another buyer by choosing the name of this buyer from the list of values. The buyer you enter receives all notifications regarding this quotation.


► **To approve the quotation:**
  - Select the Approve button to open the Approve Entire Quotation window. See: Approving Entire Quotations: page 5 – 93.

► **To enter currency information:**
  - Select the Currency button to open the Currency window. See: Entering Currency Information: page 4 – 58.

► **To enter terms and conditions information:**
  - Select the Terms button to open the Quotation Terms window. See: Entering Quotation Terms Information: page 5 – 79.

► **To enter shipment information:**
  - When the Quotation Class of the header Type is Bid, you can select the Shipments button to open the Quotation Shipments window. See: Entering Quotation Shipment Information: page 5 – 81.

► **To enter price break information:**
  - When the Quotation Class of the header Type is Catalog, you can select the Price Breaks button to open the Price Breaks window. See: Entering Quotation Price Break Information: page 5 – 84.
Entering Quotation Lines

Use the Lines tabbed region in the Quotations window to enter and edit quotation lines.

**Attention:** If your supplier gives you a single quotation that is independent of the quantity you order, you must still provide at least one shipment quotation since you approve quotation information by shipment rather than by line. Therefore, if your supplier provides you with a base unit price only, you can enter the base unit price here, but you must also provide a shipment with the same base unit price.

**To enter a quotation line:**

1. Select the Lines tabbed region in the Quotations window.

2. Enter a unique Number for the quotation line.
3. Enter the line Type for the item. When you enter a line type, Purchasing automatically copies the corresponding purchasing category, unit, and unit price. You can enter predefined items only when you choose a quantity based line type. Purchasing defaults the value you define in the Purchasing Options window. See: Defining Default Options: page 1 – 45. See: Defining Line Types: page 1 – 84.

4. Enter the Item for your quotation line. Purchasing retrieves the item description, purchasing category, and unit of measure. If you do not enter a predefined item, you must provide a purchasing category and item description for the quotation line. For amount based line types, the cursor does not enter this field. See: Defining Items, Oracle Inventory User's Guide.

5. Enter the Revision number for the item on the requisition line.

6. Enter the purchasing Category for your quotation line. If you enter a predefined item, Purchasing supplies the purchasing category.

7. Enter the item Description for your quotation line. If you enter an item, supplies the item description. You can set up the item definition so that you can override the item description for this particular quotation. See: Defining Items, Oracle Inventory User's Guide.

8. Enter the UOM for your quotation line. If you enter an item number, Purchasing supplies the unit of measure. For amount based line types, the cursor does not enter this field.

9. Enter the unit Price for the quotation line. For amount based line types, Purchasing uses a target price of 1.

10. Enter the supplier’s number for the item.

11. Save your work.

► To enter additional quotation line information:

1. Select the More tabbed region in the Quotations window. You can enter optional information in the fields described in the following steps.

2. Enter a unique line number for your quotation line. Purchasing defaults the next available line number.

3. Enter the UN Number for the item on the quotation line. See: Defining UN Numbers: page 1 – 71. If you enter a UN number, Purchasing displays the corresponding hazard class if one has been defined.
4. Enter the Hazard class for the item on the quotation line. See: Defining Hazard Classes: page 1 – 70.

5. Enter the Minimum Order Quantity for the item on the quotation line.

6. Enter the Maximum Order Quantity for the item on the quotation line.

7. Optionally enter a Project Number.

8. Optionally enter a Task Number.


10. Optionally enter a Revision for Oracle Project Contracts.

11. Enter a Note From Supplier about this item.

12. Save your work.

To approve the quotation:

- Select the Approve button to open the Approve Entire Quotation window. The Approve button is disabled if the quotation is not active and doesn’t have at least one shipment. See: Approving Entire Quotations: page 5 – 93.

See Also

Entering Currency Information: page 4 – 58

Entering Quotation Headers: page 5 – 73

Entering Quotation Terms Information: page 5 – 79

Entering Quotation Shipment Information: page 5 – 81

Oracle Projects User’s Guide

Oracle Project Manufacturing Implementation Manual

Entering Quotation Terms Information

Use the Quotation Terms window to enter terms and conditions information for quotations.
To enter quotation terms and conditions information:

1. Navigate to the Quotation Terms window by selecting the Terms button in the Quotations window. All terms and conditions information is optional. If you created the quotation using the Copy Document window, the defaults are from the RFQ. Otherwise, the defaults are from the supplier site, supplier, or the Financial Options window. See: Defining Financials Options, Oracle Public Sector Payables User’s Guide.

2. Enter the Payment terms for the quotation. Purchasing displays default payment terms that you can accept or change. See: Defining Payment Terms, Oracle Public Sector Payables User’s Guide.

3. Enter the Freight terms for the quotation. Purchasing displays default freight terms that you can accept or change. See: Defining Lookup Codes: page 1 – 74.

4. Enter the freight Carrier for shipment of the quotation. Purchasing displays a default freight carrier that you can accept or change. See: Defining Freight Carriers, Oracle Inventory User’s Guide.

5. Enter the FOB point for the quotation. Purchasing displays a default free on board (FOB) designation that you can accept or change. See: Defining Lookup Codes: page 1 – 74.

6. Enter a Note To Supplier. You can enter up to 240 characters in this field.

7. Enter the method the supplier used to answer to your RFQ. For instance, you could ask your supplier to send a quotation by mail, telephone, or FAX. See: Defining Lookup Codes: page 1 – 74.

8. Enter the Warning Delay (in days) that you want Purchasing to use when sending you an on-line notification before the quotation expiration date.

9. Save your work.
See Also

Entering Quotation Headers: page 5 – 73
Entering Quotation Lines: page 5 – 77

Entering Quotation Shipment Information

Use the Quotation Shipments window to enter shipment information for bid quotations.

To enter quotation shipment information:

1. Select the Shipments button to open the Quotation Shipments window. This button is available only when the header Type has a Quotation Class of Bid.

2. In the Shipments tabbed region, enter the shipment Number. Purchasing supplies shipment numbers in increments of one.

3. Enter the Organization.

4. Enter the Ship-To location for the quotation shipment. Purchasing defaults the ship–to location from the quotation header.
5. Enter the Quantity for which you received a quotation from your supplier.

6. Enter the shipping UOM for the quotation shipment line. You may want the supplier to ship the item in different units of measure depending on the quantity ordered. Purchasing defaults the unit of measure from the quotation line. For amount based line types, the field is not applicable.

7. Enter the unit Price for the quotation shipment line. For amount based line types, the cursor does not enter this field, and the price is set to 1.

8. Enter the Last Accept Date.

9. Enter the Need–By date.

10. Select Firm to indicate that the bid is firmed.

   The Approved check box indicates whether the shipment has been approved.

11. Save your work.

► To enter additional quotation shipment information:

   1. Select the More tabbed region in the Quotation Shipments window.

   2. Enter the shipment number. Purchasing provides shipment numbers in increments of one.

   3. Note that Taxable is selected if a Tax Code is associated with the item.

      If there is no Tax Code for the item, Taxable is not selected. You cannot change the Taxable check box independently of the Tax Code.

   4. Enter or use the default Tax Code for taxable items.

      The tax code defaults from the following sources, in the following order:

      • The Purchase Order Preferences window. If you have specified a preferred tax code in this window, Purchasing defaults this tax code onto the quotation shipment.

      • The Tax Defaults region in the Purchasing Options window. If you have specified a tax defaulting hierarchy in this window, Purchasing searches for and defaults the tax code based on that tax defaulting hierarchy. See: Defining Tax Defaults Options: page 1 – 55.
You can accept the default tax code or select another. If you need additional help with how tax defaulting works in Purchasing, see: Tax Defaults in Purchasing: page 4 – 135.

5. Choose the Match Approval Level. The default is from the Purchasing Options window. See: Defining Default Options: page 1 – 45.

**Two-Way** – Purchase order and invoice quantities must match within tolerance.

**Three-Way** – Purchase order, receipt, and invoice quantities must match within tolerance.

**Four-Way** – Purchase order, receipt, inspection, and invoice quantities must match within tolerance.

6. Enter the Quantity Received Tolerance. The default is from the Receiving Options window. See: Defining Receiving Options: page 1 – 58.

7. Enter the Quantity Received Exception option. See: Defining Receiving Options: page 1 – 58.

**None** – Receipts may exceed the selected tolerance.

**Reject** – Receipts cannot exceed the selected tolerance.

**Warning** – The receiver gets a warning message, but receipts can exceed the tolerance.

8. Save your work.

 geopolitics

▶ **To approve the quotation:**

- Select the Approve button to open the Approve Entire Quotation window. See: Approving Entire Quotations: page 5 – 93.

**See Also**

Entering Quotation Headers: page 5 – 73

Entering Quotation Lines: page 5 – 77
Entering Quotation Price Break Information

Use the Quotation Price Breaks window to enter pricing information for catalog quotations.

To enter quotation pricing information:

1. Select the Price Breaks button to open the Quotation Price Breaks window. This button is available only when the header Type has a Quotation Class of Catalog.

2. In the Price Break tabbed region, enter the price break line Number. Purchasing supplies line numbers in increments of one.

3. Enter the Quantity for this price.

4. Enter the shipping UOM for the quotation price break. The supplier may ship the item in different units of measure depending on the quantity you order. Purchasing defaults the unit of measure from the quotation line.

5. Enter the unit Price for the quotation price break.

6. Enter the Organization.

7. Enter the Ship–To location for the quotation price break. Purchasing defaults the ship–to location from the quotation header.
8. Enter the Discount percentage from the unit price for the quotation price break. If you enter a unit price and break price for this shipment, Purchasing does not automatically calculate the discount. You should provide either a break price or a discount, not both. If you enter both values for the quotation, Purchasing prints only the break price on the quotation. If you provide a discount without providing a break price, Purchasing prints the discount on the quotation.

9. Enter the Effective Date when you want to be able to start using this quotation. If you leave this field blank, Purchasing applies the quotation effective date from the Quotation Header window. You can also enter lead time information instead of date information.

10. Enter the Expiration Date when you no longer need the quotation. If you leave this field blank, Purchasing applies the expiration date from the quotation header.

11. Enter the Lead Time for this price break.

12. Enter the UOM you want to use to define the lead time.

13. Enter the Payment Terms for the quotation. Purchasing prints these terms on the quotation only if they are different from the terms on the quotation header. The default is the payment terms from the quotation header.

14. Enter the Freight Terms for the price break. Purchasing prints these terms on the quotation only if they are different from the freight terms on the quotation header. The default is the freight terms from the quotation header.

15. Enter the FOB point for the price break. Purchasing prints this FOB point on the quotation only if it is different from the FOB point on the quotation header. The default is the FOB name from the quotation header.

16. Enter the freight Carrier for the price break. Purchasing prints this carrier on the quotation only if it is different from the carrier on the quotation header. The default is the carrier from the header.

17. Save your work.

To enter additional quotation pricing information:


2. Enter the line number. Purchasing provides line numbers in increments of one.
3. Note that Taxable is selected if a Tax Code is associated with the item.
   If there is no Tax Code for the item, Taxable is not selected. You cannot change the Taxable check box independently of the Tax Code.

4. Enter or use the default Tax Code for taxable items.
   The tax code defaults from the following sources, in the following order:
   - The Purchase Order Preferences window. If you have specified a preferred tax code in this window, Purchasing defaults this tax code onto the quotation shipment.
   - The Tax Defaults region in the Purchasing Options window. If you have specified a tax defaulting hierarchy in this window, Purchasing searches for and defaults the tax code based on that tax defaulting hierarchy. See: Defining Tax Defaults Options: page 1 – 55.
   
   You can accept the default tax code or select another. If you need additional help with how tax defaulting works in Purchasing, see: Tax Defaults in Purchasing: page 4 – 135.

5. Choose the Match Approval Level. The default is from the Purchasing Options window. See: Defining Default Options: page 1 – 45.
   
   Two-Way – Purchase order and invoice quantities must match within tolerance.
   
   Three-Way – Purchase order, receipt, and invoice quantities must match within tolerance.
   
   Four-Way – Purchase order, receipt, inspection, and invoice quantities must match within tolerance.

6. Enter the Quantity Received Tolerance. The default is from the Receiving Options window. See: Defining Receiving Options: page 1 – 58.

7. Enter the Quantity Received Exception option. See: Defining Receiving Options: page 1 – 58.
   
   None – Receipts may exceed the selected tolerance.
   
   Reject – Receipts cannot exceed the selected tolerance.
   
   Warning – The receiver gets a warning message, but receipts can exceed the tolerance.
8. Save your work.

► To approve the quotation:

- Select the Approve button to open the Approve Entire Quotation window. See: Approving Entire Quotations: page 5 – 93.

See Also

Entering Quotation Headers: page 5 – 73
Entering Quotation Lines: page 5 – 77
Copying Quotations from RFQs

Use the Copy Documents window to create quotations directly from RFQs. Quotations you receive in response to an RFQ usually match the format of your RFQ. To create a quotation from an RFQ, open the original RFQ and choose Copy Document from the Tools menu. You can copy the complete RFQ or part of it to your quotation. You can then edit the quotation to provide detailed quotation line information.

Project and task information, if any, is carried from an RFQ when you copy a quotation from it.

To copy a quotation from an RFQ:

1. In the RFQs window, open the RFQ you want to copy.
3. Enter the copy–from Action: Entire RFQ, RFQ Header Only, or RFQ Header and Lines.
4. Enter a quotation Number if you are using manual quotation number entry. Otherwise, Purchasing assigns a number for you.
when you save your work. See: Defining Numbering Options: page 1 – 53.

5. Enter the document Type. This is one of the document names defined for RFQs. The list of values lists the Document Type (Document Name) and Quotation Class from the Document Types window. See: Defining Document Types: page 1 – 87.

6. Enter the name of the active Supplier. The list of values displays the supplier name, Hold Status, 1099 Number, and VAT Registration Number. See: About Suppliers, Oracle Public Sector Payables User’s Guide.

7. Enter the Supplier Site.

8. Enter the name of the Contact for this site

9. Select Copy Attachments if you want to include the RFQ attachments on the quotation.

10. Select the OK button to copy the RFQ. Purchasing displays a confirmation message and opens the new quotation in the Quotations window.

To clear your entries and return to the RFQs window:

- Select the Cancel button to clear entries and return to the RFQs window.

See Also

AutoCreate Documents Overview: page 6 – 2

Copying Purchase Orders: page 4 – 106
Approving Quotations

Finding Quotations for Approval

Use the Find Quotations window to enter search criteria for quotations that you want to approve.

► To enter search criteria:

1. Navigate to the Find Quotations window by selecting Quote Analysis from the menu. Enter optional search criteria as described in the following steps:

   ![Find Quotations window](image)

Attention: Provide the item as part of the search criteria if you know it. If not, you can provide the appropriate purchasing category or description. Use the wildcard (%) to help your search for the item. For example, to search for all items that have Computer as part of the description, enter %Computer% in the Description field. Note that the Description is case sensitive.

2. Enter the Item number. If you enter an item, you can also further restrict the search by entering an item Revision number.

3. Enter the item Description.
4. Enter the Category Set. This is used to find predefined items associated with a specific category set. If you enter a category set, you can also further restrict the search by entering a Category.

5. Enter the RFQ number. If you enter an RFQ number, you can also enter an RFQ Line number.

6. Enter the Supplier.

7. Enter the Quotation number.

8. Enter the Quotation Approval status: Yes or No

➢ To clear existing search criteria:
  ■ Select the Clear button to clear any existing search criteria.

➢ To initiate the search:
  ■ Select the Find button to initiate the search and open the Analyze Quotations window.

See Also

Defining Categories, Oracle Inventory User’s Guide
Defining Category Sets, Oracle Inventory User’s Guide
Defining Items, Oracle Inventory User’s Guide
About Suppliers, Oracle Public Sector Payables User’s Guide
Entering Quotation Headers: page 5 – 73
Approving Quotation Shipments: page 5 – 91

Approving Quotation Shipments

Use the Analyze Quotations window to review and approve general or specific quotation information for an item or a purchasing category.

You need to approve quotation shipments if you want requestors or buyers to be able to reference the shipments on purchase orders or requisitions. Purchasing lets you approve quotation shipments for specific purposes so that you can control the use of your sourcing information.
To approve quotation shipments:

1. Navigate to the Analyze Quotations window by selecting the Find button in the Find Quotations window. Purchasing opens the Analyze Quotations window and displays in the Quotations tabbed region all shipment lines from active quotations.

For each shipment line, Purchasing displays the following information: Quotation number, Supplier, Item Number, Item Description, Quotation Line, Unit Price, Freight Terms, Payment Terms, and Discount.

In the Shipment Approvals region, Purchasing displays all existing approvals for the current line. You can delete any of the existing approvals, or you can add approvals for the current line as described in the following steps.

2. Enter the approval Type. Approval types determine the types of documents on which you can use the approved shipment. The available types are: All Orders (all types of purchase orders and...
Supply Base Management

3. Enter an active approval reason. See: Defining Lookup Codes: page 1 – 74.

4. Enter comments about your approval.

5. Enter the name of the Approver. Purchasing defaults your name in this field.

6. Enter the Effective date range for your approval. You can use approved quotation shipments on your documents only if the quotation is active and if the current date is within the effectivity dates. If you do not provide an expiration date, you can always use the shipment for your documents while the quotation is active and approved.

7. Save your work.

► To approve entire quotations

- To approve/unapprove all shipments from a single quotation at one time, select the Approve Entire Quotations button to open the Approve Entire Quotations window. See: Approving Entire Quotations: page 5 – 93.

See Also

Entering Quotation Shipment Information: page 5 – 81
Entering Quotation Price Break Information: page 5 – 84
Finding Quotations for Approval page 5 – 90

Approving Entire Quotations

Use the Approve Entire Quotations window to approve or unapprove all shipments for a single quotation. You simply provide an approval type and reason. Purchasing approves or unapproves all shipments on the quotation.

You need to approve quotation information if you want to let your requestors or buyers reference it on purchase orders or requisitions. You can approve quotation information for specific purposes so that you can control the use of your sourcing information.
Use the Quotations window to approve or unapprove individual quotation shipments. See: Approving Quotation Shipments: page 5 – 91.

**To approve/unapprove entire quotations:**

1. Navigate to the Approve Entire Quotation window by selecting the Approve Entire Quotation button in the Quotations window. In this case, your approval action applies to all shipment lines on the quotation behind the current quotation shipment when you select the Approve Entire Quotation button. You can also navigate to this window by selecting the Approve button in the Quotations, Quotation Shipments, and Quotation Price Breaks windows.

![Approve Entire Quotation window](image)

2. Select either Approve or Unapprove as the approval action. You can approve an entire quotation as often as you want. Each time you approve an entire quotation, Purchasing creates a new approval for each quotation shipment.

   If you select Approve, you must enter an approval type and reason before you can save your changes. You can approve a specific quotation several times for different approval types and reasons. If you enter Unapprove, you will be unapproving all shipment lines for the current quotation.
3. Enter the approval Type for your quotation. Approval types determine the types of documents on which you can use the quotation. The available types are: All Orders (all types of purchase orders and requisitions), Purchase Agreements, Requisitions, Standard Purchase Orders.

4. Enter an active approval reason. You can enter this field only when you choose Approve as the action. See: Defining Lookup Codes: page 1 – 74.

5. Enter the name of the approver. Purchasing defaults your name in this field. You can enter this field only when you choose Approve as the action.

6. Enter the Effective date range for your approval. You can use approved quotation information on your documents only if the quotation is active and if the current date is within the effectivity dates. If you do not provide an expiration date, you can always use the quotation for your documents while the quotation is active and approved.

7. Enter comments about your approval. You can enter this field only when you choose Approve as the action.

8. Select OK to approve/unapprove the quotation.

► **To cancel your entries:**

- Select the Cancel button to cancel your action and return to the window from which you accessed the Approve Entire Quotation window.

**See Also**

- Entering Quotation Shipment Information: page 5 – 81
- Entering Quotation Price Break Information: page 5 – 84
- Approving Quotation Shipments: page 5 – 91
Defining Supplier Lists

Use the Supplier Lists window to enter and edit supplier lists. You can copy suppliers from the supplier lists onto the RFQ supplier list when you create an RFQ.

To define supplier lists:

1. Navigate to the Supplier Lists window from the menu.

2. Enter the Supplier List Name of the list you want to create. Each supplier list name must be unique.

3. Enter a Description for your supplier list.

4. Enter the Inactive Date for the list

5. Enter the Supplier name you want to place on the supplier list. The list of values displays the supplier name, number, On Hold, Taxpayer ID, and VAT number. When you copy a supplier list onto your RFQ supplier list, Purchasing copies every unique combination of supplier and supplier site that does not already appear on the current RFQ supplier list.
6. Enter the supplier Site you want to place on the supplier list. Purchasing lets you send a request for quotation to different sites of a same supplier. You cannot enter the same combination of supplier and supplier site twice on the same supplier list.

7. Enter the name of the Contact at this supplier site.

See Also

Entering RFQ Headers: page 5 – 57
Managing Buyer Workload

Finding Requisition Lines for Review or Assignment

Purchasing lets you suggest a buyer for each supplier-sourced requisition line you create. (See: Entering Requisition Lines: page 3 – 60.) When you assign requisitions or requisition lines to buyers, the buyers can choose the requisition lines assigned to them and place these lines on purchase orders.

Use the Find Requisition Lines window to choose whether to review requisition assignments or to assign/reassign requisition lines and to enter selection criteria for the lines. Choosing the Review action takes you to the Review Buyer Workload window, where you can review requisition assignments. You can identify requisition lines that reference the wrong buyer or that were not assigned to a buyer. You can also use this window to analyze buyers’ workloads. (See: Reviewing Buyer Workload: page 5 – 100.) Choosing the Assign action takes you to the Assign Requisition Lines window, where you can assign or reassign requisition lines to buyers. See: Assigning Requisition Lines: page 5 – 102.

To enter search criteria:

1. Navigate to the Find Requisition Lines window by selecting Manage Buyer Workload from the menu.
2. Select Assign or Review mode. Then enter desired search criteria as described in the following steps.

3. Enter the Requisition number.

4. Enter the Requestor.

5. Enter the Supplier Sourcing criterion (Sourced or Unsourced). If you leave this field blank, Purchasing displays both sourced and unsourced requisition lines. Requisitions have a suggested supplier either if the preparer entered a supplier when creating the requisition, or if Purchasing sourced the requisition. See: Automatic Sourcing: page 5 – 30.

6. Enter the Buyer name.

7. For sourced lines, enter the Supplier and Supplier Site.

8. Enter the Ship To location to locate requisition lines for a specific location. When you set up Deliver–To Locations, you specify a
Ship–To Location for each Deliver–To Location. If you enter a Ship–To Location, Purchasing displays all requisition lines for Deliver–To Locations that reference the Ship–To Location.

9. Enter the Rate Type.

10. Enter the Currency.

11. Use the tabbed regions to further restrict the search:
   - In the Item region, you can enter the following search criteria: Item number, Revision number, Category, item Description, and Line Type.
   - In the Status region, you can limit the search by Late status (Yes or No), Urgent status (Yes or No), Assigned status (Yes or No), RFQ Required status (Yes or No), Approval status (Approved, Incomplete, In Process, Pre–Approved, Rejected, Requires Reapproval, or Returned), or Need By date.

12. Select the Find button to initiate the search and open the Review Buyer Workload or the Assign Requisition Lines window, as chosen above.

▶ To clear existing search criteria:
   - Select the Clear button to clear any existing search criteria.

See Also

Reviewing Buyer Workload: page 5 – 100
Assigning Requisition Lines: page 5 – 102

Reviewing Buyer Workload

Use the Reviewing Buyer Workload window to review requisition assignments. You can identify requisition lines that reference the wrong buyer or that were not assigned to a buyer. You can also use this window to analyze buyers’ workloads. Use the Assign Requisition Lines window to assign or reassign requisition lines to buyers.
To review buyer workload:

1. Navigate to the Review Buyer Workload window by selecting the Review action and then selecting the Find button in the Find Requisitions Line window.

For each buyer, Purchasing displays information for the requisition lines that meet the search criteria entered in the Find Requisition Lines window.

- **Assigned** – The number of requisitions lines currently assigned to the buyer.
- **Urgent** – The number of urgent requisition lines.
- **Late** – The number of requisition lines for which the current date is later than the Need By date less the lead time.
- **Needed** – The number of requisition lines for which the Need By date is within the Need By search criteria entered in the Find Requisition Lines window.
- **Open POs** – The number of open purchase orders referencing the buyer.
At the bottom of the screen, Purchasing displays the total number of unassigned requisition lines, and the number of these that are Urgent, Late, and Needed (as defined above).

2. Close the window to return to the Find Requisition Lines window.

See Also

Finding Requisition Lines for Review or Assignment: page 5 – 98
Assigning Requisition Lines: page 5 – 102

Assigning Requisition Lines

Use the Assign Requisition Lines folder window to assign or reassign requisition lines to buyers.

► To assign requisition lines:

1. Navigate to the Assign Requisition Lines window by selecting the Assign action and then selecting the Find button in the Find Requisitions Line window.
For each requisition line meeting the search criteria, Purchasing displays the Buyer, Item number, Revision number, item Description, Category, Quantity, Unit of Measure, Currency, Unit Price, Need By Date, Requisition number, requisition Line number, Line Type, Note to Buyer, Source Type, Supplier, Supplier Site, Requestor, Destination Type, Ship To location, Rate Type, Urgent status, RFQ Required status, and Encumbered status.

2. Enter the New Buyer to whom you want to assign or reassign the requisition line.

3. Select the requisition lines that you want to assign to the new buyer.

4. Save your work.

See Also

Finding Requisition Lines for Review or Assignment: page 5 – 98
Reviewing Buyer Workload: page 5 – 100
This chapter tells you everything you need to know about AutoCreating Documents, including:

- AutoCreate Documents Overview: page 6 – 2
- Finding Requisition Lines for AutoCreate: page 6 – 12
- Selecting AutoCreate Criteria: page 6 – 16
- Entering Document Information and Completing AutoCreate: page 6 – 19
- Using the Document Builder: page 6 – 22
- Modifying Requisition Lines: page 6 – 24
AutoCreate Documents Overview

Purchasing provides automatic creation capabilities for documents. Buyers can quickly create standard purchase orders, planned purchase orders, blanket releases, and RFQs from any available purchase requisition lines. The purchase requisition lines can be for predefined items or one–time items as well as outside processing items. However, internally sourced requisition lines are supplied by internal sales orders, so they are not available for autocreation. AutoCreating documents can be as simple as selecting requisition lines and adding a supplier—and letting Purchasing do the rest. Use the AutoCreate Documents window to access the features of AutoCreate.

Note: For information on creating quotations directly from RFQs, see: Copying Quotations from RFQs: page 5 – 88.

AutoCreate provides you with the features you need to satisfy your automatic document creation needs. You should be able to:

• Create new standard or planned purchase orders, blanket releases, RFQs, and quotations with a minimum number of keystrokes. Add to existing blanket releases, planned purchase orders, standard purchase orders, RFQs, and quotations
• Review all approved requisition lines before placing specific requisition lines on a purchase order or RFQ
• Review RFQ headers, lines, and shipments before creating a quotation from a specific RFQ
• Collect all requisition lines that meet a certain set of criteria that you establish
• Split one requisition line into several requisition lines
• Consolidate multiple like requisition lines into single purchase order lines
• Review or change your purchase orders, quotations, or RFQs immediately after creation
• Use document security to control whether buyers can add to certain document types
• Specify foreign currency details during autocreation. You should be able to use the requisition foreign currency or choose another currency
• Review requisition lines by currency type
Major Features

Complete Search Criteria
You have flexible criteria by which you can search for unpurchased approved purchase requisition lines for inclusion on purchase orders and RFQs as well as unapproved requisition lines for inclusion on RFQs. When you are creating quotations from RFQs, you specify the RFQ number and lines from which you want to create the quotation. See: Copying Quotations from RFQs: page 5 – 88.

Fast Purchase Order and RFQ Creation
All purchase requisition lines available for autocreation go into a single requisition pool. Buyers can retrieve any of the requisition lines from the pool and use the AutoCreate Documents window to create standard and planned purchase orders, blanket releases and RFQs. You can place a requisition line on as many RFQs as you want before you place it on a purchase order, after which it is no longer available in the requisition pool.

Fast Quotation Creation
Buyers can use the Copy Documents window to create supplier quotations for each RFQ. Buyers can choose entire RFQs or specific RFQ lines and shipments. See: Copying Quotations from RFQs: page 5 – 88.

Automatic Creation Mode
Automatic Creation Mode lets you create purchase orders, blanket releases, or RFQs with a minimum number of keystrokes. You provide search criteria to locate the requisition lines you want to place on a purchase order or RFQ. After reviewing the requisition lines, you select all lines that you want. Then you select the Automatic button to create the purchase order or RFQ. You have the option to group requisition lines with the same item, revision, line type, unit of measure, and transaction reason into individual purchase order lines. Similarly, you can group requisition lines with the same item, revision, and line type into individual RFQ lines. Alternatively, you can autocreate documents that parallel the structure of the requisition from which they were created.

Manual Creation Mode
Manual Creation Mode lets you specify which requisition lines you want to place on a document. You decide which requisition lines you
want to combine and where you want them to appear on the document. Then you select the Manual button to create the document.

**Foreign Currency Options**

When you autocreate new purchase orders, the requisition price is converted into a purchase order price based on specified currency and rate information. You cannot specify currency information in AutoCreate if you are adding requisition lines to an existing document. Purchasing performs price tolerance verification for all currencies.

**See Also**

Finding Requisition Lines for AutoCreate: page 6 – 12  
Selecting AutoCreate Criteria: page 6 – 16  
Entering Document Information and Completing AutoCreate: page 6 – 19  
Using the Document Builder: page 6 – 22  
Modifying Requisition Lines: page 6 – 24  
Copying Quotations from RFQs: page 5 – 88

**AutoCreate Document Options**

The AutoCreate Documents window has features that simplify purchase order and blanket release creation into a few steps:


- Choose whether to create a new document or add to an existing document. See: Selecting AutoCreate Criteria: page 6 – 16.

- In the AutoCreate Documents window, select the Document Type: Standard Purchase Order, Planned Purchase Order, Blanket Release, or RFQ. See: Selecting AutoCreate Criteria: page 6 – 16.

- Choose the Grouping method: Default – requisition lines for the same item, revision, line type, unit of measure, and transaction reason are combined into individual purchase order lines; and requisition lines for the same item, revision, and line type are combined into individual RFQ lines. Requisition – the
autocreated documents parallel the structure of the requisition from which they were created. See: Selecting AutoCreate Criteria: page 6 – 16.

- Choose Automatic or Manual creation mode to place the requisition lines onto a document. Based on the results of your search and on how you want the autocreated document to look, you can decide whether Automatic or Manual creation mode is more appropriate. See: Selecting AutoCreate Criteria: page 6 – 16.

Selecting Requisition Lines

In the Find Requisition Lines window, enter search criteria to narrow the selection of requisition lines. Purchasing chooses all requisition lines from the requisition pool that meet your search criteria and displays them in the AutoCreate Documents window. Requisition lines for the same item and item category are grouped together, but they are not necessarily in order alphabetically. Within each grouping of item and item category, requisition lines are ordered by need–by date.

Creating a Purchase Order, Release, or RFQ

In the AutoCreate Documents window, you can create a new planned purchase order, standard purchase order, blanket release, or RFQ. Also, depending on your security criteria, you can add lines to an existing document. For example, if standard purchase orders have an access level of View Only, you cannot add lines to an existing standard purchase order unless you are the document owner. See: Defining Document Types: page 1 – 87. See: Selecting AutoCreate Criteria: page 6 – 16

- To create a new document, select Create New in the Action field.
- To add to an existing document, choose Add To and select the document number in the Document Number field.

Using Automatic Creation Mode

Use the Automatic creation mode when any of the following conditions occur:

- A majority of the requisition lines that your search criteria located are items you want to place on the document
- You want Purchasing to determine where to place the requisition lines on the document
- You want Purchasing to combine similar requisition lines automatically onto a single document line
• You are creating or adding to a release
• You are using Requisition grouping

Automatic Creation Mode lets you create documents with a minimum number of keystrokes. If you want to place on a document all the requisition lines that you selected from those which met your search criteria, select the Automatic button. Purchasing creates in a new document or adds to an existing document all the requisition lines you selected, and these lines are removed from the requisition pool if you are placing them on a purchase order. Lines that you did not select and lines placed on an RFQ remain in the requisition pool.

**Note:** Purchasing also copies the notes from the requisition lines and the corresponding requisition headers, but *not* descriptive flexfields, to the document lines you create.

When creating a purchase order, Purchasing combines the quantities of all requisition lines that have the same item, item revision, line type, transaction reason, and unit of measure onto a single document line. For RFQs, quantities of all requisition lines that have the same item, revision, and line type are combined. The lowest unit price from the combined requisition lines becomes the actual price of the purchase order line. If the items on the requisition lines you combine have different prices, you may want to use Manual creation mode to ensure you get the price you want. See the discussion of Manual creation mode below.

For purchase orders and releases, Purchasing combines shipment information only if the requisition lines have the same need–by date, ship–to location, organization, Accrual type (period–end or on–line), and shipment type. Each purchase order distribution corresponds to only one requisition distribution. Purchasing does not add to an existing purchase order shipment if that shipment has been encumbered. For RFQs, Purchasing combines shipment information only if the requisition lines have the same ship–to location, need–by date, and unit of measure.

**Note:** You can autocreate releases against blanket purchase agreements only if the requisition lines match the lines on the agreement.

For new documents, Purchasing places the items on document lines in the same order that they are displayed, and the shipments will be ordered by need–by date if all requisition lines share a common unit price. Additions to existing documents or document lines will be placed after any existing lines or shipments.
If the items you selected are not predefined items, Purchasing does not combine the lines. To combine lines that do not have predefined items, you must use Manual creation mode. See the discussion of Manual creation mode below.

If the profile option PO: Display the Autocreated Document is set to Yes, Purchasing displays the Purchase Orders, Releases, or RFQ window, as appropriate, after creating your document lines. See: Profile Options in Purchasing: page 1 – 103.

**Using Manual Creation Mode**

Use Manual creation mode when any of the following conditions occur:

- You want to manually choose the requisition lines to combine onto a single document line
- You want to specify the location of the items on the document (for example, specify which purchase order lines the requisition lines will become)
- You want to ensure you get the negotiated price when combining multiple requisition lines with different prices

Manual creation mode lets you take control of the actual placement of requisition lines on purchase order lines. You move each line into the position you want it on the document by using the Document Builder. See: Using the Document Builder: page 6 – 22.

You can combine requisition lines that have the same predefined item and lines that have one–time items onto a single document line. If you want to combine two requisition lines for the same item, one with an item number and one without, use Modify on the Tools menu to add the predefined item to the requisition line for the one–time item.

**Note:** You cannot use Modify with outside processing items or if you are using encumbrance or budgetary control. See: Modifying Requisition Lines: page 6 – 24.

Purchasing copies only the notes from the remaining selected requisition lines (and their corresponding headers).

**Adding Lines to Existing Documents**

You can add lines to existing documents only if your security criteria allow you to modify them. However, you can always create new releases against blanket purchase agreements – even if your security criteria do not permit you to access the document elsewhere in the system. To add lines to an existing planned or standard purchase order, specify the purchase order number:
If you use Automatic creation mode, Purchasing creates new lines beginning with the next available line number or combines your requisition lines with existing document lines.

If you use Manual creation mode, you can select any displayed line and place it onto a line in the Document Builder region.

**Entering Document Information**

Once you have completed specification of all criteria (and used the Document Builder for Manual creation mode), you add document information to complete the autocreate process. See: Entering Document Information and Completing AutoCreate: page 6 – 19.

---

**Additional AutoCreate Features**

**Modifying Requisition Lines**

Use the Modify feature when you want to split an existing requisition line into multiple requisition lines that represent the same or different items. For example, if the requisition line quantity is so large that a single supplier cannot fill the entire order by the need–by date, then you need to multi-source the order (that is, fill it from more than one supplier). On the other hand, if you have a requisition line item that contains parts that you want to order as unique items, you can explode the requisition line into several lines.

**Note:** After you modify a requisition line, you cannot modify the new requisition line(s) again. You cannot modify requisition lines for outside processing items and when you are using encumbrance accounting or budgetary control.

- In the AutoCreate Documents window, select Modify on the Tools menu to display the Modify Lines window with the current requisition line selected. See: Modifying Requisition Lines: page 6 – 24.

- Enter as many new lines as you need to represent the original requisition line. Purchasing automatically creates new distribution lines and prorates quantities for the new distributions from the original requisition line distributions. Purchasing also backs out requisition supply for the original requisition line and creates new supply for the new lines.

When you return to the AutoCreate Documents window, Purchasing displays the new requisition lines that are now available for placement.
Documents on a purchase order or RFQ. These lines do not appear, however, if the
new requisition lines do not meet your original search criteria. The
original requisition line is no longer available for purchase order or
RFQ placement, but your requestor can easily review the modification
status of a requisition line in the Requisitions window.

Returning a Requisition

Purchasing lets you return a requisition line to the requisition preparer.
You might want to return a requisition line if you are unable to obtain
the requestor’s price and want the requestor to resubmit the requisition
for approval at a higher price.

Select Return Requisitions on the Tools menu to display the Return
Requisitions window. Enter a reason for the return and select OK to
return all requisition lines on the current requisition except any lines
from the requisition already placed on a purchase order. When you
return requisition lines, they are no longer available in the requisition
pool.

Automatic Tax Defaulting

If you’ve set up a tax defaulting hierarchy in the Tax Defaults region of
the Purchasing Options window, the appropriate tax codes
automatically default onto the documents you autocreate. See:

iProcurement Requisitions

If you have iProcurement installed, note that, in addition to standard
purchase requisitions, iProcurement requisitions include emergency
requisitions and requisitions that use a procurement card for the
purchase. You can use the PO Create Documents workflow or
AutoCreate to create documents from iProcurement requisitions.

Emergency Requisition Lines

An emergency requisition is created in iProcurement only, by
requesters who can order from a supplier directly. Emergency
requisitions have a purchase order number reserved for them in
advance.

After the emergency requisition is entered in iProcurement, the PO
Create Documents workflow creates a standard purchase order from
the approved requisition lines automatically, if you use the workflow. If you don’t, you can use AutoCreate.

You can view emergency requisition lines in the AutoCreate Documents folder window by displaying the hidden field Emergency PO Number. Or enter an Emergency PO Number in the Find Requisition Lines window.

Except for the following points, emergency requisition lines are autocreated like any other requisition line:

- Emergency requisition lines on a single purchase order must have the same Emergency PO Number.
- You can put emergency and non–emergency requisition lines on the same purchase order, but Purchasing will give you a warning message when you do.
- You can create only standard purchase orders from emergency requisition lines.

Emergency requisitions, and the purchase orders created from them, go through the same approval process as other documents (unless you modify the approval workflow to handle them differently).

**Procurement Card Requisition Lines**

Requisition lines that use a corporate (or procurement) credit card for the purchase are created in iProcurement only.

After a procurement card requisition is entered in iProcurement, the PO Create Documents workflow creates a standard purchase order or release from the approved requisition lines automatically, if you use the workflow. If you don’t, you can use AutoCreate.

In the AutoCreate Documents folder window, you can view requisition lines that use a corporate credit card by displaying the P–Card hidden field.

Note the following AutoCreate criteria for procurement card purchase orders and releases:

- You cannot combine requisition lines that use procurement card information with other requisition lines on the same document.
- Procurement card lines on a single document must have the same P–Card number, supplier, and supplier site.
- You can create standard purchase orders or blanket releases from procurement card requisitions.
See: Procurement Card Purchase Orders and Releases: page 4 – 143.

See Also

Choosing Workflow Options: page 1 – 95
Selecting AutoCreate Criteria: page 6 – 16

iProcurement Implementation Manual
Finding Requisition Lines for AutoCreate

Use the Find Requisition Lines window to specify search criteria for requisition lines that you will use to autocreate purchase orders and RFQs.

Prerequisites


To enter search criteria:

1. Navigate to the Find Requisition Lines window by selecting AutoCreate from the menu. Then enter desired search criteria as described in the following steps.
2. Select the Approved status: Yes or No. Only approved lines can be used when you autocreate purchase orders. Either status can be used on RFQs. If you do not make a selection, both approved and unapproved requisition lines will be included.

   *Yes* – You can autocreate purchase orders, releases, and RFQs.
   
   *No* – You can autocreate only RFQs.

3. Enter the Requisition number.
4. Enter the Requestor.
5. Enter the Emergency PO Number.
   If you are autocreating a purchase order from an emergency requisition, enter the purchase order number that was reserved in advance for the requisition. An emergency requisition is created in iProcurement only.

6. Select the Supplier Sourcing criterion (Sourced or Unsourced).

7. The suggested Buyer from the Enter Person window is displayed as the default. If the PO: Allow Buyer Override in AutoCreate Find profile option is set to Yes, you can clear the default or enter a different buyer.

8. Enter the Supplier and Supplier Site.

9. Select the Document Type to indicate that you want to include requisition lines sourced to a Blanket purchase agreement or to a Quotation.

10. Enter the PO Number.

11. Enter the Ship–To location to include requisition lines with this Deliver To location. The default is the Ship–To Location for the buyer from the Enter Person window.

12. Enter the currency Rate Type.

13. Enter the Currency.

14. Use the tabbed regions to further restrict the search:
   - In the Item region, you can enter the following search criteria: Item number, Revision number, Category, item Description, and Supplier Item number. The default Category is the category defined for the buyer from the Enter Person window. If the PO: Allow Category Override in AutoCreate Find profile option is set to Yes, you can clear the default or enter a different category.
   - In the Status region, you can limit the search by Late status (Yes or No), Urgent status (Yes or No), Assigned status (Yes or No), RFQ Required status (Yes or No), or the number of need by days from today (For example, enter 10 if you want to locate all requisition lines with a need–by date within the next ten calendar days.)
15. Select the Find button to initiate the search and open the AutoCreate Documents window. See: Selecting AutoCreate Criteria: page 6 – 16.

► To clear existing search criteria:
  ■ Select the Clear button to clear any existing search criteria.

► To enter requisition preferences:
  ■ Select Requisition Preferences on the Tools menu to open the Requisition Preferences window. See: Entering Requisition Preferences: page 3 – 52.

See Also

Defining Buyers: page 1 – 27
Profile Options in Purchasing: page 1 – 103
The online help for the Enter Person window
Selecting AutoCreate Criteria

The AutoCreate Documents folder window displays the requisition lines that met the search criteria entered in the Find Requisition Lines window. Use this window to:

- Select whether you are creating a new document or adding to an existing document
- Select the type of document you are creating: Standard PO, Planned PO, Blanket Release, or RFQ
- Select the grouping method: Default or Requisition
- For Automatic creation mode, select which of the displayed requisition lines you will use on the autocreated document
- Select the creation mode: Manual or Automatic

About flexfields: AutoCreate does not copy descriptive flexfields from the requisition.

If your organization uses iProcurement, see: iProcurement Requisitions: page 6 – 9 for information about autocreating iProcurement requisitions, including emergency and procurement card (P-Card) requisitions.

To select autocreate criteria:

2. In the Action field, select whether you want to Create a New document or Add To an existing document.

3. Select the Document Type you want to create: Standard PO, Planned PO, Blanket Release, or RFQ. The Document Type can be only RFQ if you did not select Approved Requisitions in the Find Requisition Lines window.

You can choose only Standard PO for emergency requisition lines. You can choose only Standard PO or Blanket Release for procurement card requisition lines. See: iProcurement Requisitions: page 6 – 9.

4. Select the Grouping for requisition lines on the document:

   **Default**: Combine requisition lines for the same item, revision, line type, unit of measure, and transaction reason onto one purchase order line. Combine requisition lines for the same item, revision, and line type onto one RFQ line.

   **Requisition**: Create document with one line for each requisition line. Used only when you select lines on a single requisition.

5. For Automatic creation mode, use the check boxes to select the requisition lines that you want to use on the document and then select the Automatic button. You can also use ‘Select All’ or ‘Deselect All’ in the Edit menu.

For Manual creation mode, select the Manual button. Manual creation mode is available only when you have chosen Default grouping for Standard and Planned Purchase Orders, Blanket

For both creation modes, Purchasing displays the Add To Document, New Document Number, or New Document window, depending on the action you selected. See: Entering Document Information and Completing AutoCreate: page 6 – 19.

► To return requisition lines:
1. Select Return Requisitions on the Tools menu to display the Return Requisitions window.
2. Enter a Reason for the return.
3. Select OK to return to the requisition pool all unpurchased lines on the current requisition.

► To modify requisition lines:
- Select Modify on the Tools menu to open the Modify Lines window. See: Modifying Requisition Lines: page 6 – 24.

► To view action history:
- Select View Action History on the Tools menu to open the Action History window and display action history for the current line. See: Viewing Action History: page 8 – 2.

► To view blanket purchase agreements:
- Select View Blanket POs on the Tools menu to open the Purchase Order Lines window and display all blanket purchase agreements for the item on the current line.

► To enter requisition preferences:
- Select Requisition Preferences on the Tools menu to open the Requisition Preferences window. See: Entering Requisition Preferences: page 3 – 52.

See Also

Customizing the Presentation of Data in a Folder, Oracle Applications User’s Guide
Entering Document Information and Completing AutoCreate

Use the Add To Document, New Document Number, and New Document modal windows to enter document information for documents you are autocreating. Which window displays is determined by your Action choice in the AutoCreate Documents window.

**Attention:** If the PO: Warn RFQ Required before AutoCreate profile option is set to Yes, and one or more of the requisition lines selected for autocreation requires an RFQ and has not been placed on an RFQ, you will be given a warning message and can cancel the autocreate. See: Profile Options in Purchasing: page 1 – 103

**To enter information in the Add To Document window:**

The Add To Document modal window appears when you have chosen the Add To action and selected either the Manual or the Automatic creation mode button in the AutoCreate Documents window.

1. Select the Document Number. For blanket releases, you must also enter the Release Number.
   
   You can select Cancel to close the modal window.

2. Select OK to go to the next step.

   If you are in Automatic creation mode, this completes all required steps. Purchasing autocreates the document and displays the document entry window appropriate for the selected criteria if the PO: Display the AutoCreated Document profile option is set to Yes. See: Profile Options in Purchasing: page 1 – 103.

► **To enter information in the New Document Number window:**

   - The New Document Number window appears when you have chosen the Create New action and selected the Manual creation mode button in the AutoCreate Documents window. This short version of the New Document window requires only that you enter the Document Number. Later, after you have entered information in the Document Builder, the New Document window will appear. See: Using the Document Builder: page 6 – 22.

► **To enter information in the New Document window:**

   The New Document window appears after you have selected the Create button in the Document Builder when you are creating a new document in Manual creation mode and in all cases when you are creating a new document in Automatic creation mode.
1. Enter the Document Number. If automatic document numbering is enabled for the document type, this field is not enterable. See: Defining Numbering Options: page 1 – 53.

For RFQs, you must enter the RFQ Type, and you can enter the Supplier List Name.

For releases, you must enter the Release and the Release Date.

2. For standard and planned purchase orders, you can enter the Supplier and Supplier Site. This is filled in for releases.

3. Enter the Currency Source:
   
   *Default* – The currency is defaulted from the supplier site (if foreign currency), the supplier (if foreign currency), or the functional currency.

   *First Requisition Line* – The currency from the first requisition line is used.

   *Specify* – If you select a Requisition and Requisition Line, the currency from that line is autoselected; however, you can override this currency.

   The Rate and Rate Date are enterable only when the Rate Type is User. A rate type of EMU Fixed means that if either your base currency (functional currency, defined in your set of books) or your foreign currency (transaction currency in a document entry window) is Euro and the other is another European currency, Purchasing automatically enters a conversion Rate Date and Rate for you that you cannot change.

   You can select Cancel to close the modal window.

4. Select Create to complete autocreation of the document. If the PO: Display the AutoCreated Document profile option is set to Yes, Purchasing displays the document entry window appropriate for the selected criteria. See: Profile Options in Purchasing: page 1 – 103.
Using the Document Builder

Use the Document Builder region in the AutoCreate Documents window to build documents for autocreation in Manual creation mode.

To build documents when creating a new document:


2. In the upper region, select one requisition line for build placement. This enables the Add to Document button.

3. Choose the Add to Document button.

   This places the selected requisition line from the upper region into the Document Builder, highlights the upper region and positions the cursor in the next available Line field.
You can position the cursor anywhere in a populated line in the Document Builder to enable the Remove button. Choose the Remove button to return the line to the upper region and deselect the line.

4. You can select additional lines one at a time in the upper region and move them to the Document Builder.

To create a new purchase order line, select a requisition line in the upper region and choose the Add to Document button. Purchasing creates a new, corresponding purchase order line.

To add to an existing purchase order line, select a requisition line in the upper region, click in the Line field of an existing line below, and choose the Add to Document button. Purchasing places the requisition line on the next available open line below, but gives it the same Line number as the line you added it to. If the lines cannot be validly combined, Purchasing gives it a different Line number. (See: AutoCreate Document Options: page 6 – 4.)

You can change a Line number in the Document Builder region to any unused Line number.


**To build documents when adding to an existing document:**

If you are adding to an existing document, Purchasing displays all the existing document lines in the Document Builder, with the line disabled. You cannot remove any of these existing lines.

1. Follow steps 2 – 4 above.

2. Select Create to complete autocreation. If the PO: Display the AutoCreated Document profile option is set to Yes, Purchasing displays the document entry window appropriate for the selected criteria. See: Profile Options in Purchasing: page 1 – 103.

**To cancel the current session in the Document Builder:**

- Select the Cancel Build button to remove any lines you have added to the Document Builder and return them to the upper region.

See Also

Autocreate Documents Overview: page 6 – 2
Modifying Requisition Lines

Use the Modify Lines window to split an existing requisition line into multiple requisition lines that represent the same or different items. For example, if the requisition line quantity is so large that a single supplier cannot fill the entire order by the need-by date, then you need to fill this order from more than one supplier. On the other hand, if you have a requisition line item that contains parts that you want to order as unique items, you can explode the requisition line into several lines. After you modify a requisition line, you cannot modify the new requisition line(s) again.

**Note:** You cannot modify requisition lines for outside processing items. You cannot modify requisition lines when you are using encumbrance accounting or budgetary control.

**To modify requisition lines:**

1. Navigate to the Modify Lines window by selecting Modify on the Tools menu in the AutoCreate Documents window. Purchasing displays the current requisition line in the Lines tabbed region.
2. Enter as many new lines as you need to represent the original requisition line. Purchasing automatically creates new distribution lines and prorates quantities for the new distributions from the original requisition line distributions. Except that you cannot update destination information (destination type, organization, location, requestor, and subinventory), the entry of information in the Lines, Source Details, Details, and Currency tabbed regions is identical to entry of this information in the Requisitions window. See: Entering Requisition Lines: page 3 – 60.

▲ To cancel your entries:
- Select Cancel to cancel your entries and return to the AutoCreate Documents window.

▲ To save your work:
- Select OK to save your work and return to the AutoCreate Documents window, where Purchasing displays the new
requisition lines that are now available for placement on a purchase order or RFQ. These lines do not appear, however, if the new requisition lines do not meet your original search criteria. The original requisition line is no longer available for purchase order or RFQ placement, but your requestor can easily review the modification status of a requisition line in the Requisition Lines Summary window.
Receiving

This chapter tells you everything you need to know about Oracle Receiving, including:

- Overview of Receiving: page 7 – 2
- Advance Shipment Notices (ASNs): page 7 – 17
- Managing Receipts: page 7 – 23
- Unordered Receipts: page 7 – 39
- Receiving Transactions: page 7 – 45
- Inspections: page 7 – 72
- Returns: page 7 – 76
- Corrections: page 7 – 84
- Finding Intransit Shipments: page 7 – 92
- Control Numbers: page 7 – 96
- Receiving Reports: page 7 – 99
- Overview of Receipt Accounting: page 7 – 101
- Fund Accounting in Oracle Public Sector Purchasing: page 7 – 130
Overview of Receiving

Purchasing lets you control the items you order through receiving, inspection, transfer, and internal delivery. You can use these features to control the quantity, quality, and internal delivery of the items you receive.

Purchasing provides you with the features you need to satisfy your receipt, inspection, transfer, and delivery needs. You should be able to:

• Use routing controls at the organization, supplier, item, or order level to enforce material movement through receiving. For example, you can require inspection for some items and dock-to-stock receipt for others. See: Receiving Controls, Options, and Profiles: page 7 – 9.

• Define receiving tolerances at the organization, supplier, item, and order level, with the lowest level overriding previous levels. You can define tolerances for receipt quantity, on-time delivery, and receiving location. You can assign looser tolerances to low-value items that you consume at high volumes. You can set enforcement options to ignore, warn the user, or reject transactions that violate the tolerances. See: Receiving Controls, Options, and Profiles: page 7 – 9.

• Use blind receiving to improve accuracy in the receiving process. With this option, the quantity due for each shipment does not show and quantity control tolerances are ignored. Also, the quantity is not visible in view windows or in reports. However, if you choose to have visible receiving, then your receiving staff can see the quantity due. See: Receiving Controls, Options, and Profiles: page 7 – 9.

• Use Express Receipt to receive an entire purchase order with a few keystrokes. You can exclude certain lines for express transactions. See: Express Receipts and Receiving Transactions: page 7 – 26

• Use Advance Shipment Notices (ASNs) to enter receipts in the Enter Receipts window, reducing data entry time. See: Advance Shipment Notices: page 7 – 17.

• Use the Cascade function to distribute a given quantity of an item from a single supplier across multiple shipments and distributions. This function is enabled by a Receiving Options checkbox, Allow Cascade Transactions, and is available only when you have specified a source and an item in the Find
• Specify match approval levels. You can specify two–, three–, and four–way match approval levels on a purchase order line. Purchasing uses your receiving and inspection information to ensure that you only accept and pay for the items you order, receive, or inspect. Choose the three–way match approval level if you want to receive items before you allow payment. Choose the four–way match approval level if you require inspection and acceptance of receipts before authorizing payment. See: Receiving Controls, Options, and Profiles: page 7–9.

• Print the receiving and inspection documentation you need. For example, you can print Receipt Travelers. Also, you can prepare for incoming receipts by printing the Expected Receipts Report to help you identify items and quantities you expect to receive. You can use this report to plan your work, identify receipts satisfying an urgent demand, and control unexpected receipts. Finally, you can produce summary and detail receiving transaction reports by item, supplier, purchase order number, and/or receiving date range. See: Receiving Reports: page 7–99.

• Track, update, and record the receipt of intransit and inter–organization shipments.

• Enter different types of receipt transactions based on your organization’s needs. For example, you should be able to record in one transaction a direct receipt of inventory items into inventory.

• Record receipt of unordered items based on your item, supplier, or organization defaults. For example, if your organization does not allow receipt of unordered items, you should not be able to enter a receipt unless it is matched to an order shipment. See: Unordered Receipts: page 7–39.

• Record receipt of predefined substitute items if you set your receiving options to allow this feature. You define the acceptable substitutes during setup for the items you purchase. See: Receiving Controls, Options, and Profiles: page 7–9.

• Automatically update related supply information, inventory balances, WIP operations, requisition details, and purchase order details while entering a single receiving transaction.

• You can record transfers of inventory items from receiving and inspection to inventory or to the shop floor. You can also record
transfers of items to different locations in the receiving and inspection area. For example, you might need to move refrigerated items from the receiving dock into a cold storage area while you are waiting to inspect them. Purchasing lets you record these types of transfers in the same window you use to deliver to stock or expense.

- Record receipts against services and labor. You can enter either the total value of services received, or the amount of services tied to an invoice. For example, you might receive 40 hours of consulting services.

- Receive services, inventory, expense, and outside processing items using one screen. You acknowledge receipt of services by receiving amounts of the service, generally related to receipt of an invoice. You receive inventory items to expense or asset subinventories, you receive expense items to the requestor, and you receive outside processing to the shop floor (designated operations in your manufacturing process).

- Distinguish closed for invoicing from closed for receiving. Purchasing automatically closes your purchase order for receipt when it is fully received. You can manually close partially received purchase orders if you no longer expect any more receipts against them. Close for invoicing and close for receiving are managed using tolerances. You can specify that when you have received a certain percentage of a shipment, Purchasing will close the receipt. This is a soft close, and you can reopen the receipt. Purchasing rolls up closing to the line and header level, and “Closed” information does not show in the Open Purchase Orders Report. Also, if there is a remaining balance, closed quantities are no longer visible as supply scheduled receipts to MRP/ATP.

- Decide how you accrue un-invoiced receipts. For instance, you can accrue receipts perpetually or at period-end for expense items. Purchasing uses perpetual accrual for your inventory and shop floor item receipts. Purchasing and Inventory together provide you with perpetual visibility and control on your accrued liabilities for inventory items. Inventory lets you maintain the value of your inventories on a perpetual basis. And Purchasing automatically records your accrued liability in your general ledger as you enter receiving transactions. Purchasing also provides you with complete visibility and control of your inventories values, accrued liabilities for inventory and non-inventory items, purchase price variances, and invoice price variances. And Purchasing provides you with the information
you need to facilitate your period close and your inventory, purchasing, and payables reconciliation process. See: Overview of Receipt Accounting: page 7 – 101.

- Identify and handle hazardous materials. You can use attachments to provide detailed handling instructions. Purchasing displays hazardous material information in the receiving, transfer, and inspection windows as well as on the Receipt Traveler. See: Purchasing Hazardous Materials: page 1 – 67.

- Track the quantity and destination of internally delivered items. You know exactly what items you receive and where to deliver them within your organization.

- Define detailed rules for locator within subinventories for the disposition of inventory receipts. See: Defining Stock Locators, Oracle Inventory User’s Guide.

- Track lot and serially controlled items. See: Control Numbers: page 7 – 96.

- Define which of your items require inspection. Purchasing lets you inspect received items before you move the items into stock or deliver them to the requestor. You can accept or reject items and provide detailed information about your inspection results. Purchasing lets you review your inspection results on-line. You can review your inspection results by receipt number, purchase order number, supplier, item, and / or transaction date range. Purchasing also provides summary and detail reports to help you analyze your suppliers’ performance. You can produce supplier quality reports by buyer, supplier, and item. You can use the receiving inspection register to review your inspections by receipt. See: Inspections: page 7 – 72.

- Record returns to suppliers. You can return items that are damaged on receipt or that fail your inspection process. If you return items that you have already delivered to inventory, Purchasing automatically updates the inventory stock levels. See: Returns: page 7 – 76.

- Enable the automatic creation of debit memos for Return to Supplier transactions. See: Debit Memos: page 7 – 15.

- Correct receiving transaction errors. Purchasing automatically updates the inventory balances if you correct the quantities of items that have already been moved into inventory. See: Corrections: page 7 – 84.
• Use flexible search criteria to choose receipts for review.
• View receipts details. You should be able to view all the details of your receipt, including matching purchase order and shipment information.
• Perform transactions with minimal effort. For example, you can record a complete receipt with only a few mouse clicks.
• Use attachments throughout the receiving process to more completely identify transactions and to inform users of special requirements. See: Attaching Notes to Purchasing Documents: page 1 – 44.
• Record drop shipments as receipts once the supplier informs you that the drop shipment has been delivered to the customer. See: Drop Shipments: page 4 – 133.
• Receive purchase orders for kanban replenishment requests that were generated from Oracle Inventory. Once you record delivery of a kanban item through the Receipts or Receiving Transactions windows, Inventory automatically receives a status of Full for the order, indicating that the inventory supply has been replenished. See: Demand for Internal Requisitions: page 3 – 18.
• Capture exchange rate information on the receipt. See: Entering Receipt Lines: page 7 – 34.
• Capture and update an item’s country of origin on the receipt. See: Entering Receipt Lines: page 7 – 34.
• Capture movement statistics at the time of receipt. See: Movement Statistics: page 7 – 8.
• Enable inventory items to display shortage messages upon receipt, if a shortage exists, so that the responsible person can make the item available with a high priority. See: Material Shortage Alerts and Shortage Notifications, Oracle Inventory User’s Guide.
• Receive items returned by a customer. See: Return Material Authorizations (RMAs): page 7 – 14.

Centralized Purchasing for Multiple Receiving Organizations

Purchasing provides complete centralized procurement support. You can leverage your purchasing power by consolidating the requirements
from different plants, warehouses, and office sites; yet retain receiving support. You can define separate, autonomous receiving organizations for each of these sites.

Use the Change Organization window (See: Changing Your Organization, Oracle Master Scheduling/MRP and Supply Chain Planning User’s Guide) to choose your receiving organization. With the Receipts window, you can receive goods only for your current organization. The current organization code is displayed in the title bar of the Receipts window. (See: Entering Receipt Lines: page 7–34.) For supplier shipments, you specify the receiving organization on the purchase order shipment. For intransit inventory shipments, you specify the receiving organization when you create the intransit shipment. For internal requisitions, you use the destination organization to specify the receiving organization. For customer returns, the agent specifies the organization on the return material authorization (RMA) in Order Management.

All other receiving windows can access receiving only in your current organization. You also must deliver to the same organization in which you received the goods.

Use the Manage Shipments window to update intransit information to provide accurate expected delivery date information to better plan your production processes. See: Managing Shipments: page 7–93.

---

**Receiving Locations**

Receiving locations are designated areas in which you temporarily store items before you deliver them to their final destinations. Your receiving dock and the area in which items are inspected are receiving locations. See: Defining Locations: page 1–24.

Receiving locations are not required when the routing is Direct Receipt, when you are delivering goods to their final locations. However, when the routing is Standard Receipt, you initially receive the items into a receiving location, and you must specify the receiving location. If the routing is Inspection Required, you could transfer the items to an inspection location before delivering them to their destination. If necessary, you can create additional receiving locations, such as a cold storage area where items can be held pending inspection.
See Also

- Entering Receipt Header Information: page 7 – 32
- Receiving Transactions: page 7 – 45
- Inspections: page 7 – 72

Movement Statistics

You can automate the collection of movement statistics—or information associated with the movement of goods—by following the instructions in: Setting Up Movement Statistics, Oracle Inventory User’s Guide. (You can set up this functionality in Purchasing even if Inventory is not fully installed.) Once you set up the automatic collection of movement statistics and start the Movement Statistics Processor, the system records movement statistics automatically from the purchase order, internal requisition, return-to-supplier, and drop shipment receipt transactions.

You can also update movement statistics in the Movement Statistics window, which is accessible through the Receiving menu in Purchasing. For example, if the Movement Statistics Exceptions Report shows missing information, you can query and update the movement statistics record in the Movement Statistics window. For information on this window, see: Entering and Maintaining Movement Statistics, Oracle Inventory User’s Guide.

Once you have set up the automatic collection of movement statistics, run the Movement Statistics Processor to compile all of the material transactions for a defined period to automatically create Intrastat and Extrastat records. Then run the movement statistics reports. See: Automatically Generating Movement Statistics, Oracle Inventory User’s Guide.

Use e–Commerce Gateway to report the information to government agencies. See: Running the Movement Statistics Extract Program, Oracle e–Commerce Gateway User’s Guide.

See Also

- Overview of Movement Statistics, Oracle Inventory User’s Guide
Receiving Controls, Options, and Profiles

Purchasing provides you with all the necessary functionality to set up flexible purchasing and receiving controls, control options, and profile options. The profile options can be set at the site, application, responsibility, or user level. The receiving controls and options can be set at one or more of the following levels: order, item, supplier, organization, and system. Controls at any level override those at a higher level. For example, item level controls override supplier controls but are overridden by order controls.

Use the Profile Options window to set profile options for receiving. Use the Receiving Controls window (See: Entering Purchase Order Receiving Controls: page 4 – 69.) and the More tabbed region in the PO Shipments window (See: Entering Purchase Order Shipments: page 4 – 63.) to set receiving options at the order level. Use the Item window (See: Defining Items, Oracle Inventory User’s Guide.) to set receiving options at the item level. Use the Supplier window (See: About Suppliers, Oracle Public Sector Payables User’s Guide) to set receiving options at the supplier level. Use the Receiving Options window (See: Defining Receiving Options: page 1 – 58.) to set receiving options at the organization level. Use the Purchasing Options window (See: Defining Purchasing Options: page 1 – 45.) to set receiving options at the system level. You can set the following receiving options:

- Match approval level, which determines whether the items on a purchase order line must be received and/or inspected before the corresponding invoice can be paid. See: Defining Default Options: page 1 – 45. You can override this option for specific suppliers, items, and orders.

- The Invoice Close % tolerance for your shipments. Purchasing automatically closes a shipment for invoicing if it is within the invoicing closing tolerance at billing, when Payables matches invoices to purchase orders or receipts. See: Defining Default Options: page 1 – 45. You can override this option for specific items and orders.

- The Receipt Close % tolerance for your shipments. Purchasing automatically closes a shipment for receiving if it is within the receiving closing tolerance at the receiving close point. See: Defining Default Options: page 1 – 45. Note also that in the Find Expected Receipts form you have the option to include closed purchase orders when you are entering search criteria. You can override this option for specific items and orders. See: Finding Expected Receipts: page 7 – 28.
• The Receipt Close Point, when the shipment is closed for receiving: Accepted (passed inspection), Delivered, or Received. See: Defining Control Options: page 1 – 49.

• Whether expense accrual is on receipt or at period end. See: Defining Accrual Options: page 1 – 48.

• The default expense AP accrual account. See: Defining Accrual Options: page 1 – 48.

• Automatic or manual receipt numbering. If you choose Automatic, you can also set the start of the receipt number sequence. This is used with manual receipt numbering for inter–organization direct receipts. See: Defining Numbering Options: page 1 – 53.

• Alphanumeric or numeric receipt numbering. See: Defining Numbering Options: page 1 – 53.

• Whether you can receive a defined substitute item instead of the originally ordered item. See: Defining Receiving Options: page 1 – 58. You can override this option for specific suppliers, items, and orders.

• Whether you can receive unordered items. See: Defining Receiving Options: page 1 – 58. You can override this option for specific suppliers and items.

• Whether you allow express transactions. See: Defining Receiving Options: page 1 – 58.

  Express receipt/delivery allows you to receive/deliver the entire quantity of all selected shipments (except those you specifically omit) without entering specific quantities for each shipment and distribution.

• Whether you allow cascade transactions. See: Defining Receiving Options: page 1 – 58.

  The cascade function lets you distribute a quantity of an item from a single supplier across multiple shipments and distributions.

• Blind receipt. If you choose this option, Purchasing does not enforce quantity tolerances, nor does it display the Quantity Due or the Quantity Ordered for shipments on line or on receiving worksheets. See: Defining Receiving Options: page 1 – 58.

• Whether goods can be received only to the receiving location that was defined as the ship–to location on the purchase order and whether Purchasing prohibits the transaction, displays a
warning message while permitting the transaction, or permits the transaction without a warning. See: Defining Receiving Options: page 1 – 58. You can override this option for specific suppliers, items, and orders.

- The maximum acceptable over-receipt percentage and whether Purchasing prohibits the transaction, displays a warning message while permitting the transaction, or permits the transaction without a warning. See: Defining Receiving Options: page 1 – 58. You can override this option for specific suppliers, items, and orders.

- The number of calendar days before and after the purchase order delivery date that you allow receipt and whether Purchasing prohibits the transaction, displays a warning message while permitting the transaction, or permits the transaction without a warning. See: Defining Receiving Options: page 1 – 58. You can override this option for specific suppliers, items, and orders.

- The receiving account for your accrual entries. See: Defining Receiving Options: page 1 – 58.

- The default receipt routing that you assign goods: Direct Delivery, Standard Receipt, or Inspection Required. See: Defining Receiving Options: page 1 – 58. You can override this option for specific suppliers, items, and orders.

- Whether you can override the destination type at receipt time. This is a profile option (RCV: Allow Routing Override) that you can set at the application, responsibility, or user level. See: Profile Options in Purchasing: page 1 – 103.

- Whether receipt travelers are automatically printed when you perform a receipt or receiving transaction, and match an unordered receipt. This is a profile option (RCV: Print Receipt Traveler) that you can set at the site, application, responsibility, or user level. See: Profile Options in Purchasing: page 1 – 103.

- The processing mode for receiving transactions: Batch, Immediate, or Online. (See Receiving Transaction Processor: page 9 – 131.) This is a profile option (RCV: Processing Mode) that you can set at the site, application, responsibility, or user level. See: Profile Options in Purchasing: page 1 – 103.

- Whether or not you receive an error message—or are prevented by Purchasing—when you attempt to receive against a purchase order shipment for which an Advance Shipment Notice (ASN) already exists. This is done through an option (ASN Control) in the Receiving Options window. See: Defining Receiving
• Whether to reject an entire Advance Shipment Notice (ASN) if any ASN line fails validation or processing, or to accept an ASN if at least one ASN line is successful. This is a profile option (RCV: Fail All ASN Lines if One Line Fails). See: Profile Options in Purchasing: page 1 – 103. See also: Advance Shipment Notices (ASNs): page 7 – 17.

The following table shows the receiving controls and the windows used to enter the controls.

<table>
<thead>
<tr>
<th>Control</th>
<th>Purchasing Options Window</th>
<th>Receiving Options Window</th>
<th>Supplier Window</th>
<th>Item Window</th>
<th>PO Shipments Window *</th>
<th>User Profile Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match Approval Level (2–, 3–, or 4–way)</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Invoice Close Tolerance</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Receipt Close Tolerance</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Receipt Close Point</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expense Accrual Point</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expense AP Accrual Account</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ASN Control – None, Reject, Warning</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Receipt Numbering – Auto or manual / alpha or numeric</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allow Substitute Items</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Allow Unordered Items</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allow Express Transactions</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 7–1 Receiving Controls Matrix (Page 1 of 2)
<table>
<thead>
<tr>
<th>Control</th>
<th>Purchasing Options Window</th>
<th>Receiving Options Window</th>
<th>Supplier Window</th>
<th>Item Window</th>
<th>PO Shipments Window*</th>
<th>User Profile Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Cascade Transactions</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allow Blind Receiving</td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enforce Ship–To Location</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overreceipt Tolerance</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Early/Late Receipt Tolerance</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Receiving Account</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Receipt Routing</td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allow Routing Override</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Fail All ASN Lines if One Line Fail</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>System Profile</td>
</tr>
<tr>
<td>Print Receipt Traveler</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Processing Mode</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
</tbody>
</table>

Table 7 – 1 Receiving Controls Matrix (Page 2 of 2)

* Note: Controls are entered through the More tabbed region in the PO Shipments window (See: Entering Purchase Order Shipments: page 4 – 63) or through the Receiving Controls window (See: Entering Purchase Order Receiving Controls: page 4 – 69), which is accessible only through the PO Shipments window.

**Receipt Tolerances**

You may want to allow over-receipts on items that you use frequently within your organization, and you can prevent misallocation of shipments to incorrect destinations by setting tolerance levels and the control action. You can over-receive for a particular item if the over-receipt quantity is within tolerance, and you can set the control action to allow all over-receipts, permit over-receipts outside the
tolerance but issue a warning message, or reject over-receipts outside the tolerance. See: Receiving Controls, Options, and Profiles: page 7 – 9.

**Example**

You order 100 boxes of shelf braces and indicate on the purchase order that this order requires a receipt. You decide to relax the restriction on the receiving tolerance for shelves since shelves are a low cost/high turnover item. You define the receiving tolerance level for shelves to be 10% but choose to allow receipts over this tolerance level after displaying a warning.

At the receiving dock, the receiving agent receives 111 boxes of shelf braces and enters a receipt for all of them. The receiving agent can accept them all because your system setup allows receipt over tolerance for this item.

Later, you determine that you are not using all the shelf braces you had predicted, and you decide to change the tolerance level to 3% and to not allow receipts over tolerance. In the next shipment, you receive another 111 boxes of shelf braces. Again, the purchase order was for 100 boxes. The receiving agent attempts to receive 111, but Purchasing displays an error message stating that the receipt quantity is over tolerance and does not let the receiving agent record the over receipt. So, this time the receiving agent can receive only 103 and must reject the additional 8.

---

**Return Material Authorizations (RMAs)**

You can use Purchasing’s receiving functionality to receive goods returned by your customers. These are goods for which a sales order in Oracle Order Management was created. If the customer wishes to return the goods, the agent creates a return material authorization (RMA) authorizing the return. When the return arrives at your receiving dock, you can create a receipt against the RMA as you would any other receipt, inspect the return, return the repaired goods to the customer, and make receiving corrections. Use the Customer tabbed region of the receiving Find windows to search by customer name, item number, or RMA number. See: Finding Expected Receipts: page 7 – 28.

If an RMA does not exist for a customer return, you can create an unordered receipt while you find out from the agent which RMA to use. See: Unordered Receipts: page 7 – 39. Use the Receiving Returns window to return the item to the customer if a return is not authorized or after the goods have been repaired.
RMAs use the default receipt routing defined in the Receiving Options window. They use the receipt tolerance that was defined in Order Management when the RMA line was created. The RMA reflects the received, or partially received, quantity while the remaining quantity remains open.

Lot and serial numbers are handled for RMAs as they are for any other item or receipt.

You cannot cascade RMA receipts.

**Example**

Your organization makes computer boards. A agent creates sales orders using Order Management and ships the boards to customers. One of your customers receives a shipment of 20 boards, which do not work properly, and calls the agent. The agent creates an RMA in Order Management authorizing the return of the boards. The RMA line is created with a line type of Return with Receipt of Goods.

When the boards arrive at your receiving dock, you enter the customer name, item number, or RMA number in the Find Expected Receipts window and create a receipt. Purchasing automatically updates the RMA to reflect the quantity received.

You use the Inspection window to record your inspection of the boards. Inspection confirms that all 20 of the returned boards are defective. You use the Receiving Transactions window to deliver the boards to their final destination. Purchasing automatically updates the RMA with the quantity fulfilled.


---

**Debit Memos**

You can automatically generate debit memos for Return To Supplier transactions once an invoice has been created. To enable this functionality, enable the supplier site as a Pay Site (or indicate an Alternate Pay Site) and select Create Debit Memo from RTS Transaction in the Supplier Sites window. See: Purchasing Region of the Suppliers and Supplier Sites windows, *Oracle Public Sector Payables User’s Guide*. When you create the return, make sure the Create Debit Memo Option is selected in the Returns window. Once you enable this functionality, a debit memo is created for each return line you enter in the Returns window.
The debit memo number contains the original receipt number. It is dated with the return transaction date. If this date does not fall within an open period in Oracle Public Sector Payables, the date defaults to the first open date available in Payables. The payment schedule on the debit memo is based on the purchase order payment terms (in the Terms and Conditions window) and the invoice terms defined in Payables.

The debit memo is calculated by multiplying the returned quantity by the purchase order item unit price. If the purchase order is in a foreign currency, and you perform invoice matching to receipts, Purchasing uses the currency conversion rate at the time of receipt to calculate the unit price. The debit memo does not include tax and freight charges. If the unit of measure (UOM) on the return in the Returns window differs from the purchase order UOM, Purchasing restates the return quantity on the debit memo in terms of the purchase order UOM. If an Advance Shipment Notice (ASN) or an ASN with billing information (ASBN) exists for the receipt, the unit price from the ASN or ASBN is used.

Purchasing does not automatically include corrections to returns in debit memos; in this case, you need to adjust the debit memo manually. See: Entering Debit/Credit Memos, Oracle Public Sector Payables User’s Guide. Purchasing does not create debit memos for returns against unordered receipts.

If an invoice has not yet been created for the receiving transaction or if Payment on Receipt already accounted for the return using the Aging Period functionality, a debit memo will not be created. Whenever a debit memo cannot be created, you will receive a notification in the Notifications Summary window.

Similarly, the Aging Period functionality in Payment on Receipt does not include returns for which a debit memo was already created, so that duplicate debits are not made. See: Payment on Receipt: page 9 – 66.

You can match the debit memo to the purchase order or receipt. See: Matching Credit/Debit Memos in the Invoices chapter/section of the Oracle Public Sector Payables User’s Guide.
Advance Shipment Notices (ASNs)

An Advance Shipment Notice (ASN) is transmitted via Electronic Data Interchange (EDI) from a supplier to let the receiving organization know that a shipment is coming. The ASN contains details including shipment date, time, and identification number; packing slip data; freight information; item detail including cumulative received quantities; country of origin; purchase order number; and returnable container information.

Once an ASN is successfully validated, you can use it in the Receipts window to create receipts, reducing data entry time. (A validated ASN is one that contains no errors during data validation in the Receiving Open Interface.)

Suppliers can also send ASNs with billing information. These contain the same information as ASNs plus invoice and tax information. Once an ASN with billing information (also known as an ASBN) is validated in the receiving open interface and imported into Purchasing, an invoice for the shipment is created automatically.

A supplier creates an ASN based on the demand conveyed by the purchasing organization’s Purchase Order, Planning Schedule, or Shipping Schedule. If Purchasing detects errors or discrepancies in the ASN at any time, from the time the ASN is sent to the time it is entered as received, an Application Advice, transmitted via EDI, is sent automatically to the supplier. The supplier can then send a corrected ASN.

**Attention:** ASNs come from external suppliers only. They cannot be used for internal sales orders sourced from your inventory and generated by internal requisitions.

You can view or cancel an accepted ASN as an intransit shipment in the Manage Shipments window.

You can match invoices to receipts created from ASNs. You can also match ASBN invoices to receipts.

**ASN Process**

The ASN process, shown in the next figure, includes the following:

- **A shipment authorization is made** to the supplier in the form of a Purchase Order, Planning Schedule, or Shipping Schedule.

- **The supplier sends the ASN** to the receiving organization at the time of shipment.
• **The ASN is verified in the Receiving Open Interface.** Intransit and purchasing supplies are updated for ASN lines that are successfully validated. For each accepted line on the ASN, intransit supply is increased and purchasing supply is reduced. If the data isn’t accepted or if there is an error or discrepancy in the data, an Application Advice, containing the most likely cause of the error, is sent to the supplier. The supplier can then send a corrected (New) ASN.

• **The goods arrive.** You can use the ASN in the Receipts window to create receipts.

• **Shipment–vs.–receipt quantities are compared** during the receipt transaction process. (As an optional step, CUM quantities can be compared if Oracle Supplier Scheduling is installed.) If discrepancies are detected in shipment–vs.–receipt or CUM quantity comparisons, an Application Advice is sent to the supplier.

---

**ASN Receiving Options**

There are two receiving options related to ASNs:

- **ASN Control option in the Receiving Options window** – With this option, you can choose whether or not you receive an error message—or are prevented by Purchasing—when you attempt to
receive against a purchase order shipment for which an ASN already exists. See: Defining Receiving Options: page 1 – 58.

- RCV: Fail All ASN Lines if One Line Fails – With this profile option, you can choose to reject an entire ASN if any ASN line fails validation or processing, or to accept an ASN if at least one ASN line is successful. See: Profile Options in Purchasing: page 1 – 103.

Application Advices

If an ASN is not accepted or is only partially accepted, errors and discrepancies are electronically conveyed to the supplier in an Application Advice. The Application Advice transmits to the supplier the status (acceptance with errors or rejection) of the ASN, and the severity and description of the errors.

An Application Advice can be sent at several points during the receiving process:

- When the ASN is first sent and contains header or line errors.
- When the quantity received does not match the quantity shipped indicated by the ASN.
- When the receiving organization’s newly updated cumulative received quantities do not match the supplier’s cumulative shipped quantities.

**Note:** CUM quantity comparisons can be performed only if Oracle Supplier Scheduling is installed.

The supplier can respond to an Application Advice by sending a Cancellation ASN followed by a corrected (New) ASN. The receiving organization can also cancel an ASN manually in the Manage Shipments window.

The following table indicates the appropriate supplier response to particular Application Advices.
<table>
<thead>
<tr>
<th>ASN Header</th>
<th>ASN Lines</th>
<th>Transaction Status</th>
<th>Supplier Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fatal Error</td>
<td>Not Validated</td>
<td>Transaction Rejected</td>
<td>Send New ASN before goods arrive.</td>
</tr>
<tr>
<td>Warning or Valid</td>
<td>All lines Warning or Valid (no fatal errors)</td>
<td>Transaction Accepted</td>
<td>Do not send a New ASN, but correct indicated problems on future ASNs.</td>
</tr>
<tr>
<td>Warning or Valid</td>
<td>Some Warning Some Valid Some Fatal Error</td>
<td>Transaction Accepted with Some Lines Rejected</td>
<td>Send Cancellation ASN, then send a New (corrected) ASN.</td>
</tr>
<tr>
<td>Warning or Valid</td>
<td>All lines had a Fatal Error</td>
<td>Transaction Rejected</td>
<td>Send a New (corrected) ASN before goods arrive.</td>
</tr>
</tbody>
</table>

Table 7–2  (Page 1 of 1)

Types of ASNs

There are three types of ASNs:

- A **New** ASN is the initial ASN.
  An ASN can also contain substitute item information. To accurately handle substitutions, the supplier must indicate both the buyer’s original item number and the buyer’s substitute item number on the ASN. With both identifiers available, substitutes can be validated as allowed, and a valid substitute item is referenced against valid purchasing document information.

- A **Cancellation** ASN, once validated, cancels the original (New) ASN if the original (New) ASN has not yet had a receipt created against it. The shipment number on the Cancellation ASN is matched to the shipment number on the validated, original (New) ASN.

- A **Test** ASN is sent by the supplier usually to make sure the ASN transmission works between you and your supplier. A Test ASN is verified as if it were a New ASN and generates an outbound Application Advice if necessary. A Test ASN is not available for creating a receipt against it and is not visible as inbound supply.

**Note:** A validated ASN, as described above, is one that contains no errors during data validation in the Receiving Open Interface.
ASNs and CUM Management

You can perform CUM management under the following conditions:

- Oracle Supplier Scheduling is installed and CUM Accounting is enabled for the ship-to organization.
- The ASN item or items are defined in the Approved Supplier List.
- The items are sourced from the supplier using a Supply Agreement Blanket Purchase Order.

The CUM is the total quantity received from a supplier site, for a particular item, within a CUM period. When an ASN is used during receiving and Supplier Scheduling is installed, the updated CUM is compared to the supplier’s CUM. Any discrepancy transmits an Application Advice to the supplier. For more information about CUM management, see: CUM Management, Oracle Supplier Scheduling User’s Guide.

ASNs and Supply

For each accepted line on the accepted ASN, intransit supply quantity is automatically increased and purchasing supply quantity is automatically reduced by the shipment quantity specified in the ASN.

When an accepted ASN is cancelled or a corrected ASN is sent, corresponding changes are also made to purchasing and intransit supply. (A supplier can send a Cancellation ASN or you can cancel the ASN in the Manage Shipments window.)

The table below shows, for each action you perform with an ASN, the movement of the quantity on the ASN between the various categories of supply.

<table>
<thead>
<tr>
<th>ASN Action</th>
<th>Purchasing Supply</th>
<th>Intransit Supply</th>
<th>Inventory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept the New ASN</td>
<td>Reduced for accepted lines only</td>
<td>Increased for accepted lines only</td>
<td></td>
</tr>
<tr>
<td>Accept the Cancellation ASN</td>
<td>Increased for all accepted lines on New ASN</td>
<td>Reduced for all accepted lines on New ASN</td>
<td></td>
</tr>
</tbody>
</table>

Table 7 – 3  (Page 1 of 2)
<table>
<thead>
<tr>
<th>ASN Action</th>
<th>Purchasing Supply</th>
<th>Intransit Supply</th>
<th>Inventory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receive item when the item is indicated on an ASN line</td>
<td></td>
<td>Reduced</td>
<td>Increased</td>
</tr>
<tr>
<td>Receive item when the item is not indicated on an ASN line</td>
<td>Reduced</td>
<td></td>
<td>Increased</td>
</tr>
<tr>
<td>Increase receipt quantity before the ASN is closed</td>
<td></td>
<td>Reduced</td>
<td>Increased</td>
</tr>
<tr>
<td>Increase receipt quantity after the ASN is closed</td>
<td>Reduced</td>
<td></td>
<td>Increased</td>
</tr>
<tr>
<td>Decrease receipt quantity before the ASN is closed</td>
<td></td>
<td>Increased</td>
<td>Reduced</td>
</tr>
<tr>
<td>Decrease receipt quantity after the ASN is closed</td>
<td>Increased</td>
<td></td>
<td>Reduced</td>
</tr>
<tr>
<td>Return item(s) to the supplier before the ASN is closed</td>
<td></td>
<td>Increased</td>
<td>Reduced</td>
</tr>
<tr>
<td>Return item(s) to the supplier after the ASN is closed</td>
<td>Increased</td>
<td></td>
<td>Reduced</td>
</tr>
<tr>
<td>Close the Purchase Order while an ASN for that purchase order is open</td>
<td>Reduced</td>
<td>Reduced</td>
<td></td>
</tr>
</tbody>
</table>

Table 7–3 (Page 2 of 2)

See Also

- Entering Receipt Lines: page 7–34
- Managing Shipments: page 7–93
- Profile Options in Purchasing: page 1–103
- Advanced Shipment Notice Discrepant Receipts Report: page 9–16
- Receiving Interface Errors Report: page 9–130

Oracle Manufacturing, Distribution, Sales and Service Open Interfaces Manual

Oracle e-Commerce Gateway Implementation Manual
Managing Receipts

Using the Find Expected Receipts Window

When you enter a receipt, you first use the Find Expected Receipts window to locate the source document for the receipt: a shipment from a supplier based on a purchase order, a shipment from inventory backed by an internal sales order generated by an internal requisition, an intransit shipment within your inventory, or a return from a customer based on a return material authorization (RMA).

Receiving Shipments

Once you have entered your search criteria, you move to the Receipts window, where all the supplier shipments and inter–organization shipments corresponding to your search criteria are displayed. You can receive goods into a receiving location or to their final destination. When you receive goods into a receiving location, you then use the Receiving Transactions window to optionally inspect and/or transfer receipts between receiving locations before you deliver the receipts to their final destination specified on the source document. You can also receive and deliver to a final destination in one transaction using the Receipts window. You can either use Express Receipt to receive all quantities as shipped, or you can enter specific receipt quantities for shipments. You can modify information, such as the receipt number and packing slip number. When suppliers have consolidated orders onto a single shipment, you can use the Cascade function to allocate the shipment across orders during entry of receipts.

If the RCV: Print Receipt Traveler profile option is set to Yes, receipt travelers are printed automatically when you perform receipts or receiving transactions. See: Profile Options in Purchasing: page 1 – 103.

You can also record the receipt of substitute and unordered items. Purchasing records the shipment for the unordered items when you enter the receipt. You cannot perform receiving transactions upon the receipt until you match it to an order. See: Matching Unordered Receipts: page 7 – 41.

See Also

Finding Expected Receipts: page 7 – 28
Express Receipts and Receiving Transactions: page 7 – 26
Multiple Distributions

If you’re familiar with the previous release of Purchasing, you may remember you had to use a separate screen when entering receipts for purchase orders with multiple distributions. In the current release of Purchasing, you can explode a single shipment into its component distributions in the Receipts window.

When you initially query up a shipment line that has multiple distributions, there will be a + icon to the right of the UOM field for all lines with a Destination Type of Multiple. Shipment lines for which there is only a single distribution will not have the + icon. You can click on the + icon to expand the line into multiple lines, one for each distribution. The original shipment line will appear grey and will not be updatable. The + icon on that line will change to a – icon. Click on the – icon to end the display of the expanded lines.

You can distribute the available quantity across the expanded lines, but you cannot distribute more than the available quantity shown in the parent shipment quantity column. Also, you can enter and maintain line information only in the expanded lines.

If the default routing is direct receipt and routing override is not enabled, you can explode the line and transact the receipt at the distribution level, but you cannot change any of the values on that line. If the default routing is standard receipt and routing override is enabled and there are multiple destinations, Purchasing displays the destination type Receiving and the + icon is not present. If you want to override the routing and send it to final, you must first change the destination type to Multiple. Then the + icon will appear, and you can expand to see all of the distribution lines and change any or all to have a destination type of final.
Cascading Receipts and Receiving Transactions

The Cascade function facilitates the distribution of a given quantity of an item from a single supplier across multiple shipments and distributions. This function is available in the Receipts window if you have specified a Supplier and Item in the Find Expected Receipts window and if Allow Cascade Transactions is enabled in the Receiving Options window. In the Receiving Transactions window, the cascade function is available for deliveries if you have specified an Item in the Find Receiving Transactions window. Performing any manual transaction in a line disables the Cascade button, and it is not enabled until you have again selected the Find button in the appropriate Find window.

When you select the Cascade button, Purchasing displays the Cascade Details window in which you must enter the cascade quantity and the unit of measure. When you select the OK button, the cascade process begins.

The process starts at the first displayed line and allocates the supply available to receive/deliver to that line from the cascade quantity you entered. The process continues to the next line and again allocates the quantity available to receive/deliver, continuing until either the process reaches the last queried line or the cascade quantity is exhausted. Since the lines are displayed in order by promised date/need – by date, the process operates as a First In/First Out procedure. If you entered a cascade quantity larger than the quantity available to receive/deliver, Purchasing displays a dialog window explaining that the process could allocate only so many. If the quantity available to receive/deliver is greater than the cascade quantity, the last receipt/delivery may be partial. To clearly indicate that the cascade quantity has been exhausted, Purchasing displays a transaction quantity of 0 for the remaining lines.

The cascade function does not modify any destination information; it uses the information defined by the routing and defaulted from the shipment.

If a given shipment line has multiple distributions and the default routing for that line is direct receipt, the cascade process explodes the line and allocates the quantity available on the shipment line to the component distributions based on the supply available for the distribution. If you have over distributed a given line, Purchasing allocates all remaining supply for the shipment to the last distribution. If you have over delivered the transactions with prior receipts or transactions, then the process may fill the lines with undesired values,
but you can reallocate in this situation once the cascade process is complete.

Record validation is disabled during the cascade process to facilitate the running of the process, but all lines are validated when you save them. Quantities are applied to lines in the expectation that you will transact the line as the default routing intended. However, you can manually override these values.

---

**Express Receipts and Receiving Transactions**

The express function is a quick method of entering receipts and receiving transactions. This function is available in the Receipts window if you have specified or inferred a source in the Find Expected Receipts window. (The source would be inferred if you entered, for example, a purchase order number.) In the Receiving Transactions window, the express function is available for deliveries regardless of your search criteria in the Find Receiving Transactions window. Performing any manual action in a line disables the Express button, and it is not enabled until you have again selected the Find button.

When you select the Express button in the Receipts window, Purchasing displays the Express Details window in which you must enter the destination: Final Destination or Receiving location. When you select the OK button, all lines are selected and the Express button changes to Unexpress. When you select the Express button in the Receiving Transactions window, all lines are selected and the Express button changes to Unexpress. In either case, you can select the Unexpress button to return to manual mode. Otherwise, you can deselect lines to omit them from express processing and then save your work to initiate express processing.

**Note:** You cannot perform data collection using Oracle Quality when you select the Express button in the Receiving Transactions window. See: Receiving Transactions: page 7 – 45.

The express processor performs validation and rejects lines based on the following criteria:

- the item revision/subinventory/locator is required and not obtainable as a default from the item definition and the destination is Final
- the early/late receipt date tolerance is exceeded and the exception control is Reject
- lot/serial information is required
• ship–to location is not available and the destination is Receiving
• location is not available for Expense destination type and the destination is Final Destination
• purchase order supplier and receipt header supplier do not match
• other receipts are pending for the specified shipment

When validation processing is complete, Purchasing displays a dialog telling you how many lines passed validation and how many failed and are still available to receive manually.

See Also

Entering Express Receipts: page 7 – 27

Entering Express Receipts

Use the Receipts window to enter express receipts.

► To find source documents:

1. Navigate to the Find Expected Receipts window by selecting Receipts on the menu.
2. Enter search criteria to find the source documents for which you want to enter express receipts. You must include the supplier or organization in the source criteria.
3. Select the Find button to display the Receipts window with line(s) available for receipt displayed in the Lines tabbed region.

► To enter express receipts:

1. Select the Express button to open the Express Details window.
2. Select the Destination Type: Final Destination or Receiving location.
3. Select the OK button. This changes the Express button to Unexpress and selects all the lines for express receipt.
4. Optionally deselect individual lines to omit them from the express receipt.
5. Save your work to begin express receipt validation processing.
See Also

Express Receipts and Receiving Transactions: page 7 – 26
Finding Expected Receipts: page 7 – 28
Entering Receipt Lines: page 7 – 34

Finding Expected Receipts

Use the Find Expected Receipts window to find source documents for which you can enter receipts. Use the Supplier and Internal tabbed region to search for Purchasing documents. If Order Management is installed, use the Customer tabbed region to search for customer return material authorizations (RMAs).

To find expected receipts in the Supplier and Internal tabbed region:

1. Navigate to the Find Expected Receipts window by selecting Receipts from the menu.
2. Select the Supplier and Internal tabbed region.

3. Specify any of the following, optional search criteria:

   - Select the receipt Source Type for the search:

     **Internal**: An internal order generated from an internal requisition and sourced from your inventory, or an intransit inventory shipment. If you choose this option, the following fields are disabled: PO Number, Release, Line, Shipment, and Include Closed POs.

     **Supplier**: A purchase order sourced from a supplier. If you choose this option, the Requisition Number and requisition Line number fields are disabled.

     **All**: Internal– and supplier–sourced documents.

   - For a Supplier source type, enter the Purchase Order number. To be available, a purchase order must have at least one approved shipment for which the ship–to organization is the same as the current active organization. If you enter a purchase order number, you can also enter a Release number, Line number,
7 – 30  Oracle Public Sector Purchasing User’s Guide

and/or Shipment number for the purchase order. The Release field is applicable only when you have entered a purchase order number associated with a planned purchase order or a blanket purchase agreement. The list of values in the Release field includes all releases for the specified purchase order that are not final closed.

• For an Internal source type, enter the Requisition Number. If you enter a requisition number, you can also enter a Line number. Available lines are those with the same ship–to organization as the current active organization.

• In the second Shipment field, enter the shipment number of the Advance Shipment Notice (ASN). See: Advanced Shipment Notices (ASNs): page 7 – 17.

• Enter the Supplier. For Source Type Internal, this is the organization. For Source Type Supplier, this is the supplier name, and you can also enter the Supplier Site.

• Select Include Closed POs to include soft closed purchase orders in the search. By not checking Include Closed POs, you exclude purchase orders that have a status of Closed or Closed for Receiving.

• Enter the Receiving Location.

• Use the lower tabbed regions to further restrict the search.

4. Select the Find button to initiate the search and display the selected source documents in the Receipts window. Purchasing first opens the Receipt Header window.

To find expected returns in the Customer tabbed region:


   This region is used for finding items that a customer has returned to your organization. When a agent creates a sales order in Order Management and ships the item to the customer, you can find and create receipts if the customer returns the item. You create the receipt against a return material authorization (RMA) document, which the agent uses to authorize the return.

2. Specify any of the following, optional search criteria:

   • Line type, such as Return with Receipt of Goods, on the RMA. There are different return line types. Search by RMA line type if
you want to see all RMA lines with that line type in your receiving organization.

- RMA Number, which corresponds to the Order Number field on the sales order
- Line number from the RMA
- Customer returning the item
- Customer Number
- Customer Item Number that the customer used to order the item
- The lower tabbed regions. See: To further restrict the search, below.

3. Select the Find button to initiate the search and display the selected source documents in the Receipts window.

► To further restrict the search:

■ Specify any of the following, optional search criteria:

- In the Item region, you can enter the following search criteria: Item number, Revision number, Category, item Description, and Supplier Item Number. Since the supplier item number is generally the best way you can identify purchase order lines when your supplier does not reference your purchase order number on its shipping documents, you should provide a supplier item number on your purchase order lines.

- In the Date Ranges region, you can select Due Today to limit the search to receipt lines due on the current date. Otherwise, you can enter a Due By date range. These dates correspond to the Promised Date (or Need–by Date if there is no Promised Date) on the Purchasing document or to the Promise Date (or Request Date if there is no Promise Date) on the RMA.

- In the Shipment region, you can enter the Container, Truck Number, or Bar Code Label indicated on an Advance Shipment Notice (ASN). See: Advance Shipment Notices (ASNs): page 7 – 17.

► To enter unordered receipts:

■ Select the Unordered button to open the Receipt Header window to enter unordered receipts. See: Entering Unordered Receipts: page 7 – 40.
To remove existing search criteria

Select the Clear button in any of the source document search windows to remove existing search criteria.

See Also

- Entering Receipt Header Information: page 7 – 32
- Return Material Authorizations (RMAs): page 7 – 14

Entering Receipt Header Information

Use the Receipt Header window to enter header information for all types of receipts.

**Note:** If you are entering a receipt against an Advance Shipment Notice (ASN), the header information may already be entered for you if the supplier sending the ASN provided that information. See: Advanced Shipment Notices (ASNs): page 7 – 17.

**To enter receipt header information:**

1. Navigate to the Receipt Header window. Purchasing opens this window when you select Find or Unordered in the Find Expected Receipts window. You can also get to this window by selecting the Header button in the Receipts window.

2. Enter the Receipt number. If automatic receipt numbering is enabled, this field is not enterable when you are creating a new
receiving. Purchasing displays the receipt number if the shipment has been partially received.

3. Enter the Receipt date.
4. Enter the Shipment number.
5. Enter the Shipped Date.
6. Enter the Packing Slip number.
7. Enter the Waybill/Airbill number.
8. Enter the Freight Carrier. See: Defining Freight Carriers, Oracle Inventory User’s Guide.

Note: Only the active freight carriers are displayed.

9. Enter the Bill of Lading.
10. Enter the number of Containers.
11. Enter the Received By person.
12. Enter the Supplier or Customer. For supplier–sourced shipments, this is the supplier. For inventory–sourced shipments, this is the organization. If the field says Customer, this is the customer returning an item ordered from your organization.
13. Enter Comments.

To add lines to an existing receipt:

- Select the Add To Receipt button to open a list of values showing the receipts to which you can add lines. When you select the receipt to add to, Purchasing displays values from that receipt in the remaining header fields. You can also change the date when the action is Add To Receipt.

See Also

Entering Receipt Lines: page 7 – 34
Entering Receipt Lines

Use this window to enter receipt line information.

➢ To enter receipt line information:

1. Purchasing opens the Receipts window and displays all shipments that meet the search criteria when you choose the Find button in the Find Expected Receipts window. See: Finding Expected Receipts: page 7 – 28.

In the lower part of the screen, Purchasing displays the following detail information for the current shipment line: Order Type, Order number, the Supplier or internal organization shipping the item or the Customer returning the item, Due Date, Item Description, Hazard class, Destination, UN Number, Header.
2. Select the line you want to receive.

If the line you select contains information in the ASN Type field, then an Advance Shipment Notice (ASN) exists for that shipment. (You can set an ASN Control option in the Receiving Options window to prevent you from receiving against a purchase order shipment for which an ASN exists. See: Defining Receiving Options: page 1 – 58.)

If a material shortage exists for the item, a message appears. Displaying shortage messages for certain items is a setup option. From the message, you can view details of where in your organization the demand exists for the item. You can then make the item available with a high priority. See: Viewing Potential Shortages, Oracle Inventory User’s Guide. See: Material Shortage Alerts and Shortage Notifications, Oracle Inventory User’s Guide.

3. Purchasing displays the Quantity due for the shipment. If you change the unit of measure, the receipt quantity is adjusted to reflect the new unit of measure. You can override this value if you are recording a partial receipt or an over-receipt. Depending on your receiving options, Purchasing either ignores over-receipts, displays a warning message when you try to receive more items than you ordered, or prevents you from receiving quantities over your receipt tolerance. If you specify blind receiving at the system option level, Purchasing neither performs over-receipt checking nor displays a Quantity To Receive. If you have fully received a shipment, the receipt quantity displayed is zero, but over-receipt checking will reveal whether you have exceeded the over-receipt tolerance on this shipment.

The information described above applies to an ASN line as well as a purchase order shipment line.

The quantity received on the corresponding purchase order or return material authorization (RMA) is updated to reflect the received quantity.

4. Enter the UOM of the item you are receiving.

5. Enter the Destination Type: Receiving, Expense, Inventory, or Shop Floor. This determines the final destination of the received items.

You can change the Destination Type if the profile option RCV: Allow Routing Override is set to Yes.

6. If the item is under revision control, you must enter a Revision.
7. Enter the receiving Location.
8. Enter the Requestor.
9. For the Inventory destination type, enter the Subinventory into which the goods will be delivered.
10. When the destination type is Inventory and when the item and/or the subinventory have locator control enabled, enter the stock Locator.
11. Optionally choose or change the Country of Origin.
   The Country of Origin is the country in which an item is manufactured. The Country of Origin defaults from the ASN if there is one. Otherwise, it defaults from the purchase order shipment.
12. Save your work.

► To enter receipt line detail information:
1. Navigate to the Details tabbed region.
2. Enter the Packing Slip number.
3. Enter the Supplier Lot number.
4. Enter the transaction Reason Code. See: Defining Transaction Reasons, Oracle Inventory User’s Guide.
5. Enter comments.
6. Select Receipt Exception if you want to enter a release exception for this receipt.

► To modify exchange rate information:
1. Navigate to the Currency tabbed region.
   You can update exchange rate information on the receipt only if you perform invoice–to–receipt matching (an Invoice Match Option of Receipt is chosen for the shipment in the purchase order Shipments window).
   These fields are blank and disabled if there is no exchange rate—that is, if the purchase order is not in a foreign currency.
2. Modify the Rate Date.
   If the Invoice Match Option on the purchase order shipment is Purchase Order, the default is the purchase order creation date, and you cannot change it. If the Invoice Match Option is Receipt, the
default is today’s date. You can change the Rate Date to one that better captures the cost of the item at the appropriate exchange rate. For example, if you are creating a receipt for an item that was actually received into inventory a few days earlier, you could enter the earlier date to apply the rate from that day. You can enter a different Rate Date for different receipt lines. For User rate types, changing the Rate Date does not affect the Rate.

Once you complete the receipt transaction, you cannot correct this exchange rate information later.

3. If the Rate Type is User and the profile option *PO: Allow Rate Override for User Rate Type* is set to Yes, optionally modify the Rate.

The Rate defaults from the purchase order.

**Note:** The Currency and the Rate Type also default from the purchase order, but cannot be changed.

► **To view order information:**

- Navigate to the Order Information tabbed region to view the following information for the shipment: Order Type, Number, Release number, order Line number, Shipment number, Supplier, Quantity Ordered, UOM, Due Date, Supplier Item number.

► **To view outside processing information:**

- Navigate to the Outside Processing tabbed region to view the Job or repetitive Schedule number, the repetitive schedule Line number, the Operation Sequence, and the Department number.

► **To view shipment (ASN) information:**

- Navigate to the Shipment Information tabbed region to view information from the Advance Shipment Notice (ASN), if one exists for the shipment. See: Advance Shipment Notices (ASNs): page 7 – 17.

► **To enter control number information:**

- For controlled items, you can select the Lot–Serial button to navigate to the Lot Number and Serial Number windows. See: Lot Control, Oracle Inventory User’s Guide. See: Serial Number Control, Oracle Inventory User’s Guide.
To cascade quantities across shipments and distributions:
- If you specified a Supplier and Item in the Find Expected Receipts window, and if Allow Cascade Transactions is selected in the Receiving Options window, choose the Cascade button. See: Cascading Receipts and Receiving Transactions: page 7 – 25.

To perform an express receipt:
- Select the Express button to perform an express receipt. See: Entering Express Receipts: page 7 – 27.

See Also

Entering Receipt Header Information: page 7 – 32
Cascading Receipts and Receiving Transactions: page 7 – 25
Express Receipts and Receiving Transactions: page 7 – 26
Entering Express Receipts: page 7 – 27
Defining Conversion Rate Types, Oracle Public Sector General Ledger User’s Guide
Return Material Authorizations (RMAs): page 7 – 14
Unordered Receipts

You can receive items from a supplier when you do not have a corresponding purchase order but want to receive the items so you can track them on the system while you wait for a buyer to decide which purchase order to use. You can receive returned items from a customer that were issued on a sales order in Order Management while you find out from the agent which return material authorization (RMA) to use.

First receive the items as Unordered Receipts in the Receipts window. You can create a new receipt or add to an existing receipt for the supplier or customer who shipped the unexpected items. Then perform a standard receipt for the unordered item shipment quantity.

Use the Find Unordered Receipts window to find the receipts or RMAs that are available for matching. Then use the Match Unordered Receipts window to specify the purchase order or RMA number, release, line, and shipment schedule to which you want to match the unordered receipt. Purchasing restricts the list of possible matching purchase orders/releases as follows:

- The purchase order must have the same supplier as the unordered receipt (when matching to RMAs, the RMA must have the same customer as the unordered receipt)
- The purchase order cannot be final closed or cancelled
- The purchase order must have at least one approved shipment in the same organization where you performed the unordered receipt (when matching to RMAs, the receiving organization on the RMA must be the same organization where you performed the unordered receipt)
- Except for receipts for one–time items, the item and the purchasing category on the purchase order (or the item on the RMA) must be the same as the item and purchasing category on the unordered receipt
- The purchase order must have a receipt routing of Standard Receipt, Inspection Required, or none (blank). If the purchase order shipment has a routing of Direct Delivery, the profile option RCV: Allow Routing Override must be set to Yes. This routing requirement also applies to RMAs, which use the routing specified in the Receiving Options window.

You can match only to approved shipments. If you cannot locate a valid matching document for your unordered receipt, you can modify and approve an existing purchase order/release or you can create and approve a new purchase order. You can then match to this new,
approved shipment. For RMAs, you can ask the agent to create one in Order Management, and then you can match to the new RMA or RMA line.

When you choose a shipment or RMA line, Purchasing performs receiving control checks of the quantity received tolerance and due date threshold.

If the RCV: Print Receipt Traveler profile option is set to Yes, receipt travelers are printed automatically when you match unordered receipts.

See Also

Entering Unordered Receipts: page 7 – 40
Matching Unordered Receipts: page 7 – 41
Profile Options in Purchasing: page 1 – 103
Return Material Authorizations (RMAs): page 7 – 14

Entering Unordered Receipts

To enter unordered receipts:


2. Choose the appropriate tabbed region. Choose the Supplier and Internal tabbed region to create an unordered receipt that will later be matched to a purchase order or release. Choose the Customer tabbed region to create an unordered receipt that will later be matched to a return material authorization (RMA). An RMA is created in Order Management to authorize a customer’s returning an item to your organization.

Attention: It is important to choose the correct tabbed region. For example, if the Customer tab is selected, later when you enter the receipt you will see only customer information in the lists of values.

3. Select the Unordered button to open the Receipt Header window.


6. Save your work.

See Also

Unordered Receipts: page 7 – 39
Matching Unordered Receipts: page 7 – 41
Return Material Authorizations (RMAs): page 7 – 14

Matching Unordered Receipts

Use this window to match unordered receipts to purchase order shipments.

To select unordered receipts for matching:

1. Navigate to the Find Unordered Receipts window by selecting Match Unordered Receipts on the menu.
2. Enter any of the following as selection criteria for the receipts you want to match to purchase orders or return material authorizations (RMAs): Receipt Number, Supplier or Customer name, Item, Category, Supplier Item Number, Receiver, Transaction Date, Receiving Location, Item Description.

3. Select the Find button. If your selection criteria produce any receipts for matching, the Item Number, Revision, Category, and Supplier or Customer are displayed in the Unordered Receipts block in the Match Unordered Receipts window. The Receipt Number, Quantity Received, Receiving UOM, Deliver To, Receiver, Item Description, Quantity Ordered, Order UOM, Destination, and Supplier Item Number for the current receipt are displayed in the lower part of the window.

▶ **To match unordered receipts:**

1. Navigate to the Match Unordered Receipts window by selecting the Find button in the Find Unordered Receipts window.
2. In the Order Information block in the Match Unordered Receipts window, enter a purchase order number in the Order Number field. For customer–returned items (a Customer is displayed rather than a Supplier), enter the return material authorization (RMA) number in the Order Number field. You can also choose List of Values from the tool bar to query the purchase order shipments or RMA lines available to match the current unordered receipt. This displays the Order Number, Release, Line, and Shipment for all shipments appropriate for matching. See: Unordered Receipts: page 7 – 39.

3. Save your work.

► To display receipt header information:

- Select the View Receipt Header on the Tools menu to display receipt header information.
To display receipt line information:

- Select the View Receipt Line on the Tools menu to display receipt line information.

To display purchase order information:

- If an Order Number is entered, select View Purchase Orders on the Tools menu to display purchase order header information.

See Also

Unordered Receipts: page 7 – 39
Return Material Authorizations (RMAs): page 7 – 14
Receiving Transactions

You record inspections, deliveries, and material movements within receiving and inspection by entering receiving transactions. These transactions provide a history that allows you to track an item from its source to its destination.

From the time of receipt, many transactions may be required to record the movement of an item through the receiving and inspection process. For example, after being received, an item can be transferred, inspected, and then delivered. To help you keep track of an item within receiving and inspection, these transactions are linked to each other. You can use the Receiving Transaction Summary (See: Finding Receiving Transactions (Summary): page 7 – 47) to view an item’s transaction history as if it were a family tree with parent and child transactions. A parent transaction can have one or more child transactions, but a child transaction has only one parent transaction. In the above example, the receipt transaction is the parent of the transfer transaction, while the transfer transaction is the child of the receipt transaction. Purchasing displays parent transaction information to help you determine the status of the item for which you are entering a transaction. For example, if you are about to transfer an item from Receiving Dock 1 to Inspection Area A, you should verify that the parent transaction’s location is Receiving Dock 1. Purchasing also displays the parent transaction’s unit of measure and available quantity. Available quantity is significant because you cannot enter a quantity for a current transaction that is greater than the parent transaction’s available quantity. For example, if you have received 10, you can inspect only up to a quantity of 10. Purchasing also displays the inspection result for a parent transaction if the given material has been accepted or rejected as part of an inspection. For delivery transactions, you must enter lot/serial/locator information for controlled items. See: Lot Control, Oracle Inventory User’s Guide. See: Serial Number Control, Oracle Inventory User’s Guide. See: Defining Stock Locators, Oracle Inventory User’s Guide.

Search Criteria

The first step in entering a new receiving transaction is to choose the receipt involved in this transaction. In the Find Receiving Transactions window (See: Finding Receiving Transactions: page 7 – 62), you can enter a variety of search criteria such as receipt number, current location, various item details, shipment number, purchase order number, and requisition number. Once you have specified search criteria, Purchasing displays the receipts (and previous transactions) in
the Receiving Transactions window for which you can process transactions. Information for receipts is based on information from parent transactions that meet your search criteria.

Express and Cascade Transactions

Purchasing offers two functions to facilitate transaction entry: Express and Cascade. In Express mode, you cannot modify default quantities, but you can record the delivery of many receipts at once. See: Express Receipts and Receiving Transactions: page 7–26. Cascade mode is applicable only for receipts for the same item. In cascade mode, Purchasing starts with the first receipt and enters deliveries for each subsequent receipt for this item until the cascade quantity is met. See: Cascading Receipts and Receiving Transactions: page 7–25.

Receiving Transactions Window

You enter all transfer and delivery transactions in the Receiving Transactions window. If you want to perform an inspection transaction, you can open the Inspections window to specify accepted and rejected quantities. See: Inspections: page 7–72.

Deliveries

Purchasing ensures that you can record deliveries quickly and easily. If you know the purchase order number (or shipment number for internal transactions or RMA number for customer returns to your organization), you can simply record the quantity delivered for the appropriate item. If you do not know the purchase order number, you can search using what you know, such as Receipt Number, Supplier, Packing Slip, Category, Item Number or Inspection Required. Purchasing automatically tracks the total quantity delivered to date for a particular receipt.

You can deliver only as many items as you receive. Purchasing lets you easily correct any delivery information.

Example

Both Jane Tims and Juliet Cunningham submit a requisition for 50 chairs each. The buyer places both requisitions on one purchase order line and indicates that the items require receipt. You receive the 100 chairs and record the receipt in the Receipts window. You see that 50 chairs are for Jane Tims in Building 1, and the other 50 chairs are for Juliet Cunningham in Building 2. In the Transactions window, you deliver 50 chairs to each requestor and record the quantity delivered.
Oracle Quality

There are two entry points to Oracle Quality from Purchasing if Oracle Quality is installed. Both entry points are in the Receiving Transactions window: the Enter Quality Results option in the Tools menu (or the Quality button on the menu bar) and the Inspect button. The Enter Quality Results menu option and button are available only if a quality collection plan or plans exist for the receiving transaction. When a mandatory collection plan exists for the receiving transaction, quality results data must be entered and saved before you can save your receiving transaction line information. (You optionally define a collection plan as mandatory when you create the collection plan in Oracle Quality. See also: Using Oracle Quality with Oracle Public Sector Purchasing, Oracle Quality User’s Guide and Purchasing Versus Quality Inspections, Oracle Quality User’s Guide.

You cannot perform data collection using Oracle Quality when you select the Express button in the Receiving Transactions window.

For more information on Oracle Quality and the Inspect button, see: Inspections: page 7 – 72.

See also: Entering Receiving Transactions: page 7 – 65.

Finding Receiving Transactions (Summary)

Use the Find Receiving Transactions (Summary) window to:

• Access the Receiving Headers Summary window.
• Access the Receiving Transaction Summary window.
• Perform purchase order inquiries at header and line levels.

Use the Supplier and Internal tabbed region to search for Purchasing documents. If Order Management is installed, use the Customer tabbed region to search for customer return material authorizations (RMAs).

To enter search criteria in the Supplier and Internal tabbed region:

2. Select the Supplier and Internal tabbed region.

3. Enter the Source Type: Internal, Supplier, or All.

4. Specify any of the following, optional search criteria:
   - Enter the Receipt Number.
   - For source type Supplier, enter the Purchase Order number. If you enter a purchase order number, you can also enter a Release (for blanket purchase agreements), Line, and/or Shipment (for purchase orders) number. For source type Internal, enter the Requisition Number. If you enter a requisition number, you can enter a requisition Line number.
   - In the second Shipment field, enter the shipment number of the Advance Shipment Notice (ASN). See: Advanced Shipment Notices (ASNs): page 7 – 17.
• Enter the Supplier. For Source Type Internal, this is the organization. For Source Type Supplier, this is the supplier name, and you can also enter the Supplier Site.

• Use the lower tabbed regions to further define the search. See: To further restrict the search, below.

5. Choose Results Headers (to go to the Receiving Headers Summary window) or Results Transactions (to go to the Receiving Transaction Summary window). Choose Find.

To enter search criteria in the Customer tabbed region:


   This region is used for finding items that a customer has returned to your organization. When an agent creates a sales order in Order Management and ships the item to the customer, you can find, create, and view receipt transactions if the customer returns the item. The receipt is created against a return material authorization (RMA) document, which the agent uses to authorize the return.

2. Specify any of the following, optional search criteria:

   • Line type, such as Return with Receipt of Goods, on the RMA. There are different return line types. Search by RMA line type if you want to see all RMA lines with that line type in your receiving organization.

   • Receipt Number

   • RMA Number, which corresponds to the Order Number field on the sales order

   • Line number from the RMA

   • Customer returning the item

   • Customer Number

   • Customer Item Number that the customer used to order the item

   • The lower tabbed regions. See: To further restrict the search, below.

3. Choose Results Headers (to go to the Receiving Headers Summary window) or Results Transactions (to go to the Receiving Transaction Summary window). Choose Find.
To further restrict the search:

- Specify any of the following, optional search criteria:
  - In the Item region, you can enter the following search criteria: Item, Rev, Category, Description, and Supplier Item.
  - In the Receipt Details region, you can limit the search by Packing Slip, Receiver, Freight Carrier, and Bill of Lading number.
  - In the Transaction Details region, you can limit the search by entering a range of Transaction Dates and Transaction Type.
  - In the Shipments region, you can enter the Container, Truck Number, or Bar Code Label indicated on an Advance Shipment Notice (ASN). See: Advance Shipment Notices (ASNs): page 7 – 17.

See Also

Using the Receiving Headers Summary Window: page 7 – 50
Using the Receiving Transaction Summary Window: page 7 – 51
Return Material Authorizations (RMAs): page 7 – 14

Using the Receiving Headers Summary Window

Use the Receiving Headers Summary folder window to:

- View receipt header information.
- Access the Receiving Transaction Summary window to display all receiving transactions for the current header line.

To display receiving headers information:

1. Navigate to the Receipt Header Details window.
2. Enter or choose information from one of the available fields to locate the record from the Find Receiving Transactions window.
3. Choose Results Headers, then choose Find.
4. Optionally choose Transactions to view all the records pertaining to the current search criteria.

See Also

Finding Receiving Transactions: page 7 – 62
Using the Receiving Transaction Summary Window: page 7 – 51
Customizing the Presentation of Data in a Folder, Oracle Applications User's Guide

Using the Receiving Transaction Summary Window

Use the Receipt Transaction Summary folder window to:

• View receiving transaction information.
• View order information backing the receipt.
• Access the Receipt Header Details window to view receipt header details.
To display receiving transactions navigate to the Receiving Transaction Summary window:

- In the Receipt Headers Summary window, select the Transactions button to open the Receipt Transaction Summary window and display all receiving transactions for the receipt on the current line. Alternatively, in the Find Receiving Transactions window, you can select Transactions in the Results region and then select the Find button to display all receiving transactions that meet the search criteria.

As installed, Purchasing displays the following information for each receiving transaction: Transaction Type, transaction Quantity, UOM, transaction Date, Item number, item Revision, Destination type, Location, Person, Subinventory, Locator, Receipt number, Source type, Order Number, order Release, order Line number, Order Shipment, Supplier, Country of Origin, Supplier Site, Order Quantity, Order UOM, Supplier Item Number, Supplier Lot Number, Packing Slip, Reason, Hazard class, UN Number,
Category, Job, Line, Assembly, Operation Sequence Department, and Receipt Exception.

In the lower part of the screen, Purchasing displays the following information for the purchase order, sales order (for internal requisitions), or return material authorization (RMA) behind the receipt: Order Type (Purchase Order, Inventory, or Return Material Authorization), Source, Item Description, Destination, Receiver Notes, Order number, Transaction Date, Hazard class, UN Number, and Routing.

► To view receipt header detail information:
  - Select the Header button to open the Receipt Header Details window. See: Using the Receipt Header Details Window: page 7 – 57.

► To view detail accounting lines:
  - Choose View Accounting from the Tools menu to open the View Receiving Accounting window. In this window, you can view the detail accounting lines for the transaction in the form of a balanced accounting entry (where debits equal credits). You can also choose to view the detail accounting as t-accounts. See: Viewing Accounting Lines: page 7 – 53.

See Also

Finding Receiving Transactions: page 7 – 62
Using the Receiving Headers Summary Window: page 7 – 50
Customizing the Presentation of Data in a Folder, Oracle Applications User’s Guide
Return Material Authorizations (RMAs): page 7 – 14

Viewing Accounting Lines

When you query a receiving transaction in Purchasing, you can choose to view the detail accounting lines for the queried transaction in the form of a balanced accounting entry (where debits equal credits). You can also choose to view the detail accounting as t-accounts. Use these features to see how a transaction will affect the account balances in your general ledger.
To view accounting lines:

1. Navigate to the Receipt Transaction Summary window.
2. Select the receiving transaction for which you want to view accounting lines.

You can view accounting lines for the following transaction types:

- Receive
- Deliver (to Expense)
- Return to Receiving (from Expense)
- Return to Supplier
- Correct (Receiving Transaction)
- Correct (Return to Receiving from Expense)
- Match

For each transaction type above, you can view accounting lines for the expense items (with a Destination Type of Expense) only if you accrue the expense items upon receipt. You can view accounting lines for inventory items (with a Destination Type of Inventory) from within Oracle Inventory only, not Purchasing. You can view accounting lines for shop floor items (with a Destination Type of Shop Floor) from within Oracle Work in Process only.

You cannot view accounting information for receiving transactions created against return material authorizations (RMAs).

3. Choose View Accounting from the Tools menu to open the View Receiving Accounting window.

See: View Accounting Windows, below.
4. (Optional) If your organization uses Multiple Reporting Currencies, choose the Alternate Currency button to view the accounting using an alternate currency. For example, if you are viewing the accounting in your primary functional currency (for example, BEF), you can switch to EUR (reporting functional currency).

From the poplist that appears after you choose the Alternate Currency button, choose the primary or reporting set of books whose transactions you want to view. The View Receiving Accounting window will change to reflect amounts in the appropriate currency for the chosen set of books.

5. (Optional) To view the accounting detail as t-accounts, choose the T-Accounts button.

View Accounting Windows

The first time you open the View Receiving Accounting window, the following information is displayed for the detailed accounting lines:

<table>
<thead>
<tr>
<th>Transaction Type</th>
<th>Entered Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>Currency Conversion Rate</td>
</tr>
<tr>
<td>Debit</td>
<td>Order Line</td>
</tr>
<tr>
<td>Credit</td>
<td>Order Shipment</td>
</tr>
<tr>
<td>Entered Currency</td>
<td>Order Distribution</td>
</tr>
<tr>
<td>Entered Debit</td>
<td>Accounting Date</td>
</tr>
</tbody>
</table>

Credit and Debit are the credit and debit entries from your general ledger journal entries, stated in your functional currency. Entered Credit and Entered Debit are the credits and debits in the purchase order currency.

When you select a detailed accounting line, the system displays the following information at the bottom of the View Receiving Accounting window:

<table>
<thead>
<tr>
<th>Item</th>
<th>Account Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revision</td>
<td>Order Type</td>
</tr>
<tr>
<td>Description</td>
<td>Order Num</td>
</tr>
<tr>
<td>UOM</td>
<td>Release Num</td>
</tr>
<tr>
<td>Quantity</td>
<td>Unit Price</td>
</tr>
</tbody>
</table>

Customizing the View Accounting Window

The View Receiving Accounting window is a *folder*. You can easily customize the information that is displayed in the window. See: Customizing the Presentation of Data in a Folder, *Oracle Applications User’s Guide*.

When customizing the View Receiving Accounting window, you can hide the columns that normally appear in the window and you can choose to display any additional columns that are available.

Following is a list of all the hidden columns that you can choose to display:

<table>
<thead>
<tr>
<th>Account Description</th>
<th>Receipt Num</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comments</td>
<td>Release Num</td>
</tr>
<tr>
<td>Currency Conversion Date</td>
<td>Subinventory</td>
</tr>
</tbody>
</table>
Using the Receipt Header Details Window

Use the Receipt Header Details window to:

- View detail information for receipt headers

► To navigate to the Receipt Header Details window:
  - In the Receiving Transaction Summary window, select the Header button to open the Receipt Header Details window.

  The following information is displayed: Receipt Number, Receipt Date, Shipment Number, Shipped Date, Packing Slip, Waybill/Airbill, Freight Carrier, Bill of Lading, Number of Containers, Received By, Supplier, and Comments.

► To return to the Receiving Transaction Summary window:
  - Select the Transactions button to return to the Receiving Transaction Summary window.

See Also

Using the Receiving Transaction Summary Window: page 7 – 51
Finding Transaction Status Information

Use the Find Transaction Status window to access the Transaction Status window. You can use this window to review pending transactions before they are processed by the Receiving Transaction Processor. Use the Supplier and Internal tabbed region to search against Purchasing documents. If Order Management is installed, use the Customer tabbed region to search against customer return material authorizations (RMAs).

To enter search criteria in the Supplier and Internal tabbed region:

1. Navigate to the Transaction Statuses window. The Find Transaction Statuses window appears.

2. Select the Supplier and Internal tabbed region.
3. Enter the Source Type: Internal, Supplier, or All.

4. Specify any of the following, optional search criteria:
   - Enter the Receipt Number.
   - For source type Supplier, enter the Purchase Order number. If you enter a purchase order number, you can also enter a Release (for blanket purchase agreements), Line, and/or Shipment (for purchase orders) number for the purchase order.
   - For source type Internal, enter the Requisition Number. If you enter a requisition number, you can enter a requisition Line number.
   - In the second Shipment field, enter the shipment number of the Advance Shipment Notice (ASN). See: Advanced Shipment Notices (ASNs): page 7 – 17.
   - Enter the Supplier. For Source Type Internal, this is the organization. For Source Type Supplier, this is the supplier name, and you can also enter the Supplier Site.
   - Enter the Current Location.
   - Use the lower tabbed regions to further restrict the search. See: To further restrict the search, below.

5. Select the Find to initiate the search and open the Transaction Status window.

► To enter search criteria in the Customer tabbed region:


   This region is used for finding the receipt transaction status for items that a customer has returned to your organization. When an agent creates a sales order in Order Management and ships the item to the customer, you can find, create, and view receipt transactions if the customer returns the item. The receipts are created against a return material authorization (RMA) document, which the agent uses to authorize the return.

2. Specify any of the following, optional search criteria:
   - Line type, such as Return with Receipt of Goods, on the RMA. There are different return line types. Search by RMA line type if you want to see all RMA lines with that line type in your receiving organization.
   - Receipt Number
- RMA Number, which corresponds to the Order Number field on the sales order
- Line number from the RMA
- Customer returning the item
- Customer Number
- Customer Item Number that the customer used to order the item
- The lower tabbed regions. See: To further restrict the search, below.

3. Select the Find to initiate the search and open the Transaction Status window.

➤ To further restrict the search:

- Specify any of the following, optional search criteria:
  - In the Item region, you can enter the following search criteria: Item, Rev, Category, Description, and Supplier Item.
  - In the Receipt Details region, you can limit the search by Packing Slip, Receiver, Freight Carrier, and Bill of Lading number.
  - In the Transaction Details region, you can limit the search by entering a range of Transaction Dates and Transaction Type.
  - In the Shipments region, you can enter the Container, Truck Number, or Bar Code Label indicated on an Advance Shipment Notice (ASN). See: Advance Shipment Notices (ASNs): page 7 – 17.

➤ To clear existing search criteria:

- Select the Clear button to clear any existing search criteria.

See Also

Viewing Transaction Status Information: page 7 – 61
Return Material Authorizations (RMAs): page 7 – 14
Viewing Transaction Status Information

To view transaction status information:

1. Navigate to the Transaction Statuses window.

2. Based upon the information you entered in the Find Transaction Statuses window, you see the following regions:
   - In the Transactions region you can view: Transaction Type, Processing Mode, Transaction Status, Item, Rev, Item Description, Destination Type, Location, Person, Subinventory, and Locator.
   - In the Details region you can view: Transaction Date, Reason, Comments, Packing Slip, Supplier Lot, Hazard, and UN Number.
• In the Order Information region you can view: Order Type, Order Num, Rel, Line, Shipment, Supplier, Qty Ordered, UOM, and Due Date.

• In the Order Processing region you can view: Job/Schedule, Line, Operation Sequence, and Department.

Finding Receiving Transactions

Use the Find Receiving Transactions window to find source documents for which you can enter receiving transactions. Use the Supplier and Internal tabbed region to search for Purchasing documents. If Order Management is installed, use the Customer tabbed region to search for customer return material authorizations (RMAs).

➢ To enter search criteria in the Supplier and Internal tabbed region:

1. Navigate to the Find Receiving Transactions window by selecting Receiving Transactions from the menu. Enter desired search criteria as described in the following steps.
2. Select the Supplier and Internal tabbed region.

3. Enter the Source Type: Internal, Supplier, or All.

4. Specify any of the following, optional search criteria:
   - Enter the Receipt Number.
   - For source type Supplier, enter the Purchase Order number. If you enter a purchase order number, you can also enter a Release (for blanket purchase agreements), Line, and/or Shipment (for purchase orders) number for the purchase order.
   - For source type Internal, enter the Requisition Number. If you enter a requisition number, you can enter a requisition Line number.
   - In the second Shipment field, enter the shipment number of the Advance Shipment Notice (ASN). See: Advanced Shipment Notices (ASNs): page 7 – 17.
• Enter the Supplier. For Source Type Internal, this is the organization. For Source Type Supplier, this is the supplier name, and you can also enter the Supplier Site.

• Use the lower tabbed regions to further restrict the search. See: To further restrict the search, below.

5. Select the Find button to initiate the search and open the Receiving Transactions window.

To enter search criteria in the Customer tabbed region:


This region is used for finding items that a customer has returned to your organization. When an agent creates a sales order in Order Management and ships the item to the customer, you can find and create receipts and delivery transactions if the customer returns the item. You create the transaction against a return material authorization (RMA) document, which the agent uses to authorize the return.

2. Specify any of the following, optional search criteria:
   • Line type, such as Return with Receipt of Goods, on the RMA. There are different return line types. Search by RMA line type if you want to see all RMA lines with that line type in your receiving organization.
   • Receipt Number
   • RMA Number, which corresponds to the Order Number field on the sales order
   • Line number from the RMA
   • Customer returning the item
   • Customer Number
   • Customer Item Number that the customer used to order the item
   • The lower tabbed regions. See: To further restrict the search, below.

3. Select the Find button to initiate the search and open the Receiving Transactions window.

To further restrict the search:

■ Specify any of the following, optional search criteria:
• In the Item region, you can enter the following search criteria: Item number, Revision number, Category, item Description, and Supplier Item Number.

• In the Receipt Details region, you can limit the search by Packing Slip, Receiver, Freight Carrier, and Bill of Lading number.

• In the Transaction Detail region, you can limit the search by entering a range of Transaction Dates.

• In the Shipments region, you can enter the Container, Truck Number, or Bar Code Label indicated on an Advance Shipment Notice (ASN). See: Advance Shipment Notices (ASNs): page 7 – 17.

To clear existing search criteria:

- Select the Clear button to clear any existing search criteria.

See Also

Receiving Transactions: page 7 – 45
Entering Receiving Transactions: page 7 – 65
Return Material Authorizations (RMAs): page 7 – 14

Entering Receiving Transactions

Use the Receiving Transactions window to enter receiving transactions.

Attention: If Oracle Quality is installed and at least one qualified collection plan exists, both the Enter Quality Results option on the Tools menu and the Quality button on the button bar are enabled. Only collection plans that have been associated with the Receiving Transaction are qualified. Please note that when mandatory collection plans are used, quality results data must be entered and saved before you can save your receiving transaction line information. Data collection for Inspection Transaction collection plans have no bearing on whether the Enter Quality Results Tools menu option and the Quality button are enabled. See: Using Oracle Quality with Oracle Public Sector Purchasing, Oracle Quality User’s Guide and Purchasing Versus Quality Inspections, Oracle Quality User’s Guide.
To enter receiving transaction line information:

1. Purchasing opens the Receiving Transactions window and displays all receipts that meet your search criteria when you select the Find button in the Find Receiving Transactions window. See: Finding Receiving Transactions: page 7 – 62.

In the lower part of the screen, Purchasing displays the following receipt information for the current line: Receipt Number, Order Number, the Supplier or internal organization shipping the item or the Customer returning the item, Parent Type, Description, Inspection, Destination, Current Location, Receiver Note, and Hazard Class.

2. Select the line for which you want to enter a receiving transaction.

If a material shortage exists for the item, a message appears. Displaying shortage messages for certain items is a setup option.
From the message, you can view details of where in your organization the demand exists for the item. You can then make the item available with a high priority. See: Viewing Potential Shortages, *Oracle Inventory User's Guide*. See: Material Shortage Alerts and Shortage Notifications, *Oracle Inventory User's Guide*.

3. Enter the transaction Quantity.
4. Enter the UOM of the transaction.
5. Enter the Destination Type: Expense, Inventory, Receiving, or Shop Floor. This determines the final destination of the received items.
6. Enter the Location for the transaction.
7. Enter the Person performing the transaction.
8. For Inventory transactions, enter the Subinventory.
9. If the item is under locator control, enter the stock Locator.
10. Save your work.

To enter receiving transaction detail information:

1. Navigate to the Details tabbed region.
2. Enter the Packing Slip number.
3. Enter the Transaction Date.
4. Enter the Supplier Lot number.
6. Enter the Hazard class. See: Defining Hazard Classes: page 1 – 70.
7. Enter Enter the UN Number. See: Defining UN Numbers: page 1 – 71.
8. Select Receipt Exception if you want to enter a release exception for this receipt.
9. If Oracle Quality is installed and one or more qualified collection plans exist, you can enter quality results by choosing the Quality button from the button bar or Enter Quality Results from the Tools menu. If mandatory collection plans exist, you must enter Quality results in the Enter Quality Results window before you can save the transaction line. See To enter quality results below. See also: Entering Quality Data for Receiving Transactions, *Oracle Quality User's Guide*.
10. Save your work.
To enter quality results:

- Choose the Quality button from the button bar or Enter Quality Results from the Tools menu.

The system selects the first—based on the alphanumeric order of collection plan names—of these collection plans in the Enter Quality Results window that appears.

You can only choose to enter quality results after entering all required receiving transaction line information. If the collection plan you select is mandatory, you must enter quality results data before you can save the transaction line. If the collection plan is a background data collection plan, it is not mandatory to enter data. The plan picks up data you enter in the receiving transaction line, according to the data it is configured to pick up. (A mandatory collection plan is optionally defined as mandatory when it was created in Oracle Quality. If it is mandatory and you don’t enter quality results data for it, you’ll receive a message when you save the receiving transaction line or move to the next line, telling you which collection plan was mandatory and requires quality results data.) See: Entering Quality Results Associated with Move Transactions, Oracle Quality User’s Guide.

To view order information:

- Navigate to the Order Information tabbed region to view the following information for the shipment: Order Type, Number, Release number, order Line number, Shipment number, Supplier, Quantity Ordered, UOM, Due Date, and Supplier Item number.

To view outside processing information:

- Navigate to the Outside Processing tabbed region to view the Job or repetitive Schedule number, the repetitive schedule Line number, the Operation Sequence, and the Department number.

To enter control number information:

- For controlled items, you can select the Lot–Serial button to navigate to the Lot Number and Serial Number windows. See: Lot Control, Oracle Inventory User’s Guide. See: Serial Number Control, Oracle Inventory User’s Guide.
To enter inspection information:
- Select the Inspect button to open the Inspection Details window.
  See: Inspecting Received Items: page 7 – 73.

To view exchange rate information:
- Navigate to the Currency tabbed region.
  This exchange rate information is based on the receipt. These fields are viewable only. See: Entering Receipt Lines: page 7 – 34.

See Also

Receiving Transactions: page 7 – 45
Cascading Receipts and Receiving Transactions: page 7 – 25
Express Receipts and Receiving Transactions: page 7 – 26
Return Material Authorizations (RMAs): page 7 – 14

Drilling Down to Purchasing from Oracle Public Sector General Ledger

From General Ledger, you can drill down to subledger details from the Account Inquiry, Journal Entry Inquiry, or Enter Journals windows for journals that have specific journal sources assigned to them. For example, if a journal source is Purchasing, you can drill down to the transaction details in Oracle Public Sector Purchasing.

For instructions on accessing Purchasing subledger details from General Ledger, see: Drilling Down to Subledger Detail, Oracle Public Sector General Ledger User’s Guide.
When you drill down from General Ledger, the Purchasing Receiving Accounting lines window will open. The first time you open this window, the following information will be displayed:

- **Transaction Date**
- **Receipt Num**
- **Transaction Type**
- **Supplier**
- **Debit**
- **Credit**
- **Entered Currency**
- **Entered Debit**
- **Entered Credit**
- **Currency Conversion Rate**
- **Order Line**
- **Order Shipment**
- **Order Distribution**
- **Accounting Date**

Credit and Debit are the credit and debit entries from your general ledger journal entries, stated in your functional currency. Entered Credit and Entered Debit are the credits and debits in the purchase order currency.

When you select a detailed accounting line, the system displays the following information at the bottom of the window:

- **Item**
- **Revision**
- **Description**
- **UOM**
- **Quantity**
- **Order Type**
- **Order Num**
- **Release Num**
- **Unit Price**

### Drilling Down Further

From the Purchasing Receiving Accounting lines window, you can drill down even further to view detail transactions or you can choose to view the underlying transaction accounting.

#### To drill down to detail transactions or to view transaction accounting:

1. From the Purchasing Receiving Accounting lines window, select a detail accounting line.
2. Choose the Show Transaction button to view detail transactions.
3. Choose the Show Transaction Accounting button to view the transaction accounting.

The View Receiving Accounting window opens. See: Viewing Accounting Lines: page 7 – 53.
Customizing the Drilldown Window

The drilldown window is a folder. You can easily customize the information that is displayed in the window, as described in the *Oracle Applications User’s Guide*.

When customizing the drilldown window, you can hide the columns that normally appear in the window and you can choose to display any additional columns that are available.

Following is a list of all the hidden columns that you can choose to display:

Account | Receipt Num
---|---
Account Description | Release Num
Comments | Revision
Currency Conversion Date | Subinventory
Currency Conversion Type | Supplier
Item | Supplier Num
Item Description | Supplier Site
Line Reference | Transaction Date
Order Num | Transferred to GL
Order Type | UOM
Price Override | Unit Price
Quantity

See Also

T-Accounts, *Oracle Public Sector General Ledger User’s Guide*
Inspections

Purchasing lets you inspect items you receive from suppliers or customers before internal delivery. You can inspect any item or set up certain items to require inspection.

The buyer can use the Note to Receiver field when preparing the purchase order to indicate where items that require inspection should go. The inspector or requestor can record the inspection results in the Inspections window. See: Inspecting Received Items: page 7 – 73.

You can review in the Receiving Transactions window what items require inspection, and the quantity accepted after inspection. If items require inspection, but the quantity accepted for the receipt is zero, then you know the items are still in inspection. Requestors can review the status of their requisitions in the Requisitions window. In the Purchase Orders window, you can view whether items require inspection and the quantities received and accepted.

If you choose to let requestors inspect items, they can enter the results of their inspections and then record the quantity delivered in the Receiving Transactions window.

If Oracle Quality is installed, you can inspect items through Quality, if the profile option QA: PO Inspection is set to Oracle Quality. (By default, it is set to Oracle Public Sector Purchasing.) See: Profile Options (in Oracle Quality), Oracle Quality User’s Guide. You cannot use Oracle Quality to inspect customer returns.

Example

At the receiving dock, you receive a shipment of 200 glass vials that require inspection. You record receipt and send the items to inspection. As the inspector of the 200 glass vials, you accept 195 and reject 5. You send the 5 rejected glass vials back to the supplier and deliver the 195 glass vials to the requestor.

In the Receiving Transactions window, Purchasing displays 195 in the Quantity Accepted field. This shows you how many items you can deliver to the requestors.

Returns of Rejected Goods

Purchasing lets you identify returns to a supplier or customer. There may be many receipt numbers associated with a particular purchase order or RMA number. If, after inspection, you find damaged goods and reject these, you can send the goods back to Receiving to return to the supplier or customer. The receiving agent records the quantity
Example

After inspecting 15 computer boards, you reject 5 boards and want to return them to the supplier. You can reference the purchase order on the receipt traveler that you attach to the board boxes. This number lets the receiving agent locate the receipt, and enter the quantity returned for this receipt.

Your organization has sold items to a customer that the customer has returned. Inspection shows that the items are not damaged as the customer claims. You return the items to the customer. You can reference the RMA on the receipt traveler that you attach to the items. This number lets the receiving agent locate the receipt, and enter the quantity returned for this receipt.

Your organization has sold items to a customer that the customer has returned. Inspection shows that the items are not damaged as the customer claims. You return the items to the customer. You can reference the RMA on the receipt traveler that you attach to the items. This number lets the receiving agent locate the receipt, and enter the quantity returned for this receipt.

Purchasing keeps an audit trail of returned items, so you can track returns to suppliers and customers and maintain accurate receipt information.

Inspecting Received Items

Use the Inspection Details window to enter inspection information for received items.

**Note:** If Oracle Quality is installed, you can inspect items through Quality, if the profile option QA: PO Inspection is set to Oracle Quality. (By default, it is set to Oracle Public Sector Purchasing.) See: Profile Options (in Oracle Quality), Oracle Quality User’s Guide.

**To enter inspection information:**

1. Navigate to the Inspection Details window by selecting the Inspect button in the Receiving Transactions window.

   **Note:** If you use Oracle Quality to inspect the items, when you choose the Inspect button the system selects the first—based on the alphanumeric order of inspection plan names—of the inspection plans to display. See: Entering Quality Results for Receiving Inspections, Oracle Quality User’s Guide.
2. Select Accept or Reject to describe the action you are taking in a line.

3. Enter the Quantity accepted or rejected. Purchasing displays the uninspected quantity as the default.

4. Enter the UOM for the inspected item.

5. Enter the Quality Code. See: Defining Quality Inspection Codes: page 1 – 77


7. Enter the Supplier Lot number.

8. Enter the inspection Date. The system date is the default.

9. Enter a Comment.

10. Save your work.

- To cancel inspection entry:
  - Select the Cancel button to cancel inspection entry and return to the Receiving Transactions window.
To save your work:

- Select OK to save your inspection entries and return to the Receiving Transactions window. You can use Inspection to return to this line for additional inspection entries until you have saved your work. After this time, the receipts will no longer be available for inspection.

If you want to enter more inspection results for a receipt after you’ve saved your work, requery the receiving transaction line using the Find Receiving Transactions window, and then enter more inspection results.
Returns

Purchasing allows you to perform returns to suppliers and returns to customers in the Receiving Returns window.

Use the Receiving Returns window to return delivered items to receiving and to return received or delivered externally sourced items to the supplier if the purchase order has neither been cancelled nor final closed. For controlled items, you must specify lot numbers, serial numbers or locators, as appropriate. If the Quality module is installed, you can enter quality information.

Use the Receiving Returns window to return items back to a customer. For example, a customer returns to your organization a part that does not work properly. You receive and fix the part, then return the part to the customer.

Note: You cannot enter returns for internal shipments.

When you are entering a return, the first step is to identify the purchase order or return material authorization (RMA) number and/or item that you want to return. You can choose among various selection criteria when searching for items in the Find Returns window. Use the Supplier and Internal tabbed region to search for receipts created against external suppliers. Use the Customer tabbed region to search for receipts created for customer returns to your organization.

You can return to the supplier or customer unordered receipts that have not been matched.

To return items to receiving, enter the return quantity in the Receiving Returns window. If you originally performed a direct receipt, you must specify a Return To receiving location. Otherwise, Purchasing routes all returned items to the receiving location from which you delivered them. For Inventory (but not Expense or Shop Floor) deliveries, you can update the Return From subinventory. You can also optionally specify additional return information such as Reason Code and RMA number (the number your supplier issues to you to track your return to the supplier).

To return items to the supplier or customer, enter the return quantity in the Receiving Returns window. Purchasing provides the source supplier or customer for the items. For Inventory (but not Expense or Shop Floor) deliveries, you can update the Return From subinventory. You can also optionally specify additional return information such as Reason Code and RMA number (the number your supplier issues to you to track your return to the supplier). When you return items to the supplier or customer, Purchasing creates both a Return To Receiving
and a Return To Supplier transaction. Purchasing also reopens the associated purchase order for the return quantity by reducing the original receipt quantity. For customer returns, if you return the item back to the customer, Purchasing updates the RMA to reflect the returned quantity.

You can automatically generate debit memos for Return To Supplier transactions once an invoice has been created. When you create the return make sure the Create Debit Memo option is selected. To enable this functionality, enable the supplier site as a Pay Site (or indicate an Alternate Pay Site) and select Create Debit Memo from RTS Transaction in the Supplier Sites window. See: Debit Memos: page 7 – 15.

See Also

Finding Returns: page 7 – 77
Entering Returns: page 7 – 80

Finding Returns

Use the Find Returns window to find source documents for which you can enter returns. Use the Supplier and Internal tabbed region to search for Purchasing documents. If Order Management is installed, use the Customer tabbed region to search for customer return material authorizations (RMAs).

Note: You cannot enter returns for internal shipments (that is, shipments with a Source Type of Internal).

To find source documents for Supplier and Internal returns:

1. Navigate to the Find Returns window by selecting Returns from the menu. The following steps describe ways in which you can specify search criteria to limit the search for source documents. All of the search criteria are optional.
2. Select the Supplier and Internal tabbed region.
3. Select a receipt Source Type of Supplier for the search:
   The Requisition Number and requisition Line number fields are disabled.
   You cannot do returns for documents with a Source Type of Internal.
4. Specify any of the following, optional search criteria:
   - Enter the Receipt Number.
   - Enter the Purchase Order number. To be available, a purchase order must have at least one approved shipment for which the ship-to organization is the same as the current active organization. If you enter a purchase order number, you can also enter a Release number, Line number, and/or Shipment number for the purchase order. The Release field is applicable only when you have entered a purchase order number associated with a planned purchase order or a blanket purchase agreement. The list of values in the Release field includes all releases for the specified purchase order that are not final closed.
   - Enter the Supplier name. You can also enter the Supplier Site.
   - Enter the Current Location.
   - Use the lower tabbed regions to further restrict the search. See: To further restrict the search, below.

5. Select the Find button to initiate the search and display the selected source documents in the Receiving Returns window.

To find source documents for Customer returns:

1. Select the Customer tabbed region in the Find Returns window. This region is used for finding items that a customer has returned to your organization. When a agent creates a sales order in Order Management and ships the item to the customer, you can find and create receipts if the customer returns the item. The receipts are created against a return material authorization (RMA) document, which the agent uses to authorize the return. You can then return the item (for example, after it has been repaired) back to the customer, using the Receiving Returns window.

2. Specify any of the following, optional search criteria:
   - Line type, such as Return with Receipt of Goods, on the RMA. There are different return line types. Search by RMA line type if you want to see all RMA lines with that line type in your receiving organization.
   - Receipt Number
   - RMA Number, which corresponds to the Order Number field on the sales order
   - Line number from the RMA
- Customer returning the item
- Customer Number
- Customer Item Number that the customer used to order the item
- The lower tabbed regions. See: **To further restrict the search**, below.

3. Select the Find button to initiate the search and display the selected source documents in the Receiving Returns window.

**To further restrict the search:**

- Specify any of the following, optional search criteria:

  - In the Item region, you can enter the following search criteria: Item number, Revision number, Category, Item Description, and Supplier Item Number. Since the supplier item number is generally the best way you can identify purchase order lines when your supplier does not reference your purchase order number on its shipping documents, you should provide a supplier item number on your purchase order lines.

  - In the Date Ranges region, you can select Due Today to limit the search to receipt lines due on the current date. Otherwise, you can enter a Due By date range. These dates correspond to the Promised Date (or Need–by Date if there is no Promised Date) on the Purchasing document or to the Promise Date (or Request Date if there is no Promise Date) on the RMA.

  - In the Transaction Detail region, you can enter a Transaction Date range.

  - In the Shipment region, you can enter the Container, Truck Number, or Bar Code Label indicated on an Advance Shipment Notice (ASN) or Advance Shipment and Billing Notice (ASBN). See: Advance Shipment Notices (ASNs): page 7–17.

**To remove existing search criteria**

- Select the Clear button in any of the source document search windows to remove existing search criteria.

**See Also**

- Returns: page 7–76
- Entering Returns: page 7–80
Entering Returns

Use the Receiving Returns window to enter returns against receipts, deliveries, transfers, acceptances, and rejections.

**Note:** You cannot enter returns for internal shipments (that is, shipments with a Source Type of Internal).

**To enter returns:**


The Receiving Returns window appears. In the Transactions tabbed region of this window, Purchasing displays transactions that meet your search criteria. The Order Information tabbed region displays information about the purchase order against which the receipt was made. The Outside Processing tabbed region displays pertinent information for outside processing receipts.
2. Enter the return Quantity. Purchasing selects the line and places a check in the line selector checkbox.

For Return To Supplier transactions, Purchasing reopens the associated purchase order for the return quantity by reducing the original receipt quantity. For customer returns that you return back to the customer, Purchasing updates the RMA to reflect the returned quantity.

3. Enter the Return Unit of Measure. Purchasing displays the unit of measure conversion.

4. Note that Create Debit Memo is selected if Create Debit Memo from RTS Transaction is selected for this supplier site in the Supplier Sites window.

If Create Debit Memos is selected, Purchasing creates a debit memo for the returned quantity once you save the transaction. You can then view or edit the debit memo in Payables. Debit memo creation is enabled for Return to Supplier transactions only. If you do not
want a debit memo to be created automatically for this transaction, deselect this option.

If you enter a return and an invoice has not yet been created for the original receipt, or if Payment on Receipt already accounted for the return using the Aging Period functionality, Purchasing does not create a debit memo. (See: Payment on Receipt: page 9–66.) You will receive a notification in the Notifications Summary window for any debit memo that could not be created. Purchasing does not create debit memos for returns against unordered receipts. Tax or freight is not included in the debit memo amount.

5. In the Transactions tabbed region, you can update the RMA Number used by your supplier for returns to that supplier. For Inventory (but not Expense or Shop Floor) deliveries, you can update the Return From subinventory.

Attention: The RMA number in the Customer tabbed region of the Find Returns window is the number you and your customer use to track returns to you. The RMA number here is the number you and your supplier use to track your return to the supplier.

6. In the Details tabbed region, you can enter a Reason Code, update the Transaction Date, and view whether a Receipt Exception has been placed. See: Defining Quality Inspection Codes: page 1–77.

7. Save your work.

To enter control number information:

- For controlled items, you can select the Lot & Serial button to navigate to the Lot Number and Serial Number windows. See: Lot Control, Oracle Inventory User’s Guide. See: Serial Number Control, Oracle Inventory User’s Guide.

To move to the Quality module:

- If the Quality module is installed and if a quality plan applies to the transaction, you can navigate to the Quality module by selecting the Quality button.
See Also

Returns: page 7 – 76
Corrections: page 7 – 84
Finding Returns: page 7 – 77
Return Material Authorizations (RMAs): page 7 – 14
Debit Memos: page 7 – 15
Corrections

Use the Receiving Corrections window to modify receiving transactions to correct errors. You can correct any receiving transaction except another Correction transaction. For controlled items, you must specify lot and/or serial numbers, as appropriate. For corrections to customer return transactions, the return material authorization (RMA) in Order Management is updated to reflect the new quantity.

When you are entering a correction, the first step is using the Find Corrections window to identify the transaction that you want to correct. See: Finding Corrections: page 7 – 85.

You can enter positive or negative corrections to any receiving transaction. Purchasing allows you to enter correction quantities greater than the outstanding receiving supply quantity.

You can also make corrections to quantities that you return to a supplier. For example, you receive 100 items, and you use a Return To Supplier transaction to return 10 items to the supplier because they were damaged. Then you realize that only 9 items were damaged. This means that, in the Corrections window, you must enter a correction of −1 for the Return to Supplier transaction. Purchasing moves the item from the supplier to your receiving supply. If you additionally want to move the item from your receiving supply to your on-hand supply, you must additionally enter a correction of −1 for the Return to Receiving transaction.

The table below illustrates this process, using a correction of −1 and +1 as examples.

<table>
<thead>
<tr>
<th>In the Corrections window, in the Quantity field, when you enter …</th>
<th>Purchasing …</th>
</tr>
</thead>
<tbody>
<tr>
<td>−1 for the Return to Supplier transaction</td>
<td>Returns the item to receiving supply:</td>
</tr>
<tr>
<td></td>
<td>Supplier —&gt; Receiving</td>
</tr>
<tr>
<td>−1 for the Return to Receiving transaction</td>
<td>Returns the item to on-hand supply:</td>
</tr>
<tr>
<td></td>
<td>Supplier —&gt; Receiving —&gt; Supply</td>
</tr>
<tr>
<td>+1 for the Return to Receiving transaction</td>
<td>Returns the item to receiving supply:</td>
</tr>
<tr>
<td></td>
<td>Receiving —&gt; Supply</td>
</tr>
<tr>
<td>+1 for the Return to Supplier transaction</td>
<td>Returns the item to the supplier:</td>
</tr>
<tr>
<td></td>
<td>Supplier —&gt; Receiving —&gt; Supply</td>
</tr>
</tbody>
</table>
When you make corrections to a receipt created against an Advance Shipment Notice (ASN), your purchasing, in–transit, and inventory supplies are automatically updated. See: ASNs and Supply: page 7 – 21.

**See Also**

Returns: page 7 – 76
Entering Returns: page 7 – 80
Finding Corrections: page 7 – 85
Entering Corrections: page 7 – 88
Return Material Authorizations (RMAs): page 7 – 14

**Finding Corrections**

Use the Find Corrections window to find source documents for which you can enter corrections. Use the Supplier and Internal tabbed region to search for Purchasing documents. If Order Management is installed, use the Customer tabbed region to search for customer return material authorizations (RMAs).

Note: You can also make corrections to quantities that you return to a supplier. For instructions, see: Corrections: page 7 – 84.

To find Supplier and Internal source documents for corrections:

1. Navigate to the Find Corrections window by selecting Corrections from the menu. The following steps describe ways in which you can specify search criteria to limit the search for source documents. All of the search criteria are optional.
2. Select the Supplier and Internal tabbed region.
3. Select the receipt Source Type for the search:

   Internal: An internal order generated from an internal requisition and sourced from your inventory, or an intransit inventory shipment. If you choose this option, the following fields are disabled: PO Number, Release, Line, Shipment, and Include Closed POs.
Supplier: A purchase order sourced from a supplier. If you choose this option, the following fields are disabled: Requisition Number, requisition Line number, and Shipment Number.

All: Internal– and supplier–sourced documents.

4. Specify any of the following, optional search criteria:

- Enter the Receipt Number.

- For source type Supplier, enter the Purchase Order number. To be available, a purchase order must have at least one approved shipment for which the ship–to organization is the same as the current active organization. If you enter a PO Number, you can also enter a Release number, Line number, and/or Shipment number for the purchase order. The Release field is applicable only when you have entered a purchase order number associated with a planned purchase order or a blanket purchase agreement. The list of values in the Release field includes all releases for the specified PO that are not final closed.

- For source type Internal, enter the Requisition Number. If you enter a requisition number, you can also enter a Line number. Available lines are those with the same ship–to organization as the current active organization.

- In the second Shipment field, enter the shipment number of the Advance Shipment Notice (ASN). See: Advanced Shipment Notices (ASNs): page 7 – 17.

- Enter the Supplier. For Source Type Internal, this is the organization. For Source Type Supplier, this is the supplier name, and you can also enter the Supplier Site.

- Enter the Current Location.

- Use the lower tabbed regions to further restrict the search. See: To further restrict the search, below.

5. Select the Find button to initiate the search and display the selected source documents in the Receiving Corrections window.

To find Customer returns for corrections:

1. Select the Customer tabbed region in the Find Corrections window.

This region is used for finding items that a customer has returned to your organization. When a agent creates a sales order in Order Management and ships the item to the customer, you can find and create receipts and corrections if the customer returns the item. The
2. Specify any of the following, optional search criteria:

- Line type, such as Return with Receipt of Goods, on the RMA. There are different return line types. Search by RMA line type if you want to see all RMA lines with that line type in your receiving organization.
- Receipt Number
- RMA Number, which corresponds to the Order Number field on the sales order
- Line number from the RMA
- Customer returning the item
- Customer Number
- Customer Item Number that the customer used to order the item
- The lower tabbed regions. See: To further restrict the search, below.

3. Select the Find button to initiate the search and display the selected source documents in the Receiving Corrections window.

To further restrict the search:

- Specify any of the following, optional search criteria:

  - In the Item region, you can enter the following search criteria: Item number, Revision number, Category, item Description, and Supplier Item number. Since the supplier item number is generally the best way you can identify purchase order lines when your supplier does not reference your purchase order number on its shipping documents, you should provide a supplier item number on your purchase order lines.
  - In the Receipt Details region, you can restrict the search by Packing Slip number, Receiver, Freight Carrier, or Bill of Lading.
  - In the Transaction Detail region, you can enter a Transaction Date range.
  - In the Shipment region, you can enter the Container, Truck Number, or Bar Code Label indicated on an Advance Shipment Notice (ASN). See: Advance Shipment Notices (ASNs): page 7 – 17.
To remove existing search criteria

- Select the Clear button in any of the source document search windows to remove existing search criteria.

See Also

Corrections: page 7 – 84
Entering Corrections: page 7 – 88
Return Material Authorizations (RMAs): page 7 – 14

Entering Corrections

Use the Receiving Corrections window to record correction transactions against prior receiving transactions.

Prerequisites

- Receiving transactions against which to make corrections. See: Receiving Transactions: page 7 – 45.

To select transactions for corrections:

1. Navigate to the Find Corrections window by selecting Corrections on the menu. See: Finding Corrections: page 7 – 85.
2. Enter any of the following as additional selection criteria for the transactions you want to correct: Source Type, Receipt Number, PO Number, Release, Line, Shipment, Requisition Number, Line, Shipment Number, Source, and Source Site. In the tabbed regions in the lower part of the screen, you can specify additional selection criteria for the item, receipt detail, transaction details, project, and outside processing.
3. Select the Find button to move to the Receiving Corrections window.

To enter corrections:

1. Navigate to the Receiving Corrections window by selecting the Find button in the Find Corrections window. See: Finding Corrections: page 7 – 85.
If your selection criteria produce any transactions, the Transaction Type (Expense, Inventory, Shop Floor, or Receiving), Quantity, Destination, Item, Revision, and Item Description are displayed in the Transactions tabbed region. The Order Type, Order number, the Supplier or internal organization shipping the item or the Customer returning the item, and the Due Date are displayed in the Order Information region. The Item Description, Hazard Class, Destination, UN Number, Receiver Note, and Routing for the current line are displayed in the lower part of the window.

2. Use the remaining tabbed regions to display additional information about the transactions.
   - In the Transactions region, you can view the following: Destination Type, Item number, Revision number, Item Description, Location, Person, Subinventory, and stock Locator.
   - In the Details region, you can view the following: Packing Slip number, Supplier Lot number, Reason code, Hazard class, and UN Number.
• In the Currency region, you can view exchange rate information if the purchase order was created in a foreign currency.

• In the Order Information region, you can view the following: Order Type, Order number, Release number, Line number, Shipment number, Supplier or Customer, Quantity Ordered, UOM, and Due Date.

• In the Outside Processing region, you can view the Job/Schedule, Line, Operation Sequence, and Department.

3. In the Quantity field, enter the positive or negative correction quantity for the current line. Making any entry on the line automatically selects the line. You can also use the line selector to select and deselect lines.

   You can also make corrections to quantities that you return to a supplier. For instructions, see: Corrections: page 7 – 84.

4. Save your work.

   ▶ To enter control number information:

   ■ For controlled items, you can select the Lot & Serial button to navigate to the Lot Number and Serial Number windows. See: Lot Control, Oracle Inventory User’s Guide. See: Serial Number Control, Oracle Inventory User’s Guide.

   ▶ To move to the Quality module:

   ■ If the Quality module is installed and if a quality plan applies to the transaction, you can navigate to the Quality module by selecting the Quality button. See: Using Oracle Quality with Oracle Public Sector Purchasing, Oracle Quality User’s Guide

   ▶ To view exchange rate information:

   ■ Navigate to the Currency tabbed region.

   This exchange rate information is based on the receipt. See: Entering Receipt Lines: page 7 – 34. These fields are viewable only. Any correction you make is made using the exchange rate information you see here.
See Also

Returns: page 7 – 76
Entering Returns: page 7 – 80
Corrections: page 7 – 84
Finding Corrections: page 7 – 85
Return Material Authorizations (RMAs): page 7 – 14
Finding Intransit Shipments

Use the Find Intransit Shipments window to find source documents for which you can enter shipment information. You can also use the Find Intransit Shipments window to view validated Advance Shipment Notices (ASNs).

To find source documents for intransit shipments:

1. Navigate to the Find Intransit Shipments window by selecting Manage Shipments in the Navigator.

2. Specify any of the following, optional search criteria:
   - Select a Source Type of Internal, Supplier, or All. ‘Internal’ searches for inventory intransit shipment information. ‘Supplier’ searches for external suppliers’ shipment information, such as ASNs. ‘All’ searches for both internal and external shipment information.
   - For a Supplier source type, enter the Purchase Order Number. If you enter a purchase order number, you can also enter a Release number, Line number, and/or Shipment number for the purchase order.
   - For an Internal source type, enter the Requisition Number. If you enter a requisition number, you can also enter a Line number.
   - In the second Shipment field, enter the shipment number of the Advance Shipment Notice (ASN). See: Advanced Shipment Notices (ASNs): page 7 – 17.
   - Enter the Supplier. For Source Type Internal, this is the organization. For Source Type Supplier, this is the supplier name, and you can also enter the Supplier Site.
   - Enter the Receiving Location.
   - Use the tabbed regions to further restrict the search.
     - In the Item region, you can enter the following search criteria: Item number, Revision number, Category, and item Description.
     - In the Date Ranges region, you can select Due Today to limit the search to receipt lines due on the current date. Otherwise, you can enter a Due By date range.
– In the Receipt Details region, you can restrict the search by Packing Slip number, Receiver, Freight Carrier, or Bill of Lading.

– In the Shipment region, you can enter the Container, Truck Number, or Bar Code Label indicated on an ASN.

3. Select the Find button to initiate the search and display the selected source documents in the Manage Shipments window.

▶ To remove existing search criteria

■ Select the Clear button in any of the source document search windows to remove existing search criteria.

See Also

Managing Shipments: page 7 – 93
Advanced Shipment Notices (ASNs): page 7 – 17

Managing Shipments

Use the Manage Shipments window to view and update inventory intransit shipment information. Also use the Manage Shipments window to view or cancel Advance Shipment Notices (ASNs).

You can view a wide variety of information about an inventory intransit shipment, including internal requisition information backing the intransit shipment. You can enter or change selected header information including packing slip and bill of lading numbers, the expected receipt date, the freight carrier, the ship-to location, and the number of containers. You can also enter or change some information at the shipment line level: the packing slip number, receipt routing, and reason code.

For an ASN, you can also view a wide variety of information, including truck and container numbers. You can also cancel an ASN by choosing Cancel from the Tools menu. (The supplier can also send a Cancellation ASN.) See: Advanced Shipment Notices (ASNs): page 7 – 17.

Prerequisites

❑ Before you can use this window to view and update inventory intransit shipment information, you must transfer material between
organizations that use intransit inventory. See: Transferring Between Organizations, Oracle Inventory User’s Guide.

► To select shipments:

1. Select Manage Shipments on the menu to navigate to the Find Intransit Shipments window. See: Finding Intransit Shipments: page 7 – 92.

2. Enter any of the following as selection criteria: Purchase Order or Requisition number, requisition Line number, ASN Shipment number, Supplier, Supplier Site and Receiving Location. In the tabbed regions in the lower part of the screen, you can specify additional selection criteria for the item, and date ranges.

3. Select the Find button to move to the Manage Shipments window.

► To manage shipments:

1. Navigate to the Manage Shipments window. In this window Purchasing displays Shipment Header information for the first shipment that meets the criteria. Use the down arrow on your keyboard to display information for subsequent shipments that meet your search criteria.

   Note: For inventory intransit shipments, you will see Shipment Lines information only when you view the shipments from within the receiving organization.
2. You can maintain data only in the following Shipment Header fields: Expected Receipt Date, Bill of Lading, Freight Carrier, Packing Slip, Ship-to Location, Number of Containers, and Comments.

3. In the Shipment Lines region, only the item Revision, stock Locator, Packing Slip, Comments, Transaction Reason Code, and Receipt Routing are maintainable.

4. Save your work.

▶ To cancel an Advanced Shipment Notice:

- Select the shipment line and choose Cancel from the Tools menu.
Control Numbers

Purchasing uses *three* types of control numbers: lot numbers, serial numbers, and stock locators.

Purchasing provides you the ability to assign lot and serial numbers to items as they are transacted to their destinations by direct receipt or delivery and to track these items by lot and serial number.

You assign lot and serial numbers to items as you are entering individual deliveries or performing direct receipts. You can access the Lot and Serial Numbers window directly from each transaction that you enter, and assign lot and/or serial numbers to each unit of the item in the transaction.

Stock Locators are used for deliveries to inventory destinations. Purchasing uses the locator controls defined in Inventory.

Entering Lot Numbers

In the Lot Numbers window, there may or may not be existing lot number information corresponding to your transaction. If such information exists, you can pick the lot number that you want to assign to your receiving transaction. If you are entering a supplier receipt, you have to enter a lot number that has not been previously assigned to an item. If you are entering any other type of receiving transaction, you have to pick a lot number from the list of lot numbers that are valid for the given item. For example, if you enter an intransit receipt or a transfer, you cannot assign a completely new lot number, but rather you must choose the appropriate lot number that has been previously assigned to the item.

Based on the lot number you enter, Purchasing automatically enters the expiration date if you defined shelf life control for the item and specified a number of shelf life days. If you defined the item by specifying lot control with shelf life control that is user definable, then you can enter an expiration date that is the same as or later than the current date. Purchasing displays the quantity of each lot number that is available for assignment, and you cannot assign more units to a lot number than are available.

Entering Serial Numbers

For deliveries, you must enter serial number information if the item is under serial number control. Purchasing displays a running total of the number of units that have been assigned to serial numbers.
There may be existing serial number information corresponding to the item in this transaction. For example, if you were receiving an item from intransit and the sending organization had assigned serial numbers to the item at the time of shipment, these numbers would be available in a list of values. On the other hand, if you were entering a supplier receipt, you would have to assign new serial numbers.

You enter serial numbers by assigning a range of numbers for each item or lot quantity. Purchasing then assigns each unit of the item or lot quantity to a serial number within your selected range. When you enter a beginning serial number, Purchasing automatically defaults the ending serial number to the same value. You can override this default if you want to specify a range of serial numbers rather than just one serial number.

### Lot and Serial Numbers in Inter–organization Transfers

When you perform an inter–organization transfer, the source and destination organization may have different lot/serial controls. Purchasing handles this situation as follows:

- When the source organization uses controls and the destination organization does not, the control numbers are recorded as being issued from the source organization. Lot/serial transactions are recorded for the destination organization.

- When the source organization does not use controls and the destination organization does, the transaction is processed normally.

- When both source and destination organizations use controls, the control numbers are recorded as being issued from the source organization. These control numbers are tracked to insure that the same control numbers that were shipped are the ones that are received. When items are returned from inventory to receiving or to the supplier, only the control numbers originally recorded for the delivery transaction can be used.

### Entering Stock Locators

When you enter a receiving transaction that will result in a delivery to an inventory destination, and when locator control is required for the organization/item/subinventory, Purchasing displays the Stock Locator flexfield during entry of the destination information in the Receipts, Receiving Transactions, Returns, and Corrections windows.
See Also

Lot Control, *Oracle Inventory User’s Guide*
Serial Number Control, *Oracle Inventory User’s Guide*
Defining Stock Locators, *Oracle Inventory User’s Guide*
Receiving Reports

Purchasing provides summary and detail reports on your receipts. You can produce receiving transaction reports by item, supplier, purchase order number, receipt number and/or receiving date range.

Purchasing also provides summary and detail reports to help you analyze your suppliers’ performance. You can produce supplier quality reports by buyer, supplier, and item. You can use the receiving inspection register to review your inspections by receipt.

Use the Submit Requests window to run Receiving reports. See: Submitting a Request, Oracle Applications System Administrator’s Guide.

Printing an Expected Receipts Report

Purchasing helps you organize your work by generating an Expected Receipts Report using the setup options you specify. You can use setup options such as Ship–To Location, Promised Dates, Category, and Item Number. For example, you can review all expected computer equipment receipts, or you can review all receipts for the next two days.

Example You want to print an Expected Receipts Report for the current week. You are primarily interested in the furniture receipts for the week, so you specify a date range for the current week and the purchasing category Furniture in the Category field. See: Expected Receipts Report: page 9 – 39.

Using Receipt Travelers

Purchasing makes it easy to route goods in your organization by letting you print a receipt traveler that you can place on the goods. You can use the Submit Requests window to print as many travelers as you need. See: Submitting a Request, Oracle Applications System Administrator’s Guide.

Example You receive 5 personal computers and you want to show the final destination for each. In the Submit Requests window, you can generate a Receipt Traveler for each box. See: Receipt Traveler: page 9 – 124.

Attention: If the RCV: Print Receipt Traveler profile option is set to Yes, Purchasing automatically prints the Receipt Traveler when you perform a standard or direct receipt and when you match unordered receipts.
See Also

Profile Options in Purchasing: page 1 – 103
Submitting a Request, Oracle Applications System Administrator’s Guide
Overview of Receipt Accounting

Inventory Accruals

Inventory and Purchasing provide you with visibility and control of your accrued liabilities for inventory items. Purchasing automatically records the accrued liability for your inventory items at the time of receipt as perpetual accruals. This transaction is automatically recorded in your general ledger at the time of receipt (unless you specified otherwise when setting up periodic costing). The inventory expense is recorded at delivery if you use Standard Delivery and at receipt if you use Direct Delivery. You have options to determine whether Purchasing and Inventory reverse encumbrances. The option used is dependent on how you compare encumbrance to budget balances in inventory for your organization.

Expense Period–End Accruals

Purchasing optionally accrues uninvoiced receipts of non-inventory items when you close a period. You can choose which uninvoiced receipts are accrued. At period end, Purchasing automatically creates a balanced journal entry for each uninvoiced receipt, which will automatically be reversed at the beginning of the next period. Purchasing creates a reversing entry for the encumbered amount corresponding to the expense while creating an accrual entry for the receipt in the general ledger if you are using encumbrance at your site.

Attention: When using Cash Basis Accounting, you will not normally run the Receipt Accrual – Period End process. However, you must use the Purchasing Options window and set the Accrue Expense Items flag to Period End. See: Receipt Accruals – Period End Process: page 9 – 119.

Expense Perpetual Accruals

Purchasing optionally provides you with the ability to accrue non-inventory liabilities at the time of receipt. If you choose at time of receipt, Purchasing records an accrued liability and charges your receiving inspection account for each non-inventory receipt. This transaction is automatically recorded in your general ledger at the time of receipt. Purchasing creates a reversing entry for the encumbered amount at the time you deliver the goods to the final inventory or expense destination. When an invoice is matched to a purchase order and approved in Payables, it is not necessary for Payables to record an
encumbrance for the expense. However, Payables will record an encumbrance for invoice price variance or exchange rate variance, if the variance exists.

**Purchase Price Variance**

Purchasing and Inventory provide you with visibility and control of your purchase price variances. When you use standard costing, Purchasing and Inventory automatically calculate and record purchase price variances as you receive your inventory items into inventory. If desired, Purchasing and Inventory automatically calculate and record purchase price variances for your outside processing receipts into work in process. You can use the Purchase Price Variance Report to review the accuracy of the standard costs for your purchased items and services. See: Purchase Price Variance Report: page 9 – 100.

**Invoice Price Variance (IPV) and Exchange Rate Variance**

Purchasing and Inventory provide you with visibility and control of your invoice price and exchange rate variances. When Payables accounts for invoices, it automatically creates accounting entries for price and exchange rate variances. You can use the Invoice Price Variance Report to review the accuracy of your purchase order prices. See: Invoice Price Variance Report: page 9 – 47.

**Foreign Currencies**

If the purchase order uses a foreign currency, Purchasing converts the purchase order price to the inventory functional currency. Inventory uses this converted value for receiving accounting purposes. Payables allows you to record exchange rate invoice variance to separate accounts.

**Nonrecoverable Tax**

If you use nonrecoverable or partially recoverable tax, the nonrecoverable tax amount is included in your period-end or perpetual accrual accounting. Nonrecoverable tax is also included in the invoice and exchange rate variances. Changing the exchange rate on the receipt may affect the nonrecoverable tax amount. See: Tax Defaults in Purchasing: page 4 – 135. See: Entering Receipt Lines: page 7 – 34.
Accrual Reconciliation and Write–Off

Purchasing and Inventory provide you with a complete reconciliation report of all of your accounts payable accrual transactions. You can quickly identify any mismatched items and write–off accrual transactions from your receiving, accounts payable, inventory, and work in process subledgers. See: Reconciling A/P Accrual Accounts Balance: page 7 – 117.

Expense Accrual Reporting

You can use the Uninvoiced Receipts Report to analyze your uninvoiced receipt liabilities for non–inventory purchases when you create accrual entries for them in your general ledger. You can control the amount of expenses you accrue by supplier and purchasing category. You can obtain detailed information about the purchase order receipts you accrued during your accounting period. See: Uninvoiced Receipts Report: page 9 – 170.

Period–End Accruals and Encumbrance

For period–end accruals when using encumbrances, Purchasing creates a reversing entry for the encumbered amount corresponding to an expense while creating an accrual entry for the receipt in the general ledger. When you accrue your receipts, Purchasing ensures that you do not duplicate entries for the period. At the beginning of the following period, you reverse the accrual entry for the expense and recreate the encumbrance entry you reversed in the previous period using General Ledger. See: Receipt Accruals – Period End Process: page 9 – 119.

If you use nonrecoverable or partially recoverable tax, the nonrecoverable tax amount is included in your encumbrances.

Inventory and Perpetual Expense Accruals and Encumbrance

For perpetual expense and inventory accruals, Purchasing and Inventory create a reversing entry for the encumbered amount at the time you deliver the goods to the final inventory or expense destination. When an invoice is matched to a purchase order and approved in Payables, it is not necessary for Payables to record an encumbrance for the expense. However, Payables will record an encumbrance for invoice price variance or exchange rate variance, if the variance exists.
If you use nonrecoverable or partially recoverable tax, the nonrecoverable tax amount is included in your encumbrances.

See Also

Setting Up Inventory Accruals: page 7 – 104
Accrual Process for Perpetual Accruals: page 7 – 109
Monitoring Price variances: page 7 – 117
Reconciling A/P Accrual Accounts Balance: page 7 – 117
Accrual Process for Period End Accruals: page 7 – 119
Identifying Journal Entry Batches in General Ledger: page 7 – 124

Setting Up Inventory Accruals

If you use Purchasing and Inventory together, use the following steps to implement perpetual accruals for inventory item purchases:

Defining Expense Accrual Option

You need to specify whether you want to use period-end or perpetual accruals for your expense destination receipts. Set the Accrue Expense Items option in the Purchasing Options window to At Receipt if you want to accrue your expense receipts perpetually. Specify Period End if you want to accrue your receipts at period end. See: Defining Accrual Options: page 1 – 48.

Defining Default Accounts

You need to define the following accounts before entering transactions in Purchasing and Inventory.

Receiving Account

Enter the general ledger account to record the current balance of material in receiving and inspection.

Use the Define Organization or Receiving Options window to set up this account. See: Defining Receiving Options: page 1 – 58.
Inventory A/P Accrual Account

Enter a general ledger account to accumulate the inventory accounts payable accrual for this organization. This is the account used by Purchasing to accrue your payable liability when you receive your items. This account represents your uninvoiced receipts and is usually part of your accounts payable liabilities in the balance sheet. Payables relieves this account when the invoice is matched and approved. See: Defining Other Account Parameters, *Oracle Inventory User’s Guide*.

Expense A/P Accrual Account

Enter a general ledger account to accumulate the expense accounts payable accrual for your purchasing installation. This is the account used by Purchasing to accrue your accounts payable liability for expense items at time of receipt when your Expense Accrual Option is At Receipt, or at period-end when your Expense Accrual Option is Period End. This account represents your uninvoiced receipts and is usually part of your accounts payable liabilities in the balance sheet.

Use the Purchasing Options window to set up this account. See: Defining Accrual Options: page 1 – 48.

Purchase Price Variance Account

Enter a general ledger account to accumulate purchase price variance for this organization. The purchase price variance account is usually an expense account. This is the variance that you record at the time you receive an item in inventory, and is the difference between the purchase order cost and an item’s standard cost. Purchasing calculates purchase price variance as:

\[ PPV = \frac{(PO \ unit \ price - standard \ unit \ cost)}{quantity \ received} \times \]

Note: Cost Management includes nonrecoverable tax with the PO unit price if tax and a recovery rate are set up for the item. If the purchase order is in a foreign currency, the purchase price variance is calculated using the exchange rate from the receipt if the Invoice Match Option in the purchase order Shipments window is Receipt and from the purchase order if the Invoice Match Option is Purchase Order.

Purchase price variance is not used for average costing.

Use the Organization Parameters window to set this account. See: Inter–Organization Transfer Accounts, *Oracle Inventory User’s Guide*. 
**Invoice Price Variance Account**

Enter a general ledger account to accumulate invoice price variance for this organization. This is usually an expense account.

Invoice price variance is the difference between the purchase order price for an inventory item and the actual invoice price multiplied by the quantity invoiced: Invoice Quantity x (Invoice Price – PO Price) x Invoice Exchange Rate. Purchasing uses this account on the PO distribution when the requisition or purchase order is created. When Payables creates accounting entries for the invoice, it uses the invoice price variance account from the purchase order to record invoice price variance entries.

Use the Organization Parameters window to set this account. See: Inter–Organization Transfer Accounts, *Oracle Inventory User’s Guide*.

**Exchange Rate Gain or Loss Accounts**

Enter general ledger accounts to accumulate exchange rate gains or losses for this organization. These are usually expense accounts.

Exchange rate gain or loss accounts are used to record the difference between the exchange rate used for the purchase order and the exchange rate used for the invoice. The exchange rate is taken from the purchase order only if the Invoice Match Option in the purchase order Shipments window is Purchase Order. If the Invoice Match Option is Receipt, the exchange rate is taken from the receipt.

These accounts can also be used in Payables to record gains and losses at payment time and clearing time.

Use the Accounting region of the Financials Options window to set up these accounts. See: Defining Financials Options, *Oracle Public Sector Payables User’s Guide*.

**Using the Account Generator to build accounts**

In addition to the standard default accounts listed above, you can use the Account Generator to redefine a set of rules that allow Purchasing to build the following accounts for each purchase order distribution automatically:

- Charge Account
- Budget Account
- Accrual Account
- Invoice Variance Account
Setting Up Your Period End Date

For the accrual report to balance to the general ledger, the last transaction (or accounting) date of each fiscal period has to be the same in Inventory, Purchasing, and Payables.

Creating Purchase Orders for Inventory Items

Some of the purchase orders you create are for items you want to move directly into your inventories. Some other purchase orders are for items you simply want to expense.

Purchasing ensures that you charge all inventory items you purchase to the Inventory A/P accrual account for the receiving organization. Each time you enter an item on a purchase order, Purchasing defaults the Inventory A/P accrual account corresponding to the organization you are ordering this item for on your distributions. You cannot override the distribution accrual account.

Purchasing also ensures that you use the correct invoice price variance account for the receiving organization. Each time you enter an item on a purchase order, Purchasing defaults the invoice price variance account corresponding to the organization you are ordering this item for on your distributions. You cannot override the distribution invoice variance account.

Inventory Funds Checking Methods

One way in which you can budget and funds check the inventory purchases you make for a given subinventory is by setting up an encumbrance (i.e. budget) account for the subinventory, and not reversing the encumbrance on receipt/delivery. This way, the encumbrance will accumulate as an actual and can be compared with the account budget for actual purchases to budget analysis. You cannot use the subinventory asset account in the funds available calculation \( FA = Budget - Enc - Actuals \), because this account will only contain the current value of the subinventory or the net of received and delivered items currently in the subinventory, and will not track to the accumulated purchases for the subinventory. To use this method of funds checking, you must set the Reverse Encumbrance flag in the Organization Parameters window to No. See: Inter–Organization Transfer Accounts, Oracle Inventory User’s Guide.
An alternative method of funds checking inventory purchases is by setting up a summary account and performing a funds check against that summary account. To provide an accurate picture of the funds available, you need to take into account:

- The outstanding commitments/obligations for inventory and expense purchases
- The current value of inventory
- The amounts purchased for inventory, but already issued out of the subinventory to either expense accounts within the “department” (summary account) or to other “departments” (other summary accounts)

Funds available = Budget

less amount on open commitments/obligations (either for inventory, or for expense accounts within the department)

less current inventory value

less value of material ‘expensed’ to accounts with the department

The following example illustrates some of the transactions and their impact on the funds available:

<table>
<thead>
<tr>
<th>Summary (Department X)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subinventory Asset Account ‘x1’</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Summary (Department Y)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subinventory Asset Account ‘y1’</td>
</tr>
</tbody>
</table>

- Requisitions and purchase orders for expense purchases will create commitments/obligations against expense accounts (xA, xB, xC), decreasing the funds available for Department X
- Receipt and Delivery of expense purchase orders (or invoicing for period end accruals) will create the actuals to the department expense accounts (xA, xB, xC), and reverse the encumbrance in those same accounts
Requisitions and purchase orders for inventory purchases will create commitments/obligations against the encumbrance account (x2, y2). We use a different account than the asset account to ensure that we do not distort the value in the asset account (which should only contain the value of the material in the given subinventory). The requisitions and purchase orders will decrease funds available for the department.

Receipt and Delivery of inventory purchase orders will reverse the encumbrance against x2/y2 and create actuals to the subinventory asset account, having no net impact against funds available.

Inventory issues from x1 to xA, xB, or xC will not be funds checked and will have no net impact on funds available.

Inventory issues from x1 to Department Y expense accounts (yA, yB, or yC) will increase Department X’s funds available and decrease Department Y’s funds available.

Inventory transfers from x1 to y1 will also increase Department X’s funds available, and decrease Department Y’s funds available.

Note: If you want to use encumbrances and budgetary control for inventory transfers or issues to expense accounts, you can use internal requisitions.

If you are using Period End Accruals, the encumbrance reversals are created with the accrual entries for the month end. You should reverse these journal entries in the beginning of the next period.

If you are accruing At Receipt, the delivery transaction reverses the encumbrances (and creates the debit to the charge account and the credit to the receiving/inspection account).

Note: A direct receipt in purchasing performs both the debit and credit transactions.

Accrual Process for Perpetual Accruals

Use perpetual accruals for expense purchases when you want to record un invoiced receipt liabilities immediately upon receipt of goods. Receipts for inventory purchases are always accrued upon receipt. Other key points of perpetual accruals include:

- Actual journal entries are created for the amount of the receipt liabilities, debiting the receiving inspection account and crediting the expense accrual liability account.
• Accrual journal entries are created when you enter receiving transactions. Purchasing creates adjusting journal entries if you correct your receiving transactions.

• Perpetual accrual entries do not need to be reversed at the start of a new accounting period.

• If you are using encumbrance accounting, purchase order encumbrance is relieved when the goods are delivered to their final destination, either by a delivery or a direct receipt.

  **Attention:** If you accrue expense purchases at the time of receipt, you must reconcile the entries in the A/P accrual accounts. In addition, if you also receive inventory, you need to use the Receiving Value By Destination Account Report to break out your receiving/inspection value by asset and expense.

**Purchase Order Receipt to Receiving Inspection**

When you receive material from a supplier into receiving inspection, Purchasing uses the quantity received; the purchase order price; nonrecoverable tax if any; and, if the purchase order is in a foreign currency, exchange rate, to update the accrual and the receiving inspection account. (If the purchase order is in a foreign currency, the exchange rate comes from the receipt if the Invoice Match Option in the purchase order Shipments window is Receipt and from the purchase order if the Invoice Match Option is Purchase Order.) The accounting entries for inventory receipts are:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receiving Inspection account @ PO price</td>
<td>XX</td>
<td></td>
</tr>
<tr>
<td>Inventory A/P Accrual account @ PO price</td>
<td></td>
<td>XX</td>
</tr>
</tbody>
</table>

The accounting entries for expense destination receipts are:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receiving Inspection account @ PO price</td>
<td>XX</td>
<td></td>
</tr>
<tr>
<td>Expense A/P Accrual account @ PO price</td>
<td></td>
<td>XX</td>
</tr>
</tbody>
</table>

  **Attention:** For clarity, the accounting entries in this section refer to the Inventory A/P Accrual Account and the Expense A/P Accrual Account. These are the accounts you typically use as your purchase order distribution accrual accounts for inventory and expense destinations. You can use the Account Generator to define the business rules you want Purchasing to
use to determine the actual purchase order distribution accrual account. Purchasing uses the accrual account on the purchase order distribution for all receipt accrual entries.

For expense destinations, the PO distribution accrual account is the Expense A/P Accrual Account set in the Purchasing Options window. For inventory destinations, the purchase order distribution accrual account is the Inventory A/P accrual account for the receiving organization. The accrual accounts are the liability accounts that offset the material and expense charge accounts. They represent all inventory and expense receipts not matched in Payables.

**Delivery From Receiving Inspection to Inventory**

With the Receiving Transactions window, you can move material from receiving inspection to inventory. See: Receiving Transactions: page 7 – 45.

For standard costing, when you enter a delivery transaction in Purchasing and move the items to inventory, Inventory generates a purchase price variance transaction. Inventory books this transaction as a period expense for the current accounting period. If the standard cost is greater than the purchase order price, then the purchase price variance is favorable. Inventory records the expense as a credit (negative expense). If the standard cost is less than the purchase order price, then the variance is unfavorable. Inventory records the expense as a debit (positive expense).

For average costing, when you enter a delivery transaction in Purchasing, the system recalculates the average cost for the inventory organization with the incoming purchase order value. You do not have any purchase price variance for average costing.

For periodic costing, when you enter a delivery transaction in Purchasing, the system recalculates the periodic average cost for the period based on the periodic acquisition cost. See: Processing Periodic Acquisition Costs, *Oracle Cost Management User’s Guide*.

Inventory uses the quantity; the purchase order price; nonrecoverable tax if any; and, if the purchase order is in a foreign currency, exchange rate, of the delivered item to update the receiving inspection account and the quantity. Inventory uses the standard cost of the delivered item to update the subinventory balances. The standard cost is in the functional currency. The accounting entries are:
## Delivery From Receiving Inspection to Expense Destinations

With the Receiving Transactions window, you can also move material from receiving inspection to expense destinations. See: Receiving Transactions: page 7–45.

When you enter a delivery transaction in Purchasing and move the items to an expense location, Purchasing uses the transaction quantity; the purchase order price; nonrecoverable tax if any; and, if the purchase order is in a foreign currency, exchange rate, of the delivered item to update the receiving inspection and expense charge account. (If the purchase order is in a foreign currency, the exchange rate comes from the receipt if the Invoice Match Option in the purchase order Shipments window is Receipt and from the purchase order if the Invoice Match Option is Purchase Order.) The accounting entries are:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subinventory accounts @ standard cost</td>
<td>XX</td>
<td></td>
</tr>
<tr>
<td>Receiving Inspection account @ PO price</td>
<td>XX</td>
<td></td>
</tr>
<tr>
<td>Debit/Credit Purchase Price Variance</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO distribution charge accounts @ PO price</td>
<td>XX</td>
<td></td>
</tr>
<tr>
<td>Receiving Inspection account @ PO price</td>
<td>XX</td>
<td></td>
</tr>
<tr>
<td>Encumbrance @ PO price</td>
<td>XX</td>
<td></td>
</tr>
<tr>
<td>Reserve for Encumbrance @ PO price</td>
<td>XX</td>
<td></td>
</tr>
</tbody>
</table>

## Purchase Order Receipt to Inventory

You can use the Receipts window to receive material directly from a supplier to inventory. See: Managing Receipts: page 7–23. Please note that this section addresses inventory destinations only.

When you receive material from a supplier directly to inventory, Purchasing and Inventory perform the receipt and delivery transactions in one step.

Purchasing uses the quantity received; the purchase order price; nonrecoverable tax if any; and, if the purchase order is in a foreign currency, exchange rate, to update the accrual and the receiving inspection account. (If the purchase order is in a foreign currency, the exchange rate comes from the receipt if the Invoice Match Option in the purchase order Shipments window is Receipt and from the purchase order if the Invoice Match Option is Purchase Order.) The accounting entries are:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO distribution charge accounts @ PO price</td>
<td>XX</td>
<td></td>
</tr>
<tr>
<td>Receiving Inspection account @ PO price</td>
<td>XX</td>
<td></td>
</tr>
<tr>
<td>Encumbrance @ PO price</td>
<td>XX</td>
<td></td>
</tr>
<tr>
<td>Reserve for Encumbrance @ PO price</td>
<td>XX</td>
<td></td>
</tr>
</tbody>
</table>
order if the Invoice Match Option is Purchase Order.) The accounting entries are:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receiving Inspection account @ PO price XX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inventory A/P Accrual account @ PO price</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Inventory uses the quantity and standard cost of the received item to update the receiving inspection and subinventory balances. The accounting entries are:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subinventory accounts @ standard cost XX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Receiving Inspection account @ PO price XX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Debit/Credit Purchase Price Variance</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If you use average costing, the system recalculates the average cost at receipt, and you do not have any purchase price variance.

The Inventory A/P Accrual account is the liability account that offsets the material accounts, and represents all inventory receipts not matched in Payables.

**Purchase Order Receipt to Expense Destinations**

You can use the Receipts window to receive material directly from a supplier to the expense destination. See: Managing Receipts: page 7 – 23. Please note this section addresses expense destinations only.

When you receive material from a supplier directly to expense destinations, Purchasing performs the receipt and delivery transactions in one step.

Purchasing uses the quantity received; the purchase order price; nonrecoverable tax if any; and, if the purchase order is in a foreign currency, exchange rate, to update the accrual and the receiving inspection account. (If the purchase order is in a foreign currency, the exchange rate comes from the receipt if the Invoice Match Option in the purchase order Shipments window is Receipt and from the purchase order if the Invoice Match Option is Purchase Order.) The accounting entries are:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receiving Inspection account @ PO price XX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expense A/P Accrual account @ PO price</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Purchasing uses the quantity received; the purchase order price; nonrecoverable tax if any; and, if the purchase order is in a foreign currency, exchange rate, to update the receiving inspection and expense accounts. (If the purchase order is in a foreign currency, the exchange rate comes from the receipt if the Invoice Match Option in the purchase order Shipments window is Receipt and from the purchase order if the Invoice Match Option is Purchase Order.) The accounting entries are:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO distribution charge accounts @ PO price</td>
<td>XX</td>
<td>XX</td>
</tr>
<tr>
<td>Receiving Inspection account @ PO price</td>
<td>XX</td>
<td></td>
</tr>
<tr>
<td>Reserve for Encumbrance @ PO price</td>
<td>XX</td>
<td></td>
</tr>
<tr>
<td>Encumbrance @ PO price</td>
<td></td>
<td>XX</td>
</tr>
</tbody>
</table>

**Match, Approve, and Create Accounting Entries for an Invoice**

In Payables, when you are matching an invoice to a purchasing document, if the Invoice Match Option in the purchase order Shipments window is Purchase Order, then you match each invoice distribution to a purchase order distribution. If the Invoice Match Option is Receipt, then you match each invoice distribution to a purchase order distribution for the received transaction. You can set up Payables to ensure that you pay only for the quantity you received.

If you accrue at receipt, and if you use encumbrance, then during the Payables Approval process, Payables makes any encumbrance adjustments for price and exchange rate variances, including nonrecoverable tax, between the invoice and the purchase order (or receipt, if the invoice is matched to a receipt). Also, if your encumbrance types are different for purchase orders and invoices, then Payables creates appropriate entries. For details on how Payables calculates variance amounts, see: Invoice Variances (*Oracle Public Sector Payables User’s Guide*). To see the accounts that Payables uses to record the variances, see: Variance Accounts (*Oracle Public Sector Payables User’s Guide*).

When Payables records the accounting entries for the invoice, any variances are recorded as actuals and the encumbrances are reversed. Payables then credits the Liability account for the full amount of the invoice, and debits the accrual account for the remaining amount (invoice price – invoice price variance – exchange rate variance).

**Attention:** Normally, you charge the original expense account for any invoice price variances. Purchasing uses the Account Generator to set your purchase order distribution variance account to be the same as your purchase order charge account.
If you want to record your invoice price variances to a separate account, use the Account Generator to define the business rules you use to determine the correct invoice price variance account.

**Invoice Exchange Rate Variances**

Note that Purchasing uses the functional currency for your set of books in all receiving accounting entries. Purchasing converts foreign currency purchase order prices to the functional currency using the currency conversion rate from the purchase order. Payables uses the currency and the conversion rate of the invoice when it creates accounting entries for the invoice. If the conversion rate differs between the purchase order (or the receipt, if the Invoice Match Option in the purchase order Shipments window is Receipt) and the invoice, then the conversion difference is recorded as an Exchange Rate Variance. Separate accounts are defined for exchange rate gains and losses, which record currency gains and losses within Payables, for example, between invoice time and payment time.

**Return to Supplier From Receiving**

You use the Returns window to return material from receiving inspection or from inventory to a supplier. If you use receiving inspection and you have delivered the material into inventory, you must first return the goods to receiving before you can return to your supplier. For a return from inspection, Purchasing decreases the receiving inspection balance, and reverses the accounting entry created for the original receipt. See: Returns: page 7 – 76.

**Return To Supplier From Inventory or Expense Destinations**

When you do not use receiving inspection, the return to supplier transaction updates the same accounts as the direct receipt to the inventory or expense destination, with reverse transaction amounts.

**Period–End Reconciliation Tasks**

When you use perpetual inventories, you should balance your inventory accounts to your inventory value report. You should also review the general ledger journal transactions for inventory Purchase Price Variance and A/P Accrual Accounts. You should look for potential problems or errors such as transactions charged to the wrong account and duplicate transactions. This process is called the
Inventory Reconciliation and Period Close Review. Purchasing and Inventory provide you with a set of reports you can use to reconcile your transactions with your general ledger account balances quickly and easily.

**Period–End Checklist**

Before reconciling your transactions with your general ledger account balances, you should perform the following steps:

1. Identify the period you want to reconcile and close.
2. Enter all receiving transactions for goods and services you received during the period.
3. Enter and match all invoices you received during the period for your receipt accrual entries.
4. Perform the GL Transfer in Inventory and reconcile your Inventory Purchase Price Variance and A/P Accrual entries.
5. Identify the period–end balances of the following accounts in your general ledger:
   - Purchase Price Variance
   - A/P Accrual Account
   - Inventory Accounts
6. Reconcile the balance of the Purchase Price Variance account using the Purchase Price Variance Report (detailed below).
7. Identify the Invoice Price Variances amount and Accrued Receipts amounts in the A/P Accrual Account (detailed below).
8. Manually remove the Invoice Price Variance amount from the A/P Accrual Account using your general ledger (prior release IPV only).
10. Perform period–end accruals steps for purchasing and one–time items as described in the following section.
12. Close your Inventory period after review. See: Maintaining Accounting Periods, Oracle Inventory User’s Guide.

13. Close your General Ledger period after review.

**Monitoring Price Variances**

Purchasing provides you with reports you can use to review the purchase and invoice price variances. You should run the Purchase Price Variance Report weekly to review the accuracy of standard costs and purchase price variance. The Purchase Price Variance Report is also a good indicator of buyer’s performance. However, you should make sure to include in your analysis any fluctuation of market prices beyond buyer control or changes in standard costs. At the end of a period, you should run the Purchase Price Variance Report for the entire period. See: Purchase Price Variance Report: page 9 – 100.

You should run the Invoice Price Variance Report monthly to review the accuracy of standard costs and purchase order prices. The Invoice Price Variance Report is also a good indicator of buyers’ performance. However, you should make sure to include in your analysis any pricing fluctuations beyond buyer control.

You can sort the Invoice Price Variance Report by Category or Supplier, and you can restrict your report to invoice price variances for a specific Category, Supplier, or Period Name.

At the end of a period, you should run the Invoice Price Variance Report for this period. Identify the invoice price variance for all purchase orders charged to the Inventory A/P Accrual Account and compare it with the balance of the Invoice Price Variance account in your general ledger. See: Invoice Price Variance Report: page 9 – 47.

**Reconciling A/P Accrual Accounts Balance**

At any given time, the balance of the A/P accrual accounts can account for the following transactions:

- Uninvoiced Receipts
- Over-invoiced Receipts
- Errors (Invoices or inventory transactions charged to this Account by mistake)
You need to analyze the balance of the A/P accrual accounts, distinguish accrued receipts from invoice price variances, and identify errors.

Analyzing the A/P Accrual Account Balance

You need to monitor potential problems with purchasing and receiving activities that can affect the accuracy of your A/P accrual accounts. You can use the Accrual Reconciliation Report to identify the following problems in receiving, purchasing, inventory, work in process, or accounts payable transactions:

- Quantities differ between receipts and invoices
- Incorrect purchase order or invoice unit prices (previous releases only)
- Discrepancies in supplier billing
- Invoice matched to the wrong purchase order distribution (or for receipt–matched invoices, the wrong purchase order distribution for the receipt transaction)
- Received against the wrong purchase order or order line
- Miscellaneous inventory or work in process transactions that do not belong to the accrual accounts
- Payables entries for tax and freight that do not belong to the accrual accounts

Using the Accrual Reconciliation Report

Use the Accrual Reconciliation Report to analyze the balance of the Accounts Payable (A/P) accrual accounts. To submit this report, you must have Purchasing and Payables installed. You can accrue both expense and inventory purchases as you receive them. When this happens, you temporarily record an accounts payable liability to your Expense or Inventory A/P accrual accounts. When Payables creates accounting entries for the invoice, Payables clears the A/P accrual accounts and records the liability from the supplier site. See: Accrual Reconciliation Report: page 9 – 5.

Typically, you run this report at month end. After you have entered your receipt transactions and matched your invoices, you can run the Accrual Reconciliation Report for any transaction date range and identify any differences between your PO Receipts and A/P Invoices. This report also displays any miscellaneous transactions recorded in
error to your accrual accounts. These miscellaneous transactions or transactions unrelated to purchase order receipts may be from Payables, Inventory, or Work in Process (depending on your installation). After you have researched the reported accrual balances, you can use the Accrual Write–Off form to indicate which entries you wish to remove and write off from this report. And, after you have written off these entries, you can use the Accrual Write–Off Report as supporting detail for your manual journal entry.

Resolving Quantity Differences

The Accrual Reconciliation Report lets you easily identify quantity differences (i.e., when the quantity received for a purchase order shipment is smaller than the quantity invoiced). Such differences leave residual balances that never clear from the A/P accrual accounts. You should investigate the cause of these differences and take corrective actions before closing your period.

Common causes of quantity differences include late inventory receipts, incorrect receipt quantities, and supplier overbilling. To correct late receipts, ensure that receivers enter all receipts into inventory. To correct receipt quantities, enter receipt corrections. To correct overbilling errors, follow your standard procedure for supplier debit memos to clear the difference.

Resolving Price Differences

The Accrual Reconciliation Report lets you determine how much you should have paid and whether the PO or invoice is correct. Such differences leave residual balances that never clear from the A/P accrual accounts. You should investigate the cause of these differences and take corrective actions before closing your period.

Accrual Process for Period–End Accruals

Key points for accruing expense purchases at period–end include:

- You record the total un invoiced receipt liabilities accrued during the accounting period.

- Actual journal entries are created for the amount of the receipt liabilities, debiting the charge account and crediting the PO distribution accrual account (normally the Expense A/P Accrual Account defined in the Define Purchasing Options form).
• You reverse accrual journal entries manually at the start of the new accounting period.

• If you are using encumbrance accounting, purchase order encumbrance is relieved when the invoice(s) matched to the purchase order are posted to the general ledger.

Receiving Transactions


Receivings Accruals–Period End

Use the Receipt Accruals – Period End process to create period-end accruals for your uninvoiced receipts for expense distributions. Purchasing creates an accrual journal entry in your general ledger for each uninvoiced receipt you choose using this form. If you use encumbrance or budgetary control, Purchasing reverses your encumbrance entry when creating the corresponding accrual entry.

Purchasing never accrues an uninvoiced receipt twice. Each time you create accrual entries for a specific uninvoiced receipt, Purchasing marks this receipt as accrued and ignores it the next time you run the Receipt Accrual – Period–End process. Purchasing creates accrual entries only up to the quantity the supplier did not invoice for partially invoiced receipts.

Purchasing creates the following accounting entries for each distribution you accrue using the Receipt Accruals – Period–End process:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO charge account @ Uninvoiced Quantity x PO unit Price</td>
<td>XX</td>
<td></td>
</tr>
<tr>
<td>Expense A/P accrual account @ Uninvoiced Quantity x PO price</td>
<td>XX</td>
<td></td>
</tr>
</tbody>
</table>

As soon as you open the next period, Purchasing reverses the accrual entries using the following accounting entries:
Match, Approve, and Create Accounting Entries for an Invoice

When you enter an invoice in Payables, you match each invoice distribution to a specific purchase order distribution or to a purchase order distribution for a receipt transaction in Purchasing. You can set up Payables to ensure that you pay only for the quantity you received. If you accrue your un invoiced receipts at period-end, Payables records the expense transactions part of the accounting transactions.

Attention: Normally, you charge the original expense account for any invoice price variances, so your PO distribution variance account is the same as the PO distribution charge account. You do not record invoice price variances for expense purchases. Purchasing uses the Account Generator to set your purchase order distribution variance account to be the same as your purchase order charge account. If you want to record your invoice price variances to a separate account, use the Account Generator to define the business rules you use to determine the correct invoice price variance account.

Complete Period Transactions

If you use encumbrance or budgetary control, Purchasing creates encumbrance journal entries in your general ledger each time you approve a purchase order. Similar to accrual journal entries, encumbrance journal entries recognize a liability towards your supplier before any invoicing transactions occur. Unlike accrual journal entries, encumbrance journal entries are not actual transactions. General Ledger tracks actual and encumbrance journal entries and balances separately.
Period–End Checklist

Purchasing provides you with complete flexibility and control for your period–end accruals. You can use the Uninvoiced Receipts Report to analyze your uninvoiced non–inventory receipts before you accrue these receipts. You can then use the Receipt Accruals – Period–End process as many times as you want to generate accrual entries for the receipts you choose.

For your period–end reconciliation, you should perform the following steps:

1. Identify the purchasing period you want to reconcile and close.
2. Enter all receiving transactions for goods and services you received during the period. Purchasing automatically creates receipt accruals for all receipts you entered up to the end of this period. To prevent any period–end disruption, Purchasing lets you provide a receipt date that is different from the date you enter the receipts. You never have to enter all the receipts for a period before the end of this period. You can enter these receipts later. You simply need to back date the receipt date.
3. Enter and match all invoices you received during the period for your receipt accrual entries. You should make sure that you solve all posting holds problems in Payables before accruing receipts. Purchasing creates accrual journal entries for all purchase orders you received and did not match to an invoice. If you matched a purchase order or receipt to an invoice, Purchasing does not accrue the corresponding receipts. Purchasing does not accrue any purchase order that you closed on or before the end of the accrual period you choose. If the invoice is on posting hold, Payables has not yet accounted for the liability corresponding to the invoice. Under these conditions, the liability corresponding to this invoice would not appear in your books for the period. Payables lets you recognize this liability in the following period.
4. Close your accounts payable period corresponding to the purchasing period for your receipt accrual entries.

**Note:** The List of Values for period end accruals does not require the Accounts Payable period to be closed, however it’s strongly recommended that closed periods are used, as the receipt accruals process will not pick up invoices entered after the accruals process is run for the period.

5. For period–end accruals of expense purchases, run the Uninvoiced Receipts Report. Use this report to analyze your uninvoiced receipts. The Uninvoiced Receipts Report lets you use the same
selection criteria for your uninvoiced receipts as the Receipt Accruals – Period–End process. You always know exactly what you accrue and for what amount.

6. For period–end accruals of expense purchases, use the Receipt Accruals – Period–End process as many times as you need. You can use the search criteria to choose what you want to accrue and accrue your receipts step by step. You create accruals for a specific purchasing period. Purchasing automatically accrues all uninvoiced receipts your entered up to the end of the accrual period you specify. See: Receipt Accruals – Period End Process: page 9 – 119.

Each time you use the Receipt Accruals – Period–End process, Purchasing creates an unposted journal entries batch in your general ledger for your receipt accruals. If you are using encumbrance, Purchasing creates another journal entries batch in your general ledger corresponding to the encumbrance reversal entries for the uninvoiced receipts you accrued.

Purchasing never accrues your uninvoiced receipt twice. Each time you create accrual entries for a specific uninvoiced receipt, Purchasing marks this receipt as accrued and ignores it the next time you use the Receipt Accruals – Period–End process. Purchasing creates accrual entries only up to the quantity your supplier did not invoice for your partially invoiced receipts.

7. Post Accrual and Encumbrance Reversal journal entry batches in your general ledger. (See the following section to identify Accrual and Encumbrance Reversal journal entry batches.)

8. Perform all the steps you need to close your accounting period and generate your period–end reports and financial statements in your general ledger.

9. Use your general ledger system to reverse all the receipt accrual and encumbrance reversal batches you created for your period–end accruals.

10. Close the purchasing period for your receipt accruals. When you close a purchasing period, Purchasing automatically un–marks all the receipts you previously accrued to make sure you can accrue these receipts again if they are still uninvoiced in the next period. See: Uninvoiced Receipts Report: page 9 – 170.
Identifying Journal Entry Batches in General Ledger

Purchasing creates accrual journal entries in your general ledger when you accrue receipts. If you use encumbrance, Purchasing also creates encumbrance reversal journal entries corresponding to the receipts you accrued. Purchasing automatically names journal entry batches, headers, and lines for you. The names Purchasing uses to create batches are the following:

Period–End Accruals


Journal Entry Batches

- Batch Name: PO/Accruals/[current date and time]/Batch: [JE_BATCH_ID of the Accruals Batch]
- Batch Type: Actual
- Batch Status: Unposted
- Period: [Accrual Period]
- Debits: [Sum of all debits for all headers]
- Credits: [Sum of all credits for all headers]

Journal Entry Headers

- Header Name: Accrue/PO [PO Number–Release Number]
- Category: Accrual
- Source: Purchasing
- Currency: [PO Currency]
- Reverse: Yes
- Reverse to Period: [Next Period]
- Debits: [Sum of all debits for all lines]
- Credits: [Sum of all credits for all lines]

Purchasing creates two types of journal entry lines for each accrued receipt:
• Distribution Lines (one for each distribution of an accrued purchase order line)

• Accrued Receipt Lines (one for each accrued purchase order line)

Purchasing creates one line for each purchase order distribution you accrued on the purchase order. Purchasing charges each line to the charge account on the purchase order distribution. Purchasing computes the accrual amount by prorating the quantity accrued for the purchase order shipment of the distribution to the quantity ordered on the distribution.

Purchasing creates one journal entry line charged to the PO distribution accrual account (normally the expense A/P accrual account). This line corresponds to the amount accrued for a purchase order. The amount accrued for a purchase order equals the sum of all uninvoiced receipts for this purchase order multiplied by the price for the corresponding purchase order shipments. The accrued receipt journal entry line balances all the distribution journal entry lines.

**Distribution Journal Entry Lines**

- **Account:** [Charge Account for PO Distribution]
- **Amount:** [Shipment Price x Quantity Received for Shipment x Quantity Ordered on Distribution / Quantity Ordered on Shipment]
- **Dr/Cr:** Dr
- **Description:** Purchase Order Line Description

**Accrued Receipt Journal Entry Lines**

- **Account:** [Accrual Account for PO Distribution]
- **Amount:** [Sum of all amounts for Distributions Journal Entry Lines for the same Header]
- **Dr/Cr:** Dr
- **Description:** Accrued Liability Account

**Encumbrance Reversal**

Purchasing creates one batch each time you use the Receipt Accruals – Period–End process if you use encumbrance.

Note that Encumbrance Journal Entry Batches are unbalanced in General Ledger. General Ledger automatically offsets the Reserve for Encumbrance account with the balance of your encumbrance batch.
You set up your Reserve for Encumbrance account when defining your set of books. See: Defining Sets of Books, Oracle Public Sector General Ledger User’s Guide.

Purchasing creates one header for each purchase order you accrue.

**Journal Entry Batches**

- Batch Name: PO/Accruals/[current date and time]/Batch: [JE_BATCH_ID of the Encumbrance Batch]
- Batch Type: Encumbrance
- Batch Status: Unposted
- Period: [Accrual Period]
- Debits: 0.00
- Credits: [Sum of all credits for all headers]

**Journal Entry Headers**

- Header Name: Rev Enc/PO [PO Number–Release Number]
- Category: Purchases
- Source: Purchasing
- Encumbrance Type: Obligation
- Currency: [PO Currency]
- Reverse: Yes
- Reverse to Period: [Next Period]
- Debits: 0.00
- Credits: [Sum of all credits for all lines]

Purchasing creates one line for each purchase order distribution you accrued on the purchase order. Purchasing charges each line to the account on the purchase order distribution. Purchasing computes the line amount by prorating the quantity accrued for the purchase order shipment of the distribution to the quantity ordered on the distribution.

**Distribution Journal Entry Lines**

- Account: [Charge Account for PO Distribution]
- Amount: [Shipment Price x Quantity Received for Shipment x Quantity Ordered on Distribution/Quantity Ordered on Shipment]
Accrual Write-offs

If you choose the Perpetual Accrual Method within Purchasing, Purchasing records an accounts payable liability to an AP accrual account for goods received but not invoiced. When Payables matches and approves the invoice for the received goods, Payables clears the accounts payable accrual account and records the actual liability amount to the invoice accounts payable liability account.

After you have entered your receipt transactions and matched and approved your invoices, you can run the Accrual Reconciliation Report to identify any differences between your Purchasing receipts and Payables invoices. With this report, you can identify the following problems with receiving, purchasing, inventory, work in process, or accounts payable transactions:

- Quantities differ between receipts and invoices
- Incorrect purchase order or invoice unit prices (previous releases only)
- Discrepancies in supplier billing
- Accounts Payable clerk matched an invoice to the wrong purchase order or purchase order line or the wrong receipt or receipt line
- Receiving clerk received against the wrong purchase order or wrong purchase order line
- Miscellaneous inventory or work in process transactions that do not belong to the accrual accounts
- Payables entries for sales tax and freight that do not belong to the accrual accounts

After you have researched the reported accrual balances, you can use the Accrual Write–Offs window to indicate which entries you wish to write off and remove from the Accrual Reconciliation Report. Submit the Accrual Write Off Report, which lists the transactions you marked in the Accrual Write–Offs window, and use it to support a manual journal entry to write off listed transactions.
Writing Off Accrual Transactions

Prerequisites:

- Payables and Purchasing are installed.
- Define your transactions reasons in Inventory’s Transaction Reasons window. This gives you a means of classifying your write-offs so you can record them in separate accounts when you record a manual journal entry to write off these transactions. The Accrual Write Off Report provides a summary by transaction reason. See: Defining Transaction Reasons, Oracle Inventory User’s Guide.
- If you use Inventory and Work in Process, transfer to your general ledger transactions from these two sources.
- Transfer your Payables invoices to your general ledger. See: Payables Transfer to General Ledger Program, Oracle Public Sector Payables User’s Guide.

To write off a transaction from an accrual account:


2. Select Accrual Write–Offs from the menu. Enter search criteria in the Write–Off Search Criteria region to find the transactions you want to write off:
   - Enter the Source:
     - AP. Payables.
     - INV. Inventory.
     - PO. Purchasing.
     - WIP. Work in Progress.
   - You can optionally enter the following additional search criteria: Account number, Item number, item Description, PO Number, Document Order Line, Document Number, Document Line, Destination Type, Quantity, and a date range. You can also restrict the search to include written off transactions and transactions matched to a purchase order.

3. Choose Find to initiate the search and display the results in the Write–Off Transactions region.
4. Select the transactions that you want to write off. Enter a Write Off Date that is in the same accounting period as the journal entry you will prepare to write off selected transactions.

5. Save your work. Transactions that you selected to write off in this window will no longer appear on the Accrual Reconciliation Report. They will appear on the Accrual Write Off Report, which is used to support your manual journal entry.


7. Using the Accrual Writeoff Report as support, prepare a manual journal entry for the transactions you wish to write off. Optionally prepare a journal entry line for each transaction reason.

See Also

Defining Accrual Options: page 1 – 48
Setting Up Inventory Accruals: page 7 – 104
Defining Purchase Order Receipt Accruals: page 7 – 130
Overview of Receipt Accounting: page 7 – 101
Reconciling A/P Accrual Accounts Balance: page 7 – 117
Accrual Process for Perpetual Accruals: page 7 – 109
Fund Accounting in Oracle Public Sector Purchasing

Receipt Accruals

The default Account Generator configuration in Oracle Public Sector Purchasing builds a charge, budget, accrual, and variance account for each purchase order, release, and requisition distribution based on the distribution’s Expense, or Inventory, destination type. Oracle Public Sector Purchasing always builds these accounts using the Account Generator; you cannot disable this feature.

To populate the Accrual account for distributions with an Expense destination type, the Account Generator locates the Expense AP Accrual Account that you specify in Define Purchasing Options as part of your application setup and copies it into the Accrual Account in your document. The Account Generator then overlays the balancing segment of the AP Accrual Account with the balancing segment of the charge account so that your transactions always balance by fund.

Defining Purchase Order Receipt Accruals

You can create balanced offsets for receipt accrual accounts in Oracle Public Sector Purchasing by customizing the default configuration of the Account Generator to overlay the balancing segment of the AP Accrual Account with the balancing segment of the charge account so that your transactions always balance by segment.

Prerequisites

- See Prerequisites to Using the Account Generator in: Decide How To Use the Account Generator: page C – 10.

To build Purchase Order Receipt Accrual Accounts:

1. Use the same Chart of Accounts you used to build the purchase order charge accounts by balancing segment, substituting the receipt accrual liability account for the expense account.

The Account Generator function is called from the Purchase Orders window to automatically create the receipt accrual liability
accounts by balancing segment on each purchase order distribution.

**Attention:** Use the same balancing segment for the charge account and the receipt accrual account so the receipt transactions will balance by balancing segment.


**See Also**

Fund Accounting in Oracle Public Sector Purchasing: page 7 – 130
Defining Purchase Order Receipt Accruals: page 7 – 130
Defining Transaction Reasons, *Oracle Inventory User’s Guide*
Accrual Reconciliation Report: page 9 – 5
Accrual Write Off Report: page 9 – 13
Overview of Receipt Accounting: page 7 – 101
Continues in Volume 2.
Index

A
Acceptances, 4 – 7
Acceptances window, Entering and Viewing
   Purchase Order Acceptances, 4 – 84
Access Level Options
   full, 2 – 10
   modify, 2 – 10
   view only, 2 – 10
Account Generator, using in Oracle Public
   Sector Purchasing, C – 10
Accounting lines, viewing, 7 – 53
Accrual Process, for period-end accruals,
   7 – 119
Accrual Reconciliation report, 9 – 5
Accrual Write–Off report, 9 – 13
Accrual Write–offs, 7 – 127
Accrual Write–offs window, Accrual
   Write–offs, 7 – 127
Accrue Expense Items, option setup, 1 – 48
Action History Window
   Purchase Order Distributions, 8 – 2
   Purchase Order Distributions (Summary),
   8 – 2
   Purchase Order Headers (Summary), 8 – 2
   Purchase Order Lines (Summary), 8 – 2
   Purchase Order Shipments, 8 – 2
   Purchase Order Shipments (Summary), 8 – 2
   Purchase Orders, 8 – 2
   Releases, 8 – 2
   Requisition Distributions, 8 – 2
   Requisition Headers Summary, 8 – 2
   Requisition Lines Summary, 8 – 2
Action History window, Viewing Action
   History, 8 – 2
Action History, viewing, 8 – 2
Activities
   in the Approve and Forward PO subprocess,
       C – 153
   in the Approve PO (Change Order)
       subprocess, C – 204
   in the Approve PO subprocess, C – 147
   in the Approve Requisition subprocess,
       C – 108
   in the Change Order Reserve Before
       Approve subprocess, C – 201
   in the Confirm Receipt process, C – 249
   in the Create And Approve Purchase Order
       Or Release process, C – 234
   in the Do Document Changes Require
       Reapproval? subprocess, C – 198
   in the Does Req Line Have Enough
       Information To Automatically Create A
       Document? process, C – 232
   in the Find Approver subprocess (for
       purchase orders), C – 161
   in the Forward PO subprocess, C – 164
   in the Generate Default Accounts process,
       C – 35
   in the Get All Blanket PO Changes
       subprocess, C – 189
   in the Get All Contract PO Changes
       subprocess, C – 190
in the Get All Document Changes subprocess, C – 187
in the Get All Planned PO Changes subprocess, C – 192
in the Get All Release Changes subprocess, C – 193
in the Get All Standard PO Changes subprocess, C – 195
in the Get Buyer process, C – 237
in the Notify Approver subprocess, C – 85
in the Notify Approver subprocess (for purchase orders), C – 157
in the Notify Requester subprocess, C – 253
in the Overall Document Creation / Launch Approval Process, C – 222
in the PO Approval process, C – 135
in the PO Approval Top Process, C – 128
in the PO Catalog Price Tolerances Exceeded workflow, C – 273
in the PO Document Approval Reminder process, C – 263
in the Print Document subprocess, C – 110
in the Print Document subprocess (for change orders), C – 207
in the Print Document subprocess (for purchase orders), C – 150
in the Reject PO subprocess, C – 169
in the Reject Requisition subprocess, C – 90
in the Reserve at the Start subprocess, C – 83
in the Reserve Before Approve subprocess (for purchase orders), C – 142
in the Return PO to Submitter subprocess, C – 166
in the Return Requisition to Submitter subprocess, C – 92
in the Verify Approval Authority subprocess, C – 85, C – 113
in the Verify Approval Authority subprocess (for purchase orders), C – 145
in the Verify PO subprocess, C – 139
in the Verify Req Line Info process, C – 228
in the Verify Requisition subprocess, C – 80
in the Web Requisition Main Requisition Approval process, C – 72
Activity nodes, in the Notify Approver subprocess, C – 85
Advance Shipment Notice and CUM management, 7 – 21
application advices, 7 – 19
correcting a receipt against, 7 – 84
finding expected receipts, 7 – 30
finding returns, 7 – 79
in Find Intransit Shipments window, 7 – 92
in Manage Shipments window, 7 – 93
overview, 7 – 17
receiving against, 7 – 21
related receiving options, 7 – 18
types of, 7 – 20
with substitute items, 7 – 20
Alternate Fields, 5 – 4
Amount Based Purchasing, 1 – 80
Annotating Purchasing Documents, 1 – 36
unlimited text, 1 – 36
Approval Actions
cancel, 2 – 37
change the forward from person, 2 – 37
change the forward to person, 2 – 38
enter notes, 2 – 38
facsimile, 2 – 38, 2 – 39
print, 2 – 38
reserve, 2 – 36
Approval and Security
setup matrix, 2 – 6
setup overview, 2 – 2
setup steps, 2 – 3
Approval authorization rules, defining, 2 – 16
Approval Groups
account range, 1 – 30
document total, 1 – 31
item category range, 1 – 31
item range, 1 – 31
location, 1 – 31
Approval groups
assigning, 2 – 19
defining, 2 – 16
Approval Groups window, Defining Approval Groups, 1 – 29
Approval groups, assigning, 1 – 33
Approval groups, defining, 1 – 29
Approval hierarchy, changing, 2 – 5
Approvals
effect on supply, 2 – 25
offline, 2 – 40
overview, 2 – 24
Pre-Approved status, 2 – 25
taking approval actions, 2 – 35
Approve and Forward PO subprocess
activities
Approve And Forward The PO, C – 153
Document Failed State Check, C – 154
Document Manager Failed, C – 154
Does Document State Allow Approval?,
   C – 153
Get PO Attributes, C – 154
Is Document Complete?, C – 153
Reject the PO, C – 154
Set PO Status to Original Status, C – 154
Start, C – 153
Unable To Approve Document, C – 154
Unable To Reject Document, C – 154
Approve and Forward PO subprocess
overview, C – 151
Approve and Forward Req subprocess
activities, End, C – 155
Approve Document window, Taking Approval
   Actions, 2 – 35
Approve Entire Quotations window,
   Approving Entire Quotations, 5 – 94
Approve PO (Change Order) subprocess
activities
Approve the PO, C – 204
Document Failed State Check, C – 205
Document Manager Failed, C – 205
Does Document State Allow Approval?,
   C – 204
End, C – 205
Get PO Attributes, C – 205
Is Document Approved?, C – 204
Is Document Complete?, C – 204
Reject the PO, C – 205
Set PO Status to Original Status, C – 205
Start, C – 204
Unable To Approve Document, C – 205
Unable to Reject Document, C – 205
Approve PO (Change Order) subprocess
overview, C – 202
Approve PO subprocess activities
Approve the PO, C – 148
Document Failed State Check, C – 148
Document Manager Failed, C – 148
Does Document State Allow Approval?,
   C – 147
End, C – 149
Get PO Attributes, C – 148
Is Document Approved?, C – 147
Is Document Complete?, C – 148
Reject the PO, C – 148
Set PO Status to Original Status, C – 148
Start, C – 147
Unable To Approve Document, C – 148
Unable to Reject Document, C – 149
Approve PO subprocess overview, C – 146
Approve purchase orders, 4 – 8
Approve Quotations window, Approving
   Quotation Shipments, 5 – 92
Approve Requisition subprocess activities
Approve the Requisition, C – 108
Document Failed Correctness Check, C – 109
Document Failed State Check, C – 109
Document Manager Failed, C – 109
Does Document State Allow Approval
   Action?, C – 108
End, C – 109
Get Requisition Attributes, C – 108
Is Document Approved, C – 108
Is Document Complete?, C – 108
Set Req Status to Original Status, C – 109
Start, C – 108
Approve Requisition subprocess overview,
   C – 106
Approved Quotations
   using on purchase orders, 5 – 91
   using on purchase orders and requisitions, 5 – 93
   using on requisitions, 5 – 91
Approved Supplier List, 5 – 42
   find window, 5 – 56
Approved Supplier List Statuses window,
   5 – 45
Approved Supplier List Summary, window,
   5 – 56
Approved Supplier List Summary window,
   5 – 56
Approved Supplier List window, 5 – 47
defining the supplier and item/commodity
   combination, 5 – 47
ASL Upgrade process, 9 – 17
Assign Approval Groups, Assign Approval Groups, 1 – 33
Assign Requisition Lines window, Assigning Requisition Lines, 5 – 102
Attachments, 1 – 44
icon, 1 – 44
referencing on documents, 1 – 43
understanding usages, 1 – 42
Attributes (item attributes)
Account Generator workflows, C – 27
Change order workflow, C – 174
Debit Memo Notification, C – 280
PO Approval, C – 120
PO Confirm Receipts, C – 245
PO Create Documents, C – 216
PO Requisition Approval, C – 63
PO Send Notifications for Purchasing Documents, C – 258
AutoApproval, definition, 3 – 6
AutoClose, 4 – 9
AutoCreate
Add to Document window, 6 – 19
and descriptive flexfields, 6 – 16
Automatic mode, 6 – 3
completing, 6 – 19
criteria, selecting, 6 – 16
entering document information for, 6 – 19
from emergency requisitions, 6 – 9
from procurement card requisitions, 6 – 9
Manual mode, 6 – 3
modifying requisition lines, 6 – 24
New Document Number window, 6 – 20
New Document window, 6 – 20
overview, 6 – 2
Self–Service Purchasing requisitions, 6 – 9
AutoCreate Documents window
Selecting AutoCreation Criteria, 6 – 16
Using the Document Builder, 6 – 22
Automatic Release Generation, 4 – 103
Automatic sourcing, 5 – 30
definition, 5 – 5
setting up, 5 – 33
trouble with, 5 – 35

B
Backordered Internal Requisitions report, 9 – 18
Bid quotation or RFQ, 5 – 7
Blanket and Planned PO Status report, 9 – 19
Blanket purchase agreements, 4 – 4
audit report, 9 – 91
notify options setup, 1 – 50
Blanket purchase orders, status report, 9 – 19
Blanket releases, 4 – 4
Blind receipt, setup, 7 – 10
Blind Receiving, option setup, 1 – 60
Brief Notes, 1 – 37
Budgetary account. See Glossary
Budgetary control
on–line funds availability Checking, 3 – 5
on–line funds availability checking, 4 – 6
Build Expense Charge Account subprocess overview, C – 44
Build Inventory Budget Account subprocess overview, C – 47
Build Inventory Charge Account subprocess overview, C – 45
Build Project Related Account subprocess overview, C – 49
Build Shop Floor Charge Account subprocess overview, C – 46
Buyer Listing, 9 – 21
Buyer Workload, Reviewing, 5 – 100
Buyer’s Requisition Action Required report, 9 – 23
Buyers window, Defining Buyers, 1 – 27
Buyers, defining, 1 – 27

C
Cancel, purchase orders, 4 – 9
Cancel Requisitions, option setup, 1 – 51
Cancelled Purchase Order report, 9 – 25
Cancelled Requisition report, 9 – 26
Capacity defining for a supplier (overview), 5 – 32
in Supplier–Item Attributes window, 5 – 55
Cascade, receipts and receiving transactions, 7 – 25
Cascade Transactions, option setup, 1 – 59
Cascade transactions, setup, 7 – 10
Catalog information, receiving electronically, 5 – 22
  monitoring supplier price increases, 5 – 26
  price tolerance, 5 – 25
  sourcing, 5 – 23
Catalog quotation or RFQ, 5 – 7
Change Order Reserve Before Approve subprocess activities
  Document Manager Failed, C – 201
  End, C – 202
  Is Encumbrance On and Is Document Not Reserved?, C – 201
  Is Forward–To Valid?, C – 201
  Reject the PO, C – 202
  Reserve Document, C – 201
  Set Forward–To/From For Forward Action, C – 202
  Start, C – 201
  Unable to Reject Document, C – 202
  Unable To Reserve Document, C – 201
Change Order Reserve Before Approve subprocess overview, C – 199
Changes to purchase orders, viewing, 8 – 4
Confirm Receipt process activities
  End, C – 251
  Notify Receiving Transactions Failure, C – 251
  Process Receiving Transactions, C – 250
  Retrieve Order Information, C – 250
  Retrieve Receive Orders Web Page URL, C – 250
  Retrieve Requester’s Manager, C – 250
Confirm Receipt process overview, C – 247
Confirm Receipts Workflow Select Orders, 9 – 28
Contract purchase agreements, 4 – 4
Contract Status report, 9 – 30
Control Documents window, Controlling Documents, 2 – 58
Control Numbers, 7 – 96
Control Purchasing Periods window, Controlling Purchasing Periods, 1 – 93
Controlling Documents, 2 – 55
cancel, 2 – 55
close, 2 – 56
close for invoicing, 2 – 56
close for receiving, 2 – 57
finally close, 2 – 57
freeze, 2 – 57
on hold, 2 – 57
open, 2 – 57
open for invoicing, 2 – 57
open for receiving, 2 – 57
release hold, 2 – 58
unfreeze, 2 – 58
Controlling Purchasing Periods, prerequisites, 1 – 93
Copy Document window
  AutoCreating Quotations, 5 – 88
  copying purchase orders, agreements, and quotations, 4 – 106
Copying, purchase orders, agreements, and quotations, 4 – 106
Copying quotations from RFQs, 5 – 88
Corrections, 7 – 84
Corrections window
  Entering Corrections, 7 – 88
  exchange rate and Currency, 7 – 90
Corrections, entering, 7 – 88
Corrections, finding, 7 – 85
Country of Origin
  in the Approved Supplier List, 5 – 53
  in the Receipts window, 7 – 37
  purchase order Shipments window, 4 – 64, 4 – 65
Receipts window, 7 – 36
  release Shipments window, 4 – 93
Country of Origin Report (by Item), 9 – 31
Country of Origin Report (by Supplier), 9 – 33
Create And Approve Purchase Order Or Release process activities
Continue Flow, C – 235
Create Purchase Order Or Release, C – 235
End, C – 235
Is Automatic Approval Allowed?, C – 235
Launch Document Approval Process, C – 235
Purchase Order Or Release Has Been Created, C – 235
Start, C – 234
Create And Approve Purchase Order Or Release process overview, C – 233
Create Internal Sales Orders process, 9 – 35
Create Releases process, 9 – 36
Creating Purchase Orders for Services, 1 – 82
Creating Purchasing Document Lines, 1 – 81
Creating Requisitions for Services, 1 – 82
Currency information, entering in purchase orders, RFQs, quotations, 4 – 58
information, entering in receipt, 7 – 36
rate type options setup, 1 – 46
window, Entering Currency Information, 4 – 58
Currency information
in Corrections window, 7 – 90
in Receiving Transactions window, 7 – 69
Customer returns, overview, 7 – 14

D
Days Early/Late tolerance, option setup, 1 – 58
Debit Memo process overview, C – 282
Define Catalog Server for External Suppliers window, 1 – 102
Define Catalog Server Loader Values window, 1 – 102
Define MassCancel Listing, 2 – 63
Define MassCancel window, 2 – 60
Defining MassCancel, 2 – 60
Defining Default Category Sets, a note about Purchasing, 1 – 14
Defining Line Types, 1 – 81
Defining MassCancel, report submission, 2 – 65
Defining Purchase Order Receipt Accruals, 7 – 130
Delivery from receiving inspection to inventory, standard costing, 7 – 111
Disposition messages, display option, 1 – 50
Distributions window, 3 – 68
Entering Purchase Order Distributions, 4 – 74
Entering Release Distributions, 4 – 97
Do Document Changes Require Reapproval?, End, C – 199
Do Document Changes Require Reapproval? subprocess activities
Determine Document Type, C – 198
Does the Blanket PO Require Reapproval?, C – 198
Does the Blanket Release Require Reapproval?, C – 199
Does the Contract PO Require Reapproval?, C – 198
Does the Planned PO Require Reapproval?, C – 198
Does the Scheduled Release Require Reapproval?, C – 198
Does the Standard PO Require Reapproval?, C – 198
Start, C – 198
Do Document Changes Require Reapproval? subprocess overview, C – 196
Document Approval
approval button, 2 – 24
Approve button, 2 – 24
Document Approval and Security
Human Resources, 2 – 2
Using Approval Hierarchies, 2 – 2
Using Security Hierarchies, 2 – 2
Document Approval Status Rules, 2 – 26
Document Builder in AutoCreate, using, 6 – 22
Document Control, 2 – 44
options, 2 – 44
Document control
applicability matrix, 2 – 52
status check matrix, 2 – 53
submission check matrix, 2 – 54
Document Control Options
cancel, 2 – 45
close, close for receiving, close for invoicing, 2 – 49
delete, 2 – 44
final close, 2 – 46
firm, 2 – 48
freeze, 2 – 48
hold, 2 – 48
Document Manager Failed notification, 2 – 34
Document Revision Numbering, 4 – 123
Document Security and Access
hierarchy, 2 – 10
private, 2 – 10
public, 2 – 10
purchasing, 2 – 10
Document Subtypes
purchase agreement, 1 – 88
purchase order, 1 – 88
quotation, 1 – 88
release, 1 – 88
request for quotation, 1 – 89
requisition, 1 – 89
Document Types
associating workflow processes with, 1 – 91
prerequisites, 1 – 87
Document Types window
Defining Document Types, 1 – 87
Multilingual Support, 1 – 87
Document Types, defining, 1 – 87
Documents
approval process overview, 2 – 24
approval routing, 2 – 13
approval status checks, 2 – 26
approval submission checks, 2 – 27
authorization rules, 2 – 16
controlling, 2 – 44
placing purchase orders in the Navigator, 4 – 11
placing requisitions in the Navigator, 3 – 6
security and access level matrix, 2 – 12
security and access levels, 2 – 10
Does Req Line Have Enough Information To
Automatically Create A Document?
process activities
Does the Req Line Have Valid Source
Document Information?, C – 233
Does The Req Line Have Valid Supplier
Information?, C – 232
End, C – 233
Is This An Emergency Requisition?, C – 232
Start, C – 232
Does Req Line Have Enough Information To
Automatically Create A Document?
process overview, C – 231
Drilling down from GL, customizing windows, 7 – 71
Drop shipments, 4 – 133

E
Early/late receipt tolerance, setup, 7 – 11
EDI integration, price sales catalogs, 5 – 23
Emergency requisitions, 6 – 9
Employees, assigning to jobs or positions, 2 – 23
Encumbrance
in Approve Document window, 2 – 36
purchase orders and requisitions, 4 – 132
requisitions, 3 – 9
Encumbrance Detail report, 9 – 37
Enforce Buyer Name, options setup, 1 – 51
Enforce Ship-To Location, option setup, 1 – 60
Enforce ship-to location, setup, 7 – 10
Enforce Supplier Hold, options setup, 1 – 51
Enhanced Document Printing, 1 – 82
Enhanced Reporting, 1 – 82
Enter Person, window, 2 – 23
Euro
currency rate type in Currency window, 4 – 58
currency Rate Type in New Document window, 6–21
currency rate type in Requisition Preferences window, 3–53
currency rate type in Requisitions window, 3–65
rate type options setup, 1–46
Exceeded Price Tolerances window, 5–26
Exchange rate
entering at time of receipt, 7–36
in Corrections Window, 7–90
in Receiving Transactions Window, 7–69
Expected Receipts Report, using, 7–99
Expected Receipts report, 9–39
Expected Receipts, finding, 7–28
Expense Accrual, setup, 7–10
Expense AP accrual account, setup, 7–10
Expiring line items, 4–57
Express, receipts and receiving transactions, 7–26
Express Receipts, entering, 7–27
Express Transactions, option setup, 1–59
Express transactions, setup, 7–10
External Systems, 3–20

F
Facsimile
of purchase orders, 4–110
upon approval, 2–38, 2–39
Fill Employee Hierarchy process, 9–41
Financials/Purchasing Options Listing, 9–42
Find Approver subprocess activities
Are You Using PO Approval Hierarchies? (for purchase orders), C–162
Document Manager Failed (for purchase orders), C–162
Does Approver Have Authority? (for purchase orders), C–162
End (for purchase orders), C–162
Get Approval Path (for purchase orders), C–161
Get First Manager in Approval Hierarchy (for purchase orders), C–162
Get Forwarding Mode (for purchase orders), C–161
Get Next Manager in H.R. (for purchase orders), C–162
Is Forward–To Provided? (for purchase orders), C–161
Start (for purchase orders), C–161
Find Approver subprocess overview (for purchase orders), C–159
Find Corrections window, Finding Corrections, 7–85
Find Expected Receipts window
Entering Unordered Receipts, 7–40
Finding Expected Receipts, 7–28
Find In–Transit Shipments window, Finding In–Transit Shipments, 7–92
Find Purchase Orders window, Finding Purchase Orders, 4–19
Find Quotations window, Finding quotations, 5–90
Find Receiving Transactions window, Finding Receiving Transactions, 7–92
Find Requisition Lines window (for assignment), Finding Requisition Lines for Review or Assignment, 5–98
Find Requisitions window, Finding Requisitions, 3–42
Find Returns window, Finding Returns, 7–77
Finding Requisitions
clear existing search criteria, 3–44
enter a new requisition, 3–44
Forms, Enter Purchase Orders, 6–12
Forward, in Approve Document window, 2–37
Forward Documents window, Mass Forwarding Documents, 2–42
Forward PO subprocess activities
Document Manager Failed, C–165
End, C–165
Forward PO with Status “In–Process”, C–164
Forward PO with Status “Pre–Approved”, C–165
Get PO Attributes, C–165
Is PO Pre–Approved?, C–164
Start, C – 164
Forward PO subprocess overview, C – 163
Freeze, purchase orders, 4 – 10
Full lot quantities, enforcement options, 1 – 50
Function Security, 1 – 112
Funds checking
See also Glossary
purchase orders, 4 – 6
requisitions, 3 – 5
Funds reservation
See also Glossary
approvals, 2 – 36
changing reserved/unreserved documents,
4 – 132
requisitions, 3 – 9

G
Generate Accounts Using FlexBuilder Rules process overview, C – 53
Generate Default Accounts process activities
Accrual Account For Expense Item, C – 36
Accrual Account From Organization, C – 36
Build Inventory Charge Account, C – 36
End, C – 266
Expense Account, C – 36
Get Budget Account From Item/Sub, C – 36
Get Charge Account, C – 36
Get Item Level Budget Account, C – 36
Get Org Level Budget Account, C – 37
Is Charge Account CCID Null?, C – 37
Item Under Budgetary Control?, C – 37
Job WIP Account, C – 37
PO Accrual Acc Flexbuilder Upgrade, C – 37
PO Budget Acc Flexbuilder Upgrade, C – 37
PO Charge Acc Flexbuilder Upgrade, C – 37
PO Project–Related?, C – 38
PO Requisition Accrual Acc Flexbuilder Upgrade, C – 37
PO Requisition Budget Acc Flexbuilder Upgrade, C – 38
PO Requisition Charge Acc Flexbuilder Upgrade, C – 38
PO Requisition Variance Acc Flexbuilder Upgrade, C – 38
PO Variance Flexbuilder Upgrade, C – 38
Requisition Project–Related?, C – 38
Schedule Account, C – 39
Set Encoded Error Message, C – 39
Type of WIP, C – 39
Variance Account From Organization, C – 39
Work Item Destination Type, C – 39
Generate Default Accounts process overview,
C – 32
Generate Default Accrual Account subprocess overview, C – 39
Generate Default Budget Account subprocess overview, C – 41
Generate Default Charge Account subprocess overview, C – 42
Generate Default Variance Account subprocess overview, C – 43
Get All Blanket PO Changes subprocess activities
End, C – 189
Get Header Changes, C – 189
Get Lines Changes, C – 189
Start, C – 189
Get All Blanket PO Changes subprocess overview, C – 188
Get All Contract PO Changes subprocess activities
End, C – 191, C – 194
Get Header Changes, C – 190
Get Lines Changes, C – 190
Start, C – 190
Get All Contract PO Changes subprocess overview, C – 190
Get All Document Changes subprocess activities
Determine Document Type, C – 187
End, C – 188
Start, C – 187
Get All Document Changes subprocess overview, C – 185
Get All Planned PO Changes subprocess activities
End, C – 192
Get Distribution Changes, C – 192
Get Header Changes, C – 192
Get Lines Changes, C – 192
Get Shipments Changes, C – 192
Start, C – 192
Get All Planned PO Changes subprocess overview, C – 191
Get All Release Changes subprocess activities
  Get Distribution Changes, C – 194
  Get Release Changes, C – 193
  Get Shipments Changes, C – 194
  Start, C – 193
Get All Release Changes subprocess overview, C – 193
Get All Standard PO Changes subprocess activities
  End, C – 195
  Get Distribution Changes, C – 195
  Get Header Changes, C – 195
  Get Lines Changes, C – 195
  Get Shipment Changes, C – 195
  Start, C – 195
Get All Standard PO Changes subprocess overview, C – 194
Get Buyer process activities
  End, C – 237
  Get Buyer From Category, C – 237
  Get Buyer From Item, C – 237
  Get Buyer From Req Line, C – 237
  Get Buyer From Source Doc, C – 237
  Start, C – 237
Get Buyer process overview, C – 236
Get Charge Account for Variance Account subprocess overview, C – 51
Get Variance Account from Organization subprocess overview, C – 52

H

Hazard Classes window
  Defining Hazard Classes, 1 – 70
  Multilingual Support, 1 – 70
Hazard Classes, defining, 1 – 70
Hazardous Materials
  overview, 1 – 67
  regulation background, 1 – 67

I

In–Transit Shipments, finding, 7 – 92

Include In Next RFQ Printing, 5 – 64
Information Template window, 1 – 102
Inspecting Received Items, 7 – 73
Inspection, 7 – 72
Inspection Details window, Inspecting Received Items, 7 – 73
Internal Requisition Status Report, 9 – 43
Internal Requisitions
  approvals and controls, 3 – 17
  cancellation of requisitions, 3 – 18
  complete item sourcing definition, 3 – 15
  complete requisitions status visibility, 3 – 17
  creating online requisitions, 3 – 16
  creation of internal sales orders, 3 – 17
  exception processing, 3 – 17
  flexible processing, 3 – 16
  full unit of issue enforcement, 3 – 16
  inter–organization shipping network, 3 – 16
  inventory replenishment requisitions, 3 – 16
  Kanban replenishments, 3 – 19
  MRP generated requisitions, 3 – 17
  order management, 3 – 17
Internal requisitions
  approval, 3 – 21
  business example, 3 – 35
  cancelling, 3 – 25
  demand for, 3 – 18
  management, 3 – 25
  minimum inventory setup, 3 – 32
  minimum purchasing setup, 3 – 30
  minimum shipping setup, 3 – 30
  online processing automation, 3 – 34
  overview, 3 – 15
  processing summary, 3 – 26
  setup overview, 3 – 27
  updating intransit information, 3 – 25
  viewing status of, 3 – 25
Internal Requisitions/Deliveries Discrepancy report, 9 – 45
Internal Sales Orders, across operating units, 3 – 22
Internal sales orders
  creation, 3 – 21
  management, 3 – 23
  pick release, 3 – 24
  ship confirmation, 3 – 24
Intrastat, 7 – 8
Inventory accruals, setting up, 7 – 104
Inventory Replenishment Requests, 3 – 19
Invoice Close % Tolerance, setup, 7 – 9
Invoice Close Tolerance percentage, option setup, 1 – 47
Invoice exchange rate variances, 7 – 115
Invoice match approval, setup, 7 – 9
Invoice Matching, option setup, 1 – 47
Invoice Price Variance by Vendor, 9 – 49
Invoice Price Variance report, 9 – 47
Invoices, finding, 9 – 69
Item Attachments, 1 – 38
Item Description, update options setup, 1 – 51
Item Detail Listing, 9 – 51
Item Source window, 1 – 102
Item Summary Listing, 9 – 53
Item type attributes, Catalog Price Tolerances Exceeded workflow, C – 272
Item types
  Account Generator, C – 27
  Catalog Price Tolerances Exceeded workflow, C – 272
  Debit Memo Notification, C – 280
  PO Approval, C – 120
  PO Confirm Receipts, C – 245
  PO Create Documents, C – 216
  PO Requisition Approval, C – 63
  PO Send Notifications for Purchasing Documents, C – 258
Items
  last price history, 5 – 5
  purchase history, 5 – 5

J
Journal Entry Batches in General Ledger, 7 – 124

K
Kanban, replenishments, 3 – 19
Kanban replenishment request, receiving purchase order for, 7 – 6

L
Last Price History, definition, 5 – 5
Line Type, 1 – 80
default for documents, 1 – 47
Line Types, definition, 1 – 84
Line Types window
  Defining Line Types, 1 – 85
  Multilingual Support, 1 – 84
Line Types, defining, 1 – 84
Location Listing, 9 – 84
Lookup Codes
  1099 Supplier Exception, 1 – 75
  acceptance type, 1 – 75
  freight terms, 1 – 75
  minority group, 1 – 76
  pay group, 1 – 76
  PO/Requisition Reason, 1 – 76
  price type, 1 – 76
  quotation approval reason, 1 – 76
  reply/receive via, 1 – 76
  supplier type, 1 – 76
Lookup Codes, defining, 1 – 74
Lookups window, Defining Lookup Codes, 1 – 74
Lot numbers, 7 – 96

M
Main Requisition Approval process activities
  Can Owner Approve?, C – 73
  Get AutoCreate PO Mode, C – 76
  Is Requisition Pre–Approved?, C – 89, C – 99, C – 101
  Launch Create PO Workflow, C – 76
  Wait for Background Process, C – 76
Manage Shipments window, 7 – 94
Managing Attachments window, 1 – 38
Managing Requisitions, 3 – 10

Index – 11
Mass Forwarding Documents, 2 – 42
change original approver, 2 – 43
view action history, 2 – 43
MassCancel
delete MassCancel batch, 2 – 67
run MassCancel, 2 – 66
MassCancel, defining, 2 – 60
MassCancel, running, 2 – 65
Match Unordered Receipts, Matching
Unordered Receipts, 7 – 42
Matching Holds by Buyer report, 9 – 56
Matching Service Purchase Orders, 1 – 83
Matching Unordered Receipts, 7 – 41
Maximum release amount, option setup, 1 – 46
Menu paths, A – 2
Model/unit effectivity
purchase orders, 4 – 79
releases, 4 – 102
requisitions, 3 – 71
Modify Lines window, Modifying Requisition
Lines, 6 – 24
Movement statistics, 7 – 8
MRP Generated Requisitions, 3 – 20
Multilingual Support
Document Types window, 1 – 87
Hazard Classes window, 1 – 70
Line Types window, 1 – 84
Oracle Public Sector Purchasing Lookups
window, 1 – 74
UN Numbers window, 1 – 72
Multilingual support, Printed purchase orders, 4 – 109
Multiple Distributions, 7 – 24
Multiple Receiving Organizations, Centralized
Purchasing in, 7 – 6

N
Naming conventions, PL/SQL stored
procedures in the PO Catalog Price
Exceeded Tolerances workflow, C – 273
Navigator
placing purchase orders in, 4 – 11
placing requisitions in, 3 – 6
Navigator paths, A – 2
New Vendor Letter report, 9 – 58
Notification Controls window, Entering
Purchase Order Notification Controls,
4 – 82
Notifications
MRP reschedules, 2 – 33
viewing and responding to (overview),
2 – 31
Notifications Summary window, 2 – 31
Notify Approver subprocess activities
Approve PO Notification, C – 157
Approve Requisition Notification, C – 96
End (for purchase orders), C – 159
Is Forward–To Valid, C – 97
Is Forward–To Valid? (for purchase orders),
C – 158
PO Approval Reminder 1, C – 158
PO Approval Reminder 2, C – 158
Requisition Approval Reminder 2, C – 97
Requisition Approval Reminder1, C – 97
Set Forward–To/From App. & Fwd. Action
(for purchase orders), C – 158
Set Forward–To/From For Approve Action
(for purchase orders), C – 158
Set Forward–To/From For Timeout (for
purchase orders), C – 159
Start (for purchase orders), C – 157
Notify Approver subprocess overview (for
purchase orders), C – 155
Notify Requester subprocess overview,
C – 251
Notify Requester subprocess activities
End, C – 253
Notify Requester of Confirm Receipt – first
reminder, C – 253
Notify Requester of Confirm Receipt – initial
notice, C – 253
Notify Requester of Confirm Receipt –
second reminder, C – 253
O

Offline approvers, 2 – 40
Open Purchase Orders By Buyer report, 9 – 60
Open Purchase Orders by Organization report, 9 – 61
Oracle Alert, use in Purchasing, B – 2
Oracle Public Sector Purchasing, Account Generator setup, C – 10
Oracle Public Sector Purchasing Lookups window, 1 – 74
Multilingual Support, 1 – 74
Oracle Quality results in Receiving Transactions window, 7 – 65
Order Pad Options, entering, 5 – 19
Order Source default, setup for internal requisitions, 1 – 52
Order Type default, setup for internal requisitions, 1 – 52
Outside processing information, entering, 4 – 80
Outside Processing Line Types, 1 – 80
Outside Processing window, Entering Outside Processing Information, 4 – 80
Over–Receipt Tolerance percentage, option setup, 1 – 59
Overall Document Creation / Launch Approval process activities
End, C – 225
Group Req Lines Into Purchase Orders Or Releases, C – 224
Is Automatic Creation Allowed?, C – 223
Is This An Emergency Requisition?, C – 224
Launch Process To Create/Approve PO Or Release, C – 224
Launch Process to Verify Req Line Information, C – 223
Put All Requisition Lines On A Purchase Order, C – 224
Remove Processed Req Lines From Temp Table, C – 224
Start, C – 223
Wait For Flow, C – 223
Overall Document Creation / Launch Approval process overview, C – 219
Overdue Vendor Shipments report, 9 – 62
Overreceipt tolerance, setup, 7 – 11
Overshipments report, 9 – 64

P

Payment on Receipt process, 9 – 66
Period Status
closed, 1 – 94
future, 1 – 94
never opened, 1 – 94
open, 1 – 94
permanently closed, 1 – 94
Period–End reconciliation tasks, 7 – 115
Perpetual accruals, accrual process for, 7 – 109
PL/SQL Error Occurs, C – 132
PL/SQL stored procedures
Generate Default Accounts process, C – 35
PO Approval process, C – 135
PO Approval Top Process, C – 128
PO Document Approval Reminder process, C – 263
workflow naming conventions, C – 273
Placing purchase orders in the Navigator, 4 – 11
Placing requisitions in the Navigator, 3 – 6
Planned purchase orders, 4 – 5
Planning active, 5 – 38
Planning constraints, overview, 5 – 32
PO Approval Process activities
Can Owner Approve?, C – 135
End, C – 137
Is Forward–To Provided?, C – 135
Is PO Pre–Approved?, C – 136
PO Approved, C – 136
PO Rejected, C – 137
Start, C – 135
PO Approval Top Process activities
Get PO Attributes, C – 130
Get Workflow Approval Mode, C – 130
Is Archive on Approval Flag Set to Yes?, C – 131
Is Change Initiated from Web Suppliers?, C – 130
Is This a New Document?, C – 130
PO Approved, C – 131
Remove All Notifications For This Doc, C – 129
Set PO Status to "In Process", C – 130
Set Workflow Startup Values, C – 129
Start, C – 129
Update PO Header with Workflow Key, C – 129
Wait for Background Process, C – 130
PO Approval Top Process overview, C – 126
PO Change History, 8 – 4
PO Document Approval Reminder process activities
Approve Purchase Order Release Reminder Notification, C – 266
Approve Purchase Order Reminder Notification, C – 266
Approve Requisition Reminder Notification, C – 265
Compare Text, C – 264
Is Forward to Valid, C – 266
Noop, C – 266
PO Acceptance Past Due Notification, C – 265
PO Acceptance Required Notification, C – 265
Quotation Near Expiration Notification, C – 264
Quotation Requires Completion Notification, C – 264
Release Acceptance Past Due Notification, C – 265
Release Acceptance Required Notification, C – 265
RFQ Near Expiration Notification, C – 265
RFQ Requires Completion Notification, C – 265
Set Document Type, C – 264
Start, C – 264
Start Document Approval, C – 266
PO Document Approval Reminder process overview, C – 261
Position Hierarchies
setting up, 2 – 8
uses, 2 – 8
Pre–Approved, document, 2 – 25
Price Break Type, option setup, 1 – 46
Price Break window, Entering Purchase Agreement Price Break Information, 4 – 72
Price Tolerance, options setup, 1 – 49
Price Type, option setup, 1 – 47
Price Update Tolerance field, 5 – 25
Price Variances, monitoring, 7 – 117
Print, purchase orders, 4 – 8
Print Document Process (Change Order) overview, C – 206
Print Document subprocess activities
Does User Want Document Printed, C – 110
Does User Want Document Printed? (for change orders), C – 207
Does User Want Document Printed? (for purchase orders), C – 150
End, C – 111
End (for change orders), C – 208
End (for purchase orders), C – 151
Print Document, C – 110
Print Document (for change orders), C – 207
Print Document (for purchase orders), C – 151
Start, C – 110
Start (for change orders), C – 207
Start (for purchase orders), C – 150
Print Document subprocess overview, C – 109
Print Document subprocess overview (for purchase orders), C – 149
Printed Change Orders (Landscape) report, 9 – 74
Printed Change Orders (Portrait) report, 9 – 77
Printed Purchase Order (Landscape) report, 9 – 80
Printed Purchase Order (Portrait) report, 9 – 83
Printed Purchase Order, overview, 4 – 109
Printed Requisitions report, 9 – 90
Printed RFQ (Landscape) report, 9 – 86
Printed RFQ (Portrait) report, 9 – 88
Printing Attachments, 1 – 41
Process navigator, C – 276
Processes
ASL Upgrade, 9 – 17
Confirm Receipts Workflow Select Orders, 9 – 28
Create Internal Sales Orders, 9 – 35
Create Releases, 9 – 36
Fill Employee Hierarchy, 9 – 41
overall document creation, C – 219
Payment on Receipt, 9 – 66
Purchasing Database Administration, 9 – 107
Purge Purchasing Open Interface Processed Data, 9 – 113
Receipt Accruals – Period End, 7 – 120, 9 – 119
Receiving Transaction Processor, 9 – 131
Requisition Import, 9 – 144
Reschedule Requisitions, 9 – 150
Send Notifications for Purchasing Documents, 9 – 155
Upgrade Notifications to Release 11, 9 – 177
Workflow Background, 1 – 100
Processing mode, setup, 7 – 11
Procurement cards, 4 – 143
Procurement processes workflow, C – 276
Profile options, 1 – 103
Project information
  in purchase order Distributions window, 4 – 78
  in Purchase Order Preferences window, 4 – 37
  in quotation when copying from RFQ, 5 – 88
  in Quotations window, 5 – 78
  in release Distributions window, 4 – 101
  in requisition Distributions window, 3 – 70
  in Requisition Preferences window, 3 – 55
  in RFQs window, 5 – 62
Project Manufacturing information
  in purchase order Distributions window, 4 – 78
  in release Distributions window, 4 – 101
  in requisition Distributions window, 3 – 70
Proprietary account. See Glossary
Purchase Agreement Audit report, 9 – 91
Purchase agreement header information, entering, 4 – 55
Purchase agreement line information, entering, 4 – 55
Purchase agreement price break information, entering, 4 – 72
Purchase History, definition, 5 – 5
Purchase order acceptances, entering and viewing, 4 – 84
Purchase Order and Releases Detail report, 9 – 99
Purchase Order Commitment report, 9 – 93
Purchase Order Detail report, 9 – 95
Purchase order details, entering, 4 – 60
Purchase Order Distribution Detail report, 9 – 97
Purchase Order Distributions results window, Using the Purchase Order Distributions Results Window, 4 – 32
Purchase Order Distributions results window, using, 4 – 32
Purchase order distributions, entering, 4 – 74
Purchase Order Header Results window, using, 4 – 23
Purchase Order Headers window, Using the Purchase Order Headers Results window, 4 – 23
Purchase Order Headers, entering, 4 – 39
Purchase order lines, using line types, 1 – 84
Purchase Order Lines Results window, using, 4 – 26
Purchase Order Lines window, Using the Purchase Order Lines Results window, 4 – 26
Purchase order lines, entering, 4 – 45
Purchase Order Miscellaneous Information, entering, 4 – 53
Purchase order notification controls, entering, 4 – 82
Purchase order numbers
  entry method setup, 1 – 53
  entry type setup, 1 – 54
Purchase Order Preferences window, Entering Purchase Order Preferences, 4 – 35
Purchase Order Preferences, entering, 4 – 34
Purchase order price reference information, entering, 4 – 49
purchase order receipt accruals, defining, 7 – 130
Purchase order receipt to expense destinations, standard costing, 7 – 113
Purchase order receipt to inventory, standard costing, 7 – 112
Purchase order receipt to receiving inspection, standard costing, 7 – 110
Purchase order receiving controls, entering, 4 – 69
Purchase order reference document information, entering, 4 – 51
Purchase Order Shipments results window, using, 4 – 29
Purchase Order Shipments window, Using the Purchase Order Shipments Results Window, 4 – 29
Purchase order shipments, entering, 4 – 63
Purchase order terms and conditions, entering, 4 – 60
Purchase Orders
control matrices, 2 – 50
line types, 4 – 7
Purchase orders
acceptances, 4 – 7
approval, 4 – 8
AutoClose, 4 – 9
blanket purchase agreements, 4 – 4
cancel, 4 – 9
close, 4 – 9
contract purchase agreements, 4 – 4
defaulting rules, 4 – 12
freeze, 4 – 10
funds checking, 4 – 6
hold, 4 – 10
multiple shipments, 4 – 7
notification controls, 4 – 10
overview, 4 – 3
placing in the Navigator for easy access, 4 – 11
planned purchase orders, 4 – 5
print, 4 – 8
reserve and unreserve, 4 – 132
revising and archiving, 4 – 123
revision, 4 – 7
standard purchase orders, 4 – 4
tax information at distribution level, 4 – 77
tax information at shipment level, 4 – 68
types, 4 – 4
viewing changes to, 8 – 4
viewing line–level tax, 4 – 47
Purchase Orders window
Entering Purchase Agreement Header Information, 4 – 55
entering purchase agreement line information, 4 – 56
Entering Purchase Order Headers, 4 – 39
Entering Purchase Order Lines, 4 – 45
Entering Purchase Order Miscellaneous Information, 4 – 53
Entering Purchase Order Price Reference Information, 4 – 49
Entering Purchase Order Reference Document Information, 4 – 51
Purchase Orders, finding, 4 – 19
Purchase Price Variance report, 9 – 100
Purchase Requisition Status report, 9 – 102
Purchase Summary by Category report, 9 – 104
Purchasing Accounting Lines window, 7 – 70
Purchasing Activity Register, 9 – 105
Purchasing Database Administration, 9 – 107
Purchasing Documents Open Interface, 5 – 22
monitoring supplier price increases, 5 – 26
price tolerance, 5 – 25
sourcing, 5 – 23
Purchasing Documents Open Interface Report, 9 – 108
Purchasing Interface Errors Report, 9 – 111
Purchasing Options
accrual options, 1 – 48
collection options, 1 – 48
default options, 1 – 48
internal requisition options, 1 – 45
numbering options, 1 – 45
tax defaults options, 1 – 45
Purchasing options
accrual options, 1 – 48
control options, 1 – 49
default options, 1 – 45
internal requisition options, 1 – 52
numbering options, 1 – 53
numbering options in a Multi–Org setup, 1 – 54
tax defaults options, 1 – 55
Purchasing Options window, Defining Purchasing Options, 1 – 45
Purchasing options, defining, 1 – 45
Purchasing Periods, controlling, 1 – 93
Purchasing Services, 1 – 79
Purge Purchasing Open Interface Processed Data process, 9 – 113

Q
Quality Code Listing, 9 – 114
Quality Inspection Codes
  quality code, 1 – 77
  ranking number, 1 – 77
Quality Inspection Codes window, Defining Quality Inspection Codes, 1 – 77
Quality Inspection Codes, defining, 1 – 77
Quality results
  entering (overview), 7 – 47
  entering in Receiving Transactions window, 7 – 65
Quantity–Based Purchasing, 1 – 80
Quotation Action Required report, 9 – 115
Quotation Headers, entering, 5 – 73
Quotation lines, using line types, 1 – 84
Quotation Lines, entering, 5 – 77
Quotation numbers
  entry method setup, 1 – 53
  entry type setup, 1 – 54
Quotation Price Breaks window, Entering Quotation Price Break Information, 5 – 84
Quotation Price Breaks, entering, 5 – 84
Quotation Shipments window, Entering Quotation Shipment Information, 5 – 81
Quotation Shipments, approving, 5 – 91
Quotation Shipments, entering, 5 – 81
Quotation Terms window, Entering Quotation Terms Information, 5 – 80
Quotation Terms, entering, 5 – 79
Quotations
  autocreating, 5 – 4
  copying from RFQs, 5 – 88
  numbering options, 5 – 3
  purchase orders, 5 – 6
  requisitions, 5 – 6
  types, 5 – 7
  warning delay default, 1 – 47
Quotations window
  Entering Quotation Headers, 5 – 73
  Entering Quotation Lines, 5 – 77
Quotations, approving entire, 5 – 93
Quotations, finding, 5 – 90
Quote warning delay, option setup, 1 – 47

R
Realms window, 1 – 102
Reassign, through Notifications Summary window, 2 – 32
Receipt accounting
  overview, 7 – 101
  viewing from receiving transaction, 7 – 53
Receipt Accruals – Period End process, 7 – 120, 9 – 119
Receipt Adjustments Report, 9 – 122
Receipt Close % Tolerance, setup, 7 – 9
Receipt Close Point, option setup, 1 – 50
Receipt close point, setup, 7 – 10
Receipt Close Tolerance percentage, option setup, 1 – 47
Receipt Date Control, option setup, 1 – 58
Receipt exchange information
  entering, 7 – 36
  in Corrections window, 7 – 90
  in Receiving Transactions window, 7 – 69
Receipt Header Details window, Using the Receipt Header Details window, 7 – 57
Receipt Header Details window, using, 7 – 57
Receipt Header window, Entering Receipt Headers, 7 – 32
Receipt Headers, entering, 7 – 32
Receipt Lines, entering, 7–34
Receipt numbering
  alphanumeric or numeric, 7–10
  automatic or manual, 7–10
  option setup, 1–60
Receipt Routing, option setup, 1–60
Receipt routing override, setup, 7–11
Receipt routing, default, setup, 7–11
Receipt tolerances, 7–13
Receipt Traveler, 9–124
Receipt Traveler, automatic print, setup, 7–11
Receipt Travelers, 7–99
Receipt–invoice matching
  with ASN, 7–17
  with Payment on Receipt, 9–67
Receipts
  cascade, 7–25
  express, 7–26
  Receipt Traveler, 7–99
  Substitute Receipts Report, 9–157
Receipts window
  Entering exchange rate information, 7–36
  Entering Express Receipts, 7–27
  Entering Receipt Lines, 7–34
Receiving
  accrue un–invoiced receipts, 7–4
  blind receiving, 7–2
  Cascade, 7–2
  closed for invoicing, 7–4
  closed for receiving, 7–4
  control numbers, 7–5
  entering Quality results (overview), 7–47
  entering Quality results in Receiving Transactions window, 7–65
  Express Receipt, 7–2
  hazardous materials, 7–5
  inspection, 7–5
  locator, 7–5
  match approval levels, 7–3
  overview, 7–2
  predefined substitute items, 7–3
  quality and destination, 7–5
  receiving tolerances, 7–2
  returns, 7–5
  services and labor, 7–4
  supply information, 7–3
  transfers of inventory items, 7–3
  unordered items, 7–3
Receiving Account Distributions report, 9–126
Receiving account, default, setup, 7–11
Receiving Accrual Account, option setup, 1–61
Receiving Controls window, Entering Purchase Order Receiving Controls, 4–69
Receiving Controls, Options, and Profiles, 7–9
Receiving corrections, 7–84
Receiving Exceptions report, 9–128
Receiving Headers Summary window, using, 7–50
Receiving Inspections, 7–72
Receiving Locations, 7–7
Receiving Options window, Defining Receiving Options, 1–58
Receiving Options, defining, 1–58
Receiving Reports, 7–99
Receiving Returns, 7–76
Receiving Returns window, Entering Receiving Returns, 7–80
Receiving Services, 1–83
Receiving Transaction Processor, 9–131
Receiving Transaction Summary window, using, 7–51
Receiving Transactions, 7–45
  cascade, 7–25
  express, 7–26
Receiving transactions (summary), finding, 7–47
Receiving Transactions Register, 9–133
Receiving Transactions Summary window, Using the Receiving Transactions Summary window, 7–52
Receiving Transactions window
  entering Quality results, 7–65
  Entering Receiving Transactions, 7–66
  exchange rate and Currency, 7–69
Receiving Transactions, entering, 7–65
Receiving transactions, finding, 7–62
Receiving Value by Destination Account report, 9 – 139
Receiving Value report, 9 – 136
Recovery Rate field, overview, 4 – 137
Regulation Background
hazard class, 1 – 68
identification number, 1 – 68
labels required, 1 – 69
packaging requirements, 1 – 69
shipping name, 1 – 67
shipping requirements, 1 – 69
Reject PO subprocess activities
Document Manager Failed, C – 169
End, C – 169
Reject The PO, C – 169
Start, C – 169
Unable To Reject Document, C – 169
Reject PO subprocess overview, C – 167
Reject Requisition subprocess activities
Document Manager Failed, C – 91
End, C – 91
Reject the Requisition, C – 91
Start, C – 90
Unable to Reject Document, C – 91
Reject Requisition subprocess overview, C – 89
Release distributions, entering, 4 – 97
Release generation, automatic, 4 – 103
Release Headers, entering, 4 – 87
Release shipments, entering, 4 – 90
Releases
blanket, 4 – 4
scheduled, 4 – 5
tax information at distribution level, 4 – 100
tax information at shipment level, 4 – 96
Releases window
Entering Release Headers, 4 – 87
Entering Release Shipments, 4 – 90
Reports
Accrual Reconciliation, 9 – 5
Accrual Write–Off, 9 – 13
Backordered Internal Requisitions, 9 – 18
Blanket and Planned PO Status, 9 – 19
Buyer Listing, 9 – 21
Buyer’s Requisition Action Required, 9 – 23
Cancelled Purchase Order, 9 – 25
Cancelled Requisition, 9 – 26
Contract Status, 9 – 30
Country of Origin (by Item), 9 – 31
Country of Origin (by Supplier), 9 – 33
Define MassCancel Listing, 2 – 63
Encumbrance Detail, 9 – 37
Expected Receipts Report, 9 – 39
Financials/Purchasing Options Listing, 9 – 42
Internal Requisition Status Report, 9 – 43
Internal Requisitions/Deliveries
Discrepancy, 9 – 45
Invoice Price Variance by Vendor, 9 – 49
Invoice Price Variance Report, 9 – 47
Item Detail Listing, 9 – 51
Item Summary Listing, 9 – 53
Location Listing, 9 – 54
Matching Holds by Buyer, 9 – 56
New Vendor Letter, 9 – 58
Open Purchase Orders By Buyer, 9 – 60
Open Purchase Orders by Organization, 9 – 61
Overdue Vendor Shipments Report, 9 – 62
Overshipments, 9 – 64
Printed Change Orders (Landscape), 9 – 74
Printed Change Orders (Portrait), 9 – 77
Printed Purchase Order (Landscape), 9 – 80
Printed Purchase Order (Portrait), 9 – 83
Printed Requisitions, 9 – 90
Printed RFQ (Landscape), 9 – 86
Printed RFQ Report (Portrait), 9 – 88
Purchase Agreement Audit, 9 – 91
Purchase Order and Releases Detail, 9 – 99
Purchase Order Commitment, 9 – 93
Purchase Order Detail, 9 – 95
Purchase Order Distribution Detail, 9 – 97
Purchase Price Variance Report, 9 – 100
Purchase Requisition Status Report, 9 – 102
Purchase Summary by Category, 9 – 104
Purchasing Activity Register, 9 – 105
Purchasing Documents Open Interface, 9 – 108
Purchasing Interface Errors, 9 – 111
Quality Code Listing, 9 – 114
Quotation Action Required, 9 – 115
Receipt Adjustments Report, 9 – 122
Receipt Traveler, 9 – 124
Receiving Account Distributions Report, 9 – 126
Receiving Exceptions Report, 9–128
Receiving Transactions Register, 9–133
Receiving Value by Destination Account Report, 9–139
Receiving Value Report, 9–136
ReqExpress Templates Listing, 9–141
Requisition Activity Register, 9–142
Requisition Distribution Detail, 9–143
Requisition Import Exceptions, 9–148
Requisitions on Cancelled Sales Orders, 9–149
RFQ Action Required, 9–117
Run MassCancel Listing, 2–67
Savings Analysis (By Buyer), 9–151
Savings Analysis (By Category), 9–153
Standard Notes Listing, 9–156
Substitute Receipts Report, 9–157
Tax Code Listing, 9–169
Uninvoiced Receipts, 9–170
Unit of Measure Class Listing, 9–172
Unit of Measure Listing, 9–173
Unordered Receipts, 9–175
Vendor Affiliated Structure Listing, 9–158
Vendor Price Performance Analysis, 9–159
Vendor Purchase Summary, 9–161
Vendor Quality Performance Analysis, 9–163
Vendor Service Performance Analysis, 9–165
Vendor Volume Analysis, 9–167
Vendors on Hold, 9–168
Req Import group by, option setup, 1–46
ReqExpress, definition, 3–5
ReqExpress Templates Listing, 9–141
ReqImport, definition, 3–6
Requires Reapproval status, effect on supply, 2–26
Requisition Activity Register, 9–142
Requisition Distribution Detail report, 9–143
Requisition Distributions, 3–68
Requisition Distributions Summary window, Using the Requisition Distributions Summary Window, 3–49
Requisition Distributions Summary window, using, 3–49

Requisition Headers
enter requisition preferences, 3–59
open the Supplier Item Catalog, 3–58
take approval actions, 3–58
to check funds, 3–59
Requisition Headers Summary window, Using the Requisition Headers Summary Window, 3–44
Requisition Headers Summary window, using, 3–44
enter a new requisition, 3–45
enter requisition preferences, 3–46
navigate, 3–44
open for the current line, 3–45
requisition control information, 3–46
view action history, 3–46
view distributions information, 3–46
view purchase orders, 3–46
view requisition line information, 3–45
view sales orders, 3–46
Requisition Headers, entering, 3–57
Requisition Import Exceptions report, 9–148
Requisition Import process, 9–144
Requisition Lines
enter line details, 3–64
enter requisition distributions, 3–65
enter requisition preferences, 3–66
line currency information, 3–64
line source details, 3–64
open the Supplier Item Catalog, 3–65
outside processing information, 3–65
to approve requisitions, 3–66
to check funds, 3–66
Requisition lines, using line types, 1–84
Requisition Lines for AutoCreate, finding, 6–12
Requisition Lines Summary window, Using the Requisition Lines Summary Window, 3–47
Requisition Lines Summary window, using, 3–47
view purchase orders, 3–48
view sales orders, 3–48
Requisition Lines, assigning, 5–102
Requisition lines, entering, 3 – 60
Requisition Lines, finding for review or assignment, 5 – 98
Requisition lines, modifying during AutoCreate, 6 – 24
Requisition numbers
entry method setup, 1 – 53
entry type setup, 1 – 54
Requisition Preferences window, Entering Requisition Preferences, 3 – 52
Requisition preferences, entering, 3 – 52
Requisition Template, copy button, 1 – 63
Requisition Templates window, Defining Requisition Express Templates, 1 – 62
Requisition Templates, defining, 1 – 62
Requisition templates, using, 3 – 73
Requisitions
accounting information, 3 – 4
action history, 8 – 2
approval history, 3 – 4
approval status, 3 – 4
approvals, 3 – 5
assigning to a buyer, 3 – 11
AutoApproval, 3 – 6
cancelling, 3 – 12
emergency, 6 – 9
currency, 3 – 9
finally closing, 3 – 13
foreign currency, 3 – 11
imported, 3 – 8
imported from Self-Service Purchasing, 6 – 9
importing from another system, 3 – 6
Internal, 3 – 8
kanban replenishments, 3 – 19
on-line entry, 3 – 3
paper, 3 – 9
paperless system, 3 – 3
placing in the Navigator for easy access, 3 – 6
printing, 3 – 5
purchase, 3 – 8
Purchase Requisitions Status report, 9 – 102
quantity rounding, 3 – 5
reserving funds for, 3 – 9
resubmission, 3 – 4
returning, 3 – 11
templates, 3 – 8
updating during approval, 3 – 14
updating with Modify, 3 – 13
viewing distribution-level tax, 3 – 70
viewing line-level tax, 3 – 66
Requisitions cancellation, 3 – 4, 3 – 26
Requisitions on Cancelled Sales Order Report, 9 – 149
Requisitions window
Entering Requisition Headers, 3 – 57
Entering Requisition Lines, 3 – 60
using requisition templates, 3 – 73
Requisitions, finding, 3 – 42
Requisitions, overview, 3 – 2
Requisition Template
copy lines, 1 – 63
define, 1 – 62
manually add lines, 1 – 64
sourcing information, 1 – 65
Reschedule Requisitions process, 9 – 150
Reserve at the Start subprocess activities
Document Manager Failed, C – 84
End, C – 84
Is Encumbrance On and Is Document Not Reserved?, C – 84
Is Interface Source Req Import, C – 83
Reserve Document, C – 84
Start, C – 83
Reserve at the Start subprocess overview, C – 82
Reserve Before Approve subprocess activities
Document Manager Failed, C – 105
Document Manager Failed (for purchase orders), C – 142
End (for purchase orders), C – 143
Is Encumbrance On and Is Document Not Reserved?, C – 105
Is Encumbrance On and Is Document Not Reserved? (for purchase orders), C – 142
Is Forward–To Valid, C – 105
Is Forward–To Valid? (for purchase orders), C – 143
Reject the PO (for purchase orders), C – 143
Reject the Requisition, C – 106
Reserve Document, C – 105
Reserve Document (for purchase orders), C – 142
Set Forward–To/From For Forward Action (for purchase orders), C – 143
Set Forward–To/From Forward, C – 106
Start (for purchase orders), C – 142
Unable to Reject Document, C – 106
Unable to Reject Document (for purchase orders), C – 143
Unable to Reserve Document, C – 105
Unable To Reserve Document (for purchase orders), C – 143
Reserve Before Approve subprocess overview, in the PO Approval workflow, C – 140
Reserve for Encumbrance account. See Glossary
Reserving funds changing documents, 4 – 132
for requisitions, 3 – 9
through Approve Document window, 2 – 36
Return material authorizations, 7 – 14
Return PO to Submitter subprocess activities
End, C – 167
Is Submitter Last Approver?, C – 167
Notify Last Approver Of No Approver Found, C – 167
Notify Preparer Of No Approver Found, C – 166
Set PO Status to Original Status, C – 166
Start, C – 166
Return PO to Submitter subprocess overview, C – 165
Return Requisition to Submitter subprocess activities
End, C – 93
Is Submitter Last Approver?, C – 93
Notify Last Approver of No Approver Found, C – 93
Notify Requestor of No Approver Available, C – 93
Set Req Status to Original Status, C – 92
Start, C – 92
Return Requisition to Submitter subprocess overview, C – 91
Return to supplier from inventory or expense destinations, standard costing, 7 – 115
Return to supplier from receiving, standard costing, 7 – 115
Returns, 7 – 76
Returns, entering, 7 – 80
Returns, finding, 7 – 77
Review, requisition approvals, 8 – 2
Review Buyer Workload window, Reviewing Buyer Workload, 5 – 101
Reviewing Requisitions, 3 – 10
RFQ, requirement, 5 – 4
RFQ Action Required report, 9 – 117
RFQ Headers, entering, 5 – 57
RFQ lines, using line types, 1 – 84
RFQ Lines, entering, 5 – 60
RFQ numbers
entry method setup, 1 – 53
entry type setup, 1 – 54
RFQ Price Break Information, entering, 5 – 69
RFQ Price Breaks window, Entering RFQ Price Break Information, 5 – 69
RFQ required, option setup, 1 – 47
RFQ Shipment Information, entering, 5 – 66
RFQ Shipments window, Entering RFQ Shipment Information, 5 – 67
RFQ Supplier Information, entering, 5 – 63
RFQ Suppliers window, Entering RFQ Supplier Information, 5 – 63
RFQ Terms Information, entering, 5 – 65
RFQ Terms window, Entering RFQ Terms Information, 5 – 65
RFQs
autocreating, 5 – 4
numbering options, 5 – 3
supplier lists, 5 – 4
types, 5 – 7
RFQs window
Entering RFQ Headers, 5 – 58
Entering RFQ Lines, 5 – 60
RMAs, 7 – 14
Routing Control
Allow Change to Approval Hierarchy, 2 – 14
Allow Change to Forward–From, 2 – 13
Allow Change to Forward–To, 2 – 13
Approval Hierarchy, 2 – 14
Forwarding Method, 2 – 14
Owner Can Approve, 2 – 13
Run MassCancel
  purchase order, 2 – 61
  requisition, 2 – 61
Run MassCancel Listing, 2 – 67
Run MassCancel window, 2 – 61
  Running MassCancel, 2 – 66

S

Sample alerts, for Oracle Public Sector Purchasing, B – 3
Savings Analysis (By Buyer) report, 9 – 151
Savings Analysis Report (By Category), 9 – 153
Scheduled releases, 4 – 5
Search Supplier Item Catalog window, Finding Supplier Items, 5 – 12
Security Hierarchy, options setup, 1 – 51
Self–Service Purchasing, requisitions and AutoCreate, 6 – 9
Send Notifications for Purchasing Documents process, 9 – 155
Serial numbers, 7 – 96
Setting Up a Default Line Type, 1 – 81
  setup overview, 1 – 2
Shipments window, Entering Purchase Order Shipments, 4 – 63
Shipments, managing, 7 – 93
Sourcing
  automatic (overview), 5 – 30
  automatic (setting up), 5 – 33
  overview, 5 – 2
  through the Purchasing Documents Open Interface, 5 – 23
Sourcing rules
  overview, 5 – 30
  setting up, 5 – 33
Sourcing Services, 1 – 83
Standard costing transactions
  delivery from receiving inspection to inventory, 7 – 111
  matching invoices, 7 – 114
  purchase order receipt to expense destinations, 7 – 113
  purchase order receipt to inventory, 7 – 112
  purchase order receipt to receiving inspection, 7 – 110
  return to supplier from inventory or expense destinations, 7 – 115
  return to supplier from receiving, 7 – 115
Standard Notes Listing, 9 – 156
Standard purchase orders, 4 – 4
Standard quotation or RFQ, 5 – 7
Start of Approve Requisition subprocess activities
  Get Requisition Attributes, C – 79
  Get Workflow Approval Mode, C – 78
  Remove All Notifications For This Document, C – 78
  Set Req Status to In–Process and Update with Item Type & Key, C – 78
  Set Workflow Startup Values, C – 78
  Wait for Background Process, C – 78
Status, defining approved supplier, 5 – 45
Stock locators, 7 – 97
Submission Check Rules, 2 – 28
Submission Check, 2 – 27
Substitute Receipts, option setup, 1 – 59
Substitute receipts, setup, 7 – 10
Substitute Receipts Report, 9 – 157
Supplier and Item/Commodity Combination, defining, 5 – 47
Supplier Item Catalog
  Order Pad, 5 – 9
  order pad options, 5 – 10
  Order Total, 5 – 11
  search window, 5 – 8
  Select Price Only, 5 – 11
  sourcing regions, 5 – 8
Supplier Item Catalog Alternative Regions, using, 5 – 15
Supplier Item Catalog window
  Entering Order Pad Options, 5 – 19
  Using the Supplier Item Catalog Alternative Regions, 5 – 16
Supplier Item Catalog, overview, 5 – 8
Supplier Item Catalog, searching, 5 – 11
Supplier Lists, 5 – 4
  alternate fields, 5 – 4
Supplier Lists window, Defining Supplier Lists, 5 – 96
Supplier Lists, defining, 5 – 96
Supplier–Item Attributes window, 5 – 51
Supplier/Item Attributes window, defining, 5 – 51
Suppliers
defaulting, 5 – 33
holding, 5 – 4

T
Tax
at purchase order distribution level, 4 – 77
at purchase order shipment level, 4 – 68
at release distribution level, 4 – 100
at release shipment level, 4 – 96
at requisition distribution level, 3 – 70
at requisition line level, 3 – 66
defaults options, 1 – 55
overview, 4 – 135
Tax Details window, 4 – 140
Tax Summary window, 4 – 138
Tax Code field
overriding, 4 – 136
overview, 4 – 135
Tax Code Listing, 9 – 169
Tax recovery rate, overview, 4 – 137
Terms and Conditions window, Entering
Purchase Order Terms and Conditions Information, 4 – 60
Transaction status information, finding, 7 – 58
Transaction Statuses, 7 – 58

U
UN Numbers window
Defining UN Numbers, 1 – 72
Multilingual Support, 1 – 72
UN Numbers, defining, 1 – 71
Unable to Reserve Document notification, 2 – 34
Uninvoiced Receipts report, 9 – 170
Unit Number field
in purchase order Distributions window, 4 – 79
in release Distributions window, 4 – 102
in requisition Distributions window, 3 – 71
Unit of Measure Class Listing, 9 – 172
Unit of Measure Listing, 9 – 173
Unordered Receipts, 7 – 39
option setup, 1 – 59
Unordered receipts, setup, 7 – 10
Unordered Receipts report, 9 – 175
Unordered receipts, entering, 7 – 40
Unordered Receipts, matching, 7 – 41
Unreserve
purchase orders and requisitions, 4 – 132
through Approve Document window, 2 – 36
Updating Requisitions, 3 – 13
Upgrade Notifications to Release 11 process, 9 – 177
Usages, in attachments, 1 – 42
Using Attachments, 1 – 37
Using Internal Requisitions, 3 – 18

V
Vendor, Volume, 9 – 161
Vendor Affiliated Structure Listing, 9 – 158
Vendor Price Performance Analysis report, 9 – 159
Vendor Purchase Summary report, 9 – 161
Vendor Quality Performance Analysis report, 9 – 163
Vendor Service Performance Analysis report, 9 – 165
Vendor Volume Analysis report, 9 – 167
Vendors on Hold report, 9 – 168
Verify Approval Authority subprocess activities
Document Manager Failed, C – 86, C – 113
Document Manager Failed (for purchase orders), C – 145
Does Approver Have Authority?, C – 86, C – 113
Does Approver Have Authority? (for purchase orders), C – 145
End, C – 86
End (for purchase orders), C – 145
Start, C – 86
Start (for purchase orders), C – 145
Verify Approval Authority subprocess overview
in the PO Approval workflow, C – 144
in the PO Requisition Approval workflow, C – 84
Verify PO subprocess activities
Document Failed Correctness Check, C – 140
Document Failed State Check, C – 140
Document Manager Failed, C – 140
Does Document State Allow Approval Action?, C – 139
End, C – 140
Is Document Complete?, C – 139
Open Document State, C – 139
Record 'Submit' In Action History, C – 139
Set PO Status to Original Status, C – 140
Start, C – 139
Verify PO subprocess overview, C – 137
Verify Req Line Info process activities
Continue Flow, C – 230
Does the Req Line Have A One–Time Item?, C – 229
Does This Req Line Require An RFQ?, C – 228
Get Release Generation Method From ASL, C – 229
Get Req Line Info, C – 228
Get The Source Document Type, C – 229
Insert Req Line Into Temp Table As A Candidate For Creation, C – 230
Is This An Emergency Requisition?, C – 229
Is This Req Line a P–Card Line?, C – 229, C – 233
Should Workflow Create The Release?, C – 230
Start, C – 228
Verify Req Line Information process overview, C – 225
Verify Requisition subprocess activities
Document Failed Correctness Check, C – 81
Document Failed State Check, C – 81
Document Manager Failed, C – 81
Does Document State Allow Approval Action?, C – 80
End, C – 81
Is Document Complete?, C – 81
Record Submit In Action History, C – 81
Set Req Status to Original Status, C – 81
Start, C – 80
Verify Requisition subprocess overview, C – 79
View Accounting window, 7 – 56
View Accounting windows, customizing, 7 – 56
View Approved Suppliers, 5 – 56
View Receiving Accounting window, 7 – 54, 7 – 56
Viewing changes to purchase orders, 8 – 4

W
Web Requisition Approval List Routing Subprocess Activities
Get Next Approver, C – 88
Rebuild Approval List for Invalid Approver, C – 88
Web Requisition Main Requisition Approval Process Activities
Build Default Approval List, C – 73
Create Information Template Attachment, C – 75
Does Approval List Exist?, C – 73
Is Approval List Empty?, C – 74, C – 89
Rebuild Approval List After Forward Action, C – 74
Set Requisition Status to Pre–Approved, C – 73, C – 98, C – 100
Web Requisition Main Requisition Approval process overview, C – 69
Web Requisition Notify Approver Subprocess Activities, Update Action History (Expect Response), C – 96
Web Requisition Reserve at the Start Subprocess Activities, Is Requisition Created Through the Web, C – 83
Web Requisition Response with Approve Action Subprocess Activities
Update Action History (Approve), C – 98
Update Approval List Response, C – 98, C – 101, C – 102, C – 103
Web Requisition Response with Approve and Forward Action Subprocess Activities, Update Action History (Approve/Forward), C – 100
Web Requisition Response with Forward Action Subprocess Activities, Update Action History (Forward), C – 102
Web Requisition Response with Reject Action Subprocess Activities, Update Action History (Reject), C – 103
Web Requisition Start Process Activities, Find Approval List, C – 78
Windows, navigator paths, A – 2
Workflow, overall document creation process, C – 219
Workflow Background process, 1 – 100
Workflow for price exceeded notifications, naming conventions, C – 273
Workflow Monitor
Account Generator, C – 55
PO Create Documents workflow, C – 238
Workflow setup options, 1 – 95
Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this publication. Your input is an important part of the information we use for revision.

- Did you find any errors?
- Is the information clearly presented?
- Do you need more information? If so, where?
- Are the examples correct? Do you need more examples?
- What features did you like most about this manual? What did you like least about it?

If you find any errors or have any other suggestions for improvement, please indicate the topic, chapter, and page number below:

______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________

Please send your comments to:
Oracle Public Sector Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway, MS 3op7
Redwood Shores, CA 94065 USA
Phone: (650) 506–8968 Fax: (650) 506–7800

If you would like a reply, please give your name, address, and telephone number below:

______________________________________________________________________________
______________________________________________________________________________

Thank you for helping us improve our documentation.
Oracle® Public Sector Purchasing User’s Guide

RELEASE 11i
Volume 2

June 2001
Contents

Volume 1

Preface ................................................................. xi

Chapter 1

Setting Up ............................................................. 1 – 1
Overview of Setting Up .......................................... 1 – 2
Defining Locations .................................................. 1 – 24
Defining Buyers ....................................................... 1 – 27
Defining Approval Groups ....................................... 1 – 29
Assigning Approval Groups ..................................... 1 – 33
Annotating Purchasing Documents ......................... 1 – 36
Defining Purchasing Options ................................... 1 – 45
Defining Receiving Options ..................................... 1 – 58
Defining Requisition Templates ............................... 1 – 62
Purchasing Hazardous Materials ............................... 1 – 67
Defining Lookup Codes ............................................ 1 – 74
Purchasing Services .................................................. 1 – 79
Defining Document Types ......................................... 1 – 87
Controlling Purchasing Periods ................................. 1 – 93
Choosing Workflow Options ..................................... 1 – 95
iProcurement Setup Windows .................................. 1 – 102
Profile Options and Security Functions ...................... 1 – 103
Entering Outside Processing Information ...................... 4 – 80
Entering Purchase Order Notification Controls ............... 4 – 82
Entering and Viewing Purchase Order Acceptances ........... 4 – 84
Entering Releases .............................................. 4 – 87
Automatic Release Generation .................................. 4 – 103
Copying Purchase Orders ....................................... 4 – 106
Printed Purchase Order Overview ............................... 4 – 109
Document Revision Numbering .................................. 4 – 123
Changing Encumbered Documents ............................... 4 – 132
Drop Shipments .................................................. 4 – 133
Tax Defaults in Purchasing ....................................... 4 – 135
Procurement Card Purchase Orders and Releases ............. 4 – 143

Chapter 5  

Supply Base Management ....................................... 5 – 1
Overview of Sourcing, RFQs, and Quotations ................... 5 – 2
Overview of the Supplier Item Catalog ........................... 5 – 8
Receiving Price/Sales Catalog Information Electronically .... 5 – 22
Overview of Automatic Sourcing ................................ 5 – 30
Approved Supplier List .......................................... 5 – 42
Entering RFQs .................................................... 5 – 57
Entering Quotations .............................................. 5 – 73
Copying Quotations from RFQs ................................ 5 – 88
Approving Quotations ........................................... 5 – 90
Defining Supplier Lists .......................................... 5 – 96
Managing Buyer Workload ...................................... 5 – 98

Chapter 6  

Documents ....................................................... 6 – 1
AutoCreate Documents Overview ................................ 6 – 2
Finding Requisition Lines for AutoCreate ....................... 6 – 12
Selecting AutoCreate Criteria ................................... 6 – 16
Entering Document Information and Completing AutoCreate 6 – 19
Using the Document Builder ...................................... 6 – 22
Modifying Requisition Lines .................................... 6 – 24

Chapter 7  

Receiving ......................................................... 7 – 1
Overview of Receiving .......................................... 7 – 2
Advance Shipment Notices (ASNs) ................................. 7 – 17
Managing Receipts .................................................. 7 – 23
Unordered Receipts .................................................. 7 – 39
Receiving Transactions .............................................. 7 – 45
Inspections ............................................................. 7 – 72
Returns ................................................................. 7 – 76
Corrections .............................................................. 7 – 84
Finding Intransit Shipments ...................................... 7 – 92
Control Numbers ..................................................... 7 – 96
Receiving Reports ..................................................... 7 – 99
Overview of Receipt Accounting ............................... 7 – 101
Fund Accounting in Oracle Public Sector Purchasing .... 7 – 130

Index

Volume 2

Chapter 8  Inquiries ...................................................... 8 – 1
Viewing Action History .............................................. 8 – 2
Viewing Purchase Order Changes .............................. 8 – 4

Chapter 9  Reports and Processes ................................. 9 – 1
Accrual Reconciliation Report .................................... 9 – 5
Accrual Write–Off Report .......................................... 9 – 13
Advanced Shipment Notice Discrepant Receipts Report .... 9 – 16
ASL Upgrade Process .................................................. 9 – 17
Backordered Internal Requisitions Report .................... 9 – 18
Blanket and Planned PO Status Report ....................... 9 – 19
Buyer Listing ............................................................. 9 – 21
Buyer’s Requisition Action Required Report ................ 9 – 23
Cancelled Purchase Orders Report .............................. 9 – 25
Cancelled Requisitions Report ................................... 9 – 26
Confirm Receipts Workflow Select Orders Process ........ 9 – 28
Contract Status Report ............................................... 9 – 30
Country of Origin Report (by Item) ......................... 9 – 31
Country of Origin Report (by Supplier) .................... 9 – 33
Create Internal Sales Orders Process ......................... 9 – 35
Create Releases Process .................................................. 9 – 36
Encumbrance Detail Report .............................................. 9 – 37
Expected Receipts Report ................................................. 9 – 39
Fill Employee Hierarchy Process ....................................... 9 – 41
Financials/Purchasing Options Listing ............................... 9 – 42
Internal Requisition Status Report .................................... 9 – 43
Internal Requisitions/Deliveries Discrepancy Report ............ 9 – 45
Invoice Price Variance Report .......................................... 9 – 47
Invoice Price Variance by Supplier Report ......................... 9 – 49
Item Detail Listing .......................................................... 9 – 51
Item Summary Listing ..................................................... 9 – 53
Location Listing ............................................................ 9 – 54
Matching Holds by Buyer Report ....................................... 9 – 56
New Supplier Letter Report .............................................. 9 – 58
Open Purchase Orders Report (by Buyer) ......................... 9 – 60
Open Purchase Orders Report (by Organization) .............. 9 – 61
Overdue Supplier Shipments Report ................................. 9 – 62
Overshipments Report ..................................................... 9 – 64
Payment on Receipt ......................................................... 9 – 66
Printed Change Orders Report (Landscape) ....................... 9 – 74
Printed Change Orders Report (Portrait) .......................... 9 – 77
Printed Purchase Order Report (Landscape) ....................... 9 – 80
Printed Purchase Order Report (Portrait) ......................... 9 – 83
Printed RFQ Report (Landscape) ....................................... 9 – 86
Printed RFQ Report (Portrait) .......................................... 9 – 88
Printed Requisitions Report ............................................. 9 – 90
Purchase Agreement Audit Report ................................ 9 – 91
Purchase Order Commitment by Period Report .................. 9 – 93
Purchase Order Detail Report .......................................... 9 – 95
Purchase Order Distribution Detail Report .................... 9 – 97
Purchase Order and Releases Detail Report .................... 9 – 99
Purchase Price Variance Report ..................................... 9 – 100
Purchase Requisition Status Report ............................... 9 – 102
Purchase Summary Report by Category .......................... 9 – 104
Purchasing Activity Register ........................................... 9 – 105
Purchasing Database Administration ............................... 9 – 107
Purchasing Documents Open Interface ............................ 9 – 108
Purchasing Interface Errors Report .................................. 9 – 111
Purge Purchasing Open Interface Processed Data ............ 9 – 113
Quality Code Listing .................................................. 9 – 114
Quotation Action Required Report ................................. 9 – 115
RFQ Action Required Report ....................................... 9 – 117
Receipt Accruals – Period–End Process .......................... 9 – 119
Receipt Adjustments Report ........................................ 9 – 122
Receipt Traveler ......................................................... 9 – 124
Receiving Account Distribution Report ......................... 9 – 126
Receiving Exceptions Report ....................................... 9 – 128
Receiving Interface Errors Report ................................. 9 – 130
Receiving Transaction Processor ................................. 9 – 131
Receiving Transactions Register .................................. 9 – 133
Receiving Value Report .............................................. 9 – 136
Receiving Value Report by Destination Account ......... 9 – 139
ReqExpress Templates Listing ..................................... 9 – 141
Requisition Activity Register ....................................... 9 – 142
Requisition Distribution Detail Report ......................... 9 – 143
Requisition Import Process ......................................... 9 – 144
Requisition Import Exceptions Report .......................... 9 – 148
Requisitions on Cancelled Sales Order Report ......... 9 – 149
Reschedule Requisitions Process ................................. 9 – 150
Savings Analysis Report (by Buyer) ......................... 9 – 151
Savings Analysis Report (by Category) ...................... 9 – 153
Send Notifications for Purchasing Documents .......... 9 – 155
Standard Notes Listing .............................................. 9 – 156
Substitute Receipts Report ......................................... 9 – 157
Supplier Affiliated Structure Listing ......................... 9 – 158
Supplier Price Performance Analysis Report ............ 9 – 159
Supplier Purchase Summary Report ........................... 9 – 161
Supplier Quality Performance Analysis Report ............ 9 – 163
Supplier Service Performance Analysis Report .......... 9 – 165
Supplier Volume Analysis Report ............................... 9 – 167
Suppliers on Hold Report ......................................... 9 – 168
Tax Code Listing ...................................................... 9 – 169
Uninvoiced Receipts Report ....................................... 9 – 170
Unit of Measure Class Listing ..................................... 9 – 172
Unit of Measure Listing ............................................. 9 – 173
Unordered Receipts Report ....................................... 9 – 175
Upgrade Notifications to Release 11 Process .......... 9 – 177
Continued from Volume 1.
This chapter tells you everything you need to know about Oracle Public Sector Purchasing Inquiries, including:

- Viewing Action History: page 8 – 2
- Viewing Purchase Order Changes: page 8 – 4
Viewing Action History

Use this window to review the action history—such as approvals, cancellations, and returns—for specific purchasing documents or document lines.

► To view action history:

Navigate to the Action History window by selecting View Action History from the Tools menu in the following windows:

- Releases
- Purchase Orders
- Purchase Order Shipments
- Purchase Order Distributions
- Purchase Order Headers (Summary)
- Purchase Order Lines (Summary)
- Purchase Order Shipments (Summary)
- Purchase Order Distributions (Summary)
- Requisition Headers Summary
- Requisition Lines Summary
- Requisition Distributions Summary

<table>
<thead>
<tr>
<th>Seq</th>
<th>Date</th>
<th>Rev</th>
<th>Action</th>
<th>Performed By</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>16/JAN/2001</td>
<td>0</td>
<td>Approve</td>
<td>Stock, Ms. Pat</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>16/JAN/2001</td>
<td>0</td>
<td>Submit</td>
<td>Stock, Ms. Pat</td>
<td></td>
</tr>
</tbody>
</table>
Purchasing displays the document approval action Sequence number, the Date of the approval action, the Revision number, the Action performed (Accept, Approve, Approve and Reserve, Cancel, Forward, Import, Reject, Reserve, or Submit), the user whom the action was Performed By, and any Notes.

The Action History window displays only those actions that occurred at the document header or that affected the header. For example, if you changed a line, which incremented the document Revision number in the header, the Action History window displays the new document Revision number, not the line–level change that caused it.

When the Action field is empty, the Performed By field displays the name of the employee in whose approval queue the document currently resides.

See Also

Using the Requisition Headers Summary Window: page 3 – 44
Using the Requisition Lines Summary Window: page 3 – 47
Using the Requisition Distributions Summary Window: page 3 – 49.
Using the Purchase Order Headers Summary Window: page 4 – 23.
Using the Purchase Order Lines Summary Window: page 4 – 26
Using the Purchase Order Distributions Summary Window: page 4 – 32
Using the Receiving Headers Summary Window: page 7 – 50
Using the Receiving Transaction Summary Window: page 7 – 51
Using the Receipt Header Details Window: page 7 – 57
Viewing Transaction Status Information: page 7 – 61
Viewing Purchase Order Changes

The PO Change History menu item in the Oracle Public Sector Purchasing Navigator gives you even more, at-a-glance detail about all past revisions made to archived purchase orders. This menu item uses a Web browser to display the archived revisions. You can then compare the current purchase order with a previous revision or view all past changes to the purchase order. You can see what fields changed and what the fields were before and after the change. This menu item is also part of Oracle iSupplier Portal, if you have access to the Purchasing responsibility within iSupplier Portal.

To navigate to this window from the Oracle Public Sector Purchasing responsibility, choose Purchase Orders > PO Change History.
This chapter tells you everything you need to know about the following Oracle Public Sector Purchasing reports and processes:

- Accrual Reconciliation Report: page 9–5
- Advanced Shipment Notice Discrepant Receipts Report: page 9–16
- ASL Upgrade Process: page 9–17
- Backordered Internal Requisitions Report: page 9–18
- Blanket and Planned PO Status Report: page 9–19
- Buyer Listing: page 9–21
- Buyer’s Requisition Action Required Report: page 9–23
- Cancelled Purchase Orders Report: page 9–25
- Cancelled Requisitions Report: page 9–26
- Confirm Receipts Workflow Select Orders Process: page 9–28
- Contract Status Report: page 9–30
- Country of Origin Report (by Supplier): page 9–33
- Create Internal Sales Orders Process: page 9–35
- Create Releases Process: page 9–36
• Encumbrance Detail Report: page 9 – 37
• Expected Receipts Report: page 9 – 39
• Fill Employee Hierarchy Process: page 9 – 41
• Financials/Purchasing Options Listing: page 9 – 42
• Internal Requisition Status Report: page 9 – 43
• Internal Requisitions/Deliveries Discrepancy Report: page 9 – 45
• Invoice Price Variance Report: page 9 – 47
• Invoice Price Variance by Supplier Report: page 9 – 49
• Item Detail Listing: page 9 – 51
• Item Summary Listing: page 9 – 53
• Location Listing: page 9 – 54
• Matching Holds by Buyer Report: page 9 – 56
• New Supplier Letter Report: page 9 – 58
• Open Purchase Orders Report (by Buyer): page 9 – 60
• Open Purchase Orders Report (by Organization): page 9 – 61
• Overdue Supplier Shipments Report: page 9 – 62
• Overshipments Report: page 9 – 64
• Payment on Receipt: page 9 – 66
• Printed Change Orders Report (Landscape): page 9 – 74
• Printed Change Orders Report (Portrait): page 9 – 77
• Printed Purchase Order Report (Landscape): page 9 – 80
• Printed Purchase Order Report (Portrait): page 9 – 83
• Printed RFQ Report (Landscape): page 9 – 86
• Printed RFQ Report (Portrait): page 9 – 88
• Printed Requisitions Report: page 9 – 90
• Purchase Agreement Audit Report: page 9 – 91
• Purchase Order Commitment by Period Report: page 9 – 93
• Purchase Order Detail Report: page 9 – 95
• Purchase Order Distribution Detail Report: page 9 – 97
• Purchase Order and Releases Detail Report: page 9 – 99
• Purchase Price Variance Report: page 9 – 100
• Purchase Requisition Status Report: page 9 – 102
• Purchase Summary Report by Category: page 9 – 104
• Purchasing Activity Register: page 9 – 105
• Purchasing Database Administration: page 9 – 107
• Purchasing Documents Open Interface: page 9 – 108
• Purchasing Interface Errors Report: page 9 – 111
• Purge Purchasing Open Interface Processed Data: page 9 – 113
• Quality Code Listing: page 9 – 114
• Quotation Action Required Report: page 9 – 115
• RFQ Action Required Report: page 9 – 117
• Receipt Accruals – Period–End Process: page 9 – 119
• Receipt Adjustments Report: page 9 – 122
• Receipt Traveler: page 9 – 124
• Receiving Account Distribution Report: page 9 – 126
• Receiving Exceptions Report: page 9 – 128
• Receiving Interface Errors Report: page 9 – 130
• Receiving Transaction Processor: page 9 – 131
• Receiving Transactions Register: page 9 – 133
• Receiving Value Report: page 9 – 136
• Receiving Value Report by Destination Account: page 9 – 139
• ReqExpress Templates Listing: page 9 – 141
• Requisition Activity Register: page 9 – 142
• Requisition Distribution Detail Report: page 9 – 143
• Requisition Import Process: page 9 – 144
• Requisition Import Exceptions Report: page 9 – 148
• Requisitions on Cancelled Sales Order Report: page 9 – 149
• Reschedule Requisitions Process: page 9 – 150
• Savings Analysis Report (by Buyer): page 9 – 151
• Savings Analysis Report (by Category): page 9 – 153
• Send Notifications for Purchasing Documents: page 9 – 155
• Standard Notes Listing: page 9 – 156
• Substitute Receipts Report: page 9 – 157
• Supplier Affiliated Structure Listing: page 9 – 158
• Supplier Price Performance Analysis Report: page 9 – 159
• Supplier Purchase Summary Report: page 9 – 161
• Supplier Quality Performance Analysis Report: page 9 – 163
• Supplier Service Performance Analysis Report: page 9 – 165
• Supplier Volume Analysis Report: page 9 – 167
• Suppliers on Hold Report: page 9 – 168
• Tax Code Listing: page 9 – 169
• Uninvoiced Receipts Report: page 9 – 170
• Unit of Measure Class Listing: page 9 – 172
• Unit of Measure Listing: page 9 – 173
• Unordered Receipts Report: page 9 – 175
• Upgrade Notifications to Release 11 Process: page 9 – 177
Accrual Reconciliation Report

The Accrual Reconciliation Report can be used to analyze the balance of the Accounts Payable (A/P) accrual accounts. You can accrue both expense and inventory purchases as you receive them. When this happens, you temporarily record an accounts payable liability to your Expense or Inventory A/P accrual accounts. When Payables creates the accounting for the matched and approved invoice, Payables clears the A/P accrual accounts and records the liability from the supplier site.

This report is available in two versions: Accrual Reconciliation Report and Accrual Rebuild Reconciliation Report. When you specify Accrual Rebuild Reconciliation Report, the report selects the accounting entries from the appropriate source (subledgers). This accounting information resides in a temporary table and remains until you rebuild this information again. When you specify Accrual Reconciliation Report, the report does not reselect this information. Instead, it merely reports using the pre-existing information. This feature saves you time, because you do not have to recreate the accrual information every time you submit a report. Typically, you specify the Accrual Rebuild Reconciliation Report at month end and use the Accrual Reconciliation Report for interim reports. Note that the title of the report remains the Accrual Reconciliation Report even if you specify the rebuild option.

After you have entered your receipt transactions and matched your invoices, you can run the report for any transaction date range and identify any differences between your PO Receipts and A/P Invoices. This report also displays any miscellaneous transactions recorded in error to your accrual accounts. These miscellaneous transactions or transactions unrelated to purchase order receipts may be from Payables, Inventory, or Work in Process (depending on your installation). After you have researched the reported accrual balances, you can use the Accrual Write–Offs window to indicate which entries you wish to remove and write off from this report. And, after you have written off these entries, you can use the Accrual Write–Off Report as supporting detail for your manual journal entry.

The Accrual Reconciliation Report helps you monitor potential problems with purchasing and receiving activities that can affect the accuracy of your A/P accrual accounts. You can review this report to identify the following problems in receiving, purchasing, inventory, work in process, or accounts payable transactions:

- Quantities differ between receipts and invoices
- Discrepancies in supplier billing
• Accounts payable matched invoice to wrong purchase order or purchase order line, or the wrong receipt or receipt line
• Receiving clerk received against the wrong purchase order or wrong purchase order line
• Miscellaneous inventory or work in process transactions that do not belong to the accrual accounts
• Payables entries for sales tax and freight that do not belong to the accrual accounts. See: Overview of Receipt Accounting: page 7 – 101.

If you use Inventory, this report automatically reconciles your activity for all inventory organizations. If you use Work in Process for outside processing receipts, this report also reconciles all work in process activity for all organizations.

In addition, the Accrual Reconciliation Report supports multiple A/P accrual accounts. In this case, the report groups information by each account. When you define your purchase order requisitions or orders, the Account Generator processes create your A/P accrual accounts. Typically, you use only one A/P accrual account for all of your inventory organizations. However, for certain situations you may want to use more.

The report prints the following Accrual Transaction types:

**Accounts Payable Accrual Transactions**

* A/P Line Match  
  A/P invoice matching transaction for which there is a receipt against the same purchase order and purchase order line.

* A/P PO Match  
  A/P invoice matching transaction for which there is a receipt on the correct purchase order but against a different purchase order line.

* A/P Item Match  
  A/P invoice matching transaction for which there is a receipt for the item but against a different purchase order and purchase order line.

* A/P No Match  
  A/P invoice that has no corresponding receipt matched to it. However, this invoice is for a valid purchase order for an item you intend to receive.

* A/P No Item  
  A/P invoice matching transaction matched to a purchase order line with an invalid item number. The item is not in your item master but is present on your transactions. This is usually caused by incorrect data conversion from a legacy system.
The report lists the reciprocal of the transaction amount in the Invoice Price Variance column.

**A/P No PO**

A/P transaction charged to the A/P accrual account that is not matched to any purchase order or receipt. Such a transaction should typically be charged to an expense account. The report lists the reciprocal of the transaction amount in the Invoice Price Variance column.

**Exchange Rate Var**

A/P invoice exchange rate variance charged to the A/P accrual account in error. You can use the Accrual Write–Offs window to remove this entry from the report. The report lists the reciprocal of the transaction amount in the Invoice Price Variance column.

**Invoice Price Var**

A/P invoice price variance charged to the A/P accrual account in error. You can use the Accrual Write–Offs window to remove this entry from the report. The report lists the reciprocal of the transaction amount in the Invoice Price Variance column.

**A/P Receipt Match**

A/P invoice transaction matched to a receipt.

**Purchasing Accrual Transactions**

**Receive**

Receipt transaction from a purchase order into receiving.

**Deliver**

Receipt transaction from a purchase order into receiving, and then delivered to its destination.

**Return to Supplier**

Purchase order return from receiving to the supplier.

**Inventory Accrual Transactions**

The Accrual Reconciliation Report lists any Inventory transaction to the A/P accrual account. Typically, these material transaction types are Account issue, Account receipt, Account alias issue, Account alias receipt, Miscellaneous issue, or Miscellaneous receipt transaction. Usually, these transactions should not be charged to the A/P accrual account.
**Work in Process Accrual Transactions**

The Accrual Reconciliation Report lists any Work in Process transaction to the A/P accrual account. Typically, these are Assembly scrap transactions that are charged to the wrong account.

The report prints the unit of measure for the purchase order receipt, the invoice, the inventory transaction, or work in process transaction.

The Transaction Quantity is the quantity received or the quantity invoiced, depending on the type of transaction. Quantities received are negative since purchase order receipts credit the A/P accrual account. Quantities invoiced are positive since invoices debit the A/P accrual account.

The Unit Price is the purchase order price of the receipt, the actual invoice price, or the transaction unit cost. If the purchase order is in a foreign currency, the purchase order price is in the base currency of your set of books using the currency conversion rate from the purchase order if the Invoice Match Option on the purchase order shipment is Purchase Order, and from the receipt if the Invoice Match Option is Receipt.

The Transaction Amount is the total amount posted by the transaction source to the A/P accrual account. The total of this column should add up to the balance of your A/P accrual account in your general ledger, by source (subledger). Purchase order receipts are negative to indicate a credit. Payables invoices are positive to indicate a debit. This amount is in the base currency for your set of books.

For prior release transactions, the report prints the actual invoice price variance. The total of this column represents the total invoice price variance for the reported transactions. If you did not use the previous release, the Invoice Price Variance column is usually zero. You can use the Accrual Write–Offs window to remove any invoice price variance related transactions from this report. This amount is in the base currency for your set of books.

If you used Inventory and Payables in a prior release, the Net Accrual Balance column represents the net balance of the A/P accrual account after you moved the IPV out of this account. If you did not use a previous release, this column usually has the same value as the Transaction Amount column. This amount is in the base currency for your set of books.
Report Summary By Source and Accrual Transaction

Purchasing displays the report totals by each transaction source for all transactions in your report. Within each transaction source, Purchasing displays a summary total for each accrual transaction. Analyze the accrual transaction summary totals for purchase order receipt, invoice, and other miscellaneous transactions.

If you do not display written off transactions, a summary column displays the total write-offs not included in the report. If you do not display zero balance purchase order line entries, a summary column displays the accrual transaction totals not included in the report. Using the total column, you can balance this report by transaction source to your general ledger.

Prerequisites

If you install Purchasing and Oracle Public Sector Payables, you can run this report. If you accrue expense purchases on receipt, you can reconcile your expense A/P accrual account using this report. If you accrue expense purchases at period end and you do not perform inventory receipts, no information will be available to report. If you have installed Inventory or Work in Process, the Accrual Reconciliation Report also displays any inventory or work in process transactions for the accrual accounts.

Attention: Most commercial installations accrue expense receipts at period end because this information is not required as the receipt occurs. If you accrue expense purchases on receipt, you have more entries to reconcile in the A/P accrual accounts. In addition, if you also receive inventory, you need to use the Receiving Value By Destination Account Report to break out your receiving/inspection value by asset and expense.

In addition, for transactions to appear on this report, you should download the transactions to the General Ledger interface. For Payables, you need to create journal entries for the invoices. For Purchasing, all transactions are automatically transferred to the General Ledger interface. For Inventory and Work in Process, you must first perform a GL transfer or period close, for transactions to appear on this report. The Accrual Reconciliation Report requires the transactions to be transferred to the General Ledger interface to ensure the report balances to your general ledger.
Attention: Since the Accrual Reconciliation Report is 180 columns wide, you need to use a printer with this capability.

Report Submission

In the Submit Requests window, select Accrual Reconciliation Report or Accrual Rebuild Reconciliation Report in the Name field.

Report Parameters

**Title**

Enter a user defined Title for the report.

**Sort By**

Use the Sort By feature to produce a report customized to your specific needs. Choose one of the following options:

- **Item**
  
  Sort the report by item (aging date, account, item, and purchase order line). When you sort by item, the item heading is printed.

- **Supplier**
  
  Sort the report by supplier (aging date, account, supplier, and purchase order line). When you sort by supplier, the supplier name heading is printed.

**GL Dates From/To**

Enter the beginning and ending general ledger dates. These are also known as the beginning and ending transaction dates.

**Items From/To**

Enter the beginning and ending item numbers.

**Suppliers From/To**

Enter the beginning and ending supplier names.
Include All Transactions

Enter Yes or No to indicate whether you want to print zero balance purchase order line subtotals on the report. The report adds up all receipts and invoices by purchase order line. When you specify Yes and the net purchase order line amount is zero, the report prints all receipt or invoice entries for that line. When you specify No, the report considers the Transaction Amount Tolerance and Transaction Quantity Tolerance parameters. When you choose the Accrual Rebuild Reconciliation Report, the default is No. When you choose the Accrual Reconciliation Report, the default is Yes.

**Suggestion:** To minimize the size of the report, you should specify No for this option. However, if you want to see all accrual entries, you should specify Yes.

Transaction Amount Tolerance

If you selected No for Include All Transactions, specify the net amount below which purchase order line transactions are not included in the report.

Transaction Quantity Tolerance

If you selected No for Include All Transactions, specify the net quantity below which transactions are not included. This condition is checked only if the transaction amount tolerance is satisfied.

Include Written Off Transactions

Enter Yes or No to indicate whether you want to print written off entries on the report. When you specify Yes, an asterisk appears in the far right column to indicate a written off transaction. By selecting No, you decrease the report size. The default is No.

Aging Number of Days

Enter the number of days you would like the report to group information. For example, if you enter 60, for 60 days, the report first groups all purchase order lines that have the earliest transaction date in the past sixty days, and then groups the next set of lines with the earliest transaction date from 60 to 120 days, and so on. If you do not specify a number, the report displays all receipts and invoices together. This report parameter helps you separate your older activity from your current activity. When you enter a number of days, a subheading
appears on the report to indicate the to and from range of days for each group of information.

See Also

Inventory Standard Cost Transactions, Oracle Cost Management User’s Guide
Overview of Standard Costing, Oracle Cost Management User’s Guide
Overview of Average Costing, Oracle Cost Management User’s Guide
Overview of Receipt Accounting: page 7 – 101
Accrual Write–Off Report: page 9 – 13
Using the Account Generator in Oracle Public Sector Purchasing: page C – 10
Submitting a Request, Oracle Applications User’s Guide
Accrual Write–Off Report

The Accrual Write–Off Report to provide supporting detail for your write–off journal entries. The process is as follows. First, you analyze the Accrual Reconciliation Report for transactions that you should expense out of the accrual accounts. After you have researched the reported accrual balances, you then use the Accrual Write–Off window to indicate which entries you wish to remove and write off from this report. And, after you have written off these entries, you use the Accrual Write–Off Report as supporting detail for your manual journal entry.

The Accrual Write–Off Report displays entries for all organizations. Typically, you run this report at month end, at the time you prepare your manual general ledger journal entry. You can run this report for any write–off date range. These dates represent the journal entry dates for your manual journal entry. Since the Accrual Write–Off window and report do not directly create journal entries, there are no controls over the write–off date. In addition, the report displays both write–offs and any write–off reversals. Reversals display an opposite transaction amount as the initial write–off.

For example, you may want to write off a miscellaneous inventory transaction that debited your Inventory A/P accrual account. After you write off the transaction with the Accrual Write–Off window, the Accrual Write–Off Report displays a positive amount for your write–off. If you go back to the Accrual Write–Off window and reverse the write–off, the Accrual Write–Off Report displays a negative amount for your reversal, and a positive amount for the initial write–off.

You can use this report to display written off transactions for the following problems in receiving, purchasing, inventory, work in process, or accounts payable transactions:

- Quantities differ between receipts and invoices
- Incorrect purchase order or invoice unit prices (previous releases only)
- Discrepancies in supplier billing
- Accounts payable matched invoice to wrong purchase order or purchase order line, or wrong receipt or receipt line
- Receiving clerk received against the wrong purchase order or wrong purchase order line
- Miscellaneous inventory or work in process transactions that do not belong to the accrual accounts
• Payables entries for sales tax and freight that do not belong to the accrual accounts. See: Overview of Receipt Accounting: page 7 – 101.

In addition, the Accrual Write–Off Report supports multiple A/P accrual accounts in Purchasing. When you define your purchase order requisitions or orders, the Account Generator processes create your A/P accrual accounts. Typically, you only use one A/P accrual account for all of your inventory organizations. However, for certain situations you may want to use more.

The Document Number is the receipt number, invoice number, or transaction number, depending on the type of transaction.

The Transaction Quantity is the quantity received or the quantity invoiced, depending on the type of transaction. Quantities received are negative since purchase order receipts credit the A/P accrual account. Quantities invoiced are positive since invoices debit the A/P accrual account.

The Unit Price is the purchase order price of the receipt, actual invoice price, or transaction unit cost. If the purchase order is in a foreign currency, the purchase order price is in the currency of your set of books using the currency conversion rate from your purchase order at the time of receipt.

For accrual write–offs, the Transaction Amount is the total amount posted by the transaction source to the A/P accrual account. If you reverse a write–off, the transaction amount is printed with an opposite sign from the original write–off. You use the subtotals for the Transaction Amount column when preparing your manual journal entry.

---

**Prerequisites**

Since this report displays transactions from purchase order receipts and accounts payable invoices, you must install Purchasing and Payables to run this report. If you have Inventory or Work in Process, the Accrual Write–Off Report also displays any inventory or work in process transactions you have written off.
Report Submission

In the Submit Requests window, select Accrual Write–Off Report in the Name field.

Report Parameters

Write–Off Dates From/To

Enter the beginning and ending general ledger dates. Usually, these are the beginning and ending dates of the accounting period.

Write–Off Reason

Enter a specific write–off reason.

Print Comments

Enter Yes or No to indicate whether you want to print comments on the report.

See Also

Submitting a Request, Oracle Applications User’s Guide
Overview of Receipt Accounting: page 7 – 101
Using the Account Generator in Oracle Public Sector Purchasing: page C – 10
Advanced Shipment Notice Discrepant Receipts Report

For each Advance Shipment Notice (ASN) sent to you by your supplier, the Advanced Shipment Notice Discrepant Receipts report checks for overshipped or unfulfilled shipments. It looks for discrepancies between what the ASN said was shipped and what you actually received. In addition, these discrepancies are sent to the Oracle e-Commerce Gateway process responsible for generating Application Advices. (For example, Application Advices are sent back to suppliers detailing errors that occurred when the suppliers sent ASNs.)

**Note:** Goods returned to a supplier are considered shipped. For example, if a supplier promised to ship 200 items and you received 200 items but returned 40, this is not considered a discrepant receipt.

Report Submission

In the Submit Requests window, select Advanced Shipment Notice Discrepant Receipts in the Name field.

Report Parameters

**Start Date / End Date**

The report evaluates discrepancies for expected receipt dates that fall within the date range you enter. It also sends information to e-Commerce Gateway for the generation of Application Advices, if the expected receipt date of the shipment falls within the date range you enter.

See Also

Submitting a Request, *Oracle Applications User’s Guide*

Advance Shipment Notices (ASNs): page 7 – 17
ASL Upgrade Process

The ASL Upgrade process performs the same upgrade of AutoSource rules as AutoInstall, when you upgrade from Release 10.7. AutoSource rules in Release 10.7 and earlier have been replaced by enhanced sourcing rules and Approved Supplier List (ASL) entries in this release. Both AutoInstall and the ASL Upgrade process are designed to upgrade old AutoSource rules.

Run this process only if AutoInstall failed to upgrade your AutoSource rules automatically.

Report Submission

In the Submit Requests window, select ASL Upgrade in the Name field.

Report Parameters

Supplier Status

Select a Supplier Status of New. This Supplier Status appears next to all of your suppliers in the Approved Supplier List window once the ASL Upgrade process upgrades your ASL entries. New is the only Supplier Status supported by the ASL Upgrade process.

Upgrade Documents From

Select Current and future rules. This option upgrades source documents with current effectivity dates as well as effectivity dates that don’t begin until the future. Current and future rules is the only option supported by the ASL Upgrade process.

See Also

Submitting a Request, Oracle Applications User’s Guide

Oracle Applications Upgrade Manual
Backordered Internal Requisitions Report

The Backordered Internal Requisitions Report details information on your backordered *internally-sourced* requisition lines. You can run this report only if Order Management is installed.

Report Submission

In the Submit Requests window, select Backordered Internal Requisitions Report in the Name field.

Report Parameters

**Creation Dates From/To**

Enter the beginning and ending creation dates.

**Requestor**

Enter a requestor name.

**Subinventories From/To**

Enter the beginning and ending subinventories.

**Dynamic Precision Option**

Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, *Oracle Applications User’s Guide*
Blanket and Planned PO Status Report

The Blanket and Planned PO Status report can be used to review purchase order transactions for items you buy, using blanket purchase agreements and planned purchase orders. For each blanket purchase agreement and planned purchase order you create, Purchasing provides you with the detail of the releases you created against these orders. Purchasing prints the blanket agreement or planned purchase order header information, if no release exists.

Report Submission

In the Submit Requests window, select Blanket and Planned PO Status Report in the Name field.

Report Parameters

PO Numbers From/To
Enter the beginning and ending purchase order numbers.

Buyer
Enter a buyer name.

Suppliers From/To
Enter the beginning and ending supplier numbers.

Categories From/To
Enter the beginning and ending categories.

Expired Date
Enter an expiration date to restrict the report to purchase orders with earlier expiration dates.
Sort By

Use the Sort By feature to produce a report customized to your specific needs. Choose one of the following options:

- **Purchase Order Number**
  Sort the report by purchase order number.

- **Supplier**
  Sort the report by supplier.

Dynamic Precision Option

Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, *Oracle Applications User’s Guide*
Buyer Listing

The Buyer Listing shows the buyer name, default purchasing category, ship–to location, and effective dates of all buyers or a selected set of buyers. You can also use the report to isolate buyers who are assigned to a category of procurement items. See: Defining Buyers: page 1 – 27.

Report Submission

In the Submit Requests window, select Buyer Listing in the Name field.

Report Parameters

Active/Inactive

Choose one of the following options:

- Active: List only active buyers on the report.
- Both: List both active and inactive buyers on the report.
- Inactive: List only inactive buyers on the report.

Categories From/To

Enter the beginning and ending category names.

Location

Enter a ship–to location.

Sort By

Use the Sort By feature to produce a report customized to your specific needs. Choose one of the following options:

- Buyer Name: Sort the report by buyer name. This is the default if you do not choose a sort by option.
- Category: Sort the report by purchasing category.
- Location: Sort the report by location.
See Also

Submitting a Request, *Oracle Applications User’s Guide*
Buyer’s Requisition Action Required Report

The Buyer’s Requisition Action Required Report identifies all or specific approved requisition lines that buyers have not placed on purchase orders. Later, you can use the AutoCreate Documents window to modify a requisition line, return a requisition, or place a requisition line onto a purchase order.

The report includes suggested document types Blanket, Agreement, Catalog, and Quotation.

Report Submission

In the Submit Requests window, select Buyer’s Requisition Action Required Report in the Name field.

Report Parameters

### Suggested Suppliers From/To
Enter the beginning and ending suggested supplier names.

### Categories From/To
Enter the beginning and ending category from the purchasing category set. The report breaks and prints by categories.

### Need By Dates From/To
Enter the beginning and ending need–by dates.

### Location
Enter a location.

### Requestor
Enter a requestor name.
Requisition Numbers From/To
Enter the beginning and ending requisition numbers.

Print Price History
Enter Yes or No to indicate whether you want to print the price history on the report. If you leave this field blank, the default is Yes.

Dynamic Precision Option
Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, Oracle Applications User’s Guide
Cancelled Purchase Orders Report

The Cancelled Purchase Orders Report can be used to review information on cancelled purchase orders.

Report Submission

In the Submit Requests window, select Cancelled Purchase Orders Report in the Name field.

Report Parameters

**Suppliers From/To**

Enter the beginning and ending supplier names.

**Buyer**

Enter the buyer name.

**Cancelled Dates From/To**

Enter the beginning and ending cancelled dates.

See Also

Submitting a Request, Oracle Applications User’s Guide
Cancelled Requisitions Report

Use the Cancelled Requisitions Report to review information on cancelled requisitions.

Report Submission

In the Submit Requests window, select Cancelled Requisitions Report in the Name field.

Report Parameters

Preparers From/To
Enter the beginning and ending preparer names.

Requisition Creation
Dates From/To
Enter the beginning and ending creation dates to restrict the report to a range of dates.

Requestors From/To
Enter the beginning and ending requestor names to restrict the report to a range of requestors.

Sort By
Use the Sort By feature to produce a report customized to your specific needs. Choose one of the following options:

Preparer
Sort the report by preparer. This is the default if you do not choose a sort by option.

Requisition Number
Sort the report by requisition number.

Dynamic Precision Option
Enter the decimal precision for quantities on the report.
See Also

Submitting a Request, *Oracle Applications User’s Guide*
Confirm Receipts Workflow Select Orders Process

The Self-Service Purchasing Confirm Receipts Workflow Select Orders process in Purchasing must be running in order to use the Confirm Receipts workflow. The Confirm Receipts workflow sends notifications through the Web, e-mail, or Notification Details Web page (accessible through the Notifications Summary menu in Purchasing) to requestors or buyers who create requisitions in Purchasing or iProcurement. It lets people know they should have received an item.

The Confirm Receipts workflow sends notifications for items with a Destination or Deliver-To Type of Expense, a Routing of Direct Delivery, and a Need-By date that is equal to or later than today’s date.

Prerequisites

Submit the Workflow Background Engine before you submit the Confirm Receipts Workflow Select Orders process. In the Submit Requests window, in the System Administrator responsibility, select Workflow Background Engine in the Name field. See: To Schedule Background Engines, Oracle Workflow Guide.

Submission

To submit the Confirm Receipts Workflow Select Orders process:

1. Navigate to the Submit Requests window and select Confirm Receipts Workflow Select Orders in the Request Name field.
2. Choose Schedule.
3. Choose how often you want the process to run.
   
   For example, choose Periodically if you want the process to run periodically. If you set it to run one or two times a day, the Confirm Receipts workflow will query for purchase orders that meet the criteria described above and send notifications (if required) one or two times a day.
4. Choose OK, or select other options and then choose OK.
5. Choose Submit to begin the process.
See Also

Confirm Receipts Workflow: page C – 240
Submitting a Request, Oracle Applications User’s Guide
Contract Status Report

The Contract Status Report can be used to review the status of your contracts and list purchase order information for each contract. Purchasing prints the contract information if there are standard purchase order lines that reference that contract.

Report Submission

In the Submit Requests window, select Contract Status Report in the Name field.

Report Parameters

PO Numbers From/To

Enter the beginning and ending purchase order numbers.

Suppliers From/To

Enter the beginning and ending supplier names.

See Also

Submitting a Request, Oracle Applications User’s Guide
Country of Origin Report (by Item)

This report lists, by item, all suppliers and their countries of origin as follows:

- Item
  - Supplier
    Country of origin on the purchase order shipment
  - Country of origin on the receipt
    Country of origin on the purchase order shipment
  - Country of origin on the receipt
  - Supplier
    Country of origin on the purchase order shipment
  - Country of origin on the receipt

The country of origin is the country in which an item is manufactured. This report displays the countries of origin specified on the purchase order shipment and the receipt. This report also displays the purchase order and receipt number for the item.

Report Submission

In the Submit Requests window, select Country of Origin Report (by Item) in the Name field.

Report Parameters

Items From/To

Enter the beginning and ending system item numbers.
Category From/To
Enter the beginning and ending purchasing categories.

Ship To Organization
Select the ship-to organization for which to display the country of origin information. To see information from all ship-to organizations, leave this field blank.

Date From/To
Enter the beginning and ending document creation dates. The report includes all purchase orders or receipts that fall between these dates.

Country of Origin
If you want to see a list of all items belonging to just one country of origin, enter that country. To see all countries of origin, leave this field blank.

See Also

Submitting a Request, *Oracle Applications User’s Guide*

Entering Purchase Order Shipments: page 4 – 63

Entering Receipt Lines: page 7 – 34
Country of Origin Report (by Supplier)

This report lists, by supplier, all countries of origin and their items as follows:

- Supplier
  - Country of origin
  Item
  Item
- Country of origin
  Item
  Item

The country of origin is the country in which an item is manufactured. This report displays the Country of Origin specified in the Approved Supplier List (ASL). It also includes the supplier item information, the ASL status, and unit of measure for each item. See: Defining the Supplier/Item Attributes: page 5 – 51.

Report Submission

In the Submit Requests window, select Country of Origin Report (by Supplier) in the Name field.

Report Parameters

Ship To Organization

Enter a ship-to organization.
Country of Origin Code
If you want to see a list of all suppliers and items belonging to just one country of origin, enter that country. To see all countries of origin, leave this field blank.

Supplier From/To
Enter the beginning and ending supplier names.

Supplier Site
To display countries of origin for just one site, enter the supplier site.

See Also
Submitting a Request, Oracle Applications User’s Guide
Create Internal Sales Orders Process

Use the Create Internal Sales Orders process to send requisition information from approved, inventory-sourced requisition lines to the Order Management interface tables. Then the OrderImport process is run from within Order Management to generate the internal sales orders. You can set the Create Internal Sales Orders and OrderImport processes to run automatically at specified intervals.

The Create Internal Sales Orders process automatically schedules internal orders by setting the Schedule Ship Date on the order to the Need–by Date from the requisition. If a subinventory is specified on the internal requisition line, Order Management reserves the goods and uses only the specified subinventory for allocation. If the goods do not exist at the specified subinventory, Order Management backorders them, even if they do exist in another subinventory.

The Create Internal Sales Orders process loads the Order Management open interface, OrderImport, using the order type you define in the Purchasing Options window. OrderImport creates internal sales orders from the records in the interface table, and determines the order cycle and defaults values based on the order type.

To run the Create Internal Sales Orders process:

1. Navigate to the Submit Requests window.
2. Select Requests in the first field.
3. Select Create Internal Sales Orders in the Name field.
4. Choose Submit to begin the process.

See Also

Creation of Internal Sales Orders: page 3 – 21
Submitting a Request, Oracle Applications User’s Guide
Defining Internal Requisition Options: page 1 – 52
Create Releases Process

Use the Create Releases process to create releases for requisition lines that meet the following criteria:

- Approved (and Reserved, if requisition encumbrance is active)
- Requisition is already sourced to an existing blanket
- The Approved Supplier List entry for the item, supplier, and blanket indicate that the Release Generation method is either Automatic Release or Automatic Release/Review
- The requisition line is \textit{not} already on a purchase order
- The source blanket is still active and the release will not put the blanket over the amount limit.

If the release generation method is Automatic Release, the process sets the status to Approved.

You can set the Create Releases process to run automatically at specified intervals.

\textbf{To run the Create Releases process:}

1. Navigate to the Submit Requests window.
2. Select Requests in the first field.
3. Select Create Releases in the Name field.
4. Choose Submit to begin the process.

\textbf{See Also}

Submitting a Request, \textit{Oracle Applications User’s Guide}

Automatic Release Generation: page 4 – 103
Encumbrance Detail Report

The Encumbrance Detail Report can be used to review requisition and purchase order encumbrances for a range of accounts if you have enabled the encumbrance option for requisitions or purchase orders, and have entered and approved requisitions and purchases. You use this report to review the accounts encumbered.

The Encumbrance Detail Report reflects activity from General Ledger, not Purchasing or Oracle Public Sector Payables. Therefore, use the Encumbrance Detail Report in a way that matches the accounting method:

- **Receipt accrual:** You can generate the Encumbrance Detail Report as needed when the Accrue at Receipt option is used. Upon entering receipt information, an automated process transfers the receipt information to General Ledger using the Journal Import Process.

- **Period–end accrual:** You may want to generate the Encumbrance Detail Report at period–end. During the period, the encumbrance detail on the report is based on invoice matching information from Payables, not on receiving information. After the Receipt Accruals – Period–End process is run, the Encumbrance Detail Report reflects the true period–end receipt information.

- **Cash basis:** If you use cash–basis accounting, the encumbrances on the Encumbrance Detail Report remain until payment information from Payables is transferred to General Ledger. When you use cash–basis accounting and submit the Payables Transfer to General Ledger process, Payables transfers only accounting information for paid invoices to the general ledger.

Purchasing prints the purchase order and release number for purchase order encumbrances. The heading Requisition Number or PO#–Release prints if the charge account had distributions to requisitions and to purchase orders.

Report Submission

In the Submit Requests window, select Encumbrance Detail Report in the Name field.
Report Parameters

Accounts From/To
Enter the beginning and ending accounts.

Organizations From/To
Enter the beginning and ending organizations.

Encumbrance Dates From/To
Enter the beginning and ending encumbrance dates.

Document Type
Enter a document type to restrict the report to a specific document type. Leave this field blank if you want the report to include both document types. Otherwise, choose one of the following options.

Requisition list only requisitions.
Purchase order list only purchase orders.

Suppliers From/To
Enter the beginning and ending supplier names.

Dynamic Precision Option
Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, Oracle Applications User’s Guide
Expected Receipts Report

The Expected Receipts Report can be used to review all or specific supplier sourced expected receipts or expected customer returns that have not yet been received for a particular date or a range of dates. The report excludes purchase orders that are cancelled, closed, or closed for receiving at the header, release, line, or shipment level. You can specify the expected receipts you want to review.

For Supplier source type the Due Date is the promised date. If the promised date is not entered, this is the need by date. For internally sourced requisition lines, the Due Date is the need by date. For a Customer source, the Due Date is the request date on the return material authorization (RMA) document.

The Quantity/Amount Ordered and Quantity/Amount Due are not printed on the report if you are using blind receiving.

Use this report to improve or speed up your receiving operations. Your receivers may sometimes not have access to Oracle Applications when they need to enter receiving transactions. They can use the report of expected receipts to record receiving transactions and later enter them. There is space at the end of each shipment for you to record comments, the receipt date, and the quantity/amount you received.

Report Submission

In the Transaction Reports (for Inventory) or Submit Requests window, select Expected Receipts Report in the Name field.

Report Parameters

Purchase Order Numbers From/To

Enter the beginning and ending purchase order numbers.

Requisition Numbers From/To

Enter the beginning and ending requisition numbers.
Supplier
Enter the supplier name.

Items From/To
Enter the beginning and ending item numbers.

Categories From/To
Enter the beginning and ending categories.

Due Dates From/To
Enter the beginning and ending promised dates.

Ship–To Location
Enter a location to restrict the report to that location.

Organization Name
Enter an organization name to restrict the report to that organization.

RMA Numbers From/To
Enter the beginning and ending return material authorization (RMA) document numbers. An RMA is created in Order Management to authorize a customer return to your organization.

Customer From/To
Enter a beginning and ending customer name if you want to review all expected returns from a specific customer or customers. These returns are authorized through an RMA document, which is created in Order Management.

Dynamic Precision Option
Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, Oracle Applications User’s Guide
Fill Employee Hierarchy Process

Use the Fill Employee Hierarchy process to create a direct mapping between the defined position hierarchies and the employees holding positions in each hierarchy. When you run this process, it checks each position hierarchy and updates each employee, his supervisor, the level of supervision (a direct supervisor is level 1), the employee’s position, and the supervisor’s position.

The process creates an error log which lists all positions to which no employee is assigned, but having such positions is a benign error that does not hamper system operation.

If you do not use hierarchical security for any of your documents and do not use position hierarchies for your approvals, you do not need to run this process. Otherwise, you must run this process before any of the following changes can take effect:

- add or delete an employee
- change an employee name or an employee position. See: the online help for the Enter Person window.

To run the Fill Employee Hierarchy process:

1. Navigate to the Submit Requests window.
2. Select Requests in the first field.
3. Select Fill Employee Hierarchy in the Name field.
4. Choose Submit to begin the process.

See Also

Submitting a Request, Oracle Applications User’s Guide
Financials/Purchasing Options Listing

The Financials/Purchasing Options Listing can be used to review the options set for your system in the Financials Options and Purchasing Options windows. This report also displays your receipt numbering options in the Receiving Options window, for each organization.

Report Submission

In the Submit Requests window, select Financials/Purchasing Options Listing in the Name field.

See Also

Submitting a Request, Oracle Applications User’s Guide
Internal Requisition Status Report

Use the Internal Requisition Status Report to print status information for internal requisitions.

Report Submission

In the Submit Requests window, select Internal Requisition Status Report in the Name field.

Report Parameters

Creation Dates From/To
Enter the beginning and ending creation dates.

Items From/To
Enter the beginning and ending item numbers.

Requestor
Enter a requestor name to restrict the report to a specific requestor.

Subinventories From/To
Enter the beginning and ending subinventories.

Status
Enter the status to restrict the report to a specific status.

Requisition Numbers From/To
Enter the beginning and ending requisition numbers.
Sort By

Use the Sort By feature to produce a report customized to your specific needs. Choose one of the following options:

- **Creation Date**: Sort the report by creation date.
- **Requestor**: Sort the report by requestor.
- **Subinventory**: Sort the report by source subinventory.

Dynamic Precision Option

Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, *Oracle Applications User’s Guide*
Internal Requisitions/Deliveries Discrepancy Report

The Internal Requisitions/Deliveries Discrepancy Report lists requisition documents with items whose source type is inventory. Internal requisitions are typically for transfers of material from your inventories. Use this report to identify goods that have been shipped and have a delivery discrepancy. This report can be run only if Order Management is installed.

The Quantity Variance is the difference between the quantity shipped and the quantity delivered. If the quantity shipped is less than the quantity received, the result displays with a negative sign.

The Cost Variance is the variance in cost between the quantity shipped and the quantity delivered. The calculation for the cost variance is the quantity delivered times the requisition unit price, minus quantity shipped, times the sales order price.

Report Submission

In the Submit Requests window, select Internal Requisitions/Deliveries Discrepancy Report in the Name field.

Report Parameters

Requisition Numbers From/To

Enter the beginning and ending requisition numbers.

Requestor

Enter a requestor name to restrict the report to a specific requestor.

Requisition Creation Dates From/To

Enter the beginning and ending creation dates.
Sort By

Choose one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation Date</td>
<td>Sort the report by creation date. This is the default if you leave this field blank.</td>
</tr>
<tr>
<td>Requestor</td>
<td>Sort the report by requestor.</td>
</tr>
<tr>
<td>Subinventory</td>
<td>Sort the report by item source organization subinventory.</td>
</tr>
</tbody>
</table>

Dynamic Precision Option

Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, Oracle Applications User’s Guide
Invoice Price Variance Report

The Invoice Price Variance Report shows the variance between the invoice price and the purchase price for all inventory and work in process related invoice distributions. Payables records invoice price variances when the invoices are matched, approved, and posted.

The report includes invoice Entry Types Adjustment, Entry, and Reversal. The invoice price variance is the quantity invoiced multiplied by the difference between the invoice unit price and the purchase order unit price.

If the invoice price and the purchase order unit price are in the same currency but the exchange rates differ, the exchange rate variance is also displayed in this report. For example, if the report displays an invoice price variance of −9.5 and an exchange rate variance of −6, the total invoice price variance of −9.5 includes the exchange rate variance of −6.

Prerequisites

Payables records invoice price variance only when you have inventory or work in process related invoices. Use this report only if you use Inventory by itself or with Work in Process.

Report Submission

In the Cost and Period Close Reports (for Inventory) or Submit Requests windows, select Invoice Price Variance Report in the Name field.

Report Parameters

Categories From/To

Enter the beginning and ending purchasing categories.
Suppliers From/To
Enter the beginning and ending supplier numbers.

Period Name
Enter an accounting period to restrict the report to a specific period.

Dynamic Precision Option
Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, Oracle Applications User’s Guide
Invoice Price Variance by Supplier Report

The Invoice Price Variance Report shows the variance between the invoice price and the purchase price for all inventory and work in process related invoice distributions. Payables records invoice price variances when the invoices are matched, approved, and posted.

The report includes invoice Entry Types Adjustment, Entry, and Reversal.

The invoice price variance is the quantity invoiced multiplied by the difference between the invoice unit price and the purchase order unit price.

If the invoice price and the purchase order unit price are in the same currency but the exchange rates differ, the exchange rate variance is also displayed in this report. For example, if the report displays an invoice price variance of $–9.5 and an exchange rate variance of $–6, the total invoice price variance of $–9.5 includes the exchange rate variance of $–6.

Prerequisites

Payables records invoice price variance only when you have inventory or work in process related invoices. Use this report only if you use Inventory by itself or with Work in Process.

Report Submission

In the Cost and Period Close Reports (for Inventory) or Submit Requests windows, select Invoice Price Variance by Supplier Report in the Name field.

Report Parameters

Categories From/To

Enter the beginning and ending purchasing categories.
Suppliers From/To
Enter the beginning and ending supplier numbers.

Period Name
Enter an accounting period to restrict the report to a specific period.

Dynamic Precision Option
Enter the decimal precision for quantities on the report.

See Also
Submitting a Request, *Oracle Applications User’s Guide*
Item Detail Listing

The Item Detail Listing shows detail information for items defined as Purchasing Items in the Item window as well as unit of measure conversion, notes, manufacturer part numbers, and dispositions assigned to the item. Purchasing lets you isolate items by limiting the items, categories, or buyer you want to review. For example, if your categories reflect purchased commodities, you can use the listing to review what manufactured items are for a commodity.

Report Submission

In the Submit Requests window, select Item Detail Listing in the Name field.

Report Parameters

Active/Inactive

Choose one of the following options:

*Active* List only active items on the report.

*Both* List both active and inactive items on the report.

*Inactive* List only inactive items on the report.

Categories From/To

Enter the beginning and ending purchasing categories.

Items From/To

Enter the beginning and ending item numbers.

Buyer

Enter the buyer name to restrict the report to a specific buyer.
Sort By

Use the Sort By feature to produce a report customized to your specific needs. Choose one of the following options:

<table>
<thead>
<tr>
<th>Category</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Sort the report by purchasing category.
Sort the report by item number.

Dynamic Precision Option

Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, Oracle Applications User’s Guide
Defining Items, Oracle Inventory User’s Guide
Item Summary Listing

The Item Summary Listing shows the inactive or active status of items. You can also use the report to review the commodities of items that are inactive. And, finally, you can use the report as a listing of all items defined as Purchasing Items in the Items window.

Report Submission

In the Submit Requests window, select Item Summary Listing in the Name field.

Report Parameters

Active/Inactive

Choose one of the following options:

- **Active** List only active items on the report.
- **Both** List both active and inactive items on the report.
- **Inactive** List only inactive items on the report.

See Also

- Submitting a Request, *Oracle Applications User’s Guide*
- Defining Items, *Oracle Inventory User’s Guide*
Location Listing

The Location Listing shows internal organizations locations and addresses. Purchasing lets you specify which locations you want to review: Ship To, Bill To, Office, Internal, and Receiving. Use this report to isolate locations which are only for a specific function, such as locations where receiving is permitted. This document can be used as a resource when entering purchase order receiving locations.

Report Submission

In the Submit Requests window, select Location Listing in the Name field.

Report Parameters

Site

Choose one of the following options:

- All: List locations regardless of site criteria. This is the default if you do not choose a sort by option.
- Bill-To: List only locations that are bill-to sites.
- External: List only locations that are not internal sites.
- Office: List only locations that are office sites.
- Receiving: List only locations that are receiving sites.
- Ship-To: List only locations that are ship-to sites.

Active/Inactive

Choose one of the following options:

- Active: List only active locations on the report.
- Both: List both active and inactive locations on the report.
- Inactive: List only inactive locations on the report.
Sort By

Choose one of the following options:

Country   Sort the listing by country.
Location  Sort the listing by location. This is the default if you do not choose a sort by option.
State     Sort the listing by state.

See Also

Submitting a Request, Oracle Applications User’s Guide
Defining Locations: page 1 – 24
Matching Holds by Buyer Report

The Matching Holds by Buyer Report can be used to review all or selected invoices that Purchasing or your accounts payable system placed on matching hold. You can review price holds, quantity ordered holds, quantity received holds, and quality holds. You can review the matching holds for one or more buyers. After printing all of a particular buyer’s matching holds, Purchasing prints summary matching hold information for this buyer. At the end of the report, Purchasing prints summary matching hold information for all of the buyers that you selected. This report helps you understand why an invoice is on hold and provides you with the information you need to solve the problem. You can also monitor the performance for suppliers or buyers using this report.

**Suggestion:** Use this report carefully when monitoring the performance of a supplier or buyer. This report summarizes the matching holds information and provides the reason why invoices are on hold. The buyer may have no control over some of the problems.

Report Submission

In the Submit Requests window, select Matching Holds by Buyer Report in the Name field.

Report Parameters

**Buyer**

Enter a buyer name to restrict the report to a specific buyer.

**Suppliers From/To**

Enter the beginning and ending supplier names.

**Invoice Dates From/To**

Enter the beginning and ending invoice dates.
Categories From/To
Enter the beginning and ending purchasing categories.

Items From/To
Enter the beginning and ending item numbers.

Price Hold
Enter Yes or No to indicate whether the report includes purchase orders on price hold. If you leave this field blank, the default is Yes.

Quantity Ordered Hold
Enter Yes or No to indicate whether the report includes purchase orders on quantity ordered hold. If you leave this field blank, the default is Yes.

Quantity Received Hold
Enter Yes or No to indicate whether the report includes purchase orders on quantity received hold. If you leave this field blank, the default is Yes.

Quantity Accepted Hold
Enter Yes or No to indicate whether the report includes purchase orders on quantity accepted hold. If you leave this field blank, the default is Yes.

Dynamic Precision Option
Enter the decimal precision for quantities on the report.

See Also
Submitting a Request, Oracle Applications User’s Guide
New Supplier Letter Report

The New Supplier Letter Report prints letters you send to your suppliers to ask for information about the nature of their businesses. Purchasing prints the New Supplier Letter Report together with the corresponding supplier letters. The report gives you a listing of the supplier names, sites, and addresses to which you can send your letters, and prints the letters for each supplier on the listing.

Report Submission

In the Submit Requests window, select New Supplier Letter Report in the Name field.

Report Parameters

Supplier Type
Enter the supplier type from the Enter Lookup Codes window to restrict the report to a specific supplier type.

Suppliers From/To
Enter the beginning and ending supplier names.

Supplier Site
Enter the supplier site to restrict the report to a specific supplier site.

Creation Dates From/To
Enter the beginning and ending creation dates.
Active/Inactive

Choose one of the following options:

Active  List only active suppliers on the report.
Both    List both active and inactive suppliers on the report.
Inactive List only inactive suppliers on the report.

Sort By

Use the Sort By feature to produce a report customized to your specific needs. Choose one of the following options:

Supplier  Sort the report by supplier name and supplier site. This is the default if you do not enter an option.
Supplier Site Sort the report by supplier site and supplier name.
ZIP Code   Sort the report by postal code, supplier name, and supplier site.

See Also

Submitting a Request, Oracle Applications User’s Guide
Open Purchase Orders Report (by Buyer)

The Open Purchase Orders Report (by Buyer) lists all or specific open purchase orders that relate to buyers. Purchasing lets you specify the open purchase orders you want to review. An open purchase order is one that references an item that your supplier has not yet fully billed or received. The report excludes closed, final closed, and cancelled orders.

Report Submission

In the Submit Requests window, select Open Purchase Orders Report (by Buyer) in the Name field.

Report Parameters

Buyer

Enter a buyer name to restrict the report to a specific buyer.

Suppliers From/To

Enter the beginning and ending supplier names.

Dynamic Precision Option

Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, Oracle Applications User’s Guide
Open Purchase Orders Report (by Organization)

The Open Purchase Orders Report (by Organization) can be used to review all or specific open purchase orders relating to one or more organizations. An open purchase order is one that references an item that your supplier has not yet fully billed or received. The report excludes closed, final closed, and cancelled orders.

Report Submission

In the Submit Requests window, select Open Purchase Orders Report (by Organization) in the Name field.

Report Parameters

Organizations From/To
Enter the beginning and ending organization names.

Organizations From/To
Enter the beginning and ending organizations.

Dynamic Precision Option
Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, Oracle Applications User’s Guide
Overdue Supplier Shipments Report

This report can be used to follow-up with suppliers. The report includes the supplier contact and the phone number along with percentage delivery and the due date. The report also includes purchase orders that do not have a supplier contact assigned. By limiting the report to only one buyer, you can do follow-up by buyer. And, finally, by limiting the report by categories, you can do purchasing follow-up for a range of commodities.

The Due Date is the date the supplier promised delivery for the items you ordered on the shipment, or the date you indicated that you needed the goods by.

Report Submission

In the Transaction Reports (for Inventory) or Submit Requests windows, select Overdue Supplier Shipments Report in the Name field.

Report Parameters

**Overdue as of**

Enter a date to restrict the report to purchase orders not fully received where the promised date is less than or equal to this date. If you do not enter a date, the report prints all purchase orders that you have not yet fully received where the promised date is less than or equal to the current date. If the promised date is not provided, the need by date is used.

**Buyer**

Enter a buyer to restrict the report to a specific buyer.

**Suppliers From/To**

Enter a beginning and ending supplier.
Ship–to Location
Enter a ship–to location to restrict the report to overdue shipments for a specific location.

Categories From/To
Enter a beginning and an ending category from the purchasing category set.

Organization Name
Enter the organization name to restrict the report to a specific organization.

Dynamic Precision Option
Enter the decimal precision for quantities on the report.

See Also
Submitting a Request, *Oracle Applications User’s Guide*
Overshipments Report

The Overshipments Report lists purchase order receipts with a quantity received greater than the quantity ordered. You can also use the Overshipments Report to identify service overcharges or suppliers who deliver more than the requested quantity.

Report Submission

In the Submit Requests window, select Overshipments Report in the Name field.

Report Parameters

Receipt Location

Enter the receipt location to restrict the report to overshipments to a specific internal location.

Receiver

Enter the name of the employee to restrict the report to overshipments to a specific receiver.

Receipt Date From/To

Enter the beginning and ending receipt dates to restrict the report to a range of receipt dates.

Supplier From/To

Enter the beginning and ending supplier names to restrict the report to a range of suppliers.

Supplier Site

Enter the supplier site to restrict the report to overshipments to a specific supplier site.
**Organization Name**

Enter the organization name to restrict the report to a specific organization.

**Sort By**

Use the Sort By feature to produce a report customized to your specific needs. Choose one of the following options:

- *Purchase Order Number*  Sort the report by document number. This is the default if you do not choose an option.
- *Supplier*  Sort the report by supplier.

**Quantity Precision Option**

Enter the decimal precision for quantities on the report.

**See Also**

Submitting a Request, *Oracle Applications User’s Guide*
Payment on Receipt

Payment on Receipt enables you to automatically create standard, unapproved invoices for payment of goods based on receipt transactions. Invoices are created using a combination of receipt and purchase order information, eliminating duplicate manual data entry and ensuring accurate and timely data processing. Payment on Receipt is also known as Evaluated Receipt Settlement (ERS) and Self Billing.

You can automatically create invoices with multiple items and distribution lines, and include tax.

You define which supplier sites participate in Payment on Receipt and enforce matching rules to ensure the proper payments are made to the suppliers.

Payment on Receipt builds invoices with the following information:

<table>
<thead>
<tr>
<th>Amount</th>
<th>Determined by multiplying the Quantity received by the Purchase Order Item Unit Price.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payment Terms</td>
<td>Defaulted from the purchase order payment terms or from the supplier site payment terms, depending on your Oracle Public Sector Payables setup.</td>
</tr>
<tr>
<td>Tax</td>
<td>Based on Tax Codes on each purchase order shipment, or the default tax hierarchy in Payables.</td>
</tr>
</tbody>
</table>

If the purchase order currency and the supplier site Payment Currency (in the Supplier Sites window) are not fixed–rate currencies (for example, not euro–related currencies), Payment on Receipt builds the invoices this way, regardless of the supplier site Invoice Currency:

| Invoice Currency | Defaulted from the purchase order Currency. |
| Payment Currency | Defaulted from the purchase order Currency. |

If the purchase order currency and the supplier site Payment Currency are fixed–rate currencies (for example, euro–related currencies), Payment on Receipt builds the invoices this way, regardless of the supplier site Invoice Currency:

| Invoice Currency | Defaulted from the purchase order Currency. |
| Payment Currency | Defaulted from the supplier site Payment Currency. For example, if the purchase order Currency is francs and the supplier site Payment Currency is the euro, the Payment Currency on the invoice is the euro. |
Defaulted from the supplier site Invoice Currency if no supplier site Payment Currency is defined and the supplier site Invoice Currency is a fixed-rate currency.

Defaulted from the purchase order Currency if the supplier site Invoice Currency is not a fixed-rate currency.

If the Alternate Pay Site is populated for the Supplier Site used on the Purchase Order, the invoice created is for the Alternate Pay Site, otherwise the Supplier Site on the Purchase Order is used. The Supplier Site used for the invoice must be defined as a Pay Site.

**Debit Memos**

You can choose to automatically generate debit memos for Return To Supplier transactions once Payment on Receipt creates the invoice. To enable this functionality, enable the supplier site as a Pay Site (or indicate an Alternate Pay Site) and select Create Debit Memo from RTS Transaction in the Supplier Sites window. Once you enable this functionality, a debit memo is created for each return line you enter in the Returns window. When you create the return, make sure the Create Debit Memo option is selected in the Returns window. (The Aging Period profile option and field in Payment on Receipt do not account for returns for which a debit memo was already created, so that duplicate debits are not made. Likewise, a debit memo will not be created if the Aging Period functionality already handled the debit.) See: Debit Memos: page 7 – 15.

**Match Payment on Receipt Invoices to Purchase Orders or Receipts**

When Payment on Receipt runs, it automatically performs invoice matching to the purchase order or receipt, depending on which Invoice Match Option was chosen in the purchase order Shipments window. (The Invoice Match Option on the shipment defaults from the Supplier Sites window, but you can change it on the shipment.) See: Entering Purchase Order Shipments: page 4 – 63.

If matching invoices to receipts, Payment on Receipt uses the exchange rate information on the receipt. If matching invoices to purchase orders, Payment on Receipt uses the exchange rate information on the purchase order.
Enable Payment on Receipt for Individual Purchase Orders and Releases

You can enable Payment on Receipt for individual purchase orders and releases, for any purchase order or release type, by using the Pay On field in the Terms and Conditions window. (The Pay On value on a blanket purchase agreement is defaulted onto all the releases created against it.) The Pay On field defaults to Receipt for all documents whose supplier site is set up as a Payment on Receipt site in the Supplier Sites window, meaning that Payment on Receipt creates the invoices. Changing the Pay On field to Null means that Payment on Receipt does not create an invoice for that document, even if the supplier site is a Payment on Receipt site. If the supplier site is not a Payment on Receipt site, the Pay On field is disabled. See: Entering Purchase Order Detail Information: page 4 – 60.

The Pay On field also shows up on the Printed Purchase Orders Report, so your supplier knows that you will create an invoice upon receipt, and the supplier does not need to submit an invoice.

Delay Payment on Receipt

You may want to allow time for corrections or returns against the receipts before using Payment on Receipt to automatically convert the receipts into invoices. The profile option PO: ERS Aging Period enables you to specify this delay period between the receipt date and the invoice creation date.

When you run Payment on Receipt, it processes only those receipts whose dates are past the aging period. Payment on Receipt invoices include the sum of all corrections or returns made against a receipt during that aging period. Any adjustments you make after that aging period, you must process manually—by adjusting the invoice itself, or creating a debit memo.

The aging period does not include returns for which debit memos have already been automatically created. See: Debit Memos: page 7 – 15.

Example

Your aging period is two days. You receive 100 items on Monday, but on Tuesday discover that two items were missing from the shipment. You enter a correction to adjust the amount received to 98. When run on Wednesday (or later), Payment on Receipt generates an invoice for 98 items.

See: Purchasing Profile Options: page 1 – 103.
Control Invoice Prefixes

You can find Payment on Receipt invoices by using the Find Invoices window in Oracle Public Sector Payables to search for any invoice in your system containing the prefix ‘ERS–’. However, you can change this prefix, using the profile option *PO: ERS Invoice Number Prefix*. For example, shortening this prefix allows extra spaces for longer packing slip or receipt numbers. See: Purchasing Profile Options: page 1 – 103.

Create Invoices with Multiple Items and Multiple Distribution Lines

You can create a single invoice for one or more items on a single purchase order as long as the items have not been previously invoiced and matched to a purchase order or a receipt. If you are creating an invoice from the receipt transaction and purchase order, you are able to create an invoice for all ordered and received items. In the event of a partial shipment or multiple delivery dates, you are able to create multiple invoices for a single purchase order.

In addition, if your purchase order contains multiple distribution lines, you can create an invoice in Oracle Public Sector Payables with the same multiple distribution lines.

When creating multiple distribution lines for invoices with partial receipt quantities, the Pay on Receipt AutoInvoice program will either prorate the charges across all your purchase order distribution lines (for the received item) or use the FIFO method if you utilize Cascading Receipts. After the invoice has been created, you are able to make changes to the invoice distribution in accordance with the current Oracle Public Sector Payables system functionality.

Enforce Match Approval Levels to Ensure Proper Payment

Invoices created automatically are subject to the same match approval levels as standard invoices to ensure proper payment. Two–, three– and four–way match approval levels are enforced by Oracle Public Sector Payables if you specify two–, three–, or four–way for the supplier site Match Approval Level. Two–way match approval is the process of verifying that the purchase order and invoice information match within accepted tolerance levels. Three–way match approval is the process of verifying that the purchase order, invoice, and receiving information matches within accepted tolerance levels. The three–way match approval level is available with the Receipt Required option.

Four–way match approval is the process of verifying that the purchase order, receipt, inspection, and invoice information matches within
accepted tolerance levels. The four-way match approval level is available with the Inspection Required purchasing option.

Oracle Public Sector Payables requires that you approve invoices before you create accounting entries for them or pay them. Approvals can be submitted for selected invoices in the Invoice Workbench or by batch process. All discrepancies and/or adjustments must be handled manually using the appropriate online Purchasing, Receiving, and/or Payables windows.

Create Invoices which Include Tax

Payment on Receipt invoices include tax, which is based on the Tax Codes on each purchase order shipment, or the default tax hierarchy in Payables. See: Tax Defaults in Purchasing: page 4 – 135. See: Tax Rules and Defaults Payables Options, Oracle Public Sector Payables User’s Guide.

Tax on Payment on Receipt invoices is not calculated until invoice approval in Payables, or until tax calculation is performed in the Invoice Distributions window in Payables.

Create Scheduled Payments

Payables creates scheduled payments for each invoice based on the payment terms and the invoice terms date. After the invoice has been created, you can use the Scheduled Payments window to modify information such as due dates, and to change payment and discount amounts.

Define Payment on Receipt Supplier Information

You can enter supplier information in the Suppliers and Supplier Sites windows to identify which of your suppliers are eligible for Payment on Receipt and can have their invoices automatically created using the Pay on Receipt AutoInvoice program. In addition, you can specify an alternate Payment on Receipt pay site if the supplier’s pay site address is different from the purchasing address. For invoices created based on receipt transactions, you can set up invoice consolidation levels for an individual pay site. You also define the default Payment Currency in the Suppliers and Supplier Sites windows.

See: Purchasing Region of the Suppliers and Supplier Sites windows, Oracle Public Sector Payables User’s Guide.
Create Invoices with Different Invoice Summary Levels
Based on the Supplier Site Setup

The level of invoice consolidation determines how an invoice will be created for each run of Pay on Receipt AutoInvoice program. For invoices created based on receipt transactions, you set up invoice consolidation levels for an individual pay site in the Supplier Sites window. The levels are:

‘Pay Site’ — one invoice is created per supplier pay site.

‘Packing Slip’ — one invoice is created per packing slip per supplier pay site.

‘Receipt’ — one invoice is created per receipt per supplier pay site.

Invoice numbers are created based on the summary level. The invoice number is of the following format:

‘ERS’–< X >–< Seq# >

where:

– ERS is the default prefix for Pay On Receipt invoices or any prefix you specify in the profile option PO: ERS Invoice Number Prefix. See: Profile Options in Purchasing: page 1 – 103.

– Seq# is a unique system generated number.

– X depends on the summary level:
  – if summary level = Pay Site then X = Invoice Date
  – if summary level = Packing Slip then X = Packing Slip Number
  – if summary level = Receipt then X = Receipt Number

Submit Pay on Receipt AutoInvoice Program

The Pay on Receipt AutoInvoice program automatically creates an invoice batch depending on the options in the Payables Options window. Invoice count and invoice total are calculated automatically.
Prerequisites

- The supplier and supplier site must be set up correctly. Specifically, the supplier site must be set up as a Pay on Receipt site. See: Purchasing Region of the Suppliers and Supplier Sites windows, Oracle Public Sector Payables User’s Guide.

⚠️ **Attention:** Check that the receipts that you are interested in have been created successfully before running this program. You can do this by locating the receipt in the Receiving Transactions Summary window.

- Enter an Invoice Currency and a Payment Currency in the Supplier Sites window. See: Payment Region of the Suppliers and Supplier Sites windows, Oracle Public Sector Payables User’s Guide.

- If you need to calculate tax on the invoices, enable Automatic Tax Calculation and set the Calculation Level to Line or Tax Code in the Supplier Sites window. See: Invoice Tax Region of the Suppliers and Supplier Sites Windows, Oracle Public Sector Payables User’s Guide.

- If the profile option *Sequential Numbering* is set to Partially Used or Always Used, ensure that document sequences have been defined for your invoices and have been set to automatic numbering. Otherwise, Payment on Receipt may not be able to complete because it cannot generate document numbers for the invoices. See: Common User Profile Options, Oracle Applications User’s Guide. See: Voucher Numbers, Oracle Public Sector Payables User’s Guide.

► To run Payment on Receipt:

1. Navigate to the Submit Requests window.
2. Choose Requests as the Type.
3. Choose **Pay on Receipt AutoInvoice** as the Name.
4. Choose the Transaction Source **ERS**.
5. Enter a Commit Interval. The Commit Interval is a numeric representation of the number of invoices evaluated before they are committed. For example, if you have a Commit Interval of 10, after 10 invoices have been processed, they are committed. If you then process another 5, and the process fails, only 5 will not be committed.
6. Optionally enter a Receipt Number.

**Note:** If the Receipt Number is null, the program will try to process all the receipts that have not been invoiced successfully. If you enter a Receipt Number, only that receipt will be processed.

7. Optionally enter an Aging Period.

The Aging Period defaults from the *PO: ERS Aging Period* profile option, but you can change it here. For example, an Aging Period of 2 means that Payment on Receipt processes only those receipts that are 2 or more days old.

8. Choose OK and then Submit Request to begin the process.

9. Make sure the Payment on Receipt process and the Payables Open Interface Import process complete successfully.

After this process completes, it calls the Payables Open Interface Import process to complete invoice creation. Therefore, note the following in the View Output screen for the Pay on Receipt process:

- The Request ID for the Payables Open Interface Import process. Use this ID to check the status of the Payables Open Interface Import process to be sure it also completes successfully. If not, fix the errors in the Open Interface Invoices window and resubmit the Payables Open Interface Import process. See: Payables Open Interface Import, *Oracle Public Sector Payables User’s Guide*. See: Open Interface Invoices Window, *Oracle Public Sector Payables User’s Guide*.

- The Group ID for the invoice batch number. If you need to query this invoice batch to fix errors, use the Group ID to query this invoice batch.
Printed Change Orders Report (Landscape)

The Printed Change Orders Report (Landscape) prints changed purchase orders. The change purchase orders are the hard copy document you print on a preprinted form and distribute through the mail or fax to confirm changed orders you have requested or confirmed with your suppliers. Purchasing provides a default format for the preprinted form. Contact your Oracle Consultant for information regarding the forms. See: Printed Purchase Order Overview: page 4 – 109.

A purchase order will not print or fax if the supplier site on the purchase order is already set up to receive purchase orders through Electronic Data Interchange (EDI).

You can print most fields on this report in another language, if you use Multilingual Support (MLS). See: Submitting a Request, Oracle Applications User’s Guide.

Note: You can print item descriptions in other languages only for inventory items for which translations have been entered. If you change the item description on the document, it does not print in the translated language.

Report Submission

In the Submit Requests window, select Printed Change Orders Report (Landscape) in the Name field.

Report Parameters

Buyer

Select a buyer name to restrict the report to a specific buyer.

Purchase Order Numbers From/To

To restrict the report to a range of purchase orders, select the beginning and ending numbers.
**Release Numbers From/To**

To restrict the report to a range of releases, select the beginning and ending numbers.

**Release Dates From/To**

To restrict the report to a release date range, enter the beginning and ending dates.

**Print Releases Option**

Enter Y or N to indicate whether you want Blanket and Planned Purchase Order releases to be automatically printed with the Blanket and Purchase Order Agreements.

**Sort By**

Select one of the following options:

- **Buyer Name**: Sort the report by buyer name. This is the default if you leave the field blank.
- **Purchase Order Number**: Sort the report by purchase order number.

**Dynamic Precision Option**

Enter the decimal precision for quantities on the report.

**Fax Enabled / Fax Number**

Select Fax Enabled and enter a Fax Number to automatically send a facsimile of the document. CommercePath, or any facsimile software that is compatible with the CommercePath Fax Command Language (FCL), must be installed to use this functionality.

**Attention:** If you entered a Purchase Order Numbers From/To range, all of the purchase orders in that range must use the same supplier site. Otherwise, the purchase orders will be sent to the same facsimile number you enter here. (The Fax fields will be disabled if the purchase orders aren’t from the same supplier site.)

Selecting Fax Enabled without entering a Fax Number sends the document to your facsimile server once it is approved. Depending on your CommercePath setup, you can choose where or when to send the documents that are stored on your facsimile server.
See Also

Submitting a Request, Oracle Applications User’s Guide
Viewing Requests, Oracle Applications User’s Guide
Printed Change Orders Report (Portrait)

The Printed Change Orders Report (Portrait) prints changed purchase orders to send to your suppliers. The change purchase orders are the hard copy document you print on a preprinted form and distribute through the mail or fax to confirm changed orders you have requested or confirmed with your suppliers. Purchasing provides a default format for the preprinted form. Contact your Oracle Consultant for information regarding the forms. See: Printed Purchase Order Overview: page 4 – 109.

A purchase order will not print or fax if the supplier site on the purchase order is already set up to receive purchase orders through Electronic Data Interchange (EDI).

You can print most fields on this report in another language, if you use Multilingual Support (MLS). See: Submitting a Request, Oracle Applications User’s Guide.

**Note:** You can print item descriptions in other languages only for inventory items for which translations have been entered. If you change the item description on the document, it does not print in the translated language.

Report Submission

In the Submit Requests window, select Printed Change Orders Report (Portrait) in the Name field.

Report Parameters

**Buyer**

Select a buyer name to restrict the report to a specific buyer.

**Purchase Order Numbers From/To**

To restrict the report to a range of purchase orders, select the beginning and ending numbers.
Release Numbers From/To

To restrict the report to a range of releases, select the beginning and ending numbers.

Release Dates From/To

To restrict the report to a release date range, enter the beginning and ending dates.

Print Releases Option

Enter Y or N to indicate whether you want Blanket and Planned Purchase Order releases to be automatically printed with the Blanket and Purchase Order Agreements.

Sort By

Select one of the following options:

- **Buyer Name**
  
  Sort the report by buyer name. This is the default if you leave the field blank.

- **Purchase Order Number**
  
  Sort the report by purchase order number.

Dynamic Precision Option

Enter the decimal precision for quantities on the report.

Fax Enabled / Fax Number

Select Fax Enabled and enter a Fax Number to automatically send a facsimile of the document. CommercePath, or any facsimile software that is compatible with the CommercePath Fax Command Language (FCL), must be installed to use this functionality.

**Attention:** If you entered a Purchase Order Numbers From/To range, all of the purchase orders in that range must use the same supplier site. Otherwise, the purchase orders will be sent to the same facsimile number you enter here. (The Fax fields will be disabled if the purchase orders aren’t from the same supplier site.)

Selecting Fax Enabled without entering a Fax Number sends the document to your facsimile server once it is approved. Depending on your CommercePath setup, you can choose where or when to send the documents that are stored on your facsimile server.
See Also

Submitting a Request, *Oracle Applications User’s Guide*

Viewing Requests, *Oracle Applications User’s Guide*
Printed Purchase Order Report (Landscape)

The Printed Purchase Order Report (Landscape) prints your purchase orders. Purchasing lets you specify the purchase orders you want to review or print on your preprinted form. The printed purchase orders are the hard copy document you print on a preprinted form and distribute through the mail or fax to confirm orders you have requested or confirmed with your suppliers. Purchasing provides a default landscape format for the preprinted form. Contact your Oracle Consultant for information regarding the forms. See: Printed Purchase Order Overview: page 4 – 109.

A purchase order will not print or fax if the supplier site on the purchase order is already set up to receive purchase orders through Electronic Data Interchange (EDI).

You can print most fields on this report in another language, if you use Multilingual Support (MLS). See: Submitting a Request, Oracle Applications User’s Guide.

Note: You can print item descriptions in other languages only for inventory items for which translations have been entered. If you change the item description on the document, it does not print in the translated language.

Report Submission

In the Submit Requests window, select Printed Purchase Order Report (Landscape) in the Name field.

Report Parameters

Print Selection

Select one of the following options:

All          Print the report for all purchase orders. This is the default for no entry.
Changed     Print the report only for changed purchase orders.
New          Print the report only for new purchase orders.
Buyer
Select a buyer name to restrict the report to a specific buyer.

Purchase Order Numbers From/To
To restrict the report to a range of purchase orders, select the beginning and ending numbers.

Release Numbers From/To
To restrict the report to a range of releases, select the beginning and ending numbers.

Release Dates From/To
To restrict the report to a release date range, enter the beginning and ending dates.

Approved
Select Yes or No to indicate whether the report is restricted to approved purchase orders.

Test
Select Yes or No to indicate whether the report is a test.

Print Releases Option
Enter Y or N to indicate whether you want Blanket and Planned Purchase Order releases to be automatically printed with the Blanket and Purchase Order Agreements.

Sort By
Select one of the following options:

Buyer Name
Sort the report by buyer name and purchase order number.

Purchase Order Number
Sort the report by purchase order number.
Dynamic Precision Option

Enter the decimal precision for quantities on the report.

Fax Enabled / Fax Number

Select Fax Enabled and enter a Fax Number to automatically send a facsimile of the document. CommercePath, or any facsimile software that is compatible with the CommercePath Fax Command Language (FCL), must be installed to use this functionality.

Attention: If you entered a Purchase Order Numbers From/To range, all of the purchase orders in that range must use the same supplier site. Otherwise, the purchase orders will be sent to the same facsimile number you enter here. (The Fax fields will be disabled if the purchase orders aren’t from the same supplier site.)

Selecting Fax Enabled without entering a Fax Number sends the document to your facsimile server once it is approved. Depending on your CommercePath setup, you can choose where or when to send the documents that are stored on your facsimile server.

See Also

Submitting a Request, Oracle Applications User’s Guide
Viewing Requests, Oracle Applications User’s Guide
Printed Purchase Order Report (Portrait)

The Printed Purchase Orders Report (Portrait) prints the purchase orders you specify. The printed purchase orders are the hard copy document you print on a preprinted form and distribute through the mail or fax to confirm orders you have requested or confirmed with your suppliers. Purchasing provides a default portrait format for the preprinted form. Contact your Oracle Consultant for information regarding the forms. See: Printed Purchase Order Overview: page 4 – 109.

A purchase order will not print or fax if the supplier site on the purchase order is already set up to receive purchase orders through Electronic Data Interchange (EDI).

You can print most fields on this report in another language, if you use Multilingual Support (MLS). See: Submitting a Request, Oracle Applications User’s Guide.

Note: You can print item descriptions in other languages only for inventory items for which translations have been entered. If you change the item description on the document, it does not print in the translated language.

Report Submission

In the Submit Requests window, select Printed Purchase Order Report (Portrait) in the Name field.

Report Parameters

Print Selection

Select one of the following options:

- **All**: Print the report for all purchase orders. This is the default for no entry.
- **Changed**: Print the report only for changed purchase orders.
- **New**: Print the report only for new purchase orders.
**Buyer**
Select a buyer name to restrict the report to a specific buyer.

**Purchase Order**
**Numbers From/To**
To restrict the report to a range of purchase orders, select the beginning and ending numbers.

**Release Numbers From/To**
To restrict the report to a range of releases, select the beginning and ending numbers.

**Release Dates From/To**
To restrict the report to a release date range, enter the beginning and ending dates.

**Approved**
Select Yes or No to indicate whether the report is restricted to approved purchase orders.

**Test**
Select Yes or No to indicate whether the report is a test.

**Print Releases Option**
Enter Y or N to indicate whether you want Blanket and Planned Purchase Order releases to be automatically printed with the Blanket and Purchase Order Agreements.

**Sort By**
Select one of the following options:

- **Buyer Name**
  Sort the report by buyer name and purchase order number.

- **Purchase Order Number**
  Sort the report by purchase order number.
**Dynamic Precision Option**

Enter the decimal precision for quantities on the report.

**Fax Enabled / Fax Number**

Select Fax Enabled and enter a Fax Number to automatically send a facsimile of the document. CommercePath, or any facsimile software that is compatible with the CommercePath Fax Command Language (FCL), must be installed to use this functionality.

**Attention:** If you entered a Purchase Order Numbers From/To range, all of the purchase orders in that range must use the same supplier site. Otherwise, the purchase orders will be sent to the same facsimile number you enter here. (The Fax fields will be disabled if the purchase orders aren’t from the same supplier site.)

Selecting Fax Enabled without entering a Fax Number sends the document to your facsimile server once it is approved. Depending on your CommercePath setup, you can choose where or when to send the documents that are stored on your facsimile server.

**See Also**

Submitting a Request, *Oracle Applications User’s Guide*

Viewing Requests, *Oracle Applications User’s Guide*
Printed RFQ Report (Landscape)

The Printed RFQ Report (Landscape) prints in landscape format RFQs with a Status of Active. Purchasing lets you specify the RFQs you want to review or print. Purchasing provides a default landscape format for preprinted landscape forms. Contact your Oracle Consultant for information regarding the forms.

You can print most fields on this report in another language, if you use Multilingual Support (MLS). See: Submitting a Request, Oracle Applications User’s Guide.

Note: You can print item descriptions in other languages only for inventory items for which translations have been entered. If you change the item description on the document, it does not print in the translated language.

Report Submission

In the Submit Requests window, select Printed RFQ Report (Landscape) in the Name field.

Report Parameters

Report Type

Choose one of the following options:

*All*    Print the report for all RFQs.

*Changed*    Print the report only for changed RFQs.

*New*    Print the report only for new RFQs.

Buyer

Enter a buyer name to restrict the report to a specific buyer.

RFQ Numbers From/To

Enter the beginning and ending RFQ numbers.
Test

Enter Yes or No to indicate whether the report is a test.

Sort By

Choose one of the following options:

* **Buyer Name**
  Sort the report by buyer name.

* **RFQ Number**
  Sort the report by RFQ number.

Dynamic Precision Option

Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, *Oracle Applications User’s Guide*
Printed RFQ Report (Portrait)

The Printed RFQ Report (Portrait) prints in portrait format RFQs with a Status of Active. Purchasing lets you specify the RFQs you want to review or print. Purchasing provides a default portrait format for preprinted portrait forms. Contact your Oracle Consultant for information regarding these forms.

You can print most fields on this report in another language, if you use Multilingual Support (MLS). See: Submitting a Request, Oracle Applications User’s Guide.

**Note:** You can print item descriptions in other languages only for inventory items for which translations have been entered. If you change the item description on the document, it does not print in the translated language.

Report Submission

In the Submit Requests window, select Printed RFQ Report (Portrait) in the Name field.

Report Parameters

**Report Type**

Choose one of the following options:

*All* Print the report for all RFQs.

*Changed* Print the report only for changed RFQs.

*New* Print the report only for new RFQs.

**Buyer**

Enter a buyer name to restrict the report to a specific buyer.

**RFQ Numbers From/To**

Enter the beginning and ending RFQ numbers.
Test

Enter Yes or No to indicate whether the report is a test.

Sort By

Choose one of the following options:

*Buyer Name*  
Sort the report by buyer name.

*RFQ Number*  
Sort the report by RFQ number.

Dynamic Precision Option

Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, *Oracle Applications User’s Guide*
Printed Requisitions Report

The Printed Requisitions Report prints the requisitions which have the following status: Approved, Rejected, In Process, Pre–Approved, and Returned. The report does not include requisitions with status Incomplete or cancelled. You can circulate the printed requisitions for signature approvals and notes.

Additional Information: In the Approver field the report prints the name of the last person who performed an action on the requisition. This is not necessarily the approver.

Report Submission

In the Submit Requests window, select Printed Requisitions Report in the Name field.

Report Parameters

Requisition Numbers From/To

Enter the beginning and ending requisition numbers.

Dynamic Precision Option

Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, Oracle Applications User’s Guide
Purchase Agreement Audit Report

You can use this report to review purchase order transactions for items you normally buy using blanket purchase agreements. Purchasing lets you determine if you are efficiently using the blanket purchase agreements you negotiate with your suppliers. For each item you buy using blanket purchase agreements, Purchasing provides you with the detail of the existing purchase orders for this item and the detail of the agreement lines—blanket or standard—you created for this item. Purchasing shows you when you purchased items using a standard purchase order where you could have used a blanket purchase agreement.

The Opportunity Cost is calculated as the sum of the amount of the purchase order subtracted from the sum of the amount of the blankets.

Report Submission

In the Submit Requests window, select Purchase Agreement Audit Report in the Name field.

Report Parameters

Buyer
Enter a buyer name to restrict the report to a specific buyer.

Blanket PO Numbers From/To
Enter the beginning and ending blanket purchase agreement numbers.

Creation Dates From/To
Enter the beginning and ending creation dates.

Categories From/To
Enter the beginning and ending purchasing categories.
Items From/To

Enter the beginning and ending item numbers.

Sort By

Use the Sort By feature to produce a report customized to your specific needs. Choose one of the following options:

Category         Sort the report by purchasing category.
Item             Sort the report by item number.

Dynamic Precision Option

Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, Oracle Applications User’s Guide
Purchase Order Commitment by Period Report

The Purchase Order Commitment By Period Report shows the monetary value of your purchased commitments for a specified period and the next five periods. You can use the report sorted by buyer to monitor buyer performance. You can also use the report when negotiating with a supplier by limiting the commitments to a specific supplier.

Report Submission

In the Submit Requests window, select Purchase Order Commitment by Period Report in the Name field.

Report Parameters

**Period**

Enter the beginning period to be covered by the report. If the purchase order number shipment promise date falls within the period start and end date, the monetary value is included in the report. For orders which do not include a promise date, the need–by date is considered.

**PO Numbers From/To**

Enter the beginning and ending purchase order numbers.

**Suppliers From/To**

Enter the beginning and ending supplier names.

**Buyer**

Enter the buyer name to restrict the report to a specific buyer.

**Categories From/To**

Enter the beginning and ending purchasing categories.
Sort By

Use the Sort By feature to produce a report customized to your specific needs. Choose one of the following options:

Supplier        Sort the report by supplier.
Buyer Name      Sort the report by buyer.

See Also

Submitting a Request, Oracle Applications User’s Guide
Purchase Order Detail Report

The Purchase Order Detail Report lists all, specific standard, or planned purchase orders. Purchasing displays the quantity you ordered and received so you can monitor the status of your purchase orders. You can also review the open purchase orders to determine how much you still have to receive and how much your supplier has already billed you.

Report Submission

In the Submit Requests window, select Purchase Order Detail Report in the Name field.

Report Parameters

Buyer
Enter the buyer name to restrict the report to a specific buyer.

Items From/To
Enter the beginning and ending item numbers.

Categories From/To
Enter the beginning and ending purchasing categories.

Suppliers From/To
Enter the beginning and ending supplier names.

PO Numbers From/To
Enter the beginning and ending purchase order numbers.
**Status**

Enter the purchase order status to restrict the report to a specific status. Choose one of the following options: Approved, In Process, Incomplete, Pre–Approved, Rejected, Requires Reapproval, Reserved, or Returned.

**Dynamic Precision Option**

Enter the decimal precision for quantities on the report.

**See Also**

Submitting a Request, *Oracle Applications User’s Guide*
Purchase Order Distribution Detail Report

The Purchase Order Distribution Detail Report shows account distributions for a range of purchase orders. If you use Purchase Order Encumbrance Control and you set the failure funds only report option to Yes, Purchasing prints only those accounts that fail funds reservation.

The Quantity Ordered is the uncancelled shipment quantity. For planned purchase order shipments, this quantity excludes cancelled quantities and any scheduled release quantities associated with the shipment.

Report Submission

In the Submit Requests window, select Purchase Order Distribution Detail Report in the Name field.

Report Parameters

PO Numbers From/To
Enter the beginning and ending purchase order numbers.

Creation Dates From/To
Enter the beginning and ending creation dates.

Suppliers From/To
Enter the beginning and ending supplier numbers.

Buyer
Enter a buyer name to restrict the report to a specific buyer.

Failed Funds Only
Enter Yes or No to indicate whether you want to restrict the report to purchase orders that failed funds checking.
Sort By

Use the Sort By feature to produce a report customized to your specific needs. Choose one of the following options:

- **Purchase Order Number**: Sort the report by purchase order number.
- **Supplier**: Sort the report by supplier.

See Also

Submitting a Request, *Oracle Applications User’s Guide*
Purchase Order and Releases Detail Report

The Purchase Order and Releases Detail Reports show detail information for your blanket purchase agreements and planned purchase orders. Purchasing displays the quantity that you ordered, received, billed, and that is due to be received so you can monitor the status of your purchase orders. You can review releases to determine how much is remaining to be received and invoiced.

Report Submission

In the Submit Requests window, select Purchase Order and Releases Detail Report in the Name field.

Report Parameters

Buyer
Enter the buyer name to restrict the report to a specific buyer.

Categories From/To
Enter a beginning and an ending value.

Items From/To
Enter the beginning and ending item numbers.

Suppliers From/To
Enter the beginning and ending supplier names.

PO Numbers From/To
Enter the beginning and ending purchase order numbers.

See Also

Submitting a Request, Oracle Applications User’s Guide
Purchase Price Variance Report

The Purchase Price Variance Report shows the variance between the purchase price on the purchase order and standard cost for all items you receive and deliver into inventory and work in process. Inventory records purchase price variance on delivery into a subinventory. Work in Process records purchase price variance on delivery into a job or repetitive schedule. For internal requisitions, the purchase order ship to location is associated with the organization in the Customers window. See: Assigning a Business Purpose to a Customer Address, Oracle Public Sector Receivables User’s Guide.

The purchase price variance is calculated as the quantity received multiplied by the difference between the purchase order price and the standard cost.

Prerequisites

Since this report displays purchase price variances for standard costing, this report is appropriate only for organizations using Inventory and standard costing. If you use Work in Process, this report also displays the outside processing purchase price variance.

Report Submission

In the Cost and Period Close Reports (for Inventory) or Submit Requests windows, select Purchase Price Variance Report in the Name field.

Report Parameters

**Categories From/To**

Enter the beginning and ending purchasing categories.

**Transaction Dates From/To**

Enter the beginning and ending transaction dates.
Suppliers From/To

Enter the beginning and ending suppliers.

Organization Name

Enter the organization name. The ship to location is associated with the organization in the Location Association window.

Sort By

Choose one of the following options:

- **Buyer Name** Sort the report by buyer name.
- **Category** Sort the report by item category.
- **Item** Sort the report by item number.
- **Supplier** Sort the report by supplier.

Dynamic Precision Option

Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, *Oracle Applications User’s Guide*
Purchase Requisition Status Report

The Purchase Requisition Status Report can be used to review the approval status of the requisitions you create. By limiting the approval status, you can use the report as a tool to plan and monitor the buyer workload. You can also use the report to monitor requisitions in the approval process or returned and requiring further attention.

The report can include requisitions with the following statuses:

- **Approved**: An approver with sufficient authority approved the requisition. A buyer can now place the corresponding requisition lines onto purchase orders.

- **Cancelled**: A requisition preparer cancelled the requisition.

- **In Process**: The preparer completed the requisition and submitted to the approval process. However, no one with sufficient authority has approved the requisition.

- **Incomplete**: The requisition is incomplete and the preparer has not yet submitted the requisition to an approver.

- **Pre–Approved**: At least one person with sufficient authority approved the requisition. The status is not Approved either because the approver forwarded the requisition to someone else, or the approver has not yet reserved the funds.

- **Rejected**: The approver rejected the requisition. Purchasing returns the entire requisition to the preparer.

- **Returned**: A buyer returned the requisition. Purchasing returns to the preparer all requisition lines within the same requisition that are not on a purchase order.

Report Submission

In the Submit Requests window, select Purchase Requisition Status Report in the Name field.
Report Parameters

Requisition Numbers From/To
Enter the beginning and ending requisition numbers.

Creation Dates From/To
Enter the beginning and ending creation dates.

Requestor
Enter a requestor name to restrict the report to a specific requestor.

Location
Enter a deliver to location to restrict the report to a specific location.

Dynamic Precision Option
Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, *Oracle Applications User’s Guide*
Purchase Summary Report by Category

The Purchase Summary Report by Category shows the amount of orders you place with suppliers for a given category of item. Use the report to monitor the purchase documents included in a range of categories.

Report Submission

In the Submit Requests window, select Purchase Summary Report by Category in the Name field.

Report Parameters

Categories From/To
Enter the beginning and ending categories assigned to the item from the purchasing category set.

Buyers From/To
Enter the beginning and ending buyer names.

Suppliers From/To
Enter the beginning and ending supplier names.

Creation Dates From/To
Enter the beginning and ending creation dates.

See Also

Submitting a Request, Oracle Applications User’s Guide
Purchasing Activity Register

The Purchasing Activity Register shows purchase order monetary activity carried out for a time interval, such as a day or month. The report excludes all fully cancelled purchasing documents. The report includes blanket and contract purchase agreements and planned purchase orders for reference. However, since these documents do not represent actual purchase activity, their amounts are not shown in the PO Amount and Functional Amount columns and are not included in the Total amount.

Report Submission

In the Submit Requests window, select Purchasing Activity Register in the Name field.

Report Parameters

Creation Dates From/To
Enter the beginning and ending document creation dates.

PO Type
Enter the purchase order type to restrict the report to a specific type.

Supplier
Enter the supplier name to restrict the report to a specific supplier.

Buyer
Enter the buyer name to restrict the report to a specific buyer.

Sort By
Use the Sort By feature to produce a report customized to your specific needs. Choose Buyer Name or Creation Date.
Dynamic Precision Option

Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, Oracle Applications User’s Guide
Purchasing Database Administration

Use the Purchasing Database Administration process to initiate concurrent processes that purge obsolete records in Purchasing interface tables and other temporary tables. The purging of obsolete data helps reduce memory load and improve system performance. You need to run this process only once because the AutoSubmit process resubmits itself daily after you submit it the first time.

To run the Purchasing Database Administration process:

1. Navigate to the Submit Requests window.
2. Select Requests in the first field.
3. Select Purchasing Database Administration in the Name field.
4. Choose Submit Request.

See Also

Submitting a Request, Oracle Applications User’s Guide
Viewing and Responding to Notifications: page 2 – 31
Purchasing Documents Open Interface

The Purchasing Documents Open Interface receives price/sales catalog information and responses to requests for quotation (RFQs) electronically from suppliers in the form of blanket purchase agreements or catalog quotations. One way to import the agreements and quotations into the Purchasing Documents Open Interface, and finally into Purchasing, is through Oracle e–Commerce Gateway. After e–Commerce Gateway imports the electronic catalog information, the Purchasing Documents Open Interface program validates the information before importing it into Purchasing.

For blanket purchase agreements and catalog quotations, the Purchasing Documents Open Interface can be run from within e–Commerce Gateway when you choose Import Programs from the e–Commerce Gateway menu and enter parameters. Or you can run this program separately, from within Purchasing. If you run it from within Purchasing, you need to first import the price/sales catalog information into the interface tables, using e–Commerce Gateway or a custom import program. Then use this process to import the information into Purchasing. For standard purchase orders, you must use a custom import program to load the data into the interface tables and then use this process to import the information into Purchasing.

Submission

In the Submit Requests window, select Purchasing Documents Open Interface in the Name field.

Parameters

Default Buyer (Required)

Enter the default buyer name to be associated with the incoming documents.
<table>
<thead>
<tr>
<th><strong>Document Type (Required)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid options are Blanket, Quotation, and Standard. The option of Blanket directs Purchasing to create a blanket agreement from the price/sales catalog or quotation to be imported. The option of Quotation directs Purchasing to create a catalog quotation for the information to be imported. The option of Standard directs Purchasing to create a standard purchase order from the imported information.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Document Sub Type (Optional)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Used with document type of “Quotation” to indicate a document sub type of “Catalog Quotation” for the Price/Sales Catalog or Response to RFQ to be imported. The document sub type of “Bid Quotation” is invalid for the transaction.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Create or Update Item (Required)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Used with the Price/Sales Catalog or Response to RFQ to indicate whether you wish to update the item master with catalog item changes or add catalog items to the item master.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Create Sourcing Rules (Required)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicate Yes or No on whether supplier sourcing rules should be created automatically during the Price/Sales Catalog and Response to RFQ import process. Yes means that Purchasing creates sourcing rules out of the supplier, item, and document information that the supplier sends.</td>
</tr>
<tr>
<td>If you choose Yes, make sure the Approval Status field for the submitted documents is Approved. Sourcing rules can be created only when the Purchasing documents have a status of Approved.</td>
</tr>
<tr>
<td>If you are importing standard purchase orders, choose No. You cannot create sourcing rules from standard purchase orders, and purchase orders are imported with a status of Incomplete only.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Approval Status (Optional)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter desired status of Approved or Incomplete for the documents to be created. For purchase orders, you must choose Incomplete.</td>
</tr>
</tbody>
</table>
The following table shows the affects of the Approval Status you choose here on an agreement’s or quotation’s current status, when you import an Update price/sales catalog.

<table>
<thead>
<tr>
<th>Current Document Status</th>
<th>Import as Incomplete</th>
<th>Import as Approved</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incomplete</td>
<td>Document remains Incomplete</td>
<td>Document changes to Approved</td>
</tr>
<tr>
<td>Approved</td>
<td>Document remains Approved</td>
<td>Document remains Approved</td>
</tr>
</tbody>
</table>

Table 9 – 1  Document Status in Update Submission (Page 1 of 1)

**Release Generation Method (Optional)**

Used when Document Type is set to Blanket and Create Sourcing Rules is set to Yes. Select from the following three blanket release methods:

- **Automatic Release/Review**
  - Allows Purchasing to automatically generate releases and forwards them for approval.

- **Release using Autocreate**
  - Allows you to use AutoCreate to convert purchase requisitions into blanket releases for blanket purchase orders.

- **Automatic Release**
  - Allows Purchasing to automatically generate approved blanket releases for items that are sourced to a single supplier.

**Batch ID (Optional)**

Enter a valid batch ID, which is a unique identifier for the group of documents in this submission.

**See Also**

- Receiving Price/Sales Catalog Information Electronically: page 5 – 22
- Running the EDI Price/Sales Catalog Inbound Program, Oracle e–Commerce Gateway User’s Guide
- Running the EDI Response to Request for Quote Inbound Program, Oracle e–Commerce Gateway User’s Guide
- Submitting a Request, Oracle Applications User’s Guide
Purchasing Interface Errors Report

The Purchasing Interface Errors Report shows you what errors occurred, if any, while running the following programs:

- Receiving Open Interface – ASBN transactions
- Pay on Receipt – Receipt transactions
- Purchasing Documents Open Interface

For each row in the interface tables that fails validation, the above programs create one or more rows with error information that appears in the Purchasing Interface Errors Report.

Report Submission

In the Submit Requests window, select Purchasing Interface Errors Report in the Name field. A batch ID number is generated that you can refer to when you choose View My Requests from the Help menu.

Report Parameters

**Source Program**

Select the program whose errors you want reported.

- **Receiving Open Interface**
  Shows what errors occurred when the Receiving Open Interface tried creating an invoice from an Advance Shipment and Billing Notice (ASBN).

- **Pay on Receipt – Receipt transactions**
  Shows what errors occurred when the Pay on Receipt program tried creating an invoice from a receipt. Since Pay on Receipt also initiates the Payables Open Interface Import program to finish creating the invoices, also check the error report for the Payables Open Interface Import program. See: Payables Open Interface Import, *Oracle Public Sector Payables User’s Guide*. 
Purchasing Documents Open Interface

Shows what errors occurred when the Purchasing Documents Open Interface program ran. The Purchasing Documents Open Interface program processes blanket purchase agreements, catalog quotations, or standard purchase orders that are in the Oracle Applications interface tables to ensure that the data is valid before importing it into Purchasing.

Purge Data

Choose Yes to purge the data in the Purchasing Interface Errors table after the report runs. The errors you see in the report will not reappear the next time you run it. Only the data for the Source Program you chose will be deleted. Choose No to keep the errors in the table and in the report, listed along with any new errors.

See Also

Submitting a Request, Oracle Applications User’s Guide
Receiving Price/Sales Catalog Information Electronically: page 5 – 22
Purchasing Documents Open Interface: page 9 – 108
Purge Purchasing Open Interface Processed Data

The Purge Purchasing Open Interface Processed Data process purges data in the Purchasing Documents Open Interface tables. You can purge this data after you have imported the data into Purchasing. This process purges only accepted or rejected data, not data that is still pending.

Report Submission

To run the Purge Purchasing Open Interface Processed Data process:

1. In the Submit Requests window, select Purge Purchasing Open Interface Processed Data in the Name field.
2. Optionally specify the following information:
   - *Document Type* – Purges only documents of the document type you select.
   - *Document Subtype* – Purges only documents of the document subtype you select.
   - *Purge Accepted Data* – Purges only those documents that did not produce errors in the interface tables.
   - *Purge Rejected Data* – Purges only those documents that produced errors in the interface tables.
   - *Start Date / End Date* – Purges only those documents between the start and end dates you enter.
   - *Batch ID* – Purges only those documents imported under the Batch ID you enter.

   If you leave all of these fields blank, this process purges all of the data in the interface tables.

3. Choose OK and Submit to begin the process.

See Also

- Submitting a Request, *Oracle Applications User’s Guide*
- Receiving Price/Sales Catalog Information Electronically: page 5 – 22
- Purchasing Documents Open Interface: page 9 – 108
Quality Code Listing

The Quality Code Listing shows inspection quality codes. You can use this listing to help assign quality codes when inspections are performed. See: Defining Quality Inspection Codes: page 1 – 77.

Report Submission

In the Submit Requests window, select Quality Code Listing in the Name field.

Report Parameters

Active/Inactive

Choose one of the following options:

- **Active**: List only active codes on the report.
- **Both**: List both active and inactive codes on the report.
- **Inactive**: List only inactive codes on the report.

Sort By

Use the Sort By feature to produce a report customized to your specific needs. Choose one of the following options:

- **Quality Code**: Sort the report by quality code.
- **Ranking**: Sort the report by ranking.

See Also

Submitting a Request, Oracle Applications User’s Guide
Quotation Action Required Report

The Quotation Action Required report lists quotations that require follow-up action. This report provides you with all of the information you need to take immediate action on the quotation. Purchasing lets you specify the quotations you want to review. If you do not specify a date range, all quotations are displayed.

This report prints quotations that are about to expire. For each of these quotations, Purchasing prints the quotation number, the supplier name, the supplier site, the supplier quotation number, and the expiration date. Purchasing displays the quotation line details so you can quickly review the purpose of the quotations. See: Entering Quotation Headers: page 5 – 73.

Report Submission

In the Submit Requests window, select Quotation Action Required Report in the Name field.

Report Parameters

Suppliers From/To

Enter the beginning and ending supplier names.

Buyer

Enter a buyer name to restrict the report to a specific buyer.

Quotation Expiration Dates From/To

Enter the beginning and ending expiration dates to limit the quotations to the ones with expiration dates during the date range. Note that if you enter a date range, the quotation warning delay is considered but quotations without an expiration date are excluded from the report.

Categories From/To

Enter the beginning and ending purchasing categories.
Dynamic Precision Option

Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, Oracle Applications User’s Guide
RFQ Action Required Report

The RFQ Action Required report lists RFQs that require follow-up action. This report provides you with all of the information you need to take immediate action on RFQs approaching the reply due date. Purchasing lets you specify which RFQs you want to review.

This report prints your RFQs for which you have not received complete responses. For each RFQ, Purchasing prints the RFQ description and the reply due date. To help you contact the supplier that requires action, Purchasing prints the supplier, supplier site, supplier contact, and telephone number of the contact. See: Entering RFQ Headers: page 5 – 57.

Report Submission

In the Submit Requests window, select RFQ Action Required Report in the Name field.

Report Parameters

Buyer

Enter a buyer name to restrict the report to a specific buyer.

RFQ Reply Date From/To

Enter the beginning and ending reply dates. Purchasing breaks and prints on the reply date.

Suppliers From/To

Enter the beginning and ending supplier names.

Categories From/To

Enter the beginning and ending purchasing categories.
Sort By

Choose one of the following options:

- **Buyer Name**: Sort the report by buyer name.
- **RFQ Reply Date**: Sort the report by RFQ reply date.

See Also

Submitting a Request, *Oracle Applications User’s Guide*
Receipt Accruals – Period–End Process

Use the Receipt Accruals – Period–End process to create period–end accruals for your uninvoiced receipts for Expense distributions. Purchasing creates an accrual journal entry in your general ledger for each uninvoiced receipt you choose using this form. If you use encumbrance or budgetary control, Purchasing reverses your encumbrance entry when creating the corresponding accrual entry.

Attention: When using Cash Basis Accounting, you should use the Purchasing Options window to set the Accrue Expense Items flag to Period End, but you will not normally run the Receipt Accrual – Period–End process. See: Defining Accrual Options: page 1 – 48.

Purchasing provides you with complete flexibility and control for your period–end accruals. You can use the Uninvoiced Receipts Report to analyze your uninvoiced receipts before you accrue them. You can then run the Receipt Accruals – Period–End process as many times as you want to generate accruals entries for the receipts you choose. Purchasing does not accrue receipts for purchase orders on or before the last date of the Accrual Period.

You create accruals for a specific purchasing period. Purchasing automatically accrues all uninvoiced receipts you entered up to the end of the accrual period you specify. Each time you run the Receipt Accruals – Period–End process, Purchasing creates an unposted journal entries batch in your general ledger for your receipt accruals. If you are using encumbrance or budgetary control, Purchasing creates another journal entries batch in your general ledger corresponding to the encumbrance reversal entries for the uninvoiced receipts you accrued.

Each time you create accrual entries for a specific uninvoiced receipt, Purchasing marks this receipt as accrued and ignores it the next time you run the Receipt Accrual – Period–End process. Purchasing creates accrual entries only up to the quantity the supplier did not invoice for partially invoiced receipts.

Follow the steps listed below:

- Identify the purchasing period for your receipt accrual entries. Purchasing creates receipt accruals for all receipts you entered up to the end of this period. To prevent any period–end disruption, Purchasing lets you provide a receipt date that is different from the date you enter the receipts. You never have to enter all the receipts for a period before the end of this period. You can enter these receipts later. You simply need to backdate the receipt date. Of course, you should make sure you entered
all receipts for a specific period before you create receipt accruals for that period.

If you perform additional receiving activity to an item after a period is closed—for example, you return an item received in a previous period and re-receive it using a date in the current period—encumbrance and accrual entries for the item are made for the current, open period.

• Enter and match all invoices you received during the period for your receipt accrual entries.
• Close the accounts payable period corresponding to the purchasing period for your receipts accrual entries.
• Run the Uninvoiced Receipts Report and analyze your uninvoiced receipts that are accrued at period end.
• Run the Receipt Accrual – Period–End process as many times as you need. You can use the search criteria to choose what you want to accrue and accrue your receipts step by step. This process creates accounting accrual entries using the journal source ‘Purchasing’ and the journal category ‘Accrual’.
• Run Journal Import in General Ledger to import the receipt accruals journals from General Ledger into Purchasing. See: Importing Journals, Oracle Public Sector General Ledger User’s Guide.
• Perform all the steps you need to close your accounting period and generate period–end reports and financial statements in your general ledger.
• Run the Accrual Reconciliation Report after period close to analyze your receipts accrued on receipt.
• Use your general ledger system to reverse all the receipt accrual and encumbrance reversal batches for your period–end accruals.
• Close the purchasing period for your receipt accruals. When you close a purchasing period, Purchasing automatically un–marks all the receipts you previously accrued to make sure you can accrue these receipts again if they are still uninvoiced in the next period.
• Make sure the Close Purchasing Periods process completes before you open the next period. When you close a period in the Open and Close Periods window and then save, the Close Purchasing Periods process runs automatically. Make sure this process completes before opening the next period.
After you have opened your next period in General Ledger and have either closed the previous general ledger period or have completed all previous month receipt accruals, you can reverse the previous month’s receipt accruals in the new month. You perform this by reversing each general ledger journal batch in General Ledger.

To run the Receipt Accruals – Period End process:

1. Navigate to the Submit Requests window.
2. Select Requests in the first field.
3. Select Receipt Accruals – Period–End in the Name field.
4. Enter the Minimum Accrual Amount.
   For example, if you do not want to accrue amounts less than $.10, enter .10. In this example, an accrual of .09 or less will not be created. Any accrual amount of .10 or greater will still be accrued. The default minimum accrual amount is 0, meaning all amounts are accrued.
5. Enter the Supplier to restrict period–end receipt accruals to a single supplier.
6. Enter the item Category to restrict period–end receipt accruals to a single category.
7. Enter the Period for which you want to perform period–end receipt accruals. Purchasing automatically provides you with a list of acceptable accrual periods. This list contains periods that you closed in your accounts payable system and either opened or did not use in your general ledger system.
8. Choose Submit to begin the process.

See Also

Submitting a Request, Oracle Applications User’s Guide
Receipt Adjustments Report

The Receipt Adjustments Report lists purchase order shipments, internal requisition lines, or return material authorization (RMA) lines with corrections or returns to supplier (or customer).

For supplier sourcing, the Source column lists the name of the supplier and supplier source for whom you make the adjustment. For inventory sourcing, the Source is the organization and subinventory. For returns from a customer, the Source is the customer name.

Report Submission

In the Transaction Reports (for Inventory) or Submit Requests window, select Receipt Adjustments Report in the Name field.

Report Parameters

Receipt Location
Enter the receipt location to restrict the report to a specific location.

Receiver
Enter the receiver name to restrict the report to a specific receiver.

Receipt Date From/To
Enter the beginning and ending receipt dates.

Supplier From/To
Enter the beginning and ending supplier names.

Supplier Site
Enter the supplier site to restrict the report to a specific supplier site.
Customer From/To
Enter a beginning and ending customer name if you want to review all expected returns from a specific customer or customers. These returns are authorized through an RMA document, which is created in Order Management.

Organization Name
Enter the organization name to restrict the report to a specific organization.

Sort By
Use the Sort By feature to produce a report customized to your specific needs. Choose one of the following options:

- **Document Number**: Sort the report by document number.
- **Supplier**: Sort the report by supplier name.

Dynamic Precision Option
Enter the decimal precision for quantities on the report.

See Also
Submitting a Request, *Oracle Applications User’s Guide*
Receipt Traveler

The Receipt Traveler facilitates receiving inspection and delivery of goods you receive within your organization. After you receive the goods, you can print receipt travelers and attach these tickets to the goods. You can enter selection criteria to specify the receipt travelers you want to print. One receipt traveler prints per distribution, and each traveler has space for you to record delivery comments.

The report includes the document type. For the Supplier source type: Standard Purchase Order, Blanket Release, or Scheduled Release. For the Internal Order source type: Internal Requisition. For the Inventory source type: Inventory. For a return from a customer: Return Material Authorization.

The report also includes the source for the item you deliver. For source type Supplier, this is the supplier name. For source type Inventory, this is the Organization name. For source type Internal Order, this is the source subinventory. For source type Customer, this is the customer name.

If the RCV: Print Receipt Traveler profile option is set to Yes, the receipt traveler automatically prints when you perform a receipt or a receiving transaction, and when you match unordered receipts.

Report Submission

In the Transaction Reports (for Inventory) or Submit Requests window, select Receipt Traveler in the Name field.

Report Parameters

Delivery Location

Enter a delivery location to restrict the report to a specific delivery location.

Receipt Numbers From/To

Enter the beginning and ending receipt numbers.
Items From/To
Enter the beginning and ending item numbers.

Categories From/To
Enter a beginning and an ending category.

Ship to Location
Enter a ship-to location to restrict the report to a specific location.

Organization Name
Enter the organization name for this report.

Dynamic Precision Option
Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, Oracle Applications User’s Guide
Profile Options in Purchasing: page 1 – 103
Receiving Account Distribution Report

The Receiving Account Distribution Report lists the accounting distributions for your receiving transactions. This report supports the distributions created for the following transactions:

- Purchase Order Receipts
- Purchase Order Receipt Adjustments
- Purchase Order Returns to Supplier
- Deliver to Expense Destinations
- Return to Receiving from Expense Destinations
- Match Unordered Receipts

This feature helps you reconcile your receiving accounting to your general ledger.

**Note:** The accounting distributions for Deliver to and Return from both Inventory and Shop Floor (WIP) destinations are transferred to the General Ledger Interface by Inventory. When you reconcile your receiving inspection account, you need to include these transactions from the Material Account Distribution Reports as well as the WIP Account Distribution Reports.

Report Submission

In the Transaction Reports (for Inventory) or Submit Requests windows, select Receiving Account Distribution Report in the Name field.

Report Parameters

**Sort Option**

Use the Sort By parameter to produce a report customized to your specific needs. Choose one of the following options:

- **Account and Item**
  Sort the report by account and item.

- **Account and Receipt**
  Sort the report by account and receipt number.
Account and Supplier

Sort the report by account and supplier name.

**Organization Name**

Enter the organization name to restrict the report to a specific organization. If you leave this field blank, the report prints distributions for all organizations.

**Date From/To**

Enter the beginning and ending receipt dates.

**Item From/To**

Enter the beginning and ending item numbers.

**Category From/To**

Enter the beginning and ending categories.

**Supplier From / Supplier To**

Enter the beginning and ending supplier names.

**Receipt Number From / Receipt Number To**

Enter the beginning and ending receipt numbers.

**Account From / Account To**

Enter the beginning and ending accounts.

**Dynamic Precision Option**

Enter the decimal precision for quantities on the report.

**See Also**

Submitting a Request, *Oracle Applications User’s Guide*
Receiving Exceptions Report

Use the Receiving Exceptions Report to review receipts for which there is a receipt exception. These receipts cannot be automatically closed for receiving or invoicing. You can enter a receipt exception when you receive the item.

Report Submission

In the Transaction Reports (for Inventory) or Submit Requests window, select Receiving Exceptions Report in the Name field.

Report Parameters

Receipt Location
Enter the receipt location to restrict the report to a specific location.

Receiver
Enter the receiver name to restrict the report to a specific receiver.

Receipt Date From/To
Enter the beginning and ending receipt dates.

Supplier From/To
Enter the beginning and ending supplier names.

Supplier Site
Enter the supplier site to restrict the report to a specific supplier site.

Organization Name
Enter the organization name to restrict the report to a specific organization.
**Sort By**

Use the Sort By feature to produce a report customized to your specific needs. Choose one of the following options:

- **Purchase Order Number**: Sort the report by purchase order number.
- **Supplier**: Sort the report by supplier name.

**Dynamic Precision Option**

Enter the decimal precision for quantities on the report.

**See Also**

Submitting a Request, *Oracle Applications User’s Guide*
Receiving Interface Errors Report

This report shows you what warnings or errors occurred while the Receiving Transaction Processor was processing rows in the Receiving Open Interface tables. Rows processed in the Receiving Open Interface include Advance Shipment Notices (ASNs), receipts, and deliveries. Any errors that occur during this process are displayed in the Receiving Interface Errors report when you run the report. At the same time, the errors are also sent to the Oracle e-Commerce Gateway process responsible for generating Application Advices. (For example, Application Advices are sent back to suppliers detailing errors that occurred when the suppliers sent ASNs.)

Report Submission

In the Submit Requests window, select Receiving Interface Errors Report in the Name field.

Report Parameters

Start Date / End Date

Enter the Start and End dates of the period in which the Receiving Open Interface information was processed and the errors were generated.

See Also

Submitting a Request, Oracle Applications User’s Guide
Advance Shipment Notices (ASNs): page 7 – 17
Receiving Transaction Processor

Use the Receiving Transaction Processor to process your pending or unprocessed receiving transactions. How the Receiving Transaction Processor handles these transactions depends on the processing mode, which is a profile option that you can set at the site, application, responsibility, and user levels.

In On–line processing mode, Purchasing calls the Receiving Transaction Processor when you save your work.

In Immediate processing mode, when you save your work, the receiving forms call the Receiving Transaction Processor for the group of transactions you have entered since you last saved your work. Note that this is a specific group of transactions. Transactions belonging to other groups (for example, those entered by another user in Batch processing mode) are not included.

In Batch processing mode, the receiving forms insert transaction information into the receiving interface tables. These transactions remain in the interface table until you run the Receiving Transaction Processor. The receiving forms take into account all pending transactions, but Purchasing does not update the transaction history, source documents, and supply information until the transactions are processed.

You can set Standard Report Submission parameters to run the Receiving Transaction Processor at specified intervals so that your pending transactions are processed as often as required.

The Receiving Transaction Processor performs the following functions:

- validates Advance Shipment Notice (ASN) and Advance Shipment and Billing and Notice (ASBN) information in the receiving open interface
- derives and defaults values into the receiving interface tables (For example, if a particular value or field is not received, the receiving open interface tries to derive the value using defaulting and derivation rules.)
- creates receipt headers for intransit shipments
- creates receipt lines for all receipts
- maintains transaction history information
- maintains lot and serial transaction history
- accrues uninvoiced receipt liabilities
• maintains the following purchase order quantities: quantity received, quantity delivered, quantity accepted, and quantity rejected
• closes purchase orders for receiving
• maintains the following requisition quantities: quantity received, quantity delivered
• maintains supply information
• maintains inventory information (for Inventory destination type)
• maintains outside processing information (for Shop Floor destination type)

To run the Receiving Transaction Processor:
1. Navigate to the Submit Requests window.
2. Select Requests in the first field.
3. Select Receiving Transaction Processor in the Name field.
4. Choose Submit to begin the process.

See Also

Profile Options in Purchasing: page 1–103
Submitting a Request, Oracle Applications User’s Guide
Receiving Transactions Register

The Receiving Transactions Register lists detail information about your receiving transactions. The register is sorted by item, category, receipt number, document number, and transaction date. The three-part document number represents purchase order number, purchase order line number, and purchase order shipment number. For receiving transactions created against customer returns, the two-part document number represents the return material authorization (RMA) number and RMA line number.

Note that the register does not include information for transactions that are awaiting processing when the receiving transaction processor is in Batch or Immediate mode.

Report Submission

In the Transaction Reports (for Inventory) or Submit Requests window, select Receiving Transactions Register in the Name field.

Report Parameters

Organization
Enter the organization name to restrict the report to a specific organization.

Transaction Type
Enter the transaction type to restrict the report to a specific transaction type.

Transaction Dates From/To
Enter the beginning and ending transaction dates.

Receipt Numbers From/To
Enter the beginning and ending receipt numbers.
Receiver
Enter the receiver to restrict the report to a specific receiver.

Items From/To
Enter the beginning and ending items.

Categories From/To
Enter the beginning and ending purchasing categories.

Suppliers From/To
Enter the beginning and ending suppliers.

Purchase Order Numbers From/To
Enter the beginning and ending purchase order numbers.

Buyer
Enter the buyer to restrict the report to a specific buyer.

Internal Requisition Numbers From/To
Enter the beginning and ending internal requisition numbers.

Shipment Numbers From/To
Enter the beginning and ending shipment numbers.

Exception
Enter Yes or No to indicate whether to print only transactions with a receiving exception or only transactions with no receiving exception. Leave this field blank to print transactions regardless of exception status.

Detail
Enter Yes or No to indicate whether to print detail.
Include Lot/Serial

Enter Yes or No to indicate whether to print lot/serial number information.

RMA Numbers From/To

Enter the beginning and ending return material authorization (RMA) document numbers. An RMA is created in Order Management to authorize a customer return to your organization.

Customer From/To

Enter a beginning and ending customer name if you want to review all receiving transactions that were created against returns from a specific customer or customers. These returns are authorized through an RMA document, which is created in Order Management.

See Also

Submitting a Request, Oracle Applications User’s Guide
Receiving Value Report

The Receiving Value Report shows item quantity, valuation, and detailed receipt information for your receiving inspection location.

Note: If you choose a currency other than your functional currency, all value fields are multiplied by the exchange rate.

The Average Unit Price is calculated by dividing the total receiving value by the total receiving quantity on hand, using the primary unit of measure.

The Total Purchase Value is the quantity times the average unit price.

The Current Value is the sum of the quantity times the supplier cost for the cost type. This is the total cost of the item less any material overheads for the item. If material overheads are included, then the Purchase Price Difference column would be incorrect.

The Purchase Price Difference is the difference between the Total Purchase Value and the Current Value columns. You see this column only for inventory and shop floor (outside processing) destinations. This report also displays Outside Processing items with no associated resource value. You can use this information to manually accrue potential purchase price variances, before you deliver into inventory or work in process.

Report Submission

In the Cost and Period Close Reports (for Inventory) or Submit Requests (for Cost Management) window, select Receiving Value Report in the Name field.

Report Parameters

Organization Name

Enter the organization to restrict the report to a specific organization.

Cost Type

Optionally, enter a cost type to change the reported values for the Current Value column. If you do not enter a cost type, the report uses
the Frozen or Average cost type, depending on your costing method. If you specify a cost type, the report values the items at this cost type, for the respective supplier cost. This is the total cost of the item less any material overheads for the item. If the item is not in the specified cost type, the report values the item at the default cost type. For example, if you choose Quarter1 as the cost type and Quarter1 has Frozen as the default cost type, the report values the item at the Quarter1 cost. If Quarter1 is not available, it values the items at the Frozen cost type.

**Report Option**

Choose one of the following options:

- **Detail**
  Include detail receipt information, such as receipt date, receipt number, shipment number, current location, deliver-to location, packing slip, document type, document number, and item revision.

- **Summary**
  Include only summary information for the item, such as item description, quantity, average unit price, and total purchase value.

**Sort**

Choose one of the following options:

- **Category**
  Sort the report by category set and category.

- **Destination**
  Sort the report by purchase order destination and then by item.

- **Destination and Category**
  Sort the report by destination, by category set/category and then by item.

- **Item**
  Sort the report by item.

- **Location**
  Sort the report by current receiving location and then by item.

- **Supplier**
  Sort the report by supplier and then by item.

**Item From / Item To**

Enter a beginning and an ending item to restrict the report to a range of items.
Category Set

Enter a category set to restrict the report to that category set.

Category From / Category To

Enter a beginning and an ending category to restrict the report to a range of categories.

Currency

Enter a currency. When you enter a currency other than your functional currency, item costs are converted to the selected currency using the End of period rate you choose in the Exchange Rate field.

Exchange Rate

Choose an exchange rate. If you choose a currency other than your functional currency, the default is the most recent End of period rate. However, you can choose any prior End of period rate. See: Entering Period Rates, Oracle Public Sector General Ledger User’s Guide.

Quantities by Revision

Enter Yes or No to indicate whether you want to display item quantities by the revision of the item on the report. You can see revision quantities only when you choose Detail for the Report Option.

Display Zero Costs Only

Enter Yes or No to indicate whether you want to display items with zero costs only on the report. You use this option to identify any items that have a zero standard cost, before you deliver into inventory.

Document Type

Enter Purchase Order or Requisition to limit the reported information. If you do not enter a document type, the report displays both document types.

See Also

Submitting a Request, Oracle Applications User’s Guide
Receiving Value Report by Destination Account

The Receiving Value Report by Destination Account lists received items by purchase order destination and distribution account. If you accrue both inventory and expense at the time of receipt, you may have both inventory and expense as part of your receiving valuation account. The Receiving Value Report by Destination Account allocates your receiving balances by the purchase order line inventory, expense accounts, and quantities. You can then use this report to manually reclassify the receiving valuation account to the appropriate expense accounts.

Report Submission

In the Cost and Period Close Reports (for Inventory) or Submit Requests windows, select Receiving Value Report by Destination Account in the Name field.

Report Parameters

**Items From / Items To**

Enter the beginning and ending item numbers.

**Categories From / Categories To**

Enter the beginning and ending purchasing categories.

**Destination Type**

Enter a destination type to restrict the report to a specific destination type, such as Expense, Inventory, or Shop Floor.

**Accounts From / Accounts To**

Enter the beginning and ending accounts.

**Organization Name**

Enter the organization name to restrict the report to a specific organization.
Exclude One–time Items

Enter Yes or No to indicate whether you want to exclude one–time items from the report.

Dynamic Precision Option

Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, Oracle Applications User’s Guide
ReqExpress Templates Listing

The ReqExpress Templates Listing shows requisition template detail information.

The report lists sourcing information appropriate for the source type. For the Inventory source type, this is the organization and subinventory. For the Supplier source type, this is the buyer, supplier, supplier site, contact, supplier item number, and RFQ Required flag value.

Report Submission

In the Submit Requests window, select ReqExpress TemplatesListing in the Name field.

Report Parameters

Express Name

Enter the template name to restrict the report to a specific template.

See Also

Submitting a Request, Oracle Applications User’s Guide
Requisition Activity Register

The Requisition Activity Register shows requisition activity and monetary values. Purchasing prints the requisitions in order of *creation* date and prepared name.

Report Submission

In the Submit Requests window, select Requisition Activity Register in the Name field.

Report Parameters

**Creation Dates From/To**

Enter the beginning and ending requisition creation dates.

**Preparer**

Enter the preparer name to restrict the report to a requisitions from a specific preparer.

**Requisition Type**

Enter the requisitions document type (Purchase Requisition or Inventory Requisition) to restrict the report to a specific type.

See Also

Submitting a Request, *Oracle Applications User’s Guide*
Requisition Distribution Detail Report

The Requisition Distribution Detail Report lists requisitions, distributions, and charge account information. You can also use the report to review requisitions that failed funds reservation if you have enabled encumbrance. Totals print only if encumbrance has been enabled.

Report Submission

In the Submit Requests window, select Requisition Distribution Detail Report in the Name field.

Report Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requisition Numbers From/To</td>
<td>Enter the beginning and ending requisition numbers.</td>
</tr>
<tr>
<td>Requisition Creation Dates From/To</td>
<td>Enter the beginning and ending creation dates.</td>
</tr>
<tr>
<td>Preparer</td>
<td>Enter a preparer name to restrict the report to a specific preparer.</td>
</tr>
<tr>
<td>Failed Funds Only</td>
<td>Enter Yes or No to indicate whether you want to restrict the report to purchase orders that failed funds checking.</td>
</tr>
<tr>
<td>Dynamic Precision Option</td>
<td>Enter the decimal precision for quantities on the report.</td>
</tr>
</tbody>
</table>

See Also

Submitting a Request, Oracle Applications User’s Guide
Requisition Import Process

Use the Requisition Import process to import requisitions from other Oracle or non-Oracle systems. Work in Process, Master Scheduling/MRP, Order Management, and Inventory (as well as custom systems) can provide requisition information for the Purchasing requisition interface table. For example, drop-ship orders from Order Management and Kanban orders from Inventory are sent to the requisition interface table and converted into requisitions. Also, project and task information from Master Scheduling/MRP are imported through the Requisition Import process. Requisition Import creates a requisition line and one or more requisition distributions for each row it finds in the interface table. It then groups these lines on requisitions according to parameters you define below.

You can set the profile PO: Release During ReqImport to create releases each time you run the Requisition Import process. For example, when you implement planned orders as requisitions in the MRP Planner Workbench, you can automatically create the releases at the same time you create the requisitions. Purchasing automatically creates (and optionally approves) the releases for all blanket-sourced, approved requisitions as part of the Requisition Import process, not just those created by the Requisition Import run.

You can place requisitions you imported on purchase orders just as you would any other requisition. Purchasing automatically sources your requisition line to a blanket agreement or catalog quotation number if the supplier for the item is in the Approved Supplier List and if sourcing rules are set up for the item.

Requisition Import Approvals

Each requisition you create using Requisition Import enters Purchasing with the approval status that was specified when the row in the interface table was created. However, if you are using requisition encumbrance (the Use Requisition Encumbrance field in the Encumbrance Information region of the Financials Options window is set to Yes), Requisition Import changes the Approved status to Pre-Approved, and you must approve the requisitions.

Note: A Pre-Approved requisition does not show up as supply until its status changes to Approved. See: Approved Documents and Supply: page 2–25.
For Incomplete and Pre-Approved requisitions, Requisition Import calls the PO Requisition Approval workflow to submit the requisitions to the approval process unless you specify not to when you submit Requisition Import. For Approved requisitions, Requisition Import calls the PO Create Documents workflow in Purchasing to automatically create corresponding purchase orders, and the PO Create Documents workflow then calls the PO Approval workflow to approve the purchase orders, if you’ve enabled automatic creation and approval. See: Choosing Document Creation Options: page 1 – 95.

### Submission

When you submit the Requisition Import process, Purchasing automatically prints the Requisition Import Run Report. You can view this report by using the View Requests window and choosing the Report option in the View field for the Requisition Import process you submitted. If there were no records in the transaction interface table, the report has two lines:

- No records were processed
- Number of records in error = 0

Otherwise, the report normally has three lines:

- Number of approved requisitions created = n
- Number of unapproved requisitions created = n
- Number of records in error = n

When there are transaction records that cannot be processed, the report includes a fourth line:

- Number of records pending = n.

**To run the Requisition Import process:**

1. Navigate to the Submit Requests window.
2. Select Requests in the Type field.
3. Select Requisition Import in the Name field.
4. Enter the Import Source. Leave this field blank for all import sources.

If you do not see a particular import source in the list of values, there are currently no requisitions from that source.

5. Enter the Import Batch Identification for the batch that you want to import. Leave this field blank to import all batches.

6. Use the Group By feature to determine how requisition lines are grouped on the requisitions you create. The default in this field is set in the Purchasing Options window. Choose one of the following options:

* **All**: Group all requisition lines on one requisition
* **Buyer**: Group requisition lines for each buyer name on a separate requisition
* **Category**: Group requisition lines for each purchasing category on a separate requisition
* **Item**: Group requisition lines for each item on a separate requisition
* **Location**: Group requisition lines for each location on a separate requisition
* **Supplier**: Group requisition lines for each supplier name on a separate requisition

7. Enter the Last Requisition Number that exists in your system. Purchasing increments this number by one to calculate the next requisition number. If the calculated number is already in use, Purchasing selects the next available requisition number. Leave this field blank to automatically get the next available requisition number.

8. Choose No for Multiple Distributions.

In a previous release, the Import Source of ICX (for Web Requisitions) required you to choose Yes. This release supports iProcurement, which saves its requisitions directly to the Purchasing tables rather than using Requisition Import. Therefore, Yes is no longer a valid option for Multiple Distributions.
9. Choose whether to initiate approval automatically for the requisitions after they are imported.

Yes: The PO Requisition Approval workflow is launched automatically for requisitions imported with a status of Pre–Approved or Incomplete.

No: The PO Requisition Approval workflow is not automatically launched for Pre–Approved or Incomplete requisitions. You can submit these to the approval process later, when you select the Approve button on the requisition.

10. Choose Submit to begin the process.

See Also

Profile Options in Purchasing: page 1 – 103
Defining Purchasing Options: page 1 – 45
Automatic Release Generation: page 4 – 103
Submitting a Request, Oracle Applications User’s Guide
Viewing Requests, Oracle Applications User’s Guide
Automatic Sourcing: page 5 – 30
Drop Shipments: page 4 – 133
Demand for Internal Requisitions: page 3 – 18
Workflow for Creating Purchase Orders and Releases: page C – 209
Purchase Order Approval Workflow: page C – 114
Requisition Approval Workflow: page C – 57
Requisition Import Exceptions Report

The Requisition Import Exceptions Report shows errors from the Requisition Import process. If the Requisition Import process finds any requisitions that it cannot create, Purchasing records the errors in the PO Interface Errors Table.

Report Submission

In the Submit Requests window, select Requisition Import Exceptions Report in the Name field.

Report Parameters

**Import Source**

Enter the interface source to restrict the report to a specific import source.

**Import Batch ID**

Enter the name of a Requisition Import batch to restrict the report to a specific batch within your Import Source.

**Delete Exceptions**

Enter Yes or No to indicate whether you want to delete the exceptions from the PO interface errors table. If you enter Yes, Purchasing prints the report and deletes the items printed from the PO Interface Errors Table. If you enter No, Purchasing prints the report and leaves the errors in the error table. Each time Requisition Import process is generated, new transaction id numbers are created for errors. If the errors are not deleted, they remain in the Errors Table and are listed along with new error messages generated by the Requisition Import process for the same Import Source and Import Batch ID.

See Also

Submitting a Request, *Oracle Applications User’s Guide*

Requisition Import Process: page 9 – 144
Requisitions on Cancelled Sales Order Report

The Requisitions on Cancelled Sales Order Report shows information on internally sourced requisition lines for which a sales order has been generated and subsequently cancelled. You can run the report only if Order Management is installed.

Report Submission

In the Submit Requests window, select Requisitions on Cancelled Sales Order Report in the Name field.

Report Parameters

Items From/To
Enter the beginning and ending item numbers.

Requestor
Enter a requestor name to restrict the report to a specific requestor.

Categories From/To
Enter the beginning and ending purchasing categories.

Dynamic Precision Option
Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, Oracle Applications User’s Guide
Reschedule Requisitions Process

Use the Reschedule Requisitions process to update requisition information for the rows that Master Scheduling/MRP has inserted into the rescheduling interface table. This information can include changes to need-by dates recommended by MRP as well as changes to requisition quantities made by means of the Planner’s Workbench.

To run the Requisition Import process:
1. Navigate to the Submit Requests window.
2. Select Requests in the Type field.
3. Select Reschedule Requisitions in the Name field.
4. Choose Submit to begin the process.

See Also

Submitting a Request, Oracle Applications User’s Guide
Overview of Implementing Planning Recommendations, Oracle Master Scheduling/MRP and Supply Chain Planning User’s Guide
Savings Analysis Report (by Buyer)

The Savings Analysis Report (By Buyer) shows buyer performance by purchase order.

The Negotiated Amount is the product of the price on the quotation and the quantity ordered. If a quote is not defined, Purchasing prints the product of the market price of the item ordered and the quantity ordered. If the market price is not defined, Purchasing uses the list price.

The report includes a price type Legend at the bottom of each page for the price type. If the line price type is Q, the line price was from the Quote. If the line price type is M, the line price was from Market Price, and if the line price type is L, the line price was from List Price.

The Actual Amount is the product of the actual price listed on the purchase order line and the quantity ordered.

The Amount Saved is the negotiated amount less the actual amount, with negative figures in parentheses.

Report Submission

In the Submit Requests window, select Savings Analysis Report (By Buyer) in the Name field.

Report Parameters

Creation Date From/To

Enter the beginning and ending creation dates.

Buyer

Enter the buyer name to restrict the report to a specific buyer.
Sort By

Use the Sort By feature to produce a report customized to your specific needs. Choose one of the following options:

- **PO Type**: Sort the report by buyer name and purchase order type.
- **Purchase Order Number**: Sort the report by buyer name and purchase order number.

Dynamic Precision Option

Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, *Oracle Applications User’s Guide*
Savings Analysis Report (by Category)

The Savings Analysis Report (By Category) shows buyer performance by category. Use the report to compare the market, quote, or list price to the actual price.

The Negotiated Amount is the product of the price on the quotation and the quantity ordered. If a quote is not defined, Purchasing prints the product of the market price of the item ordered and the quantity ordered. If the market price is not defined, Purchasing uses the list price.

The report includes a price type Legend at the bottom of each page for the price type. If the line price type is Q, the line price was from the Quote. If the line price type is M, the line price was from Market Price, and if the line price type is L, the line price was from List Price.

The Actual Amount is the product of the actual price listed on the purchase order line and the quantity ordered.

The Amount Saved is the negotiated amount less the actual amount, with negative figures in parentheses.

Report Submission

In the Submit Requests window, select Savings Analysis Report (By Category) in the Name field.

Report Parameters

Buyer
Enter the buyer name to restrict the report to a specific buyer.

Creation Dates From/To
Enter the beginning and ending document creation dates.

Categories From/To
Enter the beginning and ending categories from the purchasing category set.
Dynamic Precision Option

Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, *Oracle Applications User’s Guide*
Send Notifications for Purchasing Documents

The workflow process, Send Notifications for Purchasing Documents, looks for documents that are incomplete, rejected, or in need of reapproval and sends notifications to the appropriate people of the document’s status. You can view and respond to these notifications through the Notifications Summary window. In order for these notifications to be sent, you need to start this concurrent program process, Send Notifications for Purchasing Documents, and choose how frequently you want the process to run. (The workflow definition itself, Send Notifications for Purchasing Documents, which is initiated by this concurrent program process, is viewable through the Oracle Workflow Builder.)

For information on the kinds of notifications sent by the Send Notifications for Purchasing Documents process, see: Viewing and Responding to Notifications: page 2 – 31.

To run the Send Notifications for Purchasing Documents process:

1. Navigate to the Submit Requests window and select Send Notifications for Purchasing Documents in the Request Name field.
2. Choose Schedule.
3. Choose how often you want the process to run.
   
   For example, choose Periodically if you want the process to run periodically. You can then choose to run the process every so many month(s), week(s), day(s), hour(s), or minute(s). For example, choose On Specific Days if you want the process to run on specific days of the month or week.
4. Choose OK.
5. Choose Submit Request once you’ve selected your options and are ready to run the process.

See Also

Send Notifications Workflow: page C – 254

Oracle Workflow Guide

Submitting a Request, Oracle Applications User’s Guide
Standard Notes Listing

The Standard Notes Listing shows your standard notes and their start and end dates.
The report lists standard notes alphabetically by usage and name.

Report Submission

In the Submit Requests window, select Standard Notes Listing in the Name field.

Report Parameters

Usages From/To

Enter the beginning and ending usages. Standard usages are the following: Approver, Buyer, Invoice Internal, Item Internal, PO Internal, Payables, Quote Internal, RCV Internal, RFQ Internal, Receiver, Req Internal, and Supplier.

When you enter a note for an invoice, you can assign a use of Invoice Internal or Supplier.

Names From/To

Enter the beginning and ending note names.
Purchasing includes notes whose names fall alphabetically, within the range you enter, including the notes with the beginning and end names you specify.

See Also

Submitting a Request, Oracle Applications User’s Guide
Substitute Receipts Report

The Substitute Receipts Report lists all or specific substitute receipts. To prevent disruption in your receiving process, Purchasing lets you receive items which a supplier has delivered as a substitute for the ordered item. You need to predefine the items you accept as substitute for other items. See: Defining Item Revisions, Oracle Inventory User’s Guide.

The report includes sourcing information appropriate for the source type. For the Inventory source type, this is the organization and subinventory. For the Supplier source type, this is the supplier and supplier site.

Report Submission

In the Submit Requests window, select Substitute Receipts Report in the Name field.

Report Parameters

Transaction Dates From/To
Enter the beginning and ending transaction dates.

Organization Name
Enter the organization name to restrict the report to a specific organization.

Dynamic Precision Option
Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, Oracle Applications User’s Guide
Supplier Affiliated Structure Listing

The Supplier Affiliated Structure Listing shows information about your supplier’s parent–child relationships. Your list of suppliers includes suppliers who are subsidiaries of larger organizations. The Supplier Affiliated Structure Listing allows you to review the relationships established. The subsidiary organization is the child supplier to the parent supplier.

Report Submission

In the Submit Requests window, select Supplier Affiliated Structure Listing in the Name field.

Report Parameters

Suppliers From/To

Enter the beginning and ending supplier names.

See Also

Submitting a Request, Oracle Applications User’s Guide
Supplier Price Performance Analysis Report

Use the Supplier Price Performance Analysis Report to compare the price of an item from different suppliers.

Report Submission

In the Submit Requests window, select Supplier Price Performance Analysis Report in the Name field.

Report Parameters

Suppliers From/To
Enter the beginning and ending supplier names.

Period From/To
Enter the beginning and ending periods.

Creation Date From/To
Enter the beginning and ending purchase order creation dates.

Categories From/To
Enter the beginning and ending purchasing categories.

Items From/To
Enter the beginning and ending system item numbers.

Sort By
Choose one of the following options:

Category Sort the report by purchasing category. If you do not make an entry, this is the default.

Item Sort the report by item number.
Dynamic Precision Option

Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, Oracle Applications User’s Guide
Supplier Purchase Summary Report

The Supplier Purchase Summary report lists the numbers and amount of orders you have placed with various suppliers during a particular period. You can use this information to analyze and manage your purchasing volume with your suppliers. You can also use the Small Business Sort By option to get the statistics you need to complete the Cumulative Commitments section of Form 295 as required for compliance with the Federal Acquistion Regulation (FAR) (U.S.). In addition, with the New Supplier Listing you can update the information provided by your suppliers.

Report Submission

In the Submit Requests window, select Supplier Purchase Summary Report in the Name field.

Report Parameters

Creation Dates From/To
Enter the beginning and ending creation dates.

Supplier Type
Enter the supplier type from the Lookup Codes window to restrict the report to a specific supplier type. See: Defining Lookup Codes: page 1 – 74.

Small Business
Enter Yes to restrict the report to small business suppliers.

Minority Owned
Enter Yes to restrict the report to minority owned suppliers.

Women Owned
Enter Yes to restrict the report to women owned suppliers.
Sort By

Use the Sort By feature to produce a report customized to your specific needs. Choose one of the following options:

- **Supplier**: Sort the report by supplier name, supplier site, and PO number
- **Supplier Type**: Sort the report by supplier type, supplier name, supplier site, and PO number

See Also

- Submitting a Request, *Oracle Applications User’s Guide*
- About Suppliers, *Oracle Public Sector Payables User’s Guide*
- New Supplier Listing: page 9 – 58
Supplier Quality Performance Analysis Report

The Supplier Quality Performance Analysis Report can be used to review your suppliers’ quality performance. You can review supplier quality performance for percents accepted, rejected, and returned. You can use this report to identify suppliers with quality performance issues.

Report Submission

In the Submit Requests window, select Supplier Quality Performance Analysis Report in the Name field.

Report Parameters

- **Items From/To**
  Enter the beginning and ending item numbers.

- **Suppliers From/To**
  Enter the beginning and ending supplier names.

- **Categories From/To**
  Enter the beginning and ending purchasing categories.

- **Buyer**
  Enter a buyer name to restrict the report to a specific buyer.

- **Creation Dates From/To**
  Enter the beginning and ending creation dates.

- **Detail**
  Enter Yes or No to indicate whether you want to print detail information on the report.
Dynamic Precision Option

Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, *Oracle Applications User’s Guide*
Supplier Service Performance Analysis Report

The Supplier Service Performance Analysis Report lists late shipments, early shipments, rejected shipments, and shipments to wrong locations. You can use this report to derive a supplier service penalty by multiplying the days variance quantity by a percentage of the price.

The % Open Current is the percentage of the ordered quantity not yet received, but within the receipt tolerance days or not past due.

The % Open Past Due is the percentage of the ordered quantity not received by the promise date and beyond the receipt tolerance days.

The % Received On Time is the percentage of the ordered quantity received on the promise date or within the receipt tolerance days.

The % Received Late is the percentage of the ordered quantity received after the promise date and outside the receipt tolerance days.

The % Received Early is the percentage of the ordered quantity received before the promise date and outside the receipt tolerance days.

The Days Variance is calculated as the summation of the date differential (transaction date subtracted from promise date) multiplied by the corrected received quantity (the received quantity plus or minus corrections) for each shipment, all divided by the total corrected received quantity. The result is the quantity per day the supplier is in variance.

Report Submission

In the Submit Requests window, select Supplier Service Performance Analysis Report in the Name field.

Report Parameters

**Items From/To**

Enter the beginning and ending item numbers.

**Suppliers From/To**

Enter the beginning and ending supplier names.
Categories From/To
Enter the beginning and ending purchasing categories.

Buyer
Enter a buyer name to restrict the report to a specific buyer.

Creation Dates From/To
Enter the beginning and ending creation dates.

Detail
Enter Yes or No to indicate whether you want to print detail information for each purchase order on the report.

Dynamic Precision Option
Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, Oracle Applications User’s Guide
Supplier Volume Analysis Report

The Supplier Volume Analysis Report shows the dollar value of items you purchase from a supplier. The report prints the items that are assigned sourcing rules. Use the report to compare your actual purchase percentages with your sourcing percentage.

The Expenditure is the sum of the item line amounts for standard purchase orders for the supplier.

The Actual Percentage is the items expenditure as a percentage of the total expenditure for the date range of the report.

The Intended Commitment is the total expenditure multiplied by the split percentage entered in the sourcing rules.

Report Submission

In the Submit Requests window, select Supplier Volume Analysis Report in the Name field.

Report Parameters

Items From/To
Enter the beginning and ending item numbers.

Creation Dates From/To
Enter the beginning and ending purchase order creation dates.

See Also

Submitting a Request, Oracle Applications User’s Guide
Suppliers on Hold Report

The Suppliers on Hold Report lists all suppliers placed on hold. This report also prints all purchase orders you still have outstanding with the suppliers on hold.

Report Submission

In the Submit Requests window, select Suppliers on Hold Report in the Name field.

Report Parameters

Supplier Names From/To
Enter the beginning and ending supplier names.

PO Numbers From/To
Enter the beginning and ending purchase order numbers.

Sort By
Use the sort by feature to produce a report customized to your specific needs. Choose one of the following options:

- Purchase Order Number
  Sort the report by purchase order number

- Supplier
  Sort the report by supplier

Dynamic Precision Option
Enter the decimal precision for quantities on the report.

See Also

Submitting a Request, Oracle Applications User’s Guide
Tax Code Listing

The Tax Code Listing shows the tax authorities and rates that are available to use when you enter purchase orders or invoices. The tax code is assigned to a purchase order line. When the line is received, the monetary value is applied to the account associated with the tax code. All information for the tax codes applies to the set of books of the Organization listed in the header of the report. Use this report to verify the validity of the tax code accounts.

Report Submission

In the Submit Requests window, select Tax Code Listing in the Name field.

See Also

Submitting a Request, Oracle Applications User’s Guide
Defining Tax Codes, Oracle Public Sector Payables User’s Guide
The Uninvoiced Receipts Report should be run before the Receipt Accrual – Period–End process. With this report, you can review all or specific uninvoiced receipts for both period end and online accruals. Uninvoiced receipts are goods and services you have received that your supplier did not invoice yet. This report indicates exactly what you have to accrue and for what amount, and helps you analyze your receipt accrual entries. The accrual amount is the difference between the quantity received and the quantity billed multiplied by the unit price of the item.

Report Submission

In the Submit Requests window, select Uninvoiced Receipts Report in the Name field.

Report Parameters

Accrued Receipts

Enter Yes to indicate that you want to include accrued receipts on the report. Otherwise, the report includes only unaccrued receipts.

Include Online Accruals

Enter Yes to indicate that you want to include online accruals on the report. Typically, you use the Accrual Reconciliation Report rather than this report to analyze your online accruals.

Categories From/To

Enter the beginning and ending purchasing categories.

Minimum Extended Value

Enter the minimum extended value for the report.
Period Name

Enter a period name to restrict the report to the periods up to and including the specified period.

Suppliers From/To

Enter the beginning and ending supplier names.

Sort By

Choose one of the following options:

- **Category**: Sort the report by purchasing category.
- **Supplier**: Sort the report by supplier name.

Dynamic Precision Option

Enter the decimal precision for quantities on the report.

See Also

- Submitting a Request, *Oracle Applications User’s Guide*
- Receipt Accruals – Period End Process: page 9 – 119
- Accrual Reconciliation Report: page 9 – 5
Unit of Measure Class Listing

The Unit Of Measure Class Listing shows the classes of measurement you have defined. A unit of measure class is a grouping of common units of measurement. For example, the standard measurement for distance is inch, yard, foot, or mile. Units of distance are assigned to the class Distance. The units assigned to a class are reviewed in the Unit Of Measure Listing.

Report Submission

In the Submit Requests window, select Unit of Measure Class Listing in the Name field.

Report Parameters

Active/Inactive

Choose one of the following options:

*Active*

List only active unit of measure classes on the report.

*Both*

List both active and inactive unit of measure classes on the report.

*Inactive*

List only inactive unit of measure classes on the report.

See Also

Submitting a Request, *Oracle Applications User’s Guide*

Defining Unit of Measure Classes, *Oracle Inventory User’s Guide*
Unit of Measure Listing

The Unit of Measure Listing shows the unit conversions you have defined in the Unit of Measure Conversions window. A unit of measure is assigned to a class. The class is a common grouping of units based on a common denominator. For example, distance is a class of measurement; where inch, foot, yard and mile are units of distance measurement. The base unit would be foot. The unit of measure inch would have a conversion of .08333, which is multiplied by the base unit foot to create the conversion from inch to foot. The conversion for mile would be 5280. A unit is assigned to a class to ensure that it has a common denominator of conversion. In other words, gallons are in a different class than miles. Gallons are a unit of volume, and miles are a unit of distance. You can assign items an interclass conversion.

Use this report to review the units of measure conversions when you create purchase orders or requisitions, or enter receiving, delivery, or inspection transactions.

Report Submission

In the Submit Requests window, select Unit of Measure Listing in the Name field.

Report Parameters

**Active/Inactive**

Choose one of the following options:

- **Active**: List only active units of measure on the report.
- **Both**: List both active and inactive units of measure on the report.
- **Inactive**: List only inactive units of measure on the report.

**Dynamic Precision Option**

Enter the decimal precision for quantities on the report.
See Also

Submitting a Request, Oracle Applications User’s Guide
Defining Unit of Measure Conversions, Oracle Inventory User’s Guide
Unordered Receipts Report

The Unordered Receipts Report lists all or selected unordered receipts. Unordered receipts refer to received items that receivers could not match to purchase orders or return material authorizations (RMAs). You can enter unordered receipt transactions only if you set up your system options accordingly. Purchasing lets you specify which unordered receipts you want to review. See: Defining Purchasing Options: page 1–45.

Report Submission

In the Submit Requests window, select Unordered Receipts Report in the Name field.

Report Parameters

Transaction Dates From/To
Enter the beginning and ending transaction dates.

Organization Name
Enter the organization to restrict the report to a specific organization.

Source
Choose Supplier to view unordered receipts that will be matched to purchase orders.

Choose Customer to view unordered receipts that will be matched to return material authorization (RMA) documents. An RMA is created in Order Management to authorize a customer return to your organization.

If you want to view all unordered receipts (for suppliers and customers), run the report twice, once with a Customer source and once with a Supplier source.

Dynamic Precision Option
Enter the decimal precision for quantities on the report.
See Also

Submitting a Request, *Oracle Applications User’s Guide*
Upgrade Notifications to Release 11 Process

Since Release 11, document approval is handled by Oracle Workflow technology. Because of Workflow, the Notifications window in Purchasing has been replaced by a new Notifications Summary window, and all notifications are Workflow notifications. Release 11 and later of Purchasing recognizes your existing notifications in Release 10.7 only if you upgrade them to Workflow notifications. This is what the Upgrade Notifications to Release 11 process does. It routes your Release 10.7 documents that are pending approval through the new approval workflow processes, so that their notifications become Workflow notifications.

**Attention:** Run this process only if you’re upgrading from Release 10.7 of Purchasing. See: *Oracle Applications Upgrade Manual.*

See Also

- Purchase Order Approval Workflow: page C – 114
- Requisition Approval Workflow: page C – 57
- Viewing and Responding to Notifications: page 2 – 31
This appendix shows you the default menu path for each Oracle Public Sector Purchasing window. Refer to this appendix when you do not already know the menu path for a window you want to use.
Windows and Navigator Paths

Although your system administrator may have customized your navigator, typical navigational paths include the following:

**Note:** Text in brackets ([ ]) indicates a button.

See also: Oracle Public Sector Purchasing Character Mode Forms and Corresponding GUI Windows: page D – 2.

For windows described in other manuals:

<table>
<thead>
<tr>
<th>See: page</th>
<th>Refer to this manual for a complete window description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AP</strong></td>
<td>Oracle Public Sector Payables User’s Guide</td>
</tr>
<tr>
<td><strong>BOM</strong></td>
<td>Oracle Bills of Material User’s Guide</td>
</tr>
<tr>
<td><strong>CST</strong></td>
<td>Oracle Cost Management User’s Guide</td>
</tr>
<tr>
<td><strong>Flex</strong></td>
<td>Oracle Applications Flexfields Manual</td>
</tr>
<tr>
<td><strong>GL</strong></td>
<td>Oracle Public Sector General Ledger User’s Guide</td>
</tr>
<tr>
<td><strong>HR</strong></td>
<td>Oracle Human Resources User’s Guide</td>
</tr>
<tr>
<td><strong>INV</strong></td>
<td>Oracle Inventory User’s Guide</td>
</tr>
<tr>
<td><strong>MRP</strong></td>
<td>Oracle Master Scheduling/MRP and Supply Chain Planning User’s Guide</td>
</tr>
<tr>
<td><strong>iProc</strong></td>
<td>iProcurement Implementation Manual</td>
</tr>
<tr>
<td><strong>SYS</strong></td>
<td>Oracle System Administrator’s Guide</td>
</tr>
<tr>
<td><strong>User</strong></td>
<td>Oracle Applications User’s Guide</td>
</tr>
<tr>
<td>Window Name</td>
<td>Navigation Path</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Acceptances: page 4 – 84</td>
<td>Purchase Orders &gt; Purchase Orders &gt; Tools menu &gt; Acceptances</td>
</tr>
<tr>
<td>Account Generator Processes: page C – 19</td>
<td>Setup &gt; Flexfields &gt; Key &gt; Accounts</td>
</tr>
<tr>
<td>Accounting Calendar, (see GL)</td>
<td>Setup &gt; Financials &gt; Accounting &gt; Calendar</td>
</tr>
<tr>
<td>Accrual Options: page 1 – 48</td>
<td>Setup &gt; Organizations &gt; Purchasing Options &gt; Accrual</td>
</tr>
<tr>
<td>Action History: page 8 – 2</td>
<td>From the following windows: Releases, Purchase Order Headers, Purchase Order Lines, Purchase Order Shipments, Purchase Order Distributions, Requisition Headers, Requisition Lines, Requisition Distributions &gt; View Requisitions &gt; Tools menu &gt; View Action History</td>
</tr>
<tr>
<td>Analyze Quotations: page 5 – 91</td>
<td>RFQs and Quotations &gt; Quote Analysis &gt; [Find]</td>
</tr>
<tr>
<td>Approval Assignments: page 1 – 33</td>
<td>Setup &gt; Approvals &gt; Approval Assignments</td>
</tr>
<tr>
<td>Approval Groups: page 1 – 29</td>
<td>Setup &gt; Approvals &gt; Approval Groups</td>
</tr>
<tr>
<td>Approve Entire Quotation: page 5 – 93</td>
<td>RFQs and Quotations &gt; Quotations &gt; [Approve]</td>
</tr>
<tr>
<td>Approve Document: page 2 – 35</td>
<td>Requisitions &gt; Requisitions &gt; [Approve]</td>
</tr>
<tr>
<td></td>
<td>Purchase Orders &gt; Purchase Orders &gt; [Approve]</td>
</tr>
<tr>
<td></td>
<td>Purchase Orders &gt; Releases &gt; [Approve]</td>
</tr>
<tr>
<td>Approved Supplier List: page 5 – 42</td>
<td>Supply Base &gt; Approved Supplier List</td>
</tr>
<tr>
<td>Approved Supplier List Statuses: page 5 – 45</td>
<td>Supply Base &gt; Supplier Statuses</td>
</tr>
<tr>
<td>Approved Supplier List Summary: page 5 – 56</td>
<td>Supply Base &gt; Summary Approved Supplier List</td>
</tr>
<tr>
<td>Assign Cross References (see INV)</td>
<td>Items &gt; Cross References &gt; [Assign]</td>
</tr>
<tr>
<td>Assign Security Rules (see Flex)</td>
<td>Setup &gt; Flexfields &gt; Descriptive &gt; Security &gt; Assign</td>
</tr>
<tr>
<td>Assign Requisition Lines: page 5 – 102</td>
<td>Management &gt; Manage Buyer Workload &gt; [Find]</td>
</tr>
<tr>
<td>Assign Security Rules (see Flex)</td>
<td>Setup &gt; Flexfields &gt; Descriptive &gt; Security &gt; Assign</td>
</tr>
<tr>
<td></td>
<td>Setup &gt; Flexfields &gt; Key &gt; Security &gt; Assign</td>
</tr>
<tr>
<td></td>
<td>Setup &gt; Flexfields &gt; Validation &gt; Security &gt; Assign</td>
</tr>
<tr>
<td>Window Name</td>
<td>Navigation Path</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AutoCreate Documents: page 6 – 16</td>
<td>Autocreate &gt; [Find]</td>
</tr>
<tr>
<td>Buyers: page 1 – 27</td>
<td>Setup &gt; Personnel &gt; Buyers</td>
</tr>
<tr>
<td>Buyer Workload: page 5 – 100</td>
<td>Management &gt; Manage Buyer Workload &gt; [Find]</td>
</tr>
<tr>
<td>Categories (see INV)</td>
<td>Setup &gt; Items &gt; Categories &gt; Category Codes</td>
</tr>
<tr>
<td>Category Assignment (see INV)</td>
<td>Items &gt; Master Items &gt; Tools menu &gt; Categories</td>
</tr>
<tr>
<td>Category Set (see INV)</td>
<td>Items &gt; Organization Items &gt; Tools menu &gt; Categories</td>
</tr>
<tr>
<td>Change Organization (see MRP)</td>
<td>Setup &gt; Items &gt; Categories &gt; Category Sets</td>
</tr>
<tr>
<td>Common Lookups (see User)</td>
<td>Setup &gt; Items &gt; Item Types</td>
</tr>
<tr>
<td>Concurrent Requests Summary (see User)</td>
<td>Requests</td>
</tr>
<tr>
<td>Control Document: page 2 – 55</td>
<td>Requisitions &gt; Requisition Summary &gt; [Headers] &gt; [Find] &gt; Tools menu &gt; Control</td>
</tr>
<tr>
<td>Control Options: page 1 – 49</td>
<td>Setup &gt; Organizations &gt; Purchasing Options &gt; Control</td>
</tr>
<tr>
<td>Control Purchasing Periods: page 1 – 93</td>
<td>Setup &gt; Financials &gt; Accounting &gt; Control Purchasing Periods</td>
</tr>
<tr>
<td>Copy Document: page 5 – 88</td>
<td>RFQs and Quotations &gt; Quotations &gt; Tools menu &gt; Copy Document</td>
</tr>
<tr>
<td>Window Name</td>
<td>Navigation Path</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Corrections: page 7 – 88</td>
<td>Receiving &gt; Corrections</td>
</tr>
<tr>
<td></td>
<td>Receiving &gt; Corrections &gt; [Find]</td>
</tr>
<tr>
<td>Cross Reference Types (see INV)</td>
<td>Items &gt; Cross References</td>
</tr>
<tr>
<td>Cross—Validation Rules (see Flex)</td>
<td>Setup &gt; Flexfields &gt; Key &gt; Cross—Validation</td>
</tr>
<tr>
<td>Currencies (see GL)</td>
<td>Setup &gt; Financials &gt; Currency &gt; Currencies</td>
</tr>
<tr>
<td></td>
<td>RFQs and Quotations &gt; RFQs &gt; [Currency]</td>
</tr>
<tr>
<td></td>
<td>RFQs and Quotations &gt; Quotations &gt; [Currency]</td>
</tr>
<tr>
<td>Daily Rates see (GL)</td>
<td>Setup &gt; Financials &gt; Currency &gt; Currencies &gt; Daily Rates</td>
</tr>
<tr>
<td>Daily Conversion Rate Type see (GL)</td>
<td>Setup &gt; Financials &gt; Currency &gt; Daily Conversion Rate Type</td>
</tr>
<tr>
<td>Default Category Sets (see INV)</td>
<td>Setup &gt; Items &gt; Categories &gt; Default Category Sets</td>
</tr>
<tr>
<td>Define Catalog Server for External Suppliers (see iProc)</td>
<td>Setup &gt; E–Catalog Admin &gt; External Suppliers</td>
</tr>
<tr>
<td>Define Catalog Server Loader Values (see iProc)</td>
<td>Setup &gt; E–Catalog Admin &gt; Loader Values</td>
</tr>
<tr>
<td>Define Information Template see (iProc)</td>
<td>Setup &gt; Information Templates</td>
</tr>
<tr>
<td>Define MassCancel: page 2 – 60</td>
<td>Accounting &gt; MassCancel</td>
</tr>
<tr>
<td>Define Security Rules (see Flex)</td>
<td>Setup &gt; Flexfields &gt; Descriptive &gt; Security &gt; Define</td>
</tr>
<tr>
<td></td>
<td>Setup &gt; Flexfields &gt; Key &gt; Security &gt; Define</td>
</tr>
<tr>
<td></td>
<td>Setup &gt; Flexfields &gt; Validation &gt; Security &gt; Define</td>
</tr>
<tr>
<td>Deletion Constraint (see BOM)</td>
<td>Setup &gt; Items &gt; Delete Constraints</td>
</tr>
<tr>
<td>Deletion Groups (see BOM)</td>
<td>Items &gt; Delete Items</td>
</tr>
<tr>
<td>Descriptive Flexfield Segments see Flex</td>
<td>Setup &gt; Flexfields &gt; Descriptive &gt; Segments</td>
</tr>
<tr>
<td>Distributions: page 4 – 74</td>
<td>Purchase Orders &gt; Purchase Orders &gt; [Shipments] &gt; [Distributions]</td>
</tr>
<tr>
<td></td>
<td>Purchase Orders &gt; Releases &gt; [Distributions]</td>
</tr>
<tr>
<td></td>
<td>Requisitions &gt; Requisitions &gt; [Distributions]</td>
</tr>
<tr>
<td>Document Types: page 1 – 84</td>
<td>Setup &gt; Purchasing &gt; Document Types</td>
</tr>
<tr>
<td>Economic Zones (see INV)</td>
<td>Setup &gt; Movement Statistics &gt; Economic Zones</td>
</tr>
<tr>
<td>Window Name</td>
<td>Navigation Path</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enter Person (see HR)</td>
<td>Setup &gt; Personnel &gt; Employees</td>
</tr>
<tr>
<td>Exceeded Price Tolerances: page 5 – 26</td>
<td>Purchase Orders &gt; Exceeded Price Tolerances</td>
</tr>
<tr>
<td></td>
<td>Notifications Summary &gt; Price tolerance exceeded notification &gt; [Open Document]</td>
</tr>
<tr>
<td>Express Receipts: page 7 – 27</td>
<td>Receiving &gt; Receipts &gt; [Find] &gt; [Express]</td>
</tr>
<tr>
<td>Find Corrections: page 7 – 85</td>
<td>Receiving &gt; Corrections</td>
</tr>
<tr>
<td>Find Expected Receipts: page 7 – 28</td>
<td>Receiving &gt; Receipts</td>
</tr>
<tr>
<td>Find Intransit Shipments: page 7 – 92</td>
<td>Receiving &gt; Manage Shipments</td>
</tr>
<tr>
<td>Find Item Information (see INV)</td>
<td>Items &gt; Item Information</td>
</tr>
<tr>
<td>Find Purchase Orders: page 4 – 19</td>
<td>Purchase Orders &gt; Purchase Order Summary</td>
</tr>
<tr>
<td>Find Quotations: page 5 – 90</td>
<td>RFQs and Quotations &gt; Quote Analysis</td>
</tr>
<tr>
<td>Find Receiving Transactions: page 7 – 62</td>
<td>Receiving &gt; Receiving Transactions</td>
</tr>
<tr>
<td>Find Receiving Transactions (Summary): page 7 – 47</td>
<td>Receiving &gt; Receiving Transactions Summary</td>
</tr>
<tr>
<td>Find Requisitions: page 3 – 42</td>
<td>Requisitions &gt; Requisition Summary</td>
</tr>
<tr>
<td>Find Requisition Lines: page 6 – 12</td>
<td>Autocreate</td>
</tr>
<tr>
<td>Find Requisition Lines: page 5 – 98</td>
<td>Management &gt; Manage Buyer Workload</td>
</tr>
<tr>
<td>Find Returns: page 7 – 77</td>
<td>Receiving &gt; Returns</td>
</tr>
<tr>
<td>Find Unordered Receipts: page 7 – 41</td>
<td>Receiving &gt; Match Unordered Receipts</td>
</tr>
<tr>
<td>Forward Documents: page 2 – 42</td>
<td>Management &gt; Forward Documents</td>
</tr>
<tr>
<td>Freight Carriers (see INV)</td>
<td>Setup &gt; Purchasing &gt; Freight Carriers</td>
</tr>
<tr>
<td>GL Accounts (see GL)</td>
<td>Setup &gt; Accounting &gt; Accounts</td>
</tr>
<tr>
<td>Hazard Classes: page 1 – 70</td>
<td>Setup &gt; Purchasing &gt; Hazard Classes</td>
</tr>
<tr>
<td>Import Items (see INV)</td>
<td>Items &gt; Import Items</td>
</tr>
<tr>
<td>Inspect Received Items: page 7 – 73</td>
<td>Receiving &gt; Receiving Transactions &gt; [Inspect]</td>
</tr>
<tr>
<td>Item Assignment (see INV)</td>
<td>Setup &gt; Items &gt; Categories &gt; Category Sets &gt; [Assign]</td>
</tr>
<tr>
<td>Internal Requisition Options: page 1 – 52</td>
<td>Setup &gt; Organizations &gt; Purchasing Options &gt; Internal Requisitions</td>
</tr>
<tr>
<td>Window Name</td>
<td>Navigation Path</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Item Attribute Controls (see INV)</td>
<td>Setup &gt; Items &gt; Attribute Controls</td>
</tr>
<tr>
<td>Item Attributes (see INV)</td>
<td>Items &gt; Item Information &gt; [Attributes]</td>
</tr>
<tr>
<td>Item Catalog (see INV)</td>
<td>Items &gt; Master Items &gt; Tools menu &gt; Catalog</td>
</tr>
<tr>
<td>Item Catalog Groups (see INV)</td>
<td>Setup &gt; Items &gt; Catalog Groups</td>
</tr>
<tr>
<td></td>
<td>Setup &gt; Items &gt; Catalog Groups &gt; [Details]</td>
</tr>
<tr>
<td>Item Categories (see INV)</td>
<td>Items &gt; Item Information &gt; [Categories]</td>
</tr>
<tr>
<td>Item Cross Reference Assignment (see INV)</td>
<td>Items &gt; Master Items &gt; Tools menu &gt; Cross References</td>
</tr>
<tr>
<td>Item Flexfield View (see INV)</td>
<td>Setup &gt; Items &gt; Item Flexfield View</td>
</tr>
<tr>
<td>Item Relationships (see INV)</td>
<td>Items &gt; Item Relationships</td>
</tr>
<tr>
<td></td>
<td>Items &gt; Master Items &gt; Tools menu &gt; Item Relationships</td>
</tr>
<tr>
<td>Item Revisions (see INV)</td>
<td>Items &gt; Master Items &gt; Tools menu &gt; Revisions</td>
</tr>
<tr>
<td></td>
<td>Items &gt; Organization Items &gt; Tools menu &gt; Revisions</td>
</tr>
<tr>
<td>Item Revisions (see INV)</td>
<td>Items &gt; Item Information &gt; [Revisions]</td>
</tr>
<tr>
<td>Item Search (see INV)</td>
<td>Items &gt; Item Search</td>
</tr>
<tr>
<td>Item Source (see iProc)</td>
<td>Setup &gt; E-Catalog Admin &gt; Item Sources</td>
</tr>
<tr>
<td>Item Status History (see INV)</td>
<td>Items &gt; Master Items &gt; Tools menu &gt; Pending Status</td>
</tr>
<tr>
<td></td>
<td>Items &gt; Organization Items &gt; Tools menu &gt; Pending Status</td>
</tr>
<tr>
<td>Item Subinventories (see INV)</td>
<td>Items &gt; Master Items &gt; Tools menu &gt; Item Subinventories</td>
</tr>
<tr>
<td></td>
<td>Items &gt; Organization Items &gt; Tools menu &gt; Item Subinventories</td>
</tr>
<tr>
<td>Item Template (see INV)</td>
<td>Setup &gt; Items &gt; Templates &gt; [New]</td>
</tr>
<tr>
<td>Item Templates Summary (see INV)</td>
<td>Setup &gt; Items &gt; Templates</td>
</tr>
<tr>
<td>Item Type QuickCodes (see INV)</td>
<td>Setup &gt; Items &gt; Item Types</td>
</tr>
<tr>
<td>Key Flexfield Segments (see Flex)</td>
<td>Setup &gt; Flexfields &gt; Key &gt; Segments</td>
</tr>
<tr>
<td>Key Segment Values (see Flex)</td>
<td>Setup &gt; Flexfields &gt; Key &gt; Values</td>
</tr>
<tr>
<td>Line Types: page 1 – 84</td>
<td>Setup &gt; Purchasing &gt; Line Types</td>
</tr>
<tr>
<td>Locations: page 1 – 24</td>
<td>Setup &gt; Organizations &gt; Locations</td>
</tr>
<tr>
<td>Window Name</td>
<td>Navigation Path</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Lookup Codes: page 1 – 74</td>
<td>Setup &gt; Purchasing &gt; Lookup Codes</td>
</tr>
<tr>
<td>Lot Entry (see INV)</td>
<td>[Lot/Serial] various locations</td>
</tr>
<tr>
<td>Manage Shipments: page 7 – 93</td>
<td>Receiving &gt; Manage Shipments &gt; [Find]</td>
</tr>
<tr>
<td>Manufacturer Part Numbers (see INV)</td>
<td>Items &gt; Manufacturers’ Part Numbers &gt; By Items</td>
</tr>
<tr>
<td></td>
<td>Items &gt; Manufacturers’ Part Numbers &gt; By Manufacturers &gt; [Parts]</td>
</tr>
<tr>
<td></td>
<td>Items &gt; Master Items &gt; Tools menu &gt; Manufacturer Part Numbers</td>
</tr>
<tr>
<td></td>
<td>Items &gt; Organization Items &gt; Tools menu &gt; Manufacturer Part Number</td>
</tr>
<tr>
<td>Manufacturers (see INV)</td>
<td>Items &gt; Manufacturers’ Part Numbers &gt; By Manufacturers</td>
</tr>
<tr>
<td>Master Items (see INV)</td>
<td>Items &gt; Master Items &gt; [New]</td>
</tr>
<tr>
<td>Mass Forwarding Documents: page 2 – 42</td>
<td>Management &gt; Forward Documents</td>
</tr>
<tr>
<td></td>
<td>Items &gt; Master Items &gt; [Open]</td>
</tr>
<tr>
<td>Master Items Summary (see INV)</td>
<td>Items &gt; Master Items</td>
</tr>
<tr>
<td>Match Unordered Receipts: page 7 – 41</td>
<td>Receiving &gt; Match Unordered Receipts &gt; [Find]</td>
</tr>
<tr>
<td>Movement Statistics (see INV)</td>
<td>Receiving &gt; Update Movement Statistics</td>
</tr>
<tr>
<td>Movement Statistics Parameters (see INV)</td>
<td>Setup &gt; Movement Statistics &gt; Parameters</td>
</tr>
<tr>
<td>New Document: page 6 – 19</td>
<td>Autocreate &gt; [Find] &gt; [Automatic]</td>
</tr>
<tr>
<td>New Document Number: page 6 – 22</td>
<td>Autocreate &gt; [Find] &gt; [Manual]</td>
</tr>
<tr>
<td>Notification Controls: page 4 – 82</td>
<td>Purchase Orders &gt; Purchase Orders &gt; Tools menu &gt; Notification Control</td>
</tr>
<tr>
<td>Notifications: page 2 – 31</td>
<td>Notifications Summary &gt; [Open]</td>
</tr>
<tr>
<td>Notifications Summary: page 2 – 31</td>
<td>Notifications Summary</td>
</tr>
<tr>
<td>Numbering Options: page 1 – 53</td>
<td>Setup &gt; Organizations &gt; Purchasing Options &gt; Numbering</td>
</tr>
<tr>
<td>Order Pad Options: page 5 – 19</td>
<td>Supplier Item Catalog &gt; [Find] &gt; [Options]</td>
</tr>
<tr>
<td></td>
<td>Requisitions &gt; Requisitions &gt; [Catalog] &gt; [Options]</td>
</tr>
<tr>
<td>Window Name</td>
<td>Navigation Path</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Order Pad Options: page 5 – 19</td>
<td>Purchase Orders &gt; Purchase Orders &gt; [Catalog] &gt; [Options]</td>
</tr>
<tr>
<td>Organization Assignment (see INV)</td>
<td>Items &gt; Master Items &gt; Tools menu &gt; Organization Assignment</td>
</tr>
<tr>
<td>Organization Items (see INV)</td>
<td>Items &gt; Organization Items &gt; [Open]</td>
</tr>
<tr>
<td>Organization Items Summary (see INV)</td>
<td>Items &gt; Organization Items</td>
</tr>
<tr>
<td>Organization (see HR)</td>
<td>Setup &gt; Organizations &gt; Organizations</td>
</tr>
<tr>
<td>Outside Processing page 4 – 80</td>
<td>Purchase Orders &gt; Purchase Orders &gt; [Shipments] &gt; [Distributions] &gt; [Outside Processing]</td>
</tr>
<tr>
<td></td>
<td>Requisitions &gt; Requisitions &gt; [Distributions] &gt; [Outside Processing]</td>
</tr>
<tr>
<td>Pending Status (see INV)</td>
<td>Items &gt; Pending Status</td>
</tr>
<tr>
<td></td>
<td>Items &gt; Master Items &gt; Tools menu &gt; Pending Status</td>
</tr>
<tr>
<td></td>
<td>Items &gt; Organization Items &gt; Pending Status</td>
</tr>
<tr>
<td>Period Types (see GL)</td>
<td>Setup &gt; Financials &gt; Accounting &gt; Period Types</td>
</tr>
<tr>
<td>Personal Profile Values (see User)</td>
<td>Personal Profiles</td>
</tr>
<tr>
<td>Purchase Agreement Price Break : page 4 – 72</td>
<td>Purchase Orders &gt; Purchase Order Summary &gt; [Find] &gt; [Open] &gt; Price Reference</td>
</tr>
<tr>
<td>Purchase Order Distributions: page 4 – 32</td>
<td>Purchase Orders &gt; Purchase Order Summary &gt; [Distributions] &gt; [Find]</td>
</tr>
<tr>
<td>Purchase Order Headers: page 4 – 23</td>
<td>Purchase Orders &gt; Purchase Order Summary &gt; [Find] &gt; [Find] &gt; [Lines] &gt; [Shipments] &gt; [Distributions]</td>
</tr>
<tr>
<td>Purchase Order Lines: page 4 – 26</td>
<td>Purchase Orders &gt; Purchase Order Summary &gt; [Find] &gt; [Lines] &gt; [Find]</td>
</tr>
<tr>
<td>Purchase Order Shipments: page 4 – 29</td>
<td>Purchase Orders &gt; Purchase Order Summary &gt; [Find] &gt; [Lines] &gt; [Shipments]</td>
</tr>
<tr>
<td>Window Name</td>
<td>Navigation Path</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Purchase Order Preferences: page 4 – 34</td>
<td>Purchase Orders &gt; Purchase Orders &gt; Tools menu &gt; Preferences</td>
</tr>
<tr>
<td></td>
<td>Purchase Orders &gt; Purchase Order Summary &gt; Tools menu &gt; Preferences</td>
</tr>
<tr>
<td>Purchase Orders: page 4 – 39</td>
<td>Purchase Orders &gt; Purchase Orders</td>
</tr>
<tr>
<td></td>
<td>Purchase Orders &gt; Purchase Order Summary &gt; [New PO]</td>
</tr>
<tr>
<td>Purchasing Options: page 1 – 45</td>
<td>Setup &gt; Organizations &gt; Purchasing Options</td>
</tr>
<tr>
<td>Purchasing Receiving Accounting: page 7 – 69</td>
<td>In General Ledger, navigate to this window from the Account Inquiry, Enter Journals, or View Journals windows</td>
</tr>
<tr>
<td>Quality Inspection Codes: page 1 – 77</td>
<td>Setup &gt; Purchasing &gt; Quality Inspection Codes</td>
</tr>
<tr>
<td>Quotation Price Breaks: page 5 – 84</td>
<td>RFQs and Quotations &gt; Quotations &gt; [Price Breaks]</td>
</tr>
<tr>
<td>Quotations: page 5 – 73</td>
<td>RFQs and Quotations &gt; Quotations</td>
</tr>
<tr>
<td>Quotation Shipments: page 5 – 81</td>
<td>RFQs and Quotations &gt; Quotations &gt; [Shipments]</td>
</tr>
<tr>
<td>Quotation Terms: page 5 – 79</td>
<td>RFQs and Quotations &gt; Quotations &gt; [Terms]</td>
</tr>
<tr>
<td>Realms (see iProc)</td>
<td>Setup &gt; E-Catalog Admin &gt; Realms</td>
</tr>
<tr>
<td>Receipts: page 7 – 34</td>
<td>Receiving &gt; Receipts &gt; [Find]</td>
</tr>
<tr>
<td>Receipt Header: page 7 – 32</td>
<td>Receiving &gt; Receipts &gt; [Find] &gt; [Header]</td>
</tr>
<tr>
<td>Receipt Header Details: page 7 – 57</td>
<td>Receiving &gt; Receiving Transactions Summary &gt; [Find] &gt; [Header]</td>
</tr>
<tr>
<td>Receipt Lines: page 7 – 34</td>
<td>Receiving &gt; Receipts</td>
</tr>
<tr>
<td>Receiving Controls: page 4 – 69</td>
<td>Purchase Orders &gt; Purchase Orders &gt; [Shipments] &gt; [Receiving Controls]</td>
</tr>
<tr>
<td></td>
<td>Purchase Orders &gt; Releases &gt; [Receiving Controls]</td>
</tr>
<tr>
<td></td>
<td>Receiving &gt; Corrections &gt; [Find]</td>
</tr>
<tr>
<td>Receiving Headers Summary: page 7 – 50</td>
<td>Receiving &gt; Receiving Transactions Summary &gt; [Find]</td>
</tr>
<tr>
<td>Receiving Options: page 1 – 58</td>
<td>Setup &gt; Organizations &gt; Receiving Options</td>
</tr>
<tr>
<td>Receiving Returns: page 7 – 80</td>
<td>Receiving &gt; Returns &gt; [Find]</td>
</tr>
<tr>
<td>Receiving Transactions: page 7 – 65</td>
<td>Receiving &gt; Receiving Transactions &gt; [Find]</td>
</tr>
<tr>
<td>Receiving Transaction Summary: page 7 – 51</td>
<td>Receiving &gt; Receiving Transactions Summary &gt; [Find] &gt; [Transactions]</td>
</tr>
<tr>
<td>Window Name</td>
<td>Navigation Path</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Recovery Rules (see AP)</td>
<td>Setup &gt; Tax &gt; Recovery Rules</td>
</tr>
<tr>
<td>Releases: page 4 – 39</td>
<td>Purchase Orders &gt; Releases</td>
</tr>
<tr>
<td>Requisitions &gt; Purchase Order Summary &gt; [NewRelease]</td>
<td></td>
</tr>
<tr>
<td>Requisition Headers Summary: page 3 – 44</td>
<td>Requisitions &gt; Requisition Summary &gt; [Headers] &gt; [Find]</td>
</tr>
<tr>
<td>Requisition Lines Summary: page 3 – 47</td>
<td>Requisitions &gt; Requisition Summary &gt; [Lines] &gt; [Find]</td>
</tr>
<tr>
<td>Requisitions &gt; Requisition Summary &gt; [Lines]</td>
<td></td>
</tr>
<tr>
<td>Requisitions &gt; Requisition Summary &gt; [Headers] &gt; [Find] &gt; [Lines]</td>
<td></td>
</tr>
<tr>
<td>Requisition Distributions Summary: page 3 – 49</td>
<td>Requisitions &gt; Requisition Summary &gt; [Distributions] &gt; [Find]</td>
</tr>
<tr>
<td>Requisitions &gt; Requisition Summary &gt; [Distributions]</td>
<td></td>
</tr>
<tr>
<td>Requisition Preferences: page 3 – 52</td>
<td>Requisitions &gt; Requisitions &gt; Tools menu &gt; Preferences</td>
</tr>
<tr>
<td>Requisitions &gt; Requisition Summary &gt; Tools menu &gt; Preferences</td>
<td></td>
</tr>
<tr>
<td>Requisitions: page 3 – 57</td>
<td>Requisitions &gt; Requisitions</td>
</tr>
<tr>
<td>Requisition Templates: page 1 – 62</td>
<td>Setup &gt; Purchasing &gt; Requisition Templates</td>
</tr>
<tr>
<td>Requisitions &gt; Requisitions &gt; Items &gt; [Catalog] &gt; Requisition Templates tabbed region</td>
<td></td>
</tr>
<tr>
<td>Requisitions &gt; Requisition Summary &gt; [Headers] &gt; [Find] &gt; [New]</td>
<td></td>
</tr>
<tr>
<td>Requisitions &gt; Requisition Summary &gt; [Headers] &gt; [Find] &gt; [Open]</td>
<td></td>
</tr>
<tr>
<td>RFQ Lines: page 5 – 57</td>
<td>RFQs &gt; Quotations &gt; RFQs</td>
</tr>
<tr>
<td>RFQ Price Breaks: page 5 – 69</td>
<td>RFQs and Quotations &gt; RFQs &gt; [Price Breaks]</td>
</tr>
<tr>
<td>RFQs: page 5 – 57</td>
<td>RFQs and Quotations &gt; RFQs</td>
</tr>
<tr>
<td>RFQs and Quotations &gt; RFQs &gt; [Shipments]</td>
<td></td>
</tr>
<tr>
<td>RFQ Suppliers: page 5 – 63</td>
<td>RFQs and Quotations &gt; RFQs &gt; [Suppliers]</td>
</tr>
<tr>
<td>RFQ Terms: page 5 – 65</td>
<td>RFQs and Quotations &gt; RFQs &gt; [Terms]</td>
</tr>
<tr>
<td>Rollup Groups (see Flex)</td>
<td>Setup &gt; Flexfields &gt; Key &gt; Groups</td>
</tr>
<tr>
<td>Run MassCancel: page 2 – 65</td>
<td>Accounting &gt; Run MassCancel</td>
</tr>
<tr>
<td>Window Name</td>
<td>Navigation Path</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Search Supplier Item Catalog: page 5 – 11</td>
<td>Supplier Item Catalog</td>
</tr>
<tr>
<td>Segment Values (see Flex)</td>
<td>Setup &gt; Flexfields &gt; Descriptive &gt; Values</td>
</tr>
<tr>
<td></td>
<td>Setup &gt; Flexfields &gt; Validation &gt; Values</td>
</tr>
<tr>
<td>Serial Numbers (see INV)</td>
<td>[Lot/Serial] various locations</td>
</tr>
<tr>
<td>Set of Books (see GL)</td>
<td>Setup &gt; Organizations &gt; Set of Books</td>
</tr>
<tr>
<td>Shipments: page 4 – 63</td>
<td>Purchase Orders &gt; Purchase Orders &gt; [Shipments]</td>
</tr>
<tr>
<td>Shorthand Aliases (see Flex)</td>
<td>Setup &gt; Flexfields &gt; Key &gt; Aliases</td>
</tr>
<tr>
<td>Sourcing Rule: page 5 – 37</td>
<td>Supply Base &gt; Sourcing Rules</td>
</tr>
<tr>
<td>Sourcing Rule/Bill of Distribution Assignments: page 5 – 39</td>
<td>Supply Base &gt; Assign Sourcing Rules</td>
</tr>
<tr>
<td>Status (see INV)</td>
<td>Setup &gt; Items &gt; Status Codes</td>
</tr>
<tr>
<td>Supplier–Item Attributes: page 5 – 51</td>
<td>Supply Base &gt; Approved Supplier List &gt; [Attributes]</td>
</tr>
<tr>
<td>Supplier Item Catalog: page 5 – 51</td>
<td>Supplier Item Catalog &gt; [Find]</td>
</tr>
<tr>
<td>Supplier Lists: page 5 – 96</td>
<td>Supply Base &gt; Define Supplier Lists</td>
</tr>
<tr>
<td>System Profile Values (see SYS)</td>
<td>Setup &gt; Profiles &gt; System</td>
</tr>
<tr>
<td>Tax Codes (see AP)</td>
<td>Setup &gt; Tax &gt; Tax Codes</td>
</tr>
<tr>
<td>Tax Code Summary: page 4 – 138</td>
<td>From the following windows: Requisitions, Purchase Orders, and Releases, and their corresponding Shipments and Distributions windows &gt; Tools menu &gt; Tax Code Summary</td>
</tr>
<tr>
<td>Tax Details: page 4 – 140</td>
<td>From the following windows: Requisitions, Purchase Orders, and Releases, and their corresponding Shipments and Distributions windows &gt; Tools menu &gt; Tax Details</td>
</tr>
<tr>
<td>Terms and Conditions: page 4 – 60</td>
<td>Purchase Orders &gt; Purchase Orders &gt; [Terms]</td>
</tr>
<tr>
<td>Transaction Reasons (see INV)</td>
<td>Setup &gt; Transactions &gt; Reasons</td>
</tr>
<tr>
<td>Unit of Measure Classes (see INV)</td>
<td>Setup &gt; Units of Measure &gt; Classes</td>
</tr>
<tr>
<td>Unit of Measure Conversions (see INV)</td>
<td>Setup &gt; Units of Measure &gt; Conversions</td>
</tr>
<tr>
<td></td>
<td>Setup &gt; Units of Measure &gt; Classes &gt; [Conversions]</td>
</tr>
<tr>
<td></td>
<td>Setup &gt; Units of Measure &gt; Units of Measure &gt; [Conversions]</td>
</tr>
<tr>
<td>Window Name</td>
<td>Navigation Path</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Units of Measure (see INV)</td>
<td>Setup &gt; Units of Measure &gt; Units of Measure</td>
</tr>
<tr>
<td></td>
<td>Setup &gt; Units of Measure &gt; Classes &gt; [Units of Measure]</td>
</tr>
<tr>
<td>UN Numbers: page 1 – 71</td>
<td>Setup &gt; Purchasing &gt; UN Numbers</td>
</tr>
<tr>
<td>Value Sets (see Flex)</td>
<td>Setup &gt; Flexfields &gt; Validation &gt; Sets</td>
</tr>
<tr>
<td>View Receiving Accounting: page 7 – 53</td>
<td>Receiving &gt; Receiving Transactions Summary &gt; [Find] &gt; [Transactions] &gt; Tools menu &gt; View Accounting</td>
</tr>
</tbody>
</table>
This appendix describes the alerts that are provided in Oracle Public Sector Purchasing. We provide a brief description of each alert.
Using Oracle Alert in Oracle Public Sector Purchasing

Several Oracle Applications products, including Purchasing, include the functionality of Oracle Alert to provide you with on-line exception reporting capability.

Oracle Alert is a customizable exception control application that:

- Notifies you automatically when a user performs a specific form transaction
- Notifies you automatically when a specific database transaction occurs
- Provides key information to you on a periodic basis
- Monitors critical activity in your Purchasing database
- Acts automatically according to your specifications

Purchasing supplies you with several pre-coded alerts that you can use with or without customizing. These alerts help you identify forecast overconsumption. See: Using Predefined Alerts, Oracle Applications User’s Guide.

You get the alerts described in the following pages if you have Oracle Alert. You can also create your own alerts to notify you when a user takes a specific action, or notify you about specific exceptions found in your Purchasing database. You can also create alerts that send messages about key indicators, according to a delivery schedule you define. See: Overview of Oracle Alert, Oracle Applications User’s Guide.

Expiration and Release Control Alerts

For planned purchase orders, blanket purchase agreements, and contracts, you can establish expiration and release control notification conditions and specify the number of days before the condition is met that you want to be notified. By selecting Notification Controls on the Tools menu in the Purchase Orders window, you can specify the following notification conditions:

- Amount released by date
- Amount not released by date
- Amount not released
- Amount released
- Expiration date
When the notification conditions are met, Purchasing sends you one of the following Oracle Alerts so that you can take appropriate action:

**Amount Not Released**
Alerts you that the total planned amount released to date against a planned purchase order, blanket purchase agreement, or contract purchase agreement is insufficient.

**Amount Released**
Alerts you that the total amount released to date against a planned purchase order, blanket purchase agreement, or contract purchase agreement meets or exceeds specified amounts.

**Expiration**
Alerts you that a planned purchase order, blanket purchase agreement, or contract purchase agreement is about to expire.

See Also

Entering Purchase Order Notification Controls: page 4 – 82

---

**Predefined Purchasing Alerts**

Oracle Alert supplies you with the following predefined alerts for Purchasing that you can use with or without customizing. For each pre-coded alert, we include:

- A brief explanation of what the alert does
- Information about the alert’s periodicity, inputs, and distribution
- An example of the message Oracle Alert sends when you use the alert
Approved Standard Purchase Orders

This alert shows the number of approved purchase orders created by each buyer during the past N days.

Alert Type: Periodic
Periodicity: On Demand
Inputs: Number of days
Distribution: User defined

To:     Henry Smith
From:   Oracle Alert
Subject: Approved Purchase Orders by Agent

The list below shows the number of approved purchase orders created by each agent during the last 100 days.

<table>
<thead>
<tr>
<th>AGENT NAME</th>
<th>NUMBER OF PURCHASE ORDERS</th>
</tr>
</thead>
<tbody>
<tr>
<td>John Brown</td>
<td>431</td>
</tr>
<tr>
<td>Alice Green</td>
<td>540</td>
</tr>
<tr>
<td>Ludwig Salzwasser</td>
<td>876</td>
</tr>
<tr>
<td>Tom White</td>
<td>112</td>
</tr>
</tbody>
</table>
Blanket Notification Expiration

This alert shows the blanket purchase agreements that are about to expire.

<table>
<thead>
<tr>
<th>Alert Type</th>
<th>Periodic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Periodicity</td>
<td>On Demand</td>
</tr>
<tr>
<td>Inputs</td>
<td>None</td>
</tr>
<tr>
<td>Distribution</td>
<td>Buyer</td>
</tr>
</tbody>
</table>

To: Henry Smith  
From: Oracle Alert  
Subject: Blanket Agreements About to Expire

Review the following blanket agreement(s) to identify those that are about to expire:

Blanket Purchase Order: 2388  
Expiration Date: 28-Jul-94  
Tickler Date: 20-Jul-94
Blanket Notification Not Released

This alert shows the blanket purchase agreements for which an insufficient amount has been released.

Alert Type: Periodic
Periodicity: On Demand
Inputs: None
Distribution: Buyer

To: Henry Smith
From: Oracle Alert
Subject: Blanket Agreements with Insufficient Releases

Review the following blanket agreement(s) to insure that you have released the desired amount.

Blanket Purchase Order: 2275
Currency: USD
Tickler Date: 20-Jul-94

Agreed Amount: 150000
Desired Release Amount: 75000
Desired Release Percentage (%): 50
Actual Release Amount: 0
Actual Release Percentage (%): 0
Blanket Notification Released

This alert shows the blanket purchase agreements for which the desired amount has been released.

<table>
<thead>
<tr>
<th>Alert Type</th>
<th>Periodic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Periodicity</td>
<td>On Demand</td>
</tr>
<tr>
<td>Inputs</td>
<td>None</td>
</tr>
<tr>
<td>Distribution</td>
<td>Buyer</td>
</tr>
</tbody>
</table>

To: Henry Smith  
From: Oracle Alert  
Subject: Blanket Agreements Reaching Desired Release Amount

Review the following blanket agreement(s) to identify the purchase orders where you have released the desired amount.

Blanket Purchase Order: 2352  
Currency: USD  
Tickler Date: 20-Jul-94

Agreed Amount: 150000  
Desired Release Amount: 75000  
Desired Release Percentage (%): 50  
Actual Release Amount: 75000  
Actual Release Percentage (%): 50
Blanket Purchase Releases over Threshold

This alert looks for blanket purchase releases that exceed a certain dollar amount.

**Alert Type**: Periodic  
**Periodicity**: On Demand  
**Inputs**: Number of days, Dollar amount  
**Distribution**: User defined

---

**To**: Henry Smith  
**From**: Oracle Alert  
**Subject**: Blanket Purchase Releases Over $50,000.00

During the past 30 days, the following blanket releases were created whose total exceeded $50,000.00.

- **Supplier**: Ace Furniture  
  - Total: $63,455.99  
  - P.O.: 4555  
  - Agent: Susan Smith  
  - Approved: No

- **Approved Date**:  
  - Line: 1  
  - Description: Forklifts for Warehouse  
  - Location: HQ  
  - Requestor: Peter Dock  
  - Accounting  
  - Information: 01-200-0220
# Contract Notification Expiration

This alert shows the contract purchase agreements that are about to expire.

<table>
<thead>
<tr>
<th>Alert Type</th>
<th>Periodic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Periodicity</td>
<td>On Demand</td>
</tr>
<tr>
<td>Inputs</td>
<td>None</td>
</tr>
<tr>
<td>Distribution</td>
<td>Buyer</td>
</tr>
</tbody>
</table>

---

**To:** Henry Smith  
**From:** Oracle Alert  
**Subject:** Contract Agreements About to Expire

Review the following contract agreement(s) to identify those that are about to expire.

- **Contract Purchase Order:** 244  
  - **Expiration Date:** 28-Jul-94  
  - **Tickler Date:** 20-Jul-94
Contract Notification Not Released

This alert shows the contract purchase agreements for which an insufficient amount has been released.

Alert Type: Periodic
Periodicity: On Demand
Inputs: None
Distribution: Buyer

To: Henry Smith
From: Oracle Alert
Subject: Contract Agreements with Insufficient Releases

Review the following contract agreement(s) to insure that you have released the desired amount.

Contract Purchase Order: 2275
Currency: USD
Tickler Date: 20-Jul-94

Agreed Amount: 150000
Desired Release Amount: 75000
Desired Release Percentage (%): 50
Actual Release Amount: 0
Actual Release Percentage (%): 0
Contract Notification Released

This alert shows the contract purchase agreements for which the desired amount has been released.

Alert Type: Periodic
Periodicity: On Demand
Inputs: None
Distribution: Buyer

To: Henry Smith
From: Oracle Alert
Subject: Contract Agreements Reaching Desired Release Amount

Review the following contract agreement(s) to identify the purchase orders where you have released the desired amount.

Contract Purchase Order: 2352
Currency: USD
Tickler Date: 20-Jul-94

Agreed Amount: 150000
Desired Release Amount: 75000
Desired Release Percentage (%): 50
Actual Release Amount: 75000
Actual Release Percentage (%): 50
No Receipt Required on Purchase Order Shipment

This alert looks for purchase order shipments where two-way matching is allowed.

<table>
<thead>
<tr>
<th>Alert Type</th>
<th>Periodic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Periodicity</td>
<td>On Demand</td>
</tr>
<tr>
<td>Inputs</td>
<td>Number of days</td>
</tr>
<tr>
<td>Distribution</td>
<td>User defined</td>
</tr>
</tbody>
</table>

To: Henry Smith
From: Oracle Alert
Subject: No Receipt Required on Purchase Order Shipment

During the past 7 days, the following purchase order shipments were created without requiring receipt before payment:

Agent: Susan Smith
Supplier: Comac
Description: 3-Hole Punch Paper
PO/Line/Release/Shipment: 4563/1/2/1
Planned Notification Expiration

This alert shows the planned purchase orders that are about to expire.

Alert Type: Periodic  
Periodicity: On Demand  
Inputs: None  
Distribution: Buyer

To: Henry Smith  
From: Oracle Alert  
Subject: Planned Orders About to Expire

Review the following planned order(s) to identify those that are about to expire.

Planned Purchase Order : 244  
Expiration Date : 28-Jul-94  
Tickler Date : 20-Jul-94
Planned Notification Not Released

This alert shows the planned purchase orders for which an insufficient amount has been released.

Alert Type          Periodic
Periodicity        On Demand
Inputs              None
Distribution       Buyer

To:      Henry Smith
From:    Oracle Alert
Subject: Planned Orders with Insufficient Releases

----------------------------------------
Review the following planned order(s) to insure that you have released the desired amount.

Planned Purchase Order : 2275
Currency               : USD
Tickler Date           : 20-Jul-94

Agreed Amount          : 150000
Desired Release Amount : 75000
Desired Release Percentage (%) : 50
Actual Release Amount  : 0
Actual Release Percentage (%) : 0
Planned Notification Released

This alert shows the planned purchase orders for which the desired amount has been released.

Alert Type: Periodic
Periodicity: On Demand
Inputs: None
Distribution: Buyer

To: Henry Smith
From: Oracle Alert
Subject: Planned Orders Reaching Desired Release Amount

Review the following planned purchase order(s) to identify the purchase orders where you have released the desired amount.

Planned Purchase Order: 2352
Currency: USD
Tickler Date: 20-Jul-94

Agreed Amount: 150000
Desired Release Amount: 75000
Desired Release Percentage (%): 50
Actual Release Amount: 75000
Actual Release Percentage (%): 50
Small Business Suppliers

This alert shows your suppliers who are identified as small businesses.

Alert Type: Periodic
Periodicity: On Demand
Inputs: None
Distribution: User defined

To: Henry Smith
From: Oracle Alert
Subject: Small Business Suppliers

The following is a listing of Small Business Suppliers:

Ace Furniture
Codex Lithography
Manor’s Hardware
Salzwasser Company
Standard Purchase Orders over Threshold

This alert looks for standard purchase orders created in the past N days that exceed a certain dollar amount.

<table>
<thead>
<tr>
<th>Alert Type</th>
<th>Periodic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Periodicity</td>
<td>On Demand</td>
</tr>
<tr>
<td>Inputs</td>
<td>Number of days</td>
</tr>
<tr>
<td></td>
<td>Dollar total</td>
</tr>
<tr>
<td>Distribution</td>
<td>User defined</td>
</tr>
</tbody>
</table>

To:      Henry Smith  
From:    Oracle Alert  
Subject: Standard Purchase Orders Over $50,000.00  

During the past 30 days, the following standard purchase orders were created whose total exceeded $50,000.00.

Supplier: Model Furniture  
Total: $53,495.99  
P.O.: 3455  
Agent: David Smith  
Approved: No  
Approved Date:  
Line: 1  
Description: Modules  
Location: HQ  
Requestor: Peter Dock  
Accounting  
Information: 01-200-0220
Suppliers on Hold

This alert shows the suppliers that you have placed on hold.

Alert Type: Periodic
Periodicity: On Demand
Inputs: None
Distribution: User defined

---

To: Henry Smith  
From: Oracle Alert  
Subject: List of Suppliers on Hold

The following is a listing of suppliers that have been placed on hold:

- Acme Hardware
- Dave’s Landscaping
- Manor’s Hardware
Using the Account Generator in Oracle Public Sector Purchasing

This appendix provides detailed information about workflows in Oracle Public Sector Purchasing, including:

- Overview: page C – 3
- Customization Guidelines: page C – 5
- Using the Account Generator in Oracle Public Sector Purchasing: page C – 10
- Requisition Approval Workflow: page C – 57
- Purchase Order Approval Workflow: page C – 114
- Workflow Processes for Approving Change Orders: page C – 171
- Workflow for Creating Purchase Orders and Releases: page C – 209
- Confirm Receipts Workflow: page C – 240
- Send Notifications Workflow: page C – 254
• Price/Sales Catalog Notification Workflow: page C – 267
• Process Navigator Workflows: page C – 276
Overview of Procurement Workflows

Purchasing uses Oracle Workflow technology to handle requisition and purchase order approvals, automatic creation of purchase orders and releases, purchase order changes (specifically, any additional approvals those changes require), notifications, and receipt confirmation. Workflow is an underlying technology that automates these procurement activities. Workflow comes with a graphical user interface that enables you to modify these procurement workflow processes to suit your public sector needs.

Purchasing comes with the following workflows:

- **PO Account Generator** workflow for automatically generating accrual, budget, charge, and variance accounts on purchase orders and releases. See: Using the Account Generator in Oracle Public Sector Purchasing: page C – 10.

- **PO Requisition Account Generator** workflow for automatically generating accrual, budget, charge, and variance accounts on requisitions. See: Using the Account Generator in Oracle Public Sector Purchasing: page C – 10.

- **PO Requisition Approval** workflow for approving requisitions. See: Requisition Approval Workflow: page C – 57.


- **Change Order** workflow for controlling which changes to purchase orders require a manual reapproval and which are automatically reapproved; the change order workflow is really a group of workflow processes contained in the PO Approval workflow. Workflow Processes for Approving Change Orders: page C – 171.


- **PO Confirm Receipts** workflow for sending receipt notifications to requesters or buyers notifying them that they should have received their order. Confirm Receipts Workflow: page C – 240.

- **PO Send Notifications for Purchasing Documents** workflow for looking for documents that are incomplete, rejected, or in need of reapproval, and sending notifications to the appropriate people of the document’s status. See: Send Notifications Workflow: page C – 254.
• **PO Catalog Price Tolerance Exceeded Notifications** workflow for sending a notification to the buyer when the price/sales catalog information sent through the Purchasing Documents Open Interface includes price increases that exceed a price tolerance that you set. Price/Sales Catalog Notification Workflow: page C – 267.

• **Procurement Processes** workflow for guiding you through procurement processes by launching the appropriate windows in Purchasing. See: Process Navigator Workflows: page C – 276.

**See Also**

Customization Guidelines: page C – 5
Customization Guidelines

Following are some of the important guidelines you should follow when customizing any workflow in Purchasing.

Access Levels

In the Workflow Builder, some of activities in the procurement workflows are locked, or protected against customization, and some are unlocked, or available for modification to suit your public sector needs. You should not change your access level to modify locked activities.

For more, important information on access levels, see Overview of Oracle Workflow Access Protection, Oracle Workflow Guide and Allowing Access to an Object, Oracle Workflow Guide.

Backups and Testing

Always make a backup and test your customized workflow on a test database before uploading it to your actual database. The sections in this documentation describing each workflow in Purchasing let you know if you should modify the default workflow that Purchasing provides or if you can create a new one. For more, important information on saving, backing up, and uploading customized workflows, see Opening and Saving Item Types, Oracle Workflow Guide.

Upgrade Support

Future upgrades of Purchasing can include upgrades to the Purchasing workflows. As you customize workflows, think about whether to protect your customizations against future upgrades. For complete information, see Overview of Oracle Workflow Access Protection, Oracle Workflow Guide and Using the Workflow Definition Loader, Oracle Workflow Guide.

Workflow Monitor

You can use the Workflow Monitor to monitor a workflow’s progress. See: Workflow Monitor, Oracle Workflow Guide.
Guidelines

It is important to use these guidelines in conjunction with information in the Oracle Workflow Guide. In addition, refer to the documentation for each workflow in Purchasing for a list of activities you can and cannot customize, and other recommendations particular to the workflow. You can also use the Item Type Definitions Web page to extract detailed information about each activity in a workflow. See: Item Type Definitions Web Page, Oracle Workflow Guide.

See also: Oracle Support Policy for Predefined Workflows, Oracle Workflow Guide.

Attributes

You can modify only the attributes listed as customizable in the documentation for each Purchasing workflow.

Processes

If you modify a customizable process, it is essential that the basic flow remain intact to maintain data integrity in the database. For example, you should not remove or bypass the function activity Is Document Complete? in the Verify Document subprocess in the approval workflows because this may allow incomplete data to be inserted into the database tables. However, you could add additional checks (processes or function activities) before allowing data to be inserted into the tables.

If you modify a customizable process, either by replacing a portion of its flow or by adding additional function activities, keep in mind:

- Attributes that are set by default function activities in the default processes must also be set if you replace the default function activities with ones of your own. If a function activity uses a SetItemAttr statement, then that function activity is setting an attribute to be used by another function activity later. Therefore, your new function activity must do the same. You should also preserve SetItemUserKey and SetItemOwner statements, if any. (Depending on your customizations, you may also want to preserve GetItemAttr statements.)

- Any database state maintained by the default process must also be maintained by the processes you customize. If a function activity in a process uses an Update or Insert Into statement, then that function activity is updating or inserting
rows in the database. Therefore, your new function activity must maintain the same database state.

To get a list of the workflow function activities that use SetItemAttr, GetItemAttr, SetItemUserKey, SetItemOwner, Insert Into, or Update statements, run the PL/SQL script powfcust.sql.

Attention: This script gives you an idea of the impact of removing a function activity; however, before you customize a process, always conduct your own analysis of the impact.

To run powfcust.sql:

1. Change to the directory where the PL/SQL–stored procedures are kept:
   ```
cd $PO_TOP/sql
   ```
2. At the SQL prompt, start the following script:
   ```
   @powfcust.sql
   ```
3. When prompted, enter the internal name for the workflow item type for which you want to run the script, or enter ALL to run the script for all of the Purchasing workflows.

   The internal workflow names for Purchasing are as shown in the following table:

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Internal Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO Account Generator</td>
<td>POWFPOAG</td>
</tr>
<tr>
<td>PO Requisition Account Generator</td>
<td>POWFRQAG</td>
</tr>
<tr>
<td>PO Approval</td>
<td>POAPPRV</td>
</tr>
<tr>
<td>PO Requisition Approval</td>
<td>REQAPPRV</td>
</tr>
<tr>
<td>PO Create Documents</td>
<td>CREATEPO</td>
</tr>
<tr>
<td>PO Confirm Receipts</td>
<td>PORCPT</td>
</tr>
<tr>
<td>PO Send Notifications for Purchasing Documents</td>
<td>APVRMDER</td>
</tr>
<tr>
<td>PO Catalog Price Tolerance Exceeded Notifications</td>
<td>POPRICAT</td>
</tr>
</tbody>
</table>
The script displays every function activity in the workflow that uses a SetItemAttr, GetItemAttr, SetItemUserKey, SetItemOwner, Insert Into, or Update statement.

Recall that this script gives you an idea of the impact of removing a function activity. Before you customize a process, always conduct your own analysis of the impact.

**Notifications**

If a notification has a reply code, make sure that the Result Type of your customized notification matches the transitions in the workflow diagram. See: To Create a Notification Activity, Oracle Workflow Guide. See also: Message Result, Oracle Workflow Guide and To Create a Message, Oracle Workflow Guide.

**Function Activities**

Usually, you cannot modify a function activity, but can replace it with one of your own, unless the documentation for the workflow advises against removing default function activities.

When you replace a function activity, you are effectively modifying the process in which it is contained. If you substitute default function activities in a process with function activities that you create, you must remember the following:

- The result type of your new function activity must match the result type of the default activity. That is, the Result Type of the function activity in the Workflow Builder—for example, a Result Type of Yes/No—needs to match the result type that you specify in that function activity’s corresponding PL/SQL procedure. In addition, if you have, for example, two results (such as Yes and No) in your function activity and corresponding PL/SQL procedure, make sure that there are two corresponding transitions in the workflow diagram (one for Yes and one for No). If you alter the result types and transitions in a process, be careful that you aren’t deleting or bypassing any special transitions or checks.

- Just as in the section Processes above, any attributes that were set by the default function activity must also be set by your customized function activity.

- Just as in the section Processes above, any database state maintained by the default function activity must also be maintained by the customized function activity.
Lookup Types

If you change a customizable lookup type, be sure that all activities that use the lookup type allow for the change. For example, if you change a lookup type from Yes/No to something else, the activities that use that lookup type should also change their Result Type from Yes/No to whatever new lookup type you created. See: Lookup Types, *Oracle Workflow Guide*.

See Also

Using the Account Generator in Oracle Public Sector Purchasing: page C – 10

Purchase Order Approval Workflow: page C – 114

Requisition Approval Workflow: page C – 57

Workflow Processes for Approving Change Orders: page C – 171

Workflow for Creating Purchase Orders and Releases: page C – 209

Confirm Receipts Workflow: page C – 240

Send Notifications Workflow: page C – 254

Price/Sales Catalog Notification Workflow: page C – 267

Using the Workflow Monitor for the Account Generator: page C – 55

Using the Workflow Monitor for the PO Create Documents Workflow: page C – 238

Process Navigator Workflows: page C – 276
Using the Account Generator in Oracle Public Sector Purchasing

This essay describes how to use and customize the default Account Generator process in Oracle Public Sector Purchasing.

The Account Generator in Oracle Public Sector Purchasing utilizes Oracle Workflow. You can view and customize Account Generator processes through the Oracle Workflow Builder. You can also monitor account generation through the Oracle Workflow Monitor. See: *Oracle Workflow Guide*.

All purchase orders, requisitions, and releases require accounting distributions. Oracle Public Sector Purchasing automatically builds a charge, budget (if using budgetary control), accrual, and variance account for each document distribution.

Basic Public Sector Needs

Oracle Public Sector Purchasing provides you with the features you need to:

- Improve accuracy and speed document generation by automatically constructing accounting distributions.
- Relieve buyers, requestors, and document preparers from the responsibility of specifying which accounts should be charged for their purchases.
- Perform fund accounting.
- Customize Account Generator account construction rules to match your business rules.

See also: Overview of Account Generator (*Oracle Applications Flexfields Guide*).

Decide How to Use the Account Generator

Use the following sections to help you evaluate whether the default Account Generator process meets your accounting requirements.

This decision determines which setup steps your implementation team needs to perform.
Decide How to Use the Account Generator

In Release 10, several Oracle Applications products used FlexBuilder to derive account code combinations for certain account transactions. In Release 11, FlexBuilder is replaced by the Account Generator to provide implementation teams with even greater flexibility and a better user interface with Oracle Workflow.

If you are upgrading from Release 10 and used FlexBuilder, then you should perform the equivalent of this setup step (deciding how to use the Account Generator) as part of your upgrade. See the FlexBuilder chapter of the Oracle Applications Upgrade Preparation Manual.

If you customized FlexBuilder in a previous release to generate account combinations, you can use the Generate Accounts Using FlexBuilder Rules process to replicate your FlexBuilder setup automatically, without changing any of your predefined FlexBuilder Rules, and without customizing the Account Generator. To build accounts, the Generate Accounts Using FlexBuilder Rules process calls the appropriate functions that were generated during your upgrade from Release 10.

Note: If you used FlexBuilder in Release 10 but did not customize the default configuration, you can use the default Account Generator process in Release 11, which gives you the same result as the default assignments in FlexBuilder.

If you are implementing Oracle Public Sector Purchasing for the first time, you need to review how Purchasing uses the Account Generator to build Accounting Flexfield code combinations. See: What the Account Generator Does in Oracle Public Sector Purchasing, below. Consider whether the default Account Generator process is appropriate for each set of books that uses a unique Accounting Flexfield structure. For each structure and set of books, you can choose one of the following:

• Use the default Account Generator processes:
  – Generate Default Accrual Account
  – Generate Default Budget Account
  – Generate Default Charge Account
  – Generate Default Variance Account

• Customize the default Account Generator processes

No setup steps are required to use the default. The default processes can also be updated later as your needs change.
Prerequisites to Using the Account Generator

Before using the Account Generator on a production database in Oracle Public Sector Purchasing to build accounts for purchase order, release, and requisition distributions, you must complete the following steps:

- **Attention:** These steps need to be performed for each operating unit.

- Define your Accounting Flexfield structure for each set of books.
- Define flexfield segment values and validation rules.
- Set up Oracle Workflow. See: Setting Up Oracle Workflow, Oracle Workflow Guide.
- Choose whether you want to use the default Account Generator processes, or if you need to customize them to meet your accounting needs.
- Then do one of the following for each set of books:
  - Choose to use the default Account Generator processes.
  - Customize the default Account Generator processes, test your customizations, and choose the processes for a flexfield structure, if necessary.

**See Also**

- The Default Account Generator Processes for Oracle Public Sector Purchasing: page C – 27
- Customizing the Account Generator for Oracle Public Sector Purchasing: page C – 19

**What the Account Generator Does in Oracle Public Sector Purchasing**

The default Account Generator processes in Oracle Public Sector Purchasing build a charge, budget, accrual, and variance account for each purchase order, release, and requisition distribution based on the distribution’s Expense, Inventory, or Shop Floor destination type. Oracle Public Sector Purchasing always builds these accounts using the Account Generator; you cannot disable this feature.

For Inventory charge account construction, the Account Generator further distinguishes between asset and expense purchases based on
the item and subinventory that you provide for the distribution. If you select an expense item, the Account Generator disregards the subinventory and builds an expense charge account. If you select an asset item, the Account Generator evaluates the subinventory to decide whether to build an expense or asset charge account.

**Additional Information:** You classify a subinventory as Expense or Asset by selecting the Asset Subinventory check box in the Oracle Inventory Subinventories window. You classify an item as Expense or Asset by selecting the Inventory Asset Value check box in the Costing section of the Master Item window. (This window is accessible through Inventory or Purchasing.)

When the Account Generator locates a source account based on the distribution destination type, it copies complete code combinations (full Accounting Flexfields) from designated fields to destination Accounting Flexfields. The default Oracle Public Sector Purchasing processes do not build individual flexfield segments.

For example, to populate the Accrual account for distributions with an Expense destination type, the Account Generator locates the Expense AP Accrual Account that you specify in the Purchasing Options window as part of your application setup, and copies it into the Accrual Account Flexfield in your document.
The following matrices describe the source fields that the Account Generator references to build the charge, budget, accrual, and variance account based on the distribution destination type.
### Default Charge Account Sources

<table>
<thead>
<tr>
<th>Destination Types</th>
<th>WIP Accounting Classes</th>
<th>Subinventories</th>
<th>Organization Parameters</th>
<th>Items (INV or PO)</th>
<th>Purchasing Options</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Expense Account</td>
</tr>
<tr>
<td>Inventory (Expense Item)</td>
<td>1</td>
<td>Subinv. Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inventory (Expense Item)</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Expense Account</td>
</tr>
<tr>
<td>Inventory (Expense Item)</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Expense</td>
</tr>
<tr>
<td>Inventory (Asset Item)</td>
<td>1</td>
<td>Sub. Material or Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inventory (Asset Item)</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Material Account</td>
</tr>
<tr>
<td>Shop Floor a</td>
<td>Material</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shop Floor b</td>
<td>Mat. Overhead</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shop Floor c</td>
<td>Resource</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shop Floor d</td>
<td>Outside Processing</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shop Floor e</td>
<td>Overhead</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table C – 1  (Page 1 of 1)

### Default Budget Account Sources

<table>
<thead>
<tr>
<th>Destination Types</th>
<th>WIP Accounting Classes</th>
<th>Subinventories</th>
<th>Organization Parameters</th>
<th>Items (INV or PO)</th>
<th>Purchasing Options</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Charge Account</td>
</tr>
<tr>
<td>Inventory</td>
<td>1</td>
<td></td>
<td>Encumbrance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inventory</td>
<td>2</td>
<td></td>
<td></td>
<td>Encumbrance Account</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inventory</td>
<td>3</td>
<td></td>
<td>Encumbrance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inventory</td>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Charge Account</td>
</tr>
<tr>
<td>Shop Floor</td>
<td>1</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
</tbody>
</table>

Table C – 2  (Page 1 of 1)
## Default Accrual Account Sources

<table>
<thead>
<tr>
<th>Destination Types</th>
<th>WIP Accounting Classes</th>
<th>Subinventories</th>
<th>Organization Parameters</th>
<th>Items (INV or PO)</th>
<th>Purchasing Options</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Expense AP Accrual Account</td>
</tr>
<tr>
<td>Inventory</td>
<td>1</td>
<td></td>
<td>Inventory AP Accrual</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shop Floor</td>
<td>1</td>
<td></td>
<td>Inventory AP Accrual</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table C – 3  (Page 1 of 1)

## Default Variance Account Sources

<table>
<thead>
<tr>
<th>Destination Types</th>
<th>WIP Accounting Classes</th>
<th>Subinventories</th>
<th>Organization Parameters</th>
<th>Items (INV or PO)</th>
<th>Purchasing Options</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Charge Account</td>
</tr>
<tr>
<td>Inventory</td>
<td>1</td>
<td></td>
<td>Inventory Price Variance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shop Floor</td>
<td>1</td>
<td></td>
<td>Inventory Price Variance</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table C – 4  (Page 1 of 1)

## Charge Account

<table>
<thead>
<tr>
<th>Destination Types</th>
<th>Subinventory</th>
<th>Organization Parameters</th>
<th>Items (INV or PO)</th>
<th>Purchasing Options</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td>Expense Account</td>
</tr>
<tr>
<td>Inventory (Expense Item)</td>
<td>1</td>
<td>Subinv. Expense</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inventory (Asset Item)</td>
<td>1</td>
<td>Sub. Material or Expense</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Budget Account

<table>
<thead>
<tr>
<th>Destination Types</th>
<th>Subinventory</th>
<th>Organization Parameters</th>
<th>Items (INV or PO)</th>
<th>Purchasing Options</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense</td>
<td>1</td>
<td>Encumbrance</td>
<td></td>
<td></td>
<td>Charge Account</td>
</tr>
<tr>
<td>Inventory</td>
<td>1</td>
<td></td>
<td>Encumbrance Account</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td></td>
<td>Encumbrance Account</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Accrual Account

<table>
<thead>
<tr>
<th>Destination Types</th>
<th>Subinventory</th>
<th>Organization Parameters</th>
<th>Items (INV or PO)</th>
<th>Purchasing Options</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td>Expense AP Accrual Account</td>
</tr>
</tbody>
</table>

Table 9 – 2  (Page 1 of 2)
The horizontal axis lists the Oracle products and windows you use to specify the source accounts that the Account Generator references in Oracle Public Sector Purchasing. The vertical axis lists the possible destination types for each account type the Account Generator constructs. The body of the matrix lists the fields you use to enter the reference accounts.

When more than one option is indicated for a particular account/destination type combination, the Account Generator attempts to locate the primary source account identified on the matrix with a 1. If this reference account is unavailable or not appropriate for the distribution information you provide, the Account Generator tries the source indicated as 2 and so on until it either successfully locates a reference account, or fails.

**Suggestion:** Minimize your setup by specifying source accounts at the appropriate level of detail for your business. For example, you can specify the charge account source for Inventory (expense) destination types at the subinventory, item, or organization level. If an organization level account is sufficient for your public sector needs, it is not necessary to specify item or subinventory accounts.

For Shop Floor destination types, the Account Generator constructs the charge account based on the resource cost element associated with the Outside Processing job or schedule. In this case, the Account Generator selects one of the five possible source accounts; it does not step through a hierarchy of choices as it does for other destination types. Finally, the Account Generator does not construct a budget account for Shop Floor distributions, even if you are using encumbrance. Oracle Public Sector Purchasing never encumbers outside processing purchases.

**Attention:** The default Oracle Public Sector Purchasing Account Generator processes include one rule for building Expense destination charge accounts. If you specify an expense

| Accrual Account |  |
|-----------------|-----------------
| Inventory       | 1               | Inventory AP Accrual |
| Variance Account| 1               | Inventory Price Variance |
| Expense         | 1               | Charge Account |
| Inventory       | 1               |  |

Table 9 – 2 (Page 2 of 2)
account for each of your predefined items, the Account Generator copies this code combination to the Charge Account field of your destination documents. If you are buying one–time or predefined items with no associated expense account, the Account Generator is unable to build a charge account. In this case, you can either manually specify a charge account in your document or you can design a custom Account Generator function to build Expense destination charge accounts based on field values like Requestor.

While you cannot edit the accrual, budget, or variance accounts that the Account Generator constructs, you can override or specify the charge account for uncommitted Expense distributions. In this case, you can either edit the charge account that the Account Generator constructs for you, or you can specify a default charge account in the Defaults region of your document. When you specify a default charge account, it always overrides any expense charge account that the Account Generator tries to provide.

**Account Build Timing and Logistics**

For Expense and Inventory destinations in the Requisitions, Purchase Orders, and Releases windows, the Account Generator constructs the account when you navigate into the distribution Charge Account field, or when an explicit or implicit commit anywhere in the window provides enough information for Oracle Public Sector Purchasing to create a distribution. For Shop Floor destinations, the code is constructed when you enter all required data in the Outside Processing region and either return to the document distributions region or commit.

For all windows, the build sequence is:

1. Charge
2. Budget
3. Accrual
4. Variance

Each account is provided as a possible source value to the subsequent builds. For example, the budget rules accept the charge account as a possible value, and for Expense destination types the charge account value is copied into the Budget Account field. The accrual account rules accept both the charge and budget account values. Finally, the variance account rules accept the charge, budget, and accrual account values as possible sources.
If the Account Generator is unable to construct accrual, variance, or budget accounts you cannot enter these fields to manually provide the missing values. You must identify and resolve the problem that is causing the Account Generator to fail. If the Account Generator is unable to construct a charge account, you can manually specify the missing values if the destination type is Expense. Since budget and variance account rules take the charge account value for Expense destination types, the Account Generator tries to construct these accounts as soon as you manually provide a charge account if it was unable to find one during the initial build attempt.

### The Account Generator Does Not Rebuild After You Update a Document

Consistent with Release 10 functionality, once the Account Generator successfully builds accounts for a document, it does not attempt to rebuild when you update the document. For example, if you build a custom process to generate the requisition charge account for Expense purchases based on requestor, and change the requestor after the Account Generator constructs the charge account, it will not attempt to rebuild.

Requisition Import does not use the Account Generator to construct charge, budget, accrual, or variance accounts. Any custom process that you create cannot be used by this utility.

### See Also

- Customizing the Account Generator for Oracle Public Sector Purchasing: page C – 19
- The Default Account Generator Processes for Oracle Public Sector Purchasing: page C – 27
- Using the Workflow Monitor with the Account Generator: page C – 55

### Customizing the Account Generator for Oracle Public Sector Purchasing

Oracle Public Sector Purchasing provides default Account Generator processes for you to use. If the defaults do not satisfy your accounting requirements, you can use the Oracle Workflow Builder to customize the default processes.
Before you use or modify any of the workflows in Purchasing, read the setup information at the beginning of this document.

For more information on the generic features and functions of the Account Generator, see the Customizing the Account Generator section of the Oracle Applications Flexfields Guide.

Use the Oracle Workflow Builder to customize workflows. When you customize a workflow, only those documents that you create after you customize it are affected by the customized workflow.

You can use the Workflow Monitor to follow where certain documents are in a workflow process. If you encounter problems while the Account Generator builds accounts, set the profile option Account Generator: Run in Debug Mode to Yes to help you locate the problem. (Always set it back to No after you are finished, to maintain performance.) See: Using the Workflow Monitor with the Account Generator: page C – 55.

To display the workflow in the Oracle Workflow Builder:

1. Choose Open from the File menu, and connect to the database.

   See: Opening and Saving Item Types, Oracle Workflow Guide.

   The Display name of the Account Generator workflow for purchase orders is PO Account Generator. The name of its Workflow definition file is poxwfpag.wft.

   The Display name of the Account Generator workflow for requisitions is PO Requisition Account Generator. The name of its Workflow definition file is poxwfrag.wft.
2. Expand the data source, then the Account Generator item type branch within that data source.

3. Expand the Processes branch within the Account Generator branch, then double-click on a process activity to display its diagram.

Creating a New Custom Process

If you want to customize the PO Account Generator or the PO Requisition Account Generator workflows, you must customize the default (original) workflows that Purchasing provides. Unlike the PO Approval, PO Requisition Approval, and PO Create Documents workflows in Purchasing, only one Account Generator workflow can be called from the application itself, through the Account Generator Processes window. You can’t select a separate customization, like you can with the other workflows in the Document Types window. Therefore, you need to make your customizations to the default Account Generator workflows. Have your backup to revert to, if you need, while you are testing your customizations.

Required Modifications

There are no required modifications you need to make to the PO Account Generator or the PO Requisition Account Generator.
workflows, unless you need to customize them to suit your business requirements. See: Decide How to Use the Account Generator: page C – 10.

**Supported and Unsupported Customizations**

Following is a discussion of what you can and *definitely cannot* modify in both the PO Account Generator and PO Requisition Account Generator workflows. For those things you *can* modify, the discussion includes important guidelines that you need to be careful of when making customizations.

For important information on how to customize workflows, see the *Oracle Workflow Guide*.

To further help you with your customizations, refer to the sections later in this document, starting with The Default Account Generator Processes for Oracle Public Sector Purchasing: page C – 27. These sections describe the components of the main processes in the PO Account Generator and the PO Requisition Account Generator workflows. If you haven’t already, see also: Customization Guidelines: page C – 5.

**Attention:** If a particular Workflow object does not appear in the following sections on the lists of things you can customize, do not modify it, regardless of its access level.

**Attributes**

You cannot modify any attributes in the PO Account Generator or the PO Requisition Account Generator.

**Processes**

If you modify a process, it is essential that the basic flow be maintained. For example, the Get Expense Account ID function activity in the Build Expense Charge Account subprocess sets the item attribute Temp Account ID with the code combination identification number (CCID) of the account being built. This attribute is used by the function activity Copy Values from Account ID to fetch the concatenated segments. Therefore, if you replace the function activity Get Expense Account ID with one of your own, your new function activity must also set the item attribute Temp Account ID.

If you modify any process, either by replacing a portion of its flow or by adding additional function activities, remember the following:
• Attributes that are set by default function activities in the default processes must also be set if you replace default function activities with ones of your own. That is, if a function activity in that process uses a `SetItemAttr` statement, then that function activity is setting an attribute to be used by another function activity later. Therefore, your new function activity must do the same. You should also preserve `SetItemUserKey` and `SetItemOwner` statements, if any. Depending on your customizations, you may also want to preserve `GetItemAttr` statements.

• Any database state maintained by the default processes must also be maintained by processes you customize. That is, if a function activity in that process uses an `Update` or `Insert Into` statement, then that function activity is updating or inserting rows in the database. Therefore, your new function activity must maintain the same database state.

To get a list of the workflow function activities that use `SetItemAttr`, `GetItemAttr`, `SetItemUserKey`, `SetItemOwner`, `Insert Into`, or `Update` statements, run the PL/SQL script `powfcust`. For instructions on running this script, see: Customization Guidelines: page C – 5.

You can modify the following processes in both the PO Account Generator and the PO Requisition Account Generator, as your public sector needs require:

• Generate Default Accrual Account
• Generate Default Budget Account
• Generate Default Charge Account
• Generate Default Variance Account
• Build Expense Charge Account
• Build Inventory Budget Account
• Build Inventory Charge Account
• Build Expense Project Accrual Account
• Build Expense Project Budget Account
• Build Expense Project Charge Account
• Build Expense Project Variance Account
• Build Shop Floor Charge Account
• Get Charge Account for Variance Account
• Get Variance Account from Organization

You cannot modify the following processes in the PO Account Generator or the PO Requisition Account Generator:

• Generate Default Accounts
• Generate Accounts Using FlexBuilder Rules
• Generate Charge Account Using FlexBuilder Rules
• Generate Budget Account Using FlexBuilder Rules
• Generate Accrual Account Using FlexBuilder Rules
• Generate Variance Account Using FlexBuilder Rules

Function Activities

You cannot modify any function activities in the PO Account Generator or PO Requisition Account Generator. However, you can modify the Set Encoded Error Message function activity by changing its attributes in the Workflow Builder. See: To use the Set Encoded Error Message function activity, below.

You can replace some function activities with function activities of your own. When you replace a function activity, you are modifying the process in which it is contained. See the guidelines for customizing the Account Generator processes in the section Processes above.

If you substitute default function activities in a process with function activities that you create, remember the following:

• The result type of your new function activity must match the result type of the default activity. That is, the Result Type of the function activity in the Workflow Builder needs to match the result type specified by that function activity’s corresponding PL/SQL procedure—for example, a Result Type of Yes/No. It also means that if you have, for example, two results (such as Yes and No) in your function activity and corresponding PL/SQL procedure, make sure that there are two corresponding transitions in the workflow diagram (one for Yes and one for No). If you alter the result types and transitions in a process, be careful that you aren’t deleting or bypassing any special transitions or checks.

• Just as with Processes above, any attributes that were set by the default function activity must also be set by your customized function activity.
• Just as with Processes above, any database state maintained by the default function activity must also be maintained by the customized function activity.

To use the Set Encoded Error Message function activity:

This function activity is not used by any process in the workflow, but is provided if you need to create a customized error message. To use this function activity to send a customized error message, do the following:

1. Create the message in the Oracle Applications Message Dictionary.
   You must first define the error message in the Oracle Applications Message Dictionary before it can be used by this function activity. For instructions, see the online help for the Messages window in the Application Developer responsibility, or see the Oracle Applications Developer’s Guide.

2. Drag and drop the Set Encoded Error Message function activity into the process diagram of the process you want to modify.

3. Select the activity in the process diagram and choose Properties from the Edit menu.

4. In the Node Attributes region, enter the Message Name of the message you defined in the Message Dictionary and optionally enter one or more tokens to provide dynamic text for the error message.
   The Application Code defaults to PO (Purchasing), but you can change it if you are displaying the error message in another application.

Lookup Types

The PO Account Generator and PO Requisition Account Generator use the following two Lookup Types provided by the PO Standard workflow; you cannot modify these Lookup Types:

• PO Work Item Destination Type
• PO WIP Type

For information on the default lookup types provided by the Standard Flexfield Workflow, see the Account Generator section/chapter of the Oracle Applications Flexfields Guide.
Implementing a Customized Account Generator Process

Use the Account Generator Processes window to choose either the Generate Default Accounts process or the Generate Accounts Using FlexBuilder Rules process and associate the process with the appropriate Accounting Flexfield structure and item type.

If you customize any of the customizable processes belonging to the Generate Default Accounts process, and you make sure the Generate Default Accounts process is associated with the appropriate Accounting Flexfield structure and item type in the Account Generator Processes window, your customizations will take effect.

Choosing the Process for a Flexfield Structure

1. Navigate to the Account Generator Processes window by switching to the System Administrator responsibility and choosing Application > Flexfield > Key > Accounts.

2. With your cursor in the Application field, choose View > Find and select the combination of Application, Flexfield Title, and Structure that you need.

   Or, perform a Query > Run and locate the PO Account Generator and PO Requisition Account Generator item types in the Item Type column.

3. In the Process field, specify the process—Generate Default Accounts or Generate Accounts Using FlexBuilder Rules—that you want to use to generate these accounts.

   The default process, Generate Default Accounts, will default in.

See Also

Using the Account Generator in Oracle Public Sector Purchasing: page C – 10

The Default Account Generator Processes for Oracle Public Sector Purchasing: page C – 27

Using the Workflow Monitor with the Account Generator: page C – 55
The Default Account Generator Processes for Oracle Public Sector Purchasing

Oracle Public Sector Purchasing comes with the following Account Generator workflow item types—the first for purchase orders and releases, and the second for requisitions:

- PO Account Generator
- PO Requisition Account

Each Account Generator workflow contains the following top-level processes:

- Generate Accounts Using FlexBuilder Rules: page C – 53
- Generate Default Accounts: page C – 32

Generate Default Accounts consists of four main subprocesses:

- Generate Default Accrual Account: page C – 39
- Generate Default Budget Account: page C – 41
- Generate Default Charge Account: page C – 42
- Generate Default Variance Account: page C – 43

Other subprocesses are as follows:

- Build Expense Charge Account: page C – 44
- Build Inventory Charge Account: page C – 45
- Build Shop Floor Charge Account: page C – 46
- Build Inventory Budget Account: page C – 47
- Build Expense Project Accrual Account: page C – 49
- Build Expense Project Budget Account: page C – 49
- Build Expense Project Charge Account: page C – 49
- Build Expense Project Variance Account: page C – 49
- Get Charge Account for Variance Account: page C – 51
- Get Variance Account from Organization: page C – 52

Each Account Generator contains a number of item attributes. These attributes correspond to all the raw parameters and some derived parameters that were used in FlexBuilder. Each account ID is provided as a possible source value, in the form of an item attribute, to the subsequent account being built.

The item type attributes in both account generator item types are listed in the table below.
# Account Generator Workflow Item Type Attributes

<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accrual Account ID</td>
<td>Unique identifier for the accrual account</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Blanket PO Header ID</td>
<td>Unique identifier for the suggested source blanket agreement or catalog quotation header</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>BOM Cost Element ID</td>
<td>Unique identifier for the Bill of Materials cost element</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>BOM Resource ID</td>
<td>Unique identifier for the Bills of Material resource</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Budget Account ID</td>
<td>Unique identifier for the budget account</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Category ID</td>
<td>Unique identifier for the item category</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Charge Account ID</td>
<td>Unique identifier for the charge account</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Chart of Accounts ID</td>
<td>Unique identifier for the chart of accounts</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Deliver to Location ID</td>
<td>Unique identifier for the deliver-to location</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Destination Organization ID</td>
<td>Unique identifier for the final destination organization</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Destination Subinventory</td>
<td>Subinventory for inventory purchases</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Destination Type Code</td>
<td>Final destination of the purchased items</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Distribution att1–15</td>
<td>Descriptive flexfield segment</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Document Type Code</td>
<td>Document type</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Error Message</td>
<td>Oracle Applications message name</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Expenditure Category</td>
<td>Expenditure category</td>
<td>Text</td>
<td>30</td>
</tr>
</tbody>
</table>

Table C – 5 (Page 1 of 4)
<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/ Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expenditure Item Date</td>
<td>Project accounting expenditure item date</td>
<td>Date</td>
<td></td>
</tr>
<tr>
<td>Expenditure Organization ID</td>
<td>Unique identifier for the project accounting expenditure organization</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Expenditure Organization Name</td>
<td>Name of the expenditure organization</td>
<td>Text</td>
<td>60</td>
</tr>
<tr>
<td>Expenditure Type</td>
<td>Project accounting expenditure type</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Header att1–15</td>
<td>Descriptive flexfield segment</td>
<td>Text</td>
<td>150</td>
</tr>
<tr>
<td>Item ID</td>
<td>Unique identifier for the item</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Line att1–15</td>
<td>Descriptive flexfield segment</td>
<td>Text</td>
<td>150</td>
</tr>
<tr>
<td>Line Type ID</td>
<td>Unique identifier for the line type</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>PA Billable Flag</td>
<td>Indicator of whether an item charged to a task can accrue revenue</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>PO Encumbrance Flag</td>
<td>Indicator of whether the distribution is encumbered</td>
<td>Text</td>
<td>4</td>
</tr>
<tr>
<td>Preparer ID</td>
<td>Unique identifier for the document preparer</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Project Class Code</td>
<td>Class code for the project</td>
<td>Text</td>
<td>30</td>
</tr>
<tr>
<td>Project ID</td>
<td>Unique identifier for the project to which the item is charged</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Project Number</td>
<td>Project number to which the item is charged</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Project Organization ID</td>
<td>Unique identifier for the organization responsible for the project work</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Project Organization Name</td>
<td>Organization responsible for the project work</td>
<td>Text</td>
<td>60</td>
</tr>
</tbody>
</table>

Table C – 5  (Page 2 of 4)
<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/ Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Type</td>
<td>Project type that classifies the project</td>
<td>Text</td>
<td>20</td>
</tr>
<tr>
<td>Public Sector Flag</td>
<td>Indicator of whether the project is in the public or private sector</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Revenue Category</td>
<td>Classifier of the expenditure type into a revenue group</td>
<td>Text</td>
<td>30</td>
</tr>
<tr>
<td>Shipment att1–15</td>
<td>Descriptive flexfield segment</td>
<td>Text</td>
<td>150</td>
</tr>
<tr>
<td>Source Document Header ID</td>
<td>Unique identifier for the source document header</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Source Document Line ID</td>
<td>Unique identifier for the source document line</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Source Document Type Code</td>
<td>Source document type</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Source Organization ID</td>
<td>Unique identifier for the inventory source organization</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Source Subinventory</td>
<td>Inventory source subinventory name</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Suggested Vendor ID</td>
<td>Unique identifier for the suggested supplier</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Source Type Code</td>
<td>Source type of the item</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Supplier Employee Number</td>
<td>Number used by Oracle Projects to identify the person associated with a supplier</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supplier Person ID</td>
<td>Unique identifier used by Oracle Projects to identify the person associated with a supplier</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supplier Type</td>
<td>Supplier type, such as Employee or Supplier</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Task ID</td>
<td>Unique identifier for the task</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Task Number</td>
<td>Task number</td>
<td>Text</td>
<td>25</td>
</tr>
</tbody>
</table>

Table C – 5  (Page 3 of 4)
<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/ Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Organization ID</td>
<td>Unique identifier of the organization responsible for the task work</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Task Organization Name</td>
<td>Organization responsible for the task work</td>
<td>Text</td>
<td>60</td>
</tr>
<tr>
<td>Task Service Type</td>
<td>Type of work performed for the task</td>
<td>Text</td>
<td>30</td>
</tr>
<tr>
<td>Temp Account ID</td>
<td>Unique identifier for the code combination of the account being built</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>To Person ID</td>
<td>Unique identifier for the deliver–to person</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Top Task ID</td>
<td>Unique identifier for the top task to which a task rolls up</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Top Task Number</td>
<td>Number of the top task to which a task rolls up</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Type Lookup Code</td>
<td>Type of the document</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Vendor ID</td>
<td>Unique identifier for the supplier</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>WIP Entity ID</td>
<td>Unique identifier for the Work in Process job or repetitive assembly</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>WIP Entity Type</td>
<td>Work in Process entity type code</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>WIP Line ID</td>
<td>Unique identifier for the Work in Process line</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>WIP Operation Seq Num</td>
<td>Work in Process operation sequence number within a routing</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>WIP Repetitive Schedule ID</td>
<td>Unique identifier for the Work in Process repetitive schedule</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>WIP Resource Seq Num</td>
<td>Work in Process resource sequence number</td>
<td>Number</td>
<td></td>
</tr>
</tbody>
</table>

Table C – 5  (Page 4 of 4)
Summary of the Generate Default Accounts Process

To view the properties of the Generate Default Accounts process, select the process in the navigator tree, then choose Properties from the Edit menu. The Generate Default Accounts process has a result type of Flexfield Result, indicating that when the process completes, it has a result of Failure or Success. These results correspond to the lookup codes in the Flexfield Result lookup type in the Standard Flexfield Workflow item type.

This process activity is also runnable, indicating that it can be initiated as a top level process to run by making calls to the Workflow Engine CreateProcess and StartProcess APIs.

The Details property page of the process activity indicates that the Generate Default Accounts process has an error process called DEFAULT_ERROR associated with it, which gets initiated only when an error is encountered in the process. This error would initiate DEFAULT_ERROR, which is associated with the System:Error item type. Currently the process simply executes the standard Default Error Notification activity to provide information associated with the error. You can customize the process further to suit your needs. See: Default Error Process, Oracle Workflow Guide.
For more information on when the Account Generator process is initiated, see the subsection **Account Build Timing and Logistics** in: What the Account Generator Does in Oracle Public Sector Purchasing: page C – 12.
Generate Default Accounts is the default workflow process in Purchasing that builds the accounts.

Node 2 checks if a charge account has already been manually entered on the document. (For example, you can override or specify the charge account for uncommitted Expense distributions.) If a charge account already exists, this process skips the charge account generation process at node 3 and proceeds to node 7, which determines whether a budget account is needed.

Nodes 3, 8, 11, and 13 build the charge, budget (if node 7 finds that budgetary control is used), accrual, and variance accounts. These nodes end in failure at nodes 4, 9, or 14, if the account could not be created—for example because not all account segments were provided, or a disabled segment was used. (In these cases, you receive an error in the document window.)

Nodes 5 and 12 suspend execution of the workflow until the previous account has completed generating the account segment values. Node 5 allows a failure option in case the charge account fails to generate a code combination identifier (CCID). In this case only, the workflow ends at node 6.

### Generate Default Accounts Process Activities

The following is a description of each activity used in all of the processes and subprocesses in the PO Account Generator and the PO Requisition Account Generator, listed by the activity’s display name. You can create all the components for an activity in the graphical Workflow Builder except for the PL/SQL stored procedures that the function activities call. All function activities execute PL/SQL stored procedures which you must create and store in the Oracle RDBMS. The naming convention for the PL/SQL stored procedures is:

```
<PACKAGE> . <PROCEDURE>
```

<PACKAGE> is the name of the package that groups all of the procedures. <PROCEDURE> represents the name of the procedure.

You can use the Item Type Definitions Web page to view <PACKAGE> . <PROCEDURE> names. See: Item Type Definitions Web Page, Oracle Workflow Guide.

Some function activities are not listed here, such as Start and End function activities. These are standard function activities provided in the Standard Flexfield Workflow item type. These also include the
function activities Copy Values from Code Combination and Validate Code Combination. For information on how to use these function activities, see: Standard Flexfield Workflow, Oracle Applications Flexfields Guide).

Most of the function activities described here perform the same functions as described in the table in the section Using the Account Generator in Oracle Public Sector Purchasing: page C – 10.

**Accrual Account For Expense Item**

This function activity gets the accrual account for the expense item.

**Accrual Account From Organization**

This function activity gets the accrual account for inventory and shop floor items from the organization.

**Build Inventory Charge Account**

This function activity gets the appropriate charge account for inventory items based on whether the item is an expense or asset item.

**Expense Account**

This function activity gets the charge expense account for expense items.

**Get Budget Account From Item/Sub**

This function activity gets the budget account for inventory items from the subinventory.

**Get Charge Account**

This function activity gets the charge account.

**Get Item Level Budget Account**

This function activity gets the budget account for inventory items from the item.
Get Org Level Budget Account
This function activity gets the budget account for inventory items from the organization.

Is Charge Account CCID Null?
This is a standard Workflow comparison activity. Here, it is used to check if the Charge Account field on the document is null. See: Comparison Activities, Oracle Workflow Guide.

Item Under Budgetary Control?
This function activity checks if encumbrance accounting is being used.

Job WIP Account
For an outside processing job, this function activity gets the charge account based on the resource cost element associated with the job.

PO Accrual Acc Flexbuilder Upgrade
In the PO Account Generator, this function activity replicates your accrual account FlexBuilder rules in the Account Generator. It calls the appropriate functions that were generated during your upgrade from Release 10.7.

PO Budget Acc Flexbuilder Upgrade
In the PO Account Generator, this function activity replicates your budget account FlexBuilder rules in the Account Generator. It calls the appropriate functions that were generated during your upgrade from Release 10.7.

PO Charge Acc Flexbuilder Upgrade
In the PO Account Generator, this function activity replicates your charge account FlexBuilder rules in the Account Generator. It calls the appropriate functions that were generated during your upgrade from Release 10.7.

PO Requisition Accrual Acc Flexbuilder Upgrade
In the PO Requisition Account Generator, this function activity replicates your accrual account FlexBuilder rules in the Account
Generator. It calls the appropriate functions that were generated during your upgrade from Release 10.7.

PO Requisition Budget Acc Flexbuilder Upgrade
In the PO Requisition Account Generator, this function activity replicates your budget account FlexBuilder rules in the Account Generator. It calls the appropriate functions that were generated during your upgrade from Release 10.7.

PO Requisition Charge Acc Flexbuilder Upgrade
In the PO Requisition Account Generator, this function activity replicates your charge account FlexBuilder rules in the Account Generator. It calls the appropriate functions that were generated during your upgrade from Release 10.7.

PO Requisition Variance Acc Flexbuilder Upgrade
In the PO Requisition Account Generator, this function activity replicates your variance account FlexBuilder rules in the Account Generator. It calls the appropriate functions that were generated during your upgrade from Release 10.7.

PO Project–Related?
In the PO Account Generator, this function activity checks if the purchase order item is for a project in Oracle Projects.

Requisition Project–Related?
In the PO Requisition Account Generator, this function activity checks if the requisition item is for a project in Oracle Projects.

PO Variance Flexbuilder Upgrade
In the PO Account Generator, this function activity replicates your variance account FlexBuilder rules in the Account Generator. It calls the appropriate functions that were generated during your upgrade from Release 10.7.
Schedule Account
For an outside processing schedule, this function activity gets the charge account based on the resource cost element associated with the schedule.

Type of WIP
For shop floor items, this function activity checks if the outside processing type is Job or Schedule.

Variance Account From Organization
This function activity gets the variance account for inventory and shop floor items from the organization.

Work Item Destination Type
This function activity checks if the destination type of the item is Inventory, Shop Floor, or Expense.

Set Encoded Error Message
This function activity is not used by any process in the workflow, but is provided to aid in customizing the workflow. It can be used to create a customized error message. You must first define the message in the Oracle Applications Message Dictionary before it can be used by this function activity.

For instructions, see To use the Set Encoded Error Message function activity in the section Customizing the Account Generator for Oracle Public Sector Purchasing: page C – 19.

Summary of the Generate Default Accrual Account Subprocess
To view the properties of this process, select the process in the navigator tree, then choose Properties from the Edit menu. This process has a result type of Flexfield Result, indicating that when the process completes, it has a result of Failure or Success. These results correspond to the lookup codes in the Flexfield Result lookup type in the Standard Flexfield Workflow item type.
This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only as a subprocess when called by a higher-level process.

The subprocess begins at node 1.

Node 2 checks if the destination type for the item is Inventory, Shop Floor, or Expense.

For expense items, node 8 first checks if the item is project-related. If it is, the subprocess at node 11 builds a project-related account, if you have customized that subprocess to do so.

If the item is not project-related, node 9 gets the accrual account. For inventory and shop floor items, node 3 gets the accrual account from the organization. See the table in the section Using the Account Generator in Oracle Public Sector Purchasing: page C – 10.

Nodes 5 and 6 are standard flexfield workflow activities. See: Standard Flexfield Workflow, Oracle Applications Flexfields Guide.
Summary of the Generate Default Budget Account Subprocess

To view the properties of this process, select the process in the navigator tree, then choose Properties from the Edit menu. This process has a result type of Flexfield Result, indicating that when the process completes, it has a result of Failure or Success. These results correspond to the lookup codes in the Flexfield Result lookup type in the Standard Flexfield Workflow item type.

This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only as a subprocess when called by a higher-level process.

The subprocess begins at node 1.

Node 2 checks if the item is project-related. If it is, the subprocess at node 3 builds a project-related account, if you have customized that subprocess to do so.

Node 6 checks if the destination type for the item is Inventory, Expense, or Shop Floor.

For shop floor items, the subprocess ends at node 7 because the Account Generator does not construct a budget account for shop floor distributions, even if you are using encumbrance.
For expense items, node 10 gets the budget account from the charge account.

For inventory items, the subprocess at node 8 builds the inventory budget account. See: Summary of the Build Inventory Budget Account Subprocess: page C – 47.

Nodes 12 and 13 are standard flexfield workflow activities. See: Standard Flexfield Workflow, Oracle Applications Flexfields Guide.

**Summary of the Generate Default Charge Account Subprocess**

To view the properties of this process, select the process in the navigator tree, then choose Properties from the Edit menu. This process has a result type of Flexfield Result, indicating that when the process completes, it has a result of Failure or Success. These results correspond to the lookup codes in the Flexfield Result lookup type in the Standard Flexfield Workflow item type.

This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only as a subprocess when called by a higher-level process.

The subprocess begins at node 1.

Node 2 checks if the destination type for the item is Shop Floor, Inventory, or Expense.
For shop floor items, node 3 builds the shop floor charge account. See: Summary of the Build Shop Floor Charge Account Subprocess: page C – 46. For inventory items, node 5 builds the inventory charge account. See: Summary of the Build Inventory Charge Account Subprocess: page C – 45. For expense items, node 9 builds the expense charge account. See: Summary of the Build Expense Charge Account Subprocess: page C – 44.

If node 9 successfully builds the charge account for expense items, the workflow does not validate the code combination right away. Instead, since you can enter your own charge account on the document for expense items, node 10 first checks if all segments were provided:

- If so, node 12 uses the function attribute Generate Code Combination ID to generate the complete code combination identifier (CCID).
- If not, node 11 uses the function attribute Validate Segment With Values Only to validate just those segments that were provided.

Nodes 6, 10, 11, and 12 are standard flexfield workflow activities. See: Standard Flexfield Workflow, Oracle Applications Flexfields Guide.

---

**Summary of the Generate Default Variance Account Subprocess**

To view the properties of this process, select the process in the navigator tree, then choose Properties from the Edit menu. This process has a result type of Flexfield Result, indicating that when the process completes, it has a result of Failure or Success. These results correspond to the lookup codes in the Flexfield Result lookup type in the Standard Flexfield Workflow item type.

This process activity is not runnable, indicating that it cannot be initiated as a top–level process to run, but rather can be run only as a subprocess when called by a higher–level process.
The subprocess begins at node 1.

Node 2 checks if the destination type is Shop Floor, Inventory, or Expense.

For shop floor or inventory items, node 5 gets the variance account from the organization. For expense items, node 3 gets the charge account. See the table in the section Using the Account Generator in Oracle Public Sector Purchasing: page C – 10.

Node 7 is a standard flexfield workflow activity. See: Standard Flexfield Workflow, Oracle Applications Flexfields Guide.

Summary of the Build Expense Charge Account Subprocess

To view the properties of this process, select the process in the navigator tree, then choose Properties from the Edit menu. This process has a result type of Flexfield Result, indicating that when the process completes, it has a result of Failure or Success. These results correspond to the lookup codes in the Flexfield Result lookup type in the Standard Flexfield Workflow item type.

This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only as a subprocess when called by a higher-level process.
The subprocess begins at node 1.

For expense items, this subprocess first checks at node 2 if the item is project-related. If it is, the subprocess at node 3 builds a project-related account, if you have customized that subprocess to do so.

If the expense item is not project-related, node 5 gets the charge expense account. See the table in the section Using the Account Generator in Oracle Public Sector Purchasing; page C–10.

Node 6 is a standard flexfield workflow activity. See: Standard Flexfield Workflow, Oracle Applications Flexfields Guide.

**Summary of the Build Inventory Charge Account Subprocess**

To view the properties of this process, select the process in the navigator tree, then choose Properties from the Edit menu. This process has a result type of Flexfield Result, indicating that when the process completes, it has a result of Failure or Success. These results correspond to the lookup codes in the Flexfield Result lookup type in the Standard Flexfield Workflow item type.
This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only as a subprocess when called by a higher-level process.

The subprocess begins at node 1.

For an inventory items, this subprocess, at node 2, gets the appropriate charge account based on whether the item is an expense or asset item. See the table in the section Using the Account Generator in Oracle Public Sector Purchasing: page C-10.

Node 4 is a standard flexfield workflow activity. See: Standard Flexfield Workflow, Oracle Applications Flexfields Guide.

**Summary of the Build Shop Floor Charge Account Subprocess**

To view the properties of this process, select the process in the navigator tree, then choose Properties from the Edit menu. This process has a result type of Flexfield Result, indicating that when the process completes, it has a result of Failure or Success. These results correspond to the lookup codes in the Flexfield Result lookup type in the Standard Flexfield Workflow item type.

This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only as a subprocess when called by a higher-level process.
The subprocess begins at node 1.

For shop floor items, this subprocess, at node 2, checks if the item is for an outside processing job or schedule. For a job, node 3 gets the charge account based on the resource cost element associated with the job. For a schedule, node 7 gets the charge account based on the resource cost element associated with the schedule. See the table in the section Using the Account Generator in Oracle Public Sector Purchasing: page C – 10.

Node 5 is a standard flexfield workflow activity. See: Standard Flexfield Workflow, Oracle Applications Flexfields Guide.

**Summary of the Build Inventory Budget Account Subprocess**

To view the properties of this process, select the process in the navigator tree, then choose Properties from the Edit menu. This process has a result type of Flexfield Result, indicating that when the...
process completes, it has a result of Failure or Success. These results correspond to the lookup codes in the Flexfield Result lookup type in the Standard Flexfield Workflow item type.

This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only as a subprocess when called by a higher-level process.

The subprocess begins at node 1.

For inventory items, this subprocess, at node 2, gets a budget account first from the subinventory. If no account is specified there, node 4 looks for the budget account for the item. If no account is specified there, node 5 looks for the budget account for the organization. If no account is specified there, node 6 gets the charge account for the
Summary of the Build Project Account Subprocesses

To view the properties of the Build Project Account subprocesses, select the process in the navigator tree, then choose Properties from the Edit menu. The Build Project Account subprocesses each have a result type of Flexfield Result, indicating that when the process completes, it has a result of Failure or Success. These results correspond to the lookup codes in the Flexfield Result lookup type in the Standard Flexfield Workflow item type.

These subprocess activities are not runnable, indicating that they cannot be initiated as a top-level process to run, but rather can be run only as a subprocess when called by a higher-level process.

There are four Build Project Account subprocesses, one for each account being built:

- Build Expense Project Accrual Account
- Build Expense Project Budget Account
- Build Expense Project Charge Account
- Build Expense Project Variance Account
The Build Project Account subprocesses are dummy processes, available for you to customize an account–building process if Oracle Projects is installed. To use this process, you provide your own rules to the process, in the form of workflow process definitions, to build the account.

Shown below, the function activity Requisition Project–Related? by default always returns a value of False. This is what is meant by the Build Project Related Account process’s being a dummy process. It isn’t used until you replace the function activity Requisition Project–Related? with one of your own that checks a document for a Project ID.

You can use the Standard workflow function activity Compare Number in place of PO Project–Related. You can use Compare Number to compare the Project ID on a document with a value that you define, or to check if a Project ID exists. If there is no Project ID, then Compare Number transitions to the Expense Account activity and builds the default expense account. If there is a Project ID, then Compare Number transitions to the Build Project Related Account process to build the account. See: Comparison Activities, Oracle Workflow Guide.

If you want to bill items to a project account, you must do the following:

- Replace Requisition Project–Related? (or PO Project–Related?) with your own function activity that branches to Build Project Account subprocess if a document has a Project ID.
• Customize the appropriate Build Project Account subprocess. In the example above, you would customize the Build Expense Project Charge Account subprocess. If you wanted to use your project-related account for all accounts—accrual, budget, charge, and variance—you would customize all four of the Build Project Account subprocesses.

For more information about using the Account Generator when you integrate Oracle Public Sector Purchasing with Oracle Projects, read the following essay: Using the Account Generator in Oracle Projects (Oracle Projects User’s Guide).

Summary of the Get Charge Account for Variance Account Subprocess

To view the properties of this process, select the process in the navigator tree, then choose Properties from the Edit menu. This process has a result type of Flexfield Result, indicating that when the process completes, it has a result of Failure or Success. These results correspond to the lookup codes in the Flexfield Result lookup type in the Standard Flexfield Workflow item type.

This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only as a subprocess when called by a higher-level process.
The subprocess begins at node 1.

For expense items, this subprocess first checks at node 2 if the item is project–related. If it is, the subprocess at node 3 builds a project–related account, if you have customized that subprocess to do so.

If the item is not project–related, node 5 gets the charge account for building the variance account.

Node 7 is a standard flexfield workflow activity. See: Standard Flexfield Workflow, Oracle Applications Flexfields Guide.

Summary of the Get Variance Account from Organization Subprocess

To view the properties of this process, select the process in the navigator tree, then choose Properties from the Edit menu. This process has a result type of Flexfield Result, indicating that when the process completes, it has a result of Failure or Success. These results
correspond to the lookup codes in the Flexfield Result lookup type in the Standard Flexfield Workflow item type.

This process activity is not runnable, indicating that it cannot be initiated as a top–level process to run, but rather can be run only as a subprocess when called by a higher–level process.

The subprocess begins at node 1.

For inventory and shop floor items, node 2 gets the variance account from the organization. See the table in the section Using the Account Generator in Oracle Public Sector Purchasing: page C – 10.

Node 3 is a standard flexfield workflow activity. See: Standard Flexfield Workflow, Oracle Applications Flexfields Guide.

Summary of the Generate Accounts Using FlexBuilder Rules Process

To view the properties of this process, select the process in the navigator tree, then choose Properties from the Edit menu. This process has a result type of Flexfield Result, indicating that when the process completes, it has a result of Failure or Success. These results correspond to the lookup codes in the Flexfield Result lookup type in the Standard Flexfield Workflow item type.

This process activity is also runnable, indicating that it can be initiated as a top–level process to run by making calls to the Workflow Engine CreateProcess and StartProcess APIs.
If you customized FlexBuilder in a previous release to generate account combinations, you can use the Generate Accounts Using FlexBuilder Rules process to replicate your FlexBuilder setup automatically, without changing any of your predefined FlexBuilder Rules, and without customizing the Account Generator. This top-level process consists of the following processes:

- (Node 3) Generate Charge Account Using FlexBuilder Rules replicates your charge account FlexBuilder rules in the Account Generator.
- (Node 8) Generate Budget Account Using FlexBuilder Rules replicates your budget account FlexBuilder rules in the Account Generator (if the activity at node 7 finds that the item is under budgetary control).
- (Node 11) Generate Accrual Account Using FlexBuilder Rules replicates your accrual account FlexBuilder rules in the Account Generator.
- (Node 13) Generate Variance Account Using FlexBuilder Rules replicates your variance account FlexBuilder rules in the Account Generator.

To build accounts, Generate Accounts Using FlexBuilder Rules process calls the appropriate functions that were generated during your upgrade from Release 10.7.

If you are upgrading from Release 10, follow the guidelines in the FlexBuilder chapter of the Oracle Applications Upgrade Preparation Manual.

---

**Using the Workflow Monitor with the Account Generator**

If you are using the Workflow Monitor to view account generation results during testing or diagnosing a problem, set the profile option Account Generator: Run in Debug Mode to Yes. This ensures that runtime data is saved. After you finish testing, always set this profile option to No, to maintain performance. Use the Purge Obsolete Workflow Runtime Data process, accessible through the System Administrator responsibility, to periodically purge the runtime data.
To monitor a document as it proceeds through a workflow, you need to provide the Workflow Monitor with an item key, which is specific both to the document you are monitoring and the process in which you’re monitoring it.

For information on how to use the Workflow Monitor, see Workflow Monitor, *Oracle Workflow Guide*.

**To determine the item key for the Account Generator workflows:**

1. In Purchasing, open the document you want to monitor and choose Tools > Examine from the Help menu.
   
   Tools > Examine is sometimes controlled by a password. If you don’t have access to it, see your system administrator.

2. Select the down–arrow box to the right of the Block field.

3. In the list of values that appears, choose PARAMETER and choose OK.

4. In the Field field, enter charge_acc_wf_itemkey.
   
   The item key appears in the Value field. Use this item key when you are prompted by the Workflow Monitor to enter the item key.
Requisition Approval Workflow

Whenever you submit a requisition for approval or take an action in the Notifications Summary window, Purchasing uses Oracle Workflow technology in the background to handle the approval process. Workflow uses the approval controls and hierarchies you define according to the setup steps in the section Setting Up Document Approval and Security: page 2 – 2 to route documents for approval. You can use the Workflow Builder to modify your approval process.

The requisition approval workflow consists of processes, which are viewable in the Workflow Builder as a diagram, some of whose objects and properties you can modify. Each workflow process, in turn, consists of individual function activities.

The PO Requisition Approval workflow is initiated at the following points in Purchasing:

- When you choose Submit for Approval (and then choose OK) in the Approve Document window in Purchasing or submit a requisition for approval in Oracle iProcurement.
- When you respond to a reminder in the Notifications Summary window reminding you to submit a document for approval that has not yet been submitted.
- When you run Requisition Import. If the requisitions are incomplete or preapproved, Requisition Import launches the PO Requisition Approval workflow to approve the requisitions, unless you specify not to.

For information on the purchase order approval workflow, see: Purchase Order Approval Workflow: page C – 114.

Customizing the PO Requisition Approval Workflow

Use the Oracle Workflow Builder to customize workflows. When you customize a workflow, only those documents that are submitted for approval after you customize it are affected by the customized workflow.

You can also use the Workflow Builder to create unique approval workflows for each document type in your organization. You associate particular workflows with certain document types in the Document Types window. See: Defining Document Types: page 1 – 87.
You can use the Workflow Monitor to follow where certain documents are in a workflow process. See: Workflow Monitor, *Oracle Workflow Guide*.

**To display the workflow in the Oracle Workflow Builder:**

1. Choose Open from the File menu, and connect to the database.  
   See: Opening and Saving Item Types, *Oracle Workflow Guide*.
   The Display name of the PO Requisition Approval workflow is *PO Requisition Approval*. The name of its Workflow definition file is *poxwfrqa.wft*.

2. Expand the data source, then the PO Requisition Approval item type branch within that data source.

3. Expand the Processes branch within the PO Requisition Approval branch, then double-click on a process activity to display its diagram.

**Creating a New Custom Process**

You can either modify the default PO Requisition Approval workflow that Purchasing provides, or copy it and create a whole new workflow. You can use the Document Types window to select a custom PO...
Requisition Approval Workflow Startup Process for specific document types or operating units.

If you create different workflows for different documents or operating units, the recommended practice is not to copy and rename the item type (such as PO Requisition Approval 1), but to copy and rename the Workflow Startup Process, which you will modify to call your own custom subprocesses. All of your operating units will point to the same item type, and will use the default item attributes and other activities that the item type requires, but one operating unit will also use your custom startup process.

**Attention:** Creating a new workflow process with a new Internal Name affects the implementation of future upgrades. See: Upgrade Support: page C – 5.

**Required Modifications**

There are no required modifications you need to make to the PO Requisition Approval workflow. However, this documentation assumes that you have already set up Purchasing and performed the Workflow setup steps described in Workflow Setup Options: page 1 – 95.

**Supported and Unsupported Customizations**

The following is a discussion of what you can and definitely cannot modify in the PO Requisition Approval workflow. For those things you can modify, the discussion includes important guidelines that you need to be careful of when making customizations.

For important information on how to customize workflows, see the Oracle Workflow Guide.

To further help you with your customizations, refer to the sections later in this document, starting with The PO Requisition Approval Item Type: page C – 63. These sections describe the components of the main processes in the PO Requisition Approval workflow. If you haven’t already, see also: Customization Guidelines: page C – 5.

**Attention:** If a particular Workflow object does not appear in the following sections on the lists of things you can customize, do not modify it, regardless of its access level.
Attributes

You can modify the following attribute only, by changing its Default Value:

- Send PO Autocreate to Background

Its Default Value is Y for Yes, to send automatic document creation to Background mode, but you can change it to N for No, to operate in Online mode. See: Choosing Workflow Options: page 1–95.

Processes

If you modify a process, it is essential that the basic flow remain intact to maintain data integrity in the database. For example, you should not remove or bypass the function activity Is Document Complete? in the Verify Requisition subprocess because this may allow incomplete data to be inserted into the database tables. However, you could add additional checks (processes or function activities) before allowing data to be inserted into the tables.

If you modify any process, either by replacing a portion of its flow or by adding additional function activities, remember the following:

- Attributes that are set by default function activities in the default processes must also be set if you replace default function activities with ones of your own. That is, if a function activity in that process uses a `SetItemAttr` statement, then that function activity is setting an attribute to be used by another function activity later. Therefore, your new function activity must do the same. You should also preserve `setItemUserKey` and `setItemOwner` statements, if any. (Depending on your customizations, you may also want to preserve `getItemAttr` statements.)

- Any database state maintained by the default processes must also be maintained by processes you customize. That is, if a function activity in that process uses an `Update` or `Insert Into` statement, then that function activity is updating or inserting rows in the database. Therefore, your new function activity must maintain the same database state.

To get a list of the workflow function activities that use `setItemAttr`, `getItemAttr`, `setItemUserKey`, `setItemOwner`, `insert Into`, or `Update` statements, run the PL/SQL script `powfcust`. For instructions on running this script, see: Customization Guidelines: page C–5.
Using the Account Generator in Oracle Public Sector Purchasing

The process listed below may be modified as your business processes require; however, remember that after your customizations, the attributes that were set and the database states that were maintained by the default process must also be set or maintained by your customized process.

- Print Document Process

You may add your own additional function activities to the processes listed below, but do not remove any default function activities from them:

- Approve Requisition
- Reject Requisition
- Reserve at the Start
- Reserve Before Approve
- Return Requisition to Submitter
- Verify Approval Authority
- Verify Approval Authority for Approve Action
- Verify Approval Authority for Approve and Forward Action
- Verify Requisition
- Approval List Routing
- Main Requisition Approval
- Notify Approver
- Response with Approve Action
- Response with Approve and Forward Action
- Response with Forward Action
- Response with Reject Action
- Reserve Before Approve
- Start of Approve Requisition Process
Notifications

All of the notifications can be modified to meet your individual public sector needs. However, if the notification has a reply code, make sure that the Result Type of your customized notification matches the transitions in the workflow diagram. See: To Create a Notification Activity, Oracle Workflow Guide. See also: Message Result, Oracle Workflow Guide and To Create a Message, Oracle Workflow Guide.

Function Activities

You cannot modify any functions in the PO Requisition Approval workflow.

However, you can replace some function activities with function activities of your own. When you replace a function activity, you are modifying the process in which it is contained. See the guidelines for customizing the PO Requisition Approval processes in the section Processes above.

If you substitute default function activities in a process with function activities that you create, you must remember the following:

- The result type of your new function activity must match the result type of the default activity. That is, the Result Type of the function activity in the Workflow Builder needs to match the result type specified by that function activity’s corresponding PL/SQL procedure—for example, a Result Type of Yes/No. It also means that if you have, for example, two results (such as Yes and No) in your function activity and corresponding PL/SQL procedure, you need to make sure that there are two corresponding transitions in the workflow diagram (one for Yes and one for No). If you alter the result types and transitions in a process, be careful that you aren’t deleting or bypassing any special transitions or checks.

- Just as with Processes above, any attributes that were set by the default function activity must also be set by your customized function activity.

- Just as with Processes above, any database state maintained by the default function activity must also be maintained by the customized function activity.

Messages

All of the messages can be modified to meet your individual public sector needs.
Lookup Types

All of the lookup types can be modified to meet your individual public sector needs.

**Note:** If you change a lookup type, be sure that all activities that use the lookup type allow for the change. For example, if you change the lookup type from Yes/No to something else, the activities that use that lookup type should also change their Result Type from Yes/No to whatever new lookup type you created. See: Lookup Types, *Oracle Workflow Guide*.

The PO Requisition Approval Workflow Item Type

The Requisition Approval process is associated with an item type called PO Requisition Approval. This item type identifies all requisition approval workflow processes available. The following workflow processes are associated with PO Requisition Approval:

- Main Requisition Approval: page C – 69
- Start of Approve Requisition Process: page C – 77
- Verify Requisition: page C – 79
- Reserve At The Start: page C – 82
- Verify Approval Authority: page C – 84
- Approval List Routing: page C – 86
- Reject Requisition: page C – 89
- Return Requisition to Submitter: page C – 91
- Notify Approver: page C – 94
- Response with Approve Action: page C – 97
- Response with Approve and Forward Action: page C – 99
- Response with Forward Action: page C – 101
- Response with Reject Action: page C – 102
- Reserve Before Approve: page C – 103
- Approve Requisition: page C – 106
- Print Document Process: page C – 109
• Verify Approval Authority for Approve Action: page C – 111
• Verify Approval Authority for Approve and Forward Action: page C – 111

The PO Requisition Approval item type also has many attributes associated with it. These attributes reference information in the Purchasing application tables. The attributes are used and maintained by function activities as well as notification activities throughout the process.

The following table shows the PO Requisition Approval Workflow item type attributes.
## PO Requisition Approval Workflow Item Type Attributes

<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action history of the document</td>
<td>Action history of the document as displayed in the approval notification</td>
<td>Document</td>
<td></td>
</tr>
<tr>
<td>Application ID</td>
<td>Unique identifier for the application (such as Purchasing)</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Approval List ID</td>
<td>Unique identifier for the list of approvers that the requester sees or modifies in iProcurement</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Approval Path ID</td>
<td>Unique identifier for the approval hierarchy</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Approver Employee ID</td>
<td>Unique identifier for the approver</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Approver Display Name</td>
<td>Approver’s name as displayed in Purchasing</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Approver User Name</td>
<td>User name of the approver</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Approve Requisition Message</td>
<td>Message header that indicates the specific document requiring approval</td>
<td>Document</td>
<td></td>
</tr>
<tr>
<td>Authorization Status</td>
<td>Status of the document, such as Approved or Incomplete</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Authorization Status Display</td>
<td>Document status as displayed in Purchasing</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Closed Code</td>
<td>Indicator that the document is closed</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Closed Code Display</td>
<td>Closed status as displayed in Purchasing</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Concurrent Request ID</td>
<td>Request ID for the Document Approval Manager</td>
<td>Number</td>
<td></td>
</tr>
</tbody>
</table>

Table C – 6  (Page 1 of 5)
<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Context ORG_ID</td>
<td>Unique identifier for the organization</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Document ID</td>
<td>Unique identifier for the document</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Document Manager Error Number</td>
<td>Error number for the Document Manager Failed notification</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Document Subtype</td>
<td>Document subtype, such as Purchase or Internal</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Document Subtype Display</td>
<td>Document subtype as displayed in Purchasing</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Document Type</td>
<td>Document type, such as Requisition</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Document Type Display</td>
<td>Document type as displayed in Purchasing</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Emergency PO Number</td>
<td>Purchase order number reserved in advance for a requisition created in iProcurement</td>
<td>Text</td>
<td>20</td>
</tr>
<tr>
<td>Forward From Display Name</td>
<td>Name of the forward–from person as displayed in Purchasing</td>
<td>Text</td>
<td>60</td>
</tr>
<tr>
<td>Forward From ID</td>
<td>Unique identifier for the forward–from person</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Forward From User Name</td>
<td>User name for the forward–from person</td>
<td>Text</td>
<td>60</td>
</tr>
<tr>
<td>Forward To Display Name</td>
<td>Name of the forward–to person as displayed in Purchasing</td>
<td>Text</td>
<td>60</td>
</tr>
<tr>
<td>Forward To ID</td>
<td>Unique identifier for the forward–to person</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Forward–To ID Old Value</td>
<td>Item attribute for internal use that keeps track of the previous forward–to person</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Forward To User Name</td>
<td>User name for the forward–to person</td>
<td>Text</td>
<td>60</td>
</tr>
</tbody>
</table>

Table C – 6 (Page 2 of 5)
<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Functional Currency</td>
<td>Functional currency</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Interface Source</td>
<td>Source of the requisition, such as ICX or POR</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>“Invalid Forward To” Translated Message</td>
<td>Message used when approving the document if the forward-to user name is invalid</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>No Approver Found Message</td>
<td>Message header that indicates the specific document for which the approver was not found</td>
<td>Document</td>
<td></td>
</tr>
<tr>
<td>Note</td>
<td>Note to the approver</td>
<td>Text</td>
<td>240</td>
</tr>
<tr>
<td>Online Report ID For Doc Complete Check</td>
<td>Unique identifier for the error message displayed after saving a document that is in error</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Online Report Text For Doc Complete Check</td>
<td>Text of the error message displayed after saving a document that is in error</td>
<td>Text</td>
<td>2000</td>
</tr>
<tr>
<td>Open From Command</td>
<td>Command that Purchasing sends to open the document from the notification</td>
<td>Form</td>
<td></td>
</tr>
<tr>
<td>Original Authorization Status</td>
<td>Status of the document before it was submitted for approval</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>PL/SQL Error Document</td>
<td>The document that was being approved when a PL/SQL error occurred</td>
<td>Text</td>
<td>2000</td>
</tr>
<tr>
<td>PL/SQL Error Location</td>
<td>Where an internal, PL/SQL error occurred</td>
<td>Text</td>
<td>2000</td>
</tr>
<tr>
<td>PL/SQL Error Message</td>
<td>Text for the notification sent when a PL/SQL error occurs</td>
<td>Text</td>
<td>2000</td>
</tr>
<tr>
<td>Preparer Display Name</td>
<td>Name of the person who created the document, as displayed in Purchasing</td>
<td>Text</td>
<td>80</td>
</tr>
</tbody>
</table>

Table C – 6 (Page 3 of 5)
<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparer ID</td>
<td>Unique identifier for the person who created the document</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Preparer User Name</td>
<td>User name for the person who created the document</td>
<td>Text</td>
<td>60</td>
</tr>
<tr>
<td>Print Document</td>
<td>Indicator of whether Print Document was selected when submitting the requisition for approval</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>&quot;Requires Approval&quot; Translated Message</td>
<td>Message text used to indicate the document requires approval</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Requisition Amount Display</td>
<td>Total amount, without tax, as displayed in Purchasing</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Requisition Approved Message</td>
<td>Message header that indicates the specific document requiring approval</td>
<td>Document</td>
<td></td>
</tr>
<tr>
<td>Requisition Detail</td>
<td>Used in iProcurement to enable you to view requisition details</td>
<td>URL</td>
<td></td>
</tr>
<tr>
<td>Requisition Description</td>
<td>Header description</td>
<td>Text</td>
<td>240</td>
</tr>
<tr>
<td>Requisition line details</td>
<td>Requisition line details displayed in the approval notification</td>
<td>Document</td>
<td></td>
</tr>
<tr>
<td>Requisition Number</td>
<td>Requisition number</td>
<td>Text</td>
<td>20</td>
</tr>
<tr>
<td>Requisition Rejected Message</td>
<td>Message header that indicates the specific document that was rejected</td>
<td>Document</td>
<td></td>
</tr>
<tr>
<td>Responder Display Name</td>
<td>Name of the approver as displayed in Purchasing</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Responder ID</td>
<td>Unique identifier for an approver’s response to a notification</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Display Name</td>
<td>Description</td>
<td>Type</td>
<td>Length/Format/ Lookup Type</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Responder User Name</td>
<td>User name of the approver</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Response Forward–To</td>
<td>Forward–to name as entered by the person forwarding the document</td>
<td>Text</td>
<td>100</td>
</tr>
<tr>
<td>Responsibility ID</td>
<td>Unique identifier for the requester’s user responsibility</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Resubmit Requisition</td>
<td>Used in iProcurement to enable you to resubmit a requisition</td>
<td>URL</td>
<td></td>
</tr>
<tr>
<td>Send PO Autocreation to Background</td>
<td>Indicator of whether to send automatic documentation creation to online or background modes</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>System Administrator Error Message</td>
<td>Document Approval Manager failed message</td>
<td>Text</td>
<td>2000</td>
</tr>
<tr>
<td>Tax Amount Display</td>
<td>Tax amount displayed in the approval notification</td>
<td>Text</td>
<td>30</td>
</tr>
<tr>
<td>Total Amount Display</td>
<td>Total document amount, with tax, displayed in the approval notification</td>
<td>Text</td>
<td>30</td>
</tr>
<tr>
<td>Update Requisition</td>
<td>Used in iProcurement to enable you to update a requisition</td>
<td>URL</td>
<td></td>
</tr>
<tr>
<td>User ID</td>
<td>Unique identifier for the requester</td>
<td>Number</td>
<td></td>
</tr>
</tbody>
</table>

Table C – 6  (Page 5 of 5)

**Summary of the Main Requisition Approval Process**

To view the properties of the Main Requisition Approval process, select the process in the navigator tree, then choose Properties from the Edit menu. The Main Requisition Approval process has a result type of PO Main Requisition Approval Process Result, indicating that when the process completes, it has a result of Approved, Invalid Action, No Approver Available, or Rejected. These results correspond to the
lookup codes in the PO Main Requisition Approval Process Result lookup type in the PO Standard item type.

This process activity is also runnable, indicating that it can be initiated as a top-level process to run by making calls to the Workflow Engine CreateProcess and StartProcess APIs.

The Main Requisition Approval workflow begins when you submit a requisition in Purchasing or iProcurement. This workflow handles both kinds of requisitions—those created in iProcurement and those created in Purchasing.

The first part of the process diagram, through node 16, is shown below:
The rest of the process diagram, starting with node 16, is shown below:

Node 2 sets all startup values, sets the requisition status to In Process, obtains the approval mode used, and retrieves requisition attributes.

If the requisition passes verification at node 3, node 5 attempts to reserve funds at the start of the approval process, for iProcurement requisitions, if you use encumbrance.

Node 6 checks if the requester in iProcurement created or modified an approval list. If not—or if the requisition was created in Purchasing—node 7 builds a default approval list based on the approval hierarchy setup in Purchasing.

If node 7 cannot build a default approval list (for example, because of a system failure or a problem in the approval hierarchy), the requisition is returned to the requester at node 8.

Node 10 checks if Owner Can Approve is enabled for the document type, and node 15 verifies the owner’s approval authority. If the owner cannot approve the document, node 11 routes the requisition according to the approval list.

If an approver responds with Reject, node 12 rejects the requisition, and node 13 sends a notification of the rejection to the requester. If there is a problem with the requisition, it is returned at node 8.

If an approver responds with Approved, the workflow begins to approve the document, starting at node 18. At node 18, the workflow reserves funds for the document if encumbrance accounting is being used and if funds for the document aren’t already reserved, before approving the document at node 20.
If the requisition is forwarded, node 19 rebuilds the approval list to include that forward-to person. Then node 11 forwards the requisition to that approver.

If node 10 and 15 confirm that the requester can approve the document, the requisition status is set to Pre-Approved at node 16. Then, if no more approvers are indicated by node 17, the workflow approves the document: node 18 makes sure funds are reserved if encumbrance is used, and node 20 approves the document and sets its status to Approved.

Finally:

- Node 23 turns iProcurement information templates into attachments, if information templates were used in iProcurement.
- Node 24 sends a notification to the document owner that the requisition was approved.
- Node 25 prints the document if Print was selected when the requisition was submitted.
- Node 26 looks to the item attribute Send PO Autocreation to Background, which sets the processing mode to Background (if the item attribute is set to Y) or Online (if the item attribute is set to N) specifically for automatic document creation. How this mode is set affects system performance. For definitions of Background and Online modes, see: Profile Options in Purchasing: page 1–103.
- Node 28 automatically starts the PO Create Documents workflow, which creates purchase orders and releases from the approved requisition lines, if you’ve allowed this in the Purchasing setup. See: Choosing Workflow Options: page 1–95.

**Main Requisition Approval Process Activities**

The following is a description of each activity in the Main Requisition Approval process.

**Start of Approve Requisition Process (Node 2)**

Verify Requisition (Node 3)

See: Verify Requisition: page C – 79.

Reserve At The Start (Node 5)

See: Reserve At The Start: page C – 82.

Does Approval List Exist? (Node 6)

This activity checks if a requester in iProcurement created or modified an approval list.

Build Default Approval List (Node 7)

If a requester in iProcurement did not create or modify the approval list, or if the requisition was submitted in Purchasing, this activity builds an approval list based on the approval hierarchy setup in Purchasing.

Can Owner Approve? (Node 10)

This function activity checks if Owner Can Approve is enabled for the specific document type in the Document Types window. See: Defining Document Types: page 1 – 87. If the owner can approve, the subprocess Verify Approval Authority verifies the owner’s approval authority. If not, the subprocess Approval List Routing begins.

Verify Approval Authority (Node 15)

See: Verify Approval Authority: page C – 84.

Set Req Status to Pre–Approved (Node 16)

If the requester has the approval authority to approve the document, this function activity sets the requisition’s status to Pre–Approved. The status is set to Pre–Approved until the subprocess Approve Requisition or the subprocess Reserve Before Approve explicitly sets the status to Approved.

This activity updates the document status only, not the action history. Later another activity, Update Action History, updates the Action History window.
Is Approval List Empty? (Node 17)

This activity makes sure there are no more approvers. If there are not, the workflow begins approving the requisition. If there are, the workflow routes the document for their approval.

Approval List Routing (Node 11)

See: Approval List Routing: page C – 86.

Reject Requisition (Node 12)

See: Reject Requisition: page C – 89.

Requisition Rejected (Node 13)

This activity sends a notification to the requester that the requisition has been rejected.

Return Requisition to Submitter (Node 8)


Rebuild Approval List After Forward Action (Node 19)

If the requisition is forwarded, this activity rebuilds the approval list to include that forward-to person.

iProcurement Example

The default approval hierarchy setup in Purchasing is as follows:

- Approver A
- Approver B
- Approver C

A requester in iProcurement adds Approvers X and Y:

- Approver A
- Approver B
- Approver C
- Approver X
- Approver Y
Approver C, however, forwards the document to Approver D, who is part of another branch in the hierarchy:

- Approver D
- Approver E
- Approver F

The approval routing will then be as follows, assuming Approver D does not have final approval authority:

- Approver A
- Approver B
- Approver C
- Approver X
- Approver Y
- Approver D
- Approver E
- Approver F

**Reserve Before Approve (Node 18)**

See: Reserve Before Approve: page C – 103.

**Approve Requisition (Node 20)**


**Is Requisition Created Through the Web? (Node 22)**

This activity checks if the requisition was created through iProcurement.

**Create Information Template Attachment (Node 23)**

This activity turns iProcurement information templates, if used, into attachments. The Define Information Template window in Purchasing lets you define these templates for iProcurement. For example, you can create a template for ordering business cards in iProcurement. The template used to gather the business card information is converted into an attachment in Purchasing by this activity.
Note: Information templates in iProcurement are not the same as requisition templates in Purchasing. See the Oracle iProcurement Implementation Manual.

Requisition Approved (Node 24)

This function activity sends a notification to the appropriate individual that the requisition has been approved.

This notification’s message uses Document type item attributes to call two PL/SQL functions, one that retrieves all of the lines in the document and displays them in the notification, and another that retrieves the action history of the document and displays that in the notification.

Print Document Process (Node 25)


Get AutoCreate PO Mode (Node 26)

While the function activity Get Workflow Approval Mode sets the processing mode for the entire approval workflow in Purchasing, based on how the profile option *PO: Workflow Processing Mode* is set, this function activity looks to the item attribute Send PO Autocreation to Background, which enables you to change the processing mode specifically for automatic purchase order creation. Background mode enables you to proceed to your next Purchasing activity while the approval process for this document completes in the background.

Wait for Background Process (Node 27)

If the item attribute Send PO Autocreation to Background is set to Yes, this function activity waits for the Workflow Background Engine to pick up this document for processing by the workflow. This activity enables you to proceed to your next Purchasing activity while the approval process for this document completes in the background.

Launch Create PO Workflow (Node 28)

After a requisition is approved, the Main Requisition Approval process launches a workflow for the automatic creation of purchase orders if you’ve allowed automatic approval for approved requisition lines. Automatic approval is allowed for approved requisition lines when the
Using the Account Generator in Oracle Public Sector Purchasing

item attribute Is Automatic Creation Allowed? is set to Y for Yes. (By default, this item attribute is set to Y.)

Summary of the Start of Approve Requisition Process

To view the properties of the Start of Approve Requisition Process, select the process in the navigator tree, then choose Properties from the Edit menu. This subprocess has a result type of PO Activity Performed, indicating that when the subprocess completes, it has a result of Activity Performed. This result corresponds to the lookup code in the PO Activity Performed lookup type in the PO Standard item type.

This process activity is not runnable, indicating that it cannot be initiated as a top–level process to run, but can be run only when called by another higher–level process.

This subprocess begins at node 1.

Node 2 removes previous notifications for this document if previous versions of the document that were sent to the workflow were incomplete or rejected. Node 3 sets startup values. Node 4 sets the requisition status to In Process.

Node 5 looks for an approval list created in iProcurement. (Here, node 5 finds the approval list and updates the Purchasing approval list tables. The activity Does Approval List Exist? in the Main Requisition Approval Process simply checks again for the approval list to determine how to branch in the Main process.)

Node 6 determines whether the requisition approval process is set up to run in Online or Background performance modes according to the profile option PO: Workflow Processing Mode, and if it is, node 7 waits for the background engine to begin. Node 8 retrieves requisition attributes (requisition information and internal Workflow attributes).
Start of Approve Requisition Process Activities

The following is a description of each activity in the Start of Approve Requisition Process, listed by the activity’s display name.

Remove All Notifications For This Document (Node 2)

This function activity removes previous notifications for a requisition previously submitted to workflow that was not completed because of an error or because of an action such as rejection.

Set Workflow Startup Values (Node 3)

This function activity sets all initial values necessary to identify a unique requisition.

Set Req Status to In–Process and Update with Item Type & Key (Node 4)

This function activity sets the document status to In Process and updates the document header with the item type and item key, which indicate that this requisition has been submitted to Workflow.

Find Approval List (Node 5)

This activity looks for an approval list created in iProcurement.

Get Workflow Approval Mode (Node 6)

This function activity retrieves the value from the profile option PO: Workflow Processing Mode, which lets you choose whether you want the approval process to run in Online or Background modes. For definitions of Background and Online modes, see: Profile Options in Purchasing: page 1 – 103.

Wait for Background Process (Node 7)

If the profile option PO: Workflow Processing Mode is set to Background, this function activity waits for the Workflow Background Engine to pick up this document for processing by the workflow. This activity enables you to proceed to your next Purchasing activity while the approval process for this document completes in the background. See: To Schedule Background Engines, Oracle Workflow Guide.
Get Requisition Attributes (Node 8)

This function activity retrieves key values from the requisition header and lines, and assigns them to Workflow attributes.

Summary of the Verify Requisition Subprocess

To view the properties of the Verify Requisition subprocess, select its process activity in the navigator tree, then choose Properties from the Edit menu. The Verify Requisition subprocess has a result type of PO Document Verification, indicating that when the subprocess completes, it has a result of Failed Verification or Passed Verification. These results correspond to the lookup codes in the PO Document Verification lookup type, in the PO Standard item type.

This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can only be run when called by another higher level process as a subprocess.

This subprocess activity makes sure the requisition is complete and the information is valid.
The subprocess begins at node 1.

Node 2 checks that the document status is compatible with an approval action (for example, its status is not closed, frozen, or on hold). Node 4 verifies that the document is complete, such as ensuring that it contains at least one line and one distribution.

If the document state does not allow an approval action at node 2 or the document is incomplete at node 4, a notification of such at node 8 or 9 respectively is sent to the requester. Then, at node 10, the requisition status is set back to what it was before it entered this subprocess, and the workflow ends at node 11. If you modify and resubmit the requisition or create a new one, the PO Requisition Approval workflow starts over again when you submit the requisition for approval.

If the document passes validation at nodes 2 and 4, node 6 records in the Action History window that the document has been submitted for approval.

If the Document Approval Manager fails at node 2 or 4, the notification activity at node 3 or 5 sends a notification of the failure to the requester. Once the Document Approval Manager is restarted successfully, the workflow continues if the requester or system administrator responds to the notification with Retry.


### Verify Requisition Subprocess Activities

The following is a description of each activity in the Verify Requisition subprocess, listed by the activity’s display name.

#### Start (Node 1)

This is a Standard function activity that simply marks the start of the subprocess.

#### Does Document State Allow Approval Action? (Node 2)

This activity checks if the document status is compatible with the approval action. Examples of document statuses that allow an approval action are Incomplete, In Process, and Pre-Approved.
Is Document Complete? (Node 4)

This activity verifies that the requisition is complete—for example, verifying that all the quantities match, and at least one line and one distribution exist.

Record Submit In Action History (Node 6)

This activity inserts a Submit Action row into the PO_ACTION_HISTORY table to record that the document has been submitted for approval. It also inserts an additional row with a null ACTION_CODE to simulate a forward–to action, since the document status is In Process. The document manager looks for this row.

Document Manager Failed (Nodes 3 and 5)

If the Document Approval Manager fails, the requester receives this notification that it failed. Once a system administrator successfully restarts the Document Approval Manager, the requester must respond to the notification by choosing Retry, so that the workflow can continue.

Document Failed State Check (Node 8)

This activity sends a notification to the requester that the document failed the state check. See: Document Status Checks: page 2 – 26.

Document Failed Correctness Check (Node 9)

This activity sends a notification to the requester that the document failed the correctness check. See: Document Submission Checks: page 2 – 27.

Set Req Status to Original Status (Node 10)

This function activity sets the document back to its status before it entered this process activity, if the document has failed state or correctness checks.

End (Nodes 7 and 11)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the
Verify Requisition subprocess activity has a result type of PO Document Verification, each End activity node must have a process result matching one of the lookup codes in the PO Document Verification lookup type.

Summary of the Reserve At The Start Subprocess

To view the properties of the Reserve At The Start subprocess, select its process activity in the navigator tree, then choose Properties from the Edit menu. The Reserve At The Start subprocess has a result type of PO Activity Performed, indicating that when the subprocess completes, it has a result of Activity Performed. This result corresponds to the lookup code in the PO Activity Performed lookup type, in the PO Standard item type.

This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can only be run when called by another higher level process as a subprocess.
The subprocess begins at node 1.

This subprocess, at node 7, tries to reserve funds at the start of the approval process for those requisitions created in iProcurement, if encumbrance is used.

First, node 2 checks if the requisition was created specifically in iProcurement. If it was, there is no need to check for an interface source of Requisition Import because iProcurement requisitions don’t use Requisition Import but are saved directly to the Oracle internal tables.

Node 3 checks specifically for requisitions created in Web Requisitions releases prior to iProcurement (if you still have some Web Requisitions requisitions in your system). These requisitions still pass through Requisition Import. See: Requisition Import: page 9 – 144.

If the Document Approval Manager fails at node 7, node 10 sends a notification of the failure to the requester. Once the Document Approval Manager is restarted successfully, the workflow continues if the requester or system administrator responds to the notification with Retry.

---

### Reserve At The Start Subprocess Activities

The following is a description of each activity in the Reserve At The Start subprocess, listed by the activity’s display name.

---

#### Start (Node 1)

This is a Standard function activity that simply marks the start of the subprocess.

#### Is Requisition Created Through the Web? (Node 2)

This activity determines if the requisition was created through iProcurement.

#### Is Interface Source Req Import? (Node 3)

This activity checks if the requisition sent through Requisition Import was created in Web Requisitions Release 11.
Is Encumbrance On and Is Document Not Reserved? (Node 5)
This function activity checks whether you are using encumbrance accounting, and whether the document is already reserved.

Reserve Document (Node 7)
This activity tries to reserve funds for the document.

Document Manager Failed (Node 10)
If the Document Approval Manager fails, the requester receives this notification that it failed. Once a system administrator successfully restarts the Document Approval Manager, the requester must respond to the notification by choosing Retry, so that the workflow can continue.

End (Nodes 4, 6, 8, and 9)
This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Reserve at the Start subprocess activity has a result type of PO Activity Performed, each End activity node must have a process result matching one of the lookup codes in the PO Activity Performed lookup type.

Summary of the Verify Approval Authority Subprocess
To view the properties of the Verify Approval Authority subprocess, select its process activity in the navigator tree, then choose Properties from the Edit menu. The Verify Approval Authority subprocess has a result type of Yes/No, indicating that when the subprocess completes, it has a result of Yes or No. This result corresponds to the lookup codes in the Yes/No lookup type, in the Standard item type.

This process activity is not runnable, indicating that it cannot be initiated as a top–level process to run, but rather can only be run when called by another higher level process as a subprocess.
The subprocess begins at node 1.

Node 2 checks the approver’s approval authority limits defined in the Approval Groups and Assign Approval Groups windows. (See: Defining Approval Groups: page 1 – 29. See: Assigning Approval Groups: page 1 – 33.)

If the person has enough authority to approve the document, the function activity Is Forward–To Provided? (which is outside this subprocess, in the overall workflow) begins. If not, then the process activity Find Approver (outside this subprocess) begins.

If the Document Approval Manager fails at node 2, node 3 sends a notification of the failure to the approver. Once the Document Approval Manager is restarted successfully, the workflow continues if the approver or system administrator responds to the notification with Retry.

---

**Verify Approval Authority Subprocess Activities**

The following is a description of each activity in the Verify Approval Authority subprocess, listed by the activity’s display name.
Start (Node 1)

This is a Standard function activity that simply marks the start of the subprocess.

Does Approver Have Authority? (Node 2)

This function activity verifies the approver’s authority based on the authority limits defined in the Approval Groups and Assign Approval Groups windows. See: Defining Approval Groups: page 1 – 29. See: Assigning Approval Groups: page 1 – 33.

Document Manager Failed (Node 3)

If the Document Approval Manager fails, the approver receives this notification that it failed. Once a system administrator successfully restarts the Document Approval Manager, the approver must respond to the notification by choosing Retry, so that the workflow can continue.

End (Nodes 4 and 5)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Verify Approval Authority subprocess activity has a result type of Yes/No, each End activity node must have a process result matching one of the lookup codes in the Yes/No lookup type.

Summary of the Approval List Routing Subprocess

To view the properties of the Approval List Routing subprocess, select the process in the navigator tree, then choose Properties from the Edit menu. The Approval List Routing subprocess has a result type of PO Approval List Routing Result, indicating that when the process completes, it has a result of Document Approved, Reject, or Return. These results correspond to the lookup codes in the PO Approval List Routing Result lookup type in the PO Standard item type.

This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only when called by another higher-level process.
This subprocess begins at node 1.

This subprocess starts when a requisition requires additional approval. Node 2 finds the first (or next) approver in the approval list. If that approver is invalid (for example, the approver left the organization shortly after the requisition was submitted), node 3 rebuilds the approval list without that approver. If node 3 cannot rebuild the approval list (for example, because of a system failure or a problem with the approval hierarchy), this subprocess ends at node 4, and the workflow returns the requisition to the requester.

At node 5, this subprocess branches differently depending on the approver’s response: a rejection branches to node 6, a Forward action branches to node 8, an approval branches to node 9, and an Approve And Forward action branches to node 10. Each of these nodes records the approver’s response in the PO_APPROVAL_LIST_HEADERS and PO_APPROVAL_LIST_LINES tables and updates the action history accordingly.
Node 11 checks if the approval list is empty before attempting to finish the approval routing. Node 12 checks if the requisition is Pre–Approved. (If the requisition has been approved, its status is set to Pre–Approved until the Approve Requisition subprocess or Reserve Before Approve subprocess later sets its status to Approved.)

Approval List Routing Subprocess Activities

The following is a description of each activity in the Approval List Routing subprocess, listed by the activity’s display name.

Get Next Approver (Node 2)

This activity finds the first (or next) approver in the approval list.

Rebuild Approval List for Invalid Approver (Node 3)

If an approver is invalid (for example, the approver left the organization shortly after the requisition was submitted), this activity rebuilds the approval list without that approver.

Note: If the approver does not have a logon user name, this activity does not rebuild the approval list in that instance.

Notify Approver (Node 5)


Response with Reject Action (Node 6)


Response with Approve Action (Node 9)


Response with Approve and Forward Action (Node 10)

Is Approval List Empty? (Node 11)

This activity makes sure there are no more approvers. If there are not, the workflow begins approving the requisition. If there are, the workflow routes the document for their approval.

Is Requisition Pre–Approved? (Node 12)

This function activity checks if the purchase order has been pre–approved. A Pre–Approved document is one that has already been approved by the appropriate individual, who also chose to forward it to yet another person for approval. Or, it is a document that has been authorized for approval but for which funds have not yet been reserved. A document is still considered pre–approved until the subprocess Reserve Before Approve or the subprocess Approve Requisition sets its status to Approved.

Summary of the Reject Requisition Subprocess

To view the properties of the Reject Requisition subprocess, select its process activity in the navigator tree, then choose Properties from the Edit menu. The Reject Requisition subprocess has a result type of PO Approval Action and Doc Verification, indicating that when the subprocess completes, it has a result of Invalid Action or Valid Action. These results correspond to the lookup codes in the PO Approval Action and Doc Verification lookup type, in the PO Standard item type.

This process activity is not runnable, indicating that it cannot be initiated as a top–level process to run, but rather can only be run when called by another higher level process as a subprocess.
The subprocess begins at node 1.

Node 2 changes the status of the document to Rejected. If the subprocess cannot reject the document (for example, the document status has changed to closed, frozen, or on hold,) node 5 sends a notification to the approver that the document could not be rejected. (If the document is rejected, a notification outside this subprocess in the Main Requisition Approval Process, sends the rejection notification.)

If the Document Approval Manager fails at node 2, node 4 sends a notification of the failure to the approver. Once the Document Approval Manager is restarted successfully, the workflow continues if the approver or system administrator responds to the notification with Retry.

**Reject Requisition Subprocess Activities**

The following is a description of each activity in the Reject Requisition subprocess, listed by the activity’s display name.

**Start (Node 1)**

This is a Standard function activity that simply marks the start of the subprocess.
Reject the Requisition (Node 2)

This activity sets a requisition to a Rejected status. It also reverses encumbrance if the document has been encumbered.

Unable to Reject Document (Node 5)

This activity sends a notification to the approver that Purchasing was unable to reject the document—for example, because its status is closed, frozen, or on hold.

Document Manager Failed (Node 4)

If the Document Approval Manager fails, the approver receives this notification that it failed. Once a system administrator successfully restarts the Document Approval Manager, the approver must respond to the notification by choosing Retry, so that the workflow can continue.

End (Nodes 3 and 6)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Reject Requisition subprocess activity has a result type of PO Approval Action and Doc Verification, each End activity node must have a process result matching one of the lookup codes in the PO Approval Action and Doc Verification lookup type.

Summary of the Return Requisition to Submitter Subprocess

To view the properties of the Return Requisition to Submitter subprocess, select its process activity in the navigator tree, then choose Properties from the Edit menu. The Return Requisition to Submitter subprocess has a result type of PO Activity Performed, indicating that when the subprocess completes, it has a result of Activity Performed. This result corresponds to the lookup code in the PO Activity Performed lookup type, in the PO Standard item type.

This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can only be run when called by another higher level process as a subprocess.
If the Approval List Routing subprocess activity (outside this subprocess activity, in the Main Requisition Approval process) doesn't find an approver, the Return Requisition to Submitter subprocess returns the requisition to the submitter.

The subprocess begins at node 1. Node 2 sets the document back to its status before it entered this subprocess. Node 3 sends the requester a notification that no approver was found. Node 5 sends the last approver a notification that no approver was found; however, if node 4 finds that the requester is also the sole or last approver, the subprocess skips node 5 and ends at node 6 so that the requester does not receive two notifications.

Return Requisition to Submitter Subprocess Activities

The following is a description of each activity in the Return Requisition to Submitter subprocess, listed by the activity’s display name.

Start (Node 1)
This is a Standard function activity that simply marks the start of the subprocess.

Set Req Status to Original Status (Node 2)
This activity sets the requisition back to its status before it entered this process activity, if no approver was found.
**Notify Requestor of No Approver Available (Node 3)**

This activity sends a notification to the requestor when no approver is found.

This notification’s message uses Document type item attributes to call two PL/SQL functions, one that retrieves all of the lines in the document and displays them in the notification, and another that retrieves the action history of the document and displays that in the notification.

**Is Submitter Last Approver? (Node 4)**

This function activity checks if the requester is also the sole or last approver. If so, the subprocess skips node 5 so as not to send the requester two notifications.

**Notify Last Approver of No Approver Found (Node 5)**

This activity sends a notification to the last approver that the next approver was not found.

This notification’s message uses Document type item attributes to call two PL/SQL functions, one that retrieves all of the lines in the document and displays them in the notification, and another that retrieves the action history of the document and displays that in the notification.

**End (Node 6)**

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Return Requisition to Submitter subprocess activity has a result type of PO Activity Performed, each End activity node must have a process result matching one of the lookup codes in the PO Activity Performed lookup type.
Summary of the Notify Approver Subprocess

To view the properties of the Notify Approver subprocess, select the process in the navigator tree, then choose Properties from the Edit menu. The Notify Approver subprocess has a result type of PO Document Approval Action, indicating that when the process completes, it has a result of Approve, Approve and Forward, Forward, or Reject. These results correspond to the lookup codes in the PO Document Approval Action lookup type in the PO Standard item type.

This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only when called by another higher-level process.
The subprocess begins at node 1.

Node 2 updates the action history. The action history records that the document awaits a response from the approver. (Other Update Action History function activities, used in other subprocesses, work together with this one to update the Action History window.)

Node 3 sends a notification to the approver that the document requires approval. If you have entered a Timeout in the Properties window for node 3, node 10 sends a reminder notification to the approver. The Timeout indicates how long the workflow waits before sending the reminder, if the approver does not respond. If you have entered a Timeout number for node 10, node 17 sends another reminder.

If the approver performs an Approve And Forward or a Forward action, nodes 4, 8, 11, 15, 18, and 22 make sure the forward-to is a valid user name.

The Approval List Routing subprocess, in which this subprocess is contained, behaves differently depending on how the approver responds here—with Approve And Forward, Approve, Reject, or Forward.

---

**Notify Approver Subprocess Activities**

The following is a description of each activity in the Notify Approver subprocess, listed by the activity’s display name.

**Update Action History (Expect Response) (Node 2)**

This activity records in the action history that the document awaits a response from the approver. This activity works in conjunction with the other Update Action History activities, used in other subprocesses, to update the Action History window.

**Approve Requisition Notification (Node 3)**

This activity sends a notification to the approver requesting approval.

This notification’s message uses Document type item attributes to call two PL/SQL functions, one that retrieves all of the lines in the document and displays them in the notification, and another that retrieves the action history of the document and displays that in the notification.
Requisition Approval Reminder1 (Node 10)

If no approval response is received after a period of time, this activity sends a first reminder if you designate a timeout period in the activity’s Properties window.

This notification’s message uses Document type item attributes to call two PL/SQL functions, one that retrieves all of the lines in the document and displays them in the notification, and another that retrieves the action history of the document and displays that in the notification.

Requisition Approval Reminder 2 (Node 17)

If still no approval response is received, this activity sends a second reminder if you’ve entered a timeout period in the activity’s Properties window.

This notification’s message uses Document type item attributes to call two PL/SQL functions, one that retrieves all of the lines in the document and displays them in the notification, and another that retrieves the action history of the document and displays that in the notification.

Is Forward–To Valid (Nodes 4, 8, 11, 15, 18, and 22)

This function activity checks that the Forward–To name entered in the Forward–To field, in response to an approval notification, is a valid user name.

Summary of the Response with Approve Action Subprocess

To view the properties of the Response with Approve Action subprocess, select the process in the navigator tree, then choose Properties from the Edit menu. The Response with Approve Action subprocess has a result type of None, indicating that when the process completes, it doesn’t end with a particular result, such as Approved or Rejected.

This process activity is not runnable, indicating that it cannot be initiated as a top–level process to run, but rather can only be run when called by another higher level process as a subprocess.
The subprocess begins at node 1.

Node 2 updates the Oracle internal approval list tables PO_APPROVAL_LIST_HEADERS and PO_APPROVAL_LIST_LINES with the approver’s approval. Node 3 updates the action history with an Approve action. Node 6 verifies that the approver has approval authority if the requisition has not yet been preapproved at node 4. Then, node 8 sets the requisition’s status to Pre–Approved. (Until the requisition is actually approved by the Approve Requisition subprocess or the Reserve Before Approve subprocess, the requisition is still considered Pre–Approved during this subprocess.)

Response with Approve Action Subprocess Activities

The following is a description of each activity in the Response with Approve Action subprocess, listed by the activity’s display name.

**Update Approval List Response (Node 2)**

This activity updates the Oracle internal approval list tables PO_APPROVAL_LIST_HEADERS and PO_APPROVAL_LIST_LINES with the approver’s approval.

**Update Action History (Approve) (Node 3)**

This activity records an Approve action action in the Action History window.

**Set Req Status to Pre–Approved (Node 8)**

A requisition’s status is set to Pre–Approved if any of the following has occurred:

- It has already been approved by the appropriate individual, who also chose to forward it to yet another person for approval.
- It has been authorized for approval but funds have not yet been reserved for it.
- The document has been approved but the subprocess Approve Requisition or the subprocess Reserve Before Approve has not yet set its status to Approved.

This activity updates the document status only, not the action history.

**Is Requisition Pre–Approved? (Node 4)**

This function activity checks if the purchase order has been pre–approved.

**Verify Approval Authority for Approve Action (Node 6)**

See: Verify Approval Authority for Approve Action: page C – 111.

---

**Summary of the Response with Approve and Forward Action Subprocess**

To view the properties of the Response with Approve and Forward Action subprocess, select the process in the navigator tree, then choose Properties from the Edit menu. The Response with Approve and Forward Action subprocess has a result type of None, indicating that when the process completes, it doesn’t end with a particular result, such as Approved or Rejected.

This process activity is not runnable, indicating that it cannot be initiated as a top–level process to run, but rather can only be run when called by another higher level process as a subprocess.

This subprocess begins at node 1.
Node 2 updates the Action History with an Approve and Forward action. If node 3 finds that the requisition has already been approved (considered Pre–Approved here), then this approver’s authority does not need to be verified at node 4. Node 6 updates the Oracle internal approval list tables PO_APPROVAL_LIST_HEADERS and PO_APPROVAL_LIST_LINES with the approver’s approval and forward action.

If node 3 finds that this requisition has not already been Pre–Approved, the approver’s approval authority is verified at node 4. If the approver does not have sufficient authority, node 6 updates the approval list tables, and the workflow (outside this subprocess) looks for the next approver with authority.

If the approver does have authority, node 5 sets the requisition status to Pre–Approved. (Until the requisition is actually approved by the subprocess Approve Requisition or the subprocess Reserve Before Approve, the requisition is still considered Pre–Approved during this subprocess.)

**Note:** The sequence of events in this subprocess is important. Node 6 depends on the information provided by nodes 2 and 5.

---

**Response with Approve and Forward Action Subprocess Activities**

The following is a description of each activity in the Response with Approve and Forward Action subprocess, listed by the activity’s display name.

**Update Action History (Approve/Forward) (Node 2)**

This activity records an Approve and Forward action in the Action History window.

**Verify Approval Authority for Approve and Forward Action (Node 4)**

See: Verify Approval Authority for Approve and Approve/Forward Action: page C – 111.

**Set Req Status to Pre–Approved (Node 5)**

A requisition’s status is set to Pre–Approved if any of the following has occurred:
It has already been approved by the appropriate individual, who also chose to forward it to yet another person for approval.

- It has been authorized for approval but funds have not yet been reserved for it.
- The document has been approved but the subprocess Approve Requisition or Reserve Before Approve has not yet set its status to Approved.

This activity updates the document status only, not the action history.

**Is Requisition Pre–Approved? (Node 3)**

This function activity checks if the requisition has been pre–approved.

**Update Approval List Response (Node 6)**

This activity updates the Oracle internal approval list tables PO_APPROVAL_LIST_HEADERS and PO_APPROVAL_LIST_LINES with the approver’s approval and forward action.

---

**Summary of the Response with Forward Action Subprocess**

To view the properties of the Response with Forward Action subprocess, select the process in the navigator tree, then choose Properties from the Edit menu. The Response with Forward Action subprocess has a result type of None, indicating that when the process completes, it doesn’t end with a particular result, such as Approved or Rejected.

This process activity is not runnable, indicating that it cannot be initiated as a top–level process to run, but rather can only be run when called by another higher level process as a subprocess.

This subprocess begins at node 1.
Node 2 updates the Oracle internal approval list tables PO_APPROVAL_LIST_HEADERS and PO_APPROVAL_LIST_LINES with the approver’s forward action. Node 3 updates the Action History window with the Forward action.

Response with Forward Action Subprocess Activities

The following is a description of each activity in the Response with Forward Action subprocess, listed by the activity’s display name.

**Update Approval List Response (Node 2)**

This activity updates the Oracle internal approval list tables PO_APPROVAL_LIST_HEADERS and PO_APPROVAL_LIST_LINES with the approver’s forward action.

**Update Action History (Forward) (Node 3)**

This activity records a Forward action in the Action History window.

Summary of the Response with Reject Action Subprocess

To view the properties of the Response with Reject Action subprocess, select the process in the navigator tree, then choose Properties from the Edit menu. The Response with Reject Action subprocess has a result type of None, indicating that when the process completes, it doesn’t end with a particular result, such as Approved or Rejected.

This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can only be run when called by another higher level process as a subprocess.
Node 2 updates the Oracle internal approval list tables PO_APPROVAL_LIST_HEADERS and PO_APPROVAL_LIST_LINES with the approver’s rejection. Node 3 updates the Action History window with a Reject action.

Response with Reject Action Subprocess Activities

The following is a description of each activity in the Response with Reject Action subprocess, listed by the activity’s display name.

Update Approval List Response (Node 2)

This activity updates the Oracle internal approval list tables PO_APPROVAL_LIST_HEADERS and PO_APPROVAL_LIST_LINES with the approver’s rejection.

Update Action History (Reject) (Node 3)

This activity records a Reject action in the Action History window.

Summary of the Reserve Before Approve Subprocess

To view the properties of the Reserve Before Approve subprocess, select the process in the navigator tree, then choose Properties from the Edit menu. The Reserve Before Approve subprocess has a result type of PO Reserve Before Approve, indicating that when the subprocess completes, it has a result of Forward, No, or Yes. These results correspond to the lookup codes in the PO Reserve Before Approve lookup type, in the PO Standard item type.

This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but can be run only when called by another higher-level process.
If node 2 finds that encumbrance is on and funds for the document are not yet reserved, node 4 attempts to reserve funds for the document.

If funds cannot be reserved, node 6 sends the notification Unable To Reserve Document to the approver. The approver must then use the Approve Document window to try to reserve the document again if, for example, more funds have been allocated, and then respond with Retry in the notification; reject the document; or forward the document to somebody else with authority to reserve the funds.

If the approver forwards the document, node 7 checks if the forward–to approver has a valid user name. If so, node 8 sets the Forward-To/From information for the new approver.

If the approver rejects the document, node 10 rejects the requisition. If it cannot reject the requisition (because the document failed the state check—for example, its status has changed to closed, frozen, or on hold), node 13 sends a notification to the approver that the document could not be rejected.

If the Document Approval Manager fails at node 4 or 10, the notification activity at node 5 or 11 sends a notification of the failure to the approver. Once the Document Approval Manager is restarted
successfully, the workflow continues if the approver or system administrator responds to the notification with Retry.

Reserve Before Approve Subprocess Activities

Following is a description of each activity in the Reserve Before Approve subprocess, listed by the activity’s display name.

Is Encumbrance On and Is Document Not Reserved? (Node 2)

This function activity checks whether you are using encumbrance accounting and whether the document is already reserved.

Reserve Document (Node 4)

This activity tries to reserve funds for the document.

Document Manager Failed (Nodes 5 and 11)

If the Document Approval Manager fails, the approver receives this notification that it failed. Once a system administrator successfully restarts the Document Approval Manager, the approver must respond to the notification by choosing Retry, so that the workflow can continue.

Unable to Reserve Document (Node 6)

This activity notifies the requester that Purchasing failed to reserve funds for the requisition, and provides instructions for resolving the failure. The approver must then use the Approve Document window to try to reserve the document again if, for example, more funds have been allocated, and then respond with Retry in the notification; reject the document; or forward the document to somebody else with authority to reserve the funds.

Is Forward–To Valid (Node 7)

This activity checks that the Forward–To name entered in the Forward–To field, in response to an approval notification, is a valid user name.
Set Forward–To/From Forward (Node 8)

If the approver responded to the notification Unable to Reserve Document by forwarding the document, this function activity resets the Forward–To and Forward–From attributes.

Reject the Requisition (Node 10)

This activity sets a requisition to a Rejected status and records the rejection in the Action History window. It also reverses encumbrance if the document has been encumbered.

Unable to Reject Document (Node 13)

This activity sends a notification to the approver that Purchasing was unable to properly reject the requisition—for example, because its status is closed, frozen, or on hold.

Summary of the Approve Requisition Subprocess

To view the properties of the Approve Requisition subprocess, select its process activity in the navigator tree, then choose Properties from the Edit menu. The Approve Requisition subprocess has a result type of PO Approval Action and Doc Verification, indicating that when the subprocess completes, it has a result of Invalid Action or Valid Action. These results correspond to the lookup codes in the PO Approval Action and Doc Verification lookup type, in the PO Standard item type.

This process activity is not runnable, indicating that it cannot be initiated as a top–level process to run, but rather can only be run when called by another higher level process as a subprocess.
The subprocess begins at node 1.

Node 2 checks if the document was already approved (for example, in the Reserve Before Approve subprocess). If so, this subprocess ends at node 3 and the workflow (in the Main Requisition Approval process), sends a notification to the requester that the document has been approved.

Otherwise, node 4 verifies that the document status is compatible with an approval action (for example, is not closed, frozen, or on hold), and node 6 verifies that the document is complete, such as ensuring that it contains at least one line and one distribution.

If the document does not allow an approval action at node 4 or is incomplete at node 6, the subprocess sends the appropriate notification at node 10 or 11 respectively. Then node 12 reverts the document status back to what it was before it entered this subprocess, and the workflow ends at node 13.

If the document passes the checks at nodes 4 and 6, node 8 approves the requisition, and node 14 retrieves requisition information and other internal workflow attributes, in case these have changed.

If the Document Approval Manager fails at node 4, 6, or 8, the notification activity at node 5, 7, or 9 sends a notification of the failure to the approver. Once the Document Approval Manager is restarted successfully, the workflow continues if the approver or system administrator responds to the notification with Retry.
Approve Requisition Subprocess Activities

The following is a description of each activity in the Approve Requisition subprocess, listed by the activity’s display name.

**Start (Node 1)**

This is a Standard function activity that simply marks the start of the subprocess.

**Is Document Approved? (Node 2)**

If you are using encumbrance and the document was Pre-Approved at the time that funds were reserved for it, then its status already changed to Approved.

**Does Document State Allow Approval Action? (Node 4)**

Examples of document statuses that allow an approval action are Incomplete, In Process, and Pre-Approved.

**Is Document Complete? (Node 6)**

This activity verifies that the requisition is complete—for example, verifying that all the quantities match, and at least one line and one distribution exist.

**Approve the Requisition (Node 8)**

This activity sets the status of the requisition to Approved.

**Get Requisition Attributes (Node 14)**

This function activity retrieves key values from the requisition header and lines, in case these have changed, and assigns them to Workflow attributes.
Document Manager Failed (Nodes 5, 7, and 9)

If the Document Approval Manager fails, the approver receives this notification that it failed. Once a system administrator successfully restarts the Document Approval Manager, the approver must respond to the notification by choosing Retry, so that the workflow can continue.

Document Failed State Check (Node 10)

This function activity sends a notification to the approver that the document failed the state check. See: Document Status Checks: page 2 – 26.

Document Failed Correctness Check (Node 11)

This function activity sends a notification to the approver that the document failed the correctness check. See: Document Submission Checks: page 2 – 27.

Set Req Status to Original Status (Node 12)

This function activity sets the requisition back to its original status, if the document has failed state or correctness checks.

End (Nodes 3 and 13)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Approve Requisition subprocess activity has a result type of PO Approval Action and Doc Verification, each End activity node must have a process result matching one of the lookup codes in the PO Approval Action and Doc Verification lookup type.

Summary of the Print Document Subprocess

To view the properties of the Print Document subprocess, select its process activity in the navigator tree, then choose Properties from the Edit menu. The Print Document subprocess has a result type of PO Activity Performed, indicating that when the subprocess completes, it has a result of Activity Performed. This result corresponds to the
lookup code in the PO Activity Performed lookup type, in the PO Standard item type.

The subprocess begins at node 1.

Node 2 checks if Print was selected in the Approve Document window when the requisition was first submitted for approval. If Print was selected, node 4 prints the document.

**Print Document Subprocess Activities**

The following is a description of each activity in the Print Document subprocess, listed by the activity’s display name.

**Start (Node 1)**

This is a Standard function activity that simply marks the start of the subprocess.

**Does User Want Document Printed? (Node 2)**

This activity checks if Print was selected when the requisition was first submitted.

**Print Document (Node 4)**

If Print was selected when the requisition was first submitted, this activity prints the document.
End (Nodes 3 and 5)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Print Document subprocess activity has a result type of PO Activity Performed, each End activity node must have a process result matching one of the lookup codes in the PO Activity Performed lookup type.

Summary of the Verify Approval Authority for Approve and Approve/Forward Action Subprocesses

To view the properties of the Verify Approval Authority for Approve Action subprocess or the Verify Approval Authority for Approve and Forward Action subprocess, select the process in the navigator tree, then choose Properties from the Edit menu. This subprocess has a result type of Yes/No, indicating that when the subprocess completes, it has a result of Yes or No. This result corresponds to the lookup code in the Yes/No lookup type in the Standard item type.

This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but can be run only when called by another higher-level process.
The Verify Approval Authority for Approve Action subprocess is called by the Response with Approve Action subprocess to verify an approver’s approval authority. The Verify Approval Authority for Approve and Forward Action subprocess is called by the Response with Approve and Forward Action subprocess to verify an approver’s approval authority.

The subprocess begins at node 1.

At node 2, the subprocess checks the approver’s approval authority limits defined in the Approval Groups and Assign Approval Groups windows. (See: Defining Approval Groups: page 1 – 29. See: Assigning Approval Groups: page 1 – 33.)

If the Document Approval Manager fails at node 2, node 3 sends a notification of the failure to the approver. Once the Document Approval Manager is restarted successfully, the workflow continues if the approver or system administrator responds to the notification with Retry.

Except for their names, the subprocess Verify Approval Authority for Approve Action and the subprocess Verify Approval Authority for Approve and Forward Action are identical. They are named differently because they are used by two different subprocesses.
Verify Approval Authority Subprocess Activities

The following is a description of each activity in the Verify Approval Authority for Approve Action subprocess and the Verify Approval Authority for Approve and Forward Action subprocess, listed by the activity’s display name.

**Does Approver Have Authority? (Node 2)**

This function activity verifies the approver’s authority based on the authority limits defined in the Approval Groups and Assign Approval Groups windows. See: Defining Approval Groups: page 1–29. See: Assigning Approval Groups: page 1–33.

**Document Manager Failed (Node 3)**

If the Document Approval Manager fails, the approver receives this notification that it failed. Once a system administrator successfully restarts the Document Approval Manager, the approver must respond to the notification by choosing Retry, so that the workflow can continue.
**Purchase Order Approval Workflow**

Whenever you submit a purchase order or release for approval or take an action in the Notifications Summary window, Purchasing uses Oracle Workflow technology in the background to handle the approval process. Workflow uses the approval controls and hierarchies you define according to the setup steps in the section to route documents for approval. You can use the Workflow Builder interface to modify your approval process.

The purchase order approval workflow consists of processes, which are viewable in the Workflow Builder as a diagram, some of whose objects and properties you can modify. Each workflow process, in turn, consists of individual function activities.

The PO Approval workflow is initiated at the following points in Purchasing:

- When you choose Submit for Approval (and then choose OK) in the Approve Document window. See: Submitting a Document for Approval: page C – 35.

- When you respond to a reminder in the Notifications Summary window reminding you to submit a document for approval that has not yet been submitted.

For information on the requisition approval workflow, see: Requisition Approval Workflow: page C – 57.

**Customizing the PO Approval Workflow**

Use the Oracle Workflow Builder to customize workflows. When you customize a workflow, only those documents that are submitted for approval after you have customized it are affected by the customized workflow.

You can also use the Workflow Builder to create unique approval workflows for each document type in your organization. You associate particular workflows with certain document types in the Document Types window. See: Defining Document Types: page 1 – 87.

You can use the Workflow Monitor to follow where certain documents are in a workflow process. See: Workflow Monitor, Oracle Workflow Guide.
To display the workflow in the Oracle Workflow Builder:

1. Choose Open from the File menu, and connect to the database.
   See: Opening and Saving Item Types, Oracle Workflow Guide.
   The Display name of the PO Approval workflow is **PO Approval**.
   The name of its Workflow definition file is `poxwfpoa.wft`.

2. Expand the data source, then the PO Approval item type branch within that data source.

3. Expand the Processes branch within the PO Approval branch, then double-click a process activity to display its diagram.

Creating a New Custom Process

You can either modify the default PO Approval workflow that Purchasing provides, or copy it and create a whole new workflow. Use the Document Types window to select a custom PO Approval Workflow Startup Process for specific document types or operating units.

If you create different workflows for different documents or operating units, the recommended practice is not to copy and rename the item type (such as PO Approval 1), but to copy and rename the Workflow Startup Process, which you will modify to call your own custom subprocesses. All of your operating units will point to the same item type, and will use the default item attributes and other activities that
the item type requires, but one operating unit will also use your custom startup process.

**Attention:** Creating a new workflow process with a new Internal Name affects the implementation of future upgrades. See: Upgrade Support: page C – 5.

**Required Modifications**

There are no required modifications you need to make to the PO Approval workflow. However, this documentation assumes that you have already set up Purchasing and performed the Workflow setup steps described in Workflow Setup Options: page 1 – 95.

**Supported and Unsupported Customizations**

The following is a discussion of what you can and *definitely cannot* modify in the PO Approval workflow. For those things you *can* modify, the discussion includes important guidelines that you need to be careful of when making customizations.

For important information on how to customize workflows, see the *Oracle Workflow Guide*.

To further help you with your customizations, refer to the sections later in this document, starting with The PO Approval Item Type: page C – 120. These sections describe the components of the main processes in the PO Approval workflow. If you haven’t already, see also: Customization Guidelines: page C – 5.

**Attention:** If a particular Workflow object does not appear in the following sections on the lists of things you can customize, do not modify it, regardless of its access level.

**Attributes**

You can modify the following attributes only, by changing their Default Value:

- Change Order Header Blanket Total Tolerance
- Change Order Header Amount Limit Tolerance
- Change Order Header Purchase Order Total Tolerance
- Change Order Line Quantity Tolerance
- Change Order Line Unit Price Tolerance
• Change Order Line Quantity Committed Tolerance
• Change Order Line Agreed Amount Tolerance
• Change Order Line Price Limit Tolerance
• Change Order Shipment Price Override Tolerance
• Change Order Shipment Quantity Tolerance
• Change Order Distribution Quantity Ordered Tolerance

For information about how to modify these attributes, see: Workflow Processes for Approving Change Orders: page C – 171.

Processes

If you modify a process, it is essential that the basic flow remain intact to maintain data integrity in the database. For example, you should not remove or bypass the function activity Is Document Complete? in the Verify PO subprocess because this may allow incomplete data to be inserted into the database tables. However, you could add additional checks (processes or function activities) before allowing data to be inserted into the tables.

If you modify any process, either by replacing a portion of its flow or by adding additional function activities, remember the following:

• Attributes that are set by default function activities in the default processes must also be set if you replace default function activities with ones of your own. That is, if a function activity in that process uses a SetItemAttr statement, then that function activity is setting an attribute to be used by another function activity later. Therefore, your new function activity must do the same. You should also preserve SetItemUserKey and SetItemOwner statements, if any. (Depending on your customizations, you may also want to preserve GetItemAttr statements.)

• Any database state maintained by the default processes must also be maintained by processes you customize. That is, if a function activity in that process uses an Update or Insert Into statement, then that function activity is updating or inserting rows in the database. Therefore, your new function activity must maintain the same database state.

To get a list of the workflow function activities that use SetItemAttr, GetItemAttr, SetItemUserKey, SetItemOwner, Insert Into, or Update statements, run
the PL/SQL script `powfcust`. For instructions on running this script, see: Customization Guidelines: page C – 5.

The processes listed below may be modified as your business processes require; however, remember that after your customizations, the attributes that were set and the database states that were maintained by the default process must also be set or maintained by your customized process:

- Do Document Changes Require Reapproval?
- Find Approver
- Get All Blanket PO Changes
- Get All Contract PO Changes
- Get All Planned PO Changes
- Get All Release Changes
- Get All Standard PO Changes
- Notify Approver
- Print Document Process
- Print Document Process (Change Order)
- Fax Document Process
- Fax Document Process (Change Order)

You may add your own additional function activities to the processes listed below, but do not remove any default function activities from them:

- Approve and Forward PO
- Approve PO
- Approve PO (Change Order)
- Change Order Reserve Before Approve
- Forward PO
- Get All Document Changes
- PO Approval Process
- PO Approval Top Process
- Reject PO
- Reserve Before Approve
- Return PO to Submitter
• Verify Approval Authority
• Verify PO

Notifications

All of the notifications can be modified to meet your individual public sector needs. However, if the notification has a reply code, make sure that the Result Type of your customized notification matches the transitions in the workflow diagram. See: To Create a Notification Activity, Oracle Workflow Guide. See also: Message Result, Oracle Workflow Guide and To Create a Message, Oracle Workflow Guide.

Function Activities

You cannot modify any function activities in the PO Approval workflow.

However, you can replace some function activities with function activities of your own. When you replace a function activity, you are modifying the process in which it is contained. See the guidelines for customizing the PO Approval processes in the section Processes above.

If you substitute default function activities in a process with function activities that you create, you must remember the following:

• The result type of your new function activity must match the result type of the default activity. That is, the Result Type of function activity in the Workflow Builder—for example, a Result Type of Yes/No—needs to match the result type that you specify in that function activity’s corresponding PL/SQL procedure. It also means that if you have, for example, two results (such as Yes and No) in your function activity and corresponding PL/SQL procedure, you need to make sure that there are two corresponding transitions in the workflow diagram (one for Yes and one for No). If you alter the result types and transitions in a process, be careful that you aren’t deleting or bypassing any special transitions or checks.

• Just as in the section Processes above, any attributes that were set by the default function activity must also be set by your customized function activity.

• Just as in the section Processes above, any database state maintained by the default function activity must also be maintained by the customized function activity.
Messages

All of the messages can be modified to meet your individual public sector needs.

Lookup Types

All of the lookup types can be modified to meet your individual public sector needs.

Note: If you change a lookup type, you must be sure that all activities that use the lookup type allow for the change. For example, if you change the lookup type from Yes/No to something else, the activities that use that lookup type should also change their Result Type from Yes/No to whatever new lookup type you created. See: Lookup Types, Oracle Workflow Guide.

The PO Approval Item Type

The purchase order approval process is associated with an item type called PO Approval. This item type identifies all purchase order and release approval workflow processes available. The following workflow processes are associated with PO Approval:

- PO Approval Top Process: page C – 126
- PO Approval Process: page C – 132
- Approve And Forward PO: page C – 151
- Approve PO: page C – 146
- Approve PO (Change Order) *
- Change Order Reserve Before Approve *
- Do Document Changes Require Reapproval? *
- Find Approver: page C – 159
- Forward PO: page C – 163
- Get All Blanket PO Changes *
- Get All Contract PO Changes *
- Get All Document Changes *
- Get All Planned PO Changes *
• Get All Release Changes *
• Get All Standard PO Changes *
• Notify Approver: page C – 155
• Print Document Process: page C – 149
• Fax Document Process: page C – 149
• Print Document Process (Change Order) *
• Fax Document Process (Change Order) *
• Reject PO: page C – 167
• Reserve Before Approve: page C – 140
• Return PO to Submitter: page C – 165
• Verify Approval Authority: page C – 144
• Verify PO: page C – 137

* These are Change Order workflow process, described in a separate section. See: Workflow Processes for Approving Change Orders: page C – 171.

The PO Approval item type also has many attributes associated with it. These attributes reference information in the Purchasing application tables. The attributes are used and maintained by function activities as well as notification activities throughout the process.

The following table shows the PO Approval Workflow item type attributes.

**PO Approval Workflow Item Type Attributes**

<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/ Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action History of the Document</td>
<td>Action history of the document as displayed in the approval notification</td>
<td>Document</td>
<td></td>
</tr>
<tr>
<td>Application ID</td>
<td>Unique identifier for the application (such as Purchasing)</td>
<td>Number</td>
<td></td>
</tr>
</tbody>
</table>

Attention: All of the Change Order item attributes are described in the Change Order Workflow section. See: Workflow Processes for Approving Change Orders: page C – 171.
<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Path ID</td>
<td>Unique identifier for the approval hierarchy</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Approver Employee ID</td>
<td>Unique identifier for the approver</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Approver Display Name</td>
<td>Approver’s name as displayed in Purchasing</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Approver User Name</td>
<td>User name of the approver</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Authorization Status</td>
<td>Status of the document, such as Approved or Incomplete</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Authorization Status Display</td>
<td>Document status as displayed in Purchasing</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Closed Code</td>
<td>Indicator that the document is closed</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Closed Code Display</td>
<td>Closed status as displayed in Purchasing</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Concurrent Request ID</td>
<td>Request ID for the Document Approval Manager</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Context ORG_ID</td>
<td>Unique identifier for the organization</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Document ID</td>
<td>Unique identifier for the document</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Document Manager Error Number</td>
<td>Error number for the Document Manager Failed notification</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Document Submitted by Web Supplier</td>
<td>Indicator of whether the change to the document was made through Oracle Supply Management Portal</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Document Subtype</td>
<td>Document subtype, such as Blanket</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Document Subtype Display</td>
<td>Document subtype as displayed in Purchasing</td>
<td>Text</td>
<td>25</td>
</tr>
</tbody>
</table>

Table C – 7 (Page 2 of 6)
<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/ Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Type</td>
<td>Document type, such as Purchase Order</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Document Type Display</td>
<td>Document type as displayed in Purchasing</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Fax Document</td>
<td>Indicator of whether Fax was selected when submitting the document for approval</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Fax Number</td>
<td>Facsimile number entered when submitting the document for approval</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Forward From Display Name</td>
<td>Name of the forward–from person as displayed in Purchasing</td>
<td>Text</td>
<td>60</td>
</tr>
<tr>
<td>Forward From ID</td>
<td>Unique identifier for the forward–from person</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Forward From User Name</td>
<td>User name for the forward–from person</td>
<td>Text</td>
<td>60</td>
</tr>
<tr>
<td>Forward To Display Name</td>
<td>Name of the forward–to person as displayed in Purchasing</td>
<td>Text</td>
<td>60</td>
</tr>
<tr>
<td>Forward To ID</td>
<td>Unique identifier for the forward–to person</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Forward–To ID Old Value</td>
<td>Item attribute for internal use that keeps track of the previous forward–to person</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Forward To User Name</td>
<td>User name for the forward–to person</td>
<td>Text</td>
<td>60</td>
</tr>
<tr>
<td>Functional Currency</td>
<td>Functional currency</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Interface Source</td>
<td>Source of the document, such as ICX or POR</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Interface Source Line ID</td>
<td><em>(Not currently used)</em></td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>“Invalid Forward To” Translated Message</td>
<td>Message used when approving the document if the forward–to user name is invalid</td>
<td>Text</td>
<td></td>
</tr>
</tbody>
</table>

Table C–7  (Page 3 of 6)
<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Number Translated</td>
<td>Translation for “Line Number”</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Note</td>
<td>Note to the approver</td>
<td>Text</td>
<td>240</td>
</tr>
<tr>
<td>Online Report ID For Doc Complete Check</td>
<td>Unique identifier for the error message displayed after saving a document that is in error</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Online Report Text For Doc Complete Check</td>
<td>Text of the error message displayed after saving a document that is in error</td>
<td>Text</td>
<td>2000</td>
</tr>
<tr>
<td>Open Document</td>
<td>Command that Purchasing sends to open the document from the notification</td>
<td>Form</td>
<td></td>
</tr>
<tr>
<td>Original Authorization Status</td>
<td>Status of the document before it was submitted for approval</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>PL/SQL Error Document</td>
<td>The document that was being approved when a PL/SQL error occurred</td>
<td>Text</td>
<td>2000</td>
</tr>
<tr>
<td>PL/SQL Error Location</td>
<td>Where an internal, PL/SQL error occurred</td>
<td>Text</td>
<td>2000</td>
</tr>
<tr>
<td>PL/SQL Error Message</td>
<td>Text for the notification sent when a PL/SQL error occurs</td>
<td>Text</td>
<td>2000</td>
</tr>
<tr>
<td>PO Amount</td>
<td><em>(Not currently used)</em></td>
<td>Text</td>
<td>30</td>
</tr>
<tr>
<td>PO Amount Display</td>
<td>Total amount, without tax, as displayed in Purchasing</td>
<td>Text</td>
<td>30</td>
</tr>
<tr>
<td>PO Approval Headers Message</td>
<td>Message header that indicates the specific document requiring approval</td>
<td>Document</td>
<td></td>
</tr>
<tr>
<td>PO Description</td>
<td>Header description</td>
<td>Text</td>
<td>240</td>
</tr>
<tr>
<td>PO Lines Details</td>
<td>Purchase order line details displayed in the approval notification</td>
<td>Document</td>
<td></td>
</tr>
<tr>
<td>PO Number</td>
<td>Purchase order number</td>
<td>Text</td>
<td>20</td>
</tr>
<tr>
<td>Display Name</td>
<td>Description</td>
<td>Type</td>
<td>Length/Format/Lookup Type</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>PO Type</td>
<td><em>(Not currently used)</em></td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Preparer Display Name</td>
<td>Name of the person who created the document, as displayed in Purchasing</td>
<td>Text</td>
<td>80</td>
</tr>
<tr>
<td>Preparer ID</td>
<td>Unique identifier for the person who created the document</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Preparer User Name</td>
<td>User name for the person who created the document</td>
<td>Text</td>
<td>60</td>
</tr>
<tr>
<td>Print Document</td>
<td>Indicator of whether Print Document was selected when submitting the document for approval</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Release Num</td>
<td>Release number</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Release Num Dash Separator</td>
<td>Separator symbol, such as a dash, used in the release number</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Release Type</td>
<td>Release type such as Blanket or Scheduled</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>&quot;Requires Approval&quot;</td>
<td>Type: <em>Blanket</em> or <em>Scheduled</em></td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Translated Message</td>
<td>Message text used to indicate the document requires approval</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Response Forward–To</td>
<td>Forward–to name as entered by the person forwarding the document</td>
<td>Text</td>
<td>100</td>
</tr>
<tr>
<td>Responsibility ID</td>
<td>Unique identifier for the document preparer’s user responsibility</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>System Administrator Error Message</td>
<td>Document Approval Manager failed message</td>
<td>Text</td>
<td>2000</td>
</tr>
<tr>
<td>Tax Amount Display</td>
<td>Tax amount displayed in the approval notification</td>
<td>Text</td>
<td>30</td>
</tr>
</tbody>
</table>

Table C – 7  (Page 5 of 6)
<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Amount Display</td>
<td>Total document amount, with tax, displayed in the approval notification</td>
<td>Text</td>
<td>30</td>
</tr>
<tr>
<td>User ID</td>
<td>Unique identifier for the document preparer</td>
<td>Number</td>
<td></td>
</tr>
</tbody>
</table>

Table C – 7  (Page 6 of 6)

**Summary of the PO Approval Top Process**

To view the properties of the PO Approval Top Process, select the process in the navigator tree, then choose Properties from the Edit menu. The PO Approval Top Process has a result type of None, indicating that when the process completes, it doesn’t end with a particular result, such as Approved or Rejected. Instead, its subprocesses end with specific results.

This process activity is runnable, indicating that it can be initiated as a top–level process to run by making calls to the Workflow Engine CreateProcess and StartProcess APIs.

The Details property page of the process activity indicates that the PO Approval Top Process has an error process called DEFAULT_ERROR associated with it, which gets initiated only when an error is encountered in the process. For example, if you attempt to initiate the PO Approval Top Process with a purchase order that is created by someone who is not listed in the employee approval hierarchy, the Workflow Engine would raise an error when it tries to execute the Find Approver activity. This error would initiate DEFAULT_ERROR, which is associated with the System:Error item type. Currently the process simply executes the standard Default Error Notification activity to provide information associated with the error. You can customize the process further to suit your needs. See: Default Error Process, Oracle Workflow Guide.

The PO Approval workflow begins when you submit a purchase order for approval in Purchasing, or respond to a reminder notification to submit a purchase order for approval.
Using the Account Generator in Oracle Public Sector Purchasing
The workflow begins at node 1.

Node 2 removes previous purchase order notifications for this document if previous versions of the document sent to the workflow were incomplete or rejected.

Node 3 sets startup values, node 5 sets the purchase order status to In Process, node 6 determines whether the process is set up to run in Online or Background performance modes according to the profile option PO: Workflow Processing Mode, and node 8 retrieves purchase order attributes (purchase order information and internal workflow attributes). For more detail on these startup activities, see the next section.

Node 9 checks if the document requires reapproval because the supplier made a change (for example, to the Promised or Need–By Date) through Oracle iSupplier Portal. If the supplier’s change was approved through iSupplier Portal, the document is approved directly rather than submitted for change order or full reapproval.

**Note:** Node 9 enables you to approve any change made through iSupplier Portal. If you were to delete node 9, any change a supplier makes through iSupplier Portal would be treated like any other document change in the change order workflow. See: Workflow Processes for Approving Change Orders: page C – 171.

Node 10 checks if the document is new. If it is, the workflow moves from node 10 to the Main PO Approval Process at node 14 to approve the document. If the document is not new, the change order workflow begins if your Purchasing setup (in the Document Types window) archives documents on approval (the Change Order workflow cannot work without this setup). The change order workflow gathers all document changes at node 12; determines at node 13 if those changes require manual reapproval or can simply be approved automatically; attempts at node 16 to reserve funds for the document if encumbrance accounting is used; approves the changes at node 18; sends a notification at node 20 that the document was approved; and, if Print was selected in the Approve Document window, prints the document at node 21. If a facsimile number was entered in the Approve Document window, node 22 sends a facsimile of the purchase order.

---

**PO Approval Top Process Activities**

The following is a description of each activity in the PO Approval Top Process listed by the activity’s display name. You can create all the
components for an activity in the graphical Workflow Builder except for the PL/SQL stored procedures that the function activities call. All function activities execute PL/SQL stored procedures which you must create and store in the Oracle RDBMS. The naming convention for the PL/SQL stored procedures is:

\(<\text{PACKAGE}>\).\(<\text{PROCEDURE}>\)

\(<\text{PACKAGE}>\) is the name of the package that groups all of the procedures. \(<\text{PROCEDURE}>\) represents the name of the procedure.

To view the package and procedure names used by the PO Approval processes, view the Properties page for each function activity. For example, the function activity Remove All Notifications For This Document uses the \(<\text{PACKAGE}>\).\(<\text{PROCEDURE}>\) name \text{PO_REQAPPROVAL_INIT1.REMOVE_REMINDER}.

You can use the Item Type Definitions Web page to view \(<\text{PACKAGE}>\).\(<\text{PROCEDURE}>\) names. See: Item Type Definitions Web Page, Oracle Workflow Guide.

Start (Node 1)

This is a Standard function activity that simply marks the start of the process.

Remove All Notifications For This Document (Node 2)

This function activity removes previous notifications for a purchase order previously submitted to the workflow that was not completed because of an error or because of an action such as rejection.

Set Workflow Startup Values (Node 3)

This function activity sets all initial values necessary to identify a unique purchase order, such as the preparer’s user name and a forward-to user name.

Update PO Header with Workflow Key (Node 4)

This function activity updates the document header with the item type and item key, which indicate that the purchase order has been submitted to the workflow.
Set PO Status to “In Process” (Node 5)

When you submit a purchase order for approval, its status changes to In Process.

Get Workflow Approval Mode (Node 6)

This function activity retrieves the value from the profile option PO: Workflow Processing Mode, which lets you choose whether you want the approval process to run in Online or Background modes. For definitions of Background and Online modes, see: Profile Options in Purchasing: page 1 – 103.

Wait for Background Process (Node 7)

If the profile option PO: Workflow Processing Mode is set to Background, this function activity waits for the Workflow Background Engine to pick up this document for processing by the workflow. This activity enables you to proceed to your next Purchasing activity while the approval process for this document completes in the background.

Get PO Attributes (Node 8)

This function activity retrieves key values from the purchase order header and lines, and assigns them to Workflow attributes.

Is Change Initiated from Web Suppliers? (Node 9)

This is a Standard Workflow comparison activity that provides a standard way to compare two numbers, dates, or text strings. Here, this activity is used to check the item attribute Document Submitted by Web Supplier. If the document change was approved through Oracle iSupplier Portal (the item attribute is Y for Yes), the document is approved directly rather than submitted for change order or full reapproval.


Is This a New Document? (Node 10)

This function activity checks whether the purchase order is new or a change to an existing purchase order. (If there is no APPROVED_DATE, it considers the document new.) If it’s new, the purchase order goes through the PO Approval Process. If it’s a change
to an existing purchase order, it goes through the change order
approval process if the document type is set to Archive on Approval.

Is Archive on Approval Flag Set to Yes? (Node 11)
This function activity checks if the document type is set to Archive on
Approval or Archive on Print in the Document Types window. See:
Defining Document Types: page 1 – 87. If it’s set to Archive on
Approval and the previously approved document has been modified,
then the workflow processes for approving changed purchase orders or
releases begins. If it’s set to Archive on Print, then the document goes
through the full approval process.

PO Approval Process (Node 14)

Get All Document Changes (Node 12)

Do Document Changes Require Reapproval? (Node 13)

Change Order Reserve Before Approve (Node 16)
See: Change Order Reserve Before Approve: page C – 199.

Approve PO (Change Order) (Node 18)

PO Approved (Node 20)
This function activity sends a notification to the appropriate individual
that the purchase order has been approved.
This notification’s message uses Document type item attributes to call
two PL/SQL functions, one that retrieves all of the lines in the
document and displays them in the notification, and another that
retrieves the action history of the document and displays that in the
notification.
Print Document Process (Change Order) (Node 21)

Fax Document Process (Change Order) (Node 22)

PL/SQL Error Occurs
This notification activity does not appear in any process diagram, but is used by the workflow in case an internal, PL/SQL error occurs when a function activity performs. If such an error occurs, this notification activity sends a notification to the document owner or approver that a Workflow error has occurred.

Summary of the PO Approval Process
To view the properties of the PO Approval process, select the process in the navigator tree, then choose Properties from the Edit menu. The PO Approval process has a result type of PO Main Requisition Approval Process Result, indicating that when the process completes, it has a result of Approved, Invalid Action, No Approver Available, or Rejected. These results correspond to the lookup codes in the PO Main Requisition Approval Process Result lookup type in the PO Standard item type.

This process activity is not runnable, indicating that it cannot be initiated as a top–level process to run, but rather can be run only as a subprocess when called by a higher–level process.

The PO Approval Process is initiated when a new purchase order is submitted for approval or when changes to a purchase order require going through the full approval process.
The workflow begins at node 1.

If the purchase order passes verification at node 2, node 4 checks if Owner Can Approve in the Document Types window is enabled for the document type. If node 5 finds that the owner has approval authority, node 6 checks if the owner has provided an additional forward-to approver. If so, node 7 approves and forwards the purchase order, and node 8 notifies the approver. Otherwise, the workflow begins to approve the document at node 9.

If the approver approves, or approves and forwards the document, node 12 checks if the resulting document status is Pre–Approved. A pre–approved document is one that has been approved by the final approver, but also forwarded to an additional approver, or one that has been authorized for approval but for which funds have not yet been reserved, if you use encumbrance accounting. In this process, even after the document is approved, it is still considered pre–approved until the subprocess at node 9 or 23 sets its status to Approved. If the document is not pre–approved, the workflow verifies the approver’s current approval authority at node 5.

The Find Approver subprocess at node 13 begins if the approver forwards the document for additional approval or does not respond, or if the activities at nodes 4 or 5 find that the document owner does not have approval authority. If an approver is found at node 13, node 16 checks if the user name of the approver is valid. If so, node 17 forwards the purchase order to the approver. If the Find Approver activity is not successful, or if the approver user name is invalid, the purchase order is returned to the submitter at node 14.

Once an approver is found, the workflow branches differently depending on how the approver responds in the subprocess at node 8—with Forward, Timeout (no response), Approve, Approve And Forward, or Reject. If the approver rejects the document, a notification as such is sent to the buyer (document owner) at node 21.

Once all approvers have approved the document, node 9 attempts to reserve funds for the document before approval if encumbrance accounting is being used and funds for the document are not already reserved. Then, node 23 approves the purchase order, sends a document–approved notification to the document owner at node 25, and prints the document at node 26 if Print was selected in the Approve Document window when the purchase order was first submitted. If a facsimile number was entered in the Approve Document window, node 27 sends a facsimile of the purchase order.
PO Approval Process Activities

The following is a description of each activity in the PO Approval Process, listed by the activity’s display name.

**Start (Node 1)**

This is a Standard function activity that simply marks the start of the process.

**Verify PO (Node 2)**

See: Verify PO: page C – 137.

**Can Owner Approve? (Node 4)**

This function activity checks if Owner Can Approve is enabled for the specific document type in the Document Types window. See: Defining Document Types: page 1 – 87. If the owner can approve, the subprocess Verify Approval Authority verifies the owner’s approval authority. If not, the subprocess Find Approver begins.

**Verify Approval Authority (Node 5)**

See: Verify Approval Authority: page C – 144.

**Find Approver (Node 13)**


**Return PO to Submitter (Node 14)**

See: Return PO to Submitter: page C – 165.

**Is Forward–To Provided? (Node 6)**

This function activity checks if a forward–to person was provided in the Approve Document or Notifications Summary windows.

**Approve and Forward PO (Node 7)**

See: Approve And Forward PO: page C – 151.
Forward PO (Node 17)
See: Forward PO: page C – 163.

Notify Approver (Node 8)

Is PO Pre–Approved? (Node 12)
This function activity checks if the purchase order has been
pre–approved. A Pre–Approved document is one that has already
been approved by the appropriate individual, who also chose to
forward it to yet another person for approval. Or, it is a document that
has been authorized for approval but for which funds have not yet
been reserved. In the PO Approval workflow, a document is still
considered pre–approved until the subprocess Reserve Before Approve
or the subprocess Approve PO sets its status to Approved.

Reserve Before Approve (Node 9)
See: Reserve Before Approve: page C – 140.

Approve PO (Node 23)
See: Approve PO: page C – 146.

PO Approved (Node 25)
This function activity sends a notification to the appropriate individual
that the purchase order has been approved.
This notification’s message uses Document type item attributes to call
two PL/SQL functions, one that retrieves all of the lines in the
document and displays them in the notification, and another that
retrieves the action history of the document and displays that in the
notification.

Print Document Process (Node 26)

Fax Document Process (Node 27)
Reject PO (Node 19)

PO Rejected (Node 21)
After the approver’s rejection is recorded and the purchase order sent back to the buyer, this activity sends a notification to the buyer that the purchase order has been rejected.

This notification’s message uses Document type item attributes to call two PL/SQL functions, one that retrieves all of the lines in the document and displays them in the notification, and another that retrieves the action history of the document and displays that in the notification.

Is Forward–To User Name Valid? (Node 16)
This function activity checks if the user name of the approver found by the Find Approver activity is valid.

End (Nodes 3, 10, 11, 15, 18, 20, 22, 24, and 28)
This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Main Requisition Approval process activity has a result type of PO Main Requisition Approval Process Result, each End activity node must have a process result matching one of the lookup codes in the PO Main Requisition Approval Process Result lookup type.

Summary of the Verify PO Subprocess
To view the properties of the Verify PO subprocess, select its process activity in the navigator tree, then choose Properties from the Edit menu. The Verify PO subprocess has a result type of PO Document Verification, indicating that when the subprocess completes, it has a result of Failed Verification or Passed Verification. These results correspond to the lookup codes in the PO Document Verification lookup type, in the PO Standard item type.

This subprocess activity is not runnable, indicating that it cannot be initiated as a top–level process to run, but rather can be run only as a subprocess when called by a higher–level process.
This subprocess activity makes sure the purchase order is complete and the information is valid.

The subprocess begins at node 1.

Node 2 checks if the document is open (for example, not finally closed).

Node 3 checks that the document status is compatible with an approval action (for example, its status is not closed, frozen, or on hold). Node 4 verifies that the document is complete, such as ensuring that it contains at least one line and one distribution.

If the document state does not allow an approval action at node 3 or the document is incomplete at node 4, a notification of such at node 8 or 9, respectively, is sent to the document owner. Then, at node 10, the purchase order status is set back to what it was before it entered this subprocess, and the workflow ends at node 11. If you modify and resubmit the purchase order or create a new one, the PO Approval workflow starts over when you submit the purchase order for approval.

If the document passes validation at nodes 3 and 4, node 12 records in the Action History window that the document has been submitted for approval. Then the activity Can Owner Approve? (outside this subprocess, in the PO Approval Top Process) begins.

If the Document Approval Manager fails at node 2, 3, or 4, the notification activity at node 5, 6, or 7 sends a notification of the failure
to the document owner. Once the Document Approval Manager is
restarted successfully, the workflow continues if the document owner
or system administrator responds to the notification with Retry.
Checks: page 2 – 27.

---

Verify PO Subprocess Activities

The following is a description of each activity in the Verify PO
subprocess, listed by the activity’s display name.

**Start (Node 1)**

This is a Standard function activity that simply marks the start of the
subprocess.

**Open Document State (Node 2)**

This function activity checks if the document is open (for example, not
finally closed).

**Does Document State Allow Approval Action? (Node 3)**

This function activity checks if the document status is compatible with
the approval action. Examples of document statuses that allow an
approval action are Incomplete, In Process, and Pre–Approved.

**Is Document Complete? (Node 4)**

This function activity verifies that the purchase order is complete—for
example, verifying that all the quantities match, and at least one line
and one distribution exist.

**Record ‘Submit’ In Action History (Node 12)**

This function activity inserts a Submit Action row into the
PO_ACTION_HISTORY table to record that the document has been
submitted for approval. It also inserts an additional row with a null
ACTION_CODE to simulate a forward–to action, since the document
status is In Process. The document manager looks for this row.
Document Manager Failed (Nodes 5, 6, and 7)

If the Document Approval Manager fails, the document owner receives this notification that it failed. Once a system administrator successfully restarts the Document Approval Manager, the owner must respond to the notification by choosing Retry, so that the workflow can continue.

Document Failed State Check (Node 8)

This function activity sends a notification to the document owner that the document failed the state check. See: Document Status Checks: page 2 – 26.

Document Failed Correctness Check (Node 9)

This function activity sends a notification to the document owner that the document failed the correctness check. See: Document Submission Checks: page 2 – 27.

Set PO Status to Original Status (Node 10)

This function activity sets the document back to its status before it entered this process activity, if the document has failed state or correctness checks.

End (Nodes 11 and 13)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Verify PO subprocess activity has a result type of PO Document Verification, each End activity node must have a process result matching one of the lookup codes in the PO Document Verification lookup type.

Summary of the Reserve Before Approve Subprocess

To view the properties of the Reserve Before Approve subprocess, select its process activity in the navigator tree, then choose Properties from the Edit menu. The Reserve Before Approve subprocess has a result type of PO Reserve Before Approve, indicating that when the subprocess completes, it has a result of Forward, No, or Yes. These
results correspond to the lookup codes in the PO Reserve Before Approve lookup type, in the PO Standard item type.

This subprocess activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only as a subprocess when called by a higher-level process.

The subprocess begins at node 1.

If node 2 finds that encumbrance is on and funds are not yet reserved, node 4 attempts to reserve funds for the document.

If funds cannot be reserved, node 6 sends an Unable to Reserve Document notification to the approver. The approver must then use the Approve Document window to try to reserve the document again if, for example, more funds have been allocated, and then respond to the notification with Retry; reject the document; or forward the document to somebody else with authority to reserve the funds.
If the approver forwards the document, node 7 checks if the forward–to approver has a valid user name. If so, node 8 sets the Forward–To/From information for the new approver.

If the approver rejects the document, node 10 rejects the purchase order. If it cannot reject the purchase order (because the document failed the state check—for example, its status has changed to closed, frozen, or on hold), node 13 sends a notification to the approver that the document could not be rejected.

If the Document Approval Manager fails at node 4 or 10, the notification activity at node 5 or 11 sends a notification of the failure to the approver. Once the Document Approval Manager is restarted successfully, the workflow continues if the approver or system administrator responds to the notification with Retry.

### Reserve Before Approve Subprocess Activities

The following is a description of each activity in the Reserve Before Approve subprocess, listed by the activity’s display name.

**Start (Node 1)**

This is a Standard function activity that simply marks the start of the subprocess.

**Is Encumbrance On and Is Document Not Reserved? (Node 2)**

This function activity checks whether you are using encumbrance accounting, and whether the document is already reserved.

**Reserve Document (Node 4)**

This function activity tries to reserve funds for the document.

**Document Manager Failed (Nodes 5 and 11)**

If the Document Approval Manager fails, the approver receives this notification that it failed. Once a system administrator successfully restarts the Document Approval Manager, the approver must respond to the notification by choosing Retry, so that the workflow can continue.
Unable To Reserve Document (Node 6)

This activity notifies the approver that Purchasing failed to reserve funds for the document, and provides instructions for resolving the failure. The approver must use the Approve Document window to try to reserve the document again if, for example, more funds have been allocated, and then respond to the notification with Retry; reject the document; or forward the document to somebody else with authority to reserve the funds.

Is Forward–To Valid? (Node 7)

This function activity checks that the Forward–To name entered in the Forward–To field, in response to an approval notification, is a valid user name.

Set Forward–To/From For Forward Action (Node 8)

If the approver responded to the notification Unable to Reserve Document by forwarding the document, this function activity resets the Forward–To and Forward–From attributes appropriately.

Reject the PO (Node 10)

This function activity updates the status of the document to Rejected and records the rejection in the Action History window. It also reverses encumbrance if the document has been encumbered.

Unable to Reject Document (Node 13)

This activity sends a notification to the approver that Purchasing was unable to reject the document—for example, because its status is closed, frozen, or on hold.

End (Nodes 3, 9, 12, and 14)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Reserve Before Approve subprocess activity has a result type of PO Reserve Before Approve, each End activity node must have a process result matching one of the lookup codes in the PO Reserve Before Approve lookup type.
Summary of the Verify Approval Authority Subprocess

To view the properties of the Verify Approval Authority subprocess, select its process activity in the navigator tree, then choose Properties from the Edit menu. The Verify Approval Authority subprocess has a result type of Yes/No, indicating that when the subprocess completes, it has a result of Yes or No. This result corresponds to the lookup codes in the Yes/No lookup type, in the Standard item type.

This subprocess activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only as a subprocess when called by a higher-level process.

The subprocess begins at node 1.

At node 2, the subprocess checks the approver’s approval authority limits defined in the Approval Groups and Assign Approval Groups windows. (See: Defining Approval Groups: page 1 – 29. See: Assigning Approval Groups: page 1 – 33.)

If the person has enough authority to approve the document, the function activity Is Forward–To Provided? (which is outside this subprocess, in the overall workflow) begins. If not, then the process activity Find Approver (outside this subprocess) begins.
If the Document Approval Manager fails at node 2, node 4 sends a notification of the failure to the approver. Once the Document Approval Manager is restarted successfully, the workflow continues if the approver or system administrator responds to the notification with Retry.

---

**Verify Approval Authority Subprocess Activities**

The following is a description of each activity in the Verify Approval Authority subprocess, listed by the activity’s display name.

**Start (Node 1)**

This is a Standard function activity that simply marks the start of the subprocess.

**Does Approver Have Authority? (Node 2)**

This function activity verifies the approver’s authority based on the authority limits defined in the Approval Groups and Assign Approval Groups windows. See: Defining Approval Groups: page 1 – 29. See: Assigning Approval Groups: page 1 – 33.

**Document Manager Failed (Node 4)**

If the Document Approval Manager fails, the approver receives this notification that it failed. Once a system administrator successfully restarts the Document Approval Manager, the approver must respond to the notification by choosing Retry, so that the workflow can continue.

**End (Nodes 3 and 5)**

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Verify Approval Authority subprocess activity has a result type of Yes/No, each End activity node must have a process result matching one of the lookup codes in the Yes/No lookup type.
Summary of the Approve PO Subprocess

To view the properties of the Approve PO subprocess, select its process activity in the navigator tree, then choose Properties from the Edit menu. The Approve PO subprocess has a result type of PO Approval Action and Doc Verification, indicating that when the subprocess completes, it has a result of Invalid Action or Valid Action. These results correspond to the lookup codes in the PO Approval Action and Doc Verification lookup type, in the PO Standard item type.

This subprocess activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only as a subprocess when called by a higher-level process.

The subprocess begins at node 1.

Node 2 checks if the document was already approved (for example, in the Reserve Before Approve subprocess). If so, this subprocess ends at node 3 and the workflow (in the PO Approval Process), sends a notification to the buyer that the document has been approved.

Otherwise, node 4 verifies that the document is ready for approval. If not, node 5 sends a notification to the approver that the document failed the state check (for example, the document’s status has changed to closed, frozen, or on hold). Then, node 6 reverts the purchase order to its status before it entered this subprocess, and the workflow ends at node 7. If you modify and resubmit the purchase order or create a new one, the PO Approval workflow starts over when you submit the purchase order for approval.
If the document passes the state check, node 8 verifies that the document is complete, such as ensuring that it contains at least one line and one distribution.

If the document is not complete, node 10 sends a notification of such to the approver. The approver can respond to the notification by choosing Retry (if there is a system-level issue), or reject the document. If node 13 cannot reject the document (for example, the document’s status has changed to closed, frozen, or on hold), node 14 sends the Unable to Reject Document notification to the document owner.

If the document passes the state check and is complete, node 17 approves the document, and node 19 retrieves purchase order information and other internal workflow attributes, in case these have changed.

If the Document Approval Manager fails at node 4, 8, 13, or 17, the notification activity at node 9, 11, 12, or 18 sends a notification of the failure to the approver. Once the Document Approval Manager is restarted successfully, the workflow continues if the approver or system administrator responds to the notification with Retry.


Approve PO Subprocess Activities

The following is a description of each activity in the Approve PO subprocess, listed by the activity’s display name.

Start (Node 1)

This is a Standard function activity that simply marks the start of the subprocess.

Is Document Approved? (Node 2)

If you are using encumbrance and the document was Pre–Approved at the time that funds were reserved for it, then its status already changed to Approved.

Does Document State Allow Approval? (Node 4)

Examples of document statuses that allow an approval action are Incomplete, In Process, and Pre–Approved.
Is Document Complete? (Node 8)
This function activity verifies that the document is complete—for example, verifying that all the quantities match, and at least one line and one distribution exist.

Approve the PO (Node 17)
This function activity sets the status of the purchase order to Approved.

Get PO Attributes (Node 19)
This function activity retrieves key values from the purchase order header and lines, in case these have changed, and assigns them to Workflow attributes.

Document Manager Failed (Nodes 9, 11, 12, and 18)
If the Document Approval Manager fails, the approver receives this notification that it failed. Once a system administrator successfully restarts the Document Approval Manager, the approver must respond to the notification by choosing Retry, so that the workflow can continue.

Document Failed State Check (Node 5)
This activity sends a notification to the approver that the document failed the state check. See: Document Status Checks: page 2 – 26.

Set PO Status to Original Status (Node 6)
This function activity sets the purchase order back to its status before it entered this process activity, if the document has failed the state check.

Unable To Approve (Node 10)
This activity sends a notification to the approver that Purchasing was unable to approve the document.

Reject the PO (Node 13)
This function activity updates the status of the document to Rejected and records the rejection in the Action History window. It also reverses encumbrance if the document has been encumbered.
Unable to Reject Document (Node 14)

This activity sends a notification to the approver that Purchasing was unable to reject the document—for example, because its status is closed, frozen, or on hold.

End (Nodes 3, 7, 15, and 16)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Approve PO subprocess activity has a result type of PO Approval Action and Doc Verification, each End activity node must have a process result matching one of the lookup codes in the PO Approval Action and Doc Verification lookup type.

Summary of the Print and Fax Document Subprocesses

To view the properties of the Print Document Process or the Fax Document Process, select its process activity in the navigator tree, then choose Properties from the Edit menu. This subprocess has a result type of PO Activity Performed, indicating that when the subprocess completes, it has a result of Activity Performed. This result corresponds to the lookup code in the PO Activity Performed lookup type, in the PO Standard item type.
Print Document Process

The subprocess begins at node 1.

Node 2 checks if Print was selected in the Approve Document window when the purchase order was first submitted for approval. If Print was selected, node 4 prints the document.

Fax Document Process

The Fax Document Process looks and behaves like the Print Document Process except that node 2 checks if Fax was selected in the Approve Document window. If Fax was selected, node 4 automatically sends a facsimile of the document if a Fax Number was also entered in the Approve Document window. (If a Fax Number was not specified, the document is sent to your facsimile server once it is approved. Depending on your CommercePath setup, you can choose where or when to send the documents that are stored on your facsimile server.)

CommercePath, or any facsimile software that uses the CommercePath Fax Command Language (FCL), must be installed to use the facsimile functionality.

Print and Fax Document Subprocess Activities

The following is a description of each activity in the Print Document and Fax Document subprocesses, listed by the activity’s display name.

Start (Node 1)

This is a Standard function activity that simply marks the start of the subprocess.

Does User Want Document Printed? (Node 2)

This function activity checks if Print was selected in the Approve Document window when the purchase order was first submitted.

In the Fax Document Process, the function activity Does User Want Document Faxed? checks if Fax was selected in the Approve Document window. CommercePath, or any facsimile software that uses the CommercePath Fax Command Language (FCL), must be installed to use the facsimile functionality.
Print Document (Node 4)

If Print was selected in the Approve Document window when the purchase order was first submitted, this activity prints the document.

In the Fax Document Process, the function activity Fax Document automatically sends a facsimile of the document if a Fax Number was entered in the Approve Document window. CommercePath, or any facsimile software that uses the CommercePath Fax Command Language (FCL), must be installed to use the facsimile functionality.

End (Nodes 3 and 5)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Print Document subprocess activity has a result type of PO Activity Performed, each End activity node must have a process result matching one of the lookup codes in the PO Activity Performed lookup type.

Summary of the Approve and Forward PO Subprocess

To view the properties of the Approve and Forward PO subprocess, select its process activity in the navigator tree, then choose Properties from the Edit menu. The Approve and Forward PO subprocess has a result type of PO Approval Action and Doc Verification, indicating that when the subprocess completes, it has a result of Invalid Action or Valid Action. These results correspond to the lookup code in the PO Approval Action and Doc Verification lookup type, in the PO Standard item type.

This subprocess activity is not runnable, indicating that it cannot be initiated as a top–level process to run, but rather can be run only as a subprocess when called by a higher–level process.
The subprocess begins at node 1.

Node 2 checks that the document status is compatible with an approval action (for example, its status is not closed, frozen, or on hold). If the document status is not compatible with an approval action, node 3 sends a notification to the approver that the document failed the state check. Then, at node 4, the subprocess reverts the purchase order to its status before it entered this subprocess, and the workflow ends at node 5. If you modify and resubmit the purchase order or create a new one, the PO Approval workflow starts over when you submit the purchase order for approval.

If the document passes the state check, node 6 verifies that the document is complete, such as ensuring that it contains at least one line and one distribution.

If the document is not complete, node 7 sends a notification of such to the approver. The approver can respond to the notification by choosing Retry, or reject the document. If node 8 cannot reject the document (because the state check fails again), node 11 sends the Unable to Reject Document notification to the document owner.

If the document is complete, node 13 approves and forwards the purchase order in one step and node 14 retrieves purchase order order.
information and other internal workflow attributes, in case these have changed. The resulting status of the purchase order is Pre–Approved until the forward–to approver approves the purchase order (outside this subprocess) and Reserve Before Approve or Approve PO (also outside this subprocess) sets the purchase order status to Approved.

If the Document Approval Manager fails at node 2, 6, 8, or 13, the notification activity at node 9, 16, 17, or 18 sends a notification of the failure to the approver. Once the Document Approval Manager is restarted successfully, the workflow continues if the approver or system administrator responds to the notification with Retry.


**Approve and Forward PO Subprocess Activities**

The following is a description of each activity in the Approve and Forward PO subprocess, listed by the activity’s display name.

**Start (Node 1)**

This is a Standard function activity that simply marks the start of the subprocess.

**Does Document State Allow Approval? (Node 2)**

Examples of document statuses that allow an approval action are Incomplete, In Process, and Pre–Approved.

**Is Document Complete? (Node 6)**

This function activity verifies that the document is complete—for example, verifying that all the quantities match, and at least one line and one distribution exist.

**Approve And Forward The PO (Node 13)**

This function activity approves the purchase order and forwards it to the next approver.
Get PO Attributes (Node 14)

This function activity retrieves key values from the purchase order header and lines, in case these have changed, and assigns them to Workflow attributes.

Document Manager Failed (Nodes 9, 16, 17, and 18)

If the Document Approval Manager fails, the approver receives this notification that it failed. Once a system administrator successfully restarts the Document Approval Manager, the approver must respond to the notification by choosing Retry, so that the workflow can continue.

Document Failed State Check (Node 3)

This function activity sends a notification to the approver that the document failed the state check. See: Document Status Checks: page 2 – 26.

Set PO Status to Original Status (Node 4)

This function activity sets the purchase order back to its status before it entered this process activity, if the document has failed the state check.

Unable To Approve Document (Node 7)

This activity sends a notification to the approver that Purchasing was unable to approve the document because the document was incomplete.

Reject the PO (Node 8)

This function activity updates the status of the document to Rejected and records the rejection in the Action History window. It also reverses encumbrance if the document has been encumbered.

Unable To Reject Document (Node 11)

This activity sends a notification to the approver that Purchasing was unable to reject the document—for example, because its status is closed, frozen, or on hold.
End (Nodes 5, 10, 12 and 15)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Approve and Forward PO subprocess activity has a result type of PO Approval Action and Doc Verification, each End activity node must have a process result matching one of the lookup codes in the PO Approval Action and Doc Verification lookup type.

Summary of the Notify Approver Subprocess

To view the properties of the Notify Approver subprocess, select its process activity in the navigator tree, then choose Properties from the Edit menu. The Notify Approver subprocess has a result type of PO Document Approval Action Process, indicating that when the subprocess completes, it has a result of Approve, Approve and Forward, Forward, Reject, or Timeout. These results correspond to the lookup codes in the PO Document Approval Action Process lookup type, in the PO Standard item type.

This subprocess activity is not runnable, indicating that it cannot be initiated as a top–level process to run, but rather can be run only as a subprocess when called by a higher–level process.
The subprocess begins at node 1.

Node 2 sends a notification to the approver that the document requires approval.

If you have entered a Timeout number in the Properties window for node 2, node 12 sends a reminder notification to the approver. The Timeout number indicates how long the workflow waits before sending the reminder if the approver does not respond. If you have entered a Timeout number for node 12, node 22 sends another reminder. If you have entered a Timeout number for node 22, the workflow ends (times out) at node 33.

Depending on whether the approver responds with Approve, Approve and Forward, Forward, or Timeout, this subprocess sets the correct forward–to and forward–from information: nodes 9, 19, and 29 set this information after an Approve action; nodes 4, 14, and 24 after an Approve and Forward action; nodes 7, 17, and 27 after a Forward action; and node 32 after the subprocess times out if a Timeout is provided.

The PO Approval process, in which this subprocess is contained, behaves differently depending on how the approver responds here—with Approve And Forward, Approve, Reject, or Forward.

### Notify Approver Subprocess Activities

The following is a description of each activity in the Notify Approver subprocess, listed by the activity’s display name.

#### Start (Node 1)

This is a Standard function activity that simply marks the start of the subprocess.

#### Approve PO Notification (Node 2)

This activity sends a notification to the approver requesting approval.

This notification’s message uses Document type item attributes to call two PL/SQL functions, one that retrieves all of the lines in the document and displays them in the notification, and another that retrieves the action history of the document and displays that in the notification.
PO Approval Reminder 1 (Node 12)

If no approval response is received after a period of time, this activity sends a first reminder if you designate a timeout period in the activity’s Properties window.

This notification’s message uses Document type item attributes to call two PL/SQL functions, one that retrieves all of the lines in the document and displays them in the notification, and another that retrieves the action history of the document and displays that in the notification.

PO Approval Reminder 2 (Node 22)

If still no approval response is received, this activity sends a second reminder if you’ve entered a timeout period in the activity’s Properties window.

This notification’s message uses Document type item attributes to call two PL/SQL functions, one that retrieves all of the lines in the document and displays them in the notification, and another that retrieves the action history of the document and displays that in the notification.

Set Forward–To/From For Approve Action (Nodes 9, 19, and 29)

This function activity resets the Forward–To and Forward–From attributes after an Approve action.

Is Forward–To Valid? (Node 3, 6, 13, 16, 23, and 26)

This function activity checks that the Forward–To name entered in the Forward–To field, in response to an approval notification, is a valid user name.

Set Forward–To/From App. & Fwd. Action (Nodes 4, 14, and 24)

This function activity resets the Forward–To and Forward–From attributes after an Approve and Forward action.

Set Forward–To/From For Forward Action (Nodes 7, 17, and 27)

This function activity resets the Forward–To and Forward–From attributes after a Forward action.
Set Forward–To/From For Timeout (Node 32)

This function activity resets the Forward–To and Forward–From attributes after the previous activity times out (if a Timeout is associated with it).

End (Nodes 5, 8, 10, 11, 15, 18, 20, 21, 25, 28, 30, 31, and 33)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Notify Approver subprocess activity has a result type of PO Document Approval Action Process, each End activity node must have a process result matching one of the lookup codes in the PO Document Approval Action Process lookup type.

Summary of the Find Approver Subprocess

To view the properties of the Find Approver subprocess, select its process activity in the navigator tree, then choose Properties from the Edit menu. The Find Approver subprocess has a result type of Yes/No, indicating that when the subprocess completes, it has a result of Yes or No. These results correspond to the lookup codes in the Yes/No lookup type, in the Standard item type.

This subprocess activity is not runnable, indicating that it cannot be initiated as a top–level process to run, but rather can be run only as a subprocess when called by a higher–level process.

This process looks for the next approver in the approval hierarchy if any of the following is true:

- Verify Approval Authority determines that the document owner does not have the authority to approve the document as defined in the Approval Groups and Assign Approval Groups windows. (See: Defining Approval Groups: page 1 – 29. See: Assigning Approval Groups: page 1 – 33.)


- The approver forwarded the document to another approver during the Notify Approver process, or didn’t respond after a certain time, if the Timeout feature is set up.
The subprocess begins at node 1.

If node 2 finds no forward-to approver, node 4 gets the default approval hierarchy—either a specific approval hierarchy that the buyer provides in the Approve Document window, or the default approval hierarchy in Purchasing.

Node 5 checks the forwarding method. If the forwarding method is Direct, the workflow sends the purchase order to the first person with enough approval authority, starting at node 13. If the forwarding method is Hierarchy, each person in the hierarchy must take action
until a person with enough approval authority is reached, starting at node 6.

Nodes 6 and 13 check whether you use position hierarchies. If you do, nodes 7 and 14 use your position hierarchy to find the next approver. If you do not, nodes 10 and 19 use your employee/supervisor hierarchy to find the next approver.

If the Document Approval Manager fails at node 16 or 21, the notification activity at node 17 or 22 sends a notification of the failure to the approver. Once the Document Approval Manager is restarted successfully, the workflow continues if the approver or system administrator responds to the notification with Retry.

## Find Approver Subprocess Activities

The following is a description of each activity in the Find Approver subprocess, listed by the activity’s display name.

### Start (Node 1)

This is a Standard function activity that simply marks the start of the subprocess.

### Is Forward–To Provided? (Node 2)

This function activity checks whether the buyer or the approver provided a forward–to user name.

### Get Approval Path (Node 4)

This function activity retrieves the approval hierarchy—either a specific approval hierarchy that the buyer provides in the Approve Document window, or the default approval hierarchy in Purchasing.

### Get Forwarding Mode (Node 5)

This function activity retrieves the forwarding mode: Hierarchy or Direct. In a Direct mode, the purchase order goes to the first person with enough approval authority. In a Hierarchy mode, each person in the hierarchy must take action until a person with enough approval authority is reached.
Are You Using PO Approval Hierarchies? (Nodes 6 and 13)

This function activity checks whether position hierarchies are being used in approvals. See: Setting Up Document Approval and Security: page 2 – 2.

Get Next Manager in H.R. (Nodes 10 and 19)

This activity retrieves the buyer’s manager if employee/supervisor relationship hierarchies are being used. It gets the buyer’s first manager using the HR_EMPLOYEES and HR_ASSIGNMENTS tables.

Get First Manager in Approval Hierarchy (Nodes 7 and 14)

This function activity gets the first manager of the buyer using the PO_EMPLOYEE_HIERARCHIES and HR_EMPLOYEES tables, if position hierarchies are being used.

Does Approver Have Authority? (Nodes 16 and 21)

This function activity verifies the approver’s approval authority based on the authority limits defined in the Approval Groups and Assign Approval Groups windows.

Document Manager Failed (Nodes 17 and 22)

If the Document Approval Manager fails, the approver receives this notification that it failed. Once a system administrator successfully restarts the Document Approval Manager, the approver must respond to the notification by choosing Retry, so that the workflow can continue.

End (Nodes 3, 8, 9, 11, 12, 15, 18, 20, and 23)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Find Approver subprocess activity has a result type of Yes/No, each End activity node must have a process result matching one of the lookup codes in the Yes/No lookup type.
Summary of the Forward PO Subprocess

To view the properties of the Forward PO subprocess, select its process activity in the navigator tree, then choose Properties from the Edit menu. The Forward PO subprocess has a result type of PO Approval Action and Doc Verification, indicating that when the subprocess completes, it has a result of Invalid Action or Valid Action. These results correspond to the lookup codes in the PO Approval Action and Doc Verification lookup type, in the PO Standard item type.

This subprocess activity is not runnable, indicating that it cannot be initiated as a top–level process to run, but rather can be run only as a subprocess when called by a higher–level process.

The subprocess begins at node 1.

If the Find Approver subprocess activity (outside this subprocess, in the overall workflow) finds an approver, this subprocess forwards the purchase order to the next approver.

Node 2 checks if the purchase order is pre–approved (it has been approved by the final approver, but also forwarded to an additional approver; or it has been authorized for approval but funds have not yet been reserved for it, if you use encumbrance accounting). If it has not
been pre-approved, node 4 forwards the purchase order with a status of In Process. If it is pre-approved, node 8 forwards the purchase order with a status of Pre-Approved. The PO Approval workflow still considers a document pre-approved until the subprocess Reserve Before Approve or the subprocess Approve PO sets its status to Approved.

After the document is forwarded, nodes 6 and 10 retrieve purchase order information and other internal workflow attributes, in case these have changed.

If the Document Approval Manager fails at node 4 or 8, the notification activity at node 5 or 9 sends a notification of the failure to the person who forwarded the document. Once the Document Approval Manager is restarted successfully, the workflow continues if the approver or system administrator responds to the notification with Retry.

---

**Forward PO Subprocess Activities**

The following is a description of each activity in the Forward PO subprocess, listed by the activity’s display name.

**Start (Node 1)**

This is a Standard function activity that simply marks the start of the subprocess.

**Is PO Pre-Approved? (Node 2)**

This function activity checks if the purchase order has been pre-approved. A Pre-Approved document is one that has already been approved by the appropriate individual, who also chose to forward it to yet another person for approval. Or, it is a document that has been authorized for approval but for which funds have not yet been reserved. The PO Approval workflow still considers a document pre-approved until the subprocess Reserve Before Approve or the subprocess Approve PO sets its status to Approved.

**Forward PO with Status “In-Process” (Node 4)**

If the purchase order status is Incomplete, this activity sets the status to In Process, forwards the purchase order to the approver, and updates the document’s action history with the forward action.
Forward PO with Status “Pre–Approved” (Node 8)

If the purchase order status is Pre–Approved, this activity forwards the purchase order to the next approver without changing its status.

Get PO Attributes (Nodes 6 and 10)

This function activity retrieves key values from the purchase order header and lines, in case these have changed, and assigns them to Workflow attributes.

Document Manager Failed (Nodes 5 and 9)

If the Document Approval Manager fails, the person who forwarded the document receives this notification that it failed. Once a system administrator successfully restarts the Document Approval Manager, the approver must respond to the notification by choosing Retry, so that the workflow can continue.

End (Nodes 3, 7, and 11)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Forward PO subprocess activity has a result type of PO Approval Action and Doc Verification, each End activity node must have a process result matching one of the lookup codes in the PO Approval Action and Doc Verification lookup type.

Summary of the Return PO to Submitter Subprocess

To view the properties of the Return PO to Submitter subprocess, select its process activity in the navigator tree, then choose Properties from the Edit menu. The Return PO to Submitter subprocess has a result type of PO Activity Performed, indicating that when the subprocess completes, it has a result of Activity Performed. This result corresponds to the lookup code in the PO Activity Performed lookup type, in the PO Standard item type.

This subprocess activity is not runnable, indicating that it cannot be initiated as a top–level process to run, but rather can be run only as a subprocess when called by a higher–level process.
If the Find Approver subprocess activity (outside this subprocess activity, in the PO Approval Process) does not find an approver, the Return PO to Submitter subprocess returns the purchase order to the buyer.

The subprocess begins at node 1. Node 2 sets the document back to its status before it entered this subprocess. Node 3 sends the buyer a notification that no approver was found. Node 5 sends the last approver a notification that no approver was found; however, if node 4 finds that the buyer is also the sole or last approver, the subprocess skips node 5 and ends at node 6 so that the buyer does not receive two notifications.

Return PO to Submitter Subprocess Activities

The following is a description of each activity in the Return PO to Submitter subprocess, listed by the activity’s display name.

Start (Node 1)
This is a Standard function activity that simply marks the start of the subprocess.

Set PO Status to Original Status (Node 2)
This activity sets the purchase order back to its status before it entered this process activity, if no approver was found.

Notify Preparer Of No Approver Found (Node 3)
This activity sends a notification to the buyer when no approver is found.
This notification’s message uses Document type item attributes to call two PL/SQL functions, one that retrieves all of the lines in the document and displays them in the notification, and another that retrieves the action history of the document and displays that in the notification.

**Is Submitter Last Approver? (Node 4)**

This function activity checks if the buyer is also the sole or last approver. If so, the subprocess skips node 5 so as not to send the buyer two notifications.

**Notify Last Approver Of No Approver Found (Node 5)**

This activity sends a notification to the last approver that the next approver was not found.

This notification’s message uses Document type item attributes to call two PL/SQL functions, one that retrieves all of the lines in the document and displays them in the notification, and another that retrieves the action history of the document and displays that in the notification.

**End (Node 6)**

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Return Requisition to Submitter subprocess activity has a result type of PO Activity Performed, each End activity node must have a process result matching one of the lookup codes in the PO Activity Performed lookup type.

**Summary of the Reject PO Subprocess**

To view the properties of the Reject PO subprocess, select its process activity in the navigator tree, then choose Properties from the Edit menu. The Reject PO subprocess has a result type of PO Approval Action and Doc Verification, indicating that when the subprocess completes, it has a result of Invalid Action or Valid Action. These results correspond to the lookup codes in the PO Approval Action and Doc Verification lookup type, in the PO Standard item type.
This subprocess activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only as a subprocess when called by a higher-level process.

The subprocess begins at node 1.

At node 2, this subprocess records the approver’s rejection of the purchase order in the Action History window and changes the status of the document to Rejected. If the subprocess cannot reject the document (for example, the document’s status has changed to closed, frozen, or on hold), node 5 sends a notification to the approver that the document could not be rejected. (If the document is rejected, a notification outside this subprocess in the PO Approval process, sends the rejection notification.)

If the Document Approval Manager fails at node 2, node 4 sends a notification of the failure to the approver. Once the Document Approval Manager is restarted successfully, the workflow continues if the approver or system administrator responds to the notification with Retry.
Reject PO Subprocess Activities

The following is a description of each activity in the Reject PO subprocess, listed by the activity’s display name.

Start (Node 1)
This is a Standard function activity that simply marks the start of the subprocess.

Reject The PO (Node 2)
This function activity updates the status of the document to Rejected and records the rejection in the Action History window. It also reverses encumbrance if the document has been encumbered.

Unable To Reject Document (Node 5)
This activity sends a notification to the approver that Purchasing was unable to reject the document—for example, because its status is closed, frozen, or on hold.

Document Manager Failed (Node 4)
If the Document Approval Manager fails, the approver receives this notification that it failed. Once a system administrator successfully restarts the Document Approval Manager, the approver must respond to the notification by choosing Retry, so that the workflow can continue.

End (Nodes 3 and 6)
This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Reject PO subprocess activity has a result type of PO Approval Action and Doc Verification, each End activity node must have a process result matching one of the lookup codes in the PO Approval Action and Doc Verification lookup type.
Change Order Process Activities

Workflow Processes for Approving Change Orders

Whenever you make a change to a document that causes its status to change to Requires Reapproval, that document is routed through the change order workflow. The change order workflow uses the same reapproval rules already defined in Purchasing. See: Document Reapproval Rules: page 4 – 128.

With the change order workflow, Purchasing lets you define what changes to purchase orders or releases—for example, to amounts, suppliers, or dates—require manual reapproval and which are automatically reapproved. If you modify the change order workflow as described in the next section, you can allow certain changes to bypass full (manual) reapproval. All reapproved documents, either fully or automatically reapproved, result in the document revision number’s being incremented.

All of the workflow processes and functions relating to change orders can be found within the PO Approval workflow.

The change order workflow begins when all of the following is true:

- Changes to a purchase order cause its Status to change to ‘Requires Reapproval.’
- The document revision number of the purchase order increases.
- You select Submit for Approval (and then choose OK) in the Approve Document window or otherwise submit the document for approval.

See Also

Purchase Order Approval Workflow: page C – 114

Customizing the Change Order Workflow

Use the Oracle Workflow Builder to customize workflows. When you customize a workflow, only those documents that are submitted for approval after you customize it are affected by the customized workflow.

You can use the Workflow Monitor to follow where certain documents are in a workflow process. See: Workflow Monitor, Oracle Workflow Guide.
To display the workflow in the Oracle Workflow Builder:

1. Choose Open from the File menu, and connect to the database.

   See: Opening and Saving Item Types, Oracle Workflow Guide.

   The change order workflow is not actually an item type, like the
   other Purchasing workflows, but is a group of processes contained
   in the purchase order approval workflow. Therefore, to display the
   change order workflow, open the purchase order approval
   workflow. The Display name of the purchase order approval
   workflow is PO Approval. The name of its Workflow definition file
   is poxwfpoa.wft.

2. Expand the data source, then the PO Approval item type branch
   within that data source.

3. Expand the Processes branch, then double-click the PO Approval
   Top Process activity.

   You can see the change order processes within the PO Approval
   Top Process diagram.

Creating a New Custom Process

For the PO Approval workflow, which contains the change order
workflow processes, you can either modify the default workflow that
Purchasing provides, or copy it and create a whole new workflow. Use
Using the Account Generator in Oracle Public Sector Purchasing

the Document Types window to select a custom PO Approval Workflow Startup Process for specific document types or operating units. See: Customizing the PO Approval Workflow: page C – 114.

**Attention:** Creating a new workflow process with a new Internal Name affects the implementation of future upgrades. See: Upgrade Support: page C – 5.

**Required Modifications**

There are no required modifications you need to make to the change order workflow itself.

However, for the change order workflow to work, you must select Archive on Approve in the Document Types window, if you haven’t already done this when you set up Purchasing. The Archive on Approve option copies the purchase order information into the archive tables in Purchasing every time you approve or reapprove a purchase order. The change order workflow uses this archive information to compare a document before and after you make a change.

**Supported and Unsupported Customizations**

You can modify percentage tolerances used by the change order workflow to determine what percentage change to a unit price, quantity, or document total requires reapproval. The change order workflow represents these percentage tolerances as item attributes that you can change, using the Workflow Builder. For example, you can change the attribute Change Order Line Unit Price Tolerance from a value of 0 to a value of 20. This means that the document will be reapproved automatically by the change order workflow, without going through the full reapproval process, if the unit price is increased or decreased by less than 20 percent.

You can modify the percentage tolerances for these attributes:

- Change Order Header Blanket Total Tolerance
- Change Order Header Amount Limit Tolerance
- Change Order Header Purchase Order Total Tolerance
- Change Order Line Quantity Tolerance
- Change Order Line Unit Price Tolerance
- Change Order Line Quantity Committed Tolerance
- Change Order Line Agreed Amount Tolerance
• Change Order Line Price Limit Tolerance
• Change Order Shipment Price Override Tolerance
• Change Order Shipment Quantity Tolerance
• Change Order Distribution Quantity Ordered Tolerance

For a complete discussion of what other change order workflow activities you can and definitely cannot modify, see: Purchase Order Approval Workflow: page C – 114.

To help you with your customizations, refer to the sections later in this document, starting with The Change Order Workflow Item Attributes: page C – 174. These sections describe the components of the change order processes in the PO Approval workflow. If you haven’t already, see also: Customization Guidelines: page C – 5.

► To modify percentage tolerances:

1. In the Workflow Navigator, select one of the modifiable Change Order tolerance item attributes listed above.
2. Select the item attribute and open its Properties window.
3. Change the Default value from 0 to your own tolerance value.

For example, if you can change the attribute Change Order Line Unit Price Tolerance from a value of 0 to a value of 20, the document will be reapproved automatically by the change order workflow, without going through the full reapproval process, if the unit price is increased or decreased by less than 20 percent.

The Change Order Workflow Item Attributes

The change order workflow processes are associated with an item type called PO Approval. The change order process activities in the PO Approval item type are as follows:

• Get All Document Changes: page C – 185
• Get All Blanket PO Changes: page C – 188
• Get All Contract PO Changes: page C – 190
• Get All Planned PO Changes: page C – 191
• Get All Release Changes: page C – 193
• Get All Standard PO Changes: page C – 194
These processes have many attributes associated with them. These attributes reference information in the Purchasing application tables. The attributes are used and maintained by function activities as well as notification activities throughout the change order processes.

The change order workflow item attributes are associated with the PO Approval item type.

**Attention:** If one item attribute for one of the document lines does not pass the tolerance check, the entire document needs to go through full reapproval.

The following tables show the Change Order Workflow item type attributes.

**Change Order Workflow: Modifiable Item Type Attributes**

<table>
<thead>
<tr>
<th>Modifiable Item Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Order Distribution Quantity Ordered Tolerance</td>
<td>If the change in the distribution Quantity ordered is less than this percentage, the document is reapproved automatically</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Change Order Header Amount Limit Tolerance</td>
<td>If the change to the Amount Limit is less than this percentage, the document is reapproved automatically</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Change Order Header Blanket Total Tolerance</td>
<td>If the change to the blanket Total is less than this percentage, the document is reapproved automatically</td>
<td>Number</td>
<td></td>
</tr>
</tbody>
</table>

Table C–8  (Page 1 of 2)
<table>
<thead>
<tr>
<th>Modifiable Item Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Order Header</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Purchase Order Total</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tolerance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If the change to the purchase order Total is less than this percentage, the document is reapproved automatically</td>
<td>Number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Order Line</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agreed Amount</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tolerance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If the change in Amount Agreed is less than this percentage, the document is reapproved automatically</td>
<td>Number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Order Line</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Price Limit Tolerance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If the change in Price Limit is less than this percentage, the document is reapproved automatically</td>
<td>Number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Order Line</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quantity Committed Tolerance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If the change in Quantity Agreed is less than this percentage, the document is reapproved automatically</td>
<td>Number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Order Line</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quantity Tolerance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If the change in Quantity ordered is less than this percentage, the document is reapproved automatically</td>
<td>Number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Order Line</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unit Price Tolerance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If the change in unit Price is less than this percentage, the document is reapproved automatically</td>
<td>Number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Order Shipment</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Price Override Tolerance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If the change in price override is less than this percentage, the document is reapproved automatically</td>
<td>Number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Order Shipment</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quantity Tolerance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If the change in the shipment Quantity ordered is less than this percentage, the document is reapproved automatically</td>
<td>Number</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table C – 8 (Page 2 of 2)
## Change Order Workflow: Header Item Type Attributes

<table>
<thead>
<tr>
<th>Header Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Order Document Type</td>
<td>The type of the document, such as Standard or Blanket Purchase Agreement</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Change Order Header Acceptance Due Date Modified</td>
<td>Indicator of whether the Acceptance Required By date (in the Terms and Conditions window) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Header Acceptance Required Modified</td>
<td>Indicator of whether the Acceptance Required option (in the Terms and Conditions window) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Header Agent Modified</td>
<td>Indicator of whether the buyer has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Header Amount Limit Change</td>
<td>Percentage by which the Amount Limit (in the Terms and Conditions window) has changed</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Change Order Header Amount Limit Modified</td>
<td>Indicator of whether the Amount Limit (in the Terms and Conditions window) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Header Bill To Modified</td>
<td>Indicator of whether the Bill-To location has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Header Blanket Total Change</td>
<td>Percentage by which the document Total for a blanket purchase agreement has changed</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Change Order Header Blanket Total Modified</td>
<td>Indicator of whether the document Total for a blanket purchase agreement has changed</td>
<td>Text</td>
<td>1</td>
</tr>
</tbody>
</table>

Table C – 9   (Page 1 of 3)
<table>
<thead>
<tr>
<th>Header Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Order Header Cancel Flag Modified</td>
<td>Indicator of whether the document’s Canceled status has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Header Confirming Order Modified</td>
<td>Indicator of whether the Confirming Order option (in the Terms and Conditions window) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Header End Date Modified</td>
<td>Indicator of whether the Effective end date (in the Terms and Conditions window) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Header FOB Modified</td>
<td>Indicator of whether the free-on-board point (in the Terms and Conditions window) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Header Freight Modified</td>
<td>Indicator of whether the Freight (in the Terms and Conditions window) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Header Note to Supplier Modified</td>
<td>Indicator of whether the Supplier Note (in the Terms and Conditions window) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Header PO Accepted</td>
<td>Indicator of whether the purchase order’s acceptance status (in the Acceptances window) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Header PO Acknowledged</td>
<td>Indicator of whether the purchase order has been acknowledged through the Acceptances window</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Header PO Total Change</td>
<td>Percentage by which the purchase order Total has changed</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Change Order Header Ship To Modified</td>
<td>Indicator of whether the document’s Ship-To information has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Header Ship Via Modified</td>
<td>Indicator of whether the Ship Via information has changed</td>
<td>Text</td>
<td>1</td>
</tr>
</tbody>
</table>

Table C – 9  (Page 2 of 3)
<table>
<thead>
<tr>
<th>Header Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Order Header Start Date Modified</td>
<td>Indicator of whether the Effective start date (in the Terms and Conditions window) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Header Supplier Contact Modified</td>
<td>Indicator of whether the Supplier Contact has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Header Supplier Site Modified</td>
<td>Indicator of whether the Supplier Site has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Header Terms Modified</td>
<td>Indicator of whether the Payment term (in the Terms and Conditions window) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
</tbody>
</table>

Table C – 9  (Page 3 of 3)

### Change Order Workflow: Release Item Type Attributes

<table>
<thead>
<tr>
<th>Release Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Order Release Acceptance Due Date Modified</td>
<td>Indicator of whether the Acceptance Required Due By date has changed on a release</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Release Acceptance Required Modified</td>
<td>Indicator of whether the Acceptance Required option has changed on a release</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Release Agent Modified</td>
<td>Indicator of whether the buyer on the release has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Release Date Modified</td>
<td>Indicator of whether the release creation date has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Release Number Modified</td>
<td>Indicator of whether the release document number has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Release Total Change</td>
<td>Percentage by which the release Total has changed</td>
<td>Number</td>
<td></td>
</tr>
</tbody>
</table>

Table C – 10  (Page 1 of 1)
## Change Order Workflow: Line Item Type Attributes

<table>
<thead>
<tr>
<th>Line Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Order Lines Agreed Amount Change</td>
<td>Percentage by which the Amount Agreed has changed for an agreement line</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Change Order Lines Agreed Quantity Change</td>
<td>Percentage by which the Quantity Agreed has changed on an agreement line</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Change Order Lines Cancel Flag Modified</td>
<td>Indicator of whether a line’s Canceled status has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Lines Category Modified</td>
<td>Indicator of whether the item Category has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Lines Closed Code Modified</td>
<td>Indicator of whether a line’s Closed status has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Lines Committed Amount Modified</td>
<td>Indicator of whether the Amount Agreed on the agreement line has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Lines Contract Number Modified</td>
<td>Indicator of whether a line’s Contract number (in the Reference Documents tabbed region) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Lines From Header Modified</td>
<td>Indicator of whether the unique identifier for the quotation header has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Lines From Line Modified</td>
<td>Indicator of whether the unique identifier for the quotation line has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Lines Hazard Class Modified</td>
<td>Indicator of whether a line’s Hazard Class (in the More tabbed region) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
</tbody>
</table>

Table C – 11  (Page 1 of 4)
<table>
<thead>
<tr>
<th>Line Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/ Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Order Lines Item Description Modified</td>
<td>Indicator of whether a line's item Description has changed</td>
<td>Text</td>
<td>1</td>
</tr>
</tbody>
</table>

Table C – 11 (Page 2 of 4)
<table>
<thead>
<tr>
<th>Line Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Order Lines Item Modified</td>
<td>Indicator of whether a line’s Item has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Lines Item Revision Modified</td>
<td>Indicator of whether a line’s item revision (Rev) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Lines Line Num Modified</td>
<td>Indicator of whether a line number (Num) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Lines Note to Supplier Modified</td>
<td>Indicator of whether a line’s Note to the Supplier (in the More tabbed region) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Lines Price Limit Change</td>
<td>Percentage by which the Price Limit (in the Price Reference tabbed region) has changed</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Change Order Lines Price Type Modified</td>
<td>Indicator of whether a line’s Price Type (in the Price Reference tabbed region) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Lines Quantity Change</td>
<td>Percentage by which a line’s Quantity ordered has changed</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Change Order Lines Quantity Committed Modified</td>
<td>Indicator of whether the Quantity Agreed on the agreement line has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Lines Quantity Modified</td>
<td>Indicator of whether a line’s Quantity ordered has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Lines Supplier Product Number Modified</td>
<td>Indicator of whether a line’s Supplier Item number has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Lines Unit of Measure Modified</td>
<td>Indicator of whether a line’s UOM has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Lines Unit Price Change</td>
<td>Percentage by which a line’s unit Price has changed</td>
<td>Number</td>
<td></td>
</tr>
</tbody>
</table>

Table C – 11  (Page 3 of 4)
### Table C–11 (Page 4 of 4)

<table>
<thead>
<tr>
<th>Line Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Order Lines Unit Price Modified</td>
<td>Indicator of whether a line’s unit Price has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Lines UN Number Modified</td>
<td>Indicator of whether a line’s UN Number (in the More tabbed region) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
</tbody>
</table>

### Change Order Workflow: Shipment Item Type Attributes

<table>
<thead>
<tr>
<th>Shipment Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Order Shipments Cancel Flag Modified</td>
<td>Indicator of whether the shipment’s Canceled status has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Shipments Closed Code Modified</td>
<td>Indicator of whether the shipment’s Closed status has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Shipments Last Accept Date Modified</td>
<td>Indicator of whether the latest acceptable receipt date for the shipment (in the Receiving Controls window) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Shipments Need By Date Modified</td>
<td>Indicator of whether the shipment’s Need By date has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Shipments Price Discount Modified</td>
<td>Indicator of whether the price break has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Shipments Price Override Change</td>
<td>Percentage by which the shipment’s price override has changed</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Change Order Shipments Price Override Modified</td>
<td>Indicator of whether the shipment’s price override (in the Price Reference tabbed region) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Shipments Promised Date Modified</td>
<td>Indicator of whether the shipment’s Promised Date has changed</td>
<td>Text</td>
<td>1</td>
</tr>
</tbody>
</table>
### Table C–12 (Page 2 of 2)

<table>
<thead>
<tr>
<th>Shipment Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Order Shipments Quantity Change</td>
<td>Percentage by which the shipment’s Quantity ordered has changed</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Change Order Shipments Quantity Modified</td>
<td>Indicator of whether the shipment’s Quantity ordered has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Shipments Shipment Number Modified</td>
<td>Indicator of whether the shipment line number (Num) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Shipments Ship To Location Modified</td>
<td>Indicator of whether the shipment’s Ship–To location has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Shipments Ship To Organization Modified</td>
<td>Indicator of whether the shipment line’s ship–to organization (Org) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Shipments Taxable Flag Modified</td>
<td>Indicator of whether the shipment line’s Taxable status has changed</td>
<td>Text</td>
<td>1</td>
</tr>
</tbody>
</table>

### Change Order Workflow: Distribution Item Type Attributes

<table>
<thead>
<tr>
<th>Distribution Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Order Distribution Line Number Modified</td>
<td>Indicator of whether the distribution line number (Num) has changed</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Change Order Distribution Quantity Ordered Change</td>
<td>Percentage by which the distribution Quantity ordered has changed</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Change Order Distribution Rate Change</td>
<td>Percentage by which the currency conversion Rate on the distribution has changed</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Change Order Distribution Rate Tolerance</td>
<td>Maximum percentage change allowed to the currency conversion rate</td>
<td>Number</td>
<td></td>
</tr>
</tbody>
</table>

Table C–13 (Page 1 of 2)
<table>
<thead>
<tr>
<th>Distribution Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Order Distribution Subinventor Modified</td>
<td>Indicator of whether the distribution Subinventor has changed</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Change Order Distributions Charge Account Modified</td>
<td>Indicator of whether the distributions Charge Account has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Distributions Deliver To Person Modified</td>
<td>Indicator of whether the distributions Deliver-To person has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Distributions GL Encumbered Date Modified</td>
<td>Indicator of whether the distributions GL Date (date the distribution was encumbered) has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Distributions Quantity Ordered Modified</td>
<td>Indicator of whether the distribution Quantity ordered has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Distributions Rate Date Modified</td>
<td>Indicator of whether the currency conversion Rate Date on the distribution has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Distributions Rate Modified</td>
<td>Indicator of whether the currency conversion Rate on the distribution has changed</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Change Order Distributions Rate Type Modified</td>
<td>Indicator of whether the currency conversion Rate Type on the distribution has changed</td>
<td>Text</td>
<td>1</td>
</tr>
</tbody>
</table>

Table C – 13  (Page 2 of 2)

**Summary of the Get All Document Changes Subprocess**

To view the properties of the Get All Document Changes subprocess, select the process in the navigator tree, then choose Properties from the Edit menu. The Get All Document Changes subprocess has a result type of PO Activity Performed, indicating that when the process completes, it has a result of Activity Performed. This result corresponds to the lookup code in the PO Activity Performed lookup type in the PO Standard item type.
This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only as a subprocess when called by a higher-level process.

The Get All Document Changes subprocess is initiated when the PO Approval workflow determines that the document is a changed, not a new, document, and Archive on Approval is chosen for the document type in the Document Types window. (The change order workflow is not initiated unless you have chosen Archive on Approval. See: Required Modifications in Customizing the Change Order Workflow: page C – 171.)

The subprocess begins at node 1.

Node 2 determines the document type so that the correct subprocess (nodes 3 through 8) for gathering the document changes begins. For example, if node 2 finds that the document is a contract purchase order, node 3 finds all the changes in the contract purchase order. Nodes 3 through 8 find the changes by comparing the document with its previous archived revision.
Get All Document Changes Subprocess Activities

The following is a description of each activity in the Get All Document Changes subprocess listed by the activity’s display name. You can create all the components for an activity in the graphical Workflow Builder except for the PL/SQL stored procedures that the function activities call. All function activities execute PL/SQL stored procedures which you must create and store in the Oracle RDBMS. The naming convention for the PL/SQL stored procedures is:

<PACKAGE>.<PROCEDURE>

<PACKAGE> is the name of the package that groups all of the procedures. <PROCEDURE> represents the name of the procedure.

To view the package and procedure names used by the change order processes, view the Properties page for each function activity. For example, the function activity Determine Document Type uses the <PACKAGE>.<PROCEDURE> name PO_CHORD_WF0.CHORD_DOC_TYPE.

You can use the Item Type Definitions Web page to view <PACKAGE>.<PROCEDURE> names. See: Item Type Definitions Web Page, Oracle Workflow Guide.

Start (Node 1)
This is a Standard function activity that simply marks the start of the subprocess.

Determine Document Type (Node 2)
This function activity looks for the changed document’s document type.

Get All Contract PO Changes (Node 3)

Get All Blanket PO Changes (Node 4)
See: Get All Blanket PO Changes: page C – 188.

Get All Planned PO Changes (Node 5)
Get All Standard PO Changes (Node 6)


Get All Release Changes (Nodes 7 and 8)

Node 7 gathers all release changes for a blanket release, and node 8 gathers all release changes for a scheduled release. See: Get All Release Changes: page C – 193.

End (Node 9)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Get All Document Changes subprocess activity has a result type of PO Activity Performed, each End activity node must have a process result matching one of the lookup codes in the PO Activity Performed lookup type.

Summary of the Get All Blanket PO Changes Subprocess

To view the properties of the Get All Blanket PO Changes subprocess, select the process in the navigator tree, then choose Properties from the Edit menu. The Get All Blanket PO Changes subprocess has a result type of PO Activity Performed, indicating that when the process completes, it has a result of Activity Performed. This result corresponds to the lookup code in the PO Activity Performed lookup type in the PO Standard item type.

This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only as a subprocess when called by a higher-level process.

The subprocess begins at node 1.
Nodes 2 and 3 compare the document with its previous archived revision to find all header and line changes for a blanket purchase order. The activities update the appropriate item attributes with the changed values.

Get All Blanket PO Changes Subprocess Activities

The following is a description of each activity in the Get All Blanket PO Changes subprocess, listed by the activity’s display name.

Start (Node 1)

This is a Standard function activity that simply marks the start of the subprocess.

Get Header Changes (Node 2)

This function activity gathers all of the changes that occurred in the blanket purchase agreement header and updates the appropriate item attributes with the changes.

Get Lines Changes (Node 3)

This function activity gathers all of the changes that occurred in the blanket purchase agreement lines and updates the appropriate item attributes with the changes.

End (Node 4)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Get All Blanket PO Changes subprocess activity has a result type of PO Activity Performed, each End activity node must have a process result matching one of the lookup codes in the PO Activity Performed lookup type.
Summary of the Get All Contract PO Changes Subprocess

To view the properties of the Get All Contract PO Changes subprocess, select the process in the navigator tree, then choose Properties from the Edit menu. The Get All Contract PO Changes subprocess has a result type of PO Activity Performed, indicating that when the process completes, it has a result of Activity Performed. This result corresponds to the lookup code in the PO Activity Performed lookup type in the PO Standard item type.

This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only as a subprocess when called by a higher-level process.

The subprocess begins at node 1.

Node 2 compares the document with its previous archived revision to find all the changes for a contract purchase order. (Contract purchase orders contain only header information.)

Get All Contract PO Changes Subprocess Activities

The following is a description of each activity in the Get All Contract PO Changes subprocess, listed by the activity’s display name.

Start (Node 1)

This is a Standard function activity that simply marks the start of the subprocess.

Get Header Changes (Node 2)

This function activity gathers all of the changes that occurred in the contract purchase order header and updates the appropriate item attributes with the changes.
**End (Node 3)**

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Get All Contract PO Changes subprocess activity has a result type of PO Activity Performed, each End activity node must have a process result matching one of the lookup codes in the PO Activity Performed lookup type.

---

**Summary of the Get All Planned PO Changes Subprocess**

To view the properties of the Get All Planned PO Changes subprocess, select the process in the navigator tree, then choose Properties from the Edit menu. The Get All Planned PO Changes subprocess has a result type of PO Activity Performed, indicating that when the process completes, it has a result of Activity Performed. This result corresponds to the lookup code in the PO Activity Performed lookup type in the PO Standard item type.

This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only as a subprocess when called by a higher-level process.

The subprocess begins at node 1.

Nodes 2, 3, 4, and 5 compare the document with its previous archived revision to find all header, line, shipment, and distribution changes for a planned purchase order.
Get All Planned PO Changes Subprocess Activities

The following is a description of each activity in the Get All Planned PO Changes subprocess, listed by the activity’s display name.

**Start (Node 1)**

This is a Standard function activity that simply marks the start of the subprocess.

**Get Header Changes (Node 2)**

This function activity gathers all of the changes that occurred in the planned purchase order header and updates the appropriate item attributes with the changes.

**Get Lines Changes (Node 3)**

This function activity gathers all of the changes that occurred in the planned purchase order lines and updates the appropriate item attributes with the changes.

**Get Shipments Changes (Node 4)**

This function activity gathers all of the changes that occurred in the planned purchase order shipments and updates the appropriate item attributes with the changes.

**Get Distribution Changes (Node 5)**

This function activity gathers all of the changes that occurred in the planned purchase order distributions and updates the appropriate item attributes with the changes.

**End (Node 6)**

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Get All Planned PO Changes subprocess activity has a result type of PO Activity Performed, each End activity node must have a process result matching one of the lookup codes in the PO Activity Performed lookup type.
Summary of the Get All Release Changes Subprocess

To view the properties of the Get All Release Changes subprocess, select the process in the navigator tree, then choose Properties from the Edit menu. The Get All Release Changes subprocess has a result type of PO Activity Performed, indicating that when the process completes, it has a result of Activity Performed. This result corresponds to the lookup code in the PO Activity Performed lookup type in the PO Standard item type.

This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only as a subprocess when called by a higher-level process.

The subprocess begins at node 1.

Nodes 2, 3, and 4 compare the document with its previous archived revision to find all release header, shipment, and distribution changes for a blanket or scheduled release.

Get All Release Changes Subprocess Activities

The following is a description of each activity in the Get All Release Changes subprocess, listed by the activity’s display name.

Start (Node 1)

This is a Standard function activity that simply marks the start of the subprocess.

Get Release Changes (Node 2)

This function activity gathers all of the changes that occurred in the release header and updates the appropriate item attributes with the changes.
Get Shipments Changes (Node 3)
This function activity gathers all of the changes that occurred in the release shipments and updates the appropriate item attributes with the changes.

Get Distribution Changes (Node 4)
This function activity gathers all of the changes that occurred in the release distributions and updates the appropriate item attributes with the changes.

End (Node 5)
This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Get All Release Changes subprocess activity has a result type of PO Activity Performed, each End activity node must have a process result matching one of the lookup codes in the PO Activity Performed lookup type.

Summary of the Get All Standard PO Changes Subprocess
To view the properties of the Get All Standard PO Changes subprocess, select the process in the navigator tree, then choose Properties from the Edit menu. The Get All Standard PO Changes subprocess has a result type of PO Activity Performed, indicating that when the process completes, it has a result of Activity Performed. This result corresponds to the lookup code in the PO Activity Performed lookup type in the PO Standard item type.

This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only as a subprocess when called by a higher-level process.

The subprocess begins at node 1.
Nodes 2, 3, 4, and 5 compare the document with its previous archived revision to find all header, line, shipment, and distribution changes for a standard purchase order.

Get All Standard PO Changes Subprocess Activities

The following is a description of each activity in the Get All Standard PO Changes subprocess, listed by the activity’s display name.

Start (Node 1)

This is a Standard function activity that simply marks the start of the subprocess.

Get Header Changes (Node 2)

This function activity gathers all of the changes that occurred in the standard purchase order header and updates the appropriate item attributes with the changes.

Get Lines Changes (Node 3)

This function activity gathers all of the changes that occurred in the standard purchase order lines and updates the appropriate item attributes with the changes.

Get Shipments Changes (Node 4)

This function activity gathers all of the changes that occurred in the standard purchase order shipments and updates the appropriate item attributes with the changes.

Get Distribution Changes (Node 5)

This function activity gathers all of the changes that occurred in the standard purchase order distributions and updates the appropriate item attributes with the changes.

End (Node 6)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process
result is assigned in the property page of the activity node. Since the Get All Standard PO Changes subprocess activity has a result type of PO Activity Performed, each End activity node must have a process result matching one of the lookup codes in the PO Activity Performed lookup type.

---

**Summary of the Do Document Changes Require Reapproval? Subprocess**

To view the properties of the Do Document Changes Require Reapproval? subprocess, select the process in the navigator tree, then choose Properties from the Edit menu. The Do Document Changes Require Reapproval? subprocess has a result type of Yes/No, indicating that when the process completes, it has a result of Yes or No. This result corresponds to the lookup code in the Yes/No lookup type in the Standard item type.

This process activity is not runnable, indicating that it cannot be initiated as a top–level process to run, but rather can be run only as a subprocess when called by a higher–level process.
The subprocess begins at node 1.

Node 2 determines the document type. Nodes 3 through 8 determine whether the changed components on the document require the document to go through the full approval process (find the next approver in the approval hierarchy, send notifications, and so on) or to be approved immediately. If the changed components require approval, the PO Approval Process (outside this subprocess, in the overall purchase order approval workflow) begins.

For example, if node 2 finds that the document is a blanket purchase agreement, node 3 checks if the changes to the agreement require full reapproval. Node 4 does the same for contract purchase orders, and so on.

The subprocess Do Document Changes Require Reapproval? uses reapproval rules that are already defined in Purchasing—or the Change Order Tolerance attributes, if you modified them—to determine if the document is required to go through the full approval process.
Do Document Changes Require Reapproval? Subprocess Activities

The following is a description of each activity in the Do Document Changes Require Reapproval? subprocess, listed by the activity’s display name.

**Start (Node 1)**
This is a Standard function activity that simply marks the start of the subprocess.

**Determine Document Type (Node 2)**
This function activity looks for the changed document’s document type.

**Does the Blanket PO Require Reapproval? (Node 3)**
This function activity returns the value of Yes when the blanket purchase agreement is required to go through the approval process and No if it is not. This subprocess uses reapproval rules that are already defined in Purchasing—or the Change Order Tolerance attributes, if you modified them—to determine if the document is required to go through the full PO Approval Process, or if it can be approved immediately.

**Does the Contract PO Require Reapproval? (Node 4)**
This function activity does the same as the previous activity, for contract purchase orders.

**Does the Planned PO Require Reapproval? (Node 5)**
This function activity does the same as the previous activity, for planned purchase orders.

**Does the Scheduled Release Require Reapproval? (Node 8)**
This function activity does the same as the previous activity, for scheduled releases.

**Does the Standard PO Require Reapproval? (Node 6)**
This function activity does the same as the previous activity, for standard purchase orders.
Does the Blanket Release Require Reapproval? (Node 7)

This function activity does the same as the previous activity, for blanket releases.

End (Nodes 9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19 and 20)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Do Document Changes Require Reapproval? subprocess activity has a result type of PO Activity Performed, each End activity node must have a process result matching one of the lookup codes in the PO Activity Performed lookup type.

Summary of the Change Order Reserve Before Approve Subprocess

To view the properties of the Change Order Reserve Before Approve subprocess, select the process in the navigator tree, then choose Properties from the Edit menu. The Change Order Reserve Before Approve subprocess has a result type of Yes/No, indicating that when the process completes, it has a result of Yes or No. This result corresponds to the lookup code in the Yes/No lookup type in the Standard item type.

This process activity is not runnable, indicating that it cannot be initiated as a top–level process to run, but rather can be run only as a subprocess when called by a higher–level process.
The subprocess begins at node 1.
If node 2 finds that encumbrance is on and funds are not yet reserved, node 4 attempts to reserve funds for the document.

If funds cannot be reserved, node 6 sends an Unable to Reserve Document notification to the approver. The approver must then use the Approve Document window to try to reserve the document again if, for example, more funds have been allocated, and then respond to the notification with Retry; reject the document; or forward the document to somebody else with approval authority to reserve the funds.

If the approver forwards the document, node 7 checks if the forward–to approver has a valid user name. If so, node 8 sets the Forward–To/From information for the new approver.

If the approver rejects the document, node 9 rejects the purchase order. If it cannot reject the purchase order (because the document failed the state check—for example, its status has changed to closed, frozen, or on hold), node 11 sends a notification to the approver that the document could not be rejected.

If the Document Approval Manager fails at node 4 or 9, the notification activity at node 5 or 10 sends a notification of the failure to the
approver, and the workflow continues if the approver or system administrator responds to the notification with Retry.

---

**Change Order Reserve Before Approve Subprocess Activities**

The following is a description of each activity in the Change Order Reserve Before Approve subprocess, listed by the activity’s display name.

**Start (Node 1)**

This is a Standard function activity that simply marks the start of the subprocess.

**Is Encumbrance On and Is Document Not Reserved? (Node 2)**

This function activity determines whether you are using encumbrance accounting, and whether the document is reserved.

**Reserve Document (Node 4)**

This function activity tries to reserve funds for the document.

**Document Manager Failed (Nodes 5 and 10)**

Any time the document manager fails, the approver receives a notification that it failed. Once a system administrator successfully restarts the Document Approval Manager, the approver must respond to the notification by choosing Retry, so that the workflow can continue.

**Unable To Reserve Document (Node 6)**

This activity notifies the document owner that Purchasing failed to reserve funds for the document, and provides instructions for resolving the failure.

**Is Forward-To Valid? (Node 7)**

This function activity checks that the Forward-To name entered in the Forward-To field, in response to an approval notification, is a valid user name.
Set Forward–To/From For Forward Action (Node 8)

This function activity resets the Forward–To and Forward–From attributes after a Forward action.

Reject the PO (Node 9)

This function activity sets a rejected purchase order to a Rejected status and records the rejection in the Action History window. It also reverses encumbrance if the document has been encumbered.

Unable to Reject Document (Node 11)

This activity sends a notification to the document owner that Purchasing was unable to properly reject the document.

End (Nodes 3 and 12)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Change Order Reserve Before Approve subprocess activity has a result type of Yes/No, each End activity node must have a process result matching one of the lookup codes in the Yes/No lookup type.

Summary of the Approve PO (Change Order) Subprocess

To view the properties of the Approve PO (Change Order) subprocess, select its process activity in the navigator tree, then choose Properties from the Edit menu. The Approve PO (Change Order) subprocess has a result type of PO Approval Action and Doc Verification, indicating that when the subprocess completes, it has a result of Invalid Action or Valid Action. These results correspond to the lookup codes in the PO Approval Action and Doc Verification lookup type, in the PO Standard item type.

This subprocess activity is not runnable, indicating that it cannot be initiated as a top–level process to run, but rather can be run only as a subprocess when called by a higher–level process.

If the change to the purchase order requires full reapproval, this process approves the purchase order. If while approving the purchase order, validation fails, this process sends a notification to the buyer that the document failed state or correctness checks.
The subprocess begins at node 1.

Node 2 checks if the document was already approved (for example, in the Reserve Before Approve subprocess). If so, this subprocess ends at node 3 and the workflow (in the PO Approval Process), sends a notification to the buyer that the document has been approved.

Otherwise, node 4 verifies that the document is ready for approval. If not, node 5 sends a notification to the approver that the document failed the state check (for example, the document’s status has changed to closed, frozen, or on hold). Then, node 6 reverts the purchase order to its status before it entered this subprocess, and the workflow ends at node 7. If you modify and resubmit the purchase order or create a new one, the PO Approval workflow starts over when you submit the purchase order for approval.

If the document passes the state check, node 8 verifies that the document is complete, such as ensuring that it contains at least one line and one distribution. If the document is not complete, node 10 sends a notification of such to the approver. The approver can respond to the notification by choosing Retry (useful if there is a system-level issue), or reject the document. If node 13 cannot reject the document (for example, the document’s status has changed to closed, frozen, or on hold), node 14 sends the Unable to Reject Document notification to the document owner.

If the document passes the state check and is complete, node 17 approves the document, and node 19 retrieves purchase order information and other internal Workflow attributes, in case these have changed.
If the Document Approval Manager fails at node 4, 8, 13, or 17, the notification activity at node 9, 11, 12, or 18 sends a notification of the failure to the approver. Once the Document Approval Manager is restarted successfully, the workflow continues if the approver or system administrator responds to the notification with Retry.


### Approve PO (Change Order) Subprocess Activities

The following is a description of each activity in the Approve PO subprocess, listed by the activity’s display name.

**Start (Node 1)**

This is a Standard function activity that simply marks the start of the subprocess.

**Is Document Approved? (Node 2)**

If you are using encumbrance and the document was Pre–Approved at the time that funds were reserved for it, then its status already changed to Approved.

**Does Document State Allow Approval? (Node 4)**

Examples of document statuses that allow an approval action are Incomplete, In Process, and Pre–Approved.

**Is Document Complete? (Node 8)**

This function activity verifies that the document is complete—for example, verifying that all the quantities match, and at least one line and one distribution exist.

**Approve the PO (Node 17)**

This function activity sets the status of the purchase order to Approved.
Get PO Attributes (Node 19)
This function activity retrieves key values from the purchase order header and lines, in case these have changed, and assigns them to Workflow attributes.

Document Manager Failed (Nodes 9, 11, 12, and 18)
If the document approval manager fails, the approver receives this notification that it failed. Once a system administrator successfully restarts the document manager, the approver must respond to the notification by choosing Retry, so that the workflow can continue.

Document Failed State Check (Node 5)
This activity sends a notification to the approver that the document failed the state check. See: Document Status Checks: page 2 – 26.

Set PO Status to Original Status (Node 6)
This function activity sets the purchase order back to its status before it entered this process activity, if the document has failed the state check.

Unable To Approve (Node 10)
This activity sends a notification to the approver that Purchasing was unable to approve the document.

Reject the PO (Node 13)
This function activity updates the status of the document to Rejected and records the rejection in the Action History window.

Unable to Reject Document (Node 14)
This activity sends a notification to the approver that Purchasing was unable to reject the document—for example, because its status is closed, frozen, or on hold.

End (Nodes 3, 7, 15, and 16)
This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the
Approve PO (Change Order) subprocess activity has a result type of PO Approval Action and Doc Verification, each End activity node must have a process result matching one of the lookup codes in the PO Approval Action and Doc Verification lookup type.

Summary of the Print and Fax Document Processes (Change Order)

To view the properties of the Print Document Process (Change Order) or the Fax Document Process (Change Order), select its process activity in the navigator tree, then choose Properties from the Edit menu. This subprocess has a result type of PO Activity Performed, indicating that when the subprocess completes, it has a result of Activity Performed. This result corresponds to the lookup code in the PO Activity Performed lookup type, in the PO Standard item type.

Print Document Process (Change Order)
The subprocess begins at node 1.

Node 2 checks if Print was selected in the Approve Document window when the purchase order was first submitted for approval. If Print was selected, node 4 prints the document.

Fax Document Process (Change Order)
The Fax Document Process (Change Order) looks and behaves like the Print Document Process (Change Order) except that node 2 checks if Fax was selected in the Approve Document window. If Fax was selected, node 4 automatically sends a facsimile of the document if a
Fax Number was also entered in the Approve Document window. (If a Fax Number was not specified, the document is sent to your facsimile server once it is approved. Depending on your CommercePath setup, you can choose where or when to send the documents that are stored on your facsimile server.)

CommercePath, or any facsimile software that uses the CommercePath Fax Command Language (FCL), must be installed to use the facsimile functionality.

---

**Print and Fax Document Process (Change Order) Activities**

The following is a description of each activity in the Print Document (Change Order) subprocess and the Fax Document (Change Order) subprocess, listed by the activity’s display name.

**Start (Node 1)**

This is a Standard function activity that simply marks the start of the subprocess.

**Does User Want Document Printed? (Node 2)**

This function activity checks if Print was selected in the Approve Document window when the purchase order was first submitted.

In the Fax Document Process, the function activity Does User Want Document Faxed? checks if Fax was selected in the Approve Document window. CommercePath, or any facsimile software that uses the CommercePath Fax Command Language (FCL), must be installed to use the facsimile functionality.

**Print Document (Node 4)**

If Print was selected in the Approve Document window when the purchase order was first submitted, this activity prints the document.

In the Fax Document Process, the function activity Fax Document automatically sends a facsimile of the document if a Fax Number was entered in the Approve Document window. CommercePath, or any facsimile software that uses the CommercePath Fax Command Language (FCL), must be installed to use the facsimile functionality.
End (Nodes 3 and 5)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Print Document (Change Order) subprocess activity has a result type of PO Activity Performed, each End activity node must have a process result matching one of the lookup codes in the PO Activity Performed lookup type.
**Workflow for Creating Purchase Orders and Releases**

Purchasing integrates with Oracle Workflow technology to create standard purchase orders or blanket releases automatically from approved requisition lines. The workflow for creating purchasing documents automatically is called PO Create Documents. You can modify this workflow in the Oracle Workflow Builder to define additional business rules that determine when your approved requisitions are automatically converted into standard purchase orders and blanket releases.

In the Workflow Builder, PO Create Documents consists of several processes. Each of these processes is viewable in the Workflow Builder as a diagram whose objects and properties you can modify. Each workflow process consists of individual functions.

For each document that is created successfully by the PO Create Documents workflow, the PO Approval workflow is called to approve the document if you have allowed automatic approval. See: Choosing Document Creation Options: page 1 – 95. See: Purchase Order Approval Workflow: page C – 114.

The PO Create Documents workflow is initiated at the end of the requisition approval workflow for approved requisition lines. The workflow begins automatic document creation if you’ve kept the item attribute Is Automatic Creation Allowed? set to Y for Yes, if source documents are associated with the requisition lines, and you have properly set up sourcing rules (see: Setting Up Automatic Sourcing: page 5 – 33). If the source document associated with the requisition line is a quotation, a standard purchase order is created. If the source document is a blanket purchase agreement, a release is created.

There are also workflow processes for approving changes to purchase orders and releases. See: Workflow Processes for Approving Change Orders: page C – 171.

**Customizing the Automatic Document Creation Workflow**

Use the Oracle Workflow Builder to customize workflows. When you customize a workflow, only those documents that are created after you customize it are affected by the customized workflow.

You can also use the Workflow Builder to create unique document creation workflows for each document type in your organization. You associate particular workflows with certain document types in the Document Types window. See: Defining Document Types: page 1 – 87.
You can use the Workflow Monitor to follow where certain documents are in a workflow process. See: Workflow Monitor, Oracle Workflow Guide.

To display the workflow in the Oracle Workflow Builder:

1. Choose Open from the File menu, and connect to the database.
   See: Opening and Saving Item Types, Oracle Workflow Guide.
   The Display name of the automatic document creation workflow is PO Create Documents. The name of its Workflow definition file is poxwfatc.wft.

   ![Workflow Builder](image)

2. Expand the data source, then the PO Create Documents item type branch within that data source.

3. Expand the Processes branch, then double-click a process activity to display its diagram.

Creating a New Custom Process

You can either modify the default PO Create Documents workflow that Purchasing provides, or copy it and create a whole new workflow. Use the Document Types window to select a custom Workflow Startup Process for specific document types or operating units.

If you create different workflows for different documents or operating units, the recommended practice is not to copy and rename the item type (such as PO Create Documents 1), but to copy and rename the Workflow Startup Process, which you will modify to call your own
custom subprocesses. All of your operating units will point to the same item type, and will use the default item attributes and other activities that the item type requires, but one operating unit will also use your custom startup process.

**Attention:** Creating a new workflow process with a new Internal Name affects the implementation of future upgrades. See: Upgrade Support: page C – 5.

**Required Modifications**

There are no required modifications you need to make to the PO Create Documents workflow. However, this documentation assumes that you have already set up Purchasing and performed the Workflow setup steps described in Workflow Setup Options: page 1 – 95.

**Supported and Unsupported Customizations**

Following is a discussion of what you can and *definitely cannot* modify in the PO Create Documents workflow. For those things you can modify, the discussion includes important guidelines that you need to be careful of when making customizations.

For important information on how to customize workflows, see the Oracle Workflow Guide.

To further help you with your customizations, refer to the sections later in this document, starting with The PO Create Documents Workflow Item Attributes: page C – 216. These sections describe the components of the automatic document creation processes in the PO Create Documents workflow. If you haven’t already, see also: Customization Guidelines: page C – 5.

**Attention:** If a particular Workflow object does not appear in the following sections on the lists of things you can customize, do not modify it, regardless of its access level.

**Attributes**

You can modify the following attributes only, by changing their Default Value:

- Is Automatic Creation Allowed?
- Is Automatic Approval Allowed?
- Should Workflow Create the Release?
For information on modifying these item attributes’ default values, see: Choosing Document Creation Options: page 1 – 95.

Processes

If you modify a process, it is essential that the basic flow remain intact to maintain data integrity in the database. For example, the function activity Get Req Line Info in the process Verify Req Line Information updates many item attributes with requisition line information. In turn, these item attributes pass that information on to other function activities and processes in the workflow. Therefore, you should not remove or bypass this function activity, and if you replace it with one of your own, you still need to make sure that these item attributes are set. However, you could add additional checks (processes or function activities) to the Verify Req Line Information process.

If you modify any process, either by replacing a portion of its flow or by adding additional function activities, remember the following:

• Attributes that are set by default function activities in the default processes must also be set if you replace default function activities with ones of your own. That is, if a function activity in that process uses a SetItemAttr statement, then that function activity is setting an attribute to be used by another function activity later. Therefore, your new function activity must do the same. You should also preserve SetItemUserKey and SetItemOwner statements if any. Depending on your customizations, you may also want to preserve GetItemAttr statements.

• Any database state maintained by the default processes must also be maintained by processes you customize. That is, if a function activity in that process uses an Update or Insert Into statement, then that function activity is updating or inserting rows in the database. Therefore, your new function activity must maintain the same database state.

To get a list of the workflow function activities that use SetItemAttr, GetItemAttr, SetItemUserKey, SetItemOwner, Insert Into, or Update statements, run the PL/SQL script powfcust. For instructions on running this script, see: Customization Guidelines: page C – 5.

You can modify all of the processes in PO Create Documents, taking into careful consideration the information described below for each:
Overall Document Creation / Launch Approval

In the Overall Document Creation / Launch Approval process, you could replace the function activity Is Automatic Creation Allowed? with one of your own. Right now, this function activity looks to an item attribute of the same name to see whether automatic document creation from an approved requisition is allowed. But you could replace this function activity with one of your own that has more complex logic. For example, you could replace this function activity with one that allows automatic document creation for requisitions under a certain total price.

You could also add a notification activity—for example after Launch Process to Create and Approve Purchase Order and Release—to let buyers know that the workflow is currently attempting to create and approve your purchase order.

Other than these kinds of additions, you should not interrupt the basic flow of the Overall Document Creation / Launch Approval process by adding or removing any other function activity.

Create and Approve Purchase Order or Release

Just as with Is Automatic Creation Allowed? in the Overall Document Creation / Launch Approval process, you can replace the function activity Is Automatic Approval Allowed? with one of your own that allows automatic approval for only certain kinds of documents. For example, you could automatically approve purchase orders under a certain total price.

Get Buyer

You could modify the Get Buyer process by adding a final function activity that, if no buyer is found by any of the previous activities, always uses a certain buyer. Or, you could replace all of these function activities with one or more of your own that simply uses buyer workload to determine which buyer to use for the purchase order or release.

Does Req Line Have Enough Information to Automatically Create a Document?

It is not recommended that you replace the function activities in this process with function activities of your own.

For example, a supplier is required to create a purchase order or release. Therefore, you should not replace the function activity Does The Req Line Have Valid Supplier Information? with anything else. Additionally, information gathered from this function activity is used...
later by function activities like Launch Process to Create and Approve Purchase Order or Release and Get The Source Document Type which get required supplier and pricing information.

Similarly, if you don't gather source document information through the function activity Does The Req Line Have Valid Source Document Information?, many function activities in the Verify Req Line Information subprocess will not be able to complete.

Even though it is not recommended to replace any of the function activities in Does Req Line Have Enough Information to Automatically Replace a Document?, you could add function activities—for example, additional information checks—to this subprocess.

**Verify Req Line Information**

In the Verify Req Line Information subprocess, the function activity Should Workflow Create the Release? looks to an item attribute by the same name to see whether the item attribute says Y for Yes or N for No. (You can set this to Y or N yourself, as described in Choosing Document Creation Options: page 1 – 95. The default is Y for workflow to create the release.) The function activity Should Workflow Create the Release? looks to its corresponding item attribute to determine if Workflow should create the release, or if Workflow should leave the release to you to create, through the AutoCreate Documents window.

You could replace the function activity Should Workflow Create the Release? with one of your own that uses a different logic (besides Yes/No) to determine whether workflow should create the release. You could make a function activity that looks at the pricing or supplier information on a requisition to determine whether to create the release. For example, Workflow could create the release automatically only for certain suppliers; for other suppliers, it won’t, and you would use AutoCreate to create those releases yourself.

**Notifications**

You can modify the following notifications in the PO Create Documents workflow, as your public sector needs require:

- Purchase Order Or Release Has Been Created

Function Activities

You cannot modify any function activity in the PO Create Documents workflow.

However, you can replace some function activities with function activities of your own. When you replace a function activity, you are modifying the process in which it is contained. See the guidelines for customizing the PO Create Documents processes in the section Processes above.

If you substitute default function activities in a process with function activities that you create, you must remember the following:

- The result type of your new function activity must match the result type of the default activity. That is, the Result Type of the function activity in the Workflow Builder needs to match the result type specified by that function activity’s corresponding PL/SQL procedure—for example, a Result Type of Yes/No. It also means that if you have, for example, two results (such as Yes and No) in your function activity and corresponding PL/SQL procedure, you need to make sure that there are two corresponding transitions in the workflow diagram (one for Yes and one for No). If you change the result types and transitions in a process, be careful that you aren’t deleting or bypassing any special transitions or checks.

- Just as in the section Processes above, any attributes that were set by the default function activity must also be set by your customized function activity.

- Just as in the section Processes above, any database state maintained by the default function activity must also be maintained by the customized function activity.

Messages

You can modify the message body of the following messages in the PO Create Documents workflow:

- PO Document Created

Lookup Types

You cannot modify any Lookup Types in the PO Create Documents workflow.
The PO Create Documents Item Type

The automatic document creation process is associated with an item type called PO Create Documents. This item type identifies all workflow processes available for automatic purchase order and release creation. The following workflow processes are associated with PO Create Documents:

- Overall Document Creation / Launch Approval: page C – 219
- Verify Req Line Information: page C – 225
- Does This Req Line Have Enough Information to Automatically Create a Document?: page C – 231
- Create and Approve Purchase Order or Release: page C – 233
- Get Buyer: page C – 236

The PO Create Documents item type also has many attributes associated with it. These attributes reference information in the Purchasing application tables. The attributes are used and maintained by function activities as well as notification activities throughout the process.

The following table shows the PO Create Documents Workflow item type attributes.

### PO Create Documents Workflow Item Type Attributes

<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent ID</td>
<td>Unique identifier for the buyer</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Autocreated Document ID</td>
<td>Unique, internal identifier for the workflow–created document</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Buyer UserName</td>
<td>User name of the buyer as set up in Oracle Applications</td>
<td>Text</td>
<td>100</td>
</tr>
<tr>
<td>Category ID</td>
<td>Unique identifier for the item category</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Currency Code</td>
<td>Currency used on the document, such as USD</td>
<td>Text</td>
<td>15</td>
</tr>
</tbody>
</table>

Table C – 14  (Page 1 of 4)
<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Number Created</td>
<td>Document (PO) number of the purchase order or release</td>
<td>Text</td>
<td>50</td>
</tr>
<tr>
<td>Document Type CreatedDisp</td>
<td>Display name for the document type</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Document Type To Create</td>
<td>Document type (standard or blanket) that the workflow will create from the requisition</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Group ID</td>
<td>Unique identifier for the requisition lines, once they are grouped</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Interface Header ID</td>
<td>Temporary identifier for the requisition lines while they are being grouped in the temporary tables</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Interface Source</td>
<td>Requisition Import source such as INV</td>
<td>Text</td>
<td>30</td>
</tr>
<tr>
<td>Is Automatic Creation Allowed?</td>
<td>Indicator (Y for Yes or N for No) of whether this workflow is initiated for all approved requisition lines</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Is Automatic Approval Allowed?</td>
<td>Indicator (Y for Yes or N for No) of whether the purchase order approval workflow is initiated automatically after this workflow</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Item ID</td>
<td>Unique identifier for the item</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>On RFQ Flag</td>
<td>Indicator of whether the requisition line is associated with an RFQ</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Open Document</td>
<td>Command that Purchasing sends to open the purchase order or release from the notification notifying you that workflow has created the document</td>
<td>Form</td>
<td></td>
</tr>
</tbody>
</table>

Table C – 14  (Page 2 of 4)
<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org ID</td>
<td>Unique identifier for the operating unit in which the document was created</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>P–Card ID</td>
<td>Unique identifier for the procurement card number specified on a requisition in iProcurement</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>PO Number To Create</td>
<td>Emergency PO Number specified on a requisition in iProcurement</td>
<td>Text</td>
<td>20</td>
</tr>
<tr>
<td>Rate</td>
<td>Exchange rate on the requisition that gets carried over to the purchase order</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Rate Date</td>
<td>Date upon which the exchange rate is obtained</td>
<td>Date</td>
<td></td>
</tr>
<tr>
<td>Rate Type</td>
<td>Exchange rate type</td>
<td>Text</td>
<td>30</td>
</tr>
<tr>
<td>Requisition ID</td>
<td>Unique identifier for the requisition from which the purchase order or release is being created</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Requisition Line ID</td>
<td>Unique identifier for the requisition line from which the purchase order or release is being created</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>RFQ Required Flag</td>
<td>Indicator of whether an RFQ is required for the item on the requisition line before the line can be automatically created onto a purchase order</td>
<td>Text</td>
<td>1</td>
</tr>
</tbody>
</table>

Table C – 14  (Page 3 of 4)
<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Should Workflow Create The Release?</td>
<td>Indicator (Y for Yes or N for No) of whether this workflow creates releases or leaves them to you to create using AutoCreate</td>
<td>Text</td>
<td>1</td>
</tr>
<tr>
<td>Source Document ID</td>
<td>Unique identifier for the source document referenced on the requisition</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Source Document Line Num</td>
<td>Source document line number used on the requisition</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Source Document Type Code</td>
<td>Type of the source document used</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Suggested Buyer ID</td>
<td>Unique identifier for the suggested buyer on the requisition</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Suggested Supplier ID</td>
<td>Unique identifier for the suggested supplier on the requisition</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Suggested Supplier Site ID</td>
<td>Unique identifier for the suggested supplier site on the requisition</td>
<td>Text</td>
<td>240</td>
</tr>
<tr>
<td>Suggested Supplier Name</td>
<td>Name of the suggested supplier on the requisition</td>
<td>Text</td>
<td>80</td>
</tr>
<tr>
<td>Suggested Supplier Site ID</td>
<td>Unique identifier for the suggested supplier site on the requisition</td>
<td>Number</td>
<td></td>
</tr>
</tbody>
</table>

Table C–14  (Page 4 of 4)

**Summary of Overall Document Creation / Launch Approval Process**

To view the properties of the Overall Document Creation / Launch Approval process, select the process in the navigator tree, then choose Properties from the Edit menu. The Overall Document Creation / Launch Approval Process process has a result type of None, indicating that when the process completes, it does not have a specific result of, for example, Invalid or Valid, which are found in the Lookup Types.
branch in the Workflow Builder. Its subprocesses have specific result types associated with them.

This process activity is also runnable, indicating that it can be initiated as a top-level process to run by making calls to the Workflow Engine CreateProcess and StartProcess APIs.

The Overall Document Creation / Launch Approval process is initiated when requisition lines are approved, you’ve kept the item attribute Is Automatic Creation Allowed? set to Y for Yes, a source document is associated with the requisition line, and you have properly set up sourcing rules (see: Setting Up Automatic Sourcing: page 5–33).
Using the Account Generator in Oracle Public Sector Purchasing
The process begins at node 1.

Node 2 checks the item attribute Is Automatic Creation Allowed? to see if this workflow for creating documents automatically from approved requisition lines should begin at all.

If automatic document creation is allowed, node 4 launches the subprocess Verify Req Line Information, which checks if the requisition line has enough information from which to automatically create a document. For example, only requisition lines with source documents associated with them can be automatically created by this workflow.

Node 5 waits for all the requisition lines to be processed by the subprocess Verify Req Line Information.

After all requisition lines on the requisition are processed, node 6 checks if the requisition is an emergency requisition created in Oracle iProcurement. An emergency requisition is given a purchase order number in advance. Instead of waiting to group similar requisition lines onto single purchase orders or releases, the PO Create Documents workflow places emergency requisition lines onto their own purchase order at node 8. At node 8, the workflow puts all of an emergency requisition’s lines (which have the same Emergency PO Number) onto one purchase order, bypassing the grouping of requisition lines at node 7.

For all other requisitions, the requisition lines on each requisition get grouped appropriately by node 7. For example, if two requisition lines on a requisition have the same Supplier, Site, Currency, and Buyer, they are created on a single purchase order header. Node 7 processes and groups lines from one requisition at a time.

Node 9 launches the Create And Approve Purchase Order or Release process. Node 10 waits for the purchase orders or releases to be created and approved before moving on to the next activity. Node 11 removes the requisition lines from the temporary storing place where they were kept to see which ones could be grouped together.

---

**Overall Document Creation / Launch Approval Process Activities**

The following is a description of each activity listed by the activity’s display name. You can create all the components for an activity in the graphical Workflow Builder except for the PL/SQL stored procedures that the function activities call. All function activities execute PL/SQL
stored procedures which you must create and store in the Oracle RDBMS. The naming convention for the PL/SQL stored procedures is:

\[ \text{<PACKAGE> . <PROCEDURE>} \]

\text{<PACKAGE>} is the name of the package that groups all of the procedures. \text{<PROCEDURE>} represents the name of the procedure.

To view the package and procedure names used by the PO Create Documents processes, view the Properties page for each function activity. For example, the function activity Is Automatic Creation Allowed? uses the \text{<PACKAGE> . <PROCEDURE>} name \text{PO_AUTOCREATE_DOC . SHOULD_REQ_BE_AUTOCREATED}.

You can use the Item Type Definitions Web page to view \text{<PACKAGE> . <PROCEDURE>} names. See: Item Type Definitions Web Page, \textit{Oracle Workflow Guide}.

**Start (Node 1)**

This is a Standard function activity that simply marks the start of the subprocess.

**Is Automatic Creation Allowed? (Node 2)**

This function activity checks the item attribute Is Automatic Creation Allowed? The default value of this item attribute is Y for Yes. If the value is Y, then automatic document creation is allowed, and the workflow continues. You can prevent automatic document creation by setting the default value of this attribute in the Workflow Builder to N for No.

**Launch Process To Verify Req Line Information (Node 4)**

This function activity retrieves all requisition lines on the requisition that are available for processing and launches the Verify Req Line Information process for each requisition line.

**Wait For Flow (Nodes 5 and 10)**

The first Wait For Flow activity waits for all the requisition lines to be processed by Verify Req Line Information. The second Wait For Flow activity waits for the purchase orders or releases to be created and approved before moving on to the next activity.
Is This An Emergency Requisition? (Node 6)

Emergency requisitions are created in iProcurement and submitted to Purchasing for approval and document creation. An emergency requisition is given a purchase order number in advance. Instead of waiting to group similar requisition lines onto single purchase orders or releases, this workflow places emergency requisition lines onto their own purchase order, bypassing the grouping of requisition lines.

Note: In iProcurement, you cannot put multiple suppliers on an emergency requisition.

For more information about iProcurement, see the iProcurement Implementation Manual.

Group Req Lines Into Purchase Orders Or Releases (Node 7)

Once Verify Req Line Information finishes processing all the requisition lines, this function activity groups together requisition lines that have similar characteristics and allows them to be created onto the same document. For example, if two requisition lines have the same Supplier, Site, Currency, and Buyer, they are created on a single purchase order header. This function activity also groups procurement card lines created in iProcurement that have the same procurement card number, supplier, and supplier site onto one purchase order or release.

Put All Requisition Lines On A Purchase Order (Node 8)

This function activity places all emergency requisition lines, which have the same Emergency PO Number, onto one purchase order.

Launch Process To Create/Approve PO or Release (Node 9)

This function activity initiates the Create and Approve Purchase Order Or Release process for each document. Then it initiates the PO Approval workflow so that purchase orders or blanket releases that match pre-defined approval criteria get approved automatically.

Remove Processed Req Lines From Temp Table (Node 11)

In the Verify Req Line Information process, the function activity Insert Req Line Into Temp Table As A Candidate For Creation puts into a temporary table those requisition lines that contain enough information to attempt automatic document creation. These lines are picked up from this table later when certain requisition lines are grouped onto
particular purchase orders or releases. Once these purchase orders or releases are created, the lines in this temporary table can be purged. That is what this function activity, Remove Processed Req Lines From Temp Table, does.

**End (Nodes 3 and 12)**

This function activity marks the end of the process.

---

**Summary of the Verify Req Line Information Process**

To view the properties of the Verify Req Line Information process, select the process in the navigator tree, then choose Properties from the Edit menu. The Verify Req Line Information process has a result type of PO Req Line AutoCreatable?, indicating that when the process completes, it has a result of Automatic Creation Not Allowed, Automatic Creation Not Done Through Workflow, Not Enough Information For Autocreation, or Req Line Can Be Automatically Created. These results correspond to the lookup codes in the PO Req Line AutoCreatable? lookup type in the PO Create Documents item type.

This process activity is also runnable, indicating that it can be initiated as a top–level process to run by making calls to the Workflow Engine *CreateProcess* and *StartProcess* APIs.

The Verify Req Line Information process is initiated by the activity Launch Process To Verify Req Line Information.
The process begins at node 1.

Node 2 retrieves information from the requisition line. Node 3 checks how the profile option *PO: Warn if RFQ Required before AutoCreate* is set. If it is set to Yes, the requisition line is not on an RFQ, and RFQ Required is checked for the requisition line, the workflow stops automatic document creation because it is unable to issue the warning. This requisition line will be available in the AutoCreate Documents window. Otherwise, even if an RFQ is required for the requisition line, as long as the profile option *PO: Warn if RFQ Required before AutoCreate* is set to No, the workflow continues creating the document.

Node 5 checks if the requisition line has enough information from which to create a purchase order or release.

Node 7 checks if the requisition is an emergency requisition created in iProcurement, and node 8 checks if a procurement (credit) card number is associated with the requisition. Emergency and procurement card requisitions can be created in iProcurement only.

If the requisition line comes from an emergency or procurement card requisition, none of the activities related to node 12 are performed. Since the workflow does not require an emergency or procurement card requisition to have a source document associated with it, the workflow skips node 12, moves directly to node 9, and continues.

**Note:** Although a procurement card requisition line doesn’t require a source document, if it is associated with a source document such as a blanket purchase agreement, the workflow (through the activity Group Requisition Lines, in a later subprocess) does create a release.

For all other requisition lines, the workflow uses node 12 to retrieve the source document type. If the source document is a quotation, or if the source document is a blanket purchase agreement but the requisition line is for a one-time item, node 9 inserts the requisition line into a temporary table as a candidate for automatic document creation, and the workflow continues.

For a requisition line that has a blanket purchase agreement as a source document (as determined by node 12) and that is not for a one-time item (as determined by node 13), the workflow at node 14 gives different results depending on the release generation method:

- If there is no release generation method, the workflow ends at Node 15.
- If the release generation method is Automatic Release/Review or Automatic Release, the workflow ends at node 16 or 17
respectively; instead the document will be created automatically through the Create Releases process.

- If the release generation method is Release Using AutoCreate, node 19 checks the item attribute Should Workflow Create the Release? to see how you set up Purchasing. If you left this item attribute set to Y for Yes, the workflow creates the release. Otherwise, it ends at node 18, and you can create the release through the AutoCreate Documents window.

**Note:** No release generation method is retrieved for one–time items at node 14 since the Approved Supplier List does not support one–time items and the release generation method is specified in the Approved Supplier List. If the requisition line is for a one–item item but also associated with a blanket purchase agreement, the workflow does create a release from it later, using the activity Group Requisition Lines. The workflow in this case does not need to retrieve a release generation method from the Approved Supplier List.

---

**Verify Req Line Information Process Activities**

The following is a description of each activity in the Verify Req Line Information process, listed by the activity’s display name.

**Start (Node 1)**

This is a Standard function activity that simply marks the start of the subprocess.

**Get Req Line Info (Node 2)**

This function activity retrieves information from the requisition line and updates the item attributes in the PO Create Documents workflow with the information. For example, the Currency Code attribute (under Attributes in the Workflow Builder) gets updated with information from the Currency field in the Requisition line.

**Does This Req Line Require An RFQ? (Node 3)**

This function activity checks if the following is true: RFQ Required is selected in the Requisitions window, the profile option *PO: Warn if RFQ Required before AutoCreate* is set to Yes, and the requisition line has not been autocreated into an RFQ. If all of these are true, the workflow
ends because it is unable to issue the RFQ Required warning. Otherwise, the workflow continues.

**Does Req Line Have Enough Information to Create Document? (Node 5)**

See: Does This Req Line Have Enough Information to Automatically Create a Document?: page C – 231.

**Is This An Emergency Requisition? (Node 7)**

Emergency requisitions are created in iProcurement and submitted to Purchasing for approval and document creation. An emergency requisition is given a purchase order number in advance. Since this workflow does not require an emergency requisition line to have a source document, this workflow bypasses the function activity Get The Source Document Type (node 12) for emergency requisition lines.

**Is This Req Line a P–Card Line? (Node 8)**

This function activity checks if the requisition line has a procurement card number associated with it. A procurement card (or P–Card) is a corporate credit card used on iProcurement requisitions only.

**Get The Source Document Type (Node 12)**

This function activity checks for the source document type—blanket agreement or quotation—referred on the requisition line.

**Does the Req Line Have A One–Time Item? (Node 13)**

This function activity checks for the type of item—one–time or predefined—used on the requisition line.

**Get Release Generation Method From ASL (Node 14)**

If the requisition line has a predefined item, this function activity checks if an approved supplier list (ASL) entry exists for that particular combination of item, supplier, and supplier site. Then the function activity retrieves the Release Generation Method specified in the ASL.

If the Release Generation Method is either Automatic Release or Automatic Release Review, then the Creates Releases process in Purchasing will create a blanket release for the requisition line. If the
Release Generation Method is Release Using AutoCreate, then the workflow continues.

**Should Workflow Create The Release? (Node 19)**

This function activity checks the value of the attribute Should Workflow Create The Release? If the value of this attribute is set to Y for Yes, then the workflow creates the release; otherwise, you must use the AutoCreate Documents window to create the release.

**Insert Req Line Into Temp Table As A Candidate For Creation (Node 9)**

This function activity puts into a temporary table those requisition lines that contain enough information to attempt automatic document creation. These lines are picked up from this table later when certain requisition lines are grouped onto particular purchase orders or releases. Once these purchase orders or releases are created, the lines in this temporary table are purged. (The function activity that does the purging is Remove Processed Req Lines From Temp Table in the Overall Document Creation / Launch Approval Process.)

**Continue Flow (Node 10)**

This function activity tells the first Wait for Flow function activity in the Overall Document Creation / Launch Approval Process that Verify Req Line Information for a particular requisition line has been completed successfully. Wait for Flow now has to wait only for the other requisition lines to be processed.

**End (Nodes 4, 6, 11, 15, 16, 17, and 18)**

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Verify Req Line Information process activity has a result type of PO Req Line AutoCreatable?, each End activity node must have a process result matching one of the lookup codes in the PO Req Line AutoCreatable? lookup type.
Summary of the Does Req Line Have Enough Information To Automatically Create A Document? Process

To view the properties of the Does Req Line Have Enough Information To Automatically Create A Document? process, select the process in the navigator tree, then choose Properties from the Edit menu. This process has a result type of Yes/No, indicating that when the process completes, it has a result of Yes or No. These results correspond to the lookup codes in the Yes/No lookup type in the Standard item type.

This process activity is also runnable, indicating that it can be initiated as a top-level process to run by making calls to the Workflow Engine CreateProcess and StartProcess APIs.

The process Does Req Line Have Enough Information To Automatically Create A Document? process is used within the process Verify Req Line Information.

The process begins at node 1.

Node 2 checks if the requisition line has enough, correct supplier information, and node 5 checks if the requisition line has enough,
correct source document information. This information is needed to automatically create a purchase order or blanket release.

If node 4 indicates that the requisition is an emergency requisition, or node 6 indicates that the requisition is a procurement card requisition, the workflow does not need to check for source document information at node 5 since a source document is not required for these requisitions. Emergency and procurement card requisitions can be created in iProcurement only.

At node 8, the workflow determines which buyer to use for the automatically created document.

---

**Does Req Line Have Enough Information To Automatically Create A Document? Process Activities**

The following is a description of each activity in the Does Req Line Have Enough Information To Automatically Create A Document? process, listed by the activity’s display name.

**Start (Node 1)**

This is a Standard function activity that simply marks the start of the subprocess.

**Does The Req Line Have Valid Supplier Information? (Node 2)**

This function activity checks if a valid Supplier and Supplier Site exist for the requisition line.

**Is This An Emergency Requisition? (Node 4)**

Emergency requisitions are created in iProcurement and submitted to Purchasing for approval and document creation. An emergency requisition is given a purchase order number in advance. Since this workflow does not require an emergency requisition line to have a source document, this workflow bypasses the function activity Does The Req Line Have Valid Source Document Information? (node 5) for emergency requisition lines.
Is This Req Line a P–Card Line? (Node 6)
This function activity checks if the requisition line has a procurement card number associated with it. A procurement card (or P–Card) is a corporate credit card used on iProcurement requisitions only.

Does The Req Line Have Valid Source Document Information? (Node 5)
This function activity checks if valid source document information (from a blanket agreement or quotation) exists for the requisition line. Specifically, it checks the source document type, the source document, and the source document line.

Get Buyer (Node 8)
See: Get Buyer: page C – 236.

End (Nodes 3, 7, 9, and 10)
This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Does Req Line Have Enough Information To Automatically Create A Document? process activity has a result type of Yes/No, each End activity node must have a process result matching one of the lookup codes in the Yes/No lookup type.

Summary of the Create and Approve Purchase Order Or Release Process
To view the properties of the Create And Approve Purchase Order Or Release process, select the process in the navigator tree, then choose Properties from the Edit menu. The Create And Approve Purchase Order Or Release process has a result type of PO Document Processed, indicating that when the process completes, it has a result of Document Processed. This result corresponds to the lookup code in the PO Document Processed lookup type in the PO Create Documents item type.

This process activity is also runnable, indicating that it can be initiated as a top–level process to run by making calls to the Workflow Engine CreateProcess and StartProcess APIs.
The Create And Approve Purchase Order Or Release process is initiated by the activity Launch Process To Create/Approve PO or Release.

The process begins at node 1.

Node 2 creates the purchase order or release. For those documents created successfully, node 3 sends a notification to the buyer that the document has been created.

Node 4 checks if the item attribute Is Automatic Approval Allowed? is set to Y for Yes. If it is, node 5 launches the PO Approval workflow to approve the purchase order or release. Node 6 indicates that the workflow should continue with the final activities in the Overall Document Creation/Launch Approval process.

Create And Approve Purchase Order Or Release Process Activities

The following is a description of each activity in the Create And Approve Purchase Order Or Release process, listed by the activity’s display name.

Start (Node 1)

This is a Standard function activity that simply marks the start of the subprocess.
Create Purchase Order Or Release (Node 2)

This function activity creates a standard purchase order or blanket release depending on the information on the requisition line.

Purchase Order Or Release Has Been Created (Node 3)

If the document is created successfully, this function activity sends a notification to the buyer.

Is Automatic Approval Allowed? (Node 4)

This function activity checks the value of the attribute, Is Automatic Approval Allowed?. If the item attribute is set to Y for Yes, this workflow launches the PO Approval workflow to approve the purchase order or release. (The default value for the item attribute is N for No.)

Launch Document Approval Process (Node 5)

This function activity launches the PO Approval workflow. See: Purchase Order Approval Workflow: page C – 114.

Continue Flow (Node 6)

This function activity tells the second Wait for Flow function activity in the Overall Document Creation / Launch Approval Process that the process Create and Approve Purchase Order Or Release has completed. Wait for Flow now has to wait only for the other documents to be processed.

End (Node 7)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Create And Approve Purchase Order Or Release process activity has a result type of PO Document Processed, each End activity node must have a process result matching one of the lookup codes in the PO Document Processed lookup type.
Summary of the Get Buyer Subprocess

To view the properties of the Get Buyer process, select the process in the navigator tree, then choose Properties from the Edit menu. The Get Buyer process has a result type of PO Action Result, indicating that when the process completes, it has a result of Action Failed or Action Complete. These results correspond to the lookup code in the PO Action Result lookup type in the PO Create Documents item type.

This process activity is not runnable, indicating that it cannot be initiated as a top-level process to run, but rather can be run only as a subprocess when called by a higher-level process.

This process retrieves buyer information for the purchase order. Node 2 retrieves a valid buyer name from the buyer field on the requisition line. If no buyer is indicated there, node 4 retrieves the default buyer from the item definition in the Master Item window. If no buyer is indicated there, node 6 retrieves the default category assigned to a buyer in the Define Buyers window. If no buyer is indicated there, node 8 retrieves the buyer from the source document associated with the requisition line. When creating a release, this subprocess retrieves the buyer’s name from the blanket agreement.

If the workflow does not find a buyer, it does not create the document. The requisition line, however, will still be available to you in the AutoCreate Documents window in Purchasing.
Get Buyer Subprocess Activities

The following is a description of each activity in the Get Buyer process, listed by the activity’s display name.

Start (Node 1)

This is a Standard function activity that simply marks the start of the subprocess.

Get Buyer From Req Line (Node 2)

This function activity tries first to get the buyer from the requisition line.

Get Buyer From Item (Node 4)

If Get Buyer From Req Line fails, then this function activity tries to get the buyer assigned to the item in the Master Item window.

Get Buyer From Category (Node 6)

If Get Buyer From Item fails, this function activity tries to get the buyer assigned to the Category on the requisition line.

Get Buyer From Source Doc (Node 8)

If Get Buyer From Category fails, this function activity tries to get the buyer from the source document associated with the requisition line. If more than one or no buyers are assigned, then this function activity fails.

End (Nodes 3, 5, 7, and 9)

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Get Buyer subprocess activity has a result type of PO Action Result, each End activity node must have a process result matching one of the lookup codes in the PO Action Result lookup type.
Using the Workflow Monitor for the PO Create Documents Workflow

To monitor a document as it proceeds through a workflow, you need to provide the Workflow Monitor with an item key, which is specific both to the document you are monitoring and the process in which you’re monitoring it.

For information on how to use the Workflow Monitor, see: Workflow Monitor, Oracle Workflow Guide.

To determine the item key for the PO Create Documents workflow:

1. Write down the requisition number of the requisition you’re monitoring.

2. Find the REQUISITION_HEADER_ID by writing the following SQL* statements. (The REQUISITION_HEADER_ID is an internal number not found in the Requisitions window.)

   For example, if the requisition number is 12012570, you would write this SQL* statement:
   ```sql
   select requisition_header_id
   from   po_requisition_headers_all
   where  segment1='12012570';
   
   A REQUISITION_HEADER_ID is returned.
   
3. Using the REQUISITION_HEADER_ID returned in the step above, find the Overall Document Creation / Launch Approval process item key by writing the following SQL* statements.

   For example, if the REQUISITION_HEADER_ID is 1024961, you would write the following SQL* statement:
   ```sql
   select item_type, item_key, root_activity
   from   wf_items
   where  item_key like '1024961'||'%'
   and    item_type='CREATEPO'
   and    root_activity='OVERALL_AUTOCREATE_PROCESS';
   
   The item key for your requisition, as it appears in the Overall Document Creation / Launch Approval process, is returned. For example:

<table>
<thead>
<tr>
<th>ITEM_TYP</th>
<th>ITEM_KEY</th>
<th>ROOT_ACTIVITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>CREATEPO</td>
<td>1024961-12374</td>
<td>OVERALL_AUTOCREATE_PROCESS</td>
</tr>
</tbody>
</table>

   Next, you need to identify the unique item keys for your requisition as it appears in the other PO Create Documents
processes, so that you can monitor it all the way through the workflow. This is described in the next step.

4. Using the ITEM_KEY returned from the step above, find the ITEM_KEY for the other two workflow processes, Verify Req Line Information and Create and Approve Document, using the following SQL* statements.

For example, if your ITEM_KEY is 1024961–12374, you would write this SQL* statement:

```sql
select item_type, item_key, root_activity
from   wf_items
where  parent_item_type = 'CREATEPO'
and    parent_item_key  = '1024961-12374';
```

REQ_LINE_PROCESSING returns an item key for each requisition line. CREATE_AND_APPROVE_DOC returns an item key for each purchase order. For example:

```
ITEM_TYP  ITEM_KEY       ROOT_ACTIVITY
––––––––– ––––––––––––––––––––––––
CREATEPO  1025575-12375         REQ_LINE_PROCESSING
CREATEPO  1004590-12376         CREATE_AND_APPROVE_DOC
```

You don’t need to find item keys for the processes Get Buyer and Does This Req Line Have Enough Information to Automatically Create a Document, because they are subprocesses of the other processes; you can drill down to these subprocesses through the Workflow Monitor, without an item key.
Confirm Receipts Workflow

The Confirm Receipts workflow sends notifications through the Web, e-mail, or Notifications Summary window to requesters or buyers who create requisitions through Purchasing or Oracle iProcurement. It lets people know they should have received an item.

The Confirm Receipts workflow sends notifications for items with a Destination or Deliver-To Type of Expense, a Routing of Direct Delivery, and a Need–By date that is equal to or later than today’s date.

This workflow requires that the Workflow Background Process and the Confirm Receipts Workflow Select Orders process be running. See: Confirm Receipts Workflow Select Orders: page 9 – 28.

Customizing the Confirm Receipts Workflow

Use the Oracle Workflow Builder to customize workflows. When you customize a workflow, only those documents that are created after you customize it are affected by the customized workflow.

You can use the Workflow Monitor to follow where certain documents are in a workflow process. See: Workflow Monitor, Oracle Workflow Guide.

To display the workflow in the Oracle Workflow Builder:

1. Choose Open from the File menu, and connect to the database.
   See: Opening and Saving Item Types, Oracle Workflow Guide.
   The Display name of the workflow is PO Confirm Receipt. The name of its Workflow definition file is poxwfrrev.wft.
2. Expand the data source, then the PO Confirm Receipt item type branch within that data source.

3. Expand the Processes branch within the PO Confirm Receipt branch, then double-click on a process activity to display its diagram.

Creating a New Custom Process

If you want to customize the PO Confirm Receipt workflow, you must customize the default (original) workflow that Purchasing provides. Unlike the PO Approval, PO Requisition Approval, and PO Create Documents workflows in Purchasing, only one PO Confirm Receipt workflow can be called from the application itself. You can’t select a separate customization, like you can with the other workflows in the Document Types window. Therefore, you need to make your customizations to the default workflow. You’ll always have your backup to revert to, if you need, while you are testing your customizations.

Required Modifications

There are no required modifications you need to make to the PO Confirm Receipt workflow itself. However, for the confirm receipts
workflow to work, you need to submit the Workflow Background Process and the Confirm Receipts Workflow Select Orders process. See: Confirm Receipts Workflow Select Orders: page 9 – 28.

Optional Customizations

You can change the amount of time given before reminding the requester to respond to a receipt confirmation. You do this by entering your own Timeout intervals in the Control Properties window for each of the notifications in the Notify Requestor subprocess.

These notifications already provide a default Timeout period before which a requester is reminded to respond to the receipt confirmation, but you can change the Timeout to suit your public sector needs.

To change the default Timeout intervals:

1. Select any of the following notification activities in the Notify Requester process:
   - Notify Requestor of Confirm Receipt – initial notification
   - Notify Requestor of Confirm Receipt – first reminder
   - Notify Requestor of Confirm Receipt – second reminder
   2. Open the notification’s Properties window and change the Timeout period before which the next reminder is sent, or before which the last reminder times out and sends a notification to the requester’s manager. For instructions, see the Oracle Workflow Guide.

Supported and Unsupported Customizations

Following is a discussion of what you can and definitely cannot modify in the PO Confirm Receipt workflow. For those things you can modify, the discussion includes important guidelines that you need to be very careful of when making customizations.

For important information on how to customize workflows, see the Oracle Workflow Guide.

Attention: If a particular Workflow object does not appear in the following sections on the lists of things you can customize, do not modify it, regardless of its access level.
Attributes

You cannot modify any item attributes in the PO Confirm Receipt workflow. However, you can add item attributes.

Processes

If you modify a process, it is essential that the basic flow remain intact to maintain data integrity in the database:

• Attributes that are set by default function activities in the default processes must also be set if you replace default function activities with ones of your own. That is, if a function activity in that process uses a `SetItemAttr` statement, then that function activity is setting an attribute to be used by another function activity later. Therefore, your new function activity must do the same. You should also preserve `SetItemUserKey` and `SetItemOwner` statements, if any. (Depending on your customizations, you may also want to preserve `GetItemAttr` statements.)

• Any database state maintained by the default processes must also be maintained by processes you customize. That is, if a function activity in that process uses an `Update` or `Insert Into` statement, then that function activity is updating or inserting rows in the database. Therefore, your new function activity must maintain the same database state.

To get a list of the workflow function activities that use `SetItemAttr`, `GetItemAttr`, `SetItemUserKey`, `SetItemOwner`, `Insert Into`, or `Update` statements, run the PL/SQL script `powfcust`. For instructions on running this script, see: Customization Guidelines: page C–5.

You should not remove any default function activities from the following processes. You may, however, add your own additional function activities to them:

• Confirm Receipt Process

• Notify Requester

Notifications

You cannot modify any of the PO Confirm Receipt notifications except for the Timeout feature in the Notify Requester of Confirm Receipt notifications in the Notify Requester process.
Function Activities

You cannot modify any function activities in the PO Confirm Receipt workflow.

However, you can replace some function activities with function activities of your own. When you replace a function activity, you are effectively modifying the process in which it is contained. See the guidelines for customizing the PO Confirm Receipt processes in the section Processes above.

If you substitute default function activities in a process with function activities that you create, you must remember the following:

- The result type of your new function activity must match the result type of the default activity. That is, the Result Type of the function activity in the Workflow Builder needs to match the result type specified by that function activity’s corresponding PL/SQL procedure—for example, a Result Type of Yes/No. It also means that if you have, for example, two results (such as Yes and No) in your function activity and corresponding PL/SQL procedure, you need to make sure that there are two corresponding transitions in the workflow diagram (one for Yes and one for No). If you change the result types and transitions in a process, be careful that you aren’t deleting or bypassing any special transitions or checks.

- Just as with Processes above, any attributes that were set by the default function activity must also be set by your customized function activity.

- Just as with Processes above, any database state maintained by the default function activity must also be maintained by the customized function activity.

Messages

You can modify any of the PO Confirm Receipt messages to suit your public sector needs.

See: Message Result, Oracle Workflow Guide and To Create a Message, Oracle Workflow Guide.

Lookup Types

You cannot modify any of the PO Confirm Receipt lookup types.
The Confirm Receipts Workflow Item Type

The Confirm Receipts workflow process is associated with an item type called PO Confirm Receipt. This item type identifies all workflow processes available for confirming receipts. The following workflow processes are associated with PO Confirm Receipt:

- Confirm Receipt Process: page C – 247
- Notify Requester: page C – 251

The PO Confirm Receipt item type also has many attributes associated with it. These attributes reference information in the Purchasing application tables. The attributes are used and maintained by function activities as well as notification activities throughout the process.

The following table shows the PO Confirm Receipt Workflow item type attributes.

**PO Confirm Receipt Workflow Item Type Attributes**

<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buyer’s Display Name</td>
<td>Buyer’s name as displayed in the window field</td>
<td>Text</td>
<td>80</td>
</tr>
<tr>
<td>Buyer ID</td>
<td>Unique identifier for the buyer</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Buyer’s Username</td>
<td>Buyer’s user (short) name as defined in Oracle Applications</td>
<td>Text</td>
<td>80</td>
</tr>
<tr>
<td>Currency Code 1–5</td>
<td>The Currency used on the first 5 lines of the requisition</td>
<td>Text</td>
<td>3</td>
</tr>
<tr>
<td>Due Date</td>
<td>Date the shipment is due</td>
<td>Date</td>
<td>DD–MON–YYYY</td>
</tr>
<tr>
<td>Filler11 , 12, 21, 22, 31, 32, 41, 42, 51, and 52</td>
<td>Notification boiler-plate text such as “This is” and “for requisition number”</td>
<td>Text</td>
<td>50</td>
</tr>
<tr>
<td>Functional Currency</td>
<td>The functional currency used in your Set of Books</td>
<td>Text</td>
<td>10</td>
</tr>
<tr>
<td>Item description 1–5</td>
<td>Description of the first 5 items</td>
<td>Text</td>
<td>240</td>
</tr>
<tr>
<td>Item price 1–5</td>
<td>Price of the first 5 items</td>
<td>Text</td>
<td>20</td>
</tr>
</tbody>
</table>

Table C – 15  (Page 1 of 3)
<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line 1–5</td>
<td>First 5 lines on the document, for reference</td>
<td>Text</td>
<td>9</td>
</tr>
<tr>
<td>Quantity 1–5</td>
<td>Quantity of each of the first 5 requisition lines</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Manager’s Display Name</td>
<td>Name of the requester’s manager</td>
<td>Text</td>
<td>80</td>
</tr>
<tr>
<td>Manager ID</td>
<td>Unique identifier for the requester’s manager</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Manager’s Username</td>
<td>User (short) name of the requester’s manager as defined in Oracle Applications</td>
<td>Text</td>
<td>80</td>
</tr>
<tr>
<td>More Lines note</td>
<td>Notification text indicating whether the requisition has more than</td>
<td>Text</td>
<td>80</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the first 5 lines displayed in the notification</td>
<td></td>
</tr>
<tr>
<td>Note from requester</td>
<td>Note from the requester</td>
<td>Text</td>
<td>640</td>
</tr>
<tr>
<td>Note to receiver</td>
<td>Note to the receiver of the purchase order, in Terms and Conditions window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of Lines</td>
<td>Number of lines in the notification message to the buyer</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>PO Header ID</td>
<td>Purchase order internal identification number</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>PO Number</td>
<td>Purchase order number</td>
<td>Text</td>
<td>20</td>
</tr>
<tr>
<td>Rct_Qty1–5</td>
<td>Partially received quantity if indicated by requester</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Receive Orders URL</td>
<td>iProcurement Receive Orders Web page URL</td>
<td>URL</td>
<td></td>
</tr>
<tr>
<td>Receiving Transaction Status</td>
<td>Receiving status such as Failed or Pending</td>
<td>Text</td>
<td>500</td>
</tr>
<tr>
<td>Requester’s Display</td>
<td>Name of the requester on the purchase order or requisition</td>
<td>Text</td>
<td>80</td>
</tr>
</tbody>
</table>

Table C – 15 (Page 2 of 3)
<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requester_ID</td>
<td>Unique identifier for the requester</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Requester’s Username</td>
<td>User name of the requester on the purchase order or requisition</td>
<td>Text</td>
<td>80</td>
</tr>
<tr>
<td>Requisition date 1–5</td>
<td>Date of each of the first 5 requisition lines</td>
<td>Text</td>
<td>30</td>
</tr>
<tr>
<td>Requisition number 1–5</td>
<td>Requisition number for each of the first 5 requisition lines used on the order</td>
<td>Text</td>
<td>30</td>
</tr>
<tr>
<td>Supplier’s Display Name</td>
<td>Supplier’s name as displayed in the window field</td>
<td>Text</td>
<td>80</td>
</tr>
<tr>
<td>Supplier ID</td>
<td>Unique identifier for the supplier</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Total Number of Lines in PO</td>
<td>Total number of lines in the purchase order</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Unit of measure 1–5</td>
<td>UOM for each of the first 5 document lines</td>
<td>Text</td>
<td>15</td>
</tr>
</tbody>
</table>

Table C–15  (Page 3 of 3)

Summary of the Confirm Receipt Process

To view the properties of the Confirm Receipt process, select the process in the navigator tree, then choose Properties from the Edit menu. The Confirm Receipt process has a result type of None, indicating that when the process completes, it does not have specific results of, for example, End (Invalid) or End (Valid), which are found in the Lookup Types branch in the Workflow Builder. Instead, this process’s subprocesses have specific result types associated with them.

The Details property page of the process activity indicates that the Confirm Receipt process has an error process called DEFAULT_ERROR associated with it, which gets initiated only when an error is encountered in the process. For example, if the workflow sends a notification to the requester’s manager but cannot find the manager’s unique identifier (Manager ID), the Workflow Engine would raise an
error when it tries to execute the notification activity. This error would initiate DEFAULT_ERROR, which is the Default Error Process. The Default Error Process is associated with the System:Error item type. Currently the process simply executes the standard Default Error Notification activity to provide information associated with the error. You can customize the process further to suit your needs. See: Default Error Process, *Oracle Workflow Guide*.

This process activity is also runnable, indicating that it can be initiated as a top-level process to run by making calls to the Workflow Engine *CreateProcess* and *StartProcess* APIs.

The Confirm Receipt process begins when you submit the Confirm Receipts Workflow Select Orders process through the Requests window.

The workflow begins at node 1.

Node 1 retrieves information from the purchase order and requisition that will be used in the message that is sent to the buyer or requester.
Node 2 retrieves a URL that enables you to access the iProcurement Receive Orders Web page from the notification if you wish to process receipt confirmation through Oracle iProcurement, if iProcurement is installed.

At node 3, the subprocess sends a notification to the requester to confirm the receipt of expense items that are past due.

If the requester responds with Not Received, node 4 notifies the buyer that the items have not been received. If the requester responds with Partially/Over Received, node 5 notifies the buyer of such. If the requester responds with Fully Received, node 6 processes the receipt. If the receipt cannot be processed, node 7 sends a notification of the failure to the requester, and node 9 sends a notification of the failure to the buyer.

At node 3, if the requester does not respond before the number of days indicated by the notification activities in the node 3 subprocess, the workflow times out, retrieves the requester’s manager from your hierarchy setup (node 10), and notifies the requester’s manager (node 11).

**Confirm Receipt Process Activities**

The following is a description of each activity listed by the activity’s display name. You can create all the components for an activity in the graphical Workflow Builder except for the PL/SQL stored procedures that the function activities call. All function activities execute PL/SQL stored procedures which you must create and store in the Oracle RDBMS. The naming convention for the PL/SQL stored procedures is: `<PACKAGE> . <PROCEDURE>`

`<PACKAGE>` is the name of the package that groups all of the procedures. `<PROCEDURE>` represents the name of the procedure.

To view the package and procedure names used by the PO Confirm Receipts processes, view the Properties page for each function activity. For example, the function activity Retrieve Requester’s Manager uses the `<PACKAGE> . <PROCEDURE>` name `PORCPTWF.GET_REQUESTER_MANAGER`.

You can use the Item Type Definitions Web page to view `<PACKAGE> . <PROCEDURE>` names. See: Item Type Definitions Web Page, Oracle Workflow Guide.
Retrieve Order Information (Node 1)

This function activity retrieves the purchase order and requisition information from the RCV_CONFIRM_RECEIPT_V table using the PO_HEADER_ID, EXPECTED_RECEIPT_DATE and REQUESTER_ID as search criteria. The retrieved data are used by the Notify Requester subprocess for sending the notification message, which contains the order header and order line data.

Retrieve Receive Orders Web Page URL (Node 2)

This function activity retrieves the URL of the Receive Orders Web page, which you set up through iProcurement. The URL provides a direct link from the workflow notification message to the Receive Orders web page for processing receipt confirmation through iProcurement, if iProcurement is installed.

Retrieve Requester’s Manager (Node 10)

If the requester does not respond before the number of days indicated by the notification activities in the Notify Requester subprocess, this function activity retrieves the manager’s user name from your hierarchy setup. The workflow then notifies the manager.

Process Receiving Transactions (Node 6)

This function activity processes transactions in the Receiving Open Interface when the workflow notification is responded to as Fully Received. It ensures that the shipment or shipments are still open. It invokes the Receiving Open Interface program to insert the receipt records into the receiving transactions open interface table.

The Receiving Transaction Manager is then called in On-line mode (regardless of how you set the profile option RCV: Processing Mode) to process the receipt records immediately. If there are errors, you receive a notification of such, sent by the activity Notify Receiving Transactions Failure.

Notify Requester’s Manager of Time Out (Node 11)

If the requester does not respond before the number of days indicated by the notification activities in the Notify Requester subprocess, this function activity notifies the requester’s manager.
Notify Receiving Transactions Failure (Nodes 7 and 9)

There are two of these activities in the Confirm Receipt process. They are used whenever a receipt cannot be created—for example, when the Receiving Transaction Manager has not started or if someone has already created a receipt in the Receipts window. One activity sends a notification to the requester that the receipt could not be created; the other sends the same notification to the buyer. On the Web, this activity presents an error message immediately on the screen. This activity also sends a formal notification to your regular notification queue.

Notify Buyer of Partial Receipt (Node 5)

If the requester responds in the Notify Requester subprocess activity with Partially/Over Received, this activity notifies the buyer that the items have been partially or over–received. The notification shows the quantity that was supposed to be received and the quantity that was actually received.

Notify Buyer of Non–Receipt (Node 4)

If the requester responds in the Notify Requester subprocess activity with Not Received, this activity notifies the buyer that the items have not been received.

End (Node 12)

This activity ends the process.

Summary of the Notify Requester Subprocess

To view the properties of the Notify Requester process, select the process in the navigator tree, then choose Properties from the Edit menu. The Notify Requester process has a result type of Notify Requester Response, indicating that when the process completes, it has a result of Fully Received, Not Received, Partially/Over Received, or Time Out. These results correspond to the lookup code in the Notify Requester Response lookup type in the PO Confirm Receipt item type.

This process activity is also runnable, indicating that it can be initiated as a top–level process to run by making calls to the Workflow Engine CreateProcess and StartProcess APIs.
This process sends a notification to the requester to confirm the receipt of expense items that are past their due date. The requester can then respond that the items were not received, partially or over−received, or fully received.

The notification activities at nodes 1, 5, and 6 contain the following default Timeout days:

- **Notify Requestor of Confirm Receipt** – initial notification (node 1) – 7 days
- **Notify Requestor of Confirm Receipt** – first reminder (node 5) – 7 days
- **Notify Requestor of Confirm Receipt** – second reminder (node 6) – 1 day

Because the first notification at node 1 contains a default Timeout of 7 days, the second notification at node 5 sends a reminder to the requester after 7 days. The third notification at node 6 sends a final reminder after another 7 days.

Node 6 times out after one additional day, if still no response is received from the requester. The Confirm Receipt process then notifies the requester’s manager to confirm receipt of the goods.

You can change these default Timeout numbers to your own desired settings. See: Customizing the Confirm Receipts Workflow: page C − 240.
Notify Requester Subprocess Activities

The following is a description of each activity in the Notify Requester subprocess listed by the activity’s display name.

**Notify Requester of Confirm Receipt – initial notice (Node 1)**

This activity notifies the requester that the requester should have received the goods, and asks for confirmation.

**Notify Requester of Confirm Receipt – first reminder (Node 5)**

This activity sends a reminder to the requester if no response is received after 7 days (or however many days you specify in the previous activity’s Control Properties window; the default is 7 days).

**Notify Requester of Confirm Receipt – second reminder (Node 6)**

This activity sends a second reminder to the requester if no response is received after another 7 days (or however many days you specify in the previous activity’s Control Properties window; the default is 7 days). If still no response is received after one day, the Notify Requester subprocess activity times out and sends the receipt confirmation notification to the requester’s manager.

**End (Nodes 2, 3, 4, 8, 10, and 12)**

This function activity marks the end of the process. Although the activity itself does not have a result type, each node of this activity in the process must have a process result assigned to it. The process result is assigned in the property page of the activity node. Since the Notify Requester subprocess activity has a result type of Notify Requester Response, each End activity node must have a process result matching one of the lookup codes in the Notify Requester Response lookup type.
Send Notifications Workflow

The workflow PO Send Notifications for Purchasing Documents looks for documents that are incomplete, rejected, or in need of reapproval and sends notifications to the appropriate people of the document’s status. You can view and respond to these notifications through the Notifications Summary window.

For information on the kinds of notifications sent by the Send Notifications for Purchasing Documents process, see: Viewing and Responding to Notifications: page 2 – 31.

In order for these notifications to be sent, you need to start the concurrent program process, Send Notifications for Purchasing Documents, and choose how frequently you want the process to run. See: Send Notifications for Purchasing Documents: page 9 – 155.

Customizing the PO Send Notifications for Purchasing Documents Workflow

Use the Oracle Workflow Builder to customize workflows. When you customize a workflow, only those documents that are created after you customize it are affected by the customized workflow.

You can use the Workflow Monitor to follow where certain documents are in a workflow process. See: Workflow Monitor, Oracle Workflow Guide.

To display the workflow in the Oracle Workflow Builder:

1. Choose Open from the File menu, and connect to the database. See: Opening and Saving Item Types, Oracle Workflow Guide.

   The Display name of the workflow is PO Send Notifications for Purchasing Documents. The name of its Workflow definition file is poxwforms.wft.
2. Expand the data source, then the PO Send Notifications for Purchasing Documents item type branch within that data source.

3. Expand the Processes branch within PO Send Notifications for Purchasing Documents branch, then double-click on its process activity to display the process diagram.

Creating a New Custom Process

If you want to customize the PO Send Notifications for Purchasing Documents workflow, you must customize the default (original) workflow that Purchasing provides. Unlike the PO Approval, PO Requisition Approval, and PO Create Documents workflows in Purchasing, only one PO Send Notifications for Purchasing Documents workflow can be called from the application itself. You can’t select a separate customization, like you can with the other workflows in the Document Types window. Therefore, you need to make your customizations to the default workflow. You’ll always have your backup to revert to, if you need, while you are testing your customizations.
Required Modifications

There are no required modifications you need to make to the PO Send Notifications for Purchasing Documents workflow itself. However, for the workflow to work, you need to start the concurrent program process, Send Notifications for Purchasing Documents, if you didn’t already start this process when you set up Purchasing. See: Send Notifications for Purchasing Documents: page 9 – 155.

Supported and Unsupported Customizations

Following is a discussion of what you can and definitely cannot modify in the PO Send Notifications for Purchasing Documents workflow. For those things you can modify, the discussion includes important guidelines that you need to be very careful of when making customizations.

For important information on how to customize workflows, see the Oracle Workflow Guide.

To further help you with your customizations, refer to the sections later in this document, starting with The PO Send Notifications for Purchasing Documents Item Attributes: page C – 258. These sections describe the components of the automatic document creation processes in the workflow. If you haven’t already, see also: Customization Guidelines: page C – 5.

Attention: If a particular Workflow object does not appear in the following sections on the lists of things you can customize, do not modify it, regardless of its access level.

Attributes

You cannot modify any of the attributes in the PO Send Notifications for Purchasing Documents workflow.

Processes

If you modify a process, it is essential that the basic flow remain intact to maintain data integrity in the database:

- Attributes that are set by default function activities in the default processes must also be set if you replace default function activities with ones of your own. That is, if a function activity in that process uses a SetItemAttr statement, then that function activity is setting an attribute to be used by another function activity later. Therefore, your new function activity must do the
same. You should also preserve SetItemUserKey and SetItemOwner statements, if any. (Depending on your customizations, you may also want to preserve GetItemAttr statements.)

- Any database state maintained by the default processes must also be maintained by processes you customize. That is, if a function activity in that process uses an Update or Insert Into statement, then that function activity is updating or inserting rows in the database. Therefore, your new function activity must maintain the same database state.

To get a list of the workflow function activities that use SetItemAttr, GetItemAttr, SetItemUserKey, SetItemOwner, Insert Into, or Update statements, run the PL/SQL script powfcust. For instructions on running this script, see: Customization Guidelines: page C – 5.

There is one process in the PO Send Notifications for Purchasing Documents workflow, and you can modify it as your public sector needs require, paying careful attention to the guidelines described above and in the following section, Function Activities:

- PO Document Approval Reminder

Notifications

You cannot modify any of the notifications in the PO Send Notifications for Purchasing Documents workflow.

Function Activities

You cannot modify any function activities in the PO Send Notifications for Purchasing Documents workflow.

However, you can replace some function activities with function activities of your own. When you replace a function activity, you are effectively modifying the process in which it is contained. See the guidelines for customizing the processes in the section Processes above.

If you substitute default function activities in a process with function activities that you create, you must remember the following:

- The result type of your new function activity must match the result type of the default activity. That is, the Result Type of the function activity in the Workflow Builder needs to match the result type specified by that function activity’s corresponding
PL/SQL procedure—for example, a Result Type of Yes/No. It also means that if you have, for example, two results (such as Yes and No) in your function activity and corresponding PL/SQL procedure, you need to make sure that there are two corresponding transitions in the workflow diagram (one for Yes and one for No). If you change the result types and transitions in a process, be careful that you aren’t deleting or bypassing any special transitions or checks.

- Just as with Processes above, any attributes that were set by the default function activity must also be set by your customized function activity.
- Just as with Processes above, any database state maintained by the default function activity must also be maintained by the customized function activity.

**Messages**

You can modify any of the messages in the PO Send Notifications for Purchasing Documents workflow, as your public sector needs require.


**Lookup types**

You cannot modify any of the lookup types in the PO Send Notifications for Purchasing Documents workflow.

---

**The PO Send Notifications for Purchasing Documents Item Type**

The notification sending process is associated with an item type called PO Send Notifications for Purchasing Documents. This item type identifies all notification workflow processes available. There is one workflow process associated with PO Send Notifications for Purchasing Documents: PO Document Approval Reminder: page C – 261.

The PO Send Notifications for Purchasing Documents item type also has many attributes associated with it. These attributes reference information in the Purchasing application tables. The attributes are used and maintained by function activities as well as notification activities throughout the process.
The following table shows the PO Send Notifications for Purchasing Documents item type attributes.

**PO Send Notifications for Purchasing Documents Item Type Attributes**

<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acceptance Due Date</td>
<td>Date acceptance is due</td>
<td>Date</td>
<td></td>
</tr>
<tr>
<td>Acceptance Past Due</td>
<td>Indicator that the acceptance due date has passed</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Agent Display Name</td>
<td>Buyer’s name as displayed in Purchasing</td>
<td>Text</td>
<td>250</td>
</tr>
<tr>
<td>Agent ID</td>
<td>Unique identifier for the buyer</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Agent User Name</td>
<td>Buyer’s user name</td>
<td>Text</td>
<td>100</td>
</tr>
<tr>
<td>Document ID</td>
<td>Unique identifier for the document submitted to this workflow</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Document Number</td>
<td>Document number for the document submitted to this workflow</td>
<td>Text</td>
<td>80</td>
</tr>
<tr>
<td>Document Subtype</td>
<td>Document subtype</td>
<td>Text</td>
<td>80</td>
</tr>
<tr>
<td>Document Type</td>
<td>Document type</td>
<td>Text</td>
<td>60</td>
</tr>
<tr>
<td>Document Type Display</td>
<td>Document type as displayed in Purchasing</td>
<td>Text</td>
<td>250</td>
</tr>
<tr>
<td>Forward From Display Name</td>
<td>Name of the person who forwarded the document, as displayed in Purchasing</td>
<td>Text</td>
<td>250</td>
</tr>
<tr>
<td>Forward From ID</td>
<td>Unique identifier of the person who forwarded the document</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Forward From User Name</td>
<td>User name of the person who forwarded the document</td>
<td>Text</td>
<td>250</td>
</tr>
<tr>
<td>Forward to Display Name</td>
<td>Name of the forward-to person as displayed in Purchasing</td>
<td>Text</td>
<td>250</td>
</tr>
<tr>
<td>Display Name</td>
<td>Description</td>
<td>Type</td>
<td>Length/Format/Lookup Type</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Forward to ID</td>
<td>Unique identifier for the forward-to person</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Forward to ID Old Value</td>
<td>Item attribute for internal use that keeps track of the previous forward-to</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td></td>
<td>person</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forward to User Name</td>
<td>User name of the forward-to person</td>
<td>Text</td>
<td>250</td>
</tr>
<tr>
<td>Never Approved Message</td>
<td>Text message that shows the document was never approved</td>
<td>Text</td>
<td>500</td>
</tr>
<tr>
<td>Note</td>
<td>Note text</td>
<td>Text</td>
<td>240</td>
</tr>
<tr>
<td>Open PO Form Command</td>
<td>Command that Purchasing sends to open the purchase order from the notification</td>
<td>Form</td>
<td></td>
</tr>
<tr>
<td>Open Quotations Form</td>
<td>Command that Purchasing sends to open the quotation from the notification</td>
<td>Form</td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open Release Form Command</td>
<td>Command that Purchasing sends to open the release from the notification</td>
<td>Form</td>
<td></td>
</tr>
<tr>
<td>Open Req Form Command</td>
<td>Command that Purchasing sends to open the requisition from the notification</td>
<td>Form</td>
<td></td>
</tr>
<tr>
<td>Open RFQ Form Command</td>
<td>Command that Purchasing sends to open the RFQ from the notification</td>
<td>Form</td>
<td></td>
</tr>
<tr>
<td>Org ID</td>
<td>Unique identifier for the operating unit</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Quotation Status</td>
<td>Quotation status such as In Process or Active</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Quote End Date Active</td>
<td>Quotation expiration date</td>
<td>Date</td>
<td></td>
</tr>
</tbody>
</table>

Table C – 16  (Page 2 of 3)
<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/ Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quote Type Display</td>
<td>Quotation type as displayed in Purchasing</td>
<td>Text</td>
<td>250</td>
</tr>
<tr>
<td>Quote Warning Delay</td>
<td>Number of days prior to the expiration of the quotation that you want to be notified</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Release Revision Number</td>
<td>Document revision number</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Requires Approval Message</td>
<td>Text for the Requires Approval message</td>
<td>Text</td>
<td>500</td>
</tr>
<tr>
<td>Requisition Rejected Message</td>
<td>Text for the Requisition Rejected message</td>
<td>Text</td>
<td>500</td>
</tr>
<tr>
<td>Requisition Returned Message</td>
<td>Text for the Requisition Returned message</td>
<td>Text</td>
<td>500</td>
</tr>
<tr>
<td>Response Forward To</td>
<td>Forward–to response</td>
<td>Text</td>
<td>250</td>
</tr>
<tr>
<td>RFQ Close Date</td>
<td>Date the RFQ will be closed</td>
<td>Date</td>
<td></td>
</tr>
<tr>
<td>RFQ Reply Date</td>
<td>Date the supplier replied to the RFQ</td>
<td>Date</td>
<td></td>
</tr>
<tr>
<td>RFQ Status</td>
<td>RFQ status such as In Process or Active</td>
<td>Text</td>
<td>25</td>
</tr>
<tr>
<td>Wrong Forward to Error Message</td>
<td>Text for “wrong forward–to” message</td>
<td>Text</td>
<td>500</td>
</tr>
</tbody>
</table>

Table C – 16 (Page 3 of 3)

**Summary of the PO Document Approval Reminder Process**

To view the properties of the PO Document Approval Reminder process, select the process in the navigator tree, then choose Properties from the Edit menu. The PO Document Approval Reminder process has a result type of None, indicating that when the process completes, it doesn’t end with any particular result, such as End (Approved) or End (Rejected). Instead, its subprocesses end with specific results.

This process activity is also runnable, indicating that it can be initiated as a top–level process to run by making calls to the Workflow Engine `CreateProcess` and `StartProcess` APIs.
The workflow begins at node 1.

At node 2, this workflow branches differently depending on whether the document is a quotation, RFQ, requisition, purchase order, purchase agreement, or release; or a buyer’s recording of a supplier’s acceptance of a purchase order or release.

Then, at nodes 3, 7, 11, and 15, the workflow uses the standard Workflow comparison activity to determine how to branch next. The comparison activities provide a standard way to compare two numbers, dates, or text strings. Node 3 checks whether the quotation requires completion or is near expiration. Node 7 checks the same for an RFQ. Node 11 checks whether release acceptance is required or past due. Node 15 checks the same for a purchase order.

Nodes 19, 23, and 27 send approval reminder notifications for documents that have not been submitted for approval, such as incomplete documents. These documents are detected by the Send Notifications for Purchasing Documents process.

If the person receiving the reminder notification responds with Ignore, Purchasing dismisses the notification from the person’s notification queue until the next time the Send Notifications for Purchasing Documents process runs. The workflow then ends at node 22 or 26.

If the person receiving the reminder notification responds with Approve, the activity at node 20, 24, or 26 makes sure that the forward–to person specified is a valid forward–to approver. If not, the standard Workflow activity at node 21, 25, or 29 directs the workflow to resend the reminder notification.

Node 30 launches the appropriate approval workflow if the notification is answered with Approve and the forward–to approver (if any) is valid.

**PO Document Approval Reminder Process Activities**

The following is a description of each activity listed by the activity’s display name. You can create all the components for an activity in the graphical Workflow Builder except for the PL/SQL stored procedures that the function activities call. All function activities execute PL/SQL stored procedures which you must create and store in the Oracle RDBMS. The naming convention for the PL/SQL stored procedures is:

<PACKAGE>.<PROCEDURE>
<PACKAGE> is the name of the package that groups all of the procedures. <PROCEDURE> represents the name of the procedure.

To view the package and procedure names used by the PO Document Approval Reminder process, view the Properties page for each function activity. For example, the function activity Set Document Type uses the <PACKAGE>.<PROCEDURE> name
PO_APPROVAL_REMINDER_SV.SET_DOC_TYPE.

You can use the Item Type Definitions Web page to view <PACKAGE>.<PROCEDURE> names. See: Item Type Definitions Web Page, Oracle Workflow Guide.

---

Start (Node 1)

This is a Standard function activity that simply marks the start of the process.

Set Document Type (Node 2)

This function activity determines the document type: quotation, RFQ, requisition, purchase order, purchase agreement, release, or a purchase order or release that requires acceptance.

Compare Text (Nodes 3, 7, 11, and 15)

This is a standard Workflow comparison activity that provides a standard way to compare two numbers, dates, or text strings. See: Comparison Activities, Oracle Workflow Guide.

Quotation Requires Completion Notification (Node 4)

This activity sends a notification to the document preparer that the quotation requires completion because its status is still In Process.

Quotation Near Expiration Notification (Node 5)

This activity sends a notification to the document preparer that the quotation is nearing expiration. That is, the quotation is Active, and the current date is between the Effectivity end date on the document and the Quote Warning Delay date in the Purchasing Options window.
RFQ Near Expiration Notification (Node 9)

This activity sends a notification to the document preparer that the RFQ is nearing expiration. That is, the RFQ is Active, and the current date is between the Due Date and the Close Date on the RFQ.

RFQ Requires Completion Notification (Node 8)

This activity sends a notification to the document preparer that the RFQ requires completion because its status is still In Process.

Release Acceptance Required Notification (Node 12)

This activity sends a notification that acceptance is required if Acceptance Required is selected for the release in the Terms and Conditions window, and the release has not been entered as accepted in the Acceptances window.

Release Acceptance Past Due Notification (Node 13)

If the Acceptance Require By date for the release indicates that acceptance is overdue, this activity sends a notification that acceptance is past due.

PO Acceptance Required Notification (Node 16)

This activity sends a notification that acceptance is required if Acceptance Required is selected for the purchase order in the Terms and Conditions window, and the purchase order has not been entered as accepted in the Acceptances window.

PO Acceptance Past Due Notification (Node 17)

If the Acceptance Require By date for the purchase order indicates that acceptance is overdue, this activity sends a notification that acceptance is past due.

Approve Requisition Reminder Notification (Node 19)

This activity sends a notification that the requisition requires approval because it is incomplete, rejected, or in need of reapproval.
Approve Purchase Order Reminder Notification (Node 23)
This activity sends a notification that the purchase order requires approval because it is incomplete, rejected, or in need of reapproval.

Approve Purchase Order Release Reminder Notification (Node 27)
This activity sends a notification that the release requires approval because it is incomplete, rejected, or in need of reapproval.

Is Forward to Valid? (Nodes 20, 24, and 28)
This function activity checks if the person responding to the notification has provided a forward–to approver and, if so, if the forward–to approver is a valid approver.

Noop (Nodes 21, 25, and 28)
This is a standard Workflow activity. Here, it is used to simply return to the previous activity, the reminder notification, if the forward–to approver is not valid. See: Noop Activity, Oracle Workflow Guide.

Start Document Approval
If the notification is answered with Approve, and the forward–to approver (if any) is valid, this function activity launches the appropriate approval workflow.

End
This function activity marks the end of the process.
Price/Sales Catalog Notification Workflow

The price/sales catalog notification workflow uses the Price Update Tolerance you set to determine when a price increase in an Update price/sales catalog submission exceeds your tolerance. Workflow is an underlying technology that sends a notification to the buyer if the price tolerance is exceeded and waits for the buyer to accept or reject the price increase. The Purchasing Documents Open Interface applies or does not apply the price increase depending on the buyer’s action.

The buyer is notified automatically by the workflow. The supplier is notified of price update rejections only if you customize the workflow to do so.

You can view or modify this workflow in the Oracle Workflow Builder. See the Oracle Workflow Guide.

The following figure shows how the workflow affects line statuses in the Purchasing Documents Open Interface tables:
Invoke the workflow and issue a notification to the buyer

Notify buyer

Buyer uses Exceeded Price Tolerances window to accept or reject line-level price updates that failed the price tolerance check

Buyer saves responses in Exceeded Price Tolerances window

For this document, the Purchasing Documents Open Interface processes lines in the PO_LINES_INTERFACE table with a PROCESS_CODE of NOTIFIED and a PRICE_CHO_ACCEPT_FLAG of Y

For Each line item updates and updates the price and price break information

Were any item updates rejected?

No

Yes

Issue notification to supplier if you've customized the workflow to do so

Cancel any outstanding notifications
Customizing the Issue Notifications Process

You can view the workflow in a Process window using the Workflow Builder.

To display the workflow in the Oracle Workflow Builder:

1. Choose Open from the File menu, and connect to the database.
   See: Opening and Saving Item Types, Oracle Workflow Guide.
   The Display name of the price/sales catalog notification workflow is PO Catalog Price Tolerance Exceeded Notifications. The name of its Workflow definition file is poxprcat.wft.

2. Expand the data source, then the item type branch within that data source.

3. Expand the Processes branch, then double-click the Issue Notifications process activity to display its diagram.

Required Modifications

There are no required modifications you need to make to this workflow.

Optional Customizations

Although you can use the workflow as is, you may wish to customize it further to accommodate your organization’s specific needs. You can modify the Issue Notifications process to suit your public sector needs.
You could modify the process to send the buyer a reminder sooner or later than the activity Wait for Buyer Action from Exceeded Price Tolerances Form does by default. You could modify the workflow to send the notification to people other than the buyer. If you want to send the supplier an automatic notification of rejected price updates, you must modify the workflow. Some of these customizations are described below.

To help you with your customizations, refer to the sections later that describe the components of this process.

See also: Customization Guidelines: page C – 5.

► To change the Timeout period from seven days:

1. In the Workflow Builder, expand the Functions branch and select the Wait for Buyer Action from Exceeded Price Tolerances Form activity.
2. Open the activity’s Properties window.
3. Change the Timeout to a period of time that best suits your organization’s needs.
4. In Oracle Applications, submit the Workflow Background Process if you haven’t already. See: To Schedule Background Engines, Oracle Workflow Guide.

► To send automatic notifications of rejected price updates to the supplier:

1. Create Workflow users and roles for your suppliers and associate e-mail addresses with them.

2. Create a function activity that for a given supplier assigns the correct supplier user name to the Supplier User Name item attribute.
   When you create a function activity in the Workflow Builder, you also have to create the PL/SQL stored procedure that the function activity calls.
   See: To Create a Function Activity, Oracle Workflow Guide.
3. Place the function activity in the Issue Notifications process diagram.
You could place it after the Were Any Items Rejected? activity and before the Supplier Username Value activity. Your new function activity will assign the supplier’s user name to the Supplier UserName item attribute. Then, the Supplier Username Value activity retrieves the supplier name from the item attribute.

**Supported and Unsupported Customizations**

You cannot modify any of the item attributes except for Supplier UserName. (Information about when you might customize this attribute is provided in the section above.) You cannot modify any of the function activities or messages in the workflow; however, you could replace them in the Issue Notifications process with ones of your own. You can modify the notification activities.

For important information on how to customize workflows, see the *Oracle Workflow Guide*.

If you modify the process, either by replacing a portion of its flow or by adding additional function activities, remember the following:

- Attributes that are set by default function activities in the default processes must also be set if you replace default function activities with ones of your own. That is, if a function activity in that process uses a `SetItemAttr` statement, then that function activity is setting an attribute to be used by another function activity later. Therefore, your new function activity must do the same. You should also preserve `SetItemUserKey` and `SetItemOwner` statements, if any. (Depending on your customizations, you may also want to preserve `GetItemAttr` statements.)

- Any database state maintained by the default processes must also be maintained by processes you customize. That is, if a function activity in that process uses an `Update` or `Insert Into` statement, then that function activity is updating or inserting rows in the database. Therefore, your new function activity must maintain the same database state.

To get a list of the workflow function activities that use `SetItemAttr`, `GetItemAttr`, `SetItemUserKey`, `SetItemOwner`, `Insert Into`, or `Update` statements, run the PL/SQL script `powfcust`. For instructions on running this script, see: Customization Guidelines: page C – 5.
Creating a New Custom Process

Customize the default (original) workflow that Purchasing provides, after you make a backup. Unlike the PO Approval, PO Requisition Approval, and PO Create Documents workflows, only one price/sales catalog notification workflow can be called in Purchasing. You can’t select a separate customization, like you can with the other workflows in the Document Types window. Therefore, you need to make your customizations to the default workflow. You’ll always have your backup to revert to, if you need, while you are testing your customizations.

The PO Catalog Price Tolerances Exceeded Notifications Item Type

The Issue Notifications process is associated with an item type called PO Catalog Price Tolerances Exceeded Notifications. This item type identifies all workflow processes available with the price/sales catalog update submission.

The PO Catalog Price Tolerances Exceeded Notifications item type also has several attributes associated with it. These attributes reference information in the Purchasing application tables. The attributes are used and maintained by function activities as well as notification activities throughout the process.

To view descriptions of each item type attribute, select the attribute in the Workflow Builder and choose Properties from the Edit menu. Look in the Description field.

Summary of the Issue Notifications Process

To view the properties of the Issue Notifications process, select the process in the navigator tree, then choose Properties from the Edit menu. The Issue Notifications process has no result type, indicating that when the process completes, it has no defined result of, for example, End (Valid) or End (Invalid) corresponding to any lookup type in the navigator tree.

This process activity is runnable, indicating that it can be initiated as a top–level process to run by making calls to the Workflow Engine CreateProcess and StartProcess APIs.
Node 2 sends the buyer a notification if any of the supplier price updates exceed the price tolerance you have set as described in the section Monitoring Price Increases in a Price/Sales Catalog Update: page 5 – 26. Node 3 waits for the buyer to respond before updating the price or price breaks. If the buyer at node 3 does not respond after the amount of time you specify in the Control Properties page, the notification at node 2 is sent to the buyer again.

As soon as the buyer responds to all of the pending price updates, node 2 cancels the notification so that it does not show up the next time the buyer queries for notifications.

Node 5 determines if any price updates were rejected. If they were, node 7 can notify the supplier of the document lines whose prices were rejected if you customize the workflow to send automatic supplier notifications. See Optional Customizations: page C – 269.

**Issue Notifications Process Activities**

The following is a description of each activity listed by the activity’s display name. You can create all the components for an activity in the graphical Workflow Builder except for the PL/SQL stored procedures that the function activities call. All function activities execute PL/SQL stored procedures which you must create and store in the Oracle RDBMS. The naming convention for the PL/SQL stored procedures is:

`<PACKAGE>.<PROCEDURE>`
<PACKAGE> is the name of the package that groups all of the procedures. <PROCEDURE> represents the name of the procedure.

To view the package and procedure names used by the Issue Notifications process, view the Properties page for each function activity. For example, the function activity Cancel Any Outstanding Buyer Notifications uses the <PACKAGE>. <PROCEDURE> name PO_WF_PO_PRICAT_UPDATE.CANCEL_BUYER_NOTIF.

You can use the Item Type Definitions Web page to view <PACKAGE>. <PROCEDURE> names. See: Item Type Definitions Web Page, Oracle Workflow Guide.

**Notify Buyer of Price Updates that Exceed Tolerance (Node 2)**

If any of the price updates in the price/sales catalog update submission exceed the tolerance you have set, this activity sends the buyer a notification. One notification is sent for each document.

**Wait for Buyer Action from Exceeded Price Tolerances Form (Node 3)**

This function activity waits for the buyer to respond to the notification. The price update is not made and the workflow does not continue until the buyer responds. If the buyer does not respond after the amount of time specified in the Control Properties page of this activity, the notification is sent to the buyer again.

**Cancel any Outstanding Buyer Notifications (Node 4)**

As soon as the buyer responds to the notification, this activity cancels the notification so that it does not show up the next time the buyer queries for notifications.

**Were Any Items Rejected? (Node 5)**

This function activity determines if any price updates were rejected.

**Supplier Username Value (Node 6)**

This function activity is a standard Workflow activity used to do comparisons. It makes sure that the supplier’s user name is on the list of user names in Oracle Applications. This activity is used only if you create a function activity to populate the Supplier User Name item attribute. This function activity is associated with the Standard item type.
Notify Supplier of Price Updates that were Rejected (Node 7)

If the function activity Were Any Items Rejected? records any price updates that the buyer rejected, this activity sends a notification to the supplier if your supplier is set up in Workflow to receive such notifications. See the Oracle Workflow Guide.
Process Navigator Workflows

The Processes tab in the Oracle Public Sector Purchasing Navigator, in the Purchasing application, allows access to the process navigator workflows. These Workflow–enabled diagrams guide you through the following procurement processes from beginning to end by automatically launching the appropriate windows:

- Procure–to–Pay, from creating a requisition and purchase order to transferring invoice and payment accounting information to the general ledger.

- Sourcing, from using the Oracle Business Intelligence System to analyze commodities and suppliers to defining sourcing rules in Purchasing.
  - Define Sourcing, a subprocess of Sourcing, which describes how to define sourcing rules.

- Purchase Order Creation, from creating the purchase order to modifying it and communicating it to the supplier.

- Receiving, from receiving an Advance Shipment Notice from the supplier to delivering the goods.

These processes are the default navigator workflow processes that come with Purchasing.

Accessing the Navigator Processes in Purchasing

The Processes tab in the Purchasing application allows access to the process navigator workflows.

See also: Using the Navigator’s Process Region, Oracle Applications User’s Guide.

▶ To use the process navigator workflows in Purchasing:

1. In the Processes tab of the Purchasing Navigator in the Purchasing application, select any process.
2. Select any activity in the process to display additional information about it.
3. Double–click each activity to launch the appropriate window and guide yourself through the process.

A few activities require other products to be installed. For example, the activity Create and Approve Requisition in the Procure–to–Pay process launches IProcurement if IProcurement is installed.
Accessing the Workflows in the Workflow Builder

You can also view these processes in the Oracle Workflow Builder. In the Workflow Builder, the procurement navigator processes are associated with an item type called Procurement Processes.

You should not change your access level to modify a locked process; however, you can use the default procurement navigator processes as examples to create your own processes for the Process Navigator. For more information, see: Creating Process Navigator Processes, Oracle Applications System Administrator’s Guide.
Debit Memo Notification Workflow

The workflow Debit Memo Notification notifies you through the Notifications Summary window of debit memos that could not be created. For example, if an invoice was not yet created for the receipt when entered the return, a debit memo for the invoice would not have been able to be created and you would receive a notification of such. See: Debit Memos: page 7 – 15.

Customizing the Debit Memo Notification Workflow

Use the Oracle Workflow Builder to customize workflows. When you customize a workflow, only those documents that are created after you customize it are affected by the customized workflow.

► To display the workflow in the Oracle Workflow Builder:

1. Choose Open from the File menu, and connect to the database.

   See: Opening and Saving Item Types, Oracle Workflow Guide.

   The Display name of the workflow is PO Debit Memo Notification. Its internal name, viewable through the Workflow Builder, is RCVDMEMO. The name of its Workflow definition file is rcvwdmo.wft.
2. Expand the data source, then the PO Debit Memo Notification item type branch within that data source.

3. Expand the Processes branch within the PO Debit Memo Notification branch, then double-click on its process activity to display the process diagram.

Creating a New Custom Process

If you want to customize the PO Debit Memo Notification workflow, you must customize the default (original) workflow that Purchasing provides. Unlike the PO Approval, PO Requisition Approval, and PO Create Documents workflows in Purchasing, only one PO Debit Memo Notification workflow can be called from the application itself. You can’t select a separate customization, like you can with the other workflows in the Document Types window. Therefore, you need to make your customizations to the default workflow. Create a backup to revert to, if you need, while you are testing your customizations.

Required Modifications

There are no required modifications you need to make to the PO Debit Memo Notification workflow.

Supported and Unsupported Customizations

Following is a discussion of what you can and definitely cannot modify in the PO Debit Memo Notification workflow. For those things you can modify, the discussion includes important guidelines that you need to be careful of when making customizations.

For important information on how to customize workflows, see the Oracle Workflow Guide.

To further help you with your customizations, refer to the following sections, The PO Debit Memo Notification Item Type and Summary of the Debit Memo Process. These sections describe the components of the notification process in the workflow. If you haven’t already, see also: Customization Guidelines: page C – 5.

**Attention:** If a particular Workflow object does not appear in the following sections on the lists of things you can customize, do not modify it, regardless of its access level.
The PO Debit Memo Notification Item Type

The notification sending process is associated with an item type called PO Debit Memo Notification. This item type identifies all notification workflow processes available. There is one workflow process associated with PO Debit Memo Notification: Debit Memo.

The PO Debit Memo Notification item type also has attributes associated with it. These attributes reference information in the Purchasing application tables. The attributes are used and maintained by function activities as well as notification activities throughout the process.

The following table shows the PO Debit Memo Notification item type attributes.
## PO Debit Memo Notification Item Type Attributes

<table>
<thead>
<tr>
<th>Display Name</th>
<th>Description</th>
<th>Type</th>
<th>Length/Format/Lookup Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debit Memo Message1</td>
<td>First part of the notification text, up until the receipt number is mentioned (the message text is divided into four messages for translation purposes)</td>
<td>Text</td>
<td>100</td>
</tr>
<tr>
<td>Debit Memo Message2</td>
<td>The part of the notification text just before the purchase order number is mentioned</td>
<td>Text</td>
<td>100</td>
</tr>
<tr>
<td>Debit Memo Message3</td>
<td>Main body of the notification text</td>
<td>Text</td>
<td>1000</td>
</tr>
<tr>
<td>Debit Memo Message 4</td>
<td>The part of the notification text that mentions the returned quantity</td>
<td>Text</td>
<td>100</td>
</tr>
<tr>
<td>Debit memo Notification Title</td>
<td>Notification title, &quot;Automatic Debit Memo Creation Failed&quot;</td>
<td>Text</td>
<td>2000</td>
</tr>
<tr>
<td>PO Number</td>
<td>Number of the purchase order against which the debit memo is created</td>
<td>Text</td>
<td>20</td>
</tr>
<tr>
<td>Quantity</td>
<td>Returned quantity for which the debit memo is created</td>
<td>Text</td>
<td>20</td>
</tr>
<tr>
<td>Receipt Number</td>
<td>Number of the receipt against which the debit memo is created</td>
<td>Text</td>
<td>20</td>
</tr>
<tr>
<td>User Display Name</td>
<td>Buyer’s name as displayed in Purchasing</td>
<td>Text</td>
<td>240</td>
</tr>
<tr>
<td>User Name</td>
<td>Buyer’s user name as set up in Oracle Applications</td>
<td>Text</td>
<td>100</td>
</tr>
</tbody>
</table>

Table C–17  (Page 1 of 1)
Summary of the Debit Memo Process

To view the properties of the Debit Memo process, select the process in the navigator tree, then choose Properties from the Edit menu. The Debit Memo process has a result type of None, indicating that when the process completes, it doesn’t end with any particular result, such as End (Approved) or End (Rejected).

This process activity is also runnable, indicating that it can be initiated as a top-level process to run by making calls to the Workflow Engine CreateProcess and StartProcess APIs.

The workflow begins at node 1. It sends a notification to the buyer at node 2 if the debit memo could not be created—for example, if an invoice does not yet exist against which to create the debit memo, or if the invoice program that creates the memos failed. This includes notifications for debit memos that were not created because Payment on Receipt already accounted for the return using the Aging Period functionality. The notification instructs the buyer to contact the Accounts Payables department to create a debit memo manually.
Character Mode Forms and Corresponding GUI Windows

This appendix describes how Character-mode forms in previous releases map to GUI windows in the current release of Oracle Public Sector Purchasing.
Oracle Public Sector Purchasing Character Mode Forms and Corresponding GUI Windows

The following table matches character mode forms with their corresponding GUI windows or processes. This information supplements *Windows and Navigator Paths* in the product online documentation. Text in brackets ([ ]) indicates a button or other selection within a window.

The GUI Navigator paths are based on the Purchasing Manager responsibility.

For more information on any window, navigate to the window and choose the help icon.

<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accrual Write–Offs</td>
<td>Accrual Write–Offs</td>
</tr>
<tr>
<td>\Navigate Documents Manage Accruals</td>
<td>Navigator: Accounting &gt; Accrual Write–Offs</td>
</tr>
<tr>
<td>Approve Documents</td>
<td>Approve Document</td>
</tr>
</tbody>
</table>
| \Navigate Documents Manage Approve | Navigator: Notifications Summary > Select a notification line > [Open] > [Respond] > Select a User Approve Action  
|                                 | or                                       |
|                                 | Navigator: Purchase Orders > Purchase Orders > [Approve]  
|                                 | or                                       |
|                                 | Navigator: Requisitions > Requisitions > [Approve] |

Table D – 1   (Page 1 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approve Quotations</td>
<td>Approve Entire Quotation</td>
</tr>
<tr>
<td>\Navigate Documents Quotations Approve Quotations</td>
<td>Navigator: RFQs and Quotations &gt; Quote Analysis &gt; [Find] &gt; [Approve Entire Quotation] or Navigator: RFQs and Quotations &gt; Quotations &gt; [Price Breaks] &gt; [Approve] or Navigator: RFQs and Quotations &gt; Quotations &gt; [Approve] or Quotations Navigator: RFQs and Quotations &gt; Quotations</td>
</tr>
<tr>
<td>Approve Quotations by Item</td>
<td>Analyze Quotations</td>
</tr>
<tr>
<td>\Navigate Documents Quotations Approve Items</td>
<td>Navigator: RFQs and Quotations &gt; Quote Analysis &gt; [Find]</td>
</tr>
<tr>
<td>Assign Descriptive Security Rules</td>
<td>Assign Security Rules</td>
</tr>
<tr>
<td>\Navigate Setup Financials Descriptive Security Assign</td>
<td>Navigator: Setup &gt; Flexfields &gt; Descriptive &gt; Security &gt; Assign</td>
</tr>
<tr>
<td>Assign Function Parameters</td>
<td>FlexBuilder is replaced by the Account Generator in Oracle Workflow. See: Overview of Account Generator (Oracle Applications Flexfields Guide)</td>
</tr>
<tr>
<td>\Navigate Setup Financials Flexfields FlexBuilder Assign</td>
<td></td>
</tr>
<tr>
<td>Assign Key Flexfield Security Rules</td>
<td>Assign Security Rules</td>
</tr>
<tr>
<td>\Navigate Setup Financials Flexfields Key Security Assign</td>
<td>Navigator: Setup &gt; Flexfields &gt; Key &gt; Security &gt; Assign</td>
</tr>
<tr>
<td>Assign Requisitions</td>
<td>Assign Requisition Lines</td>
</tr>
<tr>
<td>\Navigate Documents Requisitions Assign</td>
<td>Navigator: Management &gt; Manage Buyer Workload [Find]</td>
</tr>
<tr>
<td>Assign Value Set Security Rules</td>
<td>Assign Security Rules</td>
</tr>
<tr>
<td>\Navigate Setup Financials Flexfields Validation Security Assign</td>
<td>Navigator: Setup &gt; Flexfields &gt; Validation &gt; Security &gt; Assign</td>
</tr>
</tbody>
</table>

Table D – 1  (Page 2 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AutoCreate Purchase Orders</strong></td>
<td>Modify Lines</td>
</tr>
<tr>
<td><strong>AutoCreate Quotations</strong></td>
<td>AutoCreate Documents</td>
</tr>
<tr>
<td>\Navigate Documents Quotations AutoCreate</td>
<td>Navigator: RFQS &amp; Quotations &gt; RFQs &gt; Tools menu &gt; Copy Document</td>
</tr>
<tr>
<td><strong>AutoCreate RFQs</strong></td>
<td>AutoCreate Documents</td>
</tr>
<tr>
<td>\Navigate Documents RFQs AutoCreate</td>
<td>Navigator: AutoCreate &gt; [Find]</td>
</tr>
<tr>
<td><strong>AutoSubmit Purchasing Processes</strong></td>
<td>Submit Request</td>
</tr>
<tr>
<td>\Navigate Setup Purchasing AutoSubmit</td>
<td>Navigator: Reports &gt; Run &gt; [Single Request] &gt; [OK] or Submit Request Set Navigator: Reports &gt; Run &gt; [Request Set] &gt; [OK]</td>
</tr>
<tr>
<td><strong>Change Organization</strong></td>
<td>Organization</td>
</tr>
<tr>
<td>\Navigate Receipts ChangeOrg</td>
<td>Navigator: Change Organization</td>
</tr>
</tbody>
</table>

Table D – 1  (Page 3 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Purchase Orders</td>
<td>Control Document</td>
</tr>
<tr>
<td>\Navigate Documents Purchases Control</td>
<td>Navigator: Purchase Orders &gt; Purchase Order Summary &gt; [Headers] &gt; [Find] &gt; Tools menu &gt; Control</td>
</tr>
<tr>
<td></td>
<td>or Navigator: Purchase Orders &gt; Purchase Order Summary &gt; [Lines] &gt; [Find] &gt; Tools menu &gt; Control</td>
</tr>
<tr>
<td></td>
<td>or Navigator: Purchase Orders &gt; Purchase Order Summary &gt; [Shipments] &gt; [Find] &gt; Tools menu &gt; Control</td>
</tr>
<tr>
<td>Control Purchasing Periods</td>
<td>Control Purchasing Periods</td>
</tr>
<tr>
<td>\Navigate Setup Accounting Periods</td>
<td>Navigator: Setup &gt; Financials &gt; Accounting &gt; Control Purchasing Periods</td>
</tr>
<tr>
<td>Control Requisitions</td>
<td>Control Document</td>
</tr>
<tr>
<td>\Navigate Documents Requisitions Control</td>
<td>Navigator: Requisitions &gt; Requisition Summary &gt; [Headers] &gt; [Find] &gt; Tools menu &gt; Control</td>
</tr>
<tr>
<td></td>
<td>or Navigator: Requisitions &gt; Requisition Summary &gt; [Lines] &gt; [Find] &gt; Tools menu &gt; Control</td>
</tr>
<tr>
<td>Define Buyers</td>
<td>Buyers</td>
</tr>
<tr>
<td>\Navigate Setup Organization Buyers</td>
<td>Navigator: Setup &gt; Personnel &gt; Buyers</td>
</tr>
<tr>
<td>Define Calendar</td>
<td>Accounting Calendar</td>
</tr>
<tr>
<td>\Navigate Setup Financials Calendars Periods</td>
<td>Navigator: Setup &gt; Financials &gt; Accounting &gt; Calendar</td>
</tr>
<tr>
<td>Define Category</td>
<td>Categories</td>
</tr>
<tr>
<td>\Navigate Items Category Category</td>
<td>Navigator: Setup &gt; Items &gt; Categories &gt; Category Codes</td>
</tr>
<tr>
<td>Define Category Set</td>
<td>Category Set</td>
</tr>
<tr>
<td>\Navigate Items Category Set</td>
<td>Navigator: Setup &gt; Items &gt; Categories &gt; Category Sets</td>
</tr>
</tbody>
</table>

Table D – 1  (Page 4 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define Control Groups</td>
<td>Purchasing Options</td>
</tr>
<tr>
<td>\Navigate Setup Organization Authorizations Groups</td>
<td>Navigator: Setup &gt; Organizations &gt; Purchasing Options &gt; Control</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Approval Groups</td>
</tr>
<tr>
<td></td>
<td>Navigator: Setup &gt; Approvals &gt; Approval Groups</td>
</tr>
<tr>
<td>Define Cross–Reference Types</td>
<td>Assign Cross References</td>
</tr>
<tr>
<td>\Navigate Items References CrossReferences Types</td>
<td>Navigator: Items &gt; Cross References &gt; [Assign]</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Cross Reference Types</td>
</tr>
<tr>
<td></td>
<td>Navigator: Items &gt; Cross References</td>
</tr>
<tr>
<td>Define Cross–Validation Rule</td>
<td>Cross–Validation Rules</td>
</tr>
<tr>
<td>\Navigate Setup Financials Flexfields Key Rules</td>
<td>Navigator: Setup &gt; Flexfields &gt; Key &gt; Cross–Validation</td>
</tr>
<tr>
<td>Define Currency</td>
<td>Currencies</td>
</tr>
<tr>
<td>\Navigate Setup Financials Currencies Define</td>
<td>Navigator: Setup &gt; Financials &gt; Currency &gt; Currencies</td>
</tr>
<tr>
<td>Define Daily Conversion Rate Types</td>
<td>Daily Conversion Rate Type</td>
</tr>
<tr>
<td>\Navigate Setup Financials Currencies Rates Types</td>
<td>Navigator: Setup &gt; Financials &gt; Currency &gt; Daily Rates</td>
</tr>
<tr>
<td>Define Daily Rates</td>
<td>Daily Rates</td>
</tr>
<tr>
<td>\Navigate Setup Financials Currencies Rates Daily</td>
<td>Navigator: Setup &gt; Financials &gt; Currency &gt; Daily Rates</td>
</tr>
<tr>
<td>Define Default Category Sets</td>
<td>Default Category Sets</td>
</tr>
<tr>
<td>\Navigate Items Category Defaults</td>
<td>Navigator: Setup &gt; Items &gt; Categories &gt; Default Category Sets</td>
</tr>
<tr>
<td>Define Descriptive Flexfield Segments</td>
<td>Descriptive Flexfield Segments</td>
</tr>
<tr>
<td>\Navigate Setup Financials Flexfields Descriptive Segments</td>
<td>Navigator: Setup &gt; Flexfields &gt; Descriptive &gt; Segments</td>
</tr>
<tr>
<td>Define Descriptive Security Rule</td>
<td>Define Security Rules</td>
</tr>
<tr>
<td>\Navigate Setup Financials Flexfields Descriptive Security Define</td>
<td>Navigator: Setup &gt; Flexfields &gt; Descriptive &gt; Security &gt; Define</td>
</tr>
</tbody>
</table>

Table D – 1  (Page 5 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define Descriptive Segment Values</td>
<td>Segment Values</td>
</tr>
<tr>
<td>\Navigate Setup Financials Flexfields Descriptive Values</td>
<td>Navigator: Setup &gt; Flexfields &gt; Descriptive &gt; Values</td>
</tr>
<tr>
<td>Define Document Controls</td>
<td>Document Types</td>
</tr>
<tr>
<td>\Navigate Setup Purchasing Documents</td>
<td>Navigator: Setup &gt; Purchasing &gt; Document Types</td>
</tr>
<tr>
<td>Define Financials Options</td>
<td>Define Financial Options</td>
</tr>
<tr>
<td>\Navigate Setup Financials Options</td>
<td>Navigator: Setup &gt; Organizations &gt; Financial Options</td>
</tr>
<tr>
<td>Define Flexbuilder Parameter</td>
<td>FlexBuilder is replaced by the Account Generator in Oracle Workflow.</td>
</tr>
<tr>
<td>\Navigate Setup Financials Flexfields FlexBuilder Define</td>
<td>See: Overview of Account Generator (Oracle Applications Flexfields Guide)</td>
</tr>
<tr>
<td>Define Freight Carriers</td>
<td>Freight Carriers</td>
</tr>
<tr>
<td>\Navigate Setup Purchasing Codes Freight</td>
<td>Navigator: Setup &gt; Purchasing &gt; Freight Carriers</td>
</tr>
<tr>
<td>Define Hazard Classes</td>
<td>Hazard Classes</td>
</tr>
<tr>
<td>\Navigate Setup Purchasing Codes Hazard Class</td>
<td>Navigator: Setup &gt; Purchasing &gt; Hazard Classes</td>
</tr>
<tr>
<td>Define InterClass Conversions</td>
<td>Unit of Measure Conversions</td>
</tr>
<tr>
<td>\Navigate Setup Purchasing Units Measures Conversion InterClass</td>
<td>Navigator: Setup &gt; Units of Measure &gt; Conversions</td>
</tr>
</tbody>
</table>

Table D – 1  (Page 6 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
</table>
| Define Item \Navigate Items Define Define | Category Assignment  
Navigator: Items > Master Items > Tools menu > Categories  
or  
Navigator: Items > Organization Items > Tools menu > Categories  
or  
Item Assignment  
Navigator: Setup > Items > Master Items > Tools menu > Item Details  
or  
Item Subinventories  
Navigator: Items > Organizations Items > Tools menu > Item Subinventories  
or  
Master Item  
Navigator: Items > Master Items > [New]  
or  
Mass Forwarding Documents  
Items > Master Items > [Open]  
or  
Master Items  
Navigator: Items > Master Items |
| Define Item Attribute Controls \Navigate Items Define Attributes | Item Attribute Controls  
Navigator: Setup > Items > Attribute Controls |

Table D – 1  (Page 7 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define Item Catalog Groups</td>
<td>Item Catalog</td>
</tr>
<tr>
<td>\Navigate Items Define Groups</td>
<td>Navigator: Items &gt; Master Items &gt; Tools menu &gt; Catalog</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Item Catalog Groups</td>
</tr>
<tr>
<td></td>
<td>Navigator: Setup &gt; Items &gt; Catalog Groups</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Navigator: Setup &gt; Items &gt; Catalog Groups &gt; [Details]</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Item Categories</td>
</tr>
<tr>
<td></td>
<td>Navigator: Items &gt; Item Information &gt; [Categories]</td>
</tr>
<tr>
<td>Define Item Cross–References</td>
<td>Item Cross Reference Assignment</td>
</tr>
<tr>
<td>\Navigate Items References CrossReference CrossReferences</td>
<td>Navigator: Items &gt; Master Items &gt; Tools menu &gt; Cross References</td>
</tr>
<tr>
<td>Define Item Relationships</td>
<td>Item Relationships</td>
</tr>
<tr>
<td>\Navigate Items References Relations</td>
<td>Navigator: Items &gt; Item Relationships</td>
</tr>
<tr>
<td>Define Item Revisions</td>
<td>Item Revisions</td>
</tr>
<tr>
<td>\Navigate Item Define Revisions</td>
<td>Navigator: Items &gt; Organization Items &gt; Tools menu &gt; Revisions</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Navigator: Items &gt; Item Information &gt; [Revisions]</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Navigator: Items &gt; Master Items &gt; Tools menu &gt; Revisions</td>
</tr>
<tr>
<td>Define Item Template</td>
<td>Item Templates Summary</td>
</tr>
<tr>
<td>\Navigate Items Define Templates</td>
<td>Navigator: Setup &gt; Items &gt; Templates</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Item Template</td>
</tr>
<tr>
<td></td>
<td>Navigator: Setup &gt; Items &gt; Templates &gt; [New]</td>
</tr>
<tr>
<td>Define Job</td>
<td>Job</td>
</tr>
<tr>
<td>\Navigate Setup Organization Personnel Jobs</td>
<td>Navigator: Setup &gt; Personnel &gt; Jobs</td>
</tr>
</tbody>
</table>

Table D – 1 (Page 8 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define Key Flexfield Security Rule</td>
<td>Define Security Rules</td>
</tr>
<tr>
<td>\Navigate Setup Financials Flexfields Key Security Define</td>
<td>Navigator: Setup &gt; Flexfields &gt; Key &gt; Security &gt; Define</td>
</tr>
<tr>
<td>Define Key Flexfield Segments</td>
<td>Key Flexfield Segments</td>
</tr>
<tr>
<td>\Navigate Setup Financials Flexfields Key Segments</td>
<td>Navigator: Setup &gt; Flexfields &gt; Key &gt; Segments</td>
</tr>
<tr>
<td>Define Key Segment Values</td>
<td>Segment Values</td>
</tr>
<tr>
<td>\Navigate Setup Financials Flexfields Key Values</td>
<td>Navigator: Setup &gt; Flexfields &gt; Key &gt; Values</td>
</tr>
<tr>
<td>Define Line Types</td>
<td>Line Types</td>
</tr>
<tr>
<td>\Navigate Setup Purchasing Codes Line</td>
<td>Navigator: Setup &gt; Purchasing &gt; Line Types</td>
</tr>
<tr>
<td>Define Location</td>
<td>Location</td>
</tr>
<tr>
<td>\Navigate Setup Organization Locations Define</td>
<td>Navigator: Setup &gt; Organizations &gt; Locations</td>
</tr>
<tr>
<td>Define Location Associations</td>
<td>Location</td>
</tr>
<tr>
<td>\Navigate Setup Organization Locations Associate</td>
<td>Navigator: Setup &gt; Organizations &gt; Locations</td>
</tr>
<tr>
<td>Define Manufacturer Part Numbers</td>
<td>Manufacturer Part Numbers</td>
</tr>
<tr>
<td>\Navigate Items References ManufacturersParts</td>
<td>Navigator: Items &gt; Manufacturers’ Part Numbers &gt; By Items</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Navigator: Items &gt; Manufacturers’ Part Numbers &gt; By Manufacturers &gt; [Parts]</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Navigator: Items &gt; Master Items &gt; Tools menu &gt; Manufacturers’ Part Numbers</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Navigator: Items &gt; Organization Items &gt; Tools menu &gt; Manufacturers’ Part Number</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Manufacturers</td>
</tr>
<tr>
<td></td>
<td>Navigator: Items &gt; Manufacturers’ Part Numbers &gt; By Manufacturers</td>
</tr>
<tr>
<td>Define MassCancel</td>
<td>Define MassCancel</td>
</tr>
<tr>
<td>\Navigate Documents Manage MassCancel Define</td>
<td>Navigator: Accounting &gt; MassCancel</td>
</tr>
</tbody>
</table>

Table D – 1  (Page 9 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define Organization</td>
<td>Organization</td>
</tr>
<tr>
<td>\Navigate Setup Organization Organization</td>
<td>Navigator: Setup &gt; Organizations &gt; Organizations</td>
</tr>
<tr>
<td>Define Payment Terms</td>
<td>Define Payment Terms</td>
</tr>
<tr>
<td>\Navigate Setup Accounting Terms</td>
<td>Navigator: Setup &gt; Financials &gt; Payment Terms</td>
</tr>
<tr>
<td>Define Period Types</td>
<td>Period Types</td>
</tr>
<tr>
<td>\Navigate Setup Financials Calendars Types</td>
<td>Navigator: Setup &gt; Financials &gt; Accounting &gt; Period Types</td>
</tr>
<tr>
<td>Define Position</td>
<td>Positions</td>
</tr>
<tr>
<td>\Navigate Setup Organization Personnel Positions</td>
<td>Navigator: Setup &gt; Personnel &gt; Positions</td>
</tr>
<tr>
<td>Define Position Controls</td>
<td>Positions</td>
</tr>
<tr>
<td>\Navigate Setup Organization Authorizations Controls</td>
<td>Navigator: Setup &gt; Personnel &gt; Positions</td>
</tr>
<tr>
<td>Define Position Hierarchy</td>
<td>Position Hierarchy</td>
</tr>
<tr>
<td>\Navigate Setup Organization Personnel Hierarchies</td>
<td>Navigator: Setup &gt; Personnel &gt; Position Hierarchy</td>
</tr>
<tr>
<td>Define Purchasing Options</td>
<td>Purchasing Options</td>
</tr>
<tr>
<td>\Navigate Setup Purchasing Options Purchasing</td>
<td>Navigator: Setup &gt; Organizations &gt; Purchasing Options</td>
</tr>
<tr>
<td>Define Quality Inspection Codes</td>
<td>Quality Inspection Codes</td>
</tr>
<tr>
<td>\Navigate Setup Purchasing Codes Inspection</td>
<td>Navigator: Setup &gt; Purchasing &gt; Quality Inspection Codes</td>
</tr>
<tr>
<td>Define QuickCodes</td>
<td>Application Utilities Lookups</td>
</tr>
<tr>
<td>\Navigate Setup Financials QuickCodes</td>
<td>Navigator: Setup &gt; Financials &gt; Accounting &gt; QuickCodes</td>
</tr>
<tr>
<td>Define Receiving Options</td>
<td>Receiving Options</td>
</tr>
<tr>
<td>\Navigate Setup Purchasing Options Receiving</td>
<td>Navigator: Setup &gt; Organizations &gt; Receiving Options</td>
</tr>
<tr>
<td>Define Report Set</td>
<td>Request Set</td>
</tr>
<tr>
<td>\Navigate Reports Define</td>
<td>Use the System Administrator responsibility</td>
</tr>
<tr>
<td></td>
<td>Navigator: Concurrent &gt; Set</td>
</tr>
<tr>
<td>Define Rollup Groups</td>
<td>Rollup Groups</td>
</tr>
<tr>
<td>\Navigate Setup Financials Flexfields Key Groups</td>
<td>Navigator: Setup &gt; Flexfields &gt; Key &gt; Groups</td>
</tr>
</tbody>
</table>

Table D – 1  (Page 10 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define Set of Books</td>
<td>Set of Books</td>
</tr>
<tr>
<td>\Navigate Setup Financials Books</td>
<td>Navigator: Setup &gt; Organizations &gt; Set of Books &gt; Define</td>
</tr>
<tr>
<td>Define Shorthand Aliases</td>
<td>Shorthand Aliases</td>
</tr>
<tr>
<td>\Navigate Setup Financials Flexfields Key Aliases</td>
<td>Navigator: Setup &gt; Flexfields &gt; Key &gt; Aliases</td>
</tr>
<tr>
<td>Define Status</td>
<td>Item Status</td>
</tr>
<tr>
<td>\Navigate Items Define Status</td>
<td>Navigator: Setup &gt; Items &gt; Status Codes</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Pending Status</td>
</tr>
<tr>
<td></td>
<td>Navigator: Items &gt; Pending Status</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Navigator: Items &gt; Master Items &gt; Tools menu &gt; Pending Status</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Navigator: Items &gt; Organization Items &gt; Pending Status</td>
</tr>
<tr>
<td>Define Tax Names</td>
<td>Tax Names</td>
</tr>
<tr>
<td>\Navigate Setup Accounting Taxes</td>
<td>Navigator: Setup &gt; Accounting &gt; Taxes</td>
</tr>
<tr>
<td>Define Transaction Reasons</td>
<td>Obsolete in GUI.</td>
</tr>
<tr>
<td>\Navigate Setup Purchasing Codes Reason</td>
<td></td>
</tr>
<tr>
<td>Define UN Numbers</td>
<td>UN Numbers</td>
</tr>
<tr>
<td>\Navigate Setup Purchasing Codes Hazard Number</td>
<td>Navigator: Setup &gt; Purchasing &gt; UN Numbers</td>
</tr>
<tr>
<td>Define Unit of Measure Conversions</td>
<td>Unit of Measure Conversions</td>
</tr>
<tr>
<td>\Navigate Setup Purchasing Units Measures Conversion Standard</td>
<td>Navigator: Setup &gt; Units of Measure &gt; Conversions</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Navigator: Setup &gt; Units of Measure &gt; Units of Measure &gt; [Conversions]</td>
</tr>
<tr>
<td>Define Units of Measure</td>
<td>Units of Measure</td>
</tr>
<tr>
<td>\Navigate Setup Purchasing Units Measures Definition</td>
<td>Navigator: Setup &gt; Units of Measure &gt; Units of Measure</td>
</tr>
</tbody>
</table>

Table D – 1  (Page 11 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define Units of Measure Classes</td>
<td>Unit of Measure Classes</td>
</tr>
<tr>
<td>\Navigate Setup Purchasing Units Classes</td>
<td>Navigator: Setup &gt; Units of Measure &gt; Classes or Units of Measure Navigator: Setup &gt; Units of Measure &gt; Classes &gt; [Units of Measure]</td>
</tr>
<tr>
<td>Define Value Set</td>
<td>Value Sets</td>
</tr>
<tr>
<td>\Navigate Setup Financials Flexfields Validation Sets</td>
<td>Navigator: Setup &gt; Flexfields &gt; Validation &gt; Sets</td>
</tr>
<tr>
<td>Define Value Set Security Rule</td>
<td>Define Security Rules</td>
</tr>
<tr>
<td>\Navigate Setup Financials Flexfields Validation Security Define</td>
<td>Navigator: Setup &gt; Flexfields &gt; Validation &gt; Security &gt; Define</td>
</tr>
<tr>
<td>Define Values</td>
<td>Segment Values</td>
</tr>
<tr>
<td>\Navigate Setup Financials Flexfields Validation Values</td>
<td>Navigator: Setup &gt; Flexfields &gt; Validation &gt; Values</td>
</tr>
<tr>
<td>Enter Acceptances</td>
<td>Acceptances</td>
</tr>
<tr>
<td>\Navigate Documents Purchases Accept</td>
<td>Navigator: Purchase Orders &gt; Purchase Orders &gt; Tools menu &gt; Acceptances</td>
</tr>
<tr>
<td>Enter Employee</td>
<td>Enter Person</td>
</tr>
<tr>
<td>\Navigate Setup Organization Personnel Employees</td>
<td>Navigator: Setup &gt; Personnel &gt; Employees</td>
</tr>
<tr>
<td>Enter Express Requisitions</td>
<td>Supplier Item Catalog</td>
</tr>
<tr>
<td>\Navigate Documents Requisitions ReqExpress</td>
<td>Navigator: Supplier Item Catalog &gt; [Find] &gt; [Requisition Template] alternative region</td>
</tr>
<tr>
<td>Enter Lookup Codes</td>
<td>Oracle Purchasing Lookups</td>
</tr>
<tr>
<td>\Navigate Setup Purchasing Codes Lookups</td>
<td>Navigator: Setup &gt; Purchasing &gt; Lookup Codes</td>
</tr>
<tr>
<td>Enter Lot and Serial Numbers</td>
<td>Lot Entry</td>
</tr>
<tr>
<td></td>
<td>Navigator: [Lot/Serial] various locations or Serial Numbers Navigator: [Lot/Serial] various locations</td>
</tr>
<tr>
<td>Enter Notes</td>
<td>Item Documents</td>
</tr>
<tr>
<td></td>
<td>Navigator: Items &gt; Customer Items &gt; Documents</td>
</tr>
</tbody>
</table>

Table D – 1  (Page 12 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
</table>
| Enter Purchase Agreements \Navigate Documents Purchases Enter Agreements | Terms and Conditions  
Navigator: Purchase Orders > Purchase Orders > [Terms] |
| Enter Purchase Orders \Navigate Documents Purchases Enter Orders | Terms and Conditions  
Navigator: Purchase Orders > Purchase Orders > [Terms]  
or  
Outside Processing  
Navigator: Purchase Orders > Purchase Orders > [Shipments] > [Distributions] > [Outside Processing]  
or  
Distributions  
Navigator: Purchase Orders > Purchase Orders > [Shipments] > [Distributions]  
or  
Purchase Order Lines  
Navigator: Purchase Orders > Purchase Orders Summary > [Find] > [Lines]  
or  
Purchase Order Shipments  
Navigator: Purchase Orders > Purchase Order Summary > [Find] > [Lines] > [Shipments]  
or  
Purchase Order Distributions  
Navigator: Purchase Orders > Purchase Order Summary > [Find] > [Lines] > [Shipments]  
or  
Navigator: Purchase Orders > Purchase Order Summary > [Find] > [Lines] > [Shipments] > [Distributions]  
or  
Purchase Order Preferences  
Navigator: Purchase Orders > Purchase Orders > Tools menu > Preferences |

Table D-1 (Page 13 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter Quotations \Navigate Documents Quotations Enter</td>
<td>Quotation Terms Navigator: RFQs and Quotations &gt; Quotations &gt; [Terms] or Quotations Navigator: RFQs and Quotations &gt; Quotations or Quotation Shipments Navigator: RFQs and Quotations &gt; Quotations &gt; [Shipments]</td>
</tr>
<tr>
<td>Enter Receipts \Navigate Receipts Enter</td>
<td>Express Receipts Navigator: Receiving &gt; Receipts &gt; [Find] &gt; [Express] or Find Expected Results Navigator: Receiving &gt; Receipts</td>
</tr>
<tr>
<td>Enter Receiving Transactions \Navigate Receipts Transact</td>
<td>Inspect Received Items Navigator: Receiving &gt; Receiving Transactions &gt; [Inspect]</td>
</tr>
<tr>
<td>Enter Releases \Navigate Documents Enter Releases [Release Shipments] [More] [Receiving Controls Info]</td>
<td>Receiving Controls Navigator: Purchase Orders &gt; Releases &gt; [Receiving Controls]</td>
</tr>
<tr>
<td>Enter Releases \Navigate Documents Purchases Enter Releases</td>
<td>Purchase Order Summary to Releases Navigator: Purchase Orders &gt; Purchase Order Summary &gt; [NewRelease] or Releases Navigator: Purchase Orders &gt; Releases</td>
</tr>
<tr>
<td>Enter Releases – Distributions \Navigate Documents Purchases Enter Releases [Shipments] [Distribution]</td>
<td>Distributions Navigator: Purchase Orders &gt; Releases &gt; [Distributions]</td>
</tr>
<tr>
<td>Enter ReqExpress Template \Navigate Documents Requisitions Templates</td>
<td>Requisition Templates Navigator: Setup &gt; Purchasing &gt; Requisition Templates</td>
</tr>
</tbody>
</table>

Table D – 1  (Page 14 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter Requisitions</td>
<td>Requisitions</td>
</tr>
<tr>
<td>\Navigate Documents Requisitions Enter</td>
<td>Navigator: Requisitions &gt; Requisitions</td>
</tr>
<tr>
<td>Enter Returns and Adjustments</td>
<td>Receiving Corrections</td>
</tr>
<tr>
<td>\Navigate Receipts Return/Adjust</td>
<td>Navigator: Receiving &gt; Corrections &gt; [Find]</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Receiving Returns</td>
</tr>
<tr>
<td></td>
<td>Navigator: Receiving &gt; Returns &gt; [Find]</td>
</tr>
<tr>
<td>Enter RFQs</td>
<td>RFQ Terms</td>
</tr>
<tr>
<td>\Navigate Documents RFQs Enter</td>
<td>Navigator: RFQs and Quotations &gt; RFQs &gt; [Terms]</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>RFQ</td>
</tr>
<tr>
<td></td>
<td>Navigator: RFQs and Quotations &gt; RFQs</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>RFQ Price Breaks</td>
</tr>
<tr>
<td></td>
<td>Navigator: RFQs and Quotations &gt; RFQs &gt; [Price Breaks]</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>RFQ Shipments</td>
</tr>
<tr>
<td></td>
<td>Navigator: RFQs and Quotations &gt; RFQs &gt; [Shipments]</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>RFQ Suppliers</td>
</tr>
<tr>
<td></td>
<td>Navigator: RFQs and Quotations &gt; RFQs &gt; [Suppliers]</td>
</tr>
<tr>
<td>Enter Signature Approvals</td>
<td>Approvers without access to Purchasing can make approvals through the Web or e-mail, using Oracle Workflow. See: Offline Approvers: page 2 - 40.</td>
</tr>
<tr>
<td>\Navigate Documents Manage Signature</td>
<td></td>
</tr>
<tr>
<td>Enter Standard Notes</td>
<td>Item Documents</td>
</tr>
<tr>
<td>\Navigate Setup Purchasing Notes</td>
<td>Navigator: Items &gt; Documents</td>
</tr>
<tr>
<td>Enter Vendor</td>
<td>Suppliers</td>
</tr>
<tr>
<td>\Navigate Vendors Enter</td>
<td>Navigator: Supply Base &gt; Suppliers</td>
</tr>
</tbody>
</table>

Table D – 1  (Page 15 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
</table>
| Enter Vendor AutoSource Rules \Navigate Items References AutoSource Rules | Sourcing Rule  
Navigator: Supply Base > Sourcing Rules and  
Approved Supplier List  
Navigator: Supply Base > Approved Supplier List and  
Sourcing Rule / Bill of Distribution Assignments  
Navigator: Supply Base > Assign Sourcing Rules and  
Approved Supplier List Statuses  
Navigator: Supply Base > Supplier Statuses |
| Enter Vendor Quotation Lists \Navigate Vendors CreateList | Supplier Lists  
Navigator: Supply Base > Supplier Lists |
| Explode Requisitions  
\Navigate > Documents > Purchasing > AutoCreate > [Search] > [Requisitions] > [Action] > Explode | Modify Lines  
Navigator: AutoCreate > [Find] > Tools menu > Modify |
| Forward Documents  
\Navigate Documents Manage Forward | Forward Documents  
Navigator: Management > Forward Documents |
| Maintain Countries and Territories  
\Navigate Setup Financials Countries | Countries and Territories  
Navigator: Setup > Financials > Accounting > Countries |
| Maintain Shipments  
\Navigate Receipts Maintain | Maintain Shipments  
Navigator: Receiving > Manage Shipments > [Find] |
| Match Unordered Receipts  
\Navigate Receipts Match | Match Unordered Receipts  
Navigator: Receiving > Match Unordered Receipts > [Find]  
or  
Navigator: Receiving > Match Unordered Receipts |
| Multisource Requisitions | AutoCreate Documents  
Navigator: AutoCreate > [Find] |

Table D – 1  (Page 16 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open and Close Periods</td>
<td>Open and Close Periods</td>
</tr>
<tr>
<td>\Navigate Setup Financials Calendars Open/Close</td>
<td>Navigator: Setup &gt; Financials &gt; Accounting &gt; Open and Close Periods</td>
</tr>
<tr>
<td>Run MassCancel</td>
<td>Run MassCancel</td>
</tr>
<tr>
<td>\Navigate Documents Manage MassCancel Run</td>
<td>Navigator: Accounting &gt; Run MassCancel</td>
</tr>
<tr>
<td>Run Reports</td>
<td>Import Items</td>
</tr>
<tr>
<td>\Navigate Reports Run</td>
<td>Navigator: Items &gt; Import Items</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Submit Request</td>
</tr>
<tr>
<td></td>
<td>Navigator: Reports &gt; Run &gt; [Single Request] &gt; [OK]</td>
</tr>
<tr>
<td>Search Items</td>
<td>Item Search</td>
</tr>
<tr>
<td>\Navigate Inquiry Items Catalog</td>
<td>Navigator: Items &gt; Item Search</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Supplier Item Catalog</td>
</tr>
<tr>
<td></td>
<td>Navigator: Supplier Item Catalog &gt; [Find]</td>
</tr>
<tr>
<td>Select Approved Sources</td>
<td>Supplier Item Catalog</td>
</tr>
<tr>
<td></td>
<td>Navigator: Supplier Item Catalog &gt; [Find] &gt; [Negotiated Sources] or [Sourcing Rules] alternative region</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>(if your cursor is in a requisition line)</td>
</tr>
<tr>
<td></td>
<td>Navigator: Requisitions &gt; Requisitions &gt; [Catalog] &gt; [Find] &gt; [Negotiated Sources] or [Sourcing Rules] alternative region</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>(if your cursor is in a purchase order line)</td>
</tr>
<tr>
<td></td>
<td>Navigator: Purchase Orders &gt; Purchase Orders &gt; [Catalog] &gt; [Find] &gt; [Negotiated Sources] or [Sourcing Rules] alternative region</td>
</tr>
<tr>
<td>Submit Purge</td>
<td>Submit Purge</td>
</tr>
<tr>
<td>\Navigate Documents Manage Purge</td>
<td>Navigator: Management &gt; Purge</td>
</tr>
</tbody>
</table>

Table D – 1   (Page 17 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Flexbuilder Parameters</td>
<td>FlexBuilder is replaced by the Account Generator in Oracle Workflow. See: Overview of Account Generator (Oracle Applications Flexfields Guide)</td>
</tr>
<tr>
<td>\Navigate Setup Financials Flexfields FlexBuilder Test</td>
<td></td>
</tr>
<tr>
<td>Update Item/Org Attributes</td>
<td>Organization Item Navigator: Items &gt; Items &gt; Organization Items &gt; [Open]</td>
</tr>
<tr>
<td>\Navigate Items Update</td>
<td></td>
</tr>
<tr>
<td>Update Personal Profile Options</td>
<td>Personal Profile Values Navigator: Personal Profiles</td>
</tr>
<tr>
<td>\Navigate Other Profile</td>
<td></td>
</tr>
<tr>
<td>VendorMerge</td>
<td>Supplier Merge Navigator: Supply Base &gt; Supplier Merge</td>
</tr>
<tr>
<td>\Navigate Vendors Merge</td>
<td></td>
</tr>
<tr>
<td>View Acceptances – Acceptances</td>
<td>Acceptances Navigator: Purchase Orders &gt; Purchase Orders &gt; Tools menu &gt; Acceptances</td>
</tr>
<tr>
<td>\Navigate Inquiry Documents Purchasing</td>
<td></td>
</tr>
<tr>
<td>View Acceptances – Corrections</td>
<td>Receiving Corrections Navigator: Receiving &gt; Corrections</td>
</tr>
<tr>
<td>\Navigate Receipts Return/Adjust</td>
<td></td>
</tr>
<tr>
<td>View Action History</td>
<td>Action History Navigator: Releases &gt; Tools menu &gt; View Action History</td>
</tr>
<tr>
<td>View Employee</td>
<td>Employees Navigator: Setup &gt; Personnel &gt; Employees</td>
</tr>
<tr>
<td>\Navigate Inquiry Personnel Employee</td>
<td></td>
</tr>
<tr>
<td>View Item Attributes</td>
<td>Find Item Information Navigator: Items &gt; Item Information</td>
</tr>
<tr>
<td>\Navigate Inquiry Items Attributes</td>
<td></td>
</tr>
<tr>
<td>View Item Information</td>
<td>Find Item Information Navigator: Items &gt; Item Information or Item Status History Navigator: Items &gt; Organization Items &gt; Tools menu &gt; Pending Status</td>
</tr>
<tr>
<td>\Navigate Inquiry Items Status</td>
<td></td>
</tr>
<tr>
<td>View Job</td>
<td>Jobs Navigator: Setup &gt; Personnel &gt; Jobs</td>
</tr>
<tr>
<td>\Navigate Inquiry Personnel Job</td>
<td></td>
</tr>
</tbody>
</table>

Table D – 1  (Page 18 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Notes</td>
<td>Item Documents</td>
</tr>
<tr>
<td></td>
<td>Navigator: Items &gt; Customer Items &gt; Documents</td>
</tr>
<tr>
<td>View Notifications</td>
<td>Notifications Summary</td>
</tr>
<tr>
<td>Navigate Inquiry Notifications</td>
<td>Navigator: Notifications Summary</td>
</tr>
<tr>
<td>View PO Distribution Detail</td>
<td>Distributions</td>
</tr>
<tr>
<td></td>
<td>Navigator: Purchase Orders &gt; Purchase Orders &gt; [Shipments] &gt; [Distributions]</td>
</tr>
<tr>
<td>View Position</td>
<td>Position</td>
</tr>
<tr>
<td>\Navigate Inquiry Personnel Position</td>
<td>Navigator: Setup &gt; Personnel &gt; Positions</td>
</tr>
<tr>
<td>View Position Hierarchy</td>
<td>Position Hierarchy</td>
</tr>
<tr>
<td>\Navigate Inquiry Personnel Hierarchy</td>
<td>Navigator: Setup &gt; Personnel &gt; Position Hierarchy</td>
</tr>
<tr>
<td>View Price History</td>
<td>Supplier Item Catalog</td>
</tr>
<tr>
<td>\Navigate Inquiry Documents Purchases LastPrice</td>
<td>Navigator: Supplier Item Catalog &gt; [Find]</td>
</tr>
<tr>
<td>View Purchase History</td>
<td>Supplier Item Catalog</td>
</tr>
<tr>
<td>\Navigate Inquiry Documents Purchases History</td>
<td>Navigator: Supplier Item Catalog &gt; [Find] &gt; [Prior Purchases]</td>
</tr>
<tr>
<td>View Purchase Order Distributions</td>
<td>Distributions</td>
</tr>
<tr>
<td>\Navigate Inquiry Documents Purchases Distributions</td>
<td>Navigator: Purchase Orders &gt; Purchase Orders &gt; [Shipments] &gt; [Distributions]</td>
</tr>
<tr>
<td>View Purchase Order Header</td>
<td>Purchase Order Headers</td>
</tr>
<tr>
<td>\Navigate Inquiry Documents Purchases Purchases</td>
<td>Navigator: Purchase Orders &gt; Purchase Order Summary &gt; [Find]</td>
</tr>
<tr>
<td>View Purchase Order Line</td>
<td>Purchase Order Lines</td>
</tr>
<tr>
<td>\Navigate Inquiry Documents Purchases Purchases</td>
<td>Navigator: Purchase Orders &gt; Purchase Order Summary &gt; [Find] &gt; [Lines]</td>
</tr>
<tr>
<td>View Purchase Order Shipment</td>
<td>Purchase Order Shipments</td>
</tr>
<tr>
<td>\Navigate Inquiry Documents Purchases Purchases</td>
<td>Navigator: Purchase Orders &gt; Purchase Order Summary &gt; [Find] &gt; [Lines] &gt; [Shipments]</td>
</tr>
</tbody>
</table>

Table D – 1  (Page 19 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Purchase Orders</td>
<td>Purchase Orders</td>
</tr>
<tr>
<td>\Navigate Inquiry Documents</td>
<td>Navigator: Purchase Orders &gt; Purchase Orders or Price Breaks</td>
</tr>
<tr>
<td>Purchases Purchases</td>
<td>Navigator: Purchase Orders &gt; Purchase Order Summary &gt; [Find] &gt; [Open] &gt; Price Breaks</td>
</tr>
<tr>
<td>View Quotation Header</td>
<td>Quotations</td>
</tr>
<tr>
<td></td>
<td>Navigator: RFQs and Quotations &gt; Quotations</td>
</tr>
<tr>
<td>View Receipt Header/Receiving</td>
<td>Receipt Header</td>
</tr>
<tr>
<td>Transactions</td>
<td>Navigator: Receiving &gt; Receipts &gt; [Find] &gt; [Header] or Receipt Header Details</td>
</tr>
<tr>
<td>\Navigate Receipts Receipts</td>
<td>Navigator: Receiving &gt; Receiving Transactions Summary &gt; [Find] &gt; [Transactions] &gt; [Header]</td>
</tr>
<tr>
<td>[Search] [Receipt Header]</td>
<td></td>
</tr>
<tr>
<td>View Receipts Line Detail</td>
<td>Receipts</td>
</tr>
<tr>
<td>\Navigate Receipts Receipts</td>
<td>Navigator: Receiving &gt; Receipts &gt; [Find]</td>
</tr>
<tr>
<td>View Receiving Transaction Status</td>
<td>Receiving Transactions</td>
</tr>
<tr>
<td>\Navigate Inquiry Receipts</td>
<td>Navigator: Receiving &gt; Receiving Transactions or Find Receiving Transactions</td>
</tr>
<tr>
<td>Transactions</td>
<td>Navigator: Receiving &gt; Receiving Transactions Summary</td>
</tr>
<tr>
<td>View Receiving Transactions</td>
<td>Receiving Transactions</td>
</tr>
<tr>
<td>\Navigate Inquiry Receipts</td>
<td>Navigator: Receiving &gt; Receiving Transactions</td>
</tr>
<tr>
<td>Receipts</td>
<td></td>
</tr>
<tr>
<td>View Receive Release</td>
<td>Releases</td>
</tr>
<tr>
<td>\Navigate Inquiry Receipts</td>
<td>Navigator: Purchase Orders &gt; Releases</td>
</tr>
<tr>
<td>Receipts</td>
<td></td>
</tr>
<tr>
<td>View Reports</td>
<td>Requests</td>
</tr>
<tr>
<td>\Navigate Reports View</td>
<td>Navigator: Reports &gt; View or Navigator: Requests</td>
</tr>
<tr>
<td></td>
<td>See: Viewing Requests (Oracle Applications User’s Guide)</td>
</tr>
</tbody>
</table>

Table D – 1  (Page 20 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Requests</td>
<td>Requests</td>
</tr>
<tr>
<td>\Navigate Other Requests</td>
<td>From any window choose View My Requests from the Help menu.</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Navigator: Reports &gt; View</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Navigator: Requests</td>
</tr>
<tr>
<td>View Requisition Distribution Detail</td>
<td>See: Viewing Requests <em>(Oracle Applications User’s Guide)</em></td>
</tr>
<tr>
<td>\Navigate Inquiry Documents Requisitions</td>
<td>Requisition Distributions Summary</td>
</tr>
<tr>
<td>View Requisition Distributions</td>
<td>Navigator: Requisitions &gt; Requisition Summary &gt; [Headers] &gt; [Find] &gt; [Lines] &gt; [Distributions]</td>
</tr>
<tr>
<td>\Navigate Inquiry Documents Requisitions</td>
<td>Requisition Distributions Summary</td>
</tr>
<tr>
<td>View Requisition Line</td>
<td>Navigator: Requisitions &gt; Requisition Summary &gt; [Distributions] &gt; [Find]</td>
</tr>
<tr>
<td>\Navigate Inquiry Documents Requisitions</td>
<td>or</td>
</tr>
<tr>
<td>View Requisition Line</td>
<td>Navigator: Requisitions &gt; Requisition Summary &gt; [Headers] &gt; [Find] &gt; [Lines] &gt; [Distributions]</td>
</tr>
<tr>
<td>\Navigate Inquiry Documents Requisitions</td>
<td>Requisition Lines Summary</td>
</tr>
<tr>
<td>View Requisition Line</td>
<td>Navigator: Requisitions &gt; Requisition Summary &gt; [Headers] &gt; [Find] &gt; [Lines] &gt; [Distributions]</td>
</tr>
</tbody>
</table>

Table D – 1  (Page 21 of 23)
<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Requisitions</td>
<td>Requisition Headers Summary</td>
</tr>
<tr>
<td>\Navigate Inquiry Documents</td>
<td>Navigator: Requisitions &gt; Requisition Summary &gt; [Headers] &gt; [Find]</td>
</tr>
<tr>
<td>Requisitions</td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Requisition Lines Summary</td>
</tr>
<tr>
<td></td>
<td>Navigator: Requisitions &gt; Requisition Summary &gt; [Lines] &gt; [Find]</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Find Requisitions</td>
</tr>
<tr>
<td></td>
<td>Navigator: Requisitions &gt; Requisition Summary</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Requisition Preferences</td>
</tr>
<tr>
<td></td>
<td>Navigator: Requisitions &gt; Requisition Summary &gt; Tools menu &gt; Preferences</td>
</tr>
<tr>
<td>View Sourced Items</td>
<td>Search Supplier Item Catalog</td>
</tr>
<tr>
<td>\Navigate Inquiry Items Sources</td>
<td>Navigator: Supplier Item Catalog &gt; [Find] &gt; [Negotiated Sources] alternative region</td>
</tr>
<tr>
<td>View Transaction Detail</td>
<td>Receiving Transactions</td>
</tr>
<tr>
<td>\Navigate Inquiry Receipts</td>
<td>Navigator: Receiving &gt; Receiving Transactions &gt; [Find]</td>
</tr>
<tr>
<td>Transactions</td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Receiving Transaction Summary</td>
</tr>
<tr>
<td></td>
<td>Navigator: Receiving &gt; Receiving Transactions Summary &gt; [Find] &gt; [Transactions]</td>
</tr>
<tr>
<td>View Transactions</td>
<td>Receiving Transactions</td>
</tr>
<tr>
<td></td>
<td>Navigator: Receiving &gt; Receiving Transactions</td>
</tr>
</tbody>
</table>

Table D – 1  (Page 22 of 23)
### Table D – 1  (Page 23 of 23)

<table>
<thead>
<tr>
<th>Character Mode Form and Menu Path</th>
<th>GUI Window or Process, and Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Transactions by Source Type</td>
<td>Receiving Transactions</td>
</tr>
<tr>
<td></td>
<td>Navigator: Receiving &gt; Receiving Transactions&gt;</td>
</tr>
<tr>
<td></td>
<td>[Find]</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Receiving Transaction Summary</td>
</tr>
<tr>
<td></td>
<td>Navigator: Receiving &gt; Receiving Transactions Summary &gt; [Find] &gt; [Transactions]</td>
</tr>
<tr>
<td>View Vendors</td>
<td>Suppliers</td>
</tr>
<tr>
<td>\Navigate Inquiry Vendors</td>
<td>Navigator: Supply Base &gt; Suppliers</td>
</tr>
</tbody>
</table>

**See Also**

Oracle System Administrator Character Mode Forms and Corresponding GUI Windows, *Oracle System Administrator User’s Guide*
GLOSSARY

**accept**  An action to indicate that you accept the previous approver’s authorization.

**acceptance**  Supplier acknowledgement of a purchase order that indicates that the supplier agreed to and accepted the terms of the purchase order.

**account**  See accounting flexfield

**Account Generator**  A feature that uses Oracle Workflow to provide various Oracle Applications with the ability to construct Accounting Flexfield combinations automatically using custom construction criteria. You define a group of steps that determine how to fill in your Accounting Flexfield segments. You can define additional processes and/or modify the default process(es), depending on the application. See also activity (Workflow), function, item type, lookup type, node, process, protection level, result type, transition, Workflow Engine.

**accounting flexfield**  A feature used to define your account coding for accounting distributions. For example, this structure can correspond to your organization, budget account, and project account numbers. For simplicity, Inventory and Oracle Manufacturing use the term account to refer to the accounting flexfield.

**accounting flexfield limit**  The maximum amount you authorize an employee to approve for a particular range of accounting flexfields.

**accounting period**  The fiscal period a organization uses to report financial results, such as a calendar month or fiscal period.

**accounts payable accrual account**  The account used to accrue payable liabilities when you receive your items. Always used for inventory and outside processing purchases. You can also accrue expenses at the time of receipt. Used by Purchasing and Inventory, the accounts payable account represents your non-invoiced receipts, and is included in your month end accounts payable liability balance. This account balance is cleared when the invoice is matched in Payables.

**accrual accounting**  Recognition of revenue when you sell goods and recognition of expenses when a supplier provides services or goods. Accrual based accounting matches expenses with associated revenues when you receive the benefit of the good and services rather than when cash is paid or received.

**accrued receipts account**  The account used to accrue your uninvoiced expense receipts at month end by Purchasing. The accrued receipts account may or may not be the same account as the accounts payable accrual account. However, both accrual accounts represent additional payable liabilities you include in your month end accounts payables liability balance. You reverse the accrued receipts account by reversing the month end journal in the following period.

**acquisition cost**  The cost necessary to obtain inventory and prepare it for its intended use. It includes material costs and various costs associated with procurement and shipping of items, such as duty, freight, drayage, customs charges, storage charges, other supplier’s charges, and so on.

**activity (Workflow)**  An Oracle Workflow unit of work performed during a business process. See also activity attribute, function activity.
**activity attribute** A parameter for an Oracle Workflow function activity that controls how the function activity operates. You define an activity attribute by displaying the activity’s Attributes properties page in the Activities window of Oracle Workflow Builder. You assign a value to an activity attribute by displaying the activity node’s Attribute Values properties page in the Process window.

**alert** A specific condition defined in Oracle Alert that checks your database and performs actions based on the information it finds there.

**alert action** In Oracle Quality, an electronic mail message, operating system script, SQL script, or concurrent program request that is invoked when specified action rule conditions are met.

**alphanumeric number type** An option for numbering documents, employees, and suppliers where assigned numbers can contain letters as well as numbers.

**amount based order** An order you place, receive, and pay based solely on the amount of service you purchase.

**approve** An action you take to indicate that you consider the contents of the purchasing document to be correct. If the document passes the submission tests and you have sufficient authority, Purchasing approves the document.

**approved** A purchase order or requisition status that indicates a user with appropriate authorization approved the purchase or requisition. Purchasing verifies that the purchase order or requisition is complete during the approval process.

**archiving** The process of recording all historical versions of approved purchase orders. Purchasing automatically archives a purchase order when you approve it for the first time. Purchasing subsequently archives your purchase orders during the approval process if you have increased the revision number since the last time you approved the purchase order.

**ASL** Approved Suppliers List. A list where you can set up your Approved Suppliers, Sites, and Items.

**attribute** See *activity attribute*, *item type attribute*.

**authorization check** A set of tests on a purchasing document to determine if the document approver has sufficient authority to perform the approval action.

**automatic numbering** A numbering option Purchasing uses to assign numbers to your documents, employees, or suppliers automatically.

**automatic sourcing** A Purchasing feature which allows you to specify for predefined items a list of approved suppliers and to associate source documents for these suppliers. When you create a requisition or purchase order line for the item, Purchasing automatically provides appropriate pricing for the specified quantity based on the top–ranked open source document for the supplier with the highest percentage allocation.

**base unit** The unit of measure to which you convert all units of measure within one class. The base unit is the smallest or most commonly used unit of measure in the class. For example, millimeter is the base unit in the Length class. You define your base unit of measure when you create your unit class.

**blanket purchase agreement** A type of purchase order you issue before you request actual delivery of goods or services. You normally create a blanket purchase
agreement to document a long–term supplier agreement. A blanket purchase agreement may contain an effective date and an expiration date, a committed amount, or quantity. You use a blanket purchase agreement as a tool for specifying agreed prices and delivery dates for goods and services before ordering them.

**blanket purchase order**  See blanket purchase agreement

**blanket release**  An actual order of goods and services against a blanket purchase agreement. The blanket purchase agreement determines the characteristics and prices of the items. The blanket release specifies actual quantities and dates ordered for the items. You identify a blanket release by the combination of the blanket purchase agreement number and the release number.

**blind receiving**  A site option that requires your receiving staff to count all items on a receipt line. Blind receiving prevents display of expected receipt quantities in receiving windows.

**budget organization**  An entity, such as a department, division, or activity responsible for entering and maintaining budget data. You define budget organizations for your agency, then assign appropriate accounting flexfields to each budget organization.

**budgetary account**  An account segment value (such as 6110) that is assigned one of the two budgetary account types. You use budgetary accounts to record the movement of funds through the budget process from appropriation to expended appropriation.

**buyer**  Person responsible for placing item resupply orders with suppliers and negotiating supplier contracts.

**cancel**  You can cancel a purchase order after approving it. When you cancel a purchase order, you prevent anyone from adding new lines to the purchase order or receiving additional goods. Purchasing still allows billing for goods you received before cancelling the purchase order. Purchasing releases any unfilled requisition lines for reassignment to another purchase order.

**candidate**  A record Purchasing selects to purge based on the last activity date you specify. Purchasing selects only records that you have not updated since the last activity date. Purchasing does not purge a candidate until you confirm it.

**category**  Code used to group items with similar characteristics, such as plastics, metals, or glass items.

**check funds**  To certify whether you have funds available to complete your requisition or purchase order. The difference between the amount you are authorized to spend and the amount of your expenditures plus encumbrances equals your funds available. You can certify funds available at any time when you enter a requisition or a purchase order. You can track funds availability at different authority levels on–line.

**close**  A purchase order is automatically closed once it is received (if you require a receipt) and is billed for all purchase order shipments. Since you do not require or expect any further activity, Purchasing closes the purchase order. You can also manually close the purchase order early if you do not expect further activity. Adding lines to it or receiving against it, reopens the purchase order. Purchasing does not consider closed purchase orders for accruals.

**close for invoicing**  A purchase order control that you can assign manually or that Purchasing can assign automatically when the amount invoiced reaches a defined percentage of the order quantity.
**close for receiving**  A purchase order control you can assign manually or that Purchasing can assign automatically when the amount received reaches a defined percentage of the order quantity.

**column headings**  Descriptions of the contents of each column in the report.

**commitment**  A journal entry you make to record an anticipated expenditure as indicated by approval of a requisition. Also known as pre-commitment, pre-encumbrance or pre-lien.

**committed amount**  The amount you agree to spend with a supplier.

**concurrent manager**  Components of your applications concurrent processing facility that monitor and run time-consuming tasks for you without tying up your terminal. Whenever you submit a request, such as running a report, a concurrent manager does the work for you, letting you perform many tasks simultaneously.

**concurrent process**  A task in the process of completing. Each time you submit a task, you create a new concurrent process. A concurrent process runs simultaneously with other concurrent processes (and other activities on your computer) to help you complete multiple tasks at once with no interruptions to your terminal.

**concurrent queue**  A list of concurrent requests awaiting completion by a concurrent manager. Each concurrent manager has a queue of requests waiting in line. If your system administrator sets up simultaneous queuing, your request can wait to run in more than one queue.

**concurrent request**  A request to complete a task for you. You issue a request whenever you submit a task, such as running a report. Once you submit a task, the concurrent manager automatically takes over for you, completing your request without further involvement from you, or interruption to your work. Concurrent managers process your request according to when you submit the request and the priority you assign to your request. If you do not assign a priority to your request, your application prioritizes the request for you.

**contract**  An agreement between you and a supplier for unspecified goods or services. This agreement may include terms and conditions, committed amount, and an effective and expiration date. You reference contract purchase agreements directly on standard purchase order lines. Purchasing monitors the amount you have spent against contract purchase agreements.

**conversion formula**  The number that, when multiplied by the quantity of one unit of the source base unit, gives you the quantity of one unit of the destination base units in the interclass conversion. The number is also the conversion between units for standard unit conversion or item-specific conversion.

**copy**  An AutoCreate option that lets a buyer designate a specific requisition line as the source of information that Purchasing copies to the purchase order or RFQ line.

**cost element**  A classification for the cost of an item. Oracle Manufacturing supports five cost elements: material, material overhead, resource, outside processing, and overhead.

**deliver-to location**  A location where you deliver goods previously received from a supplier to individual requestors.

**delivery**  Internal delivery of items to requestors within your organization.
destination base unit  The unit of measure to which you are converting when you define interclass conversions. Your destination base unit is the base unit of a unit class.

detailed message action  A message representing one exception. Oracle Alert inserts the exception values into the text of the message.

direct receipt  The receipt of an item directly to its final destination (either directly to the person who requested the item or directly to the final inventory location). It differs from a standard receipt in that it is received into a receiving location and delivered in one transaction, rather than received and delivered in two separate transactions.

document reference  A message that precisely identifies the document or part of document you want to describe using standard or one–time notes.

drop shipment  A method of fulfilling sales orders by selling products without handling, stocking, or delivering them. The selling organization buys a product from a supplier and has the supplier ship the product directly to customers.

duplicate  An exception Oracle Alert located for the same action set during a previous alert check. Oracle Alert does not consider a detail action to contain a duplicate exception until Oracle Alert sends the final action level to a specific action set, and then locates the same exception for the same action set again. For example, if on Monday Oracle Alert notifies a buyer that a supplier shipment is overdue, then on Tuesday Oracle Alert finds the shipment is still overdue, you can choose whether Oracle Alert should re–notify the buyer or suppress the message.

dynamic distribution  You can use output variables to represent electronic mail IDs.

When you define mail message alert actions in Oracle Quality, the message is sent to all defined mail IDs.

dynamic insertion  Automatically creates new accounting flexfield combinations as you enter them. If you do not use dynamic insertion, you create new accounting flexfield combinations with a separate window.

employee supervisor hierarchy  An approval routing structure based on employee/supervisor relationships.  See position hierarchy

encumbrance  See purchase order encumbrance.

encumbrance type  An encumbrance category that allows you to track your expenditures according to your purchase approval process and better control your planned expenditures. You can set up separate encumbrance types for each stage in your purchasing cycle to track your spending at each level. Examples of encumbrance types are commitments (requisition encumbrances) and obligations (purchase order encumbrances).

event alert  An alert that runs when a specific event occurs that you define. For example, you can define an event alert to immediately send a message to the buyer if an item is rejected on inspection.

exception  An occurrence of the specified condition found during an alert check. For example, an alert testing for invoices on hold may find five invoices on hold, or none. Each invoice on hold is an exception.

exception reporting  An integrated system of alerts and action sets that focuses attention on time–sensitive or critical information, shortens your reaction time, and provides faster exception distribution. Exception
reporting communicates information by either electronic mail messages or paper reports.

**expected receipts report**  A printed report of all expected receipts for a time period and location you specify.

**explode**  An AutoCreate option that lets a buyer split a single requisition line for an item into one or more requisition lines for different items. Use this option to expand a requisition line for an item that your organization purchases in component parts.

**express delivery**  An option that lets you deliver the entire quantity of a receipt without entering quantities for each shipment or distribution.

**express receipt**  A site option that lets you receive an entire purchase order or blanket purchase agreement release with one keystroke.

**express requisitions**  To create requisitions quickly from predefined requisition templates. You only need to provide an accounting flexfield and quantities to create a requisition for commonly purchased items.

**FIFO (first–in–first–out) costing method**  A cost flow method used for inventory valuation. Inventory balances and values are updated perpetually after each transaction is sequentially costed. It assumes that the earliest inventory units received or produced are the first units used or shipped. The ending inventory therefore consists of the most recently acquired goods. FIFO cost flow does not have to match the physical flow of inventory.

**final close**  A purchase order control you can assign to prevent modifications to or actions against completed documents, lines, and shipments by final closing them. Final–closed documents are not accessible in the corresponding entry windows, and you cannot perform the following actions against final–closed entities: receive, transfer, inspect, deliver, correct receipt quantities, invoice, return to supplier, or return to receiving.

**firm**  A purchase order control. When you firm an order, Master Scheduling/MRP uses the firm date to create a time fence within which it does not suggest new planned purchase orders, cancellations, or reschedule–in actions. It continues to suggest reschedule–out actions for orders within the time fence. If several shipments with different promised or need–by dates reference the same item, Master Scheduling/MRP sets the time fence at the latest of all scheduled dates.

**flexfield segment**  One of the parts of your key flexfield, separated from the other parts by a symbol you choose (such as –, /, or \). Each segment typically represents an organization, fund, item family, or color code.

**forward**  An action you take to send a document to another employee without attempting to approve it yourself.

**four–way matching**  Purchasing performs four–way matching to verify that purchase order, receipt, inspection and invoice quantities match within tolerance.

**freeze**  You can freeze a purchase order after printing. By freezing a purchase order, you prevent anyone from adding new lines or changing the purchase order. You can continue to receive goods and be billed on already existing purchase order lines. The ability to continue receiving against the purchase order is the difference between freezing and cancelling.

**function**  A PL/SQL stored procedure referenced by an Oracle Workflow function.
activity that can enforce business rules, perform automated tasks within an application, or retrieve application information. The stored procedure accepts standard arguments and returns a completion result. See also function activity.

**function activity** An automated Oracle Workflow unit of work that is defined by a PL/SQL stored procedure. See also function.

**functional currency** Currency you use to record transactions and maintain your accounting information. The functional currency is generally the currency used to perform most of your organization’s business transactions. You determine the functional currency for the set of books you use in your organization. Also called base currency.

**funds available** The difference between your budget, less encumbrances of all types and actual expenditures.

**funds checking** The process of certifying funds available. When you check funds, the transaction amount is compared with your funds available, and you are notified whether funds are available for your transaction. Checking funds does not reserve funds for your transaction.

**funds reservation** The creation of requisition, purchase order, or invoice encumbrance journal entries. Purchasing immediately updates your funds available balances and creates an encumbrance journal entry in which you can post in your general ledger.

**hazard class** A category of hazardous materials. Most hazardous materials belong to only one hazard class. Some materials belong to more than one hazard class and some materials do not belong to any. If a material belongs to more than one hazard class, you should list these classes in a specific order.

**inspection** A procedure you perform to ensure that items received conform to your quality standards. You can use inspections to prevent payment for goods and services that fail to meet your quality standards.

**inter–organization transfer** Transfer of items from one inventory organization to another. You can have freight charges and transfer credits associated with inter–organization transfer. You can choose to ship items directly or have them go through intrasit inventory.

**interclass conversion** The conversion formula you define between base units from the different unit classes.

**internal requisition** See internal sales order, purchase requisition.

**internal sales order** A request within your organization for goods or services. An internal sales order originates from an employee or from another process as a requisition, such as inventory or manufacturing, and becomes an internal sales order when the information is transferred from Purchasing to Order Management. Also known as internal requisition or purchase requisition.

**intransit inventory** Items being shipped from one inventory organization to another. While items are intransit you can view and update arrival date, freight charges, and so on.

**inventory item** Items you stock in inventory. You control inventory for inventory items by quantity and value. Typically, the inventory item remains an asset until you consume it. You recognize the cost of an inventory item
as an expense when you consume it or sell it. You generally value the inventory for an item by multiplying the item standard cost by the quantity on hand.

**inventory organization** An organization that tracks inventory transactions and balances, and/or that manufactures or distributes products.

**inventory transaction** A record of material movement. The basic information for a transaction includes the item number, the quantity moved, the transaction amount, the accounting flexfields, and the date. See **material transaction**

**invoice price variance** The difference between the purchase order price for an item and the actual invoice price multiplied by the quantity invoiced. Payables records this variance after matching the invoice to the purchase order. Typically, the price variance is small since the price the supplier charges you for an item should be the one you negotiated on your purchase order.

**item category** See **category**.

**item–specific conversion** The conversion formula you define between the primary unit of measure for an item and another unit of measure from the same unit class. If you define a conversion rate for a specific item, Purchasing uses the item–specific conversion rate instead of the standard conversion rate for converting between units for that item.

**item type** A term used by Oracle Workflow to refer to a grouping of all items of a particular category that share the same set of item attributes, used as a high level grouping for processes. For example, each Account Generator item type (e.g. FA Account Generator) contains a group of processes for determining how an Accounting Flexfield code combination is created. See also **item type attribute**.

**item type attribute** A feature of a particular Oracle Workflow item type, also known as an item attribute. An item type attribute is defined as a variable whose value can be looked up and set by the application that maintains the item. An item type attribute and its value is available to all activities in a process.

**job** A category of personnel in your organization. Examples of a typical job include Vice President, Buyer, and Manager. See also **position**.

**LIFO (last–in–first–out) costing method** A cost flow method used for inventory valuation. Inventory balances and values are updated perpetually after each transaction is sequentially costed. It assumes that the most recent inventory units received or produced are the first units used or shipped. The ending inventory consists of old goods acquired in the earliest purchases or completions.

**line type** Determines whether a purchasing document line is for goods, services, or any other type that you define. The line type also determines whether the document line is based on price and quantity or on amount.

**logical organization** A business unit that tracks items for accounting purposes but does not physically exist. See **organization**.

**lookup code** The internal name of a value defined in an Oracle Workflow lookup type. See also **lookup type**.

**lookup type** An Oracle Workflow predefined list of values. Each value in a lookup type has an internal and a display name. See also **lookup code**.
**long notes** A Purchasing feature that lets you provide up to 64K characters per note. You can add long notes to your headers and lines. Purchasing automatically wraps the note while you are typing. You can also format the note by providing extra lines or indenting parts of your message. You can provide as many long notes as you want wherever the long notes capability is available.

**manual numbering** A numbering option to let someone assign numbers manually to documents, employees, and suppliers.

**message** The text or data Oracle Alert sends when it finds an exception while checking an alert.

**min–max planning** An inventory planning method used to determine when and how much to order based on a fixed user-entered minimum and maximum inventory levels.

**move transaction** A transaction to move assemblies from operation to operation or within an operation on a discrete job or repetitive schedule.

**multi–source** An AutoCreate option that lets a buyer distribute the quantity of a single requisition line to several suppliers whenever the buyer wants to purchase the requisition line item from more than one supplier.

**node** An instance of an activity in an Oracle Workflow process diagram as shown in the Process window of Oracle Workflow Builder. See also process.

**note name** A name that uniquely identifies a standard or one–time note. You use note names to locate a note you want to use or copy on a document.

**numeric number type** An option for numbering documents, employees, and suppliers where assigned numbers contain only numbers.

**omit** An AutoCreate option that lets a buyer prevent Purchasing from including certain displayed requisition lines when creating a purchase order or RFQ. If you omit a requisition line, Purchasing returns it to the available pool of requisition lines.

**one–time item** An item you want to order but do not want to maintain in the Items window. You define a one–time item when you create a requisition or purchase order. You can report or query on a one–time item by specifying the corresponding item class.

**one–time note** A unique message you can attach to an order, return, order line, or return line to convey important information.

**open** An open purchase order exists if the purchase order has any lines that have not been fully invoiced and are not cancelled. If you require receipt for items you order, an open purchase order exists if any lines have not been fully received and fully invoiced and are not cancelled.

**open interface** A Manufacturing function that lets you import or export data from other systems through an open interface. An example is a bar code reader device accumulating data you later import into your manufacturing system for further processing.

**outside operation** An operation that contains outside resources and possibly internal resources as well.

**outside processing** Performing work on a discrete job or repetitive schedule using resources provided by a supplier.

**outside processing operation** Any operation that has an outside processing resource. See outside resource.
outside processing item  An item you include on a purchase order line to purchase supplier services as part of your assembly build process. This item can be the assembly itself or a non–stocked item which represents the service performed on the assembly.

outside resource  A resource provided by a supplier that you include in your routings, such as supplier sourced labor or services. This includes both PO move and PO receipt resources.

parameter  A variable used to restrict information in a report, or determine the form of a report. For example, you may want to limit your report to the current month, or display information by supplier number instead of supplier name.

period  See accounting period.

period expense  An expense you record in the period it occurs. An expense is typically a debit.

periodic alert  An alert that checks your database for the presence of a specific condition according to a schedule you define.

planned purchase order  A type of purchase order you issue before you order actual delivery of goods and services for specific dates and locations. You normally enter a planned purchase order to specify items you want to order and when you want delivery of the items. You later enter a shipment release against the planned purchase order when you actually want to order the items.

PO  See purchase order.

PO move resource  An outside resource that is automatically charged upon receipt of a purchase order. PO move resources also automatically initiate shop floor move transactions upon receipt.

PO receipt resource  An outside resource that is automatically charged upon receipt of a purchase order.

position  A specific function within a job category. Examples of typical positions associated with the Vice President job include: Vice President of Manufacturing, Vice President of Engineering, and Vice President of Sales. See job.

position hierarchy  A structure of positions used to define management line reporting and control access to employee information.

pre–approved  A document that has been approved by someone with final approval authority, but then forwarded to yet another approver for additional approval; or a document that has been authorized for approval but for which funds have not yet been reserved (if your organization uses encumbrance). A document with a status of Pre–Approved does not show up as supply until its status changes to Approved.

price break line  Supplier pricing information for an item or purchasing category on a quotation. The price you enter on a price break line depends on the quantity you order from your supplier. Usually, suppliers provide you with price break line structures to indicate the price you would pay for an item depending on the quantity you order. Generally, the more you order, the less expensive your unit price. Also, depending on the quantity you order, a supplier may provide you with different purchase conditions, such as advantageous payment or freight terms when you buy in large quantities.

process  A set of Oracle Workflow activities that need to be performed to accomplish a
business goal. See also Account Generator, process activity, process definition.

**process activity**  An Oracle Workflow process modelled as an activity so that it can be referenced by other processes; also known as a subprocess. See also process.

**process definition**  An Oracle Workflow process as defined in the Oracle Workflow Builder. See also process.

**proprietary account**  An account segment value (such as 3500) that is assigned one of the five proprietary account types.

**protection level**  In Oracle Workflow, a numeric value ranging from 0 to 1000 that represents who the data is protected from for modification. When workflow data is defined, it can either be set to customizable (1000), meaning anyone can modify it, or it can be assigned a protection level that is equal to the access level of the user defining the data. In the latter case, only users operating at an access level equal to or lower than the data’s protection level can modify the data. See also Account Generator.

**purchase order**  A type of purchase order you issue when you request delivery of goods or services for specific dates and locations. You can order multiple items for each planned or standard purchase order. Each purchase order line can have multiple shipments and you can distribute each shipment across multiple accounts. See standard purchase order and planned purchase order.

**purchase order encumbrance**  A transaction representing a legally binding purchase. Purchasing subtracts purchase order encumbrances from funds available when you approve a purchase order. If you cancel a purchase order, Purchasing creates appropriate reversing entries in your general ledger. Purchase order encumbrance is also known as obligation, encumbrance, or lien.

**purchase order receipt**  See receipt.

**purchase order revision**  A number that distinguishes printed purchase order versions. Purchasing automatically sets the revision to 0 when you initially create a purchase order. Each purchase order you print displays the current revision number.

**purchase order shipment**  A schedule for each purchase order line composed of the quantity you want to ship to each location. You can also provide delivery dates for each shipment line. You can create an unlimited number of shipments for each purchase order line. You receive goods and services against each shipment line.

**purchase price variance**  The variance that you record at the time you receive an item in inventory or supplier services into work in process. This variance is the difference between the standard unit cost for the item or service and the purchase unit price multiplied by the quantity received. You record purchase price variances in a purchase price variance account for your organization. Since standard cost is a planned cost, you may incur variances between the standard cost and the purchase order price.

**purchase requisition**  An internal request for goods or services. A requisition can originate from an employee or from another process, such as inventory or manufacturing. Each requisition can include many lines, generally with a distinct item on each requisition line. Each requisition line includes at least a description of the item, the unit of measure, the quantity needed, the price per item, and the Accounting Flexfield
you are charging for the item. See also internal sales order.

purchased item  An item that you buy and receive. If an item is also an inventory item, you may also be able to stock it. See also inventory item.

purchasing documents  Any document you use in the purchasing life cycle, including requisitions, RFQs, quotations, purchase orders, and purchase agreements.

purchasing open interface  A Purchasing function that lets you import price/sales catalog information from your suppliers. It receives the catalog data electronically, verifies and processes the data, and imports the data directly into Purchasing as blanket purchase agreements or quotations.

purge  A technique for deleting data in Oracle Manufacturing that you no longer need to run your business.

purge category  A Purchasing feature you use to purge a particular group of records from the database. Purchasing lets you choose from the following separate categories: Simple Requisitions, Simple Purchase Orders, Suppliers, Simple Invoices (only if you installed Payables), and Matched Invoices and POs (only if you installed Payables). The last category is the most comprehensive category you can choose. You should purge all appropriate documents before purging your supplier information, because Purchasing does not purge suppliers that you referenced on existing documents.

purge status  A Purchasing method of reporting the progress of a purge you initiate. The Status field lets you take an action on your purge process (Initiate, Confirm, Abort), or reports on the current status of the purge (Printed, Deleting, Completed–Aborted, Completed–Purged).

quantity accepted  The number of items you accept after inspection.

quantity–based order  An order you place, receive, and pay based on the quantity, unit of measure, and price of the goods or services that you purchase.

quantity received tolerance  The percentage by which you allow quantity received to exceed quantity ordered.

quantity rejected  The number of items you reject after inspection.

quotation  A statement of the price, terms, and conditions of sale a supplier offers you for an item or items. A quotation usually includes a detailed description (specifications) of goods or services the supplier offers. Suppliers consider quotations as an offer to sell when given in response to an inquiry. A quotation may be verbal or written. You often get verbal quotations for minor purchases by telephone. You usually send a request for quotation if you want a written quotation from a supplier. Written quotations often have an effective date and an expiration date.

quotation type  A QuickCode you define to categorize your quotation information. Purchasing provides you with the following set of predefined quotation types: Catalog, Verbal, Telephone, or From RFQ. You can define other quotation types that better fit your business.

receipt  A shipment from one supplier that can include many items ordered on many purchase orders.

receipt exception  A control that you can set to indicate to your accounts payable group that you want to place the corresponding invoice on hold until further notice. You designate whether your purchase order shipment
should be a receipt exception when you receive the item.

**receipt line**  
An individual receipt transaction that identifies receipt of an item against a purchase order shipment.

**receipt routing**  
A method of simplifying transaction entry by specifying routing steps for receipts.

**receipt traveler**  
An internal routing ticket you place on received goods to show their final destination.

**receiving open interface**  
A set of interface tables in Purchasing that lets you import information from outside of Purchasing, from Oracle or non–Oracle applications. Some examples of information imported into the receiving open interface are Advance Shipment Notices (ASNs). The receiving open interface validates the information before importing it into the Purchasing application.

**reject**  
For Oracle Automotive, Oracle Service and Oracle Work in Process, reject is an intraoperation step in an operation where you can record assemblies that require rework or need to be scrapped. For Oracle Public Sector Purchasing and Oracle Quality, reject is an option you use to indicate that you do not want to approve a document. Purchasing returns the document to its owner for modification and resubmission if appropriate.

**reject over quantity tolerance**  
An option you use to disallow receipts that exceed the tolerance level.

**release**  
An actual order of goods and services you issue against a blanket purchase agreement. The blanket purchase agreement determines the characteristics and the prices of the items. The release specifies the actual quantities and dates ordered for the items.

You identify a release by the combination of blanket purchase agreement number and release number.

**reorder point planning**  
An inventory planning method used to determine when and how much to order based on customer service level, safety stock, carrying cost, order setup cost, lead time and average demand.

**requisition template**  
A feature that lets you define a list of commonly purchased items from which a requestor can create a requisition. You can define the list of items by referencing an existing purchase order. Requestors use the requisition template to create simple, pre–sourced requisitions.

**request for quotation (RFQ)**  
A document you use to solicit supplier quotations for goods or services you need. You usually send a request for quotation to many suppliers to ensure that you get the best price and terms possible. Depending on the way you do business, you can use two general types of RFQs: specific and generic.

**requisition** See purchase requisition and internal sales order.

**requisition approval**  
The act of approving the purchases of the items on a requisition. A requisition must receive the required approvals before a buyer can create purchase orders from this requisition. The approvals can come from any employee, but a requisition is fully approved only when an employee who has enough authority approves it. If you require encumbrance or budgetary control for requisitions, a requisition is fully approved only when an employee with sufficient approval authority approves and reserves funds for the requisition.
**requisition encumbrance**  A transaction representing an intent to purchase goods and services as indicated by the reservation of funds for a requisition. Purchasing subtracts requisition encumbrances from funds available when you reserve funds for a requisition. If you cancel a requisition, Purchasing creates appropriate reversing entries in your general ledger.

**requisition pool**  Requisition lines that are approved, not cancelled, and not yet on a purchase order.

**reserve**  An action you take in Purchasing to reserve funds for a purchasing document or an action in Order Entry to allocate products for a sales order. If the document passes the submission tests and if you have sufficient authority, Purchasing reserves funds for the document.

**Reserve for Encumbrance account**  The account you use to record your encumbrance liability. You define a Reserve for Encumbrance account when you define your set of books. When you create encumbrances automatically in Purchasing or Payables, General Ledger automatically creates a balancing entry to your Reserve for Encumbrance account when you post your encumbrance journal entries. And General Ledger overwrites the balancing segment for your Reserve for Encumbrance account, so you automatically create the reserve for encumbrance journal entry to the correct organization.

**result code**  In Oracle Workflow, the internal name of a result value, as defined by the result type.  See also result type, result value.

**result type**  In Oracle Workflow, the name of the lookup type that contains an activity’s possible result values.  See also result code, result value.

**result value**  In Oracle Workflow, the value returned by a completed activity, such as Approved.  See also result code, result type.

**return**  In Purchasing, an AutoCreate option that lets a buyer return a requisition line and all other unpurchased requisition lines on the same requisition to the requisition preparer. In Order Entry, it is the opposite of a sales order. It involves receipt of goods previously sold to a customer, credit to a customer, and possibly replacement with an identical or similar product.

**return to supplier**  A transaction that allows you to return to the supplier items from a fully or partially received purchase order and receive credit for them.

**revision**  A particular version of an item, bill of material, or routing.

**revision quantity control**  A condition placed on an item that ensures that you always identify an item by its number and its revision. Certain items require tighter controls than other. For instance, you may want to control the quantities you have in inventory for an item by revision. For another item, you may just want to know the quantities you have on hand across all revisions. You keep track of inventory quantities by revision when an item is under revision quantity control. You keep track of inventory quantities by item when an item is not under revision quantity control.

**RFQ**  See request for quotation.

**set of books**  A financial reporting entity that partitions General Ledger information and uses a particular chart of accounts, functional currency, and accounting calendar. This concept is the same whether or not the Multi–organization support feature is implemented.
**ship–to location tolerance** Whether the receiving location must be the same as the ship–to location on the purchase order and whether Purchasing prohibits the transaction, displays a warning message while permitting the transaction, or permits the transaction without a warning.

**shipment release** An actual order of goods and services against a planned purchase order. The planned purchase order determines the characteristics of the items on the order. The planned purchase order also has the expected quantities, prices, and ship–to locations, and delivery dates for the items on the order. You identify a shipment release by the combination of the planned purchase order number and the release number. Each planned purchase order line can have multiple shipments and you can distribute the quantity of each shipment across multiple accounts.

**short notes** A Purchasing feature that lets you provide up to 240 characters on your documents. Typically, these notes are for your supplier, approver, buyer, or receiver.

**source base unit** The unit of measure from which you are converting when you define your interclass conversions. You define the destination base unit in terms of the source base unit. Your source base unit is the base unit of a unit class.

**sourcing** The action of identifying a purchasing source or supplier for goods or services. To identify the best sources for your purchases, you can create RFQs that you send to your suppliers, enter quotations from your supplier, and evaluate these quotations for each item you purchase.

**sourcing rule** Specifies how to replenish items in an organization, such as purchased items in plants. You can also use sourcing rules to override sourcing that is specified in the bill of distribution assigned to an item.

**standard note** A long note you define for Oracle Manufacturing and can later reference on as many documents as you want.

**standard purchase order** A type of purchase order you issue when you order delivery of goods or services for specific dates and locations for your organization. Each standard purchase order line can have multiple shipments and you can distribute the quantity of each shipment across multiple accounts. *See purchase order.*

**standard receipt** A receipt routing in which shipments are received into a receiving location and then delivered in a separate transaction. Standard receipts can be inspected or transferred before delivery.

**standard unit conversion** The conversion formula you define between different units from the same unit class. You define your own standard conversion.

**standard unit cost** The unit cost you may use to cost all material and resource transactions in your inventory and work in process system. This cost represents the expected cost for a component or assembly for a specified interval of time. The basis for standard cost may be the cost history, purchase order history, or predicted changes in future costs.

**status check** A set of tests Purchasing performs on a purchasing document to ensure it is in a valid state before performing an approval action.

**submission check** A set of tests on a purchasing document to ensure it is ready to be submitted for approval processing.
submit  To send a document to another employee without attempting to approve or reserve funds for it yourself.

substitute receipt  An option that lets you receive predefined acceptable substitutes for any item.

summary message action  A message representing one or more exceptions. The message may include introductory and closing paragraphs separated by the exceptions listed in a columnar report format.

supplier  Provider of goods or services.

supplier product number  The number your supplier assigns to an item. You and your supplier can have different item naming conventions. You can identify the item with one number (Item) while your supplier identifies this item using another number (Supplier Product Number). Using and referencing supplier product numbers helps you speed up your purchasing cycle. By referencing a number your supplier knows, you can help your suppliers understand your purchase orders and RFQs better.

supplier purchasing hold  A hold condition you place on a supplier to prevent new purchasing activity on the supplier. You cannot approve purchase orders for suppliers you placed on hold.

supplier quotation list  A list of suppliers who can provide goods or services you need. You often define a supplier quotation list for an item or class of items. You can use a supplier quotation list to generate multiple copies of a RFQ automatically and to manage supplier responses.

supplier sourced component  A component item on a bill of material supplied to work in process directly by a supplier.

three-way matching  Purchasing performs three-way matching to verify the purchase order, receipt, and invoice information match within tolerance.

total quantity accepted  The total number of accepted items for the receipt line.

total requisition limit  The maximum amount you authorize an employee to approve for a specific requisition.

transition  In Oracle Workflow, the relationship that defines the completion of one activity and the activation of another activity within a process. In a process diagram, the arrow drawn between two activities represents a transition. See also activity, Workflow Engine.

two–level master scheduling  A technique that facilitates the forecast explosion of product groupings into related master production schedules. The top–level MPS is usually defined for a product line, family or end product while the second–level is defined for key options and components.

two–way matching  Purchasing performs two–way matching to verify that purchase order and invoice information match within tolerance.

UN number  An identifier for a hazardous material. Each Identification number has a description. Identification numbers are not unique. For instance, the same UN Number may correspond to 2 closely related but different types of materials.

unit of measure  The unit that the quantity of an item is expressed.

unit of measure class  A group of units of measure and their corresponding base unit of measure. The standard unit classes are
Length, Weight, Volume, Area, Time, and Pack.

**unit of measure conversions**  Numerical factors that enable you to perform transactions in units other than the primary unit of the item being transacted.

**unordered receipt**  A site option that lets you receive an unordered item. You can later batch an unordered item to an existing purchase order, or add it to a new purchase order.

**UOM**  See unit of measure.

**usage**  An attribute of your standard and one-time notes that determines how Purchasing should handle them.

**value basis**  An attribute you associate with a line type to indicate whether you order items for this line type by quantity or amount.

**vendor**  See supplier.

**Workflow Engine**  The Oracle Workflow component that implements a workflow process definition. The Workflow Engine manages the state of all activities, automatically executes functions, maintains a history of completed activities, and detects error conditions and starts error processes. The Workflow Engine is implemented in server PL/SQL and activated when a call to an engine API is made. See also Account Generator, activity, function, item type.
Index

A
Acceptances, 4 – 7
Acceptances window, Entering and Viewing Purchase Order Acceptances, 4 – 84
Access Level Options
  full, 2 – 10
  modify, 2 – 10
  view only, 2 – 10
Account Generator, using in Oracle Public Sector Purchasing, C – 10
Accounting lines, viewing, 7 – 53
Accrual Process, for period-end accruals, 7 – 119
Accrual Reconciliation report, 9 – 5
Accrual Write–Off report, 9 – 13
Accrual Write–offs, 7 – 127
Accrual Write–offs window, Accrual Write–offs, 7 – 127
Accrue Expense Items, option setup, 1 – 48
Action History Window
  Purchase Order Distributions, 8 – 2
  Purchase Order Distributions (Summary), 8 – 2
  Purchase Order Headers (Summary), 8 – 2
  Purchase Order Lines (Summary), 8 – 2
  Purchase Order Shipments, 8 – 2
  Purchase Order Shipments (Summary), 8 – 2
  Purchase Orders, 8 – 2
  Releases, 8 – 2
  Requisition Distributions, 8 – 2
  Requisition Headers Summary, 8 – 2
  Requisition Lines Summary, 8 – 2
Action History window, Viewing Action History, 8 – 2
Action History, viewing, 8 – 2
Activities
  in the Approve and Forward PO subprocess, C – 153
  in the Approve PO (Change Order) subprocess, C – 204
  in the Approve PO subprocess, C – 147
  in the Approve Requisition subprocess, C – 108
  in the Change Order Reserve Before Approve subprocess, C – 201
  in the Confirm Receipt process, C – 249
  in the Create And Approve Purchase Order Or Release process, C – 234
  in the Do Document Changes Require Reapproval? subprocess, C – 198
  in the Does Req Line Have Enough Information To Automatically Create A Document? process, C – 232
  in the Find Approver subprocess (for purchase orders), C – 161
  in the Forward PO subprocess, C – 164
  in the Generate Default Accounts process, C – 35
  in the Get All Blanket PO Changes subprocess, C – 189
  in the Get All Contract PO Changes subprocess, C – 190
in the Get All Document Changes subprocess, C – 187
in the Get All Planned PO Changes subprocess, C – 192
in the Get All Release Changes subprocess, C – 193
in the Get All Standard PO Changes subprocess, C – 195
in the Get Buyer process, C – 237
in the Notify Approver subprocess, C – 85
in the Notify Approver subprocess (for purchase orders), C – 157
in the Notify Requester subprocess, C – 253
in the Overall Document Creation / Launch Approval Process, C – 222
in the PO Approval process, C – 135
in the PO Approval Top Process, C – 128
in the PO Catalog Price Tolerances Exceeded workflow, C – 273
in the PO Document Approval Reminder process, C – 263
in the Print Document subprocess, C – 110
in the Print Document subprocess (for change orders), C – 207
in the Print Document subprocess (for purchase orders), C – 150
in the Reject PO subprocess, C – 169
in the Reject Requisition subprocess, C – 90
in the Reserve at the Start subprocess, C – 83
in the Verify Approval Authority subprocess (for purchase orders), C – 142
in the Return PO to Submitter subprocess, C – 166
in the Return Requisition to Submitter subprocess, C – 92
in the Verify Approval Authority subprocess, C – 85, C – 113
in the Verify Approval Authority subprocess (for purchase orders), C – 145
in the Verify PO subprocess, C – 139
in the Verify Req Line Info process, C – 228
in the Verify Requisition subprocess, C – 80
in the Web Requisition Main Requisition Approval process, C – 72
Activity nodes, in the Notify Approver subprocess, C – 85
Advance Shipment Notice and CUM management, 7 – 21
application advices, 7 – 19
correcting a receipt against, 7 – 84
deciding expected receipts, 7 – 30
deciding returns, 7 – 79
in Find Intransit Shipments window, 7 – 92
in Manage Shipments window, 7 – 93
overview, 7 – 17
receiving against, 7 – 21
related receiving options, 7 – 18
types of, 7 – 20
with substitute items, 7 – 20
Alternate Fields, 5 – 4
Amount Based Purchasing, 1 – 80
Annotating Purchasing Documents, 1 – 36
unlimited text, 1 – 36
Approval Actions
cancel, 2 – 37
change the forward from person, 2 – 37
change the forward to person, 2 – 38
enter notes, 2 – 38
facsimile, 2 – 38, 2 – 39
print, 2 – 38
reserve, 2 – 36
Approval and Security
setup matrix, 2 – 6
setup overview, 2 – 2
setup steps, 2 – 3
Approval authorization rules, defining, 2 – 16
Approval Groups
account range, 1 – 30
document total, 1 – 31
item category range, 1 – 31
item range, 1 – 31
location, 1 – 31
Approval groups
assigning, 2 – 19
defining, 2 – 16
Approval Groups window, Defining Approval Groups, 1 – 29
Approval groups, assigning, 1 – 33
Approval groups, defining, 1 – 29
Approval hierarchy, changing, 2 – 5
Approvals
effect on supply, 2 – 25
offline, 2 – 40

Index – 2  Oracle Public Sector Purchasing User’s Guide
overview, 2 – 24
Pre–Approved status, 2 – 25
taking approval actions, 2 – 35
Approve and Forward PO subprocess activities
Approve And Forward The PO, C – 153
Document Failed State Check, C – 154
Document Manager Failed, C – 154
Does Document State Allow Approval?, C – 153
Get PO Attributes, C – 154
Is Document Complete?, C – 153
Reject the PO, C – 154
Set PO Status to Original Status, C – 154
Start, C – 153
Unable To Approve Document, C – 154
Unable To Reject Document, C – 154
Approve PO subprocess overview, C – 151
Approve and Forward Req subprocess activities, End, C – 155
Approve Document window, Taking Approval Actions, 2 – 35
Approve Entire Quotations window, Approving Entire Quotations, 5 – 94
Approve PO (Change Order) subprocess activities
Approve the PO, C – 204
Document Failed State Check, C – 205
Document Manager Failed, C – 205
Does Document State Allow Approval?, C – 204
End, C – 205
Get PO Attributes, C – 205
Is Document Approved?, C – 204
Is Document Complete?, C – 204
Reject the PO, C – 205
Set PO Status to Original Status, C – 205
Start, C – 204
Unable To Approve Document, C – 205
Unable To Reject Document, C – 205
Approve PO (Change Order) subprocess overview, C – 202
Approve PO subprocess activities
Approve the PO, C – 148
Document Failed State Check, C – 148
Document Manager Failed, C – 148
Does Document State Allow Approval?, C – 147
End, C – 149
Get PO Attributes, C – 148
Is Document Approved?, C – 147
Is Document Complete?, C – 148
Reject the PO, C – 148
Set PO Status to Original Status, C – 148
Start, C – 147
Unable To Approve Document, C – 148
Unable to Reject Document, C – 149
Approve PO subprocess overview, C – 146
Approve purchase orders, 4 – 8
Approve Quotations window, Approving Quotation Shipments, 5 – 92
Approve Requisition subprocess activities
Approve the Requisition, C – 108
Document Failed Correctness Check, C – 109
Document Failed State Check, C – 109
Document Manager Failed, C – 109
Does Document State Allow Approval Action?, C – 108
End, C – 109
Get Requisition Attributes, C – 108
Is Document Approved, C – 108
Is Document Complete?, C – 108
Set Req Status to Original Status, C – 109
Start, C – 108
Approve Requisition subprocess overview, C – 106
Approved Quotations
using on purchase orders, 5 – 91
using on purchase orders and requisitions, 5 – 93
using on requisitions, 5 – 91
Approved Supplier List, 5 – 42
find window, 5 – 56
Approved Supplier List Statuses window, 5 – 45
Approved Supplier List Summary, window, 5 – 56
Approved Supplier List Summary window, 5 – 56
Approved Supplier List window, 5 – 47
defining the supplier and item/commodity combination, 5 – 47
ASL Upgrade process, 9 – 17
Assign Approval Groups, Assign Approval Groups, 1 – 33
Assign Requisition Lines window, Assigning Requisition Lines, 5 – 102
Attachments, 1 – 44
icon, 1 – 44
referencing on documents, 1 – 43
understanding usages, 1 – 42
Attributes (item attributes)
Account Generator workflows, C – 27
Change order workflow, C – 174
Debit Memo Notification, C – 280
PO Approval, C – 120
PO Confirm Receipts, C – 245
PO Create Documents, C – 216
PO Requisition Approval, C – 63
PO Send Notifications for Purchasing Documents, C – 258
AutoApproval, definition, 3 – 6
AutoClose, 4 – 9
AutoCreate
   Add to Document window, 6 – 19
   and descriptive flexfields, 6 – 16
   Automatic mode, 6 – 3
   completing, 6 – 19
   criteria, selecting, 6 – 16
   entering document information for, 6 – 19
   from emergency requisitions, 6 – 9
   from procurement card requisitions, 6 – 9
   Manual mode, 6 – 3
   modifying requisition lines, 6 – 24
   New Document Number window, 6 – 20
   New Document window, 6 – 20
   overview, 6 – 2
   Self–Service Purchasing requisitions, 6 – 9
AutoCreate Documents window
   Selecting AutoCreation Criteria, 6 – 16
   Using the Document Builder, 6 – 22
Automatic Release Generation, 4 – 103
Automatic sourcing, 5 – 30
definition, 5 – 5
setting up, 5 – 33
trouble with, 5 – 35
B
Backordered Internal Requisitions report, 9 – 18
Bid quotation or RFQ, 5 – 7
Blanket and Planned PO Status report, 9 – 19
Blanket purchase agreements, 4 – 4
   audit report, 9 – 91
   notify options setup, 1 – 50
Blanket purchase orders, status report, 9 – 19
Blanket releases, 4 – 4
Blind receipt, setup, 7 – 10
Blind Receiving, option setup, 1 – 60
Brief Notes, 1 – 37
Budgetary account. See Glossary
Budgetary control
   on–line funds availability Checking, 3 – 5
   on–line funds availability checking, 4 – 6
Build Expense Charge Account subprocess overview, C – 44
Build Inventory Budget Account subprocess overview, C – 47
Build Inventory Charge Account subprocess overview, C – 45
Build Project Related Account subprocess overview, C – 49
Build Shop Floor Charge Account subprocess overview, C – 46
Buyer Listing, 9 – 21
Buyer Workload, Reviewing, 5 – 100
Buyer’s Requisition Action Required report, 9 – 23
Buyers window, Defining Buyers, 1 – 27
Buyers, defining, 1 – 27
C
Cancel, purchase orders, 4 – 9
Cancel Requisitions, option setup, 1 – 51
Cancelled Purchase Order report, 9 – 25
Cancelled Requisition report, 9 – 26
Capacity
defining for a supplier (overview), 5 – 32
in Supplier–Item Attributes window, 5 – 55
Cascade, receipts and receiving transactions, 7 – 25
Cascade Transactions, option setup, 1 – 59
Cascade transactions, setup, 7 – 10
Catalog information, receiving electronically, 5 – 22
monitoring supplier price increases, 5 – 26
price tolerance, 5 – 25
sourcing, 5 – 23
Catalog quotation or RFQ, 5 – 7
Change Order Reserve Before Approve subprocess activities
Document Manager Failed, C – 201
End, C – 202
Is Encumbrance On and Is Document Not Reserved?, C – 201
Is Forward–To Valid?, C – 201
Reject the PO, C – 202
Reserve Document, C – 201
Set Forward–To/From For Forward Action, C – 202
Start, C – 201
Unable to Reject Document, C – 202
Unable To Reserve Document, C – 201
Change Order Reserve Before Approve subprocess overview, C – 199
Changes to purchase orders, viewing, 8 – 4
Confirm Receipt process activities
End, C – 251
Notify Receiving Transactions Failure, C – 251
Process Receiving Transactions, C – 250
 Retrieve Order Information, C – 250
 Retrieve Receive Orders Web Page URL, C – 250
 Retrieve Requester’s Manager, C – 250
Confirm Receipt process overview, C – 247
Confirm Receipts Workflow Select Orders, 9 – 28
Contract purchase agreements, 4 – 4
Contract Status report, 9 – 30
Control Documents window, Controlling Documents, 2 – 58
Control Numbers, 7 – 96
Control Purchasing Periods window,
Controlling Purchasing Periods, 1 – 93
Controlling Documents, 2 – 55
cancel, 2 – 55
close, 2 – 56
close for invoicing, 2 – 56
close for receiving, 2 – 57
finally close, 2 – 57
freeze, 2 – 57
on hold, 2 – 57
open, 2 – 57
open for invoicing, 2 – 57
open for receiving, 2 – 57
release hold, 2 – 58
unfreeze, 2 – 58
Controlling Purchasing Periods, prerequisites, 1 – 93
Copy Document window
AutoCreating Quotations, 5 – 88
copying purchase orders, agreements, and quotations, 4 – 106
Copying, purchase orders, agreements, and quotations, 4 – 106
Copying quotations from RFQs, 5 – 88
Corrections, 7 – 84
Corrections window
Entering Corrections, 7 – 88
exchange rate and Currency, 7 – 90
Corrections, entering, 7 – 88
Corrections, finding, 7 – 85
Country of Origin
in the Approved Supplier List, 5 – 53
in the Receipts window, 7 – 37
purchase order Shipments window, 4 – 64,
4 – 65
Receipts window, 7 – 36
release Shipments window, 4 – 93
Country of Origin Report (by Item), 9 – 31
Country of Origin Report (by Supplier), 9 – 33

Country of Origin Report (by Supplier), 9 – 33
Create And Approve Purchase Order Or Release process activities
  Continue Flow, C – 235
  Create Purchase Order Or Release, C – 235
  End, C – 235
  Is Automatic Approval Allowed?, C – 235
  Launch Document Approval Process, C – 235
  Purchase Order Or Release Has Been Created, C – 235
  Start, C – 234
Create And Approve Purchase Order Or Release process overview, C – 233
Create Internal Sales Orders process, 9 – 35
Create Releases process, 9 – 36
Creating Purchase Orders for Services, 1 – 82
Creating Purchasing Document Lines, 1 – 81
Creating Requisitions for Services, 1 – 82
Currency information, entering in purchase orders, RFQs, quotations, 4 – 58
  information, entering in receipt, 7 – 36
  rate type options setup, 1 – 46
  window, Entering Currency Information, 4 – 58
Currency information
  in Corrections window, 7 – 90
  in Receiving Transactions window, 7 – 69
Customer returns, overview, 7 – 14

D
  Days Early/Late tolerance, option setup, 1 – 58
  Debit Memo process overview, C – 282
  Define Catalog Server for External Suppliers window, 1 – 102
  Define Catalog Server Loader Values window, 1 – 102
  Define MassCancel Listing, 2 – 63
  Define MassCancel window, 2 – 60
  Defining MassCancel, 2 – 60
  Defining Default Category Sets, a note about Purchasing, 1 – 14
  Defining Line Types, 1 – 81
Defining MassCancel, report submission, 2 – 65
Defining Purchase Order Receipt Accruals, 7 – 130
Delivery from receiving inspection to inventory, standard costing, 7 – 111
Disposition messages, display option, 1 – 50
Distributions window, 3 – 68
  Entering Purchase Order Distributions, 4 – 74
  Entering Release Distributions, 4 – 97
Do Document Changes Require Reapproval?, End, C – 199
Do Document Changes Require Reapproval? subprocess activities
  Determine Document Type, C – 198
  Does the Blanket PO Require Reapproval?, C – 198
  Does the Blanket Release Require Reapproval?, C – 199
  Does the Contract PO Require Reapproval?, C – 198
  Does the Planned PO Require Reapproval?, C – 198
  Does the Scheduled Release Require Reapproval?, C – 198
  Does the Standard PO Require Reapproval?, C – 198
  Start, C – 198
Do Document Changes Require Reapproval? subprocess overview, C – 196
Document Approval
  approval button, 2 – 24
  Approve button, 2 – 24
Document Approval and Security
  Human Resources, 2 – 2
  Using Approval Hierarchies, 2 – 2
  Using Security Hierarchies, 2 – 2
Document Approval Status Rules, 2 – 26
Document Builder in AutoCreate, using, 6 – 22
Document Control, 2 – 44
  options, 2 – 44
Document control
  applicability matrix, 2 – 52
  status check matrix, 2 – 53
Index – 7

submission check matrix, 2 – 54
Document Control Options
cancel, 2 – 45
close, close for receiving, close for invoicing, 2 – 49
delete, 2 – 44
final close, 2 – 46
firm, 2 – 48
freeze, 2 – 48
hold, 2 – 48
Document Manager Failed notification, 2 – 34
Document Revision Numbering, 4 – 123
Document Security and Access
hierarchy, 2 – 10
private, 2 – 10
public, 2 – 10
purchasing, 2 – 10
Document Subtypes
purchase agreement, 1 – 88
purchase order, 1 – 88
quotation, 1 – 88
release, 1 – 88
request for quotation, 1 – 89
requisition, 1 – 89
Document Types
associating workflow processes with, 1 – 91
prerequisites, 1 – 87
Document Types window
Defining Document Types, 1 – 87
Multilingual Support, 1 – 87
Document Types, defining, 1 – 87
Documents
approval process overview, 2 – 24
approval routing, 2 – 13
approval status checks, 2 – 26
approval submission checks, 2 – 27
authorization rules, 2 – 16
controlling, 2 – 44
placing purchase orders in the Navigator, 4 – 11
placing requisitions in the Navigator, 3 – 6
security and access level matrix, 2 – 12
security and access levels, 2 – 10
Does Req Line Have Enough Information To Automatically Create A Document?
process activities
Does the Req Line Have Valid Source Document Information?, C – 233
Does The Req Line Have Valid Supplier Information?, C – 232
End, C – 233
Is This An Emergency Requisition?, C – 232
Start, C – 232
Does Req Line Have Enough Information To Automatically Create A Document?
process overview, C – 231
Drilling down from GL, customizing windows, 7 – 71
Drop shipments, 4 – 133

E
Early/late receipt tolerance, setup, 7 – 11
EDI integration, price sales catalogs, 5 – 23
Emergency requisitions, 6 – 9
Employees, assigning to jobs or positions, 2 – 23
Encumbrance
in Approve Document window, 2 – 36
purchase orders and requisitions, 4 – 132
requisitions, 3 – 9
Encumbrance Detail report, 9 – 37
Enforce Buyer Name, options setup, 1 – 51
Enforce Ship–To Location, option setup, 1 – 60
Enforce ship–to location, setup, 7 – 10
Enforce Supplier Hold, options setup, 1 – 51
Enhanced Document Printing, 1 – 82
Enhanced Reporting, 1 – 82
Enter Person, window, 2 – 23
Euro
currency rate type in Currency window, 4 – 58

Index – 7
currency Rate Type in New Document window, 6 – 21
currency rate type in Requisition Preferences window, 3 – 53
currency rate type in Requisitions window, 3 – 65
rate type options setup, 1 – 46
Exceeded Price Tolerances window, 5 – 26
Exchange rate
entering at time of receipt, 7 – 36
in Corrections Window, 7 – 90
in Receiving Transactions Window, 7 – 69
Expected Receipts Report, using, 7 – 99
Expected Receipts report, 9 – 39
Expected Receipts, finding, 7 – 28
Expense Accrual, setup, 7 – 10
Expense AP accrual account, setup, 7 – 10
Expiring line items, 4 – 57
Express, receipts and receiving transactions, 7 – 26
Express Receipts, entering, 7 – 27
Express Transactions, option setup, 1 – 59
Express transactions, setup, 7 – 10
External Systems, 3 – 20

F

Facsimile
of purchase orders, 4 – 110
upon approval, 2 – 38, 2 – 39
Fill Employee Hierarchy process, 9 – 41
Financials/Purchasing Options Listing, 9 – 42
Find Approver subprocess activities
Are You Using PO Approval Hierarchies? (for purchase orders), C – 161
Document Manager Failed (for purchase orders), C – 162
Does Approver Have Authority? (for purchase orders), C – 162
End (for purchase orders), C – 162
Get Approval Path (for purchase orders), C – 161
Get First Manager in Approval Hierarchy (for purchase orders), C – 162
Get Forwarding Mode (for purchase orders), C – 161
Get Next Manager in H.R. (for purchase orders), C – 162
Is Forward-To Provided? (for purchase orders), C – 161
Start (for purchase orders), C – 161
Find Approver subprocess overview (for purchase orders), C – 159
Find Corrections window, Finding Corrections, 7 – 85
Find Expected Receipts window
Entering Unordered Receipts, 7 – 40
Finding Expected Receipts, 7 – 28
Find In-Transit Shipments window, Finding In-Transit Shipments, 7 – 92
Find Purchase Orders window, Finding Purchase Orders, 4 – 19
Find Quotations window, Finding quotations, 5 – 90
Find Receiving Transactions window, Finding Receiving Transactions, 7 – 62
Find Requisition Lines window (for assignment), Finding Requisition Lines for Review or Assignment, 5 – 98
Find Requisitions window, Finding Requisitions, 3 – 42
Find Returns window, Finding Returns, 7 – 77
Finding Requisitions
clear existing search criteria, 3 – 44
enter a new requisition, 3 – 44
Forms, Enter Purchase Orders, 6 – 12
Forward, in Approve Document window, 2 – 37
Forward Documents window, Mass Forwarding Documents, 2 – 42
Forward PO subprocess activities
Document Manager Failed, C – 165
End, C – 165
Forward PO with Status “In-Process”, C – 164
Forward PO with Status “Pre-Approved”, C – 165
Get PO Attributes, C – 165
Is PO Pre-Approved?, C – 165
Start, C – 164
Forward PO subprocess overview, C – 163
Freeze, purchase orders, 4 – 10
Full lot quantities, enforcement options, 1 – 50
Function Security, 1 – 112
Funds checking
   See also Glossary
   purchase orders, 4 – 6
   requisitions, 3 – 5
Funds reservation
   See also Glossary
   approvals, 2 – 36
   changing reserved/unreserved documents, 4 – 132
   requisitions, 3 – 9

G

Generate Accounts Using FlexBuilder Rules
   process overview, C – 53
Generate Default Accounts process activities
   Accrual Account For Expense Item, C – 36
   Accrual Account From Organization, C – 36
   Build Inventory Charge Account, C – 36
   End, C – 266
   Expense Account, C – 36
   Get Budget Account From Item/Sub, C – 36
   Get Charge Account, C – 36
   Get Item Level Budget Account, C – 36
   Get Org Level Budget Account, C – 37
   Is Charge Account CCID Null?, C – 37
   Item Under Budgetary Control?, C – 37
   Job WIP Account, C – 37
   PO Accrual Acc Flexbuilder Upgrade, C – 37
   PO Budget Acc Flexbuilder Upgrade, C – 37
   PO Charge Acc Flexbuilder Upgrade, C – 37
   PO Project–Related?, C – 38
   PO Requisition Accrual Acc Flexbuilder
      Upgrade, C – 37
   PO Requisition Budget Acc Flexbuilder
      Upgrade, C – 38
   PO Requisition Charge Acc Flexbuilder
      Upgrade, C – 38
   PO Requisition Variance Acc Flexbuilder
      Upgrade, C – 38
   PO Variance Flexbuilder Upgrade, C – 38
   Requisition Project–Related?, C – 38
   Schedule Account, C – 39
   Set Encoded Error Message, C – 39
   Type of WIP, C – 39
   Variance Account From Organization, C – 39
   Work Item Destination Type, C – 39
Generate Default Accounts process overview, C – 32
Generate Default Accrual Account subprocess overview, C – 39
Generate Default Budget Account subprocess overview, C – 41
Generate Default Charge Account subprocess overview, C – 42
Generate Default Variance Account subprocess overview, C – 43
Get All Blanket PO Changes subprocess activities
   End, C – 189
   Get Header Changes, C – 189
   Get Lines Changes, C – 189
   Start, C – 189
Get All Blanket PO Changes subprocess overview, C – 188
Get All Contract PO Changes subprocess activities
   End, C – 191, C – 194
   Get Header Changes, C – 190
   Get Lines Changes, C – 190
   Start, C – 190
Get All Contract PO Changes subprocess overview, C – 190
Get All Document Changes subprocess activities
   Determine Document Type, C – 187
   End, C – 188
   Start, C – 187
Get All Document Changes subprocess overview, C – 185
Get All Planned PO Changes subprocess activities
   End, C – 192
   Get Distribution Changes, C – 192
   Get Header Changes, C – 192
   Get Lines Changes, C – 192
   Get Shipments Changes, C – 192
   Start, C – 192
Get All Planned PO Changes subprocess overview, C – 191
Get All Release Changes subprocess activities
  Get Distribution Changes, C – 194
  Get Release Changes, C – 193
  Get Shipments Changes, C – 194
  Start, C – 193
Get All Release Changes subprocess overview, C – 193
Get All Standard PO Changes subprocess activities
  End, C – 195
  Get Distribution Changes, C – 195
  Get Header Changes, C – 195
  Get Lines Changes, C – 195
  Get Shipments Changes, C – 195
  Start, C – 195
Get All Standard PO Changes subprocess overview, C – 194
Get Buyer process activities
  End, C – 237
  Get Buyer From Category, C – 237
  Get Buyer From Item, C – 237
  Get Buyer From Req Line, C – 237
  Get Buyer From Source Doc, C – 237
  Start, C – 237
Get Buyer process overview, C – 236
Get Charge Account for Variance Account subprocess overview, C – 51
Get Variance Account from Organization subprocess overview, C – 52

H
Hazard Classes window
  Defining Hazard Classes, 1 – 70
  Multilingual Support, 1 – 70
Hazard Classes, defining, 1 – 70
Hazardous Materials
  overview, 1 – 67
  regulation background, 1 – 67

I
In–Transit Shipments, finding, 7 – 92
Include In Next RFQ Printing, 5 – 64
Information Template window, 1 – 102
Inspecting Received Items, 7 – 73
Inspection, 7 – 72
Inspection Details window, Inspecting Received Items, 7 – 73
Internal Requisition Status Report, 9 – 43
Internal Requisitions
  approvals and controls, 3 – 17
  cancellation of requisitions, 3 – 18
  complete item sourcing definition, 3 – 15
  complete requisitions status visibility, 3 – 17
  creating online requisitions, 3 – 16
  creation of internal sales orders, 3 – 17
  exception processing, 3 – 17
  flexible processing, 3 – 16
  full unit of issue enforcement, 3 – 16
  inter–organization shipping network, 3 – 16
  inventory replenishment requisitions, 3 – 16
  Kanban replenishments, 3 – 19
  MRP generated requisitions, 3 – 17
  order management, 3 – 17
Internal requisitions
  approval, 3 – 21
  business example, 3 – 35
  cancelling, 3 – 25
  demand for, 3 – 18
  management, 3 – 25
  minimum inventory setup, 3 – 32
  minimum purchasing setup, 3 – 30
  minimum shipping setup, 3 – 30
  online processing automation, 3 – 34
  overview, 3 – 15
  processing summary, 3 – 26
  setup overview, 3 – 27
  updating intranet information, 3 – 25
  viewing status of, 3 – 25
Internal Requisitions/Deliveries Discrepancy report, 9 – 45
Internal Sales Orders, across operating units, 3 – 22
Internal sales orders
  creation, 3 – 21
  management, 3 – 23
  pick release, 3 – 24
  ship confirmation, 3 – 24
Intrastat, 7 – 8
Inventory accruals, setting up, 7 – 104
Inventory Replenishment Requests, 3 – 19
Invoice Close % Tolerance, setup, 7 – 9
Invoice Close Tolerance percentage, option setup, 1 – 47
Invoice exchange rate variances, 7 – 115
Invoice match approval, setup, 7 – 9
Invoice Matching, option setup, 1 – 47
Invoice Price Variance by Vendor, 9 – 49
Invoice Price Variance report, 9 – 47
Invoices, finding, 9 – 69
Item Attachments, 1 – 38
Item Description, update options setup, 1 – 51
Item Detail Listing, 9 – 51
Item Source window, 1 – 102
Item Summary Listing, 9 – 53
Item type attributes, Catalog Price Tolerances Exceeded workflow, C – 272
Item types
  Account Generator, C – 27
  Catalog Price Tolerances Exceeded workflow, C – 272
  Debit Memo Notification, C – 280
  PO Approval, C – 120
  PO Confirm Receipts, C – 245
  PO Create Documents, C – 216
  PO Requisition Approval, C – 63
  PO Send Notifications for Purchasing Documents, C – 258
Items
  last price history, 5 – 5
  purchase history, 5 – 5

Kanban replenishment request, receiving purchase order for, 7 – 6

L
Last Price History, definition, 5 – 5
Line Type, 1 – 80
default for documents, 1 – 47
Line Types, definition, 1 – 84
Line Types window
  Defining Line Types, 1 – 85
  Multilingual Support, 1 – 84
Line Types, defining, 1 – 84
Location Listing, 9 – 54
Lookup Codes
  1099 Supplier Exception, 1 – 75
  acceptance type, 1 – 75
  freight terms, 1 – 75
  minority group, 1 – 76
  pay group, 1 – 76
  PO/Requisition Reason, 1 – 76
  price type, 1 – 76
  quotation approval reason, 1 – 76
  reply/receive via, 1 – 76
  supplier type, 1 – 76
Lookup Codes, defining, 1 – 74
Lookups window, Defining Lookup Codes, 1 – 74
Lot numbers, 7 – 96

M
Main Requisition Approval process activities
  Can Owner Approve?, C – 73
  Get AutoCreate PO Mode, C – 76
  Is Requisition Pre–Approved?, C – 89,
    C – 99, C – 101
  Launch Create PO Workflow, C – 76
  Wait for Background Process, C – 76
Manage Shipments window, 7 – 94
Managing Attachments window, 1 – 38
Managing Requisitions, 3 – 10
Mass Forwarding Documents, 2 – 42
  change original approver, 2 – 43
  view action history, 2 – 43
MassCancel
  delete MassCancel batch, 2 – 67
  run MassCancel, 2 – 66
MassCancel, defining, 2 – 60
MassCancel, running, 2 – 65
Match Unordered Receipts, Matching
  Unordered Receipts, 7 – 42
Matching Holds by Buyer report, 9 – 56
Matching Service Purchase Orders, 1 – 83
Matching Unordered Receipts, 7 – 41
Maximum release amount, option setup, 1 – 46
Menu paths, A – 2
Model/unit effectivity
  purchase orders, 4 – 79
  releases, 4 – 102
  requisitions, 3 – 71
Modify Lines window, Modifying Requisition
  Lines, 6 – 24
Movement statistics, 7 – 8
MRP Generated Requisitions, 3 – 20
Multilingual Support
  Document Types window, 1 – 87
  Hazard Classes window, 1 – 70
  Line Types window, 1 – 84
  Oracle Public Sector Purchasing Lookups
    window, 1 – 74
  UN Numbers window, 1 – 72
Multilingual support, Printed purchase orders, 4 – 109
Multiple Distributions, 7 – 24
Multiple Receiving Organizations, Centralized
  Purchasing in, 7 – 6

N
Naming conventions, PL/SQL stored
  procedures in the PO Catalog Price
  Exceeded Tolerances workflow, C – 273
Navigator
  placing purchase orders in, 4 – 11
placing requisitions in, 3 – 6
Navigator paths, A – 2
New Vendor Letter report, 9 – 58
Notification Controls window, Entering
  Purchase Order Notification Controls,
  4 – 82
Notifications
  MRP reschedules, 2 – 33
  viewing and responding to (overview), 2 – 31
Notifications Summary window, 2 – 31
Notify Approver subprocess activities
  Approve PO Notification, C – 157
  Approve Requisition Notification, C – 96
  End (for purchase orders), C – 159
  Is Forward–To Valid, C – 97
  Is Forward–To Valid? (for purchase orders), C – 158
  PO Approval Reminder 1, C – 158
  PO Approval Reminder 2, C – 158
  Requisition Approval Reminder 2, C – 97
  Requisition Approval Reminder1, C – 97
  Set Forward–To/From App. & Fwd. Action
    (for purchase orders), C – 158
  Set Forward–To/From For Approve Action
    (for purchase orders), C – 158
  Set Forward–To/From For Timeout (for
    purchase orders), C – 159
  Start (for purchase orders), C – 157
Notify Approver subprocess overview (for
  purchase orders), C – 155
Notify Requester subprocess overview, C – 251
Notify Requester subprocess activities
  End, C – 253
  Notify Requester of Confirm Receipt – first
    reminder, C – 253
  Notify Requester of Confirm Receipt – initial
    notice, C – 253
  Notify Requester of Confirm Receipt –
    second reminder, C – 253
O

Offline approvers, 2 – 40
Open Purchase Orders By Buyer report, 9 – 60
Open Purchase Orders by Organization report, 9 – 61
Oracle Alert, use in Purchasing, B – 2
Oracle Public Sector Purchasing, Account Generator setup, C – 10
Oracle Public Sector Purchasing Lookups window, 1 – 74
Multilingual Support, 1 – 74
Oracle Quality results in Receiving Transactions window, 7 – 65
Order Pad Options, entering, 5 – 19
Order Source default, setup for internal requisitions, 1 – 52
Order Type default, setup for internal requisitions, 1 – 52
Outside processing information, entering, 4 – 80
Outside Processing Line Types, 1 – 80
Outside Processing window, Entering Outside Processing Information, 4 – 80
Over–Receipt Tolerance percentage, option setup, 1 – 59
Overall Document Creation / Launch Approval process activities
End, C – 225
Group Req Lines Into Purchase Orders Or Releases, C – 224
Is Automatic Creation Allowed?, C – 223
Is This An Emergency Requisition?, C – 224
Launch Process To Create/Approve PO Or Release, C – 224
Launch Process to Verify Req Line Information, C – 223
Put All Requisition Lines On A Purchase Order, C – 224
Remove Processed Req Lines From Temp Table, C – 224
Start, C – 223
Wait For Flow, C – 223
Overall Document Creation / Launch Approval process overview, C – 219
Overdue Vendor Shipments report, 9 – 62
Overreceipt tolerance, setup, 7 – 11
Overshipments report, 9 – 64

P

Payment on Receipt process, 9 – 66
Period Status
closed, 1 – 94
future, 1 – 94
never opened, 1 – 94
open, 1 – 94
permanently closed, 1 – 94
Period–End reconciliation tasks, 7 – 115
Perpetual accruals, accrual process for, 7 – 109
PL/SQL Error Occurs, C – 132
PL/SQL stored procedures
Generate Default Accounts process, C – 35
PO Approval process, C – 135
PO Approval Top Process, C – 128
PO Document Approval Reminder process, C – 263
workflow naming conventions, C – 273
Placing purchase orders in the Navigator, 4 – 11
Placing requisitions in the Navigator, 3 – 6
Planned purchase orders, 4 – 5
Planning active, 5 – 38
Planning constraints, overview, 5 – 32
PO Approval Process activities
Can Owner Approve?, C – 135
End, C – 137
Is Forward–To Provided?, C – 135
Is PO Pre–Approved?, C – 136
PO Approved, C – 136
PO Rejected, C – 137
Start, C – 135
PO Approval Top Process activities
Get PO Attributes, C – 130
Get Workflow Approval Mode, C – 130
Is Archive on Approval Flag Set to Yes?, C – 131
Is Change Initiated from Web Suppliers?, C – 130
Is This a New Document?, C – 130
PO Approved, C – 131
Index – 14 Oracle Public Sector Purchasing User’s Guide

Remove All Notifications For This Doc, C – 129
Set PO Status to "In Process", C – 130
Set Workflow Startup Values, C – 129
Start, C – 129
Update PO Header with Workflow Key, C – 129
Wait for Background Process, C – 130
PO Approval Top Process overview, C – 126
PO Change History, 8 – 4
PO Document Approval Reminder process activities
Approve Purchase Order Release Reminder Notification, C – 266
Approve Purchase Order Reminder Notification, C – 266
Approve Requisition Reminder Notification, C – 265
Compare Text, C – 264
Is Forward to Valid, C – 266
Noop, C – 266
PO Acceptance Past Due Notification, C – 265
PO Acceptance Required Notification, C – 265
Quotation Near Expiration Notification, C – 264
Quotation Requires Completion Notification, C – 264
Release Acceptance Past Due Notification, C – 265
Release Acceptance Required Notification, C – 265
RFQ Near Expiration Notification, C – 265
RFQ Requires Completion Notification, C – 265
Set Document Type, C – 264
Start, C – 264
Start Document Approval, C – 266
PO Document Approval Reminder process overview, C – 261
Position Hierarchies setting up, 2 – 8
uses, 2 – 8
Pre–Approved, document, 2 – 25
Price Break Type, option setup, 1 – 46
Price Break window, Entering Purchase Agreement Price Break Information, 4 – 72
Price Tolerance, options setup, 1 – 49
Price Type, option setup, 1 – 47
Price Update Tolerance field, 5 – 25
Price Variances, monitoring, 7 – 117
Print, purchase orders, 4 – 8
Print Document Process (Change Order) overview, C – 206
Print Document subprocess activities
Does User Want Document Printed, C – 110
Does User Want Document Printed? (for change orders), C – 207
Does User Want Document Printed? (for purchase orders), C – 150
End, C – 111
End (for change orders), C – 208
End (for purchase orders), C – 151
Print Document, C – 110
Print Document (for change orders), C – 207
Print Document (for purchase orders), C – 151
Start, C – 110
Start (for change orders), C – 207
Start (for purchase orders), C – 150
Print Document subprocess overview, C – 109
Print Document subprocess overview (for purchase orders), C – 149
Printed Change Orders (Landscape) report, 9 – 74
Printed Change Orders (Portrait) report, 9 – 77
Printed Purchase Order (Landscape) report, 9 – 80
Printed Purchase Order (Portrait) report, 9 – 83
Printed Purchase Order, overview, 4 – 109
Printed Requisitions report, 9 – 90
Printed RFQ (Landscape) report, 9 – 86
Printed RFQ (Portrait) report, 9 – 88
Printing Attachments, 1 – 41
Process navigator, C – 276
Processes
ASL Upgrade, 9 – 17
Confirm Receipts Workflow Select Orders, 9 – 28
Create Internal Sales Orders, 9 – 35
Create Releases, 9 – 36
Fill Employee Hierarchy, 9 – 41
overall document creation, C – 219
Payment on Receipt, 9 – 66
Purchasing Database Administration, 9 – 107
Purge Purchasing Open Interface Processed Data, 9 – 113
Receipt Accruals – Period End, 7 – 120, 9 – 119
Receiving Transaction Processor, 9 – 131
Requisition Import, 9 – 144
Reschedule Requisitions, 9 – 150
Send Notifications for Purchasing Documents, 9 – 155
Upgrade Notifications to Release 11, 9 – 177
Workflow Background, 1 – 100
Processing mode, setup, 7 – 11
Procurement cards, 4 – 143
Procurement processes workflow, C – 276
Profile options, 1 – 103
Project information
   in purchase order Distributions window, 4 – 78
   in Purchase Order Preferences window, 4 – 37
   in quotation when copying from RFQ, 5 – 88
   in Quotations window, 5 – 78
   in release Distributions window, 4 – 101
   in requisition Distributions window, 3 – 70
   in Requisition Preferences window, 3 – 55
   in RFQs window, 5 – 62
Project Manufacturing information
   in purchase order Distributions window, 4 – 78
   in release Distributions window, 4 – 101
   in requisition Distributions window, 3 – 70
Proprietary account. See Glossary
Purchase Agreement Audit report, 9 – 91
Purchase agreement header information, entering, 4 – 55
Purchase agreement line information, entering, 4 – 55
Purchase agreement price break information, entering, 4 – 72
Purchase History, definition, 5 – 5
Purchase order acceptances, entering and viewing, 4 – 84
Purchase Order and Releases Detail report, 9 – 99
Purchase Order Commitment report, 9 – 93
Purchase Order Detail report, 9 – 95
Purchase order details, entering, 4 – 60
Purchase Order Distribution Detail report, 9 – 97
Purchase Order Distributions results window, Using the Purchase Order Distributions Results Window, 4 – 32
Purchase Order Distributions results window, using, 4 – 32
Purchase order distributions, entering, 4 – 74
Purchase Order Header Results window, using, 4 – 23
Purchase Order Headers window, Using the Purchase Order Headers Results window, 4 – 23
Purchase Order Headers, entering, 4 – 39
Purchase order lines, using line types, 1 – 84
Purchase Order Lines Results window, using, 4 – 26
Purchase Order Lines window, Using the Purchase Order Lines Results window, 4 – 26
Purchase order lines, entering, 4 – 45
Purchase Order Miscellaneous Information, entering, 4 – 53
Purchase order notification controls, entering, 4 – 82
Purchase order numbers
   entry method setup, 1 – 53
   entry type setup, 1 – 54
Purchase Order Preferences window, Entering Purchase Order Preferences, 4 – 35
Purchase Order Preferences, entering, 4 – 34
Purchase order price reference information, entering, 4 – 49
purchase order receipt accruals, defining, 7 – 130
Purchase order receipt to expense destinations, standard costing, 7 – 113
Purchase order receipt to inventory, standard costing, 7 – 112
Purchase order receipt to receiving inspection, standard costing, 7 – 110
Purchase order receiving controls, entering, 4 – 69
Purchase order reference document information, entering, 4 – 51
Purchase Order Shipments results window, using, 4 – 29
Purchase Order Shipments window, Using the Purchase Order Shipments Results Window, 4 – 29
Purchase order shipments, entering, 4 – 63
Purchase order terms and conditions, entering, 4 – 60
Purchase Orders
  control matrices, 2 – 50
    line types, 4 – 7
Purchase orders
  acceptances, 4 – 7
  approval, 4 – 8
  AutoClose, 4 – 9
  blanket purchase agreements, 4 – 4
  cancel, 4 – 9
  close, 4 – 9
  contract purchase agreements, 4 – 4
  defaulting rules, 4 – 12
  freeze, 4 – 10
  funds checking, 4 – 6
  hold, 4 – 10
  multiple shipments, 4 – 7
  notification controls, 4 – 10
  overview, 4 – 3
  placing in the Navigator for easy access, 4 – 11
  planned purchase orders, 4 – 5
  print, 4 – 8
  reserve and unreserve, 4 – 132
  revising and archiving, 4 – 123
revision, 4 – 7
standard purchase orders, 4 – 4
tax information at distribution level, 4 – 77
tax information at shipment level, 4 – 68
types, 4 – 4
viewing changes to, 8 – 4
viewing line-level tax, 4 – 47
Purchase Orders window
  Entering Purchase Agreement Header Information, 4 – 55
    entering purchase agreement line information, 4 – 56
  Entering Purchase Order Headers, 4 – 39
  Entering Purchase Order Lines, 4 – 45
  Entering Purchase Order Miscellaneous Information, 4 – 53
  Entering Purchase Order Price Reference Information, 4 – 49
  Entering Purchase Order Reference Document Information, 4 – 51
Purchase Orders, finding, 4 – 19
Purchase Price Variance report, 9 – 100
Purchase Requisition Status report, 9 – 102
Purchase Summary by Category report, 9 – 104
Purchasing Accounting Lines window, 7 – 70
Purchasing Activity Register, 9 – 105
Purchasing Database Administration, 9 – 107
Purchasing Documents Open Interface, 5 – 22
  monitoring supplier price increases, 5 – 26
  price tolerance, 5 – 25
  sourcing, 5 – 23
Purchasing Documents Open Interface Report, 9 – 108
Purchasing Interface Errors Report, 9 – 111
Purchasing Options
  accrual options, 1 – 45
  control options, 1 – 45
  default options, 1 – 45
  internal requisition options, 1 – 45
  numbering options, 1 – 45
  tax defaults options, 1 – 45
Purchasing options
  accrual options, 1 – 48
  control options, 1 – 49
  default options, 1 – 45
internal requisition options, 1 – 52
numbering options, 1 – 53
numbering options in a Multi–Org setup, 1 – 54
tax defaults options, 1 – 55
Purchasing Options window, Defining Purchasing Options, 1 – 45
Purchasing options, defining, 1 – 45
Purchasing Periods, controlling, 1 – 93
Purchasing Services, 1 – 79
Purge Purchasing Open Interface Processed Data process, 9 – 113

Q

Quality Code Listing, 9 – 114
Quality Inspection Codes
  quality code, 1 – 77
  ranking number, 1 – 77
Quality Inspection Codes window, Defining Quality Inspection Codes, 1 – 77
Quality Inspection Codes, defining, 1 – 77
Quality results
  entering (overview), 7 – 47
  entering in Receiving Transactions window, 7 – 65
Quantity–Based Purchasing, 1 – 80
Quotation Action Required report, 9 – 115
Quotation Headers, entering, 5 – 73
Quotation lines, using line types, 1 – 84
Quotation Lines, entering, 5 – 77
Quotation numbers
  entry method setup, 1 – 53
  entry type setup, 1 – 54
Quotation Price Breaks window, Entering Quotation Price Break Information, 5 – 84
Quotation Price Breaks, entering, 5 – 84
Quotation Shipments window, Entering Quotation Shipment Information, 5 – 81
Quotation Shipments, approving, 5 – 91
Quotation Shipments, entering, 5 – 81
Quotation Terms window, Entering Quotation Terms Information, 5 – 80
Quotation Terms, entering, 5 – 79
Quotations
  autocreating, 5 – 4
  copying from RFQs, 5 – 88
  numbering options, 5 – 3
  purchase orders, 5 – 3
  requisitions, 5 – 6
  types, 5 – 7
  warning delay default, 1 – 47
Quotations window
  Entering Quotation Headers, 5 – 73
  Entering Quotation Lines, 5 – 77
Quotations, approving entire, 5 – 93
Quotations, finding, 5 – 90
Quote warning delay, option setup, 1 – 47

R

Realms window, 1 – 102
Reassign, through Notifications Summary window, 2 – 32
Receipt accounting
  overview, 7 – 101
  viewing from receiving transaction, 7 – 53
Receipt Accruals – Period End process, 7 – 120, 9 – 119
Receipt Adjustments Report, 9 – 122
Receipt Close % Tolerance, setup, 7 – 9
Receipt Close Point, option setup, 1 – 50
Receipt close point, setup, 7 – 10
Receipt Close Tolerance percentage, option setup, 1 – 47
Receipt Date Control, option setup, 1 – 58
Receipt exchange information
  entering, 7 – 36
  in Corrections window, 7 – 90
  in Receiving Transactions window, 7 – 69
Receipt Header Details window, Using the Receipt Header Details window, 7 – 57
Receipt Header Details window, using, 7 – 57
Receipt Header window, Entering Receipt Headers, 7 – 32
Receipt Headers, entering, 7 – 32
Receipt Lines, entering, 7–34
Receipt numbering
  alphanumeric or numeric, 7–10
  automatic or manual, 7–10
  option setup, 1–60
ReceiptRoutingModule, option setup, 1–60
Receipt routing override, setup, 7–11
Receipt routing, default, setup, 7–11
Receipt tolerances, 7–13
Receipt Traveler, 9–124
Receipt Traveler, automatic print, setup, 7–11
Receipt Travelers, 7–99
Receipt–invoice matching
  with ASNs, 7–17
  with Payment on Receipt, 9–67
Receipts
  cascade, 7–25
  express, 7–26
  Receipt Traveler, 7–99
  Substitute Receipts Report, 9–157
Receipts window
  Entering exchange rate information, 7–36
  Entering Express Receipts, 7–27
  Entering Receipt Lines, 7–34
Receiving
  accrue un–invoiced receipts, 7–4
  blind receiving, 7–2
  Cascade, 7–2
  closed for invoicing, 7–4
  closed for receiving, 7–4
  control numbers, 7–5
  entering Quality results (overview), 7–47
  entering Quality results in Receiving Transactions window, 7–65
  Express Receipt, 7–2
  hazardous materials, 7–5
  inspection, 7–5
  locator, 7–5
  match approval levels, 7–3
  overview, 7–2
  predefined substitute items, 7–3
  quality and destination, 7–5
  receiving tolerances, 7–2
  returns, 7–5
  services and labor, 7–4
  supply information, 7–3
  transfers of inventory items, 7–3
  unordered items, 7–3
Receiving Account Distributions report, 9–126
Receiving account, default, setup, 7–11
Receiving Accrual Account, option setup, 1–61
Receiving Controls window, Entering Purchase Order Receiving Controls, 4–69
Receiving Controls, Options, and Profiles, 7–9
Receiving corrections, 7–84
Receiving Exceptions report, 9–128
Receiving Headers Summary window, using, 7–50
Receiving Inspections, 7–72
Receiving Locations, 7–7
Receiving Options window, Defining Receiving Options, 1–58
Receiving Options, defining, 1–58
Receiving Reports, 7–99
Receiving Returns, 7–76
Receiving Returns window, Entering Receiving Returns, 7–80
Receiving Services, 1–83
Receiving Transaction Processor, 9–131
Receiving Transaction Summary window, using, 7–51
Receiving Transactions, 7–45
  cascade, 7–25
  express, 7–26
Receiving transactions (summary), finding, 7–47
Receiving Transactions Register, 9–133
Receiving Transactions Summary window, Using the Receiving Transactions Summary window, 7–52
Receiving Transactions window
  entering Quality results, 7–65
  Entering Receiving Transactions, 7–66
  exchange rate and Currency, 7–69
Receiving Transactions, entering, 7–65
Receiving transactions, finding, 7–62
Receiving Value by Destination Account report, 9 – 139
Receiving Value report, 9 – 136
Recovery Rate field, overview, 4 – 137
Regulation Background hazard class, 1 – 68
identification number, 1 – 68
labels required, 1 – 69
packaging requirements, 1 – 69
shipping name, 1 – 67
shipping requirements, 1 – 69
Reject PO subprocess activities Document Manager Failed, C – 169
End, C – 169
Reject The PO, C – 169
Start, C – 169
Unable To Reject Document, C – 169
Reject PO subprocess overview, C – 167
Reject Requisition subprocess activities Document Manager Failed, C – 91
End, C – 91
Reject the Requisition, C – 91
Start, C – 90
Unable to Reject Document, C – 91
Reject Requisition subprocess overview, C – 89
Release distributions, entering, 4 – 97
Release generation, automatic, 4 – 103
Release Headers, entering, 4 – 87
Release shipments, entering, 4 – 90
Releases blanket, 4 – 4
scheduled, 4 – 5
tax information at distribution level, 4 – 100
tax information at shipment level, 4 – 96
Releases window Entering Release Headers, 4 – 87
Entering Release Shipments, 4 – 90
Reports Accrual Reconciliation, 9 – 5
Accrual Write–Off, 9 – 13
Backordered Internal Requisitions, 9 – 18
Blanket and Planned PO Status, 9 – 19
Buyer Listing, 9 – 21
Buyer’s Requisition Action Required, 9 – 23
Cancelled Purchase Order, 9 – 25
Cancelled Requisition, 9 – 26
Contract Status, 9 – 30
Country of Origin (by Item), 9 – 31
Country of Origin (by Supplier), 9 – 33
Define Mass Cancel Listing, 2 – 63
Encumbrance Detail, 9 – 37
Expected Receipts Report, 9 – 39
Financials/Purchasing Options Listing, 9 – 42
Internal Requisition Status Report, 9 – 43
Internal Requisitions/Deliveries Discrepancy, 9 – 45
Invoice Price Variance by Vendor, 9 – 49
Invoice Price Variance Report, 9 – 47
Item Detail Listing, 9 – 51
Item Summary Listing, 9 – 53
Location Listing, 9 – 54
Matching Holds by Buyer, 9 – 56
New Vendor Letter, 9 – 58
Open Purchase Orders By Buyer, 9 – 60
Open Purchase Orders by Organization, 9 – 61
Overdue Vendor Shipments Report, 9 – 62
Overshipments, 9 – 64
Printed Change Orders (Landscape), 9 – 74
Printed Change Orders (Portrait), 9 – 77
Printed Purchase Order (Landscape), 9 – 80
Printed Purchase Order (Portrait), 9 – 83
Printed Requisitions, 9 – 90
Printed RFQ (Landscape), 9 – 86
Printed RFQ Report (Portrait), 9 – 88
Purchase Agreement Audit, 9 – 91
Purchase Order and Releases Detail, 9 – 99
Purchase Order Commitment, 9 – 93
Purchase Order Detail, 9 – 95
Purchase Order Distribution Detail, 9 – 97
Purchase Price Variance Report, 9 – 100
Purchase Requisition Status Report, 9 – 102
Purchase Summary by Category, 9 – 104
Purchasing Activity Register, 9 – 105
Purchasing Documents Open Interface, 9 – 108
Purchasing Interface Errors, 9 – 111
Quality Code Listing, 9 – 114
Quotation Action Required, 9 – 115
Receipt Adjustments Report, 9 – 122
Receipt Traveler, 9 – 124
Receiving Account Distributions Report, 9 – 126
Receiving Exceptions Report, 9 – 128
Receiving Transactions Register, 9 – 133
Receiving Value by Destination Account Report, 9 – 139
Receiving Value Report, 9 – 136
ReqExpress Templates Listing, 9 – 141
Requisition Activity Register, 9 – 142
Requisition Distribution Detail, 9 – 143
Requisition Import Exceptions, 9 – 148
Requisitions on Cancelled Sales Orders, 9 – 149
RFQ Action Required, 9 – 117
Run MassCancel Listing, 2 – 67
Savings Analysis (By Buyer), 9 – 151
Savings Analysis (By Category), 9 – 153
Standard Notes Listing, 9 – 156
Substitute Receipts Report, 9 – 157
Tax Code Listing, 9 – 169
Uninvoiced Receipts, 9 – 170
Unit of Measure Class Listing, 9 – 172
Unit of Measure Listing, 9 – 173
Unordered Receipts, 9 – 175
Vendor Affiliated Structure Listing, 9 – 158
Vendor Price Performance Analysis, 9 – 159
Vendor Purchase Summary, 9 – 161
Vendor Quality Performance Analysis, 9 – 163
Vendor Service Performance Analysis, 9 – 165
Vendor Volume Analysis, 9 – 167
Vendors on Hold, 9 – 168
Req Import group by, option setup, 1 – 46
ReqExpress, definition, 3 – 5
ReqExpress Templates Listing, 9 – 141
ReqImport, definition, 3 – 6
Requires Reapproval status, effect on supply, 2 – 26
Requisition Activity Register, 9 – 142
Requisition Distribution Detail report, 9 – 143
Requisition Distributions, 3 – 68
Requisition Distributions Summary window, 3 – 49
Requisition Distributions Summary window, using, 3 – 49
Requisition Headers
enter requisition preferences, 3 – 59
open the Supplier Item Catalog, 3 – 58
take approval actions, 3 – 58
to check funds, 3 – 59
Requisition Headers Summary window, Using the Requisition Headers Summary Window, 3 – 44
Requisition Headers Summary window, using, 3 – 44
enter a new requisition, 3 – 45
enter requisition preferences, 3 – 46
navigate, 3 – 44
open for the current line, 3 – 45
requisition control information, 3 – 46
view action history, 3 – 46
view distributions information, 3 – 46
view purchase orders, 3 – 46
view requisition line information, 3 – 45
view sales orders, 3 – 46
Requisition Headers, entering, 3 – 57
Requisition Import Exceptions report, 9 – 148
Requisition Import process, 9 – 144
Requisition Lines
enter line details, 3 – 64
enter requisition distributions, 3 – 65
enter requisition preferences, 3 – 66
line currency information, 3 – 64
line source details, 3 – 64
open the Supplier Item Catalog, 3 – 65
outside processing information, 3 – 65
to approve requisitions, 3 – 66
to check funds, 3 – 66
Requisition lines, using line types, 1 – 84
Requisition Lines for AutoCreate, finding, 6 – 12
Requisition Lines Summary window, Using the Requisition Lines Summary Window, 3 – 47
Requisition Lines Summary window, using, 3 – 47
view purchase orders, 3 – 48
view sales orders, 3 – 48
Requisition Lines, assigning, 5 – 102
Requisition lines, entering, 3 – 60
Requisition Lines, finding for review or assignment, 5 – 98
Requisition lines, modifying during AutoCreate, 6 – 24
Requisition numbers
  entry method setup, 1 – 53
  entry type setup, 1 – 54
Requisition Preferences window, Entering Requisition Preferences, 3 – 52
Requisition preferences, entering, 3 – 52
Requisition Template, copy button, 1 – 63
Requisition Templates window, Defining Requisition Express Templates, 1 – 62
Requisition Templates, defining, 1 – 62
Requisition templates, using, 3 – 73
Requisitions
  accounting information, 3 – 4
  action history, 8 – 2
  approval history, 3 – 4
  approval status, 3 – 4
  approvals, 3 – 5
  assigning to a buyer, 3 – 11
  AutoApproval, 3 – 6
  cancelling, 3 – 12
  emergency, 6 – 9
  encumbrance, 3 – 9
  finally closing, 3 – 13
  foreign currency, 3 – 11
  imported, 3 – 8
  imported from Self–Service Purchasing, 6 – 9
  importing from another system, 3 – 6
  Internal, 3 – 8
  kanban replenishments, 3 – 19
  on–line entry, 3 – 3
  paper, 3 – 9
  paperless system, 3 – 3
  placing in the Navigator for easy access, 3 – 6
  printing, 3 – 5
  purchase, 3 – 8
Purchase Requisitions Status report, 9 – 102
quantifying rounding, 3 – 5
reserving funds for, 3 – 9
resubmission, 3 – 4
returning, 3 – 11
templates, 3 – 8
updating during approval, 3 – 14
updating with Modify, 3 – 13
viewing distribution–level tax, 3 – 70
viewing line–level tax, 3 – 66
Requisitions cancellation, 3 – 4, 3 – 26
Requisitions on Cancelled Sales Order Report, 9 – 149
Requisitions window
  Entering Requisition Headers, 3 – 57
  Entering Requisition Lines, 3 – 60
  using requisition templates, 3 – 73
Requisitions, finding, 3 – 42
Requisitions, overview, 3 – 2
Requisition Template
  copy lines, 1 – 63
  define, 1 – 62
  manually add lines, 1 – 64
  sourcing information, 1 – 65
Reschedule Requisitions process, 9 – 150
Reserve at the Start subprocess activities
  Document Manager Failed, C – 84
  End, C – 84
  Is Encumbrance On and Is Document Not Reserved?, C – 84
  Is Interface Source Req Import, C – 83
  Reserve Document, C – 84
  Start, C – 83
Reserve at the Start subprocess overview, C – 82
Reserve Before Approve subprocess activities
  Document Manager Failed, C – 105
  Document Manager Failed (for purchase orders), C – 142
  End (for purchase orders), C – 143
  Is Encumbrance On and Is Document Not Reserved?, C – 105
  Is Encumbrance On and Is Document Not Reserved? (for purchase orders), C – 142
  Is Forward–To Valid, C – 105
  Is Forward–To Valid? (for purchase orders), C – 143
  Reject the PO (for purchase orders), C – 143
  Reject the Requisition, C – 106
  Reserve Document, C – 105
  Reserve Document (for purchase orders), C – 142
Set Forward–To/From Forward, C – 106
Set Forward–To/From Forward Action (for purchase orders), C – 143
Start (for purchase orders), C – 142
Unable to Reject Document, C – 106
Unable to Reject Document (for purchase orders), C – 143
Unable to Reserve Document, C – 105
Unable To Reserve Document (for purchase orders), C – 143
Reserve Before Approve subprocess overview, in the PO Approval workflow, C – 140
Reserve for Encumbrance account. See Glossary
Reserving funds
changing documents, 4 – 132
for requisitions, 3 – 9
through Approve Document window, 2 – 36
Return material authorizations, 7 – 14
Return PO to Submitter subprocess activities
End, C – 167
Is Submitter Last Approver?, C – 167
Notify Last Approver Of No Approver Found, C – 167
Notify Preparer Of No Approver, C – 166
Set PO Status to Original Status, C – 166
Start, C – 166
Return PO to Submitter subprocess overview, C – 165
Return Requisition to Submitter subprocess activities
End, C – 93
Is Submitter Last Approver?, C – 93
Notify Last Approver of No Approver Found, C – 93
Notify Requestor of No Approver Available, C – 93
Set Req Status to Original Status, C – 92
Start, C – 92
Return Requisition to Submitter subprocess overview, C – 91
Return to supplier from inventory or expense destinations, standard costing, 7 – 115
Return to supplier from receiving, standard costing, 7 – 115
Returns, 7 – 76
Returns, entering, 7 – 80
Returns, finding, 7 – 77
Review, requisition approvals, 8 – 2
Review Buyer Workload window, Reviewing Buyer Workload, 5 – 101
Reviewing Requisitions, 3 – 10
RFQ, requirement, 5 – 4
RFQ Action Required report, 9 – 117
RFQ Headers, entering, 5 – 57
RFQ lines, using line types, 1 – 84
RFQ Lines, entering, 5 – 60
RFQ numbers
entry method setup, 1 – 53
entry type setup, 1 – 54
RFQ Price Break Information, entering, 5 – 69
RFQ Price Breaks window, Entering RFQ Price Break Information, 5 – 69
RFQ required, option setup, 1 – 47
RFQ Shipment Information, entering, 5 – 66
RFQ Shipment Information, entering, 5 – 67
RFQ Supplier Information, entering, 5 – 63
RFQ Suppliers window, Entering RFQ Supplier Information, 5 – 63
RFQ Terms Information, entering, 5 – 65
RFQ Terms window, Entering RFQ Terms Information, 5 – 65
RFQs
autocreating, 5 – 4
numbering options, 5 – 3
supplier lists, 5 – 4
types, 5 – 7
RFQs window
Entering RFQ Headers, 5 – 58
Entering RFQ Lines, 5 – 60
RMAs, 7 – 14
Routing Control
Allow Change to Approval Hierarchy, 2 – 14
Allow Change to Forward–From, 2 – 13
Allow Change to Forward–To, 2 – 13
Approval Hierarchy, 2 – 14
Forwarding Method, 2 – 14
Owner Can Approve, 2 – 13
Run MassCancel
purchase order, 2 – 61
requisition, 2 – 61
Run MassCancel Listing, 2 – 67
Run MassCancel window, 2 – 61
Running MassCancel, 2 – 66

Sample alerts, for Oracle Public Sector Purchasing, B – 3
Savings Analysis (By Buyer) report, 9 – 151
Savings Analysis Report (By Category), 9 – 153
Scheduled releases, 4 – 5
Search Supplier Item Catalog window, Finding Supplier Items, 5 – 12
Security Hierarchy, options setup, 1 – 51
Self–Service Purchasing, requisitions and AutoCreate, 6 – 9
Send Notifications for Purchasing Documents process, 9 – 155
Serial numbers, 7 – 96
Setting Up a Default Line Type, 1 – 81
setup overview, 1 – 2
Shipments window, Entering Purchase Order Shipments, 4 – 63
Shipments, managing, 7 – 93
Sourcing
automatic (overview), 5 – 30
automatic (setting up), 5 – 33
overview, 5 – 2
through the Purchasing Documents Open Interface, 5 – 23
Sourcing rules
overview, 5 – 30
setting up, 5 – 33
Sourcing Services, 1 – 83
Standard costing transactions
delivery from receiving inspection to inventory, 7 – 111
matching invoices, 7 – 114
purchase order receipt to expense destinations, 7 – 113
purchase order receipt to inventory, 7 – 112
purchase order receipt to receiving inspection, 7 – 110
return to supplier from inventory or expense destinations, 7 – 115
return to supplier from receiving, 7 – 115
Standard Notes Listing, 9 – 156
Standard purchase orders, 4 – 4
Standard quotation or RFQ, 5 – 7
Start of Approve Requisition subprocess activities
Get Requisition Attributes, C – 79
Get Workflow Approval Mode, C – 78
Remove All Notifications For This Document, C – 78
Set Req Status to In–Process and Update with Item Type & Key, C – 78
Set Workflow Startup Values, C – 78
Wait for Background Process, C – 78
Status, defining approved supplier, 5 – 45
Stock locators, 7 – 97
Submission Check Rules, 2 – 28
Submission Check, 2 – 27
Substitute Receipts, option setup, 1 – 59
Substitute receipts, setup, 7 – 10
Substitute Receipts Report, 9 – 157
Supplier and Item/Commodity Combination, defining, 5 – 47
Supplier Item Catalog
Order Pad, 5 – 9
order pad options, 5 – 10
Order Total, 5 – 11
search window, 5 – 8
Select Price Only, 5 – 11
sourcing regions, 5 – 8
Supplier Item Catalog Alternative Regions, using, 5 – 15
Supplier Item Catalog window
Entering Order Pad Options, 5 – 19
Using the Supplier Item Catalog Alternative Regions, 5 – 16
Supplier Item Catalog, overview, 5 – 8
Supplier Item Catalog, searching, 5 – 11
Supplier Lists, 5 – 4
alternate fields, 5 – 4
Supplier Lists window, Defining Supplier Lists, 5 – 96
Supplier Lists, defining, 5 – 96
Supplier–Item Attributes window, 5 – 51
Supplier/Item Attributes window, defining, 5 – 51
Suppliers
  defaulting, 5 – 33
  holding, 5 – 4

T

Tax
  at purchase order distribution level, 4 – 77
  at purchase order shipment level, 4 – 68
  at release distribution level, 4 – 100
  at release shipment level, 4 – 96
  at requisition distribution level, 3 – 70
  at requisition line level, 3 – 66
  defaults options, 1 – 55
  overview, 4 – 135
  Tax Details window, 4 – 140
  Tax Summary window, 4 – 138

Tax Code field
  overriding, 4 – 136
  overview, 4 – 135

Tax Code Listing, 9 – 169

Tax recovery rate, overview, 4 – 137

Terms and Conditions window, Entering Purchase Order Terms and Conditions Information, 4 – 60

Transaction status information, finding, 7 – 58
Transaction Statuses, 7 – 58

U

UN Numbers window
  Defining UN Numbers, 1 – 72
  Multilingual Support, 1 – 72
UN Numbers, defining, 1 – 71

Unable to Reserve Document notification, 2 – 34

Uninvoiced Receipts report, 9 – 170

Unit Number field
  in purchase order Distributions window, 4 – 79
  in release Distributions window, 4 – 102
  in requisition Distributions window, 3 – 71

Unreserve
  purchase orders and requisitions, 4 – 132
  through Approve Document window, 2 – 36

Upgrade Notifications to Release 11 process, 9 – 177

Usages, in attachments, 1 – 42

Using Attachments, 1 – 37

Using Internal Requisitions, 3 – 18

V

Vendor, Volume, 9 – 161

Vendor Affiliated Structure Listing, 9 – 158

Vendor Price Performance Analysis report, 9 – 159

Vendor Purchase Summary report, 9 – 161

Vendor Quality Performance Analysis report, 9 – 163

Vendor Service Performance Analysis report, 9 – 165

Vendor Volume Analysis report, 9 – 167

Vendors on Hold report, 9 – 168

Verify Approval Authority subprocess activities
  Document Manager Failed, C – 86, C – 113
  Document Manager Failed (for purchase orders), C – 145
Does Approver Have Authority?, C – 86, C – 113
Does Approver Have Authority? (for purchase orders), C – 145
End, C – 86
End (for purchase orders), C – 145
Start, C – 86
Start (for purchase orders), C – 145
Verify Approval Authority subprocess overview
in the PO Approval workflow, C – 144
in the PO Requisition Approval workflow, C – 84
Verify PO subprocess activities
Document Failed Correctness Check, C – 140
Document Failed State Check, C – 140
Document Manager Failed, C – 140
Does Document State Allow Approval Action?, C – 139
End, C – 140
Is Document Complete?, C – 139
Open Document State, C – 139
Record 'Submit' In Action History, C – 139
Set PO Status to Original Status, C – 140
Start, C – 139
Verify PO subprocess overview, C – 137
Verify Req Line Info process activities
Continue Flow, C – 230
Does the Req Line Have A One–Time Item?, C – 229
Does This Req Line Require An RFQ?, C – 228
Get Release Generation Method From ASL, C – 229
Get Req Line Info, C – 228
Get The Source Document Type, C – 229
Insert Req Line Into Temp Table As A Candidate For Creation, C – 230
Is This An Emergency Requisition?, C – 229
Is This Req Line a P–Card Line?, C – 229, C – 233
Should Workflow Create The Release?, C – 230
Start, C – 228
Verify Req Line Information process overview, C – 225
Verify Requisition subprocess activities
Document Failed Correctness Check, C – 81
Document Failed State Check, C – 81
Document Manager Failed, C – 81
Does Document State Allow Approval Action?, C – 80
End, C – 81
Is Document Complete?, C – 81
Record Submit In Action History, C – 81
Set Req Status to Original Status, C – 81
Start, C – 80
Verify Requisition subprocess overview, C – 79
View Accounting window, 7 – 56
View Accounting windows, customizing, 7 – 56
View Approved Suppliers, 5 – 56
View Receiving Accounting window, 7 – 54, 7 – 56
Viewing changes to purchase orders, 8 – 4

W
Web Requisition Approval List Routing Subprocess Activities
Get Next Approver, C – 88
Rebuild Approval List for Invalid Approver, C – 88
Web Requisition Main Requisition Approval Process Activities
Build Default Approval List, C – 73
Create Information Template Attachment, C – 75
Does Approval List Exist?, C – 73
Is Approval List Empty?, C – 74, C – 89
Rebuild Approval List After Forward Action, C – 74
Set Requisition Status to Pre–Approved, C – 73, C – 98, C – 100
Web Requisition Main Requisition Approval process overview, C – 69
Web Requisition Notify Approver Subprocess Activities, Update Action History (Expect Response), C – 96
Web Requisition Reserve at the Start Subprocess Activities, Is Requisition Created Through the Web, C – 83
Web Requisition Response with Approve Action Subprocess Activities
  Update Action History (Approve), C – 98
  Update Approval List Response, C – 98, C – 101, C – 102, C – 103
Web Requisition Response with Approve and Forward Action Subprocess Activities,
  Update Action History (Approve/Forward), C – 100
Web Requisition Response with Forward Action Subprocess Activities, Update Action History (Forward), C – 102
Web Requisition Response with Reject Action Subprocess Activities, Update Action History (Reject), C – 103
Web Requisition Start Process Activities, Find Approval List, C – 78
Windows, navigator paths, A – 2
Workflow, overall document creation process, C – 219
Workflow Background process, 1 – 100
Workflow for price exceeded notifications, naming conventions, C – 273
Workflow Monitor
  Account Generator, C – 55
  PO Create Documents workflow, C – 238
Workflow setup options, 1 – 95
Reader’s Comment Form

A81067–02

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this publication. Your input is an important part of the information we use for revision.

• Did you find any errors?
• Is the information clearly presented?
• Do you need more information? If so, where?
• Are the examples correct? Do you need more examples?
• What features did you like most about this manual? What did you like least about it?

If you find any errors or have any other suggestions for improvement, please indicate the topic, chapter, and page number below:

________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________

Please send your comments to:
Oracle Public Sector Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway, MS 3op7
Redwood Shores, CA 94065 USA
Phone: (650) 506–8968 Fax: (650) 506–7800

If you would like a reply, please give your name, address, and telephone number below:

________________________________________________________________________
________________________________________________________________________

Thank you for helping us improve our documentation.